Contents

Chapter 1  Introduction .............................................. 1
  Introduction ..................................................... 1
  Using AutoCAD Documentation .............................. 1
  Using This Reference ........................................ 1
  Executing Commands ......................................... 2
  References to Other Sections .............................. 5

Chapter 2  Commands .............................................. 7
  Overview of Commands ....................................... 7
  3D Commands .................................................. 7
    3D .............................................................. 7
    3DALIGN .................................................... 18
    3DARRAY .................................................... 20
    3DCONFIG (-3DCONFIG) .................................... 22
    3DDISTANCE ................................................ 25
    3DEDITBAR .................................................. 25
    3D Edit Bar Shortcut Menu ................................ 29
    3DFACE ...................................................... 30
    3DFORBIT .................................................... 32
    3D Free Orbit Cursor Icons .............................. 34
    3DMESH ....................................................... 35
    3DMOVE ...................................................... 36
    3D Move Gizmo Shortcut Menu ............................ 39
<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3DORBIT</td>
<td>40</td>
</tr>
<tr>
<td>3D Orbit Shortcut Menu</td>
<td>41</td>
</tr>
<tr>
<td>3DORBITCTR</td>
<td>43</td>
</tr>
<tr>
<td>3DOSNAP</td>
<td>44</td>
</tr>
<tr>
<td>3DOSNAP</td>
<td>45</td>
</tr>
<tr>
<td>3DPAN</td>
<td>45</td>
</tr>
<tr>
<td>3DPOLY</td>
<td>46</td>
</tr>
<tr>
<td>3DROTATE</td>
<td>47</td>
</tr>
<tr>
<td>3D Rotate Gizmo Shortcut Menu</td>
<td>49</td>
</tr>
<tr>
<td>3DSCALE</td>
<td>50</td>
</tr>
<tr>
<td>3D Scale Gizmo Shortcut Menu</td>
<td>52</td>
</tr>
<tr>
<td>3DSWIVEL</td>
<td>53</td>
</tr>
<tr>
<td>3DZOOM</td>
<td>54</td>
</tr>
<tr>
<td>About</td>
<td>55</td>
</tr>
<tr>
<td>ACISIN</td>
<td>55</td>
</tr>
<tr>
<td>ACISOUT</td>
<td>56</td>
</tr>
<tr>
<td>ADDSELECTED</td>
<td>56</td>
</tr>
<tr>
<td>ALIGN</td>
<td>58</td>
</tr>
<tr>
<td>AMECONVERT</td>
<td>60</td>
</tr>
<tr>
<td>ANALYSISCURVATURE</td>
<td>61</td>
</tr>
<tr>
<td>ANALYSISDRAFT</td>
<td>62</td>
</tr>
<tr>
<td>ANALYSISOPTIONS</td>
<td>63</td>
</tr>
<tr>
<td>Analysis Options Dialog Box</td>
<td>64</td>
</tr>
<tr>
<td>ANALYSISZEBRA</td>
<td>67</td>
</tr>
<tr>
<td>ANNORESET</td>
<td>68</td>
</tr>
<tr>
<td>ANNOUPDATE</td>
<td>68</td>
</tr>
<tr>
<td>APERTURE</td>
<td>69</td>
</tr>
<tr>
<td>APPLOAD</td>
<td>69</td>
</tr>
<tr>
<td>Load/Unload Applications Dialog Box</td>
<td>70</td>
</tr>
<tr>
<td>Startup Suite Dialog Box</td>
<td>73</td>
</tr>
<tr>
<td>ARC</td>
<td>74</td>
</tr>
<tr>
<td>AREA</td>
<td>78</td>
</tr>
<tr>
<td>ARRAY</td>
<td>81</td>
</tr>
<tr>
<td>ARRAYCLASSIC</td>
<td>85</td>
</tr>
<tr>
<td>Array Dialog Box</td>
<td>86</td>
</tr>
<tr>
<td>ARRAYCLOSE</td>
<td>91</td>
</tr>
<tr>
<td>ARRAYEDIT</td>
<td>92</td>
</tr>
<tr>
<td>Path Array Visor</td>
<td>96</td>
</tr>
<tr>
<td>Polar Array Visor</td>
<td>97</td>
</tr>
<tr>
<td>Rectangular Array Visor</td>
<td>98</td>
</tr>
<tr>
<td>ARRAYPATH</td>
<td>99</td>
</tr>
<tr>
<td>Create Array Visor - Path Array</td>
<td>102</td>
</tr>
<tr>
<td>ARRAYPOLAR</td>
<td>103</td>
</tr>
<tr>
<td>Create Array Visor - Polar Array</td>
<td>106</td>
</tr>
<tr>
<td>Command</td>
<td>Page</td>
</tr>
<tr>
<td>----------------</td>
<td>------</td>
</tr>
<tr>
<td>ARRAYRECT</td>
<td>107</td>
</tr>
<tr>
<td>Create Array Visor - Rectangular Array</td>
<td>110</td>
</tr>
<tr>
<td>ARX</td>
<td>111</td>
</tr>
<tr>
<td>ATTDISP</td>
<td>119</td>
</tr>
<tr>
<td>ATTEDIT</td>
<td>120</td>
</tr>
<tr>
<td>Edit Attributes Dialog Box</td>
<td>121</td>
</tr>
<tr>
<td>ATTDEF</td>
<td>112</td>
</tr>
<tr>
<td>Attribute Definition Dialog Box</td>
<td>113</td>
</tr>
<tr>
<td>-ATTDEF</td>
<td>117</td>
</tr>
<tr>
<td>ATTTEXT (-ATTEXT)</td>
<td>123</td>
</tr>
<tr>
<td>ATTEXT</td>
<td>126</td>
</tr>
<tr>
<td>ATTREDEF</td>
<td>128</td>
</tr>
<tr>
<td>ATTREDEF</td>
<td>128</td>
</tr>
<tr>
<td>AUDIT</td>
<td>129</td>
</tr>
<tr>
<td>AUTOCOMPLETE</td>
<td>130</td>
</tr>
<tr>
<td>AUTOCONSTRAIN</td>
<td>131</td>
</tr>
<tr>
<td>B Commands</td>
<td>132</td>
</tr>
<tr>
<td>BASE</td>
<td>132</td>
</tr>
<tr>
<td>BATTMAN</td>
<td>132</td>
</tr>
<tr>
<td>Block Attribute Manager</td>
<td>133</td>
</tr>
<tr>
<td>Attribute Editor Dialog Box</td>
<td>135</td>
</tr>
<tr>
<td>BATTORDER</td>
<td>140</td>
</tr>
<tr>
<td>Attribute Order Dialog Box</td>
<td>140</td>
</tr>
<tr>
<td>BCLOSE</td>
<td>141</td>
</tr>
<tr>
<td>BEDIT</td>
<td>141</td>
</tr>
<tr>
<td>Edit Block Definition Dialog Box</td>
<td>142</td>
</tr>
<tr>
<td>Block Editor</td>
<td>143</td>
</tr>
<tr>
<td>-BEDIT</td>
<td>143</td>
</tr>
<tr>
<td>BHATCH</td>
<td>145</td>
</tr>
<tr>
<td>BLEND</td>
<td>145</td>
</tr>
<tr>
<td>BLIPMODE</td>
<td>147</td>
</tr>
<tr>
<td>BLOCK</td>
<td>148</td>
</tr>
<tr>
<td>Define Block Dialog Box</td>
<td>148</td>
</tr>
<tr>
<td>-BLOCK</td>
<td>151</td>
</tr>
<tr>
<td>BMPOUT</td>
<td>153</td>
</tr>
<tr>
<td>BOUNDARY</td>
<td>154</td>
</tr>
<tr>
<td>Boundary Creation Dialog Box</td>
<td>155</td>
</tr>
<tr>
<td>-BOUNDARY</td>
<td>156</td>
</tr>
<tr>
<td>BOX</td>
<td>157</td>
</tr>
<tr>
<td>BREAK</td>
<td>159</td>
</tr>
<tr>
<td>BREP</td>
<td>162</td>
</tr>
<tr>
<td>BROWSER</td>
<td>163</td>
</tr>
<tr>
<td>BSAVE</td>
<td>163</td>
</tr>
<tr>
<td>BSAVEAS</td>
<td>163</td>
</tr>
<tr>
<td>Commands</td>
<td>Page</td>
</tr>
<tr>
<td>----------</td>
<td>------</td>
</tr>
<tr>
<td>C</td>
<td>164</td>
</tr>
</tbody>
</table>

- **Save Block Definition As Dialog Box** | 164
- **CAL** | 165
- **C Commands** | 165
  - **Understand Syntax of Expressions** | 166
  - **Format Feet and Inches** | 167
  - **Format Angles** | 168
  - **Use Points and Vectors** | 169
  - **Use AutoLISP Variables** | 170
  - **Use System Variables in Calculations** | 171
  - **Convert Units of Measurement** | 172
  - **Use Standard Numeric Functions** | 172
  - **Calculate a Vector from Two Points** | 174
  - **Calculate the Length of a Vector** | 175
  - **Obtain a Point by Cursor** | 175
  - **Obtain the Last-Specified Point** | 175
  - **Use Snap Modes in Arithmetic Expressions** | 176
  - **Convert Points Between UCS and WCS** | 177
  - **Calculate a Point on a Line** | 179
  - **Rotate a Point About an Axis** | 179
  - **Obtain an Intersection Point** | 180
  - **Calculate a Distance** | 180
  - **Obtain a Radius** | 182
  - **Obtain an Angle** | 182
  - **Calculate a Normal Vector** | 184
  - **Use Shortcut Functions** | 186
- **CHAMFER** | 186
- **CHAMFEREDGE** | 190
- **CHANGE** | 192
- **CHPROP** | 194
- **CIRCLE** | 196
- **CLASSICGROUP** | 199
- **CLEANSCREENON** | 200
- **CLEANSCREENOFF** | 201
- **CLIP** | 201
- **CLOSE** | 204
- **CLOSEALL** | 204
- **COLOR** | 205
  - **Color Palette Dialog Box** | 205
  - **-COLOR** | 212
- **COMMANDLINE** | 213
- **COMMANDLINEHIDE** | 213
- **COMPILE** | 214
- **CONE** | 214
- **CONSTRAINTBAR** | 217
- **CONSTRAINTSETTINGS** | 219
  - **Constraint Settings Dialog Box** | 219
Contents
<table>
<thead>
<tr>
<th>MATCHCELL</th>
<th>MATCHPROP</th>
<th>Match Properties Settings Dialog Box</th>
</tr>
</thead>
<tbody>
<tr>
<td>MATERIALASSIGN</td>
<td>MATERIALS</td>
<td>MATERIALSCLOSE</td>
</tr>
<tr>
<td>MEASURE</td>
<td>MEASUREGEOM</td>
<td></td>
</tr>
<tr>
<td>MESH</td>
<td>MESH</td>
<td></td>
</tr>
<tr>
<td>MESHCAP</td>
<td>MESHCOLLAPSE</td>
<td>MESHCREASE</td>
</tr>
<tr>
<td>MESHEXTRUDE</td>
<td>MESHMERGE</td>
<td>MESHREFINE</td>
</tr>
<tr>
<td>MESHSMOOTH</td>
<td>MESHSMOOTHLESS</td>
<td>MESHSMOOTHMORE</td>
</tr>
<tr>
<td>MESHSPIN</td>
<td>MESHUNCREASE</td>
<td>MINSERT</td>
</tr>
<tr>
<td>MISMATCH</td>
<td>MIRROR</td>
<td>MIRROR3D</td>
</tr>
<tr>
<td>MLEADER</td>
<td>MLEADERALIGN</td>
<td>MLEADERCOLLECT</td>
</tr>
<tr>
<td>MLEADEREDIT</td>
<td>MLEADERSTYLE</td>
<td>Multileader Style Manager</td>
</tr>
<tr>
<td>MLEADERSTYLE</td>
<td>Modify Multileader Style Dialog Box</td>
<td>Create New Multileader Style Dialog Box</td>
</tr>
<tr>
<td>MLEDIT (-MLEDIT)</td>
<td>-MLEDIT</td>
<td>MLINE</td>
</tr>
<tr>
<td>MODEL</td>
<td>MOVE</td>
<td>MREDO</td>
</tr>
<tr>
<td>MSPACE</td>
<td>MTEXT</td>
<td>In-Place Text Editor</td>
</tr>
<tr>
<td>MTEXT</td>
<td>Text Editor Visor</td>
<td>Paragraph Dialog Box</td>
</tr>
<tr>
<td>MTEXT</td>
<td>Columns Menu</td>
<td>Column Settings Dialog Box</td>
</tr>
<tr>
<td>Command/Dialog Box</td>
<td>Page</td>
<td></td>
</tr>
<tr>
<td>-----------------------------------------------------------------------------------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>Background Mask Dialog Box</td>
<td>689</td>
<td></td>
</tr>
<tr>
<td>Find and Replace Dialog Box - MTEXT</td>
<td>690</td>
<td></td>
</tr>
<tr>
<td>Stack Properties Dialog Box</td>
<td>691</td>
<td></td>
</tr>
<tr>
<td>AutoStack Properties Dialog Box</td>
<td>693</td>
<td></td>
</tr>
<tr>
<td>Symbols and Special Characters</td>
<td>695</td>
<td></td>
</tr>
<tr>
<td>-MTEXT</td>
<td>698</td>
<td></td>
</tr>
<tr>
<td>MULTIPLE</td>
<td>702</td>
<td></td>
</tr>
<tr>
<td>MVIEW</td>
<td>702</td>
<td></td>
</tr>
<tr>
<td>MVSETUP</td>
<td>706</td>
<td></td>
</tr>
<tr>
<td>MVSETUP on the Model Layout</td>
<td>706</td>
<td></td>
</tr>
<tr>
<td>MVSETUP on a Named Layout</td>
<td>707</td>
<td></td>
</tr>
<tr>
<td>N Commands</td>
<td>711</td>
<td></td>
</tr>
<tr>
<td>NAVVCUBE</td>
<td>711</td>
<td></td>
</tr>
<tr>
<td>ViewCube Settings Dialog Box</td>
<td>711</td>
<td></td>
</tr>
<tr>
<td>NEW</td>
<td>713</td>
<td></td>
</tr>
<tr>
<td>NEW Command Prompt</td>
<td>714</td>
<td></td>
</tr>
<tr>
<td>NEWSHEETSET</td>
<td>714</td>
<td></td>
</tr>
<tr>
<td>O Commands</td>
<td>715</td>
<td></td>
</tr>
<tr>
<td>OBJECTSCALE</td>
<td>715</td>
<td></td>
</tr>
<tr>
<td>Annotation Object Scale List Dialog Box</td>
<td>716</td>
<td></td>
</tr>
<tr>
<td>Add Scales to Object Dialog Box</td>
<td>717</td>
<td></td>
</tr>
<tr>
<td>-OBJECTSCALE</td>
<td>718</td>
<td></td>
</tr>
<tr>
<td>OFFSET</td>
<td>718</td>
<td></td>
</tr>
<tr>
<td>OFFSETEDGE</td>
<td>721</td>
<td></td>
</tr>
<tr>
<td>OOPS</td>
<td>722</td>
<td></td>
</tr>
<tr>
<td>OPEN</td>
<td>723</td>
<td></td>
</tr>
<tr>
<td>Standard File Selection Dialog Boxes</td>
<td>723</td>
<td></td>
</tr>
<tr>
<td>OPEN Command Prompt</td>
<td>726</td>
<td></td>
</tr>
<tr>
<td>OPENSHEETSET</td>
<td>727</td>
<td></td>
</tr>
<tr>
<td>OPTIONS</td>
<td>727</td>
<td></td>
</tr>
<tr>
<td>Application Preferences Dialog Box</td>
<td>728</td>
<td></td>
</tr>
<tr>
<td>Select Alternate Font Dialog Box</td>
<td>744</td>
<td></td>
</tr>
<tr>
<td>Default Scale List Dialog Box</td>
<td>745</td>
<td></td>
</tr>
<tr>
<td>ORTHO</td>
<td>746</td>
<td></td>
</tr>
<tr>
<td>OSNAP</td>
<td>747</td>
<td></td>
</tr>
<tr>
<td>OVERKILL</td>
<td>748</td>
<td></td>
</tr>
<tr>
<td>Delete Duplicate Objects Dialog Box</td>
<td>749</td>
<td></td>
</tr>
<tr>
<td>-OVERKILL</td>
<td>751</td>
<td></td>
</tr>
<tr>
<td>P Commands</td>
<td>753</td>
<td></td>
</tr>
<tr>
<td>PAGESETUP</td>
<td>753</td>
<td></td>
</tr>
<tr>
<td>Page Setup Manager</td>
<td>753</td>
<td></td>
</tr>
<tr>
<td>New Page Setup Dialog Box</td>
<td>756</td>
<td></td>
</tr>
<tr>
<td>Page Setup Dialog Box</td>
<td>757</td>
<td></td>
</tr>
<tr>
<td>Import Page Setups Dialog Box</td>
<td>763</td>
<td></td>
</tr>
<tr>
<td>PAGESETUPEDIT</td>
<td>765</td>
<td></td>
</tr>
<tr>
<td>PALETTEICONOFF</td>
<td>766</td>
<td></td>
</tr>
</tbody>
</table>
Lighting Properties ........................................... 849
Sun & Sky Properties ........................................ 853
PROPERTIESCLOSE ............................................. 855
PSETUP ............................................................ 855
-PSETUP ........................................................ 856
PSPACE ........................................................... 856
PUBLISH .......................................................... 857
Batch Publish Dialog Box ..................................... 857
PURGE ............................................................. 861
-PURGE .......................................................... 861
PYRAMID .......................................................... 862
Q Commands ...................................................... 864
QDIM ............................................................... 864
QLEADER ........................................................... 866
Leader Settings Dialog Box .................................. 867
QNEW ............................................................... 872
QSAVE ............................................................. 872
QTEXT ............................................................. 873
QUICKVIEW ...................................................... 873
QuickView Dialog Box ......................................... 874
QUIT ................................................................. 876
R Commands ...................................................... 876
RAY ................................................................. 876
RECOVER .......................................................... 877
RECTANG .......................................................... 878
REDEFINE .......................................................... 880
REDO ............................................................... 880
REDRAW ........................................................... 881
REDRAWALL ....................................................... 881
REFCLOSE .......................................................... 883
REFEDIT ............................................................ 883
Reference Editor Visor ......................................... 883
Reference Edit Dialog Box .................................... 884
-REFEDIT .......................................................... 887
REFSET ............................................................. 888
REGEN ............................................................. 889
REGENALL ........................................................ 889
REGENAUTO ....................................................... 890
REGION ............................................................. 891
RENAME ............................................................ 892
Rename Dialog Box ............................................ 893
-RENAME .......................................................... 893
RENDER ............................................................. 894
Render Window .................................................. 895
Render Output File Dialog Box ............................... 897
-RENDER .......................................................... 902
New Project Layout Dialog Box ........................................... 974
Add Custom Property Dialog Box ....................................... 975
Callout Blocks Dialog Box ................................................. 976
Label Block for Views Dialog Box ....................................... 977
Repair Broken Layouts Dialog Box ....................................... 978
SHEETSET/HIDE ............................................................... 979
SHOWPALETTES .............................................................. 979
SKETCH .......................................................................... 980
SLICE ............................................................................. 981
SNAP .............................................................................. 986
SOLDRAW ...................................................................... 988
SOLID ............................................................................. 989
SOLEDIT ....................................................................... 990
SOLPROF ....................................................................... 1007
SOLVIEW ..................................................................... 1009
SPELL .......................................................................... 1014
    Check Spelling Dialog Box ........................................... 1015
    Check Spelling Settings Dialog Box .............................. 1018
SPHERE ....................................................................... 1020
SPLINE ....................................................................... 1022
SPLINEDIT ................................................................. 1027
SPOTLIGHT ................................................................. 1031
STATUS ...................................................................... 1035
STLOUT ....................................................................... 1037
    Create STL File Dialog Box .......................................... 1038
STRETCH ..................................................................... 1038
STYLE ......................................................................... 1040
    Text Style Dialog Box ................................................. 1041
    -STYLE ................................................................. 1044
STYLES MANAGER .......................................................... 1045
SUBTRACT ................................................................. 1045
SURFBLEND ............................................................... 1047
SURFEXTEND .............................................................. 1049
SURFEXTRACTCURVE .................................................... 1050
SURFFILLET ............................................................... 1051
SURFNETWORK ........................................................... 1053
SURFOFFSET .............................................................. 1054
SURFPATCH ............................................................... 1056
SURFSCULPT .............................................................. 1058
SURFTRIM ................................................................. 1059
SURFUNTRIM ............................................................. 1061
Sweep ......................................................................... 1062
T Commands ........................................................................ 1064
TABLE ............................................................................. 1064
    Manage Cell Content Dialog Box .................................. 1065
    Table Cell Format Dialog Box .................................... 1067
<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drawing Units Dialog Box</td>
<td>1131</td>
</tr>
<tr>
<td>-UNITS</td>
<td>1134</td>
</tr>
<tr>
<td>UPDATEFIELD</td>
<td>1135</td>
</tr>
<tr>
<td>UPDATETHUMBSNOW</td>
<td>1135</td>
</tr>
<tr>
<td>UPLOADTOWS</td>
<td>1136</td>
</tr>
<tr>
<td>Login to AutoCAD WS Dialog Box</td>
<td>1137</td>
</tr>
<tr>
<td>Upload Complete Dialog Box</td>
<td>1138</td>
</tr>
<tr>
<td>V Commands</td>
<td>1139</td>
</tr>
<tr>
<td>VIEW</td>
<td>1139</td>
</tr>
<tr>
<td>-VIEW</td>
<td>1139</td>
</tr>
<tr>
<td>VIEWPLOTTDETAILS</td>
<td>1141</td>
</tr>
<tr>
<td>Print Details Dialog Box</td>
<td>1141</td>
</tr>
<tr>
<td>VIEWRES</td>
<td>1143</td>
</tr>
<tr>
<td>VISUALSTYLES (-VISUALSTYLES)</td>
<td>1144</td>
</tr>
<tr>
<td>VPCLIP</td>
<td>1144</td>
</tr>
<tr>
<td>VPLAYER</td>
<td>1145</td>
</tr>
<tr>
<td>VPMAX</td>
<td>1148</td>
</tr>
<tr>
<td>VPMIN</td>
<td>1148</td>
</tr>
<tr>
<td>VPOINT</td>
<td>1149</td>
</tr>
<tr>
<td>VPORTS</td>
<td>1151</td>
</tr>
<tr>
<td>Viewports Dialog Box</td>
<td>1151</td>
</tr>
<tr>
<td>-VPORTS</td>
<td>1154</td>
</tr>
<tr>
<td>VSCURRENT</td>
<td>1158</td>
</tr>
<tr>
<td>VSAVE</td>
<td>1160</td>
</tr>
<tr>
<td>W Commands</td>
<td>1160</td>
</tr>
<tr>
<td>WBLOCK</td>
<td>1160</td>
</tr>
<tr>
<td>Write Block Dialog Box</td>
<td>1161</td>
</tr>
<tr>
<td>-WBLOCK</td>
<td>1163</td>
</tr>
<tr>
<td>WEBLIGHT</td>
<td>1164</td>
</tr>
<tr>
<td>WEDGE</td>
<td>1167</td>
</tr>
<tr>
<td>WHOHAS</td>
<td>1170</td>
</tr>
<tr>
<td>WIPEOUT</td>
<td>1170</td>
</tr>
<tr>
<td>X Commands</td>
<td>1172</td>
</tr>
<tr>
<td>XATTACH</td>
<td>1172</td>
</tr>
<tr>
<td>Attach External Reference Dialog Box</td>
<td>1172</td>
</tr>
<tr>
<td>External Reference Visor</td>
<td>1175</td>
</tr>
<tr>
<td>XBIND</td>
<td>1176</td>
</tr>
<tr>
<td>Bind External Definitions Dialog Box</td>
<td>1176</td>
</tr>
<tr>
<td>-XBIND</td>
<td>1178</td>
</tr>
<tr>
<td>XCLIP</td>
<td>1178</td>
</tr>
<tr>
<td>XEDGES</td>
<td>1180</td>
</tr>
<tr>
<td>XLINE</td>
<td>1181</td>
</tr>
<tr>
<td>XOPEN</td>
<td>1184</td>
</tr>
<tr>
<td>XPLODE</td>
<td>1184</td>
</tr>
<tr>
<td>XREF</td>
<td>1186</td>
</tr>
<tr>
<td>-XREF</td>
<td>1186</td>
</tr>
</tbody>
</table>
Chapter 3 Command Modifiers

Overview of Command Modifiers
Coordinate Filters (Command Modifier)
Direct Distance Entry (Command Modifier)
FROM (Command Modifier)
MTP (Command Modifier)
TRACKING (Command Modifier)
Object Snaps (Command Modifier)
Selection Modes (Command Modifier)

Chapter 4 System Variables

Overview of System Variables
3D System Variables
3DOSMODE
3DSELECTIONMODE
A System Variables
ACADLSPASDOC
ACADPREFIX
ACADVER
ACISOUTVER
AFLAGS
ANGBASE
ANGDIR
ANNOALLVISIBLE
ANNOAUTOSCALE
ANNOMONITOR
ANNOTAtivedwg
APBOX
APERTURE
APPAUTOLOAD
AREA
ARRAYASSOCIATIVITY
ARRAYEDITSTATE
ARRAYTYPE
ATTDIR
ATTipe
ATTMODE
ATTMULTI
ATTreQ
AUDITCTL
AUNITS
<table>
<thead>
<tr>
<th>Variable</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUPREC</td>
<td>1215</td>
</tr>
<tr>
<td>AUTOCOMPLETEDELAY</td>
<td>1216</td>
</tr>
<tr>
<td>AUTOCOMPLETEMODE</td>
<td>1216</td>
</tr>
<tr>
<td>AUTOSNAP</td>
<td>1217</td>
</tr>
<tr>
<td>B System Variables</td>
<td>1218</td>
</tr>
<tr>
<td>BACKZ</td>
<td>1218</td>
</tr>
<tr>
<td>BINDTYPE</td>
<td>1218</td>
</tr>
<tr>
<td>BLIPMODE</td>
<td>1219</td>
</tr>
<tr>
<td>BLOCKEDITLOCK</td>
<td>1219</td>
</tr>
<tr>
<td>BLOCKEDITOR</td>
<td>1220</td>
</tr>
<tr>
<td>BTMARKDISPLAY</td>
<td>1220</td>
</tr>
<tr>
<td>C System Variables</td>
<td>1221</td>
</tr>
<tr>
<td>CACHEMAXFILES</td>
<td>1221</td>
</tr>
<tr>
<td>CACHEMAXTOTALSIZE</td>
<td>1221</td>
</tr>
<tr>
<td>CAMERADISPLAY</td>
<td>1222</td>
</tr>
<tr>
<td>CANNOSCALE</td>
<td>1222</td>
</tr>
<tr>
<td>CANNOSCALEVALUE</td>
<td>1222</td>
</tr>
<tr>
<td>CCONSTRAINTFORM</td>
<td>1223</td>
</tr>
<tr>
<td>CDATE</td>
<td>1223</td>
</tr>
<tr>
<td>CECOLOR</td>
<td>1224</td>
</tr>
<tr>
<td>CELSCALE</td>
<td>1224</td>
</tr>
<tr>
<td>CELTYPE</td>
<td>1224</td>
</tr>
<tr>
<td>CELWEIGHT</td>
<td>1225</td>
</tr>
<tr>
<td>CENTERMT</td>
<td>1225</td>
</tr>
<tr>
<td>CETRANSPARENCY</td>
<td>1226</td>
</tr>
<tr>
<td>CHAMFERA</td>
<td>1226</td>
</tr>
<tr>
<td>CHAMFEBR</td>
<td>1227</td>
</tr>
<tr>
<td>CHAMFERC</td>
<td>1227</td>
</tr>
<tr>
<td>CHAMFERD</td>
<td>1227</td>
</tr>
<tr>
<td>CHAMMODE</td>
<td>1228</td>
</tr>
<tr>
<td>CIRCLERAD</td>
<td>1228</td>
</tr>
<tr>
<td>CLASSICKEYS</td>
<td>1229</td>
</tr>
<tr>
<td>CLAYER</td>
<td>1229</td>
</tr>
<tr>
<td>CLEANSCREENSTATE</td>
<td>1229</td>
</tr>
<tr>
<td>CLISTATE</td>
<td>1230</td>
</tr>
<tr>
<td>CMATERIAL</td>
<td>1230</td>
</tr>
<tr>
<td>CMDACTIVE</td>
<td>1230</td>
</tr>
<tr>
<td>CMDDIA</td>
<td>1231</td>
</tr>
<tr>
<td>CMDECHO</td>
<td>1232</td>
</tr>
<tr>
<td>CMDINPUPTHISTORYMAX</td>
<td>1232</td>
</tr>
<tr>
<td>CMDNAMES</td>
<td>1232</td>
</tr>
<tr>
<td>CMLEADERSTYLE</td>
<td>1233</td>
</tr>
<tr>
<td>CMJUST</td>
<td>1233</td>
</tr>
<tr>
<td>CMLSCALE</td>
<td>1234</td>
</tr>
<tr>
<td>CMLSTYLE</td>
<td>1234</td>
</tr>
<tr>
<td>COLORSHEME</td>
<td>1234</td>
</tr>
<tr>
<td>Variables</td>
<td>Page</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------</td>
</tr>
<tr>
<td>COMPASS</td>
<td>1235</td>
</tr>
<tr>
<td>CONSTRAINTBARDISPLAY</td>
<td>1235</td>
</tr>
<tr>
<td>CONSTRAINTBARMODE</td>
<td>1236</td>
</tr>
<tr>
<td>CONSTRAINTINFERENCE</td>
<td>1237</td>
</tr>
<tr>
<td>CONSTRAINTNAMEFORMAT</td>
<td>1238</td>
</tr>
<tr>
<td>CONSTRAINTRELAX</td>
<td>1238</td>
</tr>
<tr>
<td>CONSTRAINTSOLVEMODE</td>
<td>1239</td>
</tr>
<tr>
<td>CONTENTSTATE</td>
<td>1239</td>
</tr>
<tr>
<td>COPYMODE</td>
<td>1240</td>
</tr>
<tr>
<td>CPLOTSTYLE</td>
<td>1240</td>
</tr>
<tr>
<td>PROFILE</td>
<td>1241</td>
</tr>
<tr>
<td>CROSSINGAREACOLOR</td>
<td>1241</td>
</tr>
<tr>
<td>CSHADOW</td>
<td>1241</td>
</tr>
<tr>
<td>CTAB</td>
<td>1242</td>
</tr>
<tr>
<td>CTABLESTYLE</td>
<td>1242</td>
</tr>
<tr>
<td>CULLINGOBJ</td>
<td>1242</td>
</tr>
<tr>
<td>CULLINGOBJSELECTION</td>
<td>1243</td>
</tr>
<tr>
<td>CURSORSIZE</td>
<td>1244</td>
</tr>
<tr>
<td>CVPORT</td>
<td>1244</td>
</tr>
<tr>
<td>D System Variables</td>
<td>1245</td>
</tr>
<tr>
<td>DATE</td>
<td>1245</td>
</tr>
<tr>
<td>DBLCLKEDIT</td>
<td>1245</td>
</tr>
<tr>
<td>DBMOD</td>
<td>1246</td>
</tr>
<tr>
<td>DEFAULTGIZMO</td>
<td>1247</td>
</tr>
<tr>
<td>DEFAULTLIGHTING</td>
<td>1249</td>
</tr>
<tr>
<td>DEFAULTLIGHTINGTYPE</td>
<td>1249</td>
</tr>
<tr>
<td>DEFPLSTYLE</td>
<td>1250</td>
</tr>
<tr>
<td>DEFPLSTYLE</td>
<td>1250</td>
</tr>
<tr>
<td>DELOBJ</td>
<td>1251</td>
</tr>
<tr>
<td>DEMANDLOAD</td>
<td>1252</td>
</tr>
<tr>
<td>DIASTAT</td>
<td>1253</td>
</tr>
<tr>
<td>DIMADEC</td>
<td>1254</td>
</tr>
<tr>
<td>DIMALT</td>
<td>1254</td>
</tr>
<tr>
<td>DIMALTD</td>
<td>1254</td>
</tr>
<tr>
<td>DIMALTF</td>
<td>1255</td>
</tr>
<tr>
<td>DIMALTRND</td>
<td>1255</td>
</tr>
<tr>
<td>DIMALTTD</td>
<td>1256</td>
</tr>
<tr>
<td>DIMALTZ</td>
<td>1256</td>
</tr>
<tr>
<td>DIMALTU</td>
<td>1257</td>
</tr>
<tr>
<td>DIMALTZ</td>
<td>1257</td>
</tr>
<tr>
<td>DIMANNO</td>
<td>1258</td>
</tr>
<tr>
<td>DIMALPOST</td>
<td>1259</td>
</tr>
<tr>
<td>DIMARCSYM</td>
<td>1259</td>
</tr>
<tr>
<td>DIMASSOC</td>
<td>1260</td>
</tr>
<tr>
<td>DIMASZ</td>
<td>1260</td>
</tr>
<tr>
<td>DIMATFIT</td>
<td>1261</td>
</tr>
<tr>
<td>DIMTIH</td>
<td>1283</td>
</tr>
<tr>
<td>----------------------------</td>
<td>------</td>
</tr>
<tr>
<td>DIMTIX</td>
<td>1284</td>
</tr>
<tr>
<td>DIMTM</td>
<td>1284</td>
</tr>
<tr>
<td>DIMTMOVE</td>
<td>1285</td>
</tr>
<tr>
<td>DIMTOFL</td>
<td>1285</td>
</tr>
<tr>
<td>DIMTOH</td>
<td>1286</td>
</tr>
<tr>
<td>DIMTOL</td>
<td>1286</td>
</tr>
<tr>
<td>DIMTOLJ</td>
<td>1287</td>
</tr>
<tr>
<td>DIMP</td>
<td>1287</td>
</tr>
<tr>
<td>DMTSZ</td>
<td>1288</td>
</tr>
<tr>
<td>DMTVP</td>
<td>1288</td>
</tr>
<tr>
<td>DMTXSTY</td>
<td>1289</td>
</tr>
<tr>
<td>DMTXT</td>
<td>1289</td>
</tr>
<tr>
<td>DMTXTDIRECTION</td>
<td>1289</td>
</tr>
<tr>
<td>DMTZIN</td>
<td>1290</td>
</tr>
<tr>
<td>DIMUPT</td>
<td>1290</td>
</tr>
<tr>
<td>DIMZIN</td>
<td>1291</td>
</tr>
<tr>
<td>DISPLAYVIEWCUBEIN2D</td>
<td>1292</td>
</tr>
<tr>
<td>DISPLAYVIEWCUBEIN3D</td>
<td>1292</td>
</tr>
<tr>
<td>DIPSILH</td>
<td>1293</td>
</tr>
<tr>
<td>DISTANCE</td>
<td>1293</td>
</tr>
<tr>
<td>DIVMESHBOXHEIGHT</td>
<td>1293</td>
</tr>
<tr>
<td>DIVMESHBOXLENGTH</td>
<td>1294</td>
</tr>
<tr>
<td>DIVMESHBOXWIDTH</td>
<td>1295</td>
</tr>
<tr>
<td>DIVMESHCONEAXIS</td>
<td>1295</td>
</tr>
<tr>
<td>DIVMESHCONEBASE</td>
<td>1296</td>
</tr>
<tr>
<td>DIVMESHCONEHEIGHT</td>
<td>1297</td>
</tr>
<tr>
<td>DIVMESHCYLAXIS</td>
<td>1298</td>
</tr>
<tr>
<td>DIVMESHCYLBASE</td>
<td>1299</td>
</tr>
<tr>
<td>DIVMESHCYLHEIGHT</td>
<td>1300</td>
</tr>
<tr>
<td>DIVMESHPYRBASE</td>
<td>1300</td>
</tr>
<tr>
<td>DIVMESHPYRHEIGHT</td>
<td>1301</td>
</tr>
<tr>
<td>DIVMESHPYRLENGTH</td>
<td>1302</td>
</tr>
<tr>
<td>DIVMESHSPHEREAXIS</td>
<td>1302</td>
</tr>
<tr>
<td>DIVMESHSPHEREHEIGHT</td>
<td>1303</td>
</tr>
<tr>
<td>DIVMESHTORUSPATH</td>
<td>1304</td>
</tr>
<tr>
<td>DIVMESHTORUSSECTION</td>
<td>1304</td>
</tr>
<tr>
<td>DIVMESHWEDGEBASE</td>
<td>1305</td>
</tr>
<tr>
<td>DIVMESHWEDGEHEIGHT</td>
<td>1306</td>
</tr>
<tr>
<td>DIVMESHWEDGELENGTH</td>
<td>1306</td>
</tr>
<tr>
<td>DIVMESHWEDGESLOPE</td>
<td>1307</td>
</tr>
<tr>
<td>DIVMESHWEDGEWIDTH</td>
<td>1308</td>
</tr>
<tr>
<td>DONUTID</td>
<td>1308</td>
</tr>
<tr>
<td>DONUTOD</td>
<td>1309</td>
</tr>
<tr>
<td>DRAGMODE</td>
<td>1309</td>
</tr>
<tr>
<td>DRAGP1</td>
<td>1310</td>
</tr>
<tr>
<td>Variable</td>
<td>Page</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>DRAGP2</td>
<td>1310</td>
</tr>
<tr>
<td>DRAGVS</td>
<td>1311</td>
</tr>
<tr>
<td>DRAWORDERCTL</td>
<td>1311</td>
</tr>
<tr>
<td>DRSTATE</td>
<td>1312</td>
</tr>
<tr>
<td>DTEXTED</td>
<td>1312</td>
</tr>
<tr>
<td>DWGCHECK</td>
<td>1313</td>
</tr>
<tr>
<td>DWGCODEPAGE</td>
<td>1313</td>
</tr>
<tr>
<td>DWGNAME</td>
<td>1314</td>
</tr>
<tr>
<td>DWGPREFIX</td>
<td>1314</td>
</tr>
<tr>
<td>DWGTITLE</td>
<td>1314</td>
</tr>
<tr>
<td>DYNCONSTRAINTMODE</td>
<td>1315</td>
</tr>
<tr>
<td>DYNCONSTRAINTMODE</td>
<td>1315</td>
</tr>
<tr>
<td>DYNDIVIS</td>
<td>1316</td>
</tr>
<tr>
<td>DYNINFOTIPS</td>
<td>1317</td>
</tr>
<tr>
<td>DYNMODE</td>
<td>1317</td>
</tr>
<tr>
<td>DYNPCOORDS</td>
<td>1318</td>
</tr>
<tr>
<td>DYNPIFORMAT</td>
<td>1319</td>
</tr>
<tr>
<td>DYNPIVIS</td>
<td>1319</td>
</tr>
<tr>
<td>DYNPROMPT</td>
<td>1320</td>
</tr>
<tr>
<td>DYNTOOLTIPS</td>
<td>1320</td>
</tr>
<tr>
<td>E System Variables</td>
<td></td>
</tr>
<tr>
<td>E System Variables</td>
<td></td>
</tr>
<tr>
<td>EDGE MODE</td>
<td>1321</td>
</tr>
<tr>
<td>ELEVATION</td>
<td>1321</td>
</tr>
<tr>
<td>ERHIGHLIGHT</td>
<td>1322</td>
</tr>
<tr>
<td>ERRNO</td>
<td>1322</td>
</tr>
<tr>
<td>ERSTATE</td>
<td>1323</td>
</tr>
<tr>
<td>EXPERT</td>
<td>1323</td>
</tr>
<tr>
<td>EXPLMODE</td>
<td>1324</td>
</tr>
<tr>
<td>EXTMAX</td>
<td>1325</td>
</tr>
<tr>
<td>EXTMIN</td>
<td>1325</td>
</tr>
<tr>
<td>EXTNAMES</td>
<td>1325</td>
</tr>
<tr>
<td>Ex System Variables</td>
<td></td>
</tr>
<tr>
<td>Ex System Variables</td>
<td></td>
</tr>
<tr>
<td>FACETERDEVNORMAL</td>
<td>1326</td>
</tr>
<tr>
<td>FACETERDEVSURFACE</td>
<td>1326</td>
</tr>
<tr>
<td>FACETERGRIDRATIO</td>
<td>1327</td>
</tr>
<tr>
<td>FACETERMAXEDGELENGTH</td>
<td>1327</td>
</tr>
<tr>
<td>FACETERMAXGRID</td>
<td>1328</td>
</tr>
<tr>
<td>FACETERMESHTYPE</td>
<td>1329</td>
</tr>
<tr>
<td>FACETERMINUGRID</td>
<td>1330</td>
</tr>
<tr>
<td>FACETERMINVGRID</td>
<td>1330</td>
</tr>
<tr>
<td>FACETERPRIMITIVEMODE</td>
<td>1331</td>
</tr>
<tr>
<td>FACETERSMOOTHLEV</td>
<td>1331</td>
</tr>
<tr>
<td>FACETRATIO</td>
<td>1332</td>
</tr>
<tr>
<td>FACETRES</td>
<td>1333</td>
</tr>
<tr>
<td>FIELDDISPLAY</td>
<td>1333</td>
</tr>
<tr>
<td>FIELDEVAL</td>
<td>1334</td>
</tr>
</tbody>
</table>
INTERFEREVPS .................................................. 1379
INTERSECTIONCOLOR ........................................... 1380
INTERSECTIONDISPLAY .......................................... 1380
SAVEBAK ................................................................ 1380
SAVEPERCENT ......................................................... 1381
ISOLINES ............................................................... 1381
L System Variables .................................................. 1382
LARGEOBJECTSUPPORT ............................................. 1382
LASTANGLE ............................................................ 1382
LASTPOINT ................................................................ 1383
LASTPROMPT .......................................................... 1383
LATITUDE ................................................................ 1383
LAYERMANAGERSTATE ............................................... 1386
LAYERNOTIFY .......................................................... 1386
LAYLOCKFADECTL ..................................................... 1387
LAYOUTCREATEVIEWPORT .......................................... 1388
LAYOUTREGENCTL ..................................................... 1389
LEGACYCTRLPICK ...................................................... 1390
LIMCHECK ................................................................ 1392
LIMMAX .................................................................. 1392
LIMMIN .................................................................. 1392
LINEARBRIGHTNESS .................................................. 1393
LINEARCHART ............................................................. 1393
LOCALROOTPREFIX ...................................................... 1395
LOFTANG1 ................................................................. 1395
LOFTANG2 ................................................................. 1396
LOFTMAG1 ................................................................. 1396
LOFTMAG2 ................................................................. 1396
LOFTNORMALS ............................................................ 1397
LOFTPARAM ............................................................... 1397
LOGEXPBRIGHTNESS ............................................... 1398
LOGEXPCONTRAST ..................................................... 1398
LOGEXPDAYLIGHT ...................................................... 1399
LOGEXPMPIDTONES ................................................... 1399
LOGEXPMPHYSICALSCALE ........................................ 1400
LOGFILEMODE .......................................................... 1400
LOGFILENAME .......................................................... 1401
LOGFILEPATH ........................................................... 1401
LOGINNAME ................................................................. 1401
LONGITUDE ................................................................. 1402
LTSCALE ................................................................. 1402
LUNITS ................................................................. 1403
LUPREC ................................................................. 1403
LWDEFAULT ................................................................. 1404
LWDISPLAY ................................................................. 1404
LWUNITS ................................................................. 1404

M System Variables ......................................................... 1405
MATBROWSERSTATE ........................................................ 1405
MAXACTVP ................................................................. 1405
MAXSORT ................................................................. 1406
MBUTTONPAN ................................................................. 1406
MEASUREINIT ................................................................. 1407
MEASUREMENT ................................................................. 1407
MENUECHO ................................................................. 1408
MENUNAME ................................................................. 1408
MESHTYPE ................................................................. 1408
MIRRHATCH ................................................................. 1409
MIRRTEXT ................................................................. 1409
MLEADERSCALE ............................................................... 1410
MSLTSCALE ................................................................. 1411
MTEXTCOLUMN ................................................................. 1411
MTEXTFIXED ................................................................. 1412
MTJIGSTRING ................................................................. 1412
MYDOCUMENTSPREFIX ...................................................... 1413

N System Variables ......................................................... 1413
NAVVCUBEDISPLAY ........................................................ 1413
NAVVCUBELOCATION ...................................................... 1414
NAVVCUBEOPACITY ........................................................ 1414
NAVVCUBEORIENT .......................................................... 1415
NAVVCUBESIZE .............................................................. 1415
NOMUTT ................................................................. 1416
NORTHDIRECTION .......................................................... 1416

O System Variables ......................................................... 1417
OBJECTISOLATIONMODE .................................................... 1417
OBSCURED COLOR .......................................................... 1417
OBSCURED LT TYPE ........................................................... 1418
OFFSETDIST .............................................................. 1419
OFFSET GAP TYPE .......................................................... 1420
OPMSTATE ................................................................. 1420
ORTHOMODE ............................................................... 1421
OSMODE ................................................................. 1421
OSNAPCOORD .............................................................. 1422
OSNAPNODELEGACY .......................................................... 1423
OSNAPZ ................................................................. 1423

Contents | xxix
SELECTIONAREAOPACITY ........................................... 1467
SELECTIONCYCLING .................................................. 1467
SELECTIONPREVIEW .................................................. 1467
SELECTIONPREVIEWLIMIT .......................................... 1468
SELECTSIMILARMODE ................................................ 1468
SHADEDGE ............................................................ 1469
SHADEDIFF ........................................................... 1470
SHADOWPLANELLOCATION .......................................... 1470
SHORTCUTMENU ...................................................... 1471
SHORTCUTMENUDURATION .......................................... 1471
SHOWALLUSEDLAYERSGROUP ....................................... 1472
SHOWEMPTYGROUPS ................................................. 1472
SHOWGROUPS ........................................................ 1473
SHOWHIST ............................................................ 1473
SHOWPAGESETUPFORNEWLAYOUTS .............................. 1474
SHOWPALETTESTATE ................................................ 1474
SHOWUNRECONCILEDLAYERSGROUP ............................. 1475
SHOWVPOVERRIDESGROUP ......................................... 1475
SHOWXREFGROUPS ................................................... 1476
SHOWXREFLAYERS .................................................... 1476
SHPNAME ............................................................. 1477
SIGWARN ............................................................... 1477
SKETCHINC ........................................................... 1477
SKPOLY ................................................................. 1478
SKTOLERANCE ......................................................... 1478
SKYSTATUS ........................................................... 1478
SMOOTHMESHCONVERT .............................................. 1479
SMOOTHMESHGRID ................................................... 1480
SMOOTHMESHMAXFACE .............................................. 1480
SMOOTHMESHMAXLEV ............................................... 1481
SNAPANG .............................................................. 1481
SNAPBASE ............................................................. 1482
SNAPGRIDLEGACY ................................................... 1482
SNAPISOPAIR ........................................................ 1482
SNAPMODE ............................................................ 1483
SNAPSTYL ............................................................. 1483
SNAPTYPE ............................................................. 1484
SNAPUNIT ............................................................. 1484
SOLIDCHECK .......................................................... 1485
SOLIDHIST ............................................................ 1485
SORTENTS ............................................................. 1486
SPACEPAN ............................................................. 1486
SPACEPANTIMEOUT .................................................. 1487
SPLDEGREE ........................................................... 1487
SPLFRAME ............................................................. 1488
SPLINESEGS .......................................................... 1488
SPLINTYPE ................................................. 1489
SPLKNOTS ................................................. 1489
SPLMETHOD .............................................. 1490
SPLPERIODIC ............................................. 1490
SSFOUND ................................................. 1491
SSLOCATE ............................................... 1491
SSMAUTOOPEN .......................................... 1492
SSMPOLLTIME ............................................ 1492
SSMSHEETSTATUS ....................................... 1492
SSMSTATE ................................................ 1493
STATUSBAR .............................................. 1493
SUBOBJSELECTIONMODE ................................. 1494
SUNSTATUS .............................................. 1497
SUPPRESSALERTS ........................................ 1497
SURFACEASSOCIATIVITY ............................... 1498
SURFACEASSOCIATIVITYDRAG ......................... 1499
SURFACEAUTOTRIM ..................................... 1499
SURFACEMODELINGMODE ............................... 1500
SURFTAB1 ............................................... 1500
SURFTAB2 ............................................... 1500
SURFTYPE ................................................. 1501
SURFU .................................................... 1501
SURFV .................................................... 1502
SYSCODEPAGE .......................................... 1502
T System Variables .................................... 1502
TABLEINDICATOR ......................................... 1502
TARGET .................................................. 1503
TBSHOWSHORTCUTS ..................................... 1503
TDCREATE ............................................... 1504
TDINDWG ............................................... 1504
TDUCREATE .............................................. 1504
TDUPDATE ............................................... 1505
TDUSRTIMER ............................................ 1505
TDUUPDATE ............................................. 1505
TEMPOVERRIDES ....................................... 1506
TEMPPREFIX ............................................. 1506
TEXTED .................................................. 1507
TEXTEVAL ................................................ 1507
TEXTFILL ............................................... 1508
TEXTOUTPUTFILEFORMAT .............................. 1508
TEXTQLTY ............................................... 1509
TEXTSIZE ............................................... 1509
TEXTSTYLE ............................................. 1509
THICKNESS .............................................. 1510
THUMBSAVE ............................................. 1510
THUMBSIZE ............................................. 1510
<table>
<thead>
<tr>
<th>Variable</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>TILEMODE</td>
<td>1511</td>
</tr>
<tr>
<td>TIMEZONE</td>
<td>1512</td>
</tr>
<tr>
<td>TOOLSETSSTATE</td>
<td>1516</td>
</tr>
<tr>
<td>TOOLTIPMERGE</td>
<td>1517</td>
</tr>
<tr>
<td>TOOLTIPSIZE</td>
<td>1517</td>
</tr>
<tr>
<td>TOOLTIPTRANSPARENCY</td>
<td>1518</td>
</tr>
<tr>
<td>TRACKPATH</td>
<td>1518</td>
</tr>
<tr>
<td>TRANSPARENCYDISPLAY</td>
<td>1519</td>
</tr>
<tr>
<td>TREEDEPTH</td>
<td>1519</td>
</tr>
<tr>
<td>TREEMAX</td>
<td>1520</td>
</tr>
<tr>
<td>TRIMMODE</td>
<td>1521</td>
</tr>
<tr>
<td>TSPACEFAC</td>
<td>1521</td>
</tr>
<tr>
<td>TSPACETYPE</td>
<td>1521</td>
</tr>
<tr>
<td>TSTACKALIGN</td>
<td>1522</td>
</tr>
<tr>
<td>TSTACKSIZE</td>
<td>1522</td>
</tr>
<tr>
<td>U System Variables</td>
<td></td>
</tr>
<tr>
<td>UCS2DDISPLAYSETTING</td>
<td>1523</td>
</tr>
<tr>
<td>UCS3DPARADISPLAYSETTING</td>
<td>1523</td>
</tr>
<tr>
<td>UCS3DPERPDISPLAYSETTING</td>
<td>1524</td>
</tr>
<tr>
<td>UCSAXISANG</td>
<td>1524</td>
</tr>
<tr>
<td>UCSBASE</td>
<td>1525</td>
</tr>
<tr>
<td>UCSDETECT</td>
<td>1525</td>
</tr>
<tr>
<td>UCSFOLLOW</td>
<td>1526</td>
</tr>
<tr>
<td>UCSICON</td>
<td>1526</td>
</tr>
<tr>
<td>UCSNAME</td>
<td>1527</td>
</tr>
<tr>
<td>UCSORG</td>
<td>1527</td>
</tr>
<tr>
<td>UCSORTHO</td>
<td>1528</td>
</tr>
<tr>
<td>UCSSELECTMODE</td>
<td>1528</td>
</tr>
<tr>
<td>UCSVIEW</td>
<td>1529</td>
</tr>
<tr>
<td>UCSVP</td>
<td>1529</td>
</tr>
<tr>
<td>UCSXDIR</td>
<td>1529</td>
</tr>
<tr>
<td>UCSYDIR</td>
<td>1530</td>
</tr>
<tr>
<td>UNDOCTL</td>
<td>1530</td>
</tr>
<tr>
<td>UNDOMARKS</td>
<td>1531</td>
</tr>
<tr>
<td>UNITMODE</td>
<td>1531</td>
</tr>
<tr>
<td>UOSNAP</td>
<td>1532</td>
</tr>
<tr>
<td>UPDATETHUMBNAIL</td>
<td>1533</td>
</tr>
<tr>
<td>USER1-5</td>
<td>1533</td>
</tr>
<tr>
<td>USERR1-5</td>
<td>1534</td>
</tr>
<tr>
<td>USERS1-5</td>
<td>1534</td>
</tr>
<tr>
<td>V System Variables</td>
<td></td>
</tr>
<tr>
<td>VIEWCTR</td>
<td>1534</td>
</tr>
<tr>
<td>VIEWDIR</td>
<td>1534</td>
</tr>
<tr>
<td>VIEWMODE</td>
<td>1535</td>
</tr>
<tr>
<td>VIEWMODE</td>
<td>1535</td>
</tr>
<tr>
<td>VIEWSIZE</td>
<td>1536</td>
</tr>
<tr>
<td>VIEWTWIST</td>
<td>1536</td>
</tr>
</tbody>
</table>
VISRETAIN .................................................. 1537
VPCONTROL .................................................. 1537
VPCOORDDISPLAY ........................................... 1538
VPLAYEROVERRIDES ......................................... 1538
VPLAYEROVERRIDESMODE ..................................... 1539
VMAXIMIZEDSTATE ........................................... 1539
VPROTATEASSOC ............................................. 1540
VSACURVATUREHIGH ......................................... 1540
VSACURVATURELOW ......................................... 1541
VSACURVATURETYPE ......................................... 1541
VSADRAFTANGLEHIGH ......................................... 1542
VSADRAFTANGLELOW ......................................... 1542
VSAZEBRACOLOR1 ............................................. 1543
VSAZEBRACOLOR2 ............................................. 1543
VSAZEBRADIRECTION .......................................... 1544
VSAZEBRASIZE ................................................ 1544
VSAZEBRATYPE ............................................... 1545
VSBACKGROUNDS .............................................. 1545
VSEDGECOLOR ............................................... 1546
VSEDGEJITTER ................................................ 1546
VSEDGELEX .................................................... 1547
VSEDGEOVERHANG ............................................ 1548
VSEDGES ...................................................... 1548
VSEDGESMOOTH ............................................... 1550
VSFACECOLORMODE ........................................... 1550
VSFACEHIGHLIGHT ............................................ 1551
VSFACEOPACITY ............................................... 1551
VSFACESTYLE .................................................. 1552
VSHALOGAP .................................................... 1553
VSHIDEPRECISION ............................................. 1553
VSINTERSECTIONCOLOR ....................................... 1554
VSINTERSECTIONEDGES ....................................... 1554
VSINTERSECTIONTYPE ........................................ 1555
VSISOONTOP ................................................... 1556
VSLIGHTINGQUALITY ......................................... 1556
VSMATERIALMODE ............................................ 1557
VSMAX ......................................................... 1558
VSMIN ........................................................ 1558
VSMONOCOLOR ............................................... 1558
VSOBSCUREDCOLOR .......................................... 1559
VSOBSCUREDEDMATERIAL .................................... 1559
VSOBSCUREDTYPE ............................................. 1560
VSOCCCLUDEDCOLOR ......................................... 1562
VSOCCCLUDEDMATERIAL ....................................... 1563
VSOCCCLUDEDTYPE ............................................ 1563
VSSHADOWS .................................................... 1565
VSSILHEDGES ........................................ 1566
VSSILHWIDTH ........................................ 1567
VTDURATION .......................................... 1568
VTENABLE ........................................... 1568
VTFPS .................................................. 1569
W System Variables .................................. 1569
WHIPARC ............................................. 1569
WINDOWWAREACOLOR ................................ 1570
WIPEOUTFRAME ...................................... 1570
WORLDCS ............................................. 1571
WORLDVIEW .......................................... 1571
WRITESTAT ........................................... 1572
X System Variables .................................. 1572
XCLIPFRAME ......................................... 1572
XDWGFADECTL ...................................... 1573
XEDIT .................................................. 1573
XFADECTL ............................................ 1574
XLOADCTL ............................................ 1574
XLOADPATH .......................................... 1575
XREFCTL ............................................. 1575
XREFNOTIFY ......................................... 1576
XREFSTATE ........................................... 1576
XREFTYPE ............................................. 1577
Z System Variables .................................. 1577
ZOOMFACTOR ........................................ 1577
ZOOMFACTOR ........................................ 1577
ZOOMWHEEL .......................................... 1577

Index .................................................... 1579
Introduction

The Command Reference, a comprehensive guide to AutoCAD® commands, lists all AutoCAD commands in alphabetical order.

In addition to the command listings, the Command Reference covers several topics in the appendixes: command aliases, system variables, dimension variables, utilities, standard libraries, graphical database objects, and Unicode fonts.

Using AutoCAD Documentation

In addition to this Command Reference, several other resources are available to help you learn and use AutoCAD. The complete documentation set for AutoCAD is online. You can access it from the Help menu.

NOTE For the latest documentation corrections and additions, refer to the Readme file.

Using This Reference

The Command Reference provides detailed information on all commands, command options, and system variables. The explanations reflect the default AutoCAD system variable settings and the default prototype drawing. If you change system variable settings, the prompts on your screen might differ from what you see here. For example, the setting of the FILEDIA (page 1334) system
variable governs whether you work in a dialog box or at the command prompt when you use certain commands. See appendix B, “System Variables”.

**Executing Commands**

The process of executing a command begins by starting the command, using one of several methods. For some commands, such as **REGEN** (page 889), no further action is required. For other commands, you must respond by providing additional information or actions in order to complete the command.

As you work with commands, note that right-clicking in the drawing area either acts as Enter or displays a shortcut menu. You can control this behavior in the Application Preferences dialog box or with the **SHORTCUTMENU** (page 1471) system variable.

**Starting Commands**

You can start a command by doing one of the following:

- Select the command from a menu, tool set, status bar, or shortcut menu.
- Enter the command name or command alias at the Command prompt and press ENTER or SPACEBAR.

In this *Command Reference*, near the beginning of each command description is a command access section, listing the specific ways you can start that command. For example, following is the command access section for the **PAN** (page 767) command:

**Menu:** View ➤ Pan ➤ Realtime

**Toolbar:** Status bar

**Shortcut menu:** With no objects selected, right-click in the drawing area, and choose Pan.

**Command entry:** pan (or ‘pan for transparent use)

The availability of certain shortcut menus depends on the current setting of the **SHORTCUTMENU** (page 1471) system variable. The instructions in the command access sections assume that you have made the indicated menu available.

You can exit a command at any time by pressing ESC.
Using Transparent Commands

In many cases, you can start a command while using another command. The command you start is called a transparent command. For example, to turn on the grid while drawing a line, you can start the GRID (page 469) command transparently by preceding the command with an apostrophe. Two right angle brackets (>>) precede prompts for transparent commands.

Command: line
Specify first point: 'grid
>>Specify grid spacing(X) or
[ON/OFF/Snap/Major/Adaptive/Limit/Follow/Aspect] <current>:
on
Resuming LINE command
Specify first point:

In the Command Reference, the command access sections identify commands that you can use transparently.

Suppressing Dialog Boxes

Many commands provide both command prompt and dialog box interfaces. In most cases, when both a command prompt and dialog box interface are available, the command prompt version is preceded with a hyphen character. For example, the command prompt version of ATTDEF (page 112) is -ATTDEF.

You can also control the display of file dialog boxes through the FILEDIA (page 1334) system variable. See appendix B, “System Variables”.

Responding to Prompts

If a command does not immediately execute, AutoCAD either displays a dialog box or displays command prompts requesting more information. Command prompts are structured as follows:

Command: commandname
Current settings: Setting1 Setting2 Setting3
Instructional text [Option1/option2/option3/...] <default option or value>:

The optional current value line displays the current settings for the command or for system variables related to the command. The succeeding prompts identify the type of input required to complete the command and, when applicable, list the available options in straight brackets and a default option or value in angle brackets. In some cases, AutoCAD determines default options
and values based on the option or value that you last specified, or based on
the settings of certain system variables.

Typically, the first word of a prompt indicates the type of action you can take.
Most command prompts begin with the word `enter`, `select`, or `specify`. These
words indicate how you can respond to the prompt.

**Terminology in command prompts**

<table>
<thead>
<tr>
<th>If the prompt starts with...</th>
<th>You can...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select</td>
<td>Select objects on the screen using your pointing device.</td>
</tr>
<tr>
<td>Enter</td>
<td>Enter text at the command prompt.</td>
</tr>
<tr>
<td>Specify</td>
<td>Use your pointing device or enter text at the command prompt to select a point location on the screen.</td>
</tr>
</tbody>
</table>

**Selecting Options at the Command Prompt**

To select one of the options contained within the straight brackets, you can
enter the entire option name or only the capitalized letters, and then press
Enter or Spacebar. To select the default option enclosed in angle brackets (<>),
if available, press Enter or Spacebar.

You can also choose command options from a shortcut menu by right-clicking
in the drawing area while the command is active. The options available at the
command prompt appear in the shortcut menu. For information about how
to enable or disable this shortcut menu, see “Work with Shortcut Menus” in the
*User's Guide*.

**Entering Data at the Command Prompt**

Some prompts ask you to enter data, rather than (or as an alternative to)
choosing an option. To do so, enter the text at the command prompt and
press Enter or Spacebar. However, be aware that when the command prompt
requests an object name, Spacebar inserts a space at the command prompt
rather than acting as Enter. This allows for the support of extended symbol
names.

Just as default command options are often provided, prompts may include
default values, enclosed in angle brackets (<>), when data is requested. For
example, the POLYGON (page 832) command displays the following prompt, suggesting 4 as the number of sides for your polygon:

Command: **polygon**
Enter number of sides <4>:

To accept the default value, press Enter or Spacebar.

**Using Wild-Card Characters at the Command Prompt**

When the prompt directions ask for a name list, such as a block name, variable name, named view, and so on, you can use wild-card characters to specify names. See the table in “Group and Sort the List of Layers” in the *User's Guide*.

**Repeating Commands**

If no command is active, you can repeat the previous command by pressing Enter or Spacebar or by right-clicking in the drawing area and choosing the Repeat *Command Name* option from the shortcut menu.

**Accessing Recently Used Commands**

You can access the six most recently used commands from a shortcut menu by right-clicking in the command window and choosing Recent Commands.

**References to Other Sections**

At the end of most command descriptions, you'll find a section called “See Also.” This section includes references to chapters in other AutoCAD guides and other AutoCAD commands and system variables related to the current command.
Overview of Commands

You can start a command by using one of the following methods:

- Click the command name on a menu, status bar, tool set, or shortcut menu.
- Enter the command name or command alias at the Command prompt and press Enter or Spacebar.

The acad.pgp file lists the command aliases.

To access the acad.pgp, on the Tools menu, click Customize ➤ Edit Command Aliases (PGP).

In this Command Reference, near the beginning of each command description is a command access section that lists the specific ways you can start that command.

3D Commands

3D

Creates 3D polyface mesh objects in common geometric shapes that can be hidden, shaded, or rendered.

List of Prompts

The following prompts are displayed.
Enter an option [Box (page 8)/Cone (page 10)/Dish (page 12)/Dome (page 12)/Mesh (page 13)/Pyramid (page 14)/Sphere (page 15)/Torus (page 16)/Wedge (page 18)]:

**Box**

Creates a 3D box polyface mesh.

**Corner of Box** Sets the first corner of the box.

**Length of Box** Sets the first corner of the box.

![](image)

**Width**

Specifies the width of the box. Enter a distance or specify a point relative to the corner point of the box.

![](image)

**Height of Box** Specifies the height of the box. Enter a distance or specify a point relative to the corner point of the box.

![](image)

**Rotation Angle** Rotates the box about the first corner specified. If you enter 0, the box remains orthogonal to the current X and Y axes.

**Copy** Creates a rotated copy of the box.
Reference Aligns the box with other objects in the drawing or relative to an angle you specify. The base point for the rotation is the first corner of the box.

- **Reference Angle:** Defines a reference angle by specifying two points or an angle from the X axis on the XY plane. For example, you can rotate the box to align two specified points on the box with a point on another object. After defining a reference angle, specify a point for the reference angle to align with. The box then rotates around the first corner relative to the angle of rotation specified for the reference angle.

  If you enter 0 as a reference angle, the new angle determines the rotation of the box.

- **New Angle:**

  Specify a point relative to the base point. The base point for the rotation is the first corner of the box. The box rotates by the angle between the reference angle and the new angle. If you want to align the box with another object, specify two points on the target object to define the new angle of rotation for the box.

  If the reference angle of rotation is 0, the box rotates the angular distance entered relative to the first corner of the box.

**Cube**

Creates a cube using the length for the width and height of the box.

![Cube Diagram]

**Center Point for Base**

**Radius for Base**

**Radius for Top**

Specify rotation angle of box about the Z axis or [Reference]: Specify an angle or enter r

- **Rotation Angle** Rotates the cube about the first corner of the box. If you enter 0, the box remains orthogonal to the current X and Y axes.

- **Copy** Creates a rotated copy of the cube.

**Reference** Aligns the box with other objects in the drawing or relative to an angle you specify. The base point for the rotation is the first corner of the box.
Specify the reference angle <0>: Specify a point, enter an angle, or press Enter
You can define a reference angle by specifying two points or an angle from the X axis on the XY plane. For example, you can rotate the box to align two specified points on the box with a point on another object. After defining a reference angle, specify a point for the reference angle to align with. The box then rotates around the first corner relative to the angle of rotation specified for the reference angle.
If you enter 0 as a reference angle, the new angle alone determines the rotation of the box.
Specify the new angle: Specify a point or enter an angle
To specify the new angle of rotation, specify a point relative to the base point. The base point for the rotation is the first corner of the box. The box rotates the angular distance between the reference angle and the new angle. If you want to align the box with another object, specify two points on the target object to define the new angle of rotation for the box.
If the reference angle of rotation is 0, the box rotates the angular distance entered relative to the first corner point of the box.

**Cone**
Creates a cone-shaped polygon mesh.

Specify center point for base of cone: Specify a point (1)
Specify radius for base of cone or [Diameter]: Specify a distance or enter d

**Radius for Base**
Defines the base of the cone by its radius.

Specify radius for top of cone or [Diameter] <0>: Specify a distance, enter d, or press Enter
**Radius for Top** Defines the top of the cone by its radius. A value of 0 produces a cone. A value greater than 0 produces a truncated cone.

Specify height of cone: *Specify a distance*

Enter number of segments for surface of cone <16>: *Enter a value greater than 1 or press Enter*

**Diameter for Top** Defines the top of the cone by its diameter. A value of 0 produces a cone. A value greater than 0 produces a truncated cone.

Specify diameter for top of cone <0>: *Specify a distance or press Enter*

Specify height of cone: *Specify a distance*

Enter number of segments for surface of cone <16>: *Enter a value greater than 1 or press Enter*

**Diameter for Base**

Defines the base of the cone by its diameter.

Specify diameter for base of cone: *Specify a distance*

Specify radius for top of cone or [Diameter] <0>: *Specify a distance, enter d, or press Enter*

**Radius for Top** Defines the top of the cone by its radius. A value of 0 produces a cone. A value greater than 0 produces a truncated cone.

Specify height of cone: *Specify a distance*
Enter number of segments for surface of cone <16>: Enter a value greater than 1 or press Enter

**Diameter for Top** Defines the top of the cone by its diameter. A value of 0 produces a cone. A value greater than 0 produces a truncated cone.
Specify diameter for top of cone <0>: Specify a distance
Specify height of cone: Specify a distance
Enter number of segments for surface of cone <16>: Enter a value greater than 1 or press Enter

**Dish**
Creates the lower half of a spherical polygon mesh.
Specify center point of dish: Specify a point (1)
Specify radius of dish or [Diameter]: Specify a distance or enter \(d\)

**Radius** Defines the dish by its radius.
Enter number of longitudinal segments for surface of dish <16>: Enter a value greater than 1 or press Enter
Enter number of latitudinal segments for surface of dish <8>: Enter a value greater than 1 or press Enter

**Diameter** Defines the dish by its diameter.
Specify diameter of dish: Specify a distance
Enter number of longitudinal segments for surface of dish <16>: Enter a value greater than 1 or press Enter
Enter number of latitudinal segments for surface of dish <8>: Enter a value greater than 1 or press Enter

**Dome**
Creates the upper half of a spherical polygon mesh.
Specify center point of dome: Specify a point (1)
Specify radius of dome or [Diameter]: Specify a distance or enter \(d\)

**Radius** Defines the dome by its radius.
Enter number of longitudinal segments for surface of dome: *Enter a value greater than 1 or press Enter*

Enter number of latitudinal segments for surface of dome <8>: *Enter a value greater than 1 or press Enter*

**Diameter** Defines the dome by its diameter.
Specify diameter of dome: *Specify a distance*

Enter number of longitudinal segments for surface of dome <16>: *Enter a value greater than 1 or press Enter*

Enter number of latitudinal segments for surface of dome <8>: *Enter a value greater than 1 or press Enter*

**Mesh**

Creates a planar mesh whose M and N sizes determine the number of lines drawn in each direction along the mesh. The M and N directions are similar to the X and Y axes of an XY plane.

Specify first corner point of mesh: *Specify a point (1)*

Specify second corner point of mesh: *Specify a point (2)*

Specify third corner point of mesh: *Specify a point (3)*

Specify fourth corner point of mesh: *Specify a point (4)*

Enter mesh size in the M direction: *Enter a value between 2 and 256*

Enter mesh size in the N direction: *Enter a value between 2 and 256*
**Pyramid**
Creates a pyramid or a tetrahedron.

Specify first corner point for base of pyramid: *Specify a point (1)*

Specify second corner point for base of pyramid: *Specify a point (2)*

Specify third corner point for base of pyramid: *Specify a point (3)*

Specify fourth corner point for base of pyramid or [Tetrahedron]: *Specify a point (4) or enter t*

---

**Fourth Corner Point**
Defines the fourth corner point of the base of a pyramid.

Specify apex point of pyramid or [Ridge/Top]: *Specify a point (5) or enter an option*

The Z value of the point specified determines the height for the pyramid's apex, top, or ridge line.

**Apex Point** Defines the top of the pyramid as a point (apex).

**Ridge** Defines the top of the pyramid as a ridge line. The two endpoints must lie in the same direction as the base points to prevent a self-intersecting wireframe.

Specify first ridge end point of pyramid: *Specify a point (1)*

Specify second ridge end point of pyramid: *Specify a point (2)*
Top Defines the top of the pyramid as a rectangle. If the top points cross, they create a self-intersecting polygon mesh.
Specify first corner point for top of pyramid: Specify a point
Specify second corner point for top of pyramid: Specify a point
Specify third corner point for top of pyramid: Specify a point
Specify fourth corner point for top of pyramid: Specify a point

Tetrahedron
Creates a tetrahedral polygon mesh.
Specify apex point of tetrahedron or [Top]: Specify a point or enter t
Apex Point Defines the top of the tetrahedron as a point (apex).
Top Defines the top of the tetrahedron as a triangle. If the top points cross, they create a self-intersecting polygon mesh.
Specify first corner point for top of tetrahedron: Specify a point (1)
Specify second corner point for top of tetrahedron: Specify a point (2)
Specify third corner point for top of tetrahedron: Specify a point (3)

Sphere
Creates a spherical polygon mesh.
Specify center point of sphere: Specify a point (1)
Specify radius of sphere or [Diameter]: Specify a distance or enter d
Radius Defines the sphere by its radius.
Enter number of longitudinal segments for surface of sphere <16>: Enter a value greater than 1 or press Enter
Enter number of latitudinal segments for surface of sphere <16>: Enter a value greater than 1 or press Enter

\[\text{radius}\]

**Diameter** Defines the sphere by its diameter.
Specify diameter of sphere: Specify a distance
Enter number of longitudinal segments for surface of sphere <16>: Enter a value greater than 1 or press Enter
Enter number of latitudinal segments for surface of sphere <16>: Enter a value greater than 1 or press Enter

\[\text{diameter}\]

**Torus**
Creates a toroidal polygon mesh that is parallel to the XY plane of the current UCS.
Specify center point of torus: Specify a point (1)
Specify radius of torus or [Diameter]: Specify a distance or enter \(d\)
The radius of the torus is measured from its center point to its outside edge, not to the center of the tube.

**Radius of Torus**
Radius Defines the torus by its radius.
Specify radius of tube or [Diameter]: Specify a distance or enter \( d \)

**Diameter of Torus**
Defines the torus by its diameter.

Specify diameter of torus: Specify a distance

Specify radius of tube or [Diameter]: Specify a distance or enter \( d \)

**Radius of Tube**
Defines the tube by its radius.

Enter number of segments around tube circumference <16>: Enter a value greater than 1 or press Enter

Enter number of segments around torus circumference <16>: Enter a value greater than 1 or press Enter

The radius of the tube of the torus is measured from the center of the tube to the outside edge of the tube.

**Diameter of Tube**
Defines the tube by its diameter.

Specify diameter of tube: Specify a distance

Enter number of segments around tube circumference <16>: Enter a value greater than 1 or press Enter
Enter number of segments around torus circumference <16>: Enter a value greater than 1 or press Enter

**Wedge**

Creates a right-angle, wedge-shaped polygon mesh with a sloped face tapering along the X axis.

Specify corner point of wedge: Specify a point (1)
Specify length of wedge: Specify a distance
Specify width of wedge: Specify a distance
Specify height of wedge: Specify a distance
Specify rotation angle of wedge about the Z axis: Specify an angle
The base point for the rotation is the corner point of the wedge. If you enter 0, the wedge remains orthogonal to the current UCS plane. Enter c to create a rotated copy of the wedge.

See also:

Create Custom Mesh (Legacy)

**3DALIGN**

Aligns objects with other objects in 2D and 3D.

**Access Methods**

Button

Menu: Modify ➤ 3D Operations ➤ 3D Align

Toolbar: Modeling tool set ➤ Copy tool group ➤ 3D Align
Summary

You can specify one, two, or three points for the source object. Then, you can specify one, two, or three points for the destination.

List of Prompts

The following prompts are displayed.
Select objects: Select the objects to align and press Enter
Specify source plane and orientation...

The selected object is moved and rotated so that the base points, and the X and Y axes of the source and destination align in 3D space. 3DALIGN works with dynamic UCS (DUCS), so you can dynamically drag the selected objects and align them with the face of a solid object.
Specify base point or [Copy]: Specify a point or enter c to create a copy

The base point of the source object will be moved to the base point of the destination.
Specify second point or [Continue] <C>: Specify a point on the object’s X axis, or press Enter to skip forward to specifying destination points

The second point specifies a new X axis direction within a plane parallel to the XY plane of the current UCS. If you press Enter instead of specifying a second point, the X and Y axes are assumed to be parallel with the X and Y axes of the current UCS.
Specify third point or [Continue] <C>: Specify a point on the object’s positive XY plane, or press Enter to skip forward to specifying destination points

The third point fully specifies the orientation of the X and Y axes of the source object that will be aligned with the destination plane.
Specify destination plane and orientation...
Specify first destination point: Specify a point

This point defines the destination of the base point of the source object.
Specify second source point or [eXit] <X>: Specify a point for the X axis of the destination or press Enter

The second point specifies a new X axis direction for the destination within a plane parallel to the XY plane of the current UCS. If you press Enter instead of specifying a second point, the X and Y axes of the destination are assumed to be parallel with the X and Y axes of the current UCS.

Specify third destination point or [eXit] <X>: Specify a point for the destination’s positive XY plane, or press Enter

The third point fully specifies the orientation of the X and Y axes of the destination plane.

NOTE If the destination is a plane on an existing solid object, you can define the destination plane with a single point by turning on dynamic UCS.

See also:
Align Objects

3DARRAY

Maintains legacy behavior for creating nonassociative, 3D rectangular or polar arrays.

Access Methods

Button

Menu: Modify ➤ 3D Operations ➤ 3D Array
Toolbar: Modeling tool set ➤ Copy tool group ➤ 3D Array

Summary

3DARRAY functionality has been replaced with the enhanced ARRAY (page 81) command, which allows you to create associative or nonassociative, 2D or 3D, rectangular, path, or polar arrays. 3DARRAY maintains legacy behavior.

For 3D rectangular arrays, in addition to columns and rows, you also specify the number of levels in the Z direction. For 3D polar arrays, you specify the axis of rotation with any two points in space.
The entire selection set is treated as a single element in the array.

**List of Prompts**

The following prompts are displayed.

Enter type of array [Rectangular (page 21)/Polar (page 21)]

<R>: Enter an option or press Enter

**Rectangular Array**

Copies objects in a matrix of rows ($X$ axis), columns ($Y$ axis), and levels ($Z$ axis). An array must have at least two rows or two columns or two levels.

Specifying one row requires that more than one column be specified, and vice versa. Specifying one level creates a two-dimensional array.

Positive values generate the array along the positive $X$, $Y$, and $Z$ axes. Negative values generate the array along the negative $X$, $Y$, and $Z$ axes.

**Polar Array**

Copies objects about an axis of rotation.
The specified angle determines how far the objects are arrayed about the axis of rotation. A positive number produces a counterclockwise array rotation. A negative number produces a clockwise array rotation.

Entering \texttt{y} or pressing Enter rotates each array element.

See also:
Array Objects

\textbf{3DCONFIG (-3DCONFIG)}

Sets options that affect 3D display performance.

\textbf{Summary}

Enter \texttt{-3dconfig} at the Command prompt to use this command.

\textbf{List of Prompts}

The following prompts are displayed.

Enter option [Dynamic tessellation (page 22)/General options (page 23)/acceleration (page 23)/Plot emulation (page 24)/eXit] <Adaptive degradation>:

\textbf{Dynamic Tessellation}

Sets the options that determine the smoothness of the objects in a drawing. Objects are drawn using many short lines (or triangles when drawing spheres). These lines are called tessellation lines. Objects in your drawing appear smoother when you use more tessellation lines.

\textbf{Surface Tessellation} Determines the amount of detail for surfaces in your drawing. A higher setting provides more detail but uses more tessellation lines and more memory.
**Curve Tessellation** Determines the amount of detail for curves in your drawing. A higher setting provides more detail but uses more tessellation lines and more memory.

**Number of Tessellations to Cache** Configures your system according to memory and performance requirements. The 3D cache always stores at least one tessellation. When this option is set to 1, the tessellation for all viewports is the same; some objects in the drawing may be regenerated as you zoom in and out. Setting this option to 2 or more is useful when you have more than one viewport with different views. Increasing the number requires more memory.

**General Options**
Sets performance-related options that are not hardware dependent.

**Discard Back Faces** Discards back faces when drawing objects. You cannot see the effect of discarding back faces on some objects, such as spheres, because you cannot see the back face even when it is present. The effect of discarding back faces is visible on objects such as those that don’t have a top. Discarding back faces enhances performance.

**Transparency Quality** Adjusts the transparency quality. At the Low setting, a screen-door effect achieves transparency without sacrificing speed. At the Medium setting, the default in software mode, blending improves image quality. The High setting, the default in hardware mode, produces an image free of visual artifacts at the cost of drawing speed. Materials must also be turned on for transparency to be visible.

The General Options prompt is redisplayed.

**Acceleration**
Specifies whether to use software or hardware acceleration in 3D.

If you select Hardware, you can also specify whether geometry acceleration are turned on or off.

**Hardware** Specifies hardware acceleration. The hardware graphics card performs most of the drawing tasks in 3D to increase performance.

- **Driver Name.** You can select a driver from a list of available hardware-accelerated drivers found in the Drv directory. If you want to use a hardware driver from another vendor, it must be supported by the Heidi® Graphics System.
- **Enhanced 3D Performance.** Enables a more efficient use of the graphic card when working with 3D objects.

  NOTE If you experience problems with precision, turn this option off.

- **Smooth display.** Controls the status of the full screen anti-aliasing effect. This option removes the jagged effect on the display of diagonal line and curved edges.

- **Advanced material effects.** Controls the status of the advanced materials effect on screen.

- **Gooch hardware shader.** Enables the use of Gooch shading. With this option on the details of a 3D object are shown by softening the contrast between lighted areas and shadowed areas by using warm and cool colors as a substitute to light and dark colors.

- **Per-pixel lighting.** Enables the computation of colors for individual pixels. With this option on the 3D objects and lighting effects appear smoother in the viewport.

- **Full shadow display.** Enables shadows to be displayed in the viewport.

  NOTE Enhanced 3D performance effect must be turned on.

- **Texture compression.** Enables the use of texture compression to reduce the amount of video memory required to open and display a drawing that contains materials with images or has attached images.

  NOTE With this option turned on, the time it takes to load the images might increase the first time that they are accessed, and there is a reduction in the quality of the images when they are displayed in the viewport or plotted.

Software Feature is not supported and is provided for scripting compatibility only.

Plot Emulation Feature is not supported and is provided for scripting compatibility only.

See also:

  Control Performance
3DDISTANCE

Starts the interactive 3D view and makes objects appear closer or farther away.

Access Methods

Menu: View ➤ Camera ➤ Adjust Distance
Shortcut menu: Start any 3D navigation command, right-click in the drawing area, and click Other Navigation Modes ➤ Adjust Distance (4).

Summary

3DDISTANCE changes the cursor to a line with one arrow pointing up and one pointing down. Click and drag the cursor vertically toward the top of the screen to move the camera closer to the objects, making them appear larger. Click and drag the cursor vertically toward the bottom of the screen to move the camera away from the objects, making them appear smaller.

See also:

Use 3D Navigation Tools

3DEDITBAR

Reshapes splines and NURBS surfaces, including their tangency properties.

Summary

Several grips are available for moving a point and changing the magnitude and direction of tangents at specific points on splines, and in the $U$, $V$, and $W$ directions on NURBS surfaces.
The Grips on the Gizmo

The 3D Edit Bar gizmo includes three grips:

- **Triangle grip.** Specifies the method for reshaping the selected object.

- **Square grip.** Reshapes the selected object by moving the base point or changing the tangent direction at the base point. Use the three axes to restrict the movement option to a specified axis. Similarly, the three squares that touch the square grip restrict the movement option to the specified planes.
- **Tangent arrow grip.** Changes the magnitude of the tangent at the base point. For example, lengthening the tangent arrow grip flattens the curvature of the surface at the point of tangency. The tangent arrow points in the direction of one of the surface’s $U$, $V$, or $W$ axes, depending on the tangent direction specified in 3D Edit Bar Shortcut Menu (page 29).
List of Prompts

The following prompts are displayed.

Select a NURBS surface or curve to edit Specifies the object to be modified. Valid objects include lines, arcs, circles, ellipses and elliptical arcs, polylines, helixes, splines, and NURBS surfaces. Objects other than surfaces can be converted to splines.

Select point on curve or Select point on NURBS surface Specifies a base point on the selected curve or NURBS surface. Changes to the selected object are relative to this point.

Base point Specifies a new base point on the curve or NURBS surface.

Displacement Specifies a new base point by projecting the absolute coordinates entered onto the selected curve or surface, when possible.

Undo Cancels the previous change without exiting the command.

Exit Cancels the current operation and returns to the previous prompt, or it exits the command.
See also:
  Modify Splines
  Edit NURBS Surfaces

3D Edit Bar Shortcut Menu

Displays options to set the location of the base point, constraints, and tangency.

Access Methods

Shortcut menu: Right-click on the 3D Edit Bar gizmo.

Summary

The 3D Edit Bar shortcut menu displays several options depending on whether a spline or a NURBS surface is selected, where you click, and which editing method, move or tangent, is current.

The illustration displays an imaginary $UV$ plane in yellow that is tangent to the surface, and contains the base point. It displays the $U$ axis in red, the $V$ axis in green, and $W$ axis, which is normal to the surface, in blue.

NOTE By default, the orientation of the 3D Edit Bar gizmo is aligned with the World Coordinate System, but its alignment can be changed using the shortcut menu. To align the axes with the $U$, $V$, and $W$ axes of a NURBS surface, choose Align Gizmo With > Object.
List of Options

The following options are displayed.

**Move Point Location** Reshapes the selected object by moving the base point.

**Move Tangent Direction** Reshapes the selected object by changing the slope of the tangent at the base point.

**U Tangent Direction** Locates the tangent arrow grip on the $U$ axis. Changes to the tangency are constrained to the $UW$ plane.

**V Tangent Direction** Locates the tangent arrow grip on the $V$ axis. Changes to the tangency are constrained to the $VW$ plane.

**Normal Tangent Direction** Locates the tangent arrow grip on the $W$ axis, which is normal to the surface at the base point. Changes to the tangency are constrained to the $UW$ plane.

**Set Constraint** Sets whether the change in tangency or point location is constrained to a specific axis or major plane.

- **X, Y, or Z**. Restricts the change to the specified World Coordinate System (WCS) axis.
- **XY, YZ, or XZ**. Restricts the change to the specified World Coordinate System (WCS) plane.

**Relocate Base Point** Specifies a new base point on the curve or NURBS surface.

**Align Gizmo With** Reorients the gizmo to align with the WCS or UCS, or with a selected face or object.

**See also:**
- Modify Splines
- Edit NURBS Surfaces

### 3DFACE

Creates a three-sided or four-sided surface in 3D space.

**Access Methods**

- **Menu**: Draw ➤ 3D Modeling ➤ Meshes ➤ 3D Face
Summary

After entering the last two points for a 3D face, the command repeats automatically using these two points as the first two points of the next 3D face. For example:

List of Prompts

The following prompts are displayed.
Specify first point (page 31) or [Invisible (page 31)]: Specify a point (I) or enter i

First Point Defines the start point for the 3D surface. After entering the first point, enter the remaining points in a natural clockwise or counterclockwise order to create a normal 3D face. If you locate all four points on the same plane, a planar face is created that is similar to a region object. When you shade or render the object, planar faces are filled.

Invisible Controls which edges of a 3D face are visible, allowing for accurate modeling of objects with holes. Entering i or invisible before the first point of an edge makes the edge invisible.

The invisible specification must precede any object snap modes, XYZ filters, or coordinate input for that edge. You can create a 3D face in which all edges are invisible. Such a face is a phantom; it does not appear in wireframe presentations but can hide material in line drawings. 3D faces do appear in shaded renderings.

You can combine 3D faces to model complex 3D surfaces.
Specify second point or [Invisible]: Specify a point (2) or enter i
Specify third point or [Invisible] <exit>: Specify a point (3), enter i, or press Enter
Specify fourth point or [Invisible] <create three-sided face>: Specify a point (4), enter i, or press Enter

The Third Point and Fourth Point prompts are repeated until you press Enter. Specify points 5 and 6 at these repeating prompts. When you finish entering points, press Enter.

See also:
Create Custom Mesh (Legacy)

3DFORBIT

Rotates the view in 3D space without constraining roll.

Access Methods

Menu: View ➤ Orbit ➤ Free Orbit
Pointing device: Press Shift-Ctrl and click the mouse wheel to temporarily enter 3DFORBIT mode.
**Shortcut menu:** Start any 3D navigation command, right-click in the drawing area, and click Other Navigation Modes ➤ Free Orbit (2).

**Summary**

Selecting one of more objects before starting this command limits the display to those objects only.

While the command is active, right-click to display additional options from a shortcut menu.

3DFORB1T activates a 3D Free Orbit view in the current viewport. If the user coordinate system (UCS) icon is on, a shaded 3D UCS icon representing the current UCS appears in the 3D Orbit view. You can view your entire drawing or select one or more objects before starting the command.

The 3D Free Orbit view displays an arcball, which is a circle divided into four quadrants by smaller circles. When the Enable Orbit Auto Target option is deselected in the shortcut menu, the target of the view stays stationary. The camera location, or point of view, moves around the target. The center of the arcball, not the center of the objects you’re viewing, is the target point. Unlike 3DORBIT (page 40), 3DFORB1T does not constrain the change in view to prevent roll, the rotation of the view about an axis orthogonal to the plane of your screen.

**NOTE** You cannot edit objects while the 3DFORB1T command is active.

Moving your cursor over different parts of the arcball changes the cursor icon, indicating the direction in which the view rotates. See 3D Free Orbit Cursor Icons (page 34).

While the command is active, you can access additional 3DORBIT options from a shortcut menu by right-clicking in the drawing area. See 3D Orbit Shortcut Menu (page 41).

**TIP** While in 3D Orbit mode, you can temporarily enter 3D Free Orbit mode by pressing and holding the Shift key.

**See also:**

Use 3D Navigation Tools
3D Free Orbit Cursor Icons

While using 3D Free Orbit, the cursor changes as it is moved to indicate how the model will be orbited when clicking and dragging.

View rotation is determined by the placement and appearance of the cursor as follows:

**Sphere Encircled by Two Lines** When you move the cursor inside the arcball, it changes to a small sphere encircled by two lines. If you click and drag in the drawing area you can move freely around the objects. It works as if your cursor is grabbing a sphere surrounding the objects and dragging it around the target point. You can drag horizontally, vertically, and diagonally using this method.

**Circular Arrow** When you move the cursor outside the arcball, it becomes a circular arrow. Clicking outside the arcball and dragging the cursor around the arcball causes the view to move around an axis that extends through the center of the arcball, perpendicular to the screen. This is called a *roll*.

**Horizontal Ellipse** When you move the cursor over one of the small circles on the left or right side of the arcball, it becomes a horizontal ellipse. Clicking and dragging from either of these points rotates the view around the vertical or *Y* axis through the middle of the arcball.

**Vertical Ellipse** When you move the cursor over one of the small circles on the top or bottom of the arcball, it becomes a vertical ellipse. Clicking and dragging from either of these points rotates the view around the horizontal or *X* axis through the middle of the arcball.
See also:

3D Navigation Tools

3DMESH

Creates a free-form polygon mesh.

Summary

The mesh density controls the number of facets, and is defined in terms of a matrix of $M$ and $N$ vertices, similar to a grid consisting of columns and rows. 3DMESH is a legacy method for creating mesh, designed primarily for operation under program control rather than by manual entry.

To take advantage of smoothing, creasing, and refinement capabilities, use the MESH (page 620) command.

List of Prompts

The following prompts are displayed.

Size of mesh in M direction Sets the $M$ direction value. Enter a value between 2 and 256.

Size of mesh in N direction Sets the $N$ direction value. Enter a value between 2 and 256.

$M$ times $N$ equals the number of vertices that you must specify.

Location for vertex $(0, 0)$ Sets the coordinate location of the vertex. Enter a 2D or 3D coordinate.
The location of each vertex in the mesh is defined by \( m \) and \( n \), the row and column indices of the vertex. Defining vertices begins with vertex \((0,0)\). You must supply the coordinate locations for each vertex in row \( m \) before specifying vertices in row \( m + 1 \).

Vertices may be any distance from each other. The \( M \) and \( N \) orientation of a mesh depends on the position of its vertices.

3DMESH polygon meshes are always open in both \( M \) and \( N \) directions. You can close a mesh with PEDIT (page 779).

See also:
- Create Custom Mesh (Legacy)

**3DMOVE**

In a 3D view, displays the 3D Move gizmo to aid in moving 3D objects a specified distance in a specified direction.

**Access Methods**

- Menu: Modify ➤ 3D Operations ➤ 3D Move

**Summary**

With the 3D Move gizmo, you can move selected objects and subobjects freely or constrain the movement to an axis or plane.
If the default gizmo (DEFAULTGIZMO (page 1247)) is 3D Move, the 3D Move gizmo is displayed whenever you select an object in a view with a 3D visual style. If you are working in a viewport with 2D Wireframe set as the visual style, 3DMOVE temporarily changes the visual style to 3D Wireframe for the duration of the command.

The 3D Move gizmo is displayed at the center of the selected 3D object or objects by default. You can use the shortcut menu to change its location.

You can also align the 3D Move gizmo with the plane of a face or object by using the Align Gizmo With ➤ Face option on the shortcut menu. The direction of the move operation is then constrained relative to this work plane.

When the 3D Move gizmo is displayed, the 3D Move Gizmo shortcut menu (page 39) offers options for aligning, moving, or changing to another gizmo.

**List of Prompts**

The following prompts are displayed.

**Select objects** Selects the 3D objects you want to move. When you have selected the objects, press Enter.
When you have selected an object, the gizmo is displayed. You can constrain the movement by clicking one of the following locations on the gizmo:

- **Move along an axis.** Click an axis to constrain the movement to that axis.

- **Move along a plane.** Click the area between the axes to constrain the movement to that plane.

**Stretch point** When you are specifying the move using the gizmo, sets the new location of the selected objects. Drag and click to move the objects dynamically.

**Copy** When you are specifying the move using the gizmo, creates a copy of the selected objects instead of moving them. You can make multiple copies by continuing to specify locations.

**Base point** Specifies the base point of the 3D objects you want to move.

- **Second point.** Specifies where the 3D object or objects will be dragged. You can also move the cursor to indicate a direction and then enter a distance.

**Displacement** Specifies a relative distance and direction for the placement of the selected 3D objects using coordinate values that you enter at the command prompt.

**See also:**

Move 3D Objects
3D Move Gizmo Shortcut Menu

Displays options to set the constraint of a 3D object, switch gizmos, and move or align the gizmo.

Access Methods

Shortcut menu: Right-click the 3D Move gizmo

List of Options

The following options are displayed.

Move Activates the 3D Move gizmo.

Rotate Activates the 3D Rotate gizmo.

Scale Activates the 3D Scale gizmo.

Set Constraint Sets whether the change is constrained to a specific axis.
- X, Y or Z. Restricts the change to the designated axis.
- XY, YX, or ZX. Restricts the change to a plane that is defined by the selected axes.

Relocate Gizmo Moves the gizmo to the point you specify.

Align Gizmo With Sets the alignment for the change. Options include:
- World UCS
- Current UCS
- Face

Custom Gizmo Allows you to define the current gizmo by specifying one, two, or three points, or an object.
Respect Dynamic UCS When relocating the gizmo, as you move the cursor, temporarily aligns the XY plane of the UCS with the faces or edges.

See also:
Move 3D Objects

3DORBIT

Rotates the view in 3D space, but constrained to horizontal and vertical orbit only.

Access Methods

Button

Menu: View ➤ Orbit ➤ Constrained Orbit
Pointing device: Press Shift and click the mouse wheel to temporarily enter 3D Orbit mode.
Shortcut menu: Start any 3D navigation command, right-click in the drawing area, and click Other Navigations Modes ➤ Constrained Orbit (1).
Toolbar: Status bar (expanded) ➤ 3D Orbit

Summary

Selecting one or more objects before starting this command limits the display to those objects only.

While the command is active, right-click to display additional options from a shortcut menu.

3DORBIT activates a 3D Orbit view in the current viewport. You can view your entire drawing or select one or more objects before starting the command.

When 3DORBIT is active, the target of the view stays stationary and the camera location, or point of view, moves around the target. However, it appears as if the 3D model is turning as the mouse cursor is dragged. In this way, you can specify any view of the model.

The 3D Orbit cursor icon appears. If you drag the cursor horizontally, the camera moves parallel to the XY plane of the world coordinate system (WCS). If you drag the cursor vertically, the camera moves along the Z axis.
NOTE You cannot edit objects while the 3DORBIT command is active.

While the command is active, you can access additional 3DORBIT options from a shortcut menu by right-clicking in the drawing area. See 3D Orbit Shortcut Menu (page 41).

See also:
Use 3D Navigation Tools

3D Orbit Shortcut Menu

When the 3DORBIT command (or any 3D navigation command or mode) is active, you can access the options on the 3D Orbit shortcut menu. To access the 3D Orbit shortcut menu, right-click in the 3D Orbit view.

Current Mode: Current

Displays the current mode.

Other Navigation Modes

Choose one of the following 3D navigation modes:

- **Constrained Orbit (1)**. Constrains orbiting to the XY plane or the Z direction.
- **Free Orbit (2)**. Allows orbiting in any direction, without being constrained to the XY plane or the Z direction. See 3DFORBIT (page 32).
- **Adjust Distance (4)**. Simulates moving the camera closer to the object or farther away. See 3DDISTANCE (page 25).
- **Swivel (5)**. Changes the cursor to an arched arrow and simulates the effect of swiveling the camera. See 3DSWIVEL (page 53).
- **Zoom (8)**. Changes the cursor to a magnifying glass with plus (+) and minus (-) sign and simulates moving the camera closer to an object or farther away. Works like the Adjust Distance option. See 3DZOOM (page 54).
- **Pan (9)**. Changes the cursor to a hand cursor and moves the view in the direction that you drag. See 3DPAN (page 45).

TIP You can switch to any mode by using the shortcut menu or by entering the number displayed after its name.
**Enable Orbit Auto Target**

Keeps the target point on the objects you are viewing rather than on the center of the viewport. This feature is turned on by default.

**Zoom Window**

Changes the cursor to a window icon so that you can select a specific area to zoom in on. When the cursor changes, click a starting point and end point to define the zoom window. The drawing is zoomed in and focused on the area you selected.

**Zoom Extents**

Centers the view and sizes it to display all objects.

**Zoom Previous**

Displays the previous view.

**Parallel**

Displays objects so that two parallel lines in a drawing never converge. The shapes in your drawing always remain the same and do not appear distorted when they are closer.

**Perspective**

Displays objects in perspective so that all parallel lines converge at one point. Objects appear to recede into the distance, and parts of the objects appear larger and closer to you. The shapes are somewhat distorted when the object is very close. This view correlates more closely to what your eyes see. See **PERSPECTIVE** (page 1431).

**Reset View**

Resets the view back to the view that was current when you first started 3DORBIT.

**Preset Views**

Displays a list of predefined views such as Top, Bottom, and SW Isometric. Choose a view from the list to change the current view of your model.
Named Views

Displays a list of named views in the drawing. Choose a named view from the list to change the current view of your model.

Visual Styles

Provides methods for shading objects. For more information about visual styles, see Use a Visual Style to Display Your Model.

The options are the same as the options in VSCURRENT (page 1158).

Visual Aids

Provides aids to visualizing the objects.

- **Compass**. Draws a 3D sphere composed of three lines representing the X, Y, and Z axes.

- **Grid**. Displays a two-dimensional array of lines similar to graph paper. This grid is oriented along the X and Y axes.

  **NOTE** Before starting 3DORBIT (page 40), you can use the GRID (page 469) command to set system variables that control the grid display. The number of major grid lines corresponds to the value you set using the Grid Spacing option of the GRID command, which is stored in the GRIDUNIT (page 1346) system variable. Ten horizontal lines and ten vertical lines are drawn between the major lines.

- **UCS Icon**. Displays a shaded 3D UCS icon. Each axis is labeled X, Y, or Z. The X axis is red, the Y axis is green, and the Z axis is blue.

See also:

- Use 3D Navigation Tools

3DORBITCTR

Sets the center of rotation in 3D Orbit view.

**Summary**

Starts 3D Orbit view and uses a center of rotation that you specify with your pointing device. If you specify a point outside the current view, 3DORBITCTR ignores the specified point and uses the default center of rotation.
3DORBITCTR overrides the AutoTarget option in the 3DORBIT (page 40) command.

**See also:**
Use 3D Navigation Tools

### 3DOSNAP

Sets the object snap modes for 3D objects.

**Access Methods**

- **Menu**: Tools ➤ Drafting Settings
  - **Shortcut menu**: Press Shift while right-clicking in the drawing area and choose 3D Osnap ➤ Osnap Settings.

- **Toolbar**: Status bar (expanded) ➤ 3D Object Snap

**Summary**

Displays the 3D Object Snap tab of the Drafting Settings dialog box (page 369). You can also set the 3D object snap settings with the 3DOSMODE (page 1201) system variable.

**NOTE** Because 3D object snaps can slow performance, select only the object snaps you need.

**See also:**
Create Solids and Surfaces from Lines and Curves
Create Solids
Create Surfaces
Modify Surfaces
Use Grips to Modify Solids and Surfaces
Snap to Locations on Objects (Object Snaps)
-3DOSNAP

Uses command prompts to set running object snap modes for 3D objects.

List of Prompts

The following prompts are displayed.

**Enter List of Object Snap Modes** Specify one or more object snap modes by entering the first four characters of the name. If you enter more than one, separate the names with commas.

- **ZVERtex**. Snaps to a vertex or a control vertex.
- **ZMIDpoint**. Snaps to the midpoint on a face edge.
- **ZCENter**. Snaps to the center of a face.
- **ZKNOT**. Snaps to a spline knot.
- **ZPERpendicular**. Snaps to a perpendicular face (planar faces only).
- **ZNEAr**. Snaps to an object nearest to face.
- **ZNONE**. Turns off all 3D object snaps.

See the 3D Object Snaps tab of the [Drafting Settings dialog box](page 369) for more information.

3DPAN

When a drawing is in a Perspective view, starts the interactive 3D view and enables you to drag the view horizontally and vertically.

Access Methods

- **Menu**: View ➤ Pan ➤ Realtime
- **Shortcut menu**: Start any 3D navigation command, right-click in the drawing area, and click Other Navigation Modes ➤ Pan (9).

- **Toolbar**: Status bar ➤ Pan

**Summary**

Moves in the direction that you drag. You can drag the view vertically, horizontally, or diagonally. 3DPAN changes the cursor to a hand cursor.
You can view your entire drawing or select objects before entering 3DPAN.

See also:

Use 3D Navigation Tools

3DPOLY

Creates a 3D polyline.

Access Methods

Button

Menu: Draw ➤ 3D Polyline

Toolbar: Modeling tool set ➤ Open Shapes tool group (expanded) ➤ 3D Polyline

Summary

A 3D polyline is a connected sequence of straight line segments created as a single object. 3D polylines can be non-coplanar; however, they cannot include arc segments.

List of Prompts

The following prompts are displayed.

Specify start point of polyline: Specify a point (1)

Specify endpoint of line (page 47) or [Undo (page 47)]: Specify a point or enter an option
Specify endpoint of line or [Undo]: Specify a point or enter an option
Specify endpoint of line or [Close (page 47)/Undo]: Specify a point or enter an option

**Endpoint of Line** Draws a straight line from the previous point to the specified new point. The prompt is repeated until you press Enter to end the command.

Undo Deletes the last line created. You can continue drawing from the previous point.

Close Draws a closing line from the endpoint back to the first point, and then ends the command. To be closed, a 3D polyline must contain at least two lines.

See also:
- Draw Polylines

**3DROTATE**

In a 3D view, displays the 3D Rotate gizmo to aid in revolving 3D objects around a base point.
Access Methods

Menu: Modify ➤ 3D Operations ➤ 3D Rotate

Summary

With the 3D Rotate gizmo, you can rotate selected objects and subobjects freely or constrain the rotation to an axis.

If you are working in a viewport with 2D Wireframe set as the visual style, 3DROTATE temporarily changes the visual style to 3D Wireframe for the duration of the command.

The 3D Rotate gizmo is displayed at the center of the selected object or objects by default. You can adjust the axis of rotation by using the shortcut menu to change the location of the gizmo.

When the 3D Rotate gizmo is displayed, the 3D Rotate Gizmo shortcut menu (page 49) offers options for aligning, moving, or changing to another gizmo.

List of Prompts

The following prompts are displayed.

Select objects Specifies the objects that you want to rotate.
**Base point** Sets the center point of the rotation.

**Pick a rotation axis** On the 3D Scale gizmo, specifies the axis of rotation. Move the mouse until the axis path you want to select turns yellow, then click to select it.

![Image of 3D Rotate Gizmo](image)

**Specify angle start point or type an angle** Sets the relative start point of the rotation. You can also enter an angle value.

**Specify angle end point** Rotates the object about the specified axis. Click to end the rotation.

**See also:**
- Rotate 3D Objects

**3D Rotate Gizmo Shortcut Menu**

Displays options to set the constraint of a 3D object, switch gizmos, and move or align the gizmo.

![Image of 3D Rotate Gizmo Shortcut Menu](image)

**Access Methods**

**Shortcut menu:** Right-click the 3D Rotate gizmo
List of Options

The following options are displayed.

Move Activates the 3D Move gizmo.

Rotate Activates the 3D Rotate gizmo.

Scale Activates the 3D Scale gizmo.

Set Constraint Sets whether the change is constrained to a specific axis.  
- X, Y or Z. Restricts the change to the designated axis.

Relocate Gizmo Moves the gizmo to the point you specify.

Align Gizmo With Sets the alignment for the change. Options include:
- World UCS
- Current UCS
- Face

Custom Gizmo Allows you to define the current gizmo by specifying one,  
two, or three points, or an object.

Respect Dynamic UCS When relocating the gizmo, as you move the cursor,  
temporarily aligns the XY plane of the UCS with the faces or edges.

See also:
- Rotate 3D Objects

3DScale

In a 3D view, displays the 3D Scale gizmo to aid in resizing 3D objects.

Summary

With the 3D Scale gizmo, you can resize selected objects and subobjects along  
an axis or plane, or resize the objects uniformly.

When the 3D Scale gizmo is displayed, the 3D Scale Gizmo shortcut menu  
(page 52) offers options for aligning, moving, or changing to another gizmo.
List of Prompts

The following prompts are displayed.

Select objects Specifies the objects to be scaled.

Specify base point Specifies the base point for the scaling.

Pick a scale axis or plane Specifies whether the object is scaled uniformly or only along a specific axis or plane. You have the following choices:

- **Scale uniformly.** Click the area closest to the vertex of the 3D Scale gizmo. The interior region of all axes of the gizmo is highlighted.

- **Constrain the scale to a plane.** Click between the parallel lines between the axes that define the plane. This option is only available for meshes, not solids or surfaces.

- **Constrain the scale to an axis.** Click the axis. This option is only available for meshes, not solids or surfaces.
Specify scale factor: Specifies the amount of change. Drag to dynamically modify the size of the selected objects or enter a scale value. For example, enter 2 to double the size of the selection.

Copy: Creates and scales a copy of the selected objects.

Reference: Sets a scale based on a ratio.
- **Reference length**: Sets the relative amount that represents the current size in the scale ratio.
- **New Length**: Sets the relative value used to calculate the new size. For example, if the reference length is 1 and the new length is 3, the size of the selected objects is tripled.
- **Points**: Specifies the relative value used to calculate the new size based on two points that you specify.

See also:
- Scale 3D Objects

### 3D Scale Gizmo Shortcut Menu

Displays options to set the constraint of a 3D object, switch gizmos, and move or align the gizmo.

![3D Scale Gizmo](image)

**Access Methods**

**Shortcut menu**: Right-click the 3D Scale gizmo

**List of Options**

The following menu options are displayed when you right-click the 3D Scale gizmo.

- **Move**: Activates the 3D Move gizmo.
**Rotate** Activates the 3D Rotate gizmo.

**Scale** Activates the 3D Scale gizmo.

**Set Constraint** Sets whether the change is constrained to a specific axis.
- **X, Y or Z.** Restricts the change to the designated axis.
- **XY, YX, or ZX.** Restricts the change to a plane that is defined by the selected axes.
- **XYZ.** Applies the scaling uniformly to all axes.

---

**NOTE**

Unlike most other objects, mesh objects support non-uniform scale.

**Relocate Gizmo** Moves the gizmo to the point you specify.

**Align Gizmo With** Sets the alignment for the change. Options include:
- **World UCS**
- **Current UCS**
- **Face**

**Custom Gizmo** Allows you to define the current gizmo by specifying one, two, or three points, or an object.

**Respect Dynamic UCS** When relocating the gizmo, as you move the cursor, temporarily aligns the XY plane of the UCS with the faces or edges.

**See also:**

- Use Gizmos to Modify Objects

---

**3DSWIVEL**

Changes the target of the view in the direction that you drag.

**Access Methods**

- **Menu: View ➤ Camera ➤ Swivel**
- **Shortcut menu:** Start any 3D navigation command, right-click in the drawing area, and click Other Navigation Modes ➤ Swivel (5).
Summary
Simulates panning with a camera in the direction that you drag. The target of the view changes. You can swivel the view along the XY plane or along the Z axis.

See also:
Use 3D Navigation Tools

3DZOOM
Zooms in and out in a perspective view.

Access Methods

- **Menu:** View ➤ Zoom
- **Pointing device:** Scroll the mouse wheel to zoom in and out.
- **Shortcut menu:** Start any 3D navigation command, right-click in the drawing area, and click Other Navigation Modes ➤ Zoom (8).

- **Toolbar:** Status bar ➤ Zoom

Summary
Zooming in a perspective view simulates moving the camera closer to the target or farther away. Objects appear closer or farther away, but the position of the camera does not change.

List of Prompts
The following prompts are displayed in a perspective view.

Press Esc or Enter to exit, or right-click to display shortcut-menu.
Enter option [All (page 54)/Extents (page 54)/Window (page 55)/Previous (page 55)/Object (page 55)] <real time (page 55)>:

**All** Zooms to display the entire drawing.

**Extents** Zooms to display the drawing extents and results in the largest possible display of all the objects
**Window** Zoons to display an area specified by two points of a rectangular window.

**Previous** Zoons to display the previous view.

**Object** Zoons to display one or more selected objects as large as possible and in the center of the view.

**Real Time** Using the pointing device, zooms interactively.

**See also:**
- Specify 3D Views

### A Commands

**ABOUT**

Displays information about AutoCAD.

**Access Methods**

- **Menu:** AutoCAD ➤ About AutoCAD
- **Command entry:** `about` for transparent use

**Summary**

Copyright information and product information is displayed. Product information includes the version number and service pack, serial number, license type and expiration date, and the text of the license agreement. You can save the product information as a text file.

**See also:**
- Start a Drawing

**ACISIN**

Imports an ACIS (SAT) file and creates 3D solid, body, or region objects.
Access Methods

Menu: Insert ➤ ACIS File

Summary

The Select ACIS File box is displayed. Select the file to import in the File Name list. The SAT (ASCII) ACIS file is imported into the drawing.

NOTE ACISIN imports SAT files up to ACIS version 7.0.

See also:

Import ACIS SAT Files

ACISOUT

Exports a body object, solid, or region to an ACIS file.

Summary

Selected objects that are not solids or regions are ignored, and the Create ACIS File dialog box is displayed. Enter the name of the file you want to create. The selected objects are exported to an ASCII file.

See also:

Export ACIS SAT Files

ADDSELECTED

Creates a new object based on the object type and general properties of a selected object.

Access Methods

Shortcut menu: Select a single object, right-click, and choose Add Selected.
Summary

Differs from COPY by duplicating only the general properties (page 845) of an object. For example, creating an object based on a selected circle adopts the general properties of the circle, such as its color and layer, but prompts you for the new circle’s center point and radius.

With the ADDSELECTED command, you can create a new object with the same object type as a selected object. Certain objects have special properties that are supported in addition to its general properties, as shown in the following table.

<table>
<thead>
<tr>
<th>Object type</th>
<th>Special properties supported by ADDSELECTED</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gradient</td>
<td>Gradient name, Color 1, Color 2, Gradient Angle, Centered</td>
</tr>
<tr>
<td>Text, MText, Attribute Definition</td>
<td>Text Style, Height</td>
</tr>
<tr>
<td>Dimensions (Linear, Aligned, Radial, Diameter, Angular, Arc Length, and Ordinate)</td>
<td>Dim Style, Dim Scale</td>
</tr>
<tr>
<td>Tolerance</td>
<td>Dim Style</td>
</tr>
<tr>
<td>Leader</td>
<td>Dim Style, Dim Scale</td>
</tr>
<tr>
<td>Multileader</td>
<td>Multileader Style, Overall Scale</td>
</tr>
<tr>
<td>Table</td>
<td>Table Style</td>
</tr>
<tr>
<td>Hatch</td>
<td>Pattern, Scale, Rotation</td>
</tr>
<tr>
<td>Block Reference, External Reference</td>
<td>Name</td>
</tr>
<tr>
<td>Underlays (Image)</td>
<td>Name</td>
</tr>
</tbody>
</table>
List of Prompts

The following prompt is displayed.

Select object: *Use an object selection method*

The prompts vary by object type.

See also:

- Copy, Array, Offset, or Mirror Objects

**ALIGN**

Aligns objects with other objects in 2D and 3D.

Access Methods

- **Button**
  - Menu: Modify ➤ 3D Operations ➤ Align
  - Toolbar: Drafting tool set ➤ Move/Rotate/Scale tool group (expanded) ➤ Align

Summary

Either one, two, or three pairs of source points and definition points can be specified to move, rotate, or tilt the selected objects, aligning them with points on another object.

![Diagram](image-url)
List of Prompts

The following prompts are displayed.

Select objects: *Select the objects to align and press Enter*

Specify either **one** (page 59), **two** (page 59), or **three pairs** (page 60) of source points and definition points to align the selected objects.

ALIGN Using One Pair of Points When you select only one source point and destination point pair, the selected objects move in 2D or 3D from the source point (1) to the destination point (2).

![Two points specified](image1)

![Result](image2)

ALIGN Using Two Pairs of Points When you select two point pairs, you can move, rotate, and scale the selected objects in 2D or 3D to align with other objects.

![Objects selected](image3)

![Four points specified](image4)

![Result](image5)

The first set of source and destination points defines the base point for the alignment (1, 2). The second set of points defines the angle of rotation (3, 4). After you enter the second set of points, you are prompted to scale the object. The distance between the first and second destination points (2, 4) is used as the reference length to which the object is scaled. Scaling is available only when you are aligning objects using two point pairs.

**NOTE** If you use two source and destination points to perform a 3D alignment on non-perpendicular working planes, you get unpredictable results.
ALIGN Using Three Pairs of Points When you select three point pairs, you can move and rotate the selected objects in 3D to align with other objects.

The selected objects move from the source point (1) to the destination point (2).

The selected object is rotated (1 and 3) so that it aligns with the destination object (2 and 4).

The selected object is then rotated again (3 and 5) so that it aligns with the destination object (4 and 6).

See also:
Align Objects

AMECONVERT

Converts AME solid models to AutoCAD solid objects.

Summary

The objects you select must be Advanced Modeling Extension (AME) Release 2 or 2.1 regions or solids. All other objects are ignored.

Because of increased accuracy in the new solid modeler, AME models may look slightly different after conversion. This difference is noticeable where the previous version of the solid modeler identified the surfaces of two different shapes as so close as to be considered in the same plane. The new solid
modeler’s finer tolerance may interpret these surfaces as being slightly offset. This phenomenon is most apparent with aligned features such as fillets, chamfers, and through-holes.

Holes might become blind holes when the new modeler, with its much finer approximation capability, interprets what was once a through-hole as being slightly less wide than the solid. Typically, the length of the remaining solid material is the difference between the tolerance of the previous modeler and that of the new modeler.

Likewise, updated fillets or chamfers can occasionally be placed slightly below the surface, creating a hole through the solid, leaving the original shape unaltered. Also, drawing fillets or chamfers slightly above the original surface creates an uneven transition between the solid and the fillet or chamfer.

See also:
Use Models with Other Applications

ANALYSIS CURVATURE

Displays a color gradient onto a surface to evaluate different aspects of its curvature.

Access Methods

Button

Toolbar: Modeling tool set ➤ Analysis tool group ➤ Surface Analysis flyout ➤ Curvature Analysis

Summary

Allows you to visualize Gaussian, minimum, maximum, and mean U and V surface curvature. Maximum curvature and a positive Gaussian value display as green; minimum curvature and a negative Gaussian value display as blue.
Positive Gaussian curvature means that the surface is shaped like a bowl. Negative Gaussian curvature means the surface is shaped like a saddle (as shown below). Mean curvature and a zero Gaussian value means that the surface is flat in at least one direction (planes, cylinders, and cones have zero Gaussian curvature).

To change the curvature analysis display settings, use the Curvature tab (page 65) of the Analysis Options dialog box (page 64).

See also:
- Analyze the Curvature of a NURBS Surface

## ANALYSISDRAFT

Displays a color gradient onto a 3D model to evaluate whether there is adequate space between a part and its mold.

### Access Methods

#### Button

- Toolbar: Modeling tool set ➤ Analysis tool group ➤ Surface Analysis flyout ➤ Draft Analysis

### Summary

The color spectrum shows draft angle changes within a specified range. The maximum draft angle displays as red, and the minimum draft angle displays as blue.
If the surface is parallel to the construction plane with surface normals facing in the **same** direction as the current UCS, the draft angle is 90.0. When perpendicular, it is 0. If the surface is parallel to the current UCS with surface normals facing in the **opposite** direction than the current UCS, the draft angle is -90.0.

To change the draft analysis display settings, use the Draft Angle tab (page 66) of the Analysis Options dialog box (page 64).

**See also:**
- Use the Draft Analysis Tool

**ANALYSISOPTIONS**

Sets the display options for zebra, curvature, and draft analysis.

**Access Methods**

- **Toolbar:**
  - Modeling tool set ➤ Analysis tool group ➤ Surface Analysis flyout ➤ Analysis Options

**Summary**

The Analysis Options dialog box (page 64) is displayed.

**See also:**
- Analyze Surfaces
Analysis Options Dialog Box

Sets the display options for zebra, curvature, and draft analysis.

List of Tabs

The Analysis Options dialog box contains the following tabs:
- Zebra (page 64)
- Curvature (page 65)
- Draft Angle (page 66)

See also:

Analyze Surfaces

Zebra Tab (Analysis Options Dialog Box)

Changes the display settings for the ANALYSISZEBRA command.

List of Options

The following options are displayed.

Select Objects to Analyze

Prompts you to select the surface objects to analyze. When you are done selecting objects, press Enter to return to the dialog box.

Stripe Display

Stripe Direction

Specifies the display angle. (VSAZEBRADIRECTION (page 1544)) This option is only available when Type is set to Cylinder. If you are using the Chrome Ball type, change the stripe directions with the VSAZEBRADIRECTION (page 1544) system variable.

Type

Sets analysis display type. (VSAZEBRATYPE (page 1545))

Size

Sets the width of the zebra stripes. (VSAZEBRASIZE (page 1544))

Color 1
Sets the first color for zebra stripes. (VSAZEBRACOLOR1 (page 1543))

**Color 2**
Sets the second color for zebra stripes. (VSAZEBRACOLOR2 (page 1543))

**Clear Zebra Analysis**
Removes the zebra display from all objects in the current drawing.

**See also:**
Analyze Surfaces

**Curvature Tab (Analysis Options Dialog Box)**
Changes the display settings for the ANALYSISCURVATURE command.

**List of Options**
The following options are displayed.

**Select objects to analyze**
Prompts you to select the surface objects to analyze. When you are done selecting objects, press Enter to return to the dialog box.

**Color Mapping**
Display Style
Specifies the display for color mapping (VSACURVATURETYPE (page 1541) system variable).

Enter the **maximum** curvature value (VSACURVATUREHIGH (page 1540) system variable). When the surface curvature reaches this value, it displays as green.

Enter the **minimum** curvature value (VSACURVATURELOW (page 1541) system variable). When the surface curvature reaches this value, it displays as blue.

**Auto Range**
Calculates the curvature range so that 80% of the values are within the high and low range (VSACURVATUREHIGH (page 1540) and VSACURVATURELOW (page 1541) system variables).

**Max Range**
Calculates the maximum and minimum ranges of all objects selected for curvature analysis (VSACURVATUREHIGH (page 1540) and VSACURVATURELOW (page 1541) system variables).

**Clear Curvature Analysis**
Removes the curvature analysis display from all objects in the current drawing.

**See also:**
Analyze Surfaces

**Draft Angle Tab (Analysis Options Dialog Box)**
Changes the display settings for the ANALYSISDRAFT command.

**List of Options**
The following options are available.

**Select objects to analyze**
Prompts you to select the surface objects to analyze. When you are done selecting objects, press Enter to return to the dialog box.

**Color Mapping**
Maps green to the highest draft angle, red to the medium draft angle, and blue to the lowest draft angle.

**Angle**
Sets the value for the high and low draft angles. The draft angle is the angle in degrees between the surface normal and the UCS plane.

Enter a value for the highest angle allowed (VSADRAFTANGLEHIGH (page 1542)). When the object’s angle reaches this value, it displays in green.

Displays the average value of the high and low angles. When the object’s angle reaches this value, it displays in red.

Enter a value for the lowest angle allowed (VSADRAFTANGLELOW (page 1542)). When the object’s angle reaches this value, it displays in blue.

**Clear Draft Angle Analysis**
Removes the curvature analysis display from all objects in the current drawing.

**See also:**
Analyze Surfaces
ANALYSISZEBRA

Projects stripes onto a 3D model to analyze surface continuity.

Access Methods

Button

Toolbar: Modeling tool set ➤ Analysis tool group ➤ Surface Analysis flyout ➤ Zebra Analysis

Summary

The way the stripes line up where two surfaces meet, helps analyze the tangency and curvature of the intersection.

In this example, the surface continuity is G0 because the surface edges are coincident, but they are not tangent and they have different curvatures. The fact that the stripes are not aligned shows that the surfaces are not tangent.

To change the zebra analysis display settings, use the Zebra Analysis tab (page 64) of the Analysis Options dialog box (page 64).

See also:

Analyze Surface Continuity with Zebra Analysis
ANNORESET

Resets the locations of all alternate scale representations of the selected annotative objects.

Access Methods

Button

Toolbar: Annotation tool set ➤ Annotation Scaling tool group ➤ Sync Scale Positions
Menu: Modify ➤ Annotative Object Scale ➤ Synchronize Multiple-Scale Positions
Shortcut menu: Select an annotative object. Right-click and choose Annotative Object Scale ➤ Synchronize Multiple-Scale Positions.

Summary

The location of each scale representation of an annotative object can be adjusted using grips. For each selected annotative object, all alternate scale representations are returned to the location of the object’s current scale representation.

See also:

Add and Modify Scale Representations

ANNOUPDATE

Updates existing annotative objects to match the current properties of their styles.

Summary

When a non-annotative text object is updated to an annotative text style, the object becomes annotative and supports the current . If the text style has a fixed Paper Height, the object is set to that height. If the text style’s Paper Height is set to 0, the size of the text does not change. The Paper Height value is inferred by dividing the model height by the current annotation scale.
If an annotative object is updated to a non-annotative style, the object becomes non-annotative and any alternate are removed.

See also:
Work with Annotative Styles

**APERTURE**

Controls the size of the object snap target box.

**Access Methods**

Command entry: aperture (or ‘aperture for transparent use)

**Summary**

Object snap applies only to objects inside or crossing the object snap target box. The APBOX (page 1208) system variable controls whether the object snap target box is displayed. The number of pixels you enter using APERTURE controls the size of the object snap box. The higher the number, the larger the target box.

You can also change this setting in the Application Preferences dialog box, Cursor & Selection tab.

APERTURE controls the object snap target box, not the pickbox displayed at the Select Objects prompt. The object selection pickbox is controlled by the PICKBOX (page 1433) system variable.

**APPLOAD**

Loads and unloads applications and defines which applications to load at startup.
Access Methods

Menu: Tools ➤ Load Application

Summary

The Startup Suite option loads the specified applications each time the product first starts. Application files can be dragged from the files list, or from any application with dragging capabilities.

The Load/Unload Applications dialog box (page 70) is displayed.

See also:

Overview of AutoLISP Automatic Loading

Load/Unload Applications Dialog Box

Loads and unloads applications and defines which applications to load at startup.
Summary

Loads and unloads applications and specifies applications to be loaded at startup.

List of Options

The following options are displayed.

The options at the top of this dialog box are derived from the standard file selection dialog box (page 723). Following are descriptions of the additional options provided by the Load/Unload Applications dialog box:

Load Loads or reloads the applications that are currently selected either in the files list or on the History List tab. Load is unavailable until you select a file that you can load. ObjectARX and DBX applications are loaded immediately, but LSP and FAS applications are queued and then loaded when you close the Load/Unload Applications dialog box.
If you select a file that is already loaded, Load reloads the application when applicable. You cannot reload ObjectARX applications. In this case, you must first unload the ObjectARX application and then load it again. The Load option is also available from a shortcut menu by right-clicking a file on the History List tab.

**Loaded Applications**

Displays an alphabetical list (by file name) of currently loaded applications. LISP routines are displayed in this list only if you loaded them in the Load/Unload Applications dialog box.

You can drag files into this list from the files list or from any application with dragging capabilities, such as Finder.

You can also unload certain applications from this list. See the Unload option for details. Files that you cannot unload are not available for selection.

**History List**

Displays an alphabetical list (by file name) of applications that you previously loaded with Add To History selected. If Add To History is not selected when you drag files into this list, the dragged files are loaded but not added to the history list.

You can drag files into this list from the files list, or from any application with dragging capabilities, such as Finder.

You can load and remove applications from this list, but to unload applications, you must use the Loaded Applications tab. See the Load, Unload, and Remove options.

**Add to History**

Adds any applications that you load to the history list.

**Unload/Remove**

Unloads the selected applications or removes them from the History List.

Unload is available only when a file is selected on the Loaded Applications tab. Remove is available only when you select a file on the History List tab. LISP applications cannot be unloaded, nor can ObjectARX applications that are not registered for unloading.

**NOTE** Remove does not unload the selected application. The Remove option is also available from a shortcut menu by right-clicking an application on the History List tab.

**Startup Suite**

Contains a list of applications that are loaded each time you start AutoCAD.
You can drag application files from the files list, or from any application with dragging capabilities such as Finder, into the Startup Suite area to add them to the Startup Suite.

You cannot add applications that you load with the AutoCAD web browser to the Startup Suite.

Contents

Displays the Startup Suite dialog box (page 73). You can also add files to the Startup Suite by clicking the Startup Suite icon or by right-clicking an application on the History List tab and clicking Add to Startup Suite on the shortcut menu.

Status Line

Displays messages that indicate the status of loading and unloading operations.

See also:

Overview of AutoLISP Automatic Loading

**Startup Suite Dialog Box**

Adds and removes application files from the Startup Suite. These are the applications that are loaded each time you start AutoCAD.

![Startup Suite Dialog Box](image)

**List of Options**

The following options are displayed.

**List of Applications**
Displays an alphabetical list (by file name) of the application files to load at startup.

**Add**

Displays the Add File to Startup Suite dialog box. You can use this dialog box to select files to add to the startup suite.

**Remove**

Removes selected files from the Startup Suite.

**See also:**

Overview of AutoLISP Automatic Loading

---

**ARC**

Creates an arc.

**Access Methods**

- **Button**
  - **Toolbar:** Drafting tool set ➤ Open Shapes tool group ➤ Arc flyout
  - **Menu:** Draw ➤ Arc

**Summary**

To create an arc, you can specify combinations of center, endpoint, start point, radius, angle, chord length, and direction values.

**List of Prompts**

The following prompts are displayed.
Specify start point (page 74) of arc or [Center (page 75)]:
Specify a point, enter c, or press Enter to start tangent to last line, arc, or polyline (page 74)

**Start Point**

Specifies the starting point of the arc.
NOTE If you press Enter without specifying a point, the endpoint of the last drawn line or arc is used and you are immediately prompted to specify the endpoint of the new arc. This creates an arc tangent to the last drawn line, arc, or polyline.

Specify second point of arc or [Center/End]:

**Second Point**
Draws an arc using three specified points on the arc's circumference. The first point is the start point (1). The third point is the endpoint (3). The second point (2) is a point on the circumference of the arc.

Specify end point of arc: *Specify a point (3)*

![Three-point arc diagram](image)

You can specify a three-point arc either clockwise or counterclockwise.

**Center**
Specifies the center of the circle of which the arc is a part.

Specify center point of arc:

Specify end point of arc or [Angle/chord Length]:

**End Point** Using the center point (2), draws an arc counterclockwise from the start point (1) to an endpoint that falls on an imaginary ray drawn from the center point through the third point (3).

![End point diagram](image)

The arc does not necessarily pass through this third point, as shown in the illustration.

**Angle** Draws an arc counterclockwise from the start point (1) using a center point (2) with a specified included angle. If the angle is negative, a clockwise arc is drawn.

Specify included angle: *Specify an angle*
Chord Length
Draws either a minor or a major arc based on the distance of a straight line between the start point and endpoint.
If the chord length is positive, the minor arc is drawn counterclockwise from the start point. If the chord length is negative, the major arc is drawn counterclockwise.
Specify length of chord: Specify a length

End
Specifies the endpoint of the arc.
Specify end point of arc:
Specify center point of arc or [Angle/Direction/Radius]:

Center Point
Draws an arc counterclockwise from the start point (1) to an endpoint that falls on an imaginary ray drawn from the center point (3) through the second point specified (2).

Angle
Draws an arc counterclockwise from the start point (1) to an endpoint (2), with a specified included angle. If the angle is negative, a clockwise arc is drawn.
Specify included angle: Enter an angle in degrees or specify an angle by moving the pointing device counterclockwise
**Direction** Begins the arc tangent to a specified direction. It creates any arc, major or minor, clockwise or counterclockwise, beginning with the start point (1), and ending at an endpoint (2). The direction is determined from the start point.

Specify tangent direction for the start point of arc:

**Radius** Draws the minor arc counterclockwise from the start point (1) to the endpoint (2). If the radius is negative, the major arc is drawn.

Specify radius of arc:

**Center**

Specifies the center of the circle of which the arc is a part.

Specify center point of arc:

Specify start point of arc:

Specify end point of arc or [Angle/chord Length]:

**End Point** Draws an arc counterclockwise from the start point (2) to an endpoint that falls on an imaginary ray drawn from the center point (1) through a specified point (3).
**Angle** Draws an arc counterclockwise from the start point (2) using a center point (1) with a specified included angle. If the angle is negative, a clockwise arc is drawn.
Specify included angle:

![Angle Diagram]

**Chord Length** Draws either a minor or a major arc based on the distance of a straight line between the start point and endpoint.
If the chord length is positive, the minor arc is drawn counterclockwise from the start point. If the chord length is negative, the major arc is drawn counterclockwise.
Specify length of chord:

![Chord Length Diagram]

**Tangent to Last Line, Arc, or Polyline**
Draws an arc tangent to the last line, arc, or polyline drawn when you press ENTER at the first prompt.

Specify end point of arc: *Specify a point (1)*

See also:

- Draw Arrows

---

**AREA**

Calculates the area and perimeter of objects or of defined areas.
Summary

Several commands are available to provide area information including AREA, MEASUREGEOM (page 616), and MASSPROP (page 600). Alternatively, use BOUNDARY (page 154) to create a closed polyline or region. Then use LIST (page 583) or the Properties Inspector (page 844) to find the area.

List of Prompts

The following prompts are displayed.

Specify first corner point (page 79) or [Object (page 80)/Add Area (page 80)/Subtract Area (page 81)] <Object>: Select an option

The area and perimeter of the specified object displays at the Command prompt and in the tooltip.

Specify Corner Points

Calculates the area and perimeter defined by specified points. All points must lie in a plane parallel to the XY plane of the current user coordinate system (UCS).

A rubberband line from the first specified point to the cursor is displayed. Once the second point is specified, a line segment and a polygon with green fill are displayed.

Continue to specify points to define a polygon and then press Enter to complete the definition of the perimeter. The area to be calculated is highlighted in green.

If you do not close the polygon, the area is calculated as if a line were drawn from the last point entered to the first. When the perimeter is calculated, that line length is added.

A Commands | 79
Object
Calculates the area and perimeter of a selected object. You can calculate the area of circles, ellipses, splines, polylines, polygons, regions, and 3D solids.

NOTE 2D solids (created with the SOLID (page 989) command) do not have an area reported.

Select object:
If you select an open polyline, the area is calculated as if a line were drawn from the last point entered to the first. When the perimeter is calculated that line length is ignored.

The centerline of a wide polyline is used to make area and perimeter calculations.

The centerline of a wide polyline is used to make area and perimeter (or length) calculations.

Add Area
Turns on Add mode and keeps a running balance of the total area as you continue to define areas. You can use the Add Area option to calculate individual areas and perimeters of defined areas and objects and the total area of all defined areas and objects.

You can also select to specify the points. A rubberband line from the first specified point to the cursor is displayed.
Specify points to define a polygon (3). The area to be added is highlighted in green. Press Enter. AREA calculates the area and perimeter and returns the total area of all the areas defined by selecting points or objects since Add mode was turned on.

If you do not close the polygon, the area is calculated as if a line were drawn from the last point entered to the first. When the perimeter is calculated, that line length is added.

**Subtract Area**

Similar to the Add Area option, but subtracts areas and perimeters. You can use the Subtract Area option to subtract a specified area from a total area.

You can also specify the area to be subtracted with points. A rubberband line from the first specified point to the cursor is displayed.

The specified area to be subtracted is highlighted in red.

The total area and perimeter displays at the Command prompt and in the tooltip.

**See also:**

Obtain Area and Mass Properties Information

## ARRAY

Creates copies of objects arranged in a 2D or 3D pattern.
Access Methods

Button

Menu: Modify ➤ Array
Toolbar: Drafting tool set ➤ Copy tool group ➤ Array flyout

Summary

You can create copies of objects in a regularly spaced rectangular, polar, or path array.

The DELOBJ (page 1251) system variable controls whether the source objects of the array are deleted or retained after the array is created.

If you enter -array at the Command prompt, options are displayed (page 83).

List of Prompts

The following prompts are displayed.

Select objects: Use an object selection method
Enter array type [Rectangular (page 82)/Path (page 82)/Polar (page 82)] <Rectangular>: Enter an option or press Enter

Rectangular Distributes copies of the selected object into any combination of rows, columns, and levels (same as the ARRAYRECT (page 107) command).

Path Evenly distributes copies of the selected object along a path or a portion of a path (same as the ARRAYPATH (page 99) command).

Polar Evenly distributes copies of the object in a circular pattern around a center point or axis of rotation (same as the ARRAYPOLAR (page 103) command).
See also:

Array Objects

-ARRAY

Maintains legacy command line behavior for creating nonassociative, 2D rectangular or polar arrays.

List of Prompts

The following prompts are displayed.

Select objects: Use an object selection method

Enter the type of array [Rectangular (page 83)/Polar (page 84)] <current>: Enter an option or press Enter

**Rectangular**

Creates an array of rows and columns of copies of the selected objects.

Enter the number of rows (---) <1>: Enter a nonzero integer or press Enter

Enter the number of columns (|||) <1>: Enter a nonzero integer or press Enter

If you specify one row, you must specify more than one column and vice versa.

The selected object, or cornerstone element, is assumed to be in the lower-left corner, and generates the array up and to the right.

The specified distance between the rows and columns includes the corresponding lengths of the object to be arrayed.

Enter the distance between rows or specify unit cell (---):

To add rows downward, specify a negative value for the distance between rows. ARRAY skips the next prompt if you specify two points for the opposite corners of a rectangle.

Specify the distance between columns (|||):
To add columns to the left, specify a negative value for the distance between columns. Rectangular arrays are constructed along a baseline defined by the current snap rotation. This angle is normally 0, so the rows and columns are orthogonal with respect to the X and Y drawing axes. The Rotate option of the SNAP (page 986) command changes the angle and creates a rotated array. The SNAPANG (page 1481) system variable stores the snap rotation angle.

If you specify a large number of rows and columns for the array, it might take a while to create the copies. By default, the maximum number of array elements that you can generate in one command is 100,000. How you change this limit depends on the product:

- Most AutoCAD-based products: The limit is set by the MAXARRAY setting in the registry. To reset the limit to 200,000, for example, enter (setenv "MaxArray" "200000") at the Command prompt.
- AutoCAD LT: You can change the maximum number of array elements by setting the MaxArray system registry variable using the SETENV command.

**Polar**

Creates an array by copying the selected objects around a specified center point.

Specify center point of array or [Base]: Specify a point or enter b to specify a new base point

**Center Point** Creates an array defined by a center point.

**Base** Specifies a new reference (base) point relative to the selected objects that will remain at a constant distance from the center point of the array as the objects are arrayed.

Enter the number of items in the array: Enter a positive integer or press Enter

If you enter a value for the number of items, you must specify either the angle to fill or the angle between items. If you press Enter (and do not provide the number of items), you must specify both.
Specify the angle to fill (+=ccw, -=cw) <360>: Enter a positive number for a counterclockwise rotation or a negative number for a clockwise rotation

You can enter 0 for the angle to fill only if you specify the number of items.

If you specify an angle to fill without providing the number of items, or if you specify the number of items and enter 0 as the angle to fill or press Enter, the following prompt is displayed:

Angle between items: Specify an angle

If you specified the number of items and entered 0 as the angle to fill or pressed Enter, ARRAY prompts for a positive or negative number to indicate the direction of the array:

Angle between items (+=ccw, -=cw): Enter a positive number for a counterclockwise rotation or a negative number for a clockwise rotation

ARRAY determines the distance from the array's center point to a reference point on the last object selected. Reference points include locations such as the center point of a circle or arc, the insertion base point of a block, the start point of text, or the endpoint of a line.

Rotate arrayed objects? <Y>: Enter y, or n, or press Enter

In a polar array, the reference point of the last object in the selection set is used for all objects. If you defined the selection set by using window or crossing selection, the last object in the selection set is arbitrary. Removing an object from the selection set and adding it back forces that object to be the last object selected. You can also make the selection set into a block and replicate it.

See also:

Array Objects

**ARRAYCLASSIC**

Creates copies of objects arranged in a 2D pattern using the legacy dialog box.

**Summary**

You can create copies of objects in a regularly spaced rectangular or polar array in the **Array dialog box** (page 86).

If you enter -array at the Command prompt, **options are displayed** (page 83).
NOTE This legacy dialog box does not support array associativity or path arrays. To use these features, use the ARRAY command.

See also:
Array Objects

Array Dialog Box

Creates multiple copies of objects in a pattern.
List of Options

The following options are displayed.

Select Objects

Specifies the objects used to construct the array. You can select objects before or after the Array dialog box is displayed. To select objects when the Array dialog box is displayed, choose Select Objects. The dialog box temporarily closes. When you finish selecting objects, press Enter. The Array dialog box is redisplayed, and the number of objects selected is shown below the Select Objects button.

NOTE If you select multiple objects, the base point of the last selected object is used to construct the array.

Preview Area

Shows a preview image of the array based on the current settings in the dialog box. The preview image is dynamically updated when you move to another field after changing a setting.

Rectangular Array

Creates an array of rows and columns of copies of the selected object.

Rows

Specifies the number of rows in the array. If you specify one row, you must specify more than one column. If you specify a large number of rows and columns for the array, it might take a while to create the copies. By default, the maximum number of array elements that you can generate in one command is 100,000. The limit is set by the MAXARRAY setting in the registry. To reset the limit to 200,000, for example, enter (setenv "MaxArray" "200000") at the Command prompt.

Columns

Specifies the number of columns in the array. If you specify one column, you must specify more than one row. If you specify a large number of rows and columns for the array, it might take a while to create the copies. By default, the maximum number of array elements that
you can generate in one command is 100,000. The limit is set by the MAXARRAY setting in the registry. To reset the limit to 200,000, for example, enter (setenv "MaxArray" "200000") at the Command prompt.

**Offset Distance and Angle**
Provides a space for you to specify the distance and direction of the array's offset.

**Row Offset**
Specifies the distance (in units) between rows. To add rows downward, specify a negative value. To specify row spacing with the pointing device, use the Pick Both Offsets button or the Pick Row Offset button.

**Column Offset**
Specifies the distance (in units) between columns. To add columns to the left, specify a negative value. To specify column spacing with the pointing device, use the Pick Both Offsets button or the Pick Column Offset button.

**Angle of Array**
Specifies the angle of rotation. This angle is normally 0, so the rows and columns are orthogonal with respect to the X and Y drawing axes of the current UCS. You can change the measurement conventions for angles using UNITS (page 1130). The ANGBASE (page 1205) and ANGDIR (page 1205) system variables affect the angle of arrays.

**Pick Row Offset**
Temporarily closes the Array dialog box so that you can use the pointing device to specify the distance between rows. ARRAY prompts you to specify two points and uses the distance and direction between the points to specify the value in Row Offset.

**Pick Column Offset**
Temporarily closes the Array dialog box so that you can use the pointing device to specify the distance between columns. ARRAY prompts you to specify two points and uses the distance and direction between the points to specify the value in Column Offset.

**Pick Angle of Array**
Temporarily closes the Array dialog box so that you can specify the angle of rotation by entering a value or using the pointing device to specify two points. You can change the measurement conventions for angles using UNITS (page 1130). The ANGBASE (page 1205) and ANGDIR (page 1205) system variables affect the angle of arrays.
Pick Both Offsets
Temporarily closes the Array dialog box so that you can use the pointing device to set the row and column spacing by specifying two diagonal corners of a rectangle.

**Polar Array**
Creates an array by copying the selected objects around a specified center point.

**Center Point**
Specifies the center point of the polar array. Enter coordinate values for X and Y, or choose Pick Center Point to use the pointing device to specify the location.

**Pick Center Point**
Temporarily closes the Array dialog box so that you can use the pointing device to specify the center point in the drawing area.

**Spacing Methods**
Specifies the method and values used to position objects in the polar array.

**Method**
Sets the method used to position objects. This setting controls which of the Method and Value fields are available for specifying values. For example, if the method is Total Number of Items & Angle to Fill, the related fields are available for specifying values; the Angle Between Items field is not available.

**Total Number of Items**
Sets the number of objects that appear in the resultant array. The default value is 4.

**Angle to Fill**
Sets the size of the array by defining the included angle between the base points of the first and last elements in the array. A positive value specifies
counterclockwise rotation. A negative value specifies clockwise rotation. The default value is 360. A value of 0 is not permitted.

**Pick Angle to Fill** Temporarily closes the Array dialog box so that you can define the included angle between the base points of the first and last elements in the array. ARRAY prompts you to select a point relative to another point in the drawing area.

**Angle Between Items**

Sets the included angle between the base points of the arrayed objects and the center of the array. Enter a positive value. The default direction value is 90.

**NOTE** You can choose the Pick buttons and use the pointing device to specify the values for Angle to Fill and Angle Between Items.

**Pick Angle Between Items** Temporarily closes the Array dialog box so that you can define the included angle between the base points of the arrayed objects and the center of the array. ARRAY prompts you to select a point relative to another point in the drawing area.

**Rotation and Base Point**

Specifies the rotation and object base point for the polar array.

**Rotate Items as Copied** Rotates the items in the array, as shown in the preview area.

**Use Object Base Point** Uses the default base point of the object to position the arrayed object. To manually set the base point, clear this option.

**Base point settings by object**

<table>
<thead>
<tr>
<th>Object type</th>
<th>Default base point</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arc, circle, ellipse</td>
<td>Center point</td>
</tr>
<tr>
<td>Polygon, rectangle</td>
<td>First corner</td>
</tr>
<tr>
<td>Donut, line, polyline, 3D polyline, ray, spline</td>
<td>Starting point</td>
</tr>
<tr>
<td>Block, paragraph text, single-line text</td>
<td>Insertion point</td>
</tr>
<tr>
<td>Construction lines</td>
<td>Midpoint</td>
</tr>
</tbody>
</table>
Base point settings by object

<table>
<thead>
<tr>
<th>Object type</th>
<th>Default base point</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region</td>
<td>Grip point</td>
</tr>
</tbody>
</table>

Base Point

**NOTE** To avoid unexpected results, set the base point manually if you are constructing a polar array and do not want to rotate the objects.

**Preview**
Closes the Array dialog box and displays the array in the current drawing.

**See also:**
Array Objects

**ARRAYCLOSE**

Saves or discards changes made to an array's source objects and exits the array editing state.

**Access Methods**

- **Toolbar:** Edit Array visor ➤ Discard Changes/Save Changes
- **Shortcut menu:** Right-click in drawing area and click Close Array Edit Session ➤ Save Edits to Array/Discard Edits to Array

**Summary**

The Source option of **ARRAYEDIT** (page 92) activates an editing state in which you can edit the source objects of a selected array item. While the editing state is active, the Edit Array visor is displayed. Save or discard changes to exit the editing state.

**List of Prompts**

The following prompts are displayed.
Save changes to array [Yes (page 92)/No (page 92)] <Yes>:

*Enter an option*
**Discard Changes**
Discards any changes made; the source object or replacement item in the array is returned to its original state.

**Save Changes**
Saves all changes made to the source object or to a replacement item of the array.

*See also:*
Array Objects

**ARRAYEDIT**
Edits associative array objects and their source objects.

**Access Methods**

♂ **Menu:** Modify ➤ Object ➤ Array
♂ **Toolbar:** <current> Array visor ➤ Edit Source
**Shortcut menu:** Select an associative array. Right-click and choose Array ➤ Edit Array.

**Summary**
Modify associative arrays by editing the array properties, editing source objects, or replacing items with other objects.

When you edit source objects, an editing state is activated. Save or discard changes (*ARRAYCLOSE* (page 91)) to exit the editing state.

When you select a single associative array object, one of the following visors is displayed:
- Path Array visor (page 96)
- Polar Array visor (page 97)
- Rectangular Array visor (page 98)

**List of Prompts**
The following prompt is displayed.
*Select array: Use an object selection method*

The array type determines the remaining prompts.
For rectangular arrays:
Enter an option [Source (page 93)/REPlace (page 93)/Base point (page 93)/Rows (page 94)/Columns (page 94)/Levels (page 94)/RESet (page 95)/eXit (page 95)] <eXit>:

For path arrays:
Enter an option [Source/REPlace/Method (page 94)/Base point/Items (page 95)/Rows/Levels/Align items (page 95)/Z direction (page 95)/RESet/eXit] <eXit>:

For polar arrays:
Enter an option [Source/REPlace/Base point/Items/Angle between (page 95)/Fill angle (page 95)/Rows/Levels/ROTate items (page 95)/RESet/eXit] <eXit>:

**Source**
Activates an editing state in which you can update the associative array by editing one of its items. All changes (including the creation of new objects) are instantly applied to all items that reference the same source objects.

**Item in Array** Select a source object to modify. All changes (including the creation of new objects) are instantly applied to all items that reference the same source objects. While the editing state is active, the Edit Array visor is displayed. Save or discard the changes (ARRAYCLOSE (page 91)) to exit the editing state.

**Replace**
Replaces the source objects for selected items or for all items referencing the original source objects.

**Replacement Objects** Selects the new source objects.

**Base Point of Replacement Object** Specifies a base point for positioning each replacement object.

**Key Point** Specifies a constraint point to be used for positioning.

**Item in Array the Array to Replace** Specifies an array item to replace, and continues to prompt for additional items.

- **Source objects**. Replaces the original set of source objects in the array, which updates all items that have not been previously replaced.

**Base Point**
Redefines the base point of the array. Path arrays are repositioned relative to the new base point.
Base Point Specifies a base point for positioning the objects in the array.

Key Point For associative arrays, specifies a valid constraint (or key point) on the source objects to use as the base point. If you edit the source objects of the resulting array, the base point of the array remains coincident with the key point of the source objects.

Rows Specifies the number and spacing of rows, and the incrementing elevation between them.

Number of Rows Specifies the number of rows in the array.

Expression Derives a value using a mathematical formula or equation.

Total Specifies the total distance between the first and last rows.

Incrementing Elevation Specifies the amount of elevation change between each successive row.

Columns (Rectangular Arrays) Specifies the number and spacing of columns.

Number of Columns Specifies the number of columns in the array.

Distance Between Columns Specifies the distance between columns.

Expression Derives a value using a mathematical formula or equation.

Total Specifies the total distance between the first and last columns.

Levels Specifies the number and spacing of levels (for 3D arrays).

Number of Levels Specifies the number of levels in the array.

Distance Between Levels Specifies the distance between the levels.

Expression Derives a value using a mathematical formula or equation.

Total Specifies the total distance between the first and last levels.

Method (Path Arrays) Controls how to distribute items along the path.

- Divide. Redistributes items to divide evenly along the length of the path.

- Measure. Maintains current spacing when the path is edited, or when the number of items is edited through grips or the Properties Inspector. When the number of items is edited using ARRAYEDIT, you are prompted to redefine the distribution method.
**Items (Path and Polar Arrays)**
Specifies the number of items in the array.

**Number of Items** Specifies the number of items in the array using a value or expression.

**Fill Entire Path (Path Arrays)** Uses the distance between items value to determine how the path is filled. Use this option if you expect the size of the path to change and want to maintain a specific spacing between array items. For path arrays whose Method property is set to Measure, you are prompted to redefine the distribution method (Divide, Total, Expression).

**Align Items (Path Arrays)**
Specifies whether to align each item to be tangent to the path direction. Alignment is relative to the orientation of the first item.

![Alignment Diagram](source object)

**Z Direction (Path Arrays)**
Specifies whether to maintain the original Z direction or to naturally bank the items along a 3D path.

**Angle Between (Polar Arrays)**
Specifies the angle between items using a value or expression.

**Fill Angle (Polar Arrays)**
Specifies the angle between the first and last item in the array using a value or expression.

**Rotate Items (Polar Arrays)**
Specifies whether items are rotated as they are arrayed.

**Reset**
Restores erased items and removes any item overrides.

**Exit**
Exits the command.
See also:

Edit Associative Arrays

Path Array Visor

Modifies the properties of an associative path array, such as base point, array method, and Z direction.

Summary

The Path Array visor is displayed when you select an associative array created with the Path option. The options on this visor can also be accessed using the \texttt{ARRAYEDIT} (page 92) command from the Command prompt.

List of Options

The following options are displayed.

\textbf{Base Point}
Redefines the base point of the array. Path arrays are repositioned relative to the new base point.

\textbf{Array Method}
Controls how to distribute items along the path.

\textbf{Edit Source}
Activates an editing state in which you can update the associative array by editing one of its items.

\textbf{Replace Item}
Replaces the source objects for selected items or for all items referencing the original source objects.

\textbf{Reset Array}
Restores erased items and removes any item overrides.

\textbf{Rotate Items}
Specifies whether items are rotated as they are arrayed.
Align Items
Specifies whether to align each item to be tangent to the path direction. Alignment is relative to the orientation of the first item.

Z Direction
Specifies whether to maintain the original Z direction or to naturally bank the items along a 3D path.

See also:
   Edit Associative Arrays

Polar Array Visor

Modifies the properties of an associative polar array, such as base point and item rotation.

Summary
The Polar Array visor is displayed when you select an associative array created with the Polar option. The options on this visor can also be accessed using the ARRAYEDIT (page 92) command from the Command prompt.

List of Options
The following options are displayed.

Base Point
Redefines the base point of the array. Path arrays are repositioned relative to the new base point.

Edit Source
Activates an editing state in which you can update the associative array by editing one of its items.

Replace Item
Replaces the source objects for selected items or for all items referencing the original source objects.

Reset Array
Restores erased items and removes any item overrides.
**Rotate Items**  
Specifies whether items are rotated as they are arrayed.

**See also:**  
Edit Associative Arrays

---

**Rectangular Array Visor**

Modifies the properties of an associative rectangular array, such as base point and source item.

---

**Summary**

The Rectangular Array visor is displayed when you select an associative array created with the Rectangular option. The options on this visor can also be accessed using the `ARRAYEDIT` (page 92) command from the Command prompt.

**List of Options**

The following options are displayed.

**Base Point**  
Redefines the base point of the array. Path arrays are repositioned relative to the new base point.

**Edit Source**  
Activates an editing state in which you can update the associative array by editing one of its items.

**Replace Item**  
Replaces the source objects for selected items or for all items referencing the original source objects.

**Reset Array**  
Restores erased items and removes any item overrides.

**See also:**  
Edit Associative Arrays
ARRAYPATH

Evenly distributes object copies along a path or a portion of a path.

**Access Methods**

- **Button**
- **Menu: Modify ➤ Array ➤ Path Array**
- **Command entry:** Drafting tool set ➤ Copy tool group ➤ Array flyout ➤ Path Array

**Summary**

The path can be a line, polyline, 3D polyline, spline, helix, arc, circle, or ellipse.

**NOTE** The 3D objects used in the example cannot be created in AutoCAD LT.

This command is equivalent to the Path option in ARRAY (page 81) command.

After selecting objects to array and a path curve for the objects to follow, the Create Array visor for path arrays (page 102) is displayed.

You can also use the Properties Inspector to set the properties of the new array while it is being created.

**List of Prompts**

The following prompts are displayed.

Select objects: *Use an object selection method*

Select path curve (page 100): *Use an object selection method*

Select grip to edit array or [A]ssociative (page 100)/Method/Base point (page 100)/Tangent direction/Items (page...
Path Curve
Specifies the object to use for the path of the array. Select a line, polyline, 3D polyline, spline, helix, arc, circle, or ellipse.

Associative
Specifies whether the arrayed objects are associative or independent.

- Yes. Contains array items in a single *array object*, similar to a block. With an associative array, you can quickly propagate changes throughout the array by editing the properties and source objects.
- No. Creates array items as independent objects. Changes to one item do not affect the other items.

Method
Controls how to distribute items along the path.

- Divide Distributes a specified number of items evenly along the length of the path.
- Measure Distributes items along the path at specified intervals.

Base Point
Defines the base point of the array. Items in path arrays are positioned relative to the base point.

Base Point Specifies a base point for positioning the items in the array.

Key Point For associative arrays, specifies a valid constraint (or key point) on the source objects to align with the path. If you edit the source objects or path of the resulting array, the base point of the array remains coincident with the key point of the source objects.

Tangent Direction
Specifies how the arrayed items are aligned relative to the path.

- 2 Points Specifies two points that represent the tangency of the arrayed items relative to the path. The vector of the two points establishes the tangency of the first item in the array. The Align Items setting controls whether the other items in the array maintain a tangent or parallel orientation.
- Normal Orient the arrayed objects with the Z axis of the current UCS.

Items
Depending on the Method setting, specifies the number of items or the distance between items.
**Number of Items Along Path (Available when Method equals Divide)** Using a value or expression, specifies how many items are in the array.

**Distance Between Items Along Path (Available when Method equals Measure)** Using a value or expression, specifies the distance between arrayed items. By default, the array is populated with the maximum number of items that fill the path using the distance entered. You can specify a smaller number of items if desired. You can also turn on Fill Entire Path so that the number of items is adjusted if the length of the path changes.

**Rows**
Specifies the number of rows in the array, the distance between them, and the incremental elevation between row.

- **Number of Rows** Sets the number of rows.
- **Distance Between Rows** Specifies the distance between each row, measured from equivalent locations on each object.
- **Total** Specifies the total distance between the start and end row, measured from equivalent locations on the start and end objects. Incrementing elevation affects the increasing or decreasing elevation for each subsequent row.
- **Expression** Derives the value based on a mathematical formula or equation.

**Levels**
Specifies the number and spacing of levels for 3D arrays.

- **Number of Levels** Specifies the number of levels in the array.
- **Distance Between Levels** Specifies the distance between the levels.
- **Total** Specifies the total distance between the first and last levels.
- **Expression** Derives a value using a mathematical formula or equation.

**Align Items**
Specifies whether to align each item to be tangent to the path direction. Alignment is relative to the first item’s orientation.
**Z Direction**
Controls whether to maintain the items’ original Z direction or to naturally bank the items along a 3D path.

**Exit**
Exits the command.

**See also:**
Create Path Arrays

## Create Array Visor - Path Array

Modifies the properties of the path array as it is being created.

### Summary

The Create Array visor is displayed after selecting the objects to array and the path in which the objects to follow while using the Path option of the ARRAY command or the ARRAYPATH command.

### List of Options

The following options are displayed.

**Base Point**
Specifies a base point for the array.
**Method**
Controls how to distribute items along the path.

**Items**
Depending on the Method setting, specifies the number of items or the distance between items.

- **Fill Entire Path** Toggles the distribution of the select objects equally along the entire path.
- **Item Count** Specifies how many items are in the array.
  Available only when Method equals Divide and Fill Entire Path is not enabled.

**Spacing**
Specifies the distance between arrayed items.
Available only when Method equals Measure.

**Save Changes**
Saves the changes to the array and exits the command.

**See also:**
Create Path Arrays

---

**ARRAYPOLAR**

Evenly distributes object copies in a circular pattern around a center point or axis of rotation.

**Access Methods**

- **Button**
- **Menu: Modify ➤ Array ➤ Polar Array**
- **Command entry:** Drafting tool set ➤ Copy tool group ➤ Array flyout ➤ Polar Array

**Summary**

Creates an array by copying the selected objects around a specified center point or axis of rotation.
This command is equivalent to the Polar option in `ARRAY` (page 81).

After selecting objects to array and a center point for the array, the Create Array visor for polar arrays (page 106) is displayed.

You can also use the Properties Inspector to set the properties of the new array while it is being created.

**List of Prompts**

The following prompts are displayed.

Select objects:  *Use an object selection method*

Specify center point (page 104) of array or [Base point (page 104)/Axis of rotation (page 104)]:  *Specify a center point, or enter an option*

Select grip to edit array or [ASSociative (page 105)/Base point/Items (page 105)/Angle between (page 105)/Fill angle (page 105)/ROWS (page 105)/Levels (page 105)/ROTate items (page 106)/eXit (page 106)]<eXit>:  *Select a grip or an option*

**Center Point**

Specifies the point around which to distribute the array items. The axis of rotation is the Z axis of the current UCS.

**Base Point**

Specifies a base point for the array.

**Base Point** Specifies a base point for positioning the objects in the array.

**Key Point** For associative arrays, specifies a valid constraint (or key point) on the source objects to use as the base point. If you edit the source objects of the resulting array, the base point of the array remains coincident with the key point of the source objects.

**Axis of Rotation**

Specifies a custom axis of rotation defined by two specified points.
Associative
Specifies whether the arrayed objects are associative or independent.

- **Yes.** Contains array items in a single *array object*, similar to a block. With an associative array, you can quickly propagate changes throughout the array by editing the properties and source objects.
- **No.** Creates array items as independent objects. Changes to one item do not affect the other items.

**Items**
Specifies the number of items in the array using a value or expression.

**NOTE** When defining the fill angle in an expression, the (+ or -) mathematical symbol in the resultant value does not affect the direction of the array.

**Angle Between**
Specifies the angle between items using a value or expression.

**Fill Angle**
Specifies the angle between the first and last item in the array using a value or expression.

**Rows**
Specifies the number of rows in the array, the distance between them, and the incremental elevation between row.

**Number of Rows** Sets the number of rows.

**Distance Between Rows** Specifies the distance between each row, measured from equivalent locations on each object.

**Total** Specifies the total distance between the start and end row, measured from equivalent locations on the start and end objects.

**Incrementing Elevation** Sets the increasing or decreasing elevation for each subsequent row.

**Expression** Derives the value based on a mathematical formula or equation.

**Levels**
Specifies the number and spacing of levels (for 3D arrays).

**Number of Levels** Specifies the number of levels in the array.

**Distance Between Levels** Specifies the distance between the levels.

**Expression** Derives a value using a mathematical formula or equation.

**Total** Specifies the total distance between the first and last levels.
**Rotate Items**  
Controls whether items are rotated as they are arrayed.

**Exit**  
Exits the command.

**See also:**  
Create Polar Arrays

---

**Create Array Visor - Polar Array**

Modifies the properties of the polar array as it is being created.

---

**Summary**

The Create Array visor is displayed after selecting the objects to array and the center point or axis of rotation in which the objects are arrayed around while using the Polar option of the ARRAY command or the ARRAYPOLAR command.

**List of Options**

The following options are displayed.

**Base Point**  
Specifies a base point for the array.

**Items**  
Specifies the number of items in the array.

**Fill Angle**  
Specifies the angle between the first and last item in the array using a value or expression.

**Save Changes**  
Saves the changes to the array and exits the command.

**See also:**  
Create Polar Arrays
ARRAYRECT

Distributes object copies into any combination of rows, columns, and levels.

Access Methods

Button

Menu: Modify ➤ Array ➤ Rectangular Array
Toolbar: Drafting tool set ➤ Copy tool group ➤ Array flyout ➤ Rectangular Array

Summary

Creates an array of rows and columns of copies of the selected object.

2D rectangular array with one item replaced
2D rectangular array with one item replaced

3D rectangular array with three levels
3D rectangular array with three levels

NOTE The 3D objects in the example cannot be created in AutoCAD LT.
This command is equivalent to the Rectangular option in 3D rectangular array with three levels (page 81).

After selecting objects to array, the Create Array visor for rectangular arrays (page 110) is displayed.

You can also use the Properties Inspector to set the properties of the new array while it is being created.

**List of Prompts**

The following prompts are displayed.

Select objects: Use an object selection method
Select grip to edit array or [ASSociative (page 108)/ANgle (page 108)/Base point (page 108)/Rows (page 109)/Columns (page 109)/Levels (page 109)/COUnt/Spacing (page 109)/eXit (page 110)]

<eXit>: Select a grip or an option

**Associative**

Specifies whether the arrayed objects are associative or independent.

- **Yes.** Contains array items in a single *array object*, similar to a block. With an associative array, you can quickly propagate changes throughout the array by editing the properties and source objects.

- **No.** Creates array items as independent objects. Changes to one item do not affect the other items.

**Angle**

Specifies the angle of rotation for the row axis. The row and column axes remain orthogonal to each other. For associative arrays, you can later edit the individual row and column angles.

You can change the measurement conventions for angles using UNITS (page 1130). The ANGBASE (page 1205) and ANGDIR (page 1205) system variables affect the angle of arrays.

**Base Point**

Defines the base point of the array. Items in path arrays are positioned relative to the base point.

**Base Point** Specifies a base point for positioning the items in the array.

**Key Point** For associative arrays, specifies a valid constraint (or *key point*) on the source objects to align with the path. If you edit the source objects or path of the resulting array, the base point of the array remains coincident with the key point of the source objects.
**Rows**
Specifies the number of rows in the array, the distance between them, and the incremental elevation between row.

**Number of Rows** Sets the number of rows.

**Distance Between Rows** Specifies the distance between each row, measured from equivalent locations on each object.

**Total** Specifies the total distance between the start and end row, measured from equivalent locations on the start and end objects.

**Incrementing Elevation** Sets the increasing or decreasing elevation for each subsequent row.

**Expression** Derives the value based on a mathematical formula or equation.

**Columns**
Edits the number and spacing of columns.

**Number of Columns** Sets the number of columns.

**Distance Between Columns** Specifies the distance between each column, measured from equivalent locations on each object.

**Total** Specifies the total distance between the start and end column, measured from equivalent locations on the start and end objects.

**Expression** Derives the value based on a mathematical formula or equation.

**Levels**
Specifies the number and spacing of levels for 3D arrays.

**Number of Levels** Specifies the number of levels in the array.

**Distance Between Levels** Specifies the difference in Z coordinate values between equivalent locations on each object.

**Total** Specifies the total difference in Z coordinate values between equivalent locations on objects in the first and last levels.

**Expression** Derives the value based on a mathematical formula or equation.

**Count**
Specifies the number of rows and columns and provides a dynamic view of results as you move the cursor (a quicker alternative to the Rows and Columns options).

**Spacing**
Specifies row and column spacing and provides a dynamic view of results as you move the cursor.
**Distance Between Rows** Specifies the distance between each row, measured from equivalent locations on each object.

**Distance Between Columns** Specifies the distance between each column, measured from equivalent locations on each object.

**Unit Cell** Specifies the distance between rows and columns simultaneously by setting the each corner of a rectangular area that is equivalent to the spacing.

**Expression** Derives the value based on a mathematical formula or equation.

**Exit** Exits the command.

**See also:**
Create Rectangular Arrays

**Create Array Visor - Rectangular Array**

Modifies the properties of the rectangular array as it is being created.

---

**Summary**

The Create Array visor is displayed after selecting the objects to array while using the Rectangular option of the ARRAY command or the ARRAYRECT command.

**List of Options**

The following options are displayed.

**Base Point**
Specifies a base point for the array.

**Columns**
Specifies the number of columns.

**Rows**
Specifies the number of rows.
Save Changes
Saves the changes to the array and exits the command.

See also:
Create Rectangular Arrays

ARX

Loads, unloads, and provides information about ObjectARX applications.

List of Prompts
The following prompts are displayed.
Enter an option [Files (page 111)/Groups (page 111)/Commands (page 111)/CLasses (page 111)/Services (page 111)/Load (page 111)/Unload (page 111)]:

Files
Lists the currently loaded ObjectARX applications, which can be third-party programs or internal applications such as Render.

Groups
Causes the specified group of commands to be the first group searched when resolving the names of AutoCAD commands.

Commands
Lists the AcEd-registered commands (AcEd-registered commands are described in the ObjectARX Developer’s Guide).

Classes
Displays a class hierarchy of C++ classes derived from objects registered in the system.

Services
Lists the names of all registered services.

Load
Displays the ObjectARX/DBX File dialog box (a standard file selection dialog box (page 723)). This option loads the specified ObjectARX application.

Unload
Unloads the specified ObjectARX application.
Enter ARX/DBX file name to unload:
ATTACH

Inserts an external reference, raster image, or underlay (PDF files) in the current drawing.

Access Methods

Menu: File ➤ Attach

Summary

The Select Reference File dialog box (a standard file selection dialog box (page 723)) is displayed. To select multiple DWG files for attach, set the Files of Type to Drawing. You can select one file only for all other file formats.

See also:

Attach PDF Files as Underlays
Attach and Detach Referenced Drawings
Attach Raster Image Files

ATTDEF

Creates an attribute definition for storing data in a block.

Access Methods

Button

Toolbar: Drafting tool set ➤ Block tool group ➤ Define Attributes
Menu: Draw ➤ Block ➤ Define Attributes

Summary

The Attribute Definition dialog box (page 113) is displayed.
If you enter `-attdef` at the Command prompt, options are displayed (page 117).

An attribute is an object that is created and included with a block definition. Attributes can store data such as part numbers, product names, and so on.

See also:

Define Block Attributes

**Attribute Definition Dialog Box**

Defines the mode; attribute tag, prompt, and value; insertion point; and text settings for an attribute.
List of Options

The following options are displayed.

**Attribute**
Sets attribute data.

**Tag**
Identifies each occurrence of an attribute in the drawing. Enter the attribute tag using any combination of characters except spaces. Lowercase letters are automatically changed to uppercase.

**Prompt**
Specifies the prompt that is displayed when you insert a block containing this attribute definition. If you do not enter a prompt, the attribute tag is used as a prompt. If you select Constant in the Attribute Options area under Advanced Options, the Prompt option is not available.

**Default**
Specifies the default attribute value.

**Insert Field Button**
Displays the Field dialog box (page 432). You can insert a field as all or part of the value for an attribute. This button is available when you are not creating a multiline attribute. If you are creating a multiline attribute, right-click in the multiline in-place text editor and choose Field.

**Multiline Editor Button**
When Multiple Line mode is selected, displays an in-place text editor with a text formatting toolbar and ruler. Depending on the setting of the ATTIPE (page 1212) system variable, the Text Formatting toolbar displayed is either the abbreviated version, or the full version. For more information, see the In-Place Text Editor (page 678).

**NOTE** Several options in the full In-Place Text Editor are grayed out to preserve compatibility with single-line attributes.

**Text Settings**
Sets the justification, style, height, and rotation of the attribute text.

**Text Style**
Specifies a predefined text style for the attribute text. Currently loaded text styles are displayed. To load or create a text style, see STYLE (page 1040).
Justification
Specifies the justification of the attribute text. See TEXT (page 1078) for a description of the justification options.

Annotative
Specifies that the attribute is annotative. If the block is annotative, the attribute will match the orientation of the block. Click the information icon to learn more about annotative objects.

Text Height
Specifies the height of the attribute text. Enter a value, or choose Height to specify a height with your pointing device. The height is measured from the origin to the location you specify. If you select a text style that has fixed height (anything other than 0.0), or if you select Align in the Justification list, the Height option is not available.

Text Rotation
Specifies the rotation angle of the attribute text. Enter a value, or choose Rotation to specify a rotation angle with your pointing device. The rotation angle is measured from the origin to the location you specify. If you select Align or Fit in the Justification list, the Rotation option is not available.

Multiline Text Width
Specifies the maximum length of the lines of text in a multiple-line attribute before wrapping to the next line. A value of 0.000 means that there is no restriction on the length of a line of text.

Not available for single-line attributes.

Advanced Options
Contains options to set the behavior and insertion position for the attribute.

Attribute Options
Sets options for attribute values associated with a block when you insert the block in a drawing.

The default values are stored in the AFLAGS (page 1204) system variable. Changing the AFLAGS setting affects the default mode for new attribute definitions and does not affect existing attribute definitions.

Invisible
Specifies that attribute values are not displayed or printed when you insert the block. ATTDISP (page 119) overrides Invisible mode.
Constant
Gives attributes a fixed value for block insertions.

Verify
Prompts you to verify that the attribute value is correct when you insert the block.

Preset
Sets the attribute to its default value when you insert a block containing a preset attribute.

Lock Location
Locks the location of the attribute within the block reference. When unlocked, the attribute can be moved relative to the rest of the block using grip editing, and multiline attributes can be resized.

Multiple Lines
Specifies that the attribute value can contain multiple lines of text. When this option is selected, you can specify a boundary width for the attribute.

NOTE In a dynamic block, an attribute's position must be locked for it to be included in an action's selection set.

Insertion Point
Specifies the location for the attribute. Enter coordinate values or select Specify On-screen and use the pointing device to specify the placement of the attribute in relation to the objects that it will be associated with.

Specify On-Screen
Displays a Start Point prompt when the dialog box closes. Use the pointing device to specify the placement of the attribute in relation to the objects that it will be associated with.

Input Coordinates
Specifies the coordinates to use for the attribute's insertion point.

X
Specifies the X coordinate of the attribute's insertion point.

Y
Specifies the Y coordinate of the attribute's insertion point.

Z
Specifies the Z coordinate of the attribute's insertion point.

See also:

Define Block Attributes

-AATTDEF

List of Prompts

The following prompts are displayed.
Current attribute modes (page 117): Invisible=\textit{current}
Constant=\textit{current} Verify=\textit{current} Preset=\textit{current} Lock position=\textit{current}
Annotative =\textit{current} Multiple line =\textit{current}
Enter an option to change
[Invisible/Constant/Verify/Preset/Lock position/Annotative/Multiple lines] <done>: 
Enter attribute tag name (page 118): \textit{Enter any characters except spaces or exclamation points}
Enter attribute value (page 119): \textit{Enter the appropriate text or press}
Enter attribute prompt (page 118): \textit{Enter the text for the prompt line or press Enter} (this prompt is not displayed if you turned on Constant mode)
Enter default attribute value (page 118): \textit{Enter the appropriate text or press Enter} (this prompt is not displayed if you turned on Constant mode)
Specify location of multiline attribute (page 119): \textit{Specify a point} (this prompt is displayed only if you turned on Multiple line mode)
Specify opposite corner (page 119): \textit{Specify a point or enter an option} (this prompt is displayed only if you turned on Multiple line mode)

Attribute Modes

The current value line indicates the current settings for each attribute mode (either Y for on or N for off). Entering \textbf{i}, \textbf{c}, \textbf{v}, \textbf{p}, \textbf{l}, \textbf{a}, or \textbf{m} toggles the modes on or off. Press Enter when you have finished adjusting the mode settings. The AFLAGS (page 1204) system variable stores the current mode settings and can be used to set the default modes.

\textbf{Invisible} Specifies that attribute values are displayed when you insert the block. ATTDISP (page 119) overrides Invisible mode.

\textbf{Constant} Gives attributes a fixed value for block insertions.
Verify Prompts for verification that the attribute value is correct when you insert the block.

Preset Sets the attribute to its default value when you insert a block containing a preset attribute.

Lock Position Locks the location of the attribute within the block reference. When unlocked, the attribute can be moved relative to the rest of the block using grip editing, and multiline attributes can be resized.

**NOTE** In a dynamic block, an attribute's position must be locked for it to be included in an action's selection set.

Annotative Specifies that the attribute is annotative.

Multiple Lines Specifies that the attribute value can contain multiple lines of text. When this option is selected, you can specify a boundary width for the attribute.

**Attribute Tag Name**
Specifies the attribute tag, which identifies each occurrence of an attribute in the drawing. The tag can contain any characters except spaces or exclamation marks (!). Lowercase letters are automatically changed to uppercase.

**Attribute Prompt**
Specifies the prompt that is displayed when you insert a block containing this attribute definition. If you press Enter, the attribute tag is used as the prompt. If you turn on Constant mode, this prompt is not displayed.

**NOTE** For single-line attributes, you can enter up to 256 characters. If you need leading blanks in the prompt or the default value, start the string with a backslash (\). To make the first character a backslash, start the string with two backslashes.

**Default Attribute Value**
Specifies the default attribute value. The default attribute value appears when a block is inserted into your drawing. A default value is not required. If you turn on Constant mode, the Attribute Value prompt is displayed instead.

When Multiple Line mode is off, -ATTDEF then displays the same prompts as the TEXT command, using the attribute tag instead of requesting a text string.

Current text style: "Standard" Text height: 0.2000

Specify start point of text or [Justify/Style]: Enter an option or press Enter
Specify paper text height <current>: Specify a height, or press Enter

The Specify Paper Text Height prompt is displayed only if the current text style is annotative.
For a description of each option, see TEXT (page 1078).

**NOTE** For single-line attributes, you can enter up to 256 characters. If you need leading blanks in the prompt or the default value, start the string with a backslash (\). To make the first character a backslash, start the string with two backslashes.

When Multiple Line mode is on, -ATTDEF then displays several of the prompts used by the MTEXT command. For a description of each option, see MTEXT (page 677).

**Attribute Value (Constant Mode)**
Specifies the value for a constant attribute. This prompt is displayed only if you turn on Constant mode.

ATTDEF then displays the same prompts as the TEXT command, using the attribute tag instead of requesting a text string. For a description of each option, see TEXT (page 1078).

When Multiple Line mode is on, -ATTDEF then displays several of the prompts used by the MTEXT command. For a description of each option, see MTEXT (page 677).

**Location of Multiline Attribute (Multiple Line Mode)**
Specifies the first corner of the bounding box for the multiple-line text. This location is used as the starting point for the attribute.

**Opposite Corner (Multiple Line Mode)**
As you drag the pointing device to specify the opposite corner, a rectangle is displayed to show the location and width of the multiple-line text. The arrow within the rectangle indicates the direction of the text flow.

See also:
Define Block Attributes

**ATTDISP**
Controls the visibility overrides for all block attributes in a drawing.

**Access Methods**

- **Menu**: View ➤ Display ➤ Attribute Display
- **Command entry**: `attdisp` for transparent use
Summary

The drawing is regenerated after you change the visibility settings unless REGENAUTO (page 890), which controls automatic regeneration, is off. The current visibility of attributes is stored in the ATTMODE (page 1213) system variable.

List of Prompts

The following prompts are displayed.
Enter attribute visibility setting [Normal (page 120)/ON (page 120)/OFF (page 120)] <current>: 

Normal Restores the visibility settings of each attribute. Visible attributes are displayed. Invisible attributes are not displayed.

On Makes all attributes visible, overriding the original visibility settings.

Off Makes all attributes invisible, overriding the original visibility settings.

See also:

Define Block Attributes

ATTEDIT

Changes attribute information in a block.
Access Methods

Button

­i Toolbar: Drafting tool set ➢ Block tool group ➢ Edit Attributes flyout ➢ Single
­i Menu: Modify ➢ Object ➢ Attribute ➢ Single

Summary

The Edit Attributes dialog box (page 121) is displayed to edit attribute values for a specific block.

If you enter -attedit at the Command prompt, options are displayed (page 123) to edit attribute values and properties independent of a block.

See also:
 Attach Data to Blocks (Block Attributes)

Edit Attributes Dialog Box

Changes attribute information in a block.
Summary

To change attribute properties such as position, height, and style, use \texttt{-ATTEDIT}.

List of Options

The following options are displayed.

**Block Name**
Indicates the name of the selected block. The value of each attribute contained in the block is displayed in this dialog box.

**List of Attributes**
Displays the first eight attributes contained in the block. Edit the attribute values. If the block contains additional attributes, click Prev or Next to navigate through the list. You cannot edit attribute values on locked layers. Multiple-line attributes display the In-Place Text Editor (page 678) with the Text Formatting toolbar and the ruler. Depending on the setting of the ATTIPE (page 1212) system variable, the Text Formatting toolbar displayed is either the abbreviated version, or the full version.
To use a field as the value, right-click and click Insert Field on the shortcut menu to display the Insert Field dialog box (page 432).

**Prev**
Displays the previous eight attribute values. Previous is available only if the selected block contains more than eight attributes and you used Next to display the additional attributes.

**Next**
Displays the next eight attribute values. If the block contains no additional attributes, Next is unavailable.

See also:

Attach Data to Blocks (Block Attributes)
-ATTEDIT

List of Prompts

If you enter -attedit at the Command prompt, the following prompts are displayed.

Edit attributes one at a time? [Yes (page 123)/No (page 125)]

<Y>: Enter y or press Enter to edit attributes one at a time, or enter n to edit attributes globally

The following prompts filter the attributes to be changed based on attribute tag, current value, or object selection.

Yes

Edits attributes one at a time. Attributes to be edited one at a time must be visible and parallel to the current UCS.

Attribute values are case sensitive.

The first attribute in the selection set is marked with an X. You can change any properties of the attribute you select.

Enter an option [Value/Position/Height/Angle/Style/Layer/Color/Next] <N>: Enter the property to change, or press Enter for the next attribute

If the original attribute was defined with aligned or fit text, the prompt does not include Angle. The Height option is omitted for aligned text. For each of the options except Next, ATTEDIT prompts for a new value. The X remains on the current attribute until you move to the next attribute.
**Value**
Changes or replaces an attribute value.

Enter type of value modification [Change/Replace]: Enter c or r or press Enter

**Change** Modifies a few characters of the attribute value. Either string can be null. The ? and * characters are interpreted literally, not as wild-card characters.

**Replace** Substitutes a new attribute value for the entire attribute value. If you press Enter, the attribute value is empty (null).

**Position**
Changes the text insertion point.

![position changed](image)

If the attribute is aligned, ATTEDIT prompts for both ends of a new text baseline.

**Height**
Changes the text height.

![height changed](image)

When you specify a point, the height becomes the distance between the specified point and the start point of the text.

**Angle**
Changes the rotation angle.

![angle changed](image)

If you specify a point, the text is rotated along an imaginary line between the specified point and the start point of the text.
**Style**
Changes the style setting.

![Style icon](image)

**Layer**
Changes the layer.

**Color**
Changes the color.

You can enter a color from the AutoCAD Color Index (a color name or number), a true color, or a color from a color book.

You can enter a color name, a color number between 1 and 255, or **bylayer** or **byblock**.

**True Color** Specifies a true color to be used for the selected object.

**Color Book** Specifies a color from a loaded color book to be used for the selected object.

If you enter a color book name, you are prompted to enter the color name in the color book, such as PANTONE® 573.

**Next**
Moves to the next attribute in the selection set. If there are no more attributes, ATTEDIT ends.

**No**
Edits more than one attribute at a time. Global editing applies to both visible and invisible attributes.

Editing attributes globally limits you to replacing a single text string with another text string. If you edit attributes one at a time, you can edit any or all of the attributes.

**Yes** Edits only visible attributes.
Attribute values are case sensitive. To select empty (null) attributes, which normally are not visible and cannot be selected, enter a backslash (\).
Select the attribute you want to change.
Either string can be empty (null). The ? and * characters are interpreted literally, not as wild-card characters.
No Edits attributes whether they are visible or not. Changes to attributes are not reflected immediately. The drawing is regenerated at the end of the command unless REGENAUTO (page 890), which controls automatic regeneration, is off.

Attribute values are case sensitive. To select empty (null) attributes, which normally are not visible, enter a backslash (\).

The attributes that match the specified block name, attribute tag, and attribute value are selected.

Either string can be empty (null). The ? and * characters are interpreted literally, not as wild-card characters.

See also:
Modify Blocks

**ATTEXT (-ATTEXT)**

Extracts attribute data, informational text associated with a block, into a file.

**List of Prompts**

Enter extraction type or enable object selection [Cdf (page 126)/Sdf (page 126)/Dxf (page 127)/Objects (page 127)] <C>: Enter

**CDF: Comma-Delimited File** Generates a file containing one record for each block reference in the drawing. Commas separate the fields of each record. Single quotation marks enclose the character fields.

In the Select Template File dialog box, enter the name of an existing attribute extraction template file.

In the Create Extract File dialog box, enter the name for the output file. The extract file's file name extension is .txt for CDF or SDF format.

**SDF: Space-Delimited File** Generates a file containing one record for each block reference in the drawing. The fields of each record have a fixed width; therefore, field separators or character string delimiters are not used.

In the Select Template File dialog box, enter the name of an existing attribute extraction template file.

In the Create Extract File dialog box, enter the name for the output file. The extract file's file name extension is .txt for CDF or SDF format.
**DXF: Drawing Interchange File** Produces a subset of the AutoCAD Drawing Interchange File format containing only block reference, attribute, and end-of-sequence objects. DXF-format extraction requires no template. The file name extension `.dxx` distinguishes the output file from normal DXF files.

In the Create Extract File dialog box, enter the name for the output file. The extract file's file name extension is `.dxx` for DXF format.

**Objects** Selects objects whose attributes you want to extract.

**See also:**
- Attach Data to Blocks (Block Attributes)

---

**ATTIPEDIT**

Changes the textual content of an attribute within a block.

**Summary**

If you select a single-line attribute, displays the In-Place Text Editor (page 678) without the ruler. Right-click to display options. Selecting a multiple-line attribute displays the In-Place Text Editor (page 678) with the ruler.

Depending on the setting of the `ATTIPE` (page 1212) system variable, the right-click menu changes the formatting and editing operations available for compatibility with previous AutoCAD releases.

---

**NOTE** Not all MTEXT formatting options are available for multiline attributes even with the full In-Place Editor.

---

**List of Prompts**

The following prompts are displayed.

Select attribute to edit: Select an attribute within a block
See also:

Modify a Block Attribute Definition

**ATTREDEF**

Redefines a block and updates associated attributes.

**Summary**

New attributes assigned to existing block references use their default values. Old attributes in the new block definition retain their old values. Any old attributes that are not included in the new block definition are deleted.

**WARNING** ATTREDEF removes any format or property changes made with the ATTEDIT or EATTEDIT commands. It also deletes any extended data associated with the block, and might affect dynamic blocks and blocks created by third-party applications.

**List of Prompts**

The following prompts are displayed.

Enter the name of the block you wish to redefine:
Select objects for new block:
Select objects:
Insertion base point of new block: Specify a point

See also:

Modify a Block Attribute Definition

**ATTSYNC**

Updates block references with new and changed attributes from a specified block definition.

**Access Methods**

Button
Summary

You are prompted for the names of blocks you want to update with the current attributes defined for the blocks.

Use this command to update all instances of a block containing attributes that was redefined using the BLOCK or BEDIT commands. ATTSYNC does not change any values assigned to attributes in existing blocks.

NOTE Use the ATTREDEF command to redefine and update blocks in one command.

Entering ? displays a list of all block definitions in the drawing. Enter the name of the block you want to update.

Pressing ENTER allows you to use your pointing device to select the block whose attributes you want to update.

If a block you specify does not contain attributes or does not exist, an error message is displayed, and you are prompted to specify another block.

WARNING ATTSYNC removes any format or property changes made with the ATTEDIT or EATTEDIT commands. It also deletes any extended data associated with the block, and might affect dynamic blocks and blocks created by third-party applications.

See also:

Modify a Block Attribute Definition

AUDIT

Evaluates the integrity of a drawing and corrects some errors.

Summary

For easy access, AUDIT places all objects for which it reports errors in the Previous selection set. However, editing commands affect only the objects that belong to the current paper space or model space.
If you set the `AUDITCTL` (page 1214) system variable to 1, AUDIT creates a text file describing problems and the action taken and places this report in the same folder as the current drawing, with the file extension `.adt`.

If a drawing contains errors that AUDIT cannot fix, use `RECOVER` (page 877) to retrieve the drawing and correct its errors.

See also:

- Repair a Damaged Drawing File

**AUTOCOMPLETE**

Controls what types of automated keyboard features are available at the Command prompt.

**Access Methods**

**Shortcut menu:** Right-click within the Command Line ➤ AutoComplete

**Summary**

Entering a command or system variable at the Command prompt is assisted with several features that list or complete the commands and system variables as they are being typed. The AUTOCOMPLETE command controls which of the features are turned on.

**List of Prompts**

The following prompts are displayed.

**Append** Controls whether commands and system variables are automatically completed as you type.

**List** Controls whether a list of valid commands and system variables is displayed as you type.

**Icon** Controls whether the corresponding icon for a command is displayed in the list. The same icon is used for all system variables.

**System variables** Controls whether system variables are also included with the Append and List features.

**Delay** Sets a time delay in seconds before the Append and List features take effect.
On Enables the operation of the AutoComplete features that are currently turned on.

Off Suppresses the operation of the AutoComplete features without changing their settings.

See also:
The Command Line
Enter Commands on the Command Line

AUTOCONSTRAIN

Applies geometric constraints to a selection set of objects based on orientation of the objects relative to one another.

Access Methods

Button

Toolbar: Drafting tool set ➤ Parametric tool group ➤ Auto Constrain

Menu: Parametric ➤ AutoConstrain

Summary

You can apply geometric constraints to a selection set of geometry within the specified tolerance set using the AutoConstrain tab in the Constraint Settings dialog box (page 219).

Specify the Settings option to change the types of constraints applied, the order in which they are applied, and the applicable tolerances.

The Settings option displays the Constraint Settings dialog box with the Autoconstrain tab (page 221) selected.

See also:
Apply or Remove Geometric Constraints
B Commands

BASE

Sets the insertion base point for the current drawing.

Access Methods

Button

 Toolbar: Drafting tool set ➤ Block tool group (expanded) ➤ Set Base Point

 Menu: Draw ➤ Block ➤ Base

 Command entry: base (or 'base for transparent use)

Summary

The base point is expressed as coordinates in the current UCS. When you insert or externally reference the current drawing into other drawings, this base point is used as the insertion base point.

See also:

Insert Blocks

BATTMAN

Manages the attributes for a selected block definition.

Access Methods

Button

 Toolbar: Drafting tool set ➤ Block tool group (expanded) ➤ Manage Attributes

 Menu: Modify ➤ Object ➤ Attribute ➤ Block Attribute Manager
Summary

The Block Attribute Manager (page 133) is displayed.

If the current drawing does not contain any blocks with attributes, a message is displayed.

This command controls all attribute properties and settings of a selected block definition. Any changes to the attributes in a block definition are reflected in the block references.

See also:

Modify a Block Attribute Definition

Block Attribute Manager

Manages the attribute definitions for blocks in the current drawing.

Summary

You can edit the attribute definitions in blocks, remove attributes from blocks, and change the order in which you are prompted for attribute values when inserting a block.
Attributes of the selected block are displayed in the attribute list. By default, Tag, Prompt, Default, Mode, and Annotative attribute properties are displayed in the attribute list. For each selected block, a description below the attribute list identifies the number of its instances in the current drawing and in the current layout.

You can specify which attribute properties you want displayed in the list by right-clicking over the attribute headers and choosing the ones to display.

Double-click an attribute to display the Attribute Editor dialog box (page 135), where you can modify attribute properties.

**List of Options**

The following options are displayed.

**Select Block**

You can use your pointing device to select a block from the drawing area. When you choose Select Block, the dialog box closes until you select a block from the drawing or you cancel by pressing ESC. If you modify attributes of a block and then select a new block before you save the attribute changes you made, you are prompted to save the changes before selecting another block.

**Block**

Lists all block definitions in the current drawing that have attributes. Select the block whose attributes you want to modify.

**List of Attributes**

Displays the properties of each attribute in the selected block.

**Remove**

Removes the selected attribute from the block definition. If Synchronize Blocks is clicked and then Synchronize is clicked in the Synchronize Blocks dialog box, the attribute is removed from all instances of the block in the current drawing.

**Found in Drawing**

Reports the total number of instances of the selected block in the current drawing.

**Found in Current Layout**

Reports the number of instances of the selected block in the current model space or layout.
Synchronize Blocks
Updates all instances of the selected block with the attribute properties currently defined. This does not affect any values assigned to attributes in each block.

Update Blocks Applies the changes made and closes the dialog box open.

See also:
Modify a Block Attribute Definition

Attribute Editor Dialog Box

Allows you to edit attributes for a block definition.

Summary
The Attribute Editor dialog box contains the following tabs:
- **Attribute** (page 135)
- **Text Options**
- **Properties** (page 138)

List of Options
The following options are displayed.

Block Name
Displays the name of the block whose attributes are to be edited.

Attribute Tab (Attribute Editor Dialog Box)
Defines how a value is assigned to an attribute and whether or not the assigned value is visible in the drawing area, and sets the string that prompts users to enter a value. The Attribute tab also displays the tag name that identifies the attribute.
Tag
Sets the identifier assigned to the attribute.

Prompt
Sets the text for the prompt that is displayed when you insert the block.

Default
Sets the default value assigned to the attribute when you insert the block.

Options
Mode options determine whether and how attribute text appears.

Invisible
Displays or hides the attribute in the drawing area. If selected, hides the attribute value in the drawing area. If cleared, displays the attribute value.

Constant
Identifies whether the attribute is set to its default value. You cannot change this property. If a check mark is shown in the check box, the attribute is set to its default value and cannot be changed. If the check box is empty, you can assign a value to the attribute.

Verify
Turns value verification on and off. If selected, prompts you to verify the values you assign to the attribute when inserting a new instance of the block. If this option is cleared, verification is not performed.

**Preset**

Turns default value assignment on and off. If selected, sets the attribute to its default value when the block is inserted. If cleared, ignores the attribute's default value and prompts you to enter a value when inserting the block.

**Lock Location** Locks the location of the attribute within the block reference. When unlocked, the attribute can be moved relative to the rest of the block using grip editing, and multiline attributes can be resized.

**Multiple Lines**

Indicates whether the attribute was defined as a Multiple Lines attribute and can contain multiple lines of text.

**Text Options Tab (Attribute Editor Dialog Box)**

Sets the properties that define the way an attribute's text is displayed in the drawing. Change the color of attribute text on the Properties tab.

![Attribute Editor](image)

**Rotation**

Specifies the rotation angle of the attribute text.

**Oblique Angle**
Specifies the angle that attribute text is slanted away from its vertical axis.

**Height**
Specifies the height of the attribute text.

**Width Factor**
Sets the character spacing for attribute text. Entering a value less than 1.0 condenses the text. Entering a value greater than 1.0 expands it.

**Multiline Text Width** Specifies the maximum length of the lines of text in a multiple-line attribute before wrapping to the next line. A value of 0.000 means that there is no restriction on the length of a line of text. Not available for single-line attributes.

**Text Style**
Specifies the text style for attribute text. Default values for this text style are assigned to the text properties displayed in this dialog box.

**Backwards**
Specifies whether or not the text is displayed backwards.

**Upside Down**
Specifies whether or not the text is displayed upside down.

**Annotative**
Specifies that the attribute is annotative.

**Justification**
Specifies how attribute text is justified.

**Properties Tab (Attribute Editor Dialog Box)**
Defines the layer that the attribute is on and the color, lineweight, and linetype for the attribute's line. If the drawing uses plot styles, you can assign a plot style to the attribute using the Properties tab.
Layer
Specifies the layer that the attribute is on.

Linetype
Specifies the linetype of attribute text.

Color
Specifies the attribute's text color.

Lineweight
Specifies the lineweight of attribute text.
Changes you make to this option are not displayed if the LWDISPLAY (page 1404) system variable is off.

Plot Style
Specifies the plot style of the attribute.
If the current drawing uses color-dependent plot styles, the Plot Style list is not available.

See also:
Modify a Block Attribute Definition
BATTORDER

Specifies the order of attributes for a block.

Summary

Displays the Attribute Order dialog box (page 140), which controls the order in which attributes are listed and prompted for when you insert or edit a block reference. You can only use the BATTORDER command in the Block Editor (page 143).

See also:

Attach Data to Blocks (Block Attributes)

Attribute Order Dialog Box

Specifies the order in which attributes are listed and prompted for when you insert or edit a block reference.

![Attribute Order Dialog Box]

List of Options

The following options are displayed.
Attribute Definitions
Lists the attribute definitions in the current block.
Drag an attribute definition up or down in the list to reorder it.

See also:
Attach Data to Blocks (Block Attributes)

BCLOSE

Closes the Block Editor.

Access Methods

 Toolbar: Block Editor visor ➤ Close

Summary
Closes the Block Editor (page 143). If you have modified the block definition since it was last saved, you are prompted to save or discard the changes.

See also:
Define Blocks
Modify Blocks

BEDIT

Opens the block definition in the Block Editor.

Access Methods

 Button

 Toolbar: Drafting tool set ➤ Block tool group (expanded) ➤ Edit
 Menu: Tools ➤ Block Editor
 Shortcut menu: Select a block reference. Right-click in the drawing area. Click Block Editor.
Summary

The Edit Block Definition dialog box (page 142) is displayed. Select a block definition to edit or enter a name for a new block definition to create, then click Edit Block to open the Block Editor (page 143).

When the BLOCKEDITLOCK (page 1219) system variable is set to 1, the Block Editor cannot be opened.

The Block Editor is a separate environment for creating and changing block definitions for the current drawing. You can also use it to add dynamic behavior to blocks.

See also:
- Define Blocks
- Modify Blocks

Edit Block Definition Dialog Box

Select from a list of block definitions that are saved in the drawing to edit in the Block Editor. You can also enter a name for a new block definition to create in the Block Editor.
Summary

When you click Edit Block, the Edit Block Definition dialog box closes, and the Block Editor is displayed.

- If you selected a block definition from the list, that block definition is displayed and is available for editing in the Block Editor.
- If you entered a name for a new block definition, the Block Editor is displayed, and you can start adding objects to the block definition.

List of Options

The following options are displayed.

Block to create or edit

Specifies the name of the block to edit or create in the Block Editor. If you select <Current Drawing>, the current drawing is opened in the Block Editor.

Name List

Displays a list of block definitions that are saved in the current drawing. When you select a block definition from the list, the name is displayed in the Name box.
When you click Edit Block, this block definition is opened in the Block Editor.
When you select <Current Drawing>, the current drawing is opened in the Block Editor.

Preview

Displays a preview of the selected block definition. A lightning bolt icon indicates that the block is a dynamic block.

Description

Displays the description of the selected block definition.

See also:

- Define Blocks
- Modify Blocks

Block Editor

The Block Editor contains a special authoring area in which you can draw and edit geometry as you would in the drawing area.
Summary
You use the Block Editor to define the objects and behavior for a block definition.

The following commands are used for editing blocks and are available only in the Block Editor:
- BATTORDER (page 140)
- BCLOSE (page 141)
- BSAVE (page 163)
- BSAVEAS (page 163)

When the BLOCKEDITLOCK (page 1219) system variable is set to 1, the Block Editor cannot be opened.

Block Editor Visor
Provides tools for adding attributes to the block open for edit, save changes to a block, and close the Block Editor.

Define Attribute (ATTDEF (page 112))
Creates an attribute definition for storing data in a block.

Save (BSAVE (page 163))
Saves the current block definition.

Save New (BSAVEAS (page 163))
Saves a copy of the current block definition under a new name.

Close (BCLOSE (page 141))
Closes the Block Editor.

See also:
- Define Blocks
- Modify Blocks
-BEDIT

Summary

If you select a block in a drawing and enter -bedit at the Command prompt, the selected block is opened in the Block Editor (page 143). If nothing is selected, the following prompt is displayed:

List of Prompts

The following prompts are displayed
Enter block name (page 145) or [? (page 145)]: Enter a name or ?

Block Name
Specifies the name of a block saved in the current drawing to open in the Block Editor or specifies the name of a new block to create.

?—List Previously Defined Blocks
Lists the block names in the text window.

Enter block(s) to list <*>: Enter a name list or press Enter

See also:
Define Blocks
Modify Blocks

BHATCH

Fills an enclosed area or selected objects with a hatch pattern or gradient fill.

Summary

The BHATCH command has been renamed to HATCH.

See also:
Overview of Hatch Patterns and Fills

BLEND

Creates a spline in the gap between two selected lines or curves.
Access Methods

Button

Toolbar: Drafting tool set ➤ Modify tool group ➤ Blend
Menu: Modify ➤ Blend

Summary

Select each object near an endpoint. The shape of the resulting spline depends on the specified continuity. The lengths of the selected objects remain unchanged.

Valid objects include lines, arcs, elliptical arcs, helixes, open polylines, and open splines.

List of Prompts

The following prompts are displayed.

Select first object or [CONtinuity]: Select a line or open curve near the end where the spline should start

Select second object: Select another line or open curve near the end where the spline should end

Continuity

Specify one of two types of blends.

Tangent Creates a degree 3 spline with tangency (G1) continuity to the selected objects at their endpoints.

Smooth Creates a degree 5 spline with curvature (G2) continuity to the selected objects at their endpoints.
If you use the Smooth option, do not switch the display from control vertices to fit points. This action changes the spline to degree 3, which will change shape of the spline.

See also:

Draw Splines

**BLIPMODE**

Controls the display of marker blips.

Obsolete

**Access Methods**

Command entry: `blipmode` for transparent use

**Summary**

When Blip mode is on, a temporary mark in the shape of a plus sign (+) appears where you specify a point. BLIPMODE is off by default.

![Diagram of objects drawn with BLIPMODE on and off]

To remove marker blips, use REDRAW (page 881), REGEN (page 889), ZOOM (page 1188), PAN (page 767), or other commands that redraw or regenerate the drawing.

See also:

Customize Object Selection
**BLOCK**

Creates a block definition from selected objects.

**Access Methods**

- **Button**
  - Toolbar: Drafting tool set ➤ Block tool group ➤ Create
  - Menu: Draw ➤ Block ➤ Make

**Summary**

The Define Block dialog box (page 148) is displayed.

If you enter `-block` at the Command prompt, options are displayed (page 151).

You create a block definition by selecting objects, specifying an insertion point, and giving it a name.

**See also:**

- Define Blocks

**Define Block Dialog Box**

Defines and names a block.
List of Options

The following options are displayed.

Name
Names the block. The name can have up to 255 characters and can include letters, numbers, blank spaces, and any special character not used by the operating system or the program for other purposes. The block name and definition are saved in the current drawing.

Preview
If an existing block is selected under Name, displays a preview of the block.

Source Objects
Specifies the objects to include in the new block and whether to retain or delete the selected objects or convert them to a block instance after you create the block.

Specify On-Screen
Prompts you to specify the objects when the dialog box is closed.
Select Objects
Closes the Block Definition dialog box temporarily while you select the objects for the block. When you finish selecting objects, press Enter to return to the dialog box.

Convert to Block
Converts the selected objects to a block instance in the drawing after you create the block.

Retain Objects
Retains the selected objects as distinct objects in the drawing after you create the block.

Delete Objects
Deletes the selected objects from the drawing after you create the block.

Objects Selected
Displays the number of selected objects.

Base Point
Specifies an insertion base point for the block. The default value is 0,0,0.
Specify On-Screen
Prompts you to specify the base point when the dialog box is closed.

Pick Insertion Base Point
Temporarily closes the dialog box so that you can specify an insertion base point in the current drawing.

X
Specifies the X coordinate value.

Y
Specifies the Y coordinate value.

Z
Specifies the Z coordinate value.

Block Behavior
Specifies the behavior of the block.

Scale Uniformly
Specifies whether or not the block reference is prevented from being non-uniformly scaled.

Annotative
Specifies that the block is annotative.

Match Block Orientation to Layout
Specifies that the orientation of the block references in paper space viewports matches the orientation of the layout. This option is unavailable if the Annotative option is cleared.

Allow Exploding
Specifies whether or not the block reference can be exploded.

Units
Specifies units for the block.
Block Unit
Specifies the insertion units for the block reference.

Description
Specifies the text description of the block.

Open in Block Editor
Opens the current block definition in the Block Editor (page 143) when the dialog box is closed.

See also:
Define Blocks

-BLOCK

If you enter -block at the Command prompt, the following prompts are displayed.

List of Prompts
The following prompts are displayed.
Enter block name (page 152) or [? (page 153)]: Enter a name or ?
**Block Name**
Names the block. The name can have up to 255 characters and can include letters, numbers, blank spaces, and any special character not used by the operating system and the program for other purposes if the system variable EXTNAMES (page 1325) is set to 1.

If you enter the name of an existing block, you are prompted as follows:

**Redefine Block Reference** By redefining a block, you automatically update all references to that block. Attributes attached to existing block references remain unchanged in the drawing. However, new insertions of the block do not prompt for attributes unless the attribute definitions are included in the new block definition.

Use the ATTREDEF (page 128) command to update the attributes of an existing block insert.

**Specify Insertion Base Point** The point specified as the base point is used for subsequent insertions of the block. Typically, a base point is the center of the block or its lower-left corner. The base point is also the point about which you can rotate the block during insertion. A block with 0 rotation is oriented according to the UCS in effect when it was created. Entering a 3D point inserts the block at a specific elevation. Omitting the Z coordinate uses the current elevation.

**Annotative:**
Enter a to create an annotative block.
If you enter yes, the block becomes annotative.

**Match Orientation to Layout in Paper Space Viewports** If you enter yes, the block's orientation in paper space viewports will match the orientation of the layout.

**Select Objects** If you specify the insertion base point, you are prompted to select the objects.
The program defines a block using the objects selected, the insertion base point, and the name provided, and then erases the selected objects from the drawing. You can restore the deleted objects by entering the OOPS (page 722) command immediately after BLOCK.
The insertion base point becomes the origin of the block's coordinate system, which is parallel to the UCS in effect at the time that you define the block. When you insert the block into a drawing, its coordinate system is aligned parallel to the current UCS. Thus, you can insert a block at any orientation in space by setting the UCS first.

**List Previously Defined Blocks**

Lists the block names in the text window.

**Enter Blocks to List**

In the list, external references (xrefs) are indicated with the notation `Xref: resolved`.

In addition, externally dependent blocks (blocks in an xref) are indicated with the notation `xdep: XREFNAME`, where `xrefname` is the name of an externally referenced drawing. The following terms are used in the list:

- **User Blocks**: Number of user-defined blocks in the list.
- **External References**: Number of xrefs in the list.
- **Dependent Blocks**: Number of externally dependent blocks in the list.
- **Unnamed Blocks**: Number of unnamed (anonymous) blocks in the drawing.

**See also:**

Define Blocks

**BMPOUT**

Saves selected objects to a file in device-independent bitmap format.

**Summary**

The Create Raster File dialog box (a standard file selection dialog box (page 723)) is displayed. Enter the file name in the dialog box.

A bitmap file that contains the objects you select is created. The file reflects what is displayed on the screen. Light glyphs that are displayed in the drawing
appear in the new file, even if the Plot Glyph property of the lights is set to No.

**NOTE** When the FILEDIA (page 1334) system variable is set to 0 (Off), Command prompts are displayed.

See also:

Export Raster Files

**BOUNDARY**

Creates a region or a polyline from an enclosed area.

**Access Methods**

![Image](image)

**Button**

- **Toolbar:** Drafting tool set ➤ Closed Shapes tool group (expanded) ➤ Boundary
- **Menu:** Draw ➤ Boundary

**Summary**

The **Boundary Creation dialog box** (page 155) is displayed.

If you enter `-boundary` at the Command prompt, options are displayed (page 156).

Each point that you specify identifies the surrounding objects and creates a separate region or polyline.
See also:
Create and Combine Areas (Regions)

**Boundary Creation Dialog Box**

Defines the object type, boundary set, and island detection method for creating a region or polyline using a specified point within an area enclosed by objects.

![Boundary Creation Dialog Box](image)

**List of Options**

The following options are displayed.

**Pick Points**
Determines a boundary from existing objects that form an enclosed area around the specified point.

**Boundary Retention**
Defines the type of boundary object that will be created from the enclosed area and how enclosed areas are detected.

- **Object Type** Controls the type of the new boundary object. `boundary` creates the boundary as a region or a polyline object.
- **Retain Boundaries** Controls whether the objects created are retained after the dialog box is closed.
**Island Detection**  Controls whether **boundary** detects internal closed boundaries, called islands.

**Boundary Set**  
Defines the set of objects **boundary** analyzes when defining a boundary from a specified point.

**Current Viewport**  Defines the boundary set from everything in the current viewport extents. Selecting this option discards any current boundary set.

**New**  Prompts you to select the objects that define the boundary set. **boundary** includes only the objects that can be used to create a region or closed polyline when it constructs the new boundary set.

For more information about the options in this dialog box, see **HATCH** (page 473).

**See also:**
- Create and Combine Areas (Regions)

---

**-BOUNDARY**

If you enter **-boundary** at the Command prompt, the following prompts are displayed.

Specify internal point (page 156) or [Advanced options (page 156)]: Specify a point or enter a

**Internal Point**

Creates a region or polyline from existing objects that form an enclosed area. Specify a point inside the area.

**Advanced Options**

Sets the method **BOUNDARY** uses to create the boundary.

Enter an option [Boundary set/Island detection/Object type]: Enter an option or press Enter to return to the previous prompt

**Boundary Set**  Defines the set of objects **boundary** analyzes when it creates a boundary from a specified point. For information about defining a boundary set at the Command prompt, see the **HATCH** (page 473) Command prompt option.
Island Detection Specifies whether boundary uses objects within the outermost boundary as boundary objects. For information about specifying island detection at the Command prompt, see the HATCH (page 473) Command prompt option.

Object Type Specifies the type of object that boundary creates.
- Region
- Polyline

See also:
- Create and Combine Areas (Regions)

BOX

Creates a 3D solid box.

Access Methods

Button

Toolbar: Modeling tool set ➤ Solids - Create tool group ➤ Solid Primitives flyout ➤ Box
Menu: Draw ➤ 3D Modeling ➤ Box

List of Prompts

The following prompts are displayed.
Specify first corner or [Center (page 158)]: Specify a point or enter c for center
Specify other corner or [Cube (page 159)/Length (page 159)]: Specify the other corner of the box or enter an option
If the other corner of the box is specified with a Z value that differs from the first corner, then no height prompt is displayed.
Specify height or [2Point (page 159)] <default>: Specify the height or enter 2P for the 2 Point option
Entering a positive value draws the height along the positive Z axis of the current UCS. Entering a negative value draws the height along the negative Z axis.

The base of the box is always drawn parallel to the XY plane of the current UCS (work plane). The height of the box is specified in the Z-axis direction. You can enter both positive and negative values for the height.

**Center**
Creates the box by using a specified center point.

**Cube** Creates a box with sides of equal length.

**Length** Creates a box with length, width, and height values you specify. The length corresponds to the X axis, the width to the Y axis, and the height to the Z axis.
**Cube**
Creates a box with sides of equal length.

**Length**
Creates a box with length, width, and height values you specify. If you enter values, the length corresponds to the X axis, the width to the Y axis, and the height to the Z axis. If you pick a point to specify the length, you also specify the rotation in the XY plane.

**2Point**
Specifies that the height of the box is the distance between the two specified points.

**See also:**
Create a Solid Box

**BREAK**
Breaks the selected object between two points.
**Access Methods**

**Button**

- **Toolbar:** Drafting tool set ➤ Modify tool group (expanded) ➤ Break
- **Toolbar:** Drafting tool set ➤ Modify tool group (expanded) ➤ Break at Point
- **Menu:** Modify ➤ Break

**Summary**

You can create a gap between two specified points on an object, breaking it into two objects. If the points are off of an object, they are automatically projected on to the object. **break** is often used to create space for a block or text.

---

**List of Prompts**

The following prompts are displayed.

**Select object:** Use an object selection method, or specify the first break point (1) on an object

The prompts that are displayed next depend on how you select the object. If you select the object by using your pointing device, the program both selects the object and treats the selection point as the first break point. At the next prompt, you can continue by specifying the second point or overriding the first point.

**Specify second break point or [First point]:** Specify the second break point (2) or enter f

**Second Break Point** Specifies the second point to use to break the object.
**First Point** Overrides the original first point with the new point that you specify.

**Specify first break point:**

**Specify second break point:**

![Diagram showing before and after break](image)

The portion of the object is erased between the two points that you specify. If the second point is not on the object, the nearest point on the object is selected; therefore, to break off one end of a line, arc, or polyline, specify the second point beyond the end to be removed.

To split an object in two without erasing a portion, enter the same point for both the first and second points. You can do this by entering @ to specify the second point.

Lines, arcs, circles, polylines, ellipses, splines, donuts, and several other object types can be split into two objects or have one end removed.

The program converts a circle to an arc by removing a piece of the circle starting counterclockwise from the first to the second point.

![Diagram showing circle conversion](image)

You can also break selected objects at a single point with the Break at Point tool.

Valid objects include lines, open polylines, and arcs. Closed objects such as circles cannot be broken at a single point.
See also:

Break and Join Objects

**BREP**

Removes the history from 3D solids and composite solids, and associativity from surfaces.

**Summary**

When a solid loses the history of the original parts from which it was created, the original parts can no longer be selected and modified. BREP also removes surface associativity. When a surface loses associativity it loses any mathematical expressions or information about how the surface was created.
See also:
Display Original Forms of Composite Solids

BROWSER

Launches the default web browser defined in your system’s registry.

Summary

Pressing Enter displays your web browser, which automatically connects to the location you specify. Because browser does not append “http://” to web locations, you can specify an FTP or file location to your default web browser.

See also:
Get Started with Internet Access

BSAVE

Saves the current block definition.

Access Methods

 Toolbar: Block Editor visor ➤ Save

Summary

Saves changes to the current block definition.
You can only use the BSAVE command in the Block Editor (page 143).

See also:
Create Blocks Within a Drawing

BSAVEAS

Saves a copy of the current block definition under a new name.
Access Methods

Toolbar: Block Editor visor ➤ Save As

Summary

Displays the Save Block Definition As dialog box (page 164).
You can only use the BSAVEAS command in the Block Editor (page 143).

See also:
Create Blocks Within a Drawing

Save Block Definition As Dialog Box

Saves a copy of the current block definition under a new name.

List of Options

The following options are displayed.

Block Name

Specifies a new name under which to save a copy of the current block definition.
Save Block as Drawing Saves the geometry in the Block Editor as a drawing file. Selecting an existing drawing file on disk overwrites the file. By default, the block name specified is used as the drawing file name.

Block List
Displays a list of block definitions that are saved in the current drawing.

Preview
Displays a preview of the selected block definition.

Description
Displays the description saved with the block definition.

See also:
Create Blocks Within a Drawing

C Commands

CAL
Evaluates mathematical and geometric expressions.

Access Methods

Command entry: 'cal for transparent use

Summary
CAL is an online geometry calculator that evaluates point (vector), real, or integer expressions. The expressions can access existing geometry using the object snap functions such as CEN, END, and INS.

You can insert AutoLISP® variables into the arithmetic expression and assign the value of the expression back to an AutoLISP variable.

You can use these arithmetic and vector expressions in any command that expects points, vectors, or numbers.

See also:
Use the Command Prompt Calculator
Understand Syntax of Expressions

CAL evaluates expressions according to standard mathematical rules of precedence:
- Expressions in parentheses first, starting with the innermost set
- Operators in standard order: exponents first, multiplication and division second, and addition and subtraction last
- Operators of equal precedence from left to right

Numeric Expressions

Numeric expressions are real integer numbers and functions combined with the operators in the following table.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>(</td>
<td>Groups expressions</td>
</tr>
<tr>
<td>^</td>
<td>Indicates exponentiation</td>
</tr>
<tr>
<td>* , /</td>
<td>Multiplies, divides</td>
</tr>
<tr>
<td>+, -</td>
<td>Adds, subtracts</td>
</tr>
</tbody>
</table>

The following are examples of numeric expressions:

3
3 + 0.6
(5.8^2) + PI
**Vector Expressions**

A vector expression is a collection of points, vectors, numbers, and functions combined with the operators in the following table.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>( )</td>
<td>Groups expressions</td>
</tr>
</tbody>
</table>
| &        | Determines the vector product of vectors (as a vector)  
\[a,b,c]\&[x,y,z] = [(b\times z) - (c\times y), (c\times x) - (a\times z), (a\times y) - (b\times x)] |
| *        | Determines the scalar product of vectors (as a real number)  
\[a,b,c]*[x,y,z] = ax + by + cz |
| *, /     | Multiplies, divides a vector by a real number  
\[a\times x, a\times y, a\times z] |
| +, -     | Adds, subtracts vectors (points)  
\[a+x, b+y, c+z] |

The following are examples of vector expressions:

**A+[1,2,3]** provides the point located [1,2,3] units relative to point A.

The expression

\[2<45<45]+[2<45<0]-[1.02, 3.5, 2]\n
adds two points and subtracts a third point. The first two points are expressed in spherical coordinates.

**See also:**

Use the Command Prompt Calculator

---

**Format Feet and Inches**

Enter feet and inches using the following format:

feet'-inches" or feet inches" or feet' inches"
You can separate feet, inches, and fractional inches with a dash, a space, or nothing. You can use any of the following syntax cases to enter valid feet-inch formatted values:

- 5' or 60"
- 5'-9" or 5’ 9” or 5'9"
- 5'-1/2" or 5' 1/2” or 5'1/2"
- 5'-9-1/2" or 5' 9-1/2” or 5'9-1/2"
- 5'-9 1/2" or 5' 9 1/2” or 5'9 1/2"

To designate inches for linear calculations, entering double quotes (") is optional. For example, instead of entering 5'9-1/2", you could enter 5'9-1/2.

**WARNING** With imperial units, CAL interprets a minus or a dash (-) as a unit separator rather than a subtraction operation. To specify subtraction, include at least one space before or after the minus sign. For example, to subtract 9" from 5', enter 5' -9" rather than 5'-9".

**See also:**

- Use the Command Prompt Calculator

### Format Angles

The default units for angles are decimal degrees. Enter angles using the following format:

```
<degrees>d<minutes>'<seconds>"
```

You must enter 0d when entering an angle that is less than 1 degree (minutes and seconds only). You can omit the minutes or seconds if they are zero.

Enter a number followed by r to enter angles in radians. Enter a number followed by g to enter angles in grads.

The following examples show ways of entering angles:

- 5d10'20"
- 0d10'20"
- 124.6r
- 14g

Angles entered in any format are converted to decimal degrees.
Pi radians is equal to 180 degrees, and 100 grads is equal to 90 degrees.

See also:
Use the Command Prompt Calculator

Use Points and Vectors

Both points and vectors are pairs or triples of real numbers. A point defines a location in space, but a vector defines a direction (or translation) in space.

Some CAL functions, such as \texttt{pld} and \texttt{plt}, return a point. Other functions, such as \texttt{nor} and \texttt{vec}, return a vector.

Formatting Points and Vectors

A point or vector is a set of three real expressions enclosed in brackets ([ ]): \([r1, r2, r3]\)

The notation \texttt{p1}, \texttt{p2}, and so forth designates points. The notation \texttt{v1}, \texttt{v2}, and so forth designates vectors. In drawings, points are displayed as dots, and vectors are displayed as lines with arrows.

CAL supports points expressed in all formats.

<table>
<thead>
<tr>
<th>Coordinate system</th>
<th>Point format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polar</td>
<td>([\text{dist}&lt;\text{angle}])</td>
</tr>
<tr>
<td>Cylindrical</td>
<td>([\text{dist}&lt;\text{angle}, z])</td>
</tr>
<tr>
<td>Spherical</td>
<td>([\text{dist}&lt;\text{angle1}&lt;\text{angle2}])</td>
</tr>
<tr>
<td>Relative</td>
<td>Uses the @ prefix ([@x, y, z])</td>
</tr>
<tr>
<td>WCS (instead of UCS)</td>
<td>Uses the * prefix ([*x, y, z])</td>
</tr>
</tbody>
</table>

You can omit the following components of a point or vector: coordinate values of zero and a comma immediately preceding the right bracket (]).
The following are valid points:

\[ [1,2] \] is the same as \[ [1,2,0] \]

\[ [.,3] \] is the same as \[ [0,0,3] \]

\[ [ ] \] is the same as \[ [0,0,0] \]

In the following example, the point is entered in the relative spherical coordinate system with respect to the (WCS). The distance is \(1+2=3\); the angles are \(10+20=30\) degrees and \(45\) degrees, \(20\) minutes.

\[ [*1+2<10+20<45d20^\circ] \]

The following is a valid point that contains arithmetic expressions as its components:

\[ [2*(1.0+3.3),0.4-1.1,2*1.4] \]

The following example uses the Endpoint object snap and the vector \([2,0,3]\) to calculate a point that is offset from a selected endpoint:

\[ \text{end} + [2,,3] \]

The calculated point is offset \(2\) units in the \(X\) direction and \(3\) units in the \(Z\) direction relative to the selected endpoint.

See also:

Use the Command Prompt Calculator

**Use AutoLISP Variables**

You can use AutoLISP variables within arithmetic expressions. The variables must be one of the following types: real, integer, or 2D or 3D point (vector).

This example defines a point located \(5\) units in the \(X\) direction and \(1\) unit in the \(Y\) direction from the point stored in AutoLISP variable \(A\).

\[ A+[5,1] \]

If you enter an AutoLISP variable with a name containing a character with special meaning in CAL, such as \(+, -, *, \) or \(/\), enclose the variable name in apostrophes (’), for example:

’number-of-holes’
Assigning Values to AutoLISP Variables

To assign a value to an AutoLISP variable, precede the arithmetic expression with the variable name and the equal sign (=). Later, you can use the value of this variable for other calculations.

This example saves the values of two expressions in AutoLISP variables \( P1 \) and \( R1 \).

Command: \texttt{cal}

\textbf{>> Expression:} \texttt{P1=cen+[1,0]}

\textbf{>> Select entity for CEN snap:} Select a circle or an arc

Command: \texttt{cal}

\textbf{>> Expression:} \texttt{R1=dist(end,end)/3}

\textbf{>> Select entity for END snap:} Select an object with an endpoint

This example uses the values of variables \( P1 \) and \( R1 \):

Command: \texttt{circle}

Specify center point for circle or \([3P/2P/Ttr \text{ (tangent tangent radius)}]): \texttt{cal}

\textbf{>> Expression:} \texttt{P1+[0,1]}

Specify radius of circle or \([\text{Diameter}] <\text{last}>\): \texttt{cal}

\textbf{>> Expression:} \texttt{R1+0.5}

See also:

Use the Command Prompt Calculator

Use System Variables in Calculations

You can use the 	exttt{getvar} function to read the value of a system variable.

The syntax is

\texttt{getvar(variable\_name)}

The following example uses \texttt{getvar} to obtain the point that is the center of the view in the current viewport.

\texttt{getvar(viewctr)}

With this method, you can also access the user system variables, USERI1-5 and USERR1-5. For example, to retrieve the value stored in USERR2, enter the following:
getvar(user2)

See also:

Use the Command Prompt Calculator

Convert Units of Measurement

The cvunit function converts either a number or a point from one unit of measurement to another. See the acad.unt file for a list of units that you can convert. The syntax is

\[ \text{cvunit} (\text{value, from_unit, to_unit}) \]

The following example converts the value 1 from inches to centimeters:

\[ \text{cvunit}(1, \text{inch, cm}) \]

See also:

Use the Command Prompt Calculator

Use Standard Numeric Functions

CAL supports the standard numeric functions in the following table.

<table>
<thead>
<tr>
<th>Numeric functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function</td>
</tr>
<tr>
<td>( \text{sin}(\text{angle}) )</td>
</tr>
<tr>
<td>( \text{cos}(\text{angle}) )</td>
</tr>
<tr>
<td>( \text{tang}(\text{angle}) )</td>
</tr>
<tr>
<td>( \text{asin}(\text{real}) )</td>
</tr>
<tr>
<td>( \text{acos}(\text{real}) )</td>
</tr>
</tbody>
</table>
### Numeric functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>atan(real)</td>
<td>Arctangent of the number</td>
</tr>
<tr>
<td>ln(real)</td>
<td>Natural log of the number</td>
</tr>
<tr>
<td>log(real)</td>
<td>Base-10 log of the number</td>
</tr>
<tr>
<td>exp(real)</td>
<td>Natural exponent of the number</td>
</tr>
<tr>
<td>exp10(real)</td>
<td>Base-10 exponent of the number</td>
</tr>
<tr>
<td>sqr(real)</td>
<td>Square of the number</td>
</tr>
<tr>
<td>sqrt(real)</td>
<td>Square root of the number; the number must be nonnegative</td>
</tr>
<tr>
<td>abs(real)</td>
<td>Absolute value of the number</td>
</tr>
<tr>
<td>round(real)</td>
<td>Number rounded to the nearest integer</td>
</tr>
<tr>
<td>trunc(real)</td>
<td>Integer portion of the number</td>
</tr>
<tr>
<td>r2d(angle)</td>
<td>Angles in radians converted to degrees; for example, r2d(pi) converts the pi radians to 180 degrees</td>
</tr>
<tr>
<td>d2r(angle)</td>
<td>Angles in degrees converted to radians; for example, d2r(180) converts 180 degrees to radians and returns the value of pi</td>
</tr>
<tr>
<td>pi</td>
<td>The constant pi</td>
</tr>
</tbody>
</table>

**See also:**

Use the Command Prompt Calculator
Calculate a Vector from Two Points

The functions vec and vec1 calculate a vector from two points.

vec(p1,p2) Provides the vector from point p1 to point p2.

vec1(p1,p2) Provides the unit vector from point p1 to point p2.

The following example uses CAL to move selected objects 3 units in the
direction from the center of one selected circle to the center of another selected
circle:

Command: move
Select objects
Specify base point or displacement: 'cal
>> Expression: 3*vec1(cen,cen)
Select entity for CEN snap: Specify a circle or an arc
Specify second point of displacement or <use first point as
displacement>: Specify a point or press Enter

The following examples illustrate the meaning of vector and point calculations.

<table>
<thead>
<tr>
<th>Expression</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>vec(a,b)</td>
<td>Determines vector translation from point a to point b.</td>
</tr>
<tr>
<td>vec1(a,b)</td>
<td>Determines unit vector direction from point a to point b.</td>
</tr>
<tr>
<td>L*vec1(a,b)</td>
<td>Determines vector of length L in the direction from point a to point b.</td>
</tr>
<tr>
<td>a+v</td>
<td>Determines point b, which is a translation of the point a through vector v.</td>
</tr>
<tr>
<td>a+[5&lt;20]</td>
<td>Determines point b located 5 units away from point a at an angle of 20 degrees. Note that [5&lt;20] is a vector in polar coordinates.</td>
</tr>
</tbody>
</table>

See also:

Use the Command Prompt Calculator
Calculate the Length of a Vector

The *abs* function calculates the length of a vector.

\[ \text{abs}(v) \text{ Calculates the length of vector } v, \text{ a nonnegative real number.} \]

In spherical coordinates \((\text{dist}-\text{ang}<\text{ang})\), the \text{dist} is the length of the vector.

The following example calculates the length of the vector \([1,2,3]\):

\[ \text{abs}([1,2,3]) \]

See also:

Use the Command Prompt Calculator

Obtain a Point by Cursor

To enter a point using the pointing device, use the *cur* function. The program prompts you to specify a point and uses the coordinate values of the point in the expression. The point coordinate values are expressed in terms of the current UCS. The *cur* function sets the value of the *LASTPOINT* (page 1383) system variable.

The following example adds the vector \([3.6,2.4,0]\)—the result of \(1.2*[3,2]\)—to the point you select. This expression produces a point that is offset from the selected point.

\[ \text{cur}+1.2*[3,2] \]

See also:

Use the Command Prompt Calculator

Obtain the Last-Specified Point

Use the character in the expression to obtain the coordinate of the last point, as shown in the following example:

Command: *line*

Specify first point: `cal`

>> Expression: *cen*+[0,1]

>> Select entity for CEN snap: *Select a circle or an arc*

Specify next point or [Close/Undo]: `cal`
Expression:  +3*vec1(cen,cen)

The first point of the line is 1 unit in the Y direction from the center of the first selected circle. The second point of the line is 3 units away from the first point. The direction of the line is from the center of the first selected circle to the center of the second selected circle.

See also:

Use the Command Prompt Calculator

Use Snap Modes in Arithmetic Expressions

You can use Snap modes as parts of arithmetic expressions. The program prompts you to select an object and returns the coordinate of the appropriate snap point. Using arithmetic expressions with Snap modes greatly simplifies entering coordinates relative to other objects.

When you use these Snap modes, enter only the three-character name. For example, when you use the Center Snap mode, enter cen. CAL Snap modes set the value of the LASTPOINT (page 1383) system variable.

<table>
<thead>
<tr>
<th>CAL Snap modes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abbreviation</td>
</tr>
<tr>
<td>----------------</td>
</tr>
<tr>
<td>END</td>
</tr>
<tr>
<td>INS</td>
</tr>
<tr>
<td>INT</td>
</tr>
<tr>
<td>MID</td>
</tr>
<tr>
<td>CEN</td>
</tr>
<tr>
<td>NEA</td>
</tr>
<tr>
<td>NOD</td>
</tr>
</tbody>
</table>

176 | Chapter 2  Commands
The following example uses the Center and Endpoint Snap modes in a CAL expression:

\((\text{cen}+\text{end})/2\)

CAL prompts for a circle or arc and an object. It then determines the midpoint between the center of the circle or arc and the end of the selected object.

Using the Midpoint Snap mode, in the following example CAL prompts for an object and returns a point 1 unit in the \(Y\) direction from the midpoint of the selected object:

\(\text{mid}+[,1]\)

The following example uses the Endpoint Snap mode to calculate the centroid of a triangle defined by three endpoints:

\((\text{end}+\text{end}+\text{end})/3\)

See also:

Use the Command Prompt Calculator

**Convert Points Between UCS and WCS**

Normally, the program assumes all coordinates to be relative to the current UCS. The following functions convert points between UCS and WCS.

- \(w2u(p1)\) Converts point \(p1\) expressed in the WCS to the current UCS.
- \(u2w(p1)\) Converts point \(p1\) expressed in the current UCS to the WCS.

You can use \(w2u\) to find the WCS origin in terms of the current UCS:

\(w2u([0,0,0])\)
Filtering the X, Y, and Z Components of a Point or Vector

The following functions filter the X, Y, and Z components of a point or vector.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>xyof(p1)</code></td>
<td>X and Y components of a point; Z component is set to 0.0</td>
</tr>
<tr>
<td><code>xzof(p1)</code></td>
<td>X and Z components of a point; Y component is set to 0.0</td>
</tr>
<tr>
<td><code>yzof(p1)</code></td>
<td>Y and Z components of a point; X component is set to 0.0</td>
</tr>
<tr>
<td><code>xof(p1)</code></td>
<td>X component of a point; Y and Z components are set to 0.0</td>
</tr>
<tr>
<td><code>yof(p1)</code></td>
<td>Y component of a point; X and Z components are set to 0.0</td>
</tr>
<tr>
<td><code>zof(p1)</code></td>
<td>Z component of a point; X and Y components are set to 0.0</td>
</tr>
<tr>
<td><code>rxof(p1)</code></td>
<td>X component of a point</td>
</tr>
<tr>
<td><code>ryof(p1)</code></td>
<td>Y component of a point</td>
</tr>
<tr>
<td><code>rzof(p1)</code></td>
<td>Z component of a point</td>
</tr>
</tbody>
</table>

The following example provides the Z component of a point expressed in spherical coordinates:

`zof([2<45<45])`

The following example provides a point whose X and Y coordinate values are taken from point `a` and the Z coordinate value from point `b`:

`xyof(a)+zof(b)`

See also:

Use the Command Prompt Calculator
Calculate a Point on a Line

The `plt` and `pld` functions return a point on a given line. You can specify the location of the point on the line either by its distance from the first point or parametrically by a $t$ parameter.

`pld(p1,p2,dist)` Calculates a point on the line passing through points $p1$ and $p2$. The parameter $dist$ defines the distance of the point from the point $p1$.

`plt(p1,p2,t)` Calculates a point on the line passing through points $p1$ and $p2$. The parameter $t$ defines the parametric location of the point on the line.

The following are examples of the parameter $t$:

- If $t=0$ the point is $p1$
- If $t=0.5$ the point is the midpoint between $p1$ and $p2$
- If $t=1$ the point is $p2$

See also:

- Use the Command Prompt Calculator

Rotate a Point About an Axis

The `rot` function rotates a point about an axis and returns the resulting point.

`rot(p,origin,ang)` Rotates point $p$ through angle $ang$ about the $Z$ axis passing through the point $origin$, as shown in the following example:

```
origin

ang

p
```

`rot(p,AxP1,AxP2,ang)` Rotates point $p$ through an angle $ang$ about the axis passing through points $AxP1$ and $AxP2$, as shown in the following example. The axis is oriented from the first point to the second point.
Obtain an Intersection Point

The **ill** and **ilp** functions determine intersection points.

ill(p1,p2,p3,p4) Determines the intersection point between two lines (p1,p2) and (p3,p4). All points are considered three-dimensional.

ilp(p1,p2,p3,p4,p5) Determines the intersection point between a line (p1,p2) and a plane passing through three points (p3,p4,p5).

See also:
Use the Command Prompt Calculator

Calculate a Distance

dist(p1,p2) Determines the distance between two points, p1 and p2. This is the same as the vector expression abs(p1-p2).

dpl(p,p1,p2) Determines the shortest distance between point p and the line passing through points p1 and p2.
**dpp(p,p1,p2,p3)** Determines the distance from a point *p* to a plane defined by three points (*p1*,*p2*,*p3*).

**dist(p1,p2)** Determines the distance between two points, *p1* and *p2*. This is the same as the vector expression \( \text{abs}(p1-p2) \).

The following example returns half the distance between the centers of two selected objects:

\[ \text{dist(cen,cen)}/2 \]

The following example finds the distance between the point 3,2,4 and a plane you define by selecting three endpoints:

\[ \text{dpp([3,2,4],end, end, end)} \]

See also:

Use the Command Prompt Calculator
Obtain a Radius

The `rad` function determines the radius of a selected object.

`rad` determines the radius of a selected object. The object can be a circle, an arc, or a 2D polyline arc segment.

The following example uses `rad` with the `CIRCLE` (page 196) command. The radius of the new circle is two-thirds of the radius of the selected polyline arc segment:

Command: `circle`

Specify center point for circle or [3P/2P/Ttr (tangent tangent radius)]: `cen`

Specify radius of circle or [Diameter] <last>: `cal`

>> Expression: `2/3*rad`

>> Select circle, arc or polyline segment for RAD function: `Select the circle`

See also:

- Use the Command Prompt Calculator

Obtain an Angle

The `ang` function determines the angle between two lines. Angles are measured counterclockwise with respect to either the X axis, in the two-dimensional case, or to a user-specified axis, in the three-dimensional case.

`ang(v)` determines the angle between the X axis and vector v. The vector v is considered 2D, projected on the XY plane of the current UCS.

`ang(p1,p2)` determines the angle between the X axis and the line (p1,p2), oriented from p1 to p2. The points are considered 2D, projected on the XY plane of the current UCS.

`ang(apex,p1,p2)` determines the angle between lines (apex,p1) and (apex,p2). The points are considered 2D, projected on the XY plane of the current UCS.
\textbf{ang}(\text{apex},p_1,p_2,p)$ Determines the angle between lines $(\text{apex},p_1)$ and $(\text{apex},p_2)$. The lines are considered 3D. The last parameter, point $p$, is used to define the orientation of the angle. The angle is measured counterclockwise with respect to the axis going from apex to $p$.

The following examples show how angles are measured.

You can determine the angle between the two sides of a triangle using the \textbf{ang} function, as shown in the following example:

\textbf{Command: cal}

$\text{>> Expression: ang(end,end,end)}$

Select the apex of the angle, and then select the two opposite vertices.

\textbf{See also:}

Use the Command Prompt Calculator
**Calculate a Normal Vector**

The `nor` function calculates the unit normal vector (a vector perpendicular to a line or plane), not a point. The vector defines the direction of the normal, not a location in space. You can add this normal vector to a point to obtain another point.

`nor` Determines the three-dimensional unit normal vector of a selected circle, arc, or polyline arc segment. This normal vector is the Z coordinate of the object coordinate system (OCS) of the selected object.

`nor(v)` Determines the two-dimensional unit normal vector to vector v. Both vectors are considered 2D, projected on the XY plane of the current UCS. The orientation of the resulting normal vector points to the left of the original vector v.

`nor(p1,p2)` Determines the 2D unit normal vector to line p1,p2. The line is oriented from p1 to p2. The orientation of the resulting normal vector points to the left from the original line (p1,p2).

`nor(p1,p2,p3)` Determines the 3D unit normal vector to a plane defined by the three points p1, p2, and p3. The orientation of the normal vector is such that the given points go counterclockwise with respect to the normal.

The following illustrations show how normal vectors are calculated:
The following example sets the view direction perpendicular to a selected object. The program displays the object in plan view and does not distort the object by the parallel projection.

Command: `vpoint`
Current view direction: VIEWDIR = `current`
Specify a view point or [Rotate] <display compass and tripod>:
  'cal
>> Expression: `nor`
>> Select circle, arc or polyline for NOR function:

See also:

Use the Command Prompt Calculator
Use Shortcut Functions

The functions in the table are shortcuts for commonly used expressions that combine a function with the Endpoint Snap mode.

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut for</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>dee</td>
<td>dist(end,end)</td>
<td>Distance between two endpoints</td>
</tr>
<tr>
<td>ile</td>
<td>ill(end,end,end,end)</td>
<td>Intersection of two lines defined by four endpoints</td>
</tr>
<tr>
<td>mee</td>
<td>(end+end)/2</td>
<td>Midpoint between two endpoints</td>
</tr>
<tr>
<td>nee</td>
<td>nor(end,end)</td>
<td>Unit vector in the $XY$ plane and normal to two endpoints</td>
</tr>
<tr>
<td>pldee (d)</td>
<td>pld(d,end,end)</td>
<td>Point at a distance along a line determined by two endpoints (see pld)</td>
</tr>
<tr>
<td>pltee (t)</td>
<td>plt(t,end,end)</td>
<td>Point at a parametric location on a line determined by two endpoints (see plt)</td>
</tr>
<tr>
<td>vee</td>
<td>vec(end,end)</td>
<td>Vector from two endpoints</td>
</tr>
<tr>
<td>vee1</td>
<td>vec1(end,end)</td>
<td>Unit vector from two endpoints</td>
</tr>
</tbody>
</table>

See also:
Use the Command Prompt Calculator

CHAMFER

Bevels the edges of objects.
Access Methods

Button

Toolbar: Drafting tool set ➤ Modify tool group ➤ Chamfer
Menu: Modify ➤ Chamfer

Summary

The distances and angles that you specify are applied in the order that you select the objects.

You can chamfer lines, polylines, rays, and xlines.
You can also chamfer 3D solids and surfaces. If you select a mesh to chamfer, you can choose to convert it to a solid or surface before completing the operation.

List of Prompts

The following prompts are displayed.
(TRIM mode) Current chamfer Dist1 = current, Dist2 = current
Select first line (page 187) or [Undo (page 189)/Polyline (page 189)/Distance (page 189)/Angle (page 189)/Trim (page 190)/mEthod (page 190)/Multiple (page 190)/eXpression (page 190)]: Use an object selection method or enter an option

First Line
Specifies the first of two edges required to define a 2D chamfer, or the edge of a 3D solid to chamfer.
If you select lines or polylines, their lengths adjust to accommodate the chamfer line. You can hold down Shift while selecting the objects to override the current chamfer distances with a value of 0.

If the selected objects are line segments of a 2D polyline, they must be adjacent or separated by no more than one segment. If they're separated by another polyline segment, CHAMFER deletes the segment that separates them and replaces it with the chamfer.

If you select an edge on a 3D solid, you must indicate which one of the two surfaces adjacent to the edge is the base surface.

Enter Surface Selection Option Entering o or pressing Enter sets the selected surface as the base surface. Entering n selects either of the two surfaces adjacent to the selected edge.

After you select the base surface and the chamfer distances, select the edges of the base surface to chamfer. You can select edges individually or all the edges at once.

- **Edge** Selects an individual edge to chamfer.

  ![first edge selected](image1)  ![first base surface](image2)  ![second base surface](image3)

- **Loop** Switches to Edge Loop mode.

  ![select edge](image4)  ![edge selected](image5)  ![chamfered edge](image6)

**Edge Loop** Selects all edges on the base surface.
**Undo**
Reverses the previous action in the command.

**Polyline**
Chamfers an entire 2D polyline.

The intersecting polyline segments are chamfered at each vertex of the polyline. Chamfers become new segments of the polyline.

If the polyline includes segments that are too short to accommodate the chamfer distance, those segments are not chamfered.

**Distance**
Sets the distance of the chamfer from the endpoint of the selected edge.

If you set both distances to zero, CHAMFER extends or trims the two lines so they end at the same point.

**Angle**
Sets the chamfer distances using a chamfer distance for the first line and an angle for the second line.
Trim
Controls whether CHAMFER trims the selected edges to the chamfer line endpoints.

NOTE Trim sets the TRIMMODE (page 1521) system variable to 1; No Trim sets TRIMMODE to 0.

If the TRIMMODE system variable is set to 1, CHAMFER trims the intersecting lines to the endpoints of the chamfer line. If the selected lines do not intersect, CHAMFER extends or trims them so that they do. If TRIMMODE is set to 0, the chamfer is created without trimming the selected lines.

Method
Controls whether CHAMFER uses two distances or a distance and an angle to create the chamfer.

Multiple
Chamfers the edges of more than one set of objects.

Expression
Controls the chamfer distance with a mathematical expression. See Constrain a Design with Formulas and Equations for a list of operators and functions allowed.

See also:
Create Chamfers

CHAMFEREDGE
Bevels the edges of 3D solids and surfaces.

Access Methods

Button
Summary

You can select more than one edge at a time, as long as they belong to the same face. Enter a value for the chamfer distance or click and drag the chamfer grips.

List of Prompts

Select an Edge Selects a single solid or surface edge to chamfer.

Distance 1 Sets the distance of the first chamfer edge from the selected edge. The default value is 1.

Distance 2 Sets the distance of the second chamfer edge from the selected edge. The default value is 1.

Loop Chamfers all edges on a single face. For any edge, there are two possible loops. After selecting a loop edge you are prompted to Accept the current selection or choose the Next loop.

Expression Enter a formula or equation to specify the chamfer distance with a mathematical expression. See Constrain a Design with Formulas and Equations.

See also: Modify Edges on 3D Objects Create Chamfers
CHANGE

Changes the properties of existing objects.

List of Prompts

The following prompts are displayed
Select objects (page 192):
Specify change point (page 192) or [Properties (page 193)]:
Specify a new point, or press Enter to enter new values

Specify Objects

If you select lines and other changeable objects in the same selection set, you get varying results depending on the object selection sequence. The easiest way to use CHANGE is to select only lines in a selection set or select only objects other than lines in a selection set.

Except for zero-thickness lines, the objects selected must be parallel to the current user coordinate system (UCS).

Change Point or Values

Changes the selected objects. The result depends on the type of objects you select.

Lines Move the endpoints of the selected lines that are closest to the change point to the new point, unless Ortho mode is on. If Ortho mode is on, the selected lines are modified so that they become parallel to either the X or the Y axis; their endpoints are not moved to the specified coordinate.

Circles Changes the circle radius. If you selected more than one circle, the prompt is repeated for the next circle.

Text Changes text location and other properties.
Specify New Text Insertion Point Relocates the text.

Attribute Definitions Changes the text and text properties of an attribute that is not part of a block.

Blocks Changes the location or rotation of a block.

Specifying a new location relocates the block. Pressing Enter leaves the block in its original location.

Properties
Modifies properties of existing objects.

**NOTE** The Plotstyle option is displayed only when you are using named plot styles.

You can change several properties at a time. The Enter Property to Change prompt is redisplayed after each option is completed.

**Color** Changes the color of the selected objects.

For example, to change a color to red, enter **red** or 1. If you enter **bylayer**, the object assumes the color of the layer on which it is located. If you enter **byblock**, the object inherits the color of the block of which it is a component.

- **True Color.** Specifies a true color to be used for the selected object. The integer values range from 0 to 255 separated by commas.
- **Color Book.** Specifies a color from a loaded color book to be used for the selected object.

**Elev** Changes the Z-axis elevation of 2D objects.

You can change the elevation of an object only if all its points have the same Z value.

**Layer** Changes the layer of the selected objects.
**Ltype** Changes the linetype of the selected objects. If the new linetype is not loaded, the program tries to load it from the standard linetype library file, `acad.lin`. If this procedure fails, use `LINETYPE` (page 578) to load the linetype.

**Ltscale** Changes the linetype scale factor of the selected objects.

**Lweight** Changes the lineweight of the selected objects. Lineweight values are predefined values. If you enter a value that is not a predefined value, the closest predefined lineweight is assigned to the selected objects.

**Thickness** Changes the Z-direction thickness of 2D objects. Changing the thickness of a 3D polyline, dimension, or layout viewport object has no effect.

**Transparency** Changes the transparency level of selected objects. Set the transparency to ByLayer or ByBlock, or enter a value from 0 to 90.

**Material** Changes the material of the selected objects if a material is attached.

**Annotative** Changes the Annotative property of the selected objects.

**See also:**

Display and Change the Properties of Objects

---

**CHPROP**

Changes the properties of an object.

**List of Prompts**

The following prompts are displayed.

`Select objects:`
Enter property to change [Color (page 195)/Layer (page 195)/Ltype (page 195)/Ltscale (page 195)/Lweight (page 195)/Thickness (page 195)/Transparency (page 196)/Material (page 196)/Annotative (page 196)]:

**NOTE** The Plotstyle option is displayed only when you are using named plot styles.

If you select several objects with different values for the property you want to change, *varies* is displayed as the current value.

**Color**
Changes the color of the selected objects.

For example, to change a color to red, enter **red** or **1**. If you enter **bylayer**, the object assumes the color of the layer on which it is located. If you enter **byblock**, the object inherits the color of the block of which it is a component.

**True Color** Specifies a true color to be used for the selected object.

**Color Book** Specifies a color from a loaded color book to be used for the selected object.

**Layer**
Changes the layer of the selected objects.

**Ltype**
Changes the linetype of the selected objects.

If the new linetype is not loaded, the program tries to load it from the standard linetype library file, **acad.lin**. If this procedure fails, use **LINETYPE** (page 578) to load the linetype.

**Ltscale**
Changes the linetype scale factor of the selected objects.

**Lweight**
Changes the lineweight of the selected objects. Lineweight values are predefined values. If you enter a value that is not a predefined value, the closest predefined lineweight is assigned to the selected objects.

**Thickness**
Changes the Z-direction thickness of 2D objects.

Changing the thickness of a 3D polyline, dimension, or layout viewport object has no effect.
Transparency
Changes the transparency level of selected objects.
Set the transparency to ByLayer or ByBlock, or enter a value from 0 to 90.

Material
Changes the material of the selected objects if a material is attached.

Annotative
Changes the Annotative property of the selected objects.

See also:
Display and Change the Properties of Objects

CIRCLE
Creates a circle.

Access Methods

Button

Toolbar: Drafting tool set ➤ Closed Shapes tool group ➤ Circle flyout
Menu: Draw ➤ Circle ➤ Center, Radius

List of Prompts

The following prompts are displayed.
Specify center point (page 196) for circle or [3P (page 197)/2P (page 198)/Ttr (tan tan radius) (page 198)]: Specify a point or enter an option

Center Point
Draws a circle based on a center point and a diameter or a radius.

Radius Defines the radius of the circle. Enter a value, or specify a point.
For example:

**Diameter** Defines the diameter of the circle. Enter a value, or specify a second point.

For example:

**3P (Three Points)**
Draws a circle based on three points on the circumference.

For example:

**Tan, Tan, Tan**
Creates a circle tangent to three objects.

For example:
**2P (Two Points)**
Draws a circle based on two endpoints of the diameter.

For example:

**TTR (Tangent, Tangent, Radius)**
Draws a circle with a specified radius tangent to two objects.

Sometimes more than one circle matches the specified criteria. The program draws the circle of the specified radius whose tangent points are closest to the selected points.

For example:
See also:

Draw Circles

CLASSICGROUP

Creates and manages saved sets of objects called groups.

List of Prompts

The following prompts are displayed.
Enter a group option [? (page 199)/Order (page 199)/Add (page 199)/Remove (page 199)/Explode (page 199)/REName (page 199)/Selectable (page 200)/Create (page 200)] <Create>: Enter an option or press Enter

?—List Groups
Lists names and descriptions of groups defined in the drawing.

Order
Changes the numerical order of objects within a group. Reordering is useful when creating tool paths. For example, you can change the cut order for the horizontal and vertical lines of a tool path pattern.

Position Number Specifies the position number of the object to reorder. To reorder a range of objects, specify the first object's position number.

Reverse Order Reverses the order of all members in a group.

Add
Adds objects to a group.

Remove
Removes objects from a group.

If you remove all the group's objects, the group remains defined. You can remove the group definition from the drawing by using the Explode option.

Explode
Deletes a group definition by exploding the group into its component objects.

Ungroup
Removes the group name and the association of objects in the group.

Rename
Assigns a new name to an existing group.
Selectable
Specifies whether a group is selectable. When a group is selectable, selecting one object in the group selects the whole group. Objects on locked or frozen layers are not selected.

Create
Creates a group.

Group names can be up to 31 characters long and can include letters, numbers, and special characters dollar sign ($), hyphen (-), and underscore (_) but not spaces. The name is converted to uppercase characters.

See also:
Group Objects

CLEANSCREENON
Clears the screen of the menu bar and all palettes.

Access Methods

Button

Menu: View ➤ Clean Screen

Command entry: Cmd-0

Toolbar: Status bar ➤ Clean Screen

Summary
The screen displays only the drawing area.

Use CLEANSCREENOFF (page 201) to restore the display of interface items that were hidden by CLEANSCREENON.

See also:
Set Up the Drawing Area
CLEANSCREENOFF

Restores the state of the display before CLEANSCREENON was used.

Access Methods

Button

Menu: View ➤ Clean Screen
Command entry: Cmd-0
Toolbar: Status bar ➤ Clean Screen

Summary

Restores the state of the display before CLEANSCREENON (page 200) was used. Use CLEANSCREENON (page 200) to clear the screen of most user interface elements.

See also:

Set Up the Drawing Area

CLIP

Crops a selected external reference, image, viewport, or PDF underlay to a specified boundary.

Summary

The clipping boundary determines a portion of an image, PDF underlay, viewport, or external reference to hide. The visibility of the clipping boundary is controlled by the FRAME (page 1337) system variable.

List of Prompts

The list of prompts varies depending on whether you are clipping a PDF underlay, image, external reference, or viewport.

PDF Underlay and Image Prompts
The following prompts are displayed.
On Turns on clipping and displays the PDF underlay or image clipped to the previously defined boundary.

Off Turns off clipping and displays the entire PDF underlay or image, and frame.

If you clip the PDF underlay or image again while clipping is off, clipping automatically turns on. You are prompted to delete the old boundary even when clipping is off and the clipping boundary is not visible.

Delete Removes a predefined clipping boundary and redisplays the full original PDF underlay or image.

New Boundary Defines a rectangular or polygonal clipping boundary, or generates a polygonal clipping boundary from a polyline.

**NOTE** You can only create a new clipping boundary for a PDF underlay or image when the old boundary is deleted.

Select Polyline Defines the boundary with the selected polyline. The polyline can be open but must consist of straight line segments and cannot intersect itself.

Polygonal Defines a polygonal clipping boundary with three or more points that you specify for the vertices of a polygon.

Rectangular Defines a rectangular boundary with the points that you specify for opposite corners.

Invert Clip Inverts the mode of the clipping boundary: objects are clipped either outside the boundary or inside the boundary.

**External Reference Prompts**
The following prompts are displayed.

On Displays the clipped portion of the external reference or block in the current drawing.

Off Displays all of the geometry of the external reference or block in the current drawing, ignoring the clipping boundary.

Clipdepth Sets the front and back clipping planes on an xref or block. Objects outside the volume defined by the boundary and the specified depth are not displayed. Regardless of the current UCS, the clip depth is applied parallel to the clipping boundary.

- **Front Clip Point.** Creates a clipping plane passing through and perpendicular to the clipping boundary.

- **Distance.** Creates a clipping plane the specified distance from and parallel to the clipping boundary.
- **Remove.** Removes both the front and back clipping planes.

**Delete** Removes a clipping boundary for the selected xref or block. To temporarily turn off a clipping boundary, use the Off option. Delete erases the clipping boundary and the clipdepth. The **ERASE** (page 410) command cannot be used to delete clipping boundaries.

**Generate Polyline** Automatically draws a polyline coincident with the clipping boundary. The polyline assumes the current layer, linetype, lineweight, and color settings. Use this option when you want to modify the current clipping boundary using **PEDIT** (page 779) and then redefine the clipping boundary with the new polyline. To see the entire xref while redefining the boundary, use the Off option.

**New Boundary** Defines a rectangular or polygonal clipping boundary, or generates a polygonal clipping boundary from a polyline.

**NOTE** You can only create a new clipping boundary for a selected external reference when the old boundary is deleted.

- **Select Polyline.** Defines the boundary with the selected polyline. The polyline can be open but must consist of straight line segments and cannot intersect itself.

- **Polygonal.** Defines a polygonal clipping boundary with three or more points that you specify for the vertices of a polygon.

- **Rectangular.** Defines a rectangular boundary with the points that you specify for opposite corners.

- **Invert Clip.** Inverts the mode of the clipping boundary: objects are clipped either outside the boundary or inside the boundary.

**Viewport Prompts**

**NOTE** You cannot clip a viewport in model space. You must be in paper space on a named layout.

**Clipping Object** Select the viewport to clip.

**Polygonal** Draws a clipping boundary. You can draw line segments or arc segments by specifying points.

The descriptions of the Next Point, Arc, Close, Length, and Undo options match the descriptions of the corresponding options in the **PLINE** (page 796) command.

**Delete** Deletes the clipping boundary of a selected viewport. This option is available only if the selected viewport has already been clipped. If you clip a
viewport that has been previously clipped, the original clipping boundary is deleted, and the new clipping boundary is applied.

See also:
- Clip External References and Blocks
- Clip Raster Images
- Clip PDF Underlays

**CLOSE**

Closes the current drawing.

**Access Methods**

Menu: File ➤ Close

**Summary**

The current drawing is closed. If you modified the drawing since it was last saved, you are prompted to save or discard the changes.

You can close a file that has been opened in read-only mode if you have made no changes or if you are willing to discard changes. To save changes to a read-only file, you must use the **SAVEAS** (page 926) command.

See also:
- Open a Drawing

**CLOSEALL**

Closes all currently open drawings.

**Summary**

All open drawings are closed. A message box is displayed for each unsaved drawing, in which you can save any changes to the drawing before closing it.

See also:
- Open a Drawing
COLOR

Sets the color for new objects.

Access Methods

Menu: Format ➤ Color
Command entry: `color` for transparent use

Summary

The Color Palette dialog box (page 205) is displayed.
If you enter `-color` at the Command prompt, options are displayed (page 212).

See also:
Set the Current Color

Color Palette Dialog Box

Defines the color of objects.

Summary

You can select from the 255 AutoCAD Color Index (ACI) colors, true colors, and Color Book colors.

List of Tabs

The following tabs are displayed.
- Index Color (page 206)
- True Color (page 207)
- Color Books (page 210)

See also:
Set the Current Color
Index Color Tab (Color Palette Dialog Box)

Specifies color settings using the 255 AutoCAD Color Index (ACI) colors.

List of Options

The following options are displayed.

**AutoCAD Color Index (ACI) Palettes** Specifies a color from the AutoCAD Color Index. If you hover over a color, the number of the color and its red, green, blue value are displayed below the palette. Click a color to select it, or enter the color number or name in the Color box.

The large palette displays colors 10 through 249.

The second palette displays colors 1 through 9; these colors have names as well as numbers.

The third palette displays colors 250 through 255; these colors are shades of gray.

**Index Color** Indicates the ACI color number when you hover over a color.

**Red, Green, Blue** Indicates the RGB color value when you hover over a color.
Bylayer
Specifies that new objects assume the color assigned to the layer on which you create them. When BYLAYER is selected, the color of the current layer is displayed in the Old and New color swatches.

Byblock
Specifies that new objects use the default color (white or black, depending on your background color) until you group the objects into a block and insert the block. When you insert the block into a drawing, the objects in the block inherit the current Color setting.

**NOTE** The BYLAYER and BYBLOCK options do not apply to the LIGHT (page 575) command.

Color
Specifies a color name, BYLAYER or BYBLOCK color, or an AutoCAD Color Index (ACI) number of 1 through 255. The New color swatch shows the most recently selected color.

Old Color Swatch
Displays the previously selected color.

New Color Swatch
Displays the currently selected color.

See also:
Set the Current Color

**True Color Tab (Color Palette Dialog Box)**

Specifies color settings using true colors.
Summary

Specifies color settings using true colors (24-bit color) with either the Hue, Saturation, and Luminance (HSL) color model or the Red, Green, and Blue (RGB) color model. Over sixteen million colors are available when using true color functionality. The options available on the True Color tab are dependent on whether the HSL or RGB color model is specified.

List of Options

The following options are displayed.

HSL Color Model

Specifies the HSL color model for selecting colors.

Hue, saturation, and luminance are properties of colors. By manipulating the values of these properties, you can specify a wide range of colors.

Hue (H)

Specifies the hue of a color. Hues represent a specific wavelength of light within the visible spectrum. To specify a hue, use the color spectrum or specify a value in the Hue box. Adjusting this value affects the RGB value. Valid hue values are from 0 to 360 degrees.
Saturation (S)

Specifies the purity of a color. High saturation causes a color to look more pure while low saturation causes a color to look washed-out. To specify color saturation, use the color spectrum or specify a value in the Saturation box. Adjusting this value affects the RGB value. Valid saturation values are from 0 to 100%.

Luminance (L)

Specifies the brightness of a color. To specify color luminance, use the color slider or specify a value in the Luminance box. Valid luminance values are from 0 to 100%. A value of 0% represents the color black, 100% represents white, and 50% represents the optimal brightness for the color. Adjusting this value also affects the RGB value.

Color Spectrum Specifies the hue and purity of a color. To specify a hue, move the crosshairs from side to side over the color spectrum. To specify color saturation, move the crosshairs from top to bottom over the color spectrum.

Color Slider Specifies the brightness of a color. To specify color luminance, adjust the bar on the color slider or specify a value in the Luminance box.

RGB Color Model

Specifies the RGB color model for selecting colors. The options available on the True Color tab are dependent on whether the HSL or RGB color model is specified.

Colors can be broken down into components of red, green, and blue. The values specified for each component represent the intensity of the red, green, and blue components. The combination of these values can be manipulated to create a wide range of colors.

Red (R)

Specifies the red component of a color. Adjust the slider on the color bar or specify a value from 1 to 255 in the Red box. If this value is adjusted, it will be reflected in the HSL color mode values.

Green (G)

Specifies the green component of a color. Adjust the slider on the color bar or specify a value from 1 to 255 in the Green box. If this value is adjusted, it will be reflected in the HSL color mode values.

Blue (B)
Specifies the blue component of a color. Adjust the slider on the color bar or specify a value from 1 to 255 in the Blue box. If this value is adjusted, it will be reflected in the HSL color mode values.

**Color**

Specifies the RGB color value. This option is updated when changes are made to HSL or RGB options. You can also edit the RGB value directly using the following format: 000,000,000.

**True Color Stored as RGB**

Indicates the value for each RGB color component.

**Old Color Swatch**

Displays the previously selected color.

**New Color Swatch**

Displays the currently selected color.

**See also:**

Set the Current Color

**Color Books Tab (Color Palette Dialog Box)**

Specifies colors using third-party color books or user-defined color books.
Summary

Once a color book is selected, the Color Books tab displays the name of the selected color book.

List of Options

The following options are displayed.

Color Book

Specifies the color book to be used when selecting colors.

The list consists of all the color books that are found in the Color Book Locations specified in the Application References dialog box, Application tab. Displays the pages of the selected color book and the colors and color names on each page. Color books containing up to ten colors per page are supported. If a color book is not paginated, the colors are organized into pages containing seven colors per page. To view color book pages, select an area on the color slider or use the up and down arrows to browse.

RGB Equivalent Indicates the value for each RGB color component.

Color
Indicates the currently selected color book color. You can search for a specific color in a color book by entering the number of the color swatch and pressing Tab. This action updates the New color swatch with the requested color number. If the specified color is not found in the color book, the closest number match is displayed.

Old Color Swatch
Displays the previously selected color.

New Color Swatch
Displays the currently selected color.

See also:
Set the Current Color

-COLOR

If you enter -COLOR at the Command prompt, the following prompts are displayed.
Enter default object color [Truecolor (page 213)/COLORbook (page 213)] <BYLAYER>: Enter a color, enter t, enter co, or press Enter

You can enter a color from the AutoCAD Color Index (a color name or number), a true color, or a color from a color book.

You can enter the color number (1 through 255) or the color name (the names for the first seven colors). For example, you can specify the color red by entering the ACI number 1 or the ACI name red.

You can also enter bylayer or byblock. If you enter byblock, all new objects are drawn in the default color (white or black, depending on your background color) until they are grouped into a block. When you insert the block in a drawing, the objects in the block inherit the current setting of COLOR.

WARNING If you used a mixture of color methods to draw the objects that make up a block, inserting that block or changing its color produces complex results.

If you enter bylayer, new objects assume the color assigned to the layer on which you create them. See the LAYER (page 539) command for information about assigning a color to a layer.
List of Prompts

The following prompts are displayed.

**True Color** Specifies a true color to be used for the selected object. Enter three integer values from 0 to 255 separated by commas to specify a true color.

**Color Book** Specifies a color from a loaded color book to be used for the selected object. Enter the name of a color book that has been installed. If you enter a color book name, you are prompted to enter the color name in the color book.

See also:

Set the Current Color

COMMANDLINE

Displays the Command Line window.

Access Methods

- **Menu**: Tools ➤ Palettes ➤ Command Line
- **Menu**: Window ➤ Command Line
- **Command entry**: Cmd-3

Summary

Displays the command line when it has been hidden.

You can display commands, system variables, options, messages, and prompts in a dockable and resizable window called the Command Line.

See also:

The Command Line

COMMANDLINEHIDE

Hides the Command Line window.
Access Methods

Menu: Tools ➤ Palettes ➤ Command Line
Menu: Window ➤ Command Line
Command entry: Cmd-3

Summary

Hides the Command Line. When the Command Line is hidden, you can still enter commands with dynamic prompts turned on.

See also:
The Command Line

COMPILE

Compiles shape files and PostScript font files into SHX files.

Summary

The Select Shape or Font File dialog box (a standard file selection dialog box (page 723)) is displayed. Enter the SHP or PFB file name in the dialog box. The compiled file is assigned this name with the file extension .shx.

See also:
Overview of Shape Files

CONE

Creates a 3D solid cone.

Access Methods

Button

Toolbar: Modeling tool set ➤ Solids - Create tool group ➤ Solid Primitives ➤ Cone
Menu: Draw ➤ 3D Modeling ➤ Cone

Summary

Creates a 3D solid with a circular or elliptical base that tapers symmetrically to a point or to a circular or elliptical planar face. You can control the smoothness of 3D curved solids, such as a cone, in a shaded or hidden visual style with the FACETRES system variable.

Use the Top Radius option to create a cone frustum.
Initially, the default base radius is not set to any value. During a drawing session, the default value for the base radius is always the previously entered base radius value for any solid primitive.

List of Prompts

The following prompts are displayed.
Specify center point of base or [3P (page 216)/2P (page 217)/Ttr (page 217)/Elliptical (page 217)]: Specify a point (1) or enter an option
Specify base radius or [Diameter (page 216)] <default>: Specify a base radius, enter d to specify a diameter, or press Enter to specify the default base radius value
Specify height or [2Point (page 216)/Axis endpoint (page 216)/Top radius (page 216)] <default>: Specify a height, enter an option, or press Enter to specify the default height value

**Center Point of Base**

2Point Specifies that the height of the cone is the distance between the two specified points.

Axis Endpoint Specifies the endpoint location for the cone axis. The axis endpoint is the top point of the cone or the center point of the top face of the cone frustum (Top Radius option). The axis endpoint can be located anywhere in 3D space. The axis endpoint defines the length and orientation of the cone.

Top Radius Specifies the top radius of the cone, creating a cone frustum. Initially, the default top radius is not set to any value. During a drawing session, the default value for the top radius is always the previously entered top radius value for any solid primitive.

Diameter Specifies the diameter for the base of the cone. Initially, the default diameter is not set to any value. During a drawing session, the default value for the diameter is always the previously entered diameter value for any solid primitive.

---

**3P (Three Points)**

Defines the base circumference and base plane of the cone by specifying three points.

- 2Point (page 216)
- Axis Endpoint (page 216)
2P (Two Points)
Defines the base diameter of the cone by specifying two points.

- 2Point (page 216)
- Axis Endpoint (page 216)
- Top Radius (page 216)

TTR (Tangent, Tangent, Radius)
Defines the base of the cone with a specified radius tangent to two objects.

Sometimes, more than one base matches the specified criteria. The program draws the base of the specified radius whose tangent points are closest to the selected points.

- 2Point (page 216)
- Axis Endpoint (page 216)
- Top Radius (page 216)

Elliptical
Specifies an elliptical base for the cone.

Center Creates the base of the cone by using a specified center point.

- 2Point (page 216)
- Axis Endpoint (page 216)
- Top Radius (page 216)

See also:
Create a Solid Cone

CONSTRANTBAR
Displays or hides the geometric constraints on an object.

Access Methods

Button
**Toolbar:** Drafting tool set ➤ Parametric tool group ➤ Constraint Display flyout ➤ Show Geometric Constraints

**Menu:** Parametric ➤ Constraints Bars ➤ Select Objects

**Summary**

The selection preview behavior for constraint bars is as follows:

- Placing the cursor over an icon on a constraint bar highlights related geometry.
- Placing the cursor over a constrained object (while constraint bars are displayed) highlights the constraint icons associated with the selected object.

The `CONSTRAINTBARMODE` (page 1236) system variable or the `CONSTRAINTSETTINGS` (page 219) command controls the display of geometric constraints on constraint bars, when constraint bar are displayed.

**List of Prompts**

The following prompts are displayed.

Select objects: `Select objects with constraint bars`

Enter an option `[Show (page 218)/Hide (page 218)/Reset (page 218)] <Show>`: *Enter the appropriate value to show or hide constraint bars in the drawing.*

**Show**

Displays constraint bars for the selected objects with geometric constraints applied to them.

**Hide**

Hides constraint bars for the selected objects with geometric constraints applied to them.

**Reset**

Displays constraint bars for all objects with geometric constraints applied to them and resets them to their default locations relative to their associated parameters.

**See also:**

- Display and Verify Geometric Constraints
CONSTRAINT SETTINGS

Controls the display of geometric constraints on constraint bars.

Access Methods

Menu: Parametric ➤ Constraint Settings

Summary

The Constraint Settings dialog box (page 219) is displayed.

See also:

Overview of Constraints

Constraint Settings Dialog Box

Allows you to control the geometric constraints, dimensional constraints, and autoconstrain settings.

![Constraint Settings Dialog Box Image]
List of Options

The following options are displayed.

The Constraint Settings dialog box includes the following:

- Geometric Tab (page 220)
- Dimensional Tab (page 220)
- Autoconstrain Tab (page 221)

Geometric Tab

Controls the display of constraint types on constraint bars.

**Infer Geometric Constraints** Infers geometric constraints when creating and editing geometry.

**Displayed Constraints** Controls the display of constraint bars or constraint point markers for objects in the drawing editor.

For example, you can hide the display of constraint bars for Horizontal and Vertical constraints.

**Select All** Selects the geometric constraint types.

**Clear All** Clears the selected geometric constraint types.

**Display Constraints in the Current Plane** Displays constraint bars for geometrically constrained objects only on the current plane.

**Icon Transparency** Sets the transparency level of constraint bars in a drawing.

**Show Constraint Bars After Applying Constraints to Selected Objects** Displays relevant constraint bars after you apply a constraint manually or when you use the AUTOCONSTRAIN (page 131) command.

**Temporarily Display Constraint Bars When Objects Are Selected** Temporarily displays the constraint bars of the selected objects.

Dimensional Tab

Sets preferences in behavior when displaying dimensional constraints.

**Dimensional Constraint Format** Sets the display of the dimensional name format and lock icon.

**Dimension Name Format** Specifies the format for the text displayed when dimensional constraints are applied.

Set the name format to display: Name, Value, or Name and Expression.

For example: Width=Length/2
Show Lock Icon for Annotational Constraints Displays a lock icon against an object that has an annotational constraint applied (DIMCONSTRAINTICON (page 1267) system variable).

Show Hidden Dynamic Constraints for Selected Objects Displays dynamic constraints that have been set to hide when selected.

Autoconstrain Tab
Controls the constraints that are applied to a selection set, and the order in which they are applied when using the AUTOCONSTRAIN (page 131) command. The following conditions are checked before multiple geometric constraints are applied:

- Are the objects perpendicular or tangential to each other within the tolerances specified in the AutoConstrain tab?
- Do they also intersect within the specified tolerances?

If the first condition is met, then tangent and perpendicular constraints are always applied if the check boxes are cleared.

If you select the additional check boxes, then the distance tolerance is considered for intersecting objects. If the objects do not intersect but the nearest distance between them is within the distance tolerance specified, then the constraint will be applied even if the check box is selected.

Autoconstrain Headings

- Applied — Controls the constraints that are applied when applying constraints to multiple objects.
- Constraint Type — Controls the type of constraint applied to objects.

Tolerances Sets the acceptable tolerance values to determine whether a constraint can be applied.

- Distance — Distance tolerance are applied to coincident, concentric, tangent, and collinear constraints.
- Angle — Angular tolerance are applied to horizontal, vertical, parallel, perpendicular, tangent, and collinear constraints.

Tangent Objects Must Share an Intersection Point Specifies that two curves must share a common point (as specified within the distance tolerance) for the tangent constraint to be applied.

Perpendicular Objects Must Share an Intersection Point Specifies that lines must intersect or the endpoint of one line must be coincident with the other line or endpoint of the line as specified within the distance tolerance.
See also:
Overview of Constraints

**+CONSTRAINTSETTINGS**

Controls the tab that is displayed by default when the Constraint Settings dialog box is invoked.

<table>
<thead>
<tr>
<th>Tab Index</th>
<th>Tab Displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Geometric tab</td>
</tr>
<tr>
<td>1</td>
<td>Dimensional tab</td>
</tr>
<tr>
<td>2</td>
<td>AutoConstrain tab</td>
</tr>
</tbody>
</table>

See also:
Overview of Constraints

**CONTENT**

Opens the Content palette.

**Access**

- **Button**
- **Toolbar:** Drafting tool set ➤ Block Tool group (expanded) ➤ Content Palette
- **Menu:** Tools ➤ Palettes ➤ Content
- **Menu:** Window ➤ Content
- **Command entry:** Cmd-2
Summary

The Content palette (page 223) allows you to insert blocks from the current drawing or a custom library of blocks. You create libraries to access and organize your blocks. Blocks that you use frequently can be added to the Favorites library.

See also:

The Content Palette

Content Palette

Allows you to access and insert your blocks stored in libraries.

List of Options

The following options are displayed.

Libraries List
Displays the available libraries. Select a library to insert blocks from or select Manage Libraries to display the Manage Content Libraries dialog box (page 225). The following libraries are available by default:

- **Favorites** - Blocks that you have selected as favorites from the Blocks list.
- **Blocks in Current Drawing** - Lists the blocks in the current drawing that you can create new inserts from.
Manage Content Libraries
Displays the Manage Content Libraries dialog box (page 225) in which you create and manage content of libraries.

Blocks List
Displays the blocks in the library selected from the Libraries list.

Click a block from the list to insert it in the current drawing. If you right-click in the Blocks list, one of two shortcut menus is displayed. The Blocks List shortcut menu (page 224) is displayed when you right-click an empty area of the Blocks list, while the Block shortcut menu (page 224) is displayed when you right-click over a block thumbnail.

Filter Blocks List
Filters the blocks displayed in the Blocks list. Click the ‘X’ in the text box to clear the current filter.

Enter a text string to control which blocks are displayed in the Blocks list. Only the names of the blocks that contain the text string are displayed in the Blocks list.

Blocks List Shortcut Menu
The following options are available when you right-click in an empty area of the Blocks list:

- **Small Thumbnails** - Small thumbnails for the blocks in the current library are displayed in the Blocks list.
- **Medium Thumbnails** - Medium thumbnails for the blocks in the current library are displayed in the Blocks list.
- **Large Thumbnails** - Large thumbnails for the blocks in the current library are displayed in the Blocks list.
- **Manage Libraries** - Displays the Manage Content Libraries dialog box (page 225).

Block Shortcut Menu
The following options are available when you right-click a block thumbnail in the Blocks list:

- **Insert in Drawing** - Starts the insertion of the block in the current drawing.
- **Add to Favorites** - Adds the block to the Favorites content library.
- **Thumbnail Size** - Controls the size of the thumbnails displayed in the Blocks list: small, medium, or large.
- **Remove** - Removes the selected block from the current content library.
 Manage Libraries - Displays the Manage Content Libraries dialog box (page 225).

See also:
The Content Palette

Manage Content Libraries Dialog Box

Allows you to create and manage the blocks in a library.

List of Options

The following options are displayed.

Libraries List
Lists the available libraries. The Favorites library is available by default. Select a library to manage the blocks contained in the library in the Blocks list.

Double-click the name of a library to rename it.

Create Library (+) Creates a new library and prompts you to enter a name in an in-place editor.

Delete Library (-) Removes the selected library from the Libraries list.

Blocks List
Lists the blocks contained in the selected library.
Add Block (+) Displays the Open File Dialog (a standard navigation dialog box) in which you select a drawing (DWG) or drawing template (DWT) file to add to the selected library.

**NOTE** Hold down the Command key to select more than one file.

Delete Library (-) Removes the selected block from the library.

Filter Blocks List Filters the blocks displayed in the Blocks list. Click the ‘X’ in the text box to clear the current filter. Enter a text string to control which blocks are displayed in the Blocks list. Only the names of the blocks that contain the text string are displayed in the Blocks list.

See also:
The Content Palette

**CONTENTCLOSE**

Closes the Content palette.

**Summary**

Closes the Content palette that is displayed with the CONTENT (page 222) command.

See also:
The Content Palette

**CONVERT**

Optimizes 2D polylines and associative hatches created in AutoCAD Release 13 or earlier.

**Summary**

Hatches are not updated automatically when a drawing from a previous release is opened in Release 14 or later. Information about the rotation of a hatch pattern may not be updated properly if you have changed the UCS since creating the hatch. When updating hatches with CONVERT, it is recommended that you use the Select option so that you can check your results.
In most cases, you do not need to update polylines with CONVERT. By default, the `PLINETYPE` (page 1437) system variable specifies that polylines are updated automatically when you open an older drawing. Polylines may be created in the old format by third-party applications, and they may be contained in an older drawing that was inserted as a block and then exploded.

**NOTE** Polylines containing curve-fit or splined segments always retain the old format, as do polylines that store extended object data on their vertices. Editing commands make no distinction between the two formats.

### List of Prompts

The following prompts are displayed.

Enter type of objects to convert [Hatch (page 227)/Polyline (page 227)/All (page 227)] <All>: Enter `h` for hatches, `p` for polylines, or `a` for both

- **Hatch** Converts all hatches in the drawing.
- **Polyline** Converts all polylines in the drawing.
- **All** Converts all polylines and hatches in the drawing.

**See also:**

- Use Drawings from Different Versions and Applications

### CONVTOMESH

Converts 3D objects such as polygon meshes, surfaces, and solids to mesh objects.

**Access Methods**

- **Menu:** Modify ➤ Surface Editing ➤ Convert to Mesh

**Summary**

Take advantage of the detailed modeling capabilities of 3D mesh by converting objects such as 3D solids and surfaces to mesh.
Use this method to convert 3D faces (3DFACE) and legacy polygonal and polyface meshes (from AutoCAD 2009 and earlier). You can also convert 2D objects such as regions and closed polylines.

The level of smoothness upon conversion depends on the mesh type setting (FACETERMESHTYPE (page 1329) system variable). If the mesh type is not set to be optimized, the converted object is not smoothed.

To convert mesh objects to 3D surfaces or solids, use CONVTOSOLID (page 229) or CONVTOSURFACE (page 232) commands.

**Objects That Can Be Converted to Mesh**

<table>
<thead>
<tr>
<th>Object type</th>
</tr>
</thead>
<tbody>
<tr>
<td>3D solids</td>
</tr>
<tr>
<td>3D surfaces</td>
</tr>
<tr>
<td>3D faces</td>
</tr>
<tr>
<td>Polyface and polygon meshes (legacy)</td>
</tr>
<tr>
<td>Regions</td>
</tr>
<tr>
<td>Closed polylines</td>
</tr>
</tbody>
</table>

**See also:**

Create Meshes by Conversion
**CONVTONURBS**

Converts 3D solids and surfaces into NURBS surfaces.

**Access Methods**

Menu: Modify ➤ Surface Editing ➤ Convert to NURBS

**Summary**

Converts solids and procedural surfaces to NURBS surfaces.

To convert meshes to NURBS surfaces, convert them to a solid or surface first with CONVTOSOLID (page 229) or CONVTOURFACE (page 232) and then convert them to NURBS surfaces.

**See also:**

Create NURBS Surfaces

---

**CONVTOSOLID**

Converts 3D meshes and polylines and circles with thickness to 3D solids.

**Access Methods**

Menu: Modify ➤ 3D Operations ➤ Convert to Solid
Summary

Take advantage of the solid modeling capabilities available for 3D solids. When you convert mesh, you can specify whether the converted objects are smoothed or faceted, and whether the faces are merged.

The smoothness and number of faces of the resulting 3D solid are controlled by the SMOOTHMESHCONVERT (page 1479) system variable. Whereas the previous example shows a conversion to a smooth, optimized 3D solid, the following example shows a conversion to a faceted 3D solid in which the faces are not merged, or optimized.

The following tables list the objects that can be converted to solid objects and some limitations on their conversion.

<table>
<thead>
<tr>
<th>Objects that Can Be Converted to 3D Solids</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Object</strong></td>
</tr>
<tr>
<td>-------------</td>
</tr>
<tr>
<td>Mesh</td>
</tr>
<tr>
<td>Polyline</td>
</tr>
<tr>
<td>Object</td>
</tr>
<tr>
<td>------------------------</td>
</tr>
<tr>
<td>Polyline</td>
</tr>
<tr>
<td>Surface</td>
</tr>
</tbody>
</table>

**Limitations on Conversion to Solid Objects**

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polyline</td>
<td>Cannot contain zero-width vertices.</td>
</tr>
<tr>
<td>Polyline</td>
<td>Cannot contain segments of variable width.</td>
</tr>
<tr>
<td>Separate objects that simulate a closed surface</td>
<td>Cannot be a planar surface with contiguous edges or an exploded 3D solid box into six regions. However, you cannot convert those separate objects back to a solid with CONVTOSOLID.</td>
</tr>
<tr>
<td>Planar surfaces with contiguous edges</td>
<td>Cannot convert separate objects unless they enclose a volume without gaps. If the surfaces enclose a watertight area, you can convert to a solid with the SURFSCULPT (page 1058) command.</td>
</tr>
<tr>
<td>Exploded 3D solid</td>
<td>Cannot convert separate objects (in this case, regions) with the CONVTOSOLID command. You can, however, convert them to a solid with the SURFSCULPT (page 1058) command.</td>
</tr>
</tbody>
</table>

You can select the objects to convert before you start the command.

The **DELOBJ** (page 1251) system variable controls whether the geometry used to create 3D objects is automatically deleted when the new object is created or whether you are prompted to delete the objects.

**List of Prompts**

The following prompts are displayed.
**Select objects** Specifies one or more objects to convert to 3D solid objects. You can select objects with thickness or mesh objects. If one or more objects in the selection set are invalid for the command, you will be prompted again to select objects.

See also:
Create 3D Solids from Objects

**CONVTOSURFACE**

Converts objects to 3D surfaces.

**Access Methods**

Menu: Modify ➤ 3D Operations ➤ Convert to Surface

**Summary**

As you convert objects to surfaces, you can specify whether the resulting object is smooth or faceted.

When you convert a mesh, the smoothness and number of faces of the resulting surface are controlled by the SMOOTHMESHCONVERT (page 1479) system variable. Whereas the previous example shows a conversion to a smooth, optimized surface, the following example shows a conversion to a faceted surface in which the faces are not merged, or optimized.
With the CONVTOSURFACE command, you can convert the following objects into surfaces:

**Objects That Can Be Converted to 3D Surfaces**

<table>
<thead>
<tr>
<th>Objects</th>
</tr>
</thead>
<tbody>
<tr>
<td>2D solids</td>
</tr>
<tr>
<td>3D solids</td>
</tr>
<tr>
<td>Regions</td>
</tr>
<tr>
<td>Open, zero-width polylines with thickness</td>
</tr>
<tr>
<td>Lines with thickness</td>
</tr>
<tr>
<td>Arcs with thickness</td>
</tr>
<tr>
<td>Mesh objects</td>
</tr>
<tr>
<td>Planar 3D faces</td>
</tr>
</tbody>
</table>
objects converted to surfaces
You can select the objects to convert before you start the command.

NOTE You can create surfaces from 3D solids with curved faces, such as a cylinder, with the EXPLODE (page 411) command.

The DELOBJ (page 1251) system variable controls whether the geometry used to create 3D objects is automatically deleted when the new object is created or whether you are prompted to delete the objects.

List of Prompts

The following prompts are displayed.

Select objects Specifies one or more objects to convert to surfaces.
If one or more objects in the selection set are invalid for the command, you will be prompted again to select objects.
See also:
Convert Objects to Procedural Surfaces

COPY

Copies objects a specified distance in a specified direction.

Access Methods

Button

 Toolbar: Drafting tool set ➤ Copy tool group ➤ Copy
Menu: Modify ➤ Copy
Shortcut menu: Select the objects to copy, and right-click in the drawing area. Click Copy Selection.

Summary

With the COPYMODE (page 1240) system variable, you can control whether multiple copies are created automatically.
List of Prompts

The following prompts are displayed.

Select objects: Use an object selection method and press Enter when you finish

Specify base point or [Displacement/mOde/Multiple] <Displacement>: Specify a base point or enter an option
Specify second point or [Array] <use first point as displacement>: Specify a second point or enter an option

Displacement
Specifies a relative distance and direction using coordinates.

The two points you specify define a vector that indicates how far from the original the copied objects are to be placed and in what direction.

If you press Enter at the Specify Second Point prompt, the first point is interpreted as a relative X,Y,Z displacement. For example, if you specify 2,3 for the base point and press Enter at the next prompt, the objects are copied 2 units in the X direction and 3 units in the Y direction from their current location.

Mode
Controls whether the command repeats automatically (COPYMODE (page 1240) system variable).

Single Creates a single copy of selected objects and ends the command.

Multiple Overrides the Single mode setting. The COPY command is set to repeat automatically for the duration of the command.

Array
Arranges a specified number of copies in a linear array.
Number of Items to Array Specifies the number of items in the array, including the original selection set.

Second Point Determines a distance and direction for the array relative to the base point. By default, the first copy in the array is positioned at the specified displacement. The remaining copies are positioned in a linear array beyond that point using the same incremental displacement.

Fit Positions the final copy in the array at the specified displacement. The other copies are fit in a linear array between the original selection set and the final copy.

See also:
  Copy Objects

COPYBASE

Copies selected objects to the Clipboard along with a specified base point.

Access Methods

Menu: Edit ➤ Copy with Base Point
Shortcut menu: End any active commands, right-click in the drawing area, and choose Clipboard ➤ Copy with Base Point.

Summary

The selected objects are copied to the Clipboard.
  Use PASTECLIP (page 770) to move the copied objects from the Clipboard to a location in the same document or to another document.
  When you paste an object copied with COPYBASE, it is placed relative to the specified base point.

See also:
  Cut, Copy, and Paste with the Clipboard

COPYCLIP

Copies selected objects to the Clipboard.
Access Methods

Menu: Edit ➤ Copy
Shortcut menu: End any active commands, right-click in the drawing area, and choose Clipboard ➤ Copy.

Command entry: Cmd-C

Summary

COPYCLIP copies all objects you select to the Clipboard. You can paste the contents of the Clipboard into a document or drawing.

NOTE If the cursor is in the drawing area, the selected objects are copied to the Clipboard. If the cursor is on the command line or in the text window, the selected text is copied to the Clipboard.

When you copy objects to the Clipboard, information is stored in all available formats. When you paste the Clipboard contents into a drawing, the format that retains the most information is used. You can also use Copy and Paste to transfer objects between drawings.

See also:
Cut, Copy, and Paste with the Clipboard

COPYHIST

Copies the text in the command line history to the Clipboard.

Summary

The text is copied to the Clipboard.

See also:
View and Edit Within the Command History

CUI

Manages the customized user interface elements in the product.
Access Methods

Menu: Tools ➤ Customize ➤ Interface (CUI)

Summary

The Customize dialog box is displayed.

You use the Customize dialog box to customize the menu bar and Tool Sets palette. For information about customizing the different user interface elements found in the Customize dialog box, see User Interface Customization in the Customization Guide.

See also:

Understand User Interface Customization

Customize Dialog Box

Manages customized user interface elements for the menu bar and Tool Sets palette.

List of Tabs

The Customize User Interface Editor includes the following tabs:

- Commands (page 240)
- Menus (page 242)
- Tool Sets (page 243)

For more information, see User Interface Customization in the Customization Guide.

List of Options

The following options are displayed.

Reset to Default

Resets the commands and user interface elements back to their initial installed default settings.

See also:

Understand User Interface Customization
Commands Tab (Customize Dialog Box)

Creates and manages the available commands that can be added to menus and tool sets.

List of Options

The following options are displayed.

**Commands List**
Displays all the standard and custom commands available.

- **Image** - Thumbnail of the current image assigned to the command.
- **Command** - Name of the command. Displayed on the menu bar when the command is assigned to a menu or in a tooltip when the command is assigned to a tool group on the Tool Sets palette.
- **Source** - Name of the customization group that the command is stored in.

Create New Command (+) Adds a new command to the Commands list that can be added to the user interface.
A custom command can be used to start a core AutoCAD command or one defined by a third party. Commands can also contain AutoLISP code.

**Options** Displays a menu which allows you to manage existing commands in the Commands list.

- **Duplicate** - Creates a copy of the command currently selected in the Commands list. Duplicating a command allows you to modify an existing command without changing the original one.

- **Delete** - Removes the selected command from the Commands list. Commands that are currently assigned to a menu or Workflow cannot be deleted.

  **NOTE** There is no way to undo the removal of a command, be sure to select the correct command before you click Delete.

**Filter Commands List** Filters the commands displayed in the Commands list. Click the ‘X’ in the text box to clear the current filter.

Enter a text string to control which commands are displayed in the Commands list. Only the names of the commands that contain the text string are displayed in the Commands list.

**Properties**

Displays the properties and values that define the selected command in the Command list.

- **Name** Displays the name of the command. The name you enter is the label or tooltip name displayed in the program.

- **Description** Displays the description for the command. The description you enter is displayed in a tooltip.

- **Macro** Displays the macro assigned to the command. Enter a new or change the existing macro for the command.

- **Image** Specifies the raster image to use for the command when it is added to a tool set.

- **Preview** Displays a thumbnail of the image currently assigned to the command.

**Information**

Displays some basic information about the field that currently has cursor focus under Properties.

**See also:**

   - Customize Commands
Menus Tab (Customize Dialog Box)

Creates and manages the menus and menu items on the Mac OS menu bar.

List of Options

The following options are displayed.

**Commands List**

Displays a list of the standard and custom commands that can be added to menus and tool sets. You must be on the Commands tab (page 240) if you want to create or edit a command.

Drag the command to the location in the menu you want it positioned and drop it. The location of the command is indicated by the horizontal bar. If you hover over a menu or sub-menu while dragging a command, the menu or sub-menu will expand after a short interval.

**Filter Commands List** Filters the commands displayed in the Commands list. Click the ‘X’ in the text box to clear the current filter.
Enter a text string to control which commands are displayed in the Commands list. Only the names of the commands that contain the text string are displayed in the Commands list.

**Menus List**
Lists the menus available on the Mac OS menu bar. Expand a menu to see the commands and sub-menus that are assigned to the menu.

Create New Element(+) Displays a menu which allows you to create a new menu or sub-menu.
- **Add Menu** - Creates a new parent menu that is displayed directly on the Mac OS menu bar.
- **Add Sub-menu** - Creates a new sub-menu that is used to organize related commands on a menu.

Options Displays a menu which allows you to manage the commands and sub-menus in a menu.
- **Insert Separator** - Adds a new separator after the selected command or sub-menu in the Menus list. When inserted, a solid horizontal line is displayed in the menu when displayed from the Mac OS menu bar.
- **Duplicate** - Creates a copy of the command, sub-menu, or separator currently selected in the Menus list.
- **Delete** - Removes the selected command, sub-menu, or separator from the Menus list.

See also:
- Menus

**Tool Sets Tab (Customize Dialog Box)**

Creates and manages the tools in the Workflow palette.
List of Options

The following options are displayed.

**Commands List**
Displays a list of the standard and custom commands that can be added to menus and tool sets. You must be on the Commands tab (page 240) if you want to create or edit a command.

Drag the command to the location in the menu you want it positioned and drop it. The location of the command is indicated by the horizontal bar. If you hover over a menu or sub-menu while dragging a command, the menu or sub-menu will expand after a short interval.

**Filter Commands List** Filters the commands displayed in the Commands list. Click the ‘X’ in the text box to clear the current filter.

Enter a text string to control which commands are displayed in the Commands list. Only the names of the commands that contain the text string are displayed in the Commands list.
Tool Sets List
Lists the tool sets available on the Tool Sets palette. Expand a tool set to see the commands, tool groups, and drop-downs (also known as flyouts) that are assigned to the tool set.

Right-click over a tool set in the list and choose Specify Tool Set Image to display the Specify Tool Set Image dialog box (page 246). The image assigned appears next to the tool set name in the Tool Sets list on the Tool Sets palette.

Create New Element(+) Displays a menu which allows you to create a new tool set, tool group, or drop-down.

■ Add Tool Set - Creates a new tool set that can be accessed from the Tool Sets palette. Only one tool set can be displayed at a time on the Tool Sets palette.
   You do not add commands directly to a tool set, but to a tool group under a tool set.

■ Add Tool Group - Creates a new tool group that is used to organize related commands in a tool set.
   Tool groups are collapsed by default, and display the commands and drop-downs above the separator in the tool group. Commands and drop-downs below the separator are hidden until the disclosure triangle for the tool group is clicked on the Tool Sets palette. Click the Lock icon on a tool group’s title bar to keep it expanded.

■ Add Drop-down - Creates a new drop-down (of flyout) that is used to group related commands into a single button on a tool group.

Options Displays a menu which allows you to manage the tool groups, commands, and drop-downs in a tool set.

■ Insert Separator - Adds a new separator after the selected command or drop-down in the Tool Sets list. When inserted, a solid horizontal line is displayed in the tool group or drop-down. A separator on a tool group controls which commands and drop-downs are displayed by default or are only available when the tool group is expanded.

■ Duplicate - Creates a copy of the selected tool group, command, drop-down, or separator currently selected in the Tool Sets list.

■ Delete - Removes the selected tool group, command, drop-down, or separator from the Tool Sets list.

See also:

Tool Sets
Specify Tool Set Image Dialog Box

Assigns an external image or internal resource to a tool set.

List of Options

The following options are displayed.

Image Displays the name of the resource or external image file that is assigned to the tool set.

Click [...] to display the Select an Image File dialog box and specify the external image to assign to the tool set.

Preview Displays a thumbnail of the selected image.

See also:

Tool Sets

CUTCLIP

Copies selected objects to the Clipboard and removes them from the drawing.

Access Methods

Menu: Edit ➤ Cut
Shortcut menu: End any active commands, right-click in the drawing area, and choose Clipboard ➤ Cut.

Command entry: Cmd-X
Summary

CUTCLIP copies selected objects to the Clipboard, removing them from the drawing.

You can paste the contents of the Clipboard into a document (see PASTECLIP (page 770)).

When you want to use objects from a drawing file in another application, you can cut these objects to the Clipboard and then paste them into another application. You can also use Cut and Paste to transfer objects between drawings.

See also:
Cut, Copy, and Paste with the Clipboard

CVADD

Adds control vertices to NURBS surfaces and splines.

Access Methods

Menu: Modify ➤ Surface Editing ➤ NURBS Surface Editing ➤ Add CV

Summary

Adds control vertices in the U or V direction, or adds points directly on a surface or spline. This illustration shows a row of control vertices added in the V direction.
List of Prompts

The following prompts are displayed.

Select a NURBS surface or curve to add control vertices Select a valid NURBS surface or curve and press Enter.

Point Select a valid NURBS surface or curve and press Enter.

Insert Knots Turns off the display of control vertices and allows you to place a point directly on a surface. This option only displays if you select a surface; it does not display for splines.

Insert Edit Point Turns off the display of control vertices and allows you to place a point directly on a spline. This option only displays if you select a spline; it does not display for surfaces.

Direction Specifies whether to add control vertices in the U or V direction. This option only displays if you select a surface; it does not display for splines.

See also:

   Edit NURBS Surfaces

CVHIDE

Turns off the display of control vertices for all NURBS surfaces and curves.

Access Methods

Menu: Modify ➤ Surface Editing ➤ NURBS Surface Editing ➤ Hide CV

Summary

Turns off the CV display for all NURBS objects.
See also:
Edit NURBS Surfaces

CVREBUILD

Rebuilds the shape of NURBS surfaces and curves.

Access Methods

Menu: Modify ➤ Surface Editing ➤ NURBS Surface Editing ➤ Rebuild

Summary

If you have difficulties editing the control vertices or there are too many control vertices, you can rebuild a surface or curve with less control vertices in the U or V direction. CVREBUILD also allows you to change the degree of the surface or curve.
If you select a surface, the Rebuild Surface dialog box (page 250) is displayed. If you select a spline, the Rebuild Curve dialog box (page 251) is displayed.

See also:
   Edit NURBS Surfaces

**Rebuild Surface Dialog Box**

Rebuilds the CV hull of a NURBS surface.

**Summary**

Reshapes a NURBS surface by rebuilding the CV hull.

**List of Options**

The following options are displayed.

**Control Vertices Count**

Specifies the number of control vertices in the U and V directions.

**In U Direction**

Specifies the number of control vertices in the U direction. (REBUILDU (page 1458) system variable)

**In V Direction**

Specifies the number of control vertices in the V direction. (REBUILDV (page 1458) system variable)

**Degree**

Specifies the number of control vertices available per span. The higher the number, the more complex the surface.
In U Direction
Specifies the degree of the NURBS surface in the U direction. (REBUILDDEGREEU (page 1456) system variable)

In V Direction
Specifies the degree of the NURBS surface in the V direction. (REBUILDDEGREEV (page 1457) system variable)

Options
Specifies the build options. (REBUILDOPTIONS (page 1457) system variable)

Delete Input Geometry
Specifies whether the original surface is retained along with the rebuilt surface. (REBUILDOPTIONS (page 1457) system variable)

Retrim Previously Trimmed Surface
Specifies whether trimmed areas from the original surface are applied to the rebuilt surface. (REBUILDOPTIONS (page 1457) system variable)

Maximum Deviation
Displays the maximum deviation between the original surface and the new one.

See also:
Rebuild NURBS Surfaces and Curves

Rebuild Curve Dialog Box

Rebuilds the shape of a NURBS curve.

Summary
Changes the number of control vertices and the degree of a NURBS curve. Rebuilding the curve changes its shape.

List of Options
The following options are displayed.

Curve Geometry Details
Control Vertices Count
Specifies the number of control vertices. *(REBUILD2DCV* (page 1455) system variable)

**Degree**

Specifies the degree of the NURBS curve. *(REBUILD2DDEGREE* (page 1455) system variable)

**Options**

Specifies the build options. *(REBUILD2DOPTIONS* (page 1457) system variable)

**Delete input geometry**

Specifies whether the original curve is retained along with the rebuilt curve. *(REBUILD2DOPTION* (page 1456) system variable)

**Maximum Deviation**

Displays the maximum deviation between the original curve and the new one.

See also:

- Rebuild NURBS Surfaces and Curves

**CVREMOVE**

Removes control vertices from NURBS surfaces and curves.

**Access Methods**

- **Menu:** Modify ➤ Surface Editing ➤ NURBS Surface Editing ➤ Remove CV

**Summary**

Removes control vertices in the U or V direction. This illustration shows a row of control vertices deleted in the V direction.

**NOTE** The minimum number of control vertices that you can have on a surface or curve is two in any direction. If you try to remove more, an error displays.
List of Prompts

The following prompts are displayed.

Select a NURBS surface or curve to remove control vertices. Select a valid NURBS surface or curve and press Enter.

Point Specifies a valid NURBS surface or curve and press Enter.

Remove Knots Turns off the display of control vertices and allows you to remove a point directly from the surface. This option only displays if you select a surface; it does not display for splines.

Remove Edit Point Turns off the display of control vertices and allows you to remove a point directly from the spline. This option only displays if you select a spline, it does not display for surfaces.

Direction Specifies whether to remove control vertices in the U direction. This option only displays if you have selected a surface; it does not display for splines.

See also:

Edit NURBS Surfaces

CVSHOW

Displays the control vertices for specified NURBS surfaces or curves.
Access Methods

Menu: Modify ➤ Surface Editing ➤ NURBS Surface Editing ➤ Show CV

Summary

Prompts you to select the NURBS surfaces and curves whose control vertices you want to display. Non-NURBS surfaces do not have control vertices. You can convert objects to NURBS surfaces with the CONVTONURBS command.

See also:

Edit NURBS Surfaces

CYLINDER

Creates a 3D solid cylinder.

Access Methods

Button

Toolbar: Modeling tool set ➤ Solids - Create tool group ➤ Cylinder
Menu: Draw ➤ 3D Modeling ➤ Cylinder
Summary

In the illustration, the cylinder was created using a center point (1), a point on the radius (2), and a point for the height (3). The base of the cylinder is always on a plane parallel with the workplane. You can control the smoothness of curved 3D solids, such as a cylinder, in a shaded or hidden visual style with the FACETRES system variable.

During a drawing session, the default value for the base radius is always the previously entered base radius value.

List of Prompts

The following prompts are displayed.
Specify center point of base or [3P (page 255)/2P (page 256)/Ttr (page 256)/Elliptical (page 256)]: Specify a center point or enter an option
Specify base radius or [Diameter (page 256)] <default>: Specify a base radius, or enter d to specify a diameter, or press Enter to specify the default base radius value
Specify height or [2Point/Axis endpoint] <default>: Specify a height, enter an option, or press Enter to specify the default height value

3P (Three Points)
Defines the base circumference and base plane of the cylinder by specifying three points.

2Point Specifies that the height of the cylinder is the distance between the two specified points.

Axis Endpoint Specifies the endpoint location for the cylinder axis. This endpoint is the center point of the top face of the cylinder. The axis endpoint can be located anywhere in 3D space. The axis endpoint defines the length and orientation of the cylinder.
**2P (Two Points)**
Defines the base diameter of the cylinder by specifying two points.
- 2Point
- Axis endpoint

**TTR (Tangent, Tangent, Radius)**
Defines the base of the cylinder with a specified radius tangent to two objects.
Sometimes more than one base matches the specified criteria. The program draws the base of the specified radius whose tangent points are closest to the selected points.
- 2Point
- Axis endpoint

**Elliptical**
Specifies an elliptical base for the cylinder.

**Center** Creates the base of the cylinder by using a specified center point.
- 2Point
- Axis endpoint

**Diameter**
Specifies the diameter for the base of the cylinder.
See also:

Create a Solid Cylinder

**D Commands**

**DBLIST**

Lists database information for each object in the drawing.

**Summary**

The text window displays information about each object in the current drawing. The program pauses when the window fills with information. Press Enter to resume output, or press Esc to cancel.

See also:

Display and Change the Properties of Objects

**DCALIGNED**

Constrains the distance between two points on different objects.

**Access Methods**

- **Button**
- **Toolbar:** Drafting tool set ➤ Parametric tool group ➤ Dimensional Constraints flyout ➤ Aligned
- **Menu:** Parametric ➤ Dimensional Constraints ➤ Aligned

**Summary**

This command is equivalent to the Aligned option in **DIMCONSTRAINT** (page 289).
The following table outlines the valid constraint objects and points:

<table>
<thead>
<tr>
<th>Valid Objects or Points</th>
<th>Characteristics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>■ When a line or an arc is selected, the distance between the endpoints of the object is constrained.</td>
</tr>
<tr>
<td>Polyline segment</td>
<td>■ When a line and a constraint point are selected, the distance between the point and the closest point on the line is constrained.</td>
</tr>
<tr>
<td>Arc</td>
<td>■ When two lines are selected, the lines are made parallel and the distance between them is constrained.</td>
</tr>
<tr>
<td>Two constraint points on objects</td>
<td></td>
</tr>
<tr>
<td>Line and constraint point</td>
<td></td>
</tr>
<tr>
<td>Two lines</td>
<td></td>
</tr>
</tbody>
</table>

**List of Prompts**

The following prompts are displayed.
Specify first **constraint point** (page 258) or [Object (page 258)/Point & line (page 258)/2Lines (page 259)] <Object>: Pick a constraint point or select an object, a point and a line, or two lines to be constrained

**Constraint Point**
Specifies a constraint point for the object.

**First Constraint Point** Specifies the first point of the object to be constrained.

**Second Constraint Point** Specifies the second point of the object to be constrained.

**Dimension Line Location** Determines where the dimension line is located on the constrained object.

**Object**
Selects an object instead of a constraint point.

**Dimension Line Location** Determines where the dimension line is located on the constrained object.

**Point & Line**
Selects a point and a line object. The aligned constraint controls the distance between a point and the closest point on a line.

**Constraint Point** **Constraint Point** (page 258)
**Line** Selects a line object.

**Dimension Line Location** Determines where the dimension line is located on the constrained object.

**2Lines**
Selects two line objects. The lines are made parallel and the aligned constraint controls the distance between the two lines.

**First Line** Select the first line to be constrained.

**Second Line to Make Parallel** Select the second line to constrain the distance between the two selected lines.

**Dimension Line Location** Determines where the dimension line is located on the constrained object.

**See also:**
- Apply Dimensional Constraints

---

**DCANGULAR**

Constrains the angle between line or polyline segments, the angle swept out by an arc or a polyline arc segment, or the angle between three points on objects.

**Access Methods**

- **Button**

- **Toolbar:** Drafting tool set ➤ Parametric tool group ➤ Dimensional Constraints flyout ➤ Angular

- **Menu:** Parametric ➤ Dimensional Constraints ➤ Angular

**Summary**

This command is equivalent to the Angular option in **DIMCONSTRAINT** (page 289).

When you enter or edit an angle value that is either negative or is greater than 360 degrees, the number entered is stored for the expression (for example,
390), but the value displayed is based on the formatting of the units (for example, 30 if decimal degrees).

When an expression with variables evaluates to greater than 360 or less than -360, the constraint value is displayed in the Parameters Manager based on the units of the drawing.

The following table outlines the valid constraint objects and points:

<table>
<thead>
<tr>
<th>Valid Objects or Points</th>
<th>Characteristics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pair of lines</td>
<td>- When two lines are selected, the angle between the lines is constrained. The initial value always defaults to a value less than 180 degrees.</td>
</tr>
<tr>
<td>Pair of polyline segment</td>
<td></td>
</tr>
<tr>
<td>Three constraint points</td>
<td></td>
</tr>
<tr>
<td>Arc</td>
<td></td>
</tr>
</tbody>
</table>

- When three constraint points are specified, the following applies:
  - First point — angle vertex
  - Second and third points — endpoints of the angle

- When an arc is selected, a three-point angular constraint is created. The angle vertex is at the center of the arc and the angle endpoints of the arc are at the endpoints of the arc.

**List of Prompts**

The following prompts are displayed.

Select first line (page 260) or arc (page 261) or [3Point (page 261)] <3Point>: *Pick a line, or an arc, or three points to be constrained*

**Line**

Selects a line object.

**First Line** Specifies the first line to be constrained.

**Second Line** Specifies the second line to be constrained.

**Dimension Line Location** Determines where the dimension line is located on the constrained object.
**Arc**
Selects an arc and constrains the angle.

**Dimension Line Location** Determines where the dimension line is located on the constrained object.

**3Point**
Selects three valid constraint points on the object.

**Angle Vertex** Specifies the angle vertex, which is at the center point of the constraint.

**First Angle Constraint Point** Specifies the first angle endpoint of the arc.

**Second Angle Constraint Point** Specifies the second angle endpoint of the arc.

**Dimension Line Location** Determines where the dimension line is located on the constrained object.

**See also:**
- Apply Dimensional Constraints

---

**DCCONVERT**

Converts associative dimensions to dimensional constraints.

**Summary**
This command is equivalent to the Convert option in DIMCONSTRAINT (page 289).

Objects other than associative dimensions are ignored and filtered from the selection set.

**List of Prompts**
The following prompts are displayed.

*Select associative dimensions to convert*: Select the associative dimensions to be converted to dimensional constraints

**See also:**
- Apply Dimensional Constraints
DCDIAMETER

Constrains the diameter of a circle or an arc.

Access Methods

Button

**Toolbar:** Drafting tool set ➤ Parametric tool group ➤ Dimensional Constraints flyout ➤ Diameter

**Menu:** Parametric ➤ Dimensional Constraints ➤ Diameter

Summary

This command is equivalent to the Diameter option in DIMCONSTRAINT (page 289).

The following table outlines the valid constraint objects and points:

<table>
<thead>
<tr>
<th>Valid Objects or Points</th>
<th>Characteristics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Circle</td>
<td></td>
</tr>
<tr>
<td>Arc</td>
<td>Constrains the diameter of the circle or arc.</td>
</tr>
</tbody>
</table>

List of Prompts

The following prompts are displayed.

Select arc or circle: Select an arc or a circle to be constrained

Dimension Line Location

Determines where the dimension line is located on the constrained object.

See also:

Apply Dimensional Constraints
DCDISPLAY

Displays or hides the dynamic constraints associated with a selection set of objects.

Access Methods

Button

 Toolbar: Drafting tool set ➤ Parametric tool group ➤ Constraint Display flyout ➤ Show Dynamic Constraints

Menu: Parametric ➤ Dynamic Dimensions ➤ Select Objects

List of Prompts

The following prompts are displayed.

Select objects: Select objects to display or hide the dimensional constraints

Enter an option [Show (page 263)/Hide (page 263)] <Show>: Enter the appropriate value to show or hide dynamic constraints for the selection set of objects

Show
Displays the dynamic dimensional constraints for any selection set of objects.

Hide
Hides the dynamic dimensional constraints for any selection set of objects.

See also:

Control the Display of Dimensional Constraints

DCFORM

Specifies whether the dimensional constraint being created is dynamic or annotational.

Summary

This command is equivalent to the Form option in DIMCONSTRAINT (page 289).
Setting the value for this command defines the Constraint Form property of
the object.

List of Prompts

The following prompts are displayed.
Enter constraint form [Annotational (page 264)/Dynamic (page
264)] <Dynamic>: Select a constraint form

Annotational
Applies annotational dimensional constraints to objects.

Dynamic
Applies dynamic dimensional constraints to objects.

See also:
Apply Dimensional Constraints

DCHORIZONTAL

Constrains the X distance between points on an object, or between two points
on different objects.

Access Methods

Button

 Toolbar: Drafting tool set ➤ Parametric tool group ➤ Dimensional
Contraints flyout ➤ Horizontal

 Menu: Parametric ➤ Dimensional Constraints ➤ Horizontal

Summary

This command is equivalent to the Horizontal option in DIMCONSTRAINT
(page 289).
The following table outlines the valid constraint objects and points:

<table>
<thead>
<tr>
<th>Valid Objects or Points</th>
<th>Characteristics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>When a line or an arc is selected, the horizontal distance between the endpoints of the object is constrained.</td>
</tr>
<tr>
<td>Polyline segment</td>
<td></td>
</tr>
<tr>
<td>Arc</td>
<td></td>
</tr>
<tr>
<td>Two constraint points on objects</td>
<td></td>
</tr>
</tbody>
</table>

**List of Prompts**

The following prompts are displayed.
Specify first constraint point (page 265) or [Object (page 265)] <Object>: *Pick a constraint point or select an object*

**Constraint Point**
Specifies a constraint point for the object.

**First Constraint Point**
Specifies the first point of the object to be constrained.

**Second Constraint Point**
Specifies the second point of the object to be constrained.

**Dimension Line Location**
Determines where the dimension line is located on the constrained object.

**Object**
Selects an object instead of a constraint point.

**See also:**

Apply Dimensional Constraints

**DCLINEAR**

Creates a horizontal, vertical, or rotated constraint based on the locations of the extension line origins and the dimension line.

**Access Methods**

- Button

D Commands | 265
Summary

This command is equivalent to the Linear option in DIMCONSTRAINT (page 289).

The following table outlines the valid constraint objects and points:

<table>
<thead>
<tr>
<th>Valid Objects or Points</th>
<th>Characteristics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>• When a line or an arc is selected, the horizontal or vertical distance between the endpoints of the object is constrained.</td>
</tr>
<tr>
<td>Polyline segment</td>
<td></td>
</tr>
<tr>
<td>Arc</td>
<td></td>
</tr>
<tr>
<td>Two constraint points on objects</td>
<td></td>
</tr>
</tbody>
</table>

List of Prompts

The following prompts are displayed.

Specify first constraint point (page 266) or [Object (page 266)] <Object>: Pick a constraint point or select an object

Constraint Point

Specifies a constraint point for the object.

First Constraint Point Specifies the first point of the object to be constrained.

Second Constraint Point Specifies the second point of the object to be constrained.

Dimension Line Location Determines where the dimension line is located on the constrained object.

Object

Selects an object instead of a constraint point.

See also:

Apply Dimensional Constraints
DCRADIUS

Constrains the radius of a circle or an arc.

Access Methods

Button

Toolbar: Drafting tool set ➤ Parametric tool group ➤ Dimensional Constraints flyout ➤ Radius

Menu: Parametric ➤ Dimensional Constraints ➤ Radius

Summary

This command is equivalent to the Radius option in DIMCONSTRAINT (page 289).

The following table outlines the valid constraint objects and points:

<table>
<thead>
<tr>
<th>Valid Objects or Points</th>
<th>Characteristics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Circle</td>
<td>□ Constrains the radius of the circle or arc.</td>
</tr>
<tr>
<td>Arc</td>
<td></td>
</tr>
</tbody>
</table>

List of Prompts

The following prompts are displayed.
Select arc or circle: Select an arc or a circle to be constrained

Dimension Line Location

Determines where the dimension line is located on the constrained object.

See also:

Apply Dimensional Constraints
DCVERTICAL

Constrains the Y distance between points on an object, or between two points on different objects.

Access Methods

Button

Toolbar: Drafting tool set ➤ Parametric tool group ➤ Dimensional Constraints flyout ➤ Vertical

Menu: Parametric ➤ Dimensional Constraints ➤ Vertical

Summary

This command is equivalent to the Vertical option in DIMCONSTRAINT (page 289).

The following table outlines the valid constraint objects and points:

<table>
<thead>
<tr>
<th>Valid Objects or Points</th>
<th>Characteristics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td></td>
</tr>
<tr>
<td>Polyline segment</td>
<td></td>
</tr>
<tr>
<td>Arc</td>
<td></td>
</tr>
<tr>
<td>Two constraint points on objects</td>
<td>When a line or an arc is selected, the vertical distance between the endpoints of the object is constrained.</td>
</tr>
</tbody>
</table>

List of Prompts

The following prompts are displayed.

Specify first constraint point (page 268) or [Object (page 269)] <Object>: Pick a constraint point or select an object

Constraint Point

Specifies a constraint point for the object.

First Constraint Point Specifies the first point of the object to be constrained.

Second Constraint Point Specifies the second point of the object to be constrained.
**Dimension Line Location** Determines where the dimension line is located on the constrained object.

**Object**
Selects an object instead of a constraint point.

**See also:**
Apply Dimensional Constraints

## DD EDIT

Edits single-line text, dimension text, attribute definitions, and feature control frames.

### Access Methods

- **Menu:** Modify ➤ Object ➤ Text ➤ Edit
- **Shortcut menu:** Select a text object, right-click in the drawing area, and click Edit.
- **Pointing device:** Double-click a text object.

### List of Prompts

The following prompts are displayed.

**Select an annotation object or [Undo]:**

**Object Selection** Displays the appropriate editing method for the type of text you select:
- Text created using TEXT (page 1078) displays the In-Place Text Editor (page 678) without the Text Formatting toolbar and the ruler.
- Text created using MTEXT (page 677) displays the In-Place Text Editor (page 678).
- Attribute definitions (not part of a block definition) display the Edit Attribute Definition dialog box (page 270).
- Feature control frames display the Geometric Tolerance dialog box (page 1092).

DDEDIT repeats the prompt until you press Enter to end the command.

**Undo** Returns the text or attribute definition to its previous value. You can use this option immediately after editing.
See also:
Change Text

Edit Attribute Definition Dialog Box

Edits an attribute text object.

![Edit Attribute Definition Dialog Box](image)

**List of Options**

The following options are displayed.

**Tag**
Specifies the attribute tag, which identifies the attribute in the drawing. The tag can contain exclamation marks (!). The case change is not immediately displayed in the tag field.

**Prompt**
Specifies the attribute prompt that is displayed when you insert a block containing this attribute definition.

**Default**
Specifies the default attribute value.
To use a field as the value, right-click and click Insert Field on the shortcut menu to display the Insert Field dialog box (page 432).

See also:
Change Text
DDPTYPE

Specifies the display style and size of point objects.

Access Methods

Button

Toolbar: Drafting tool set ➤ Open Shapes tool group (expanded) ➤ Point Style

Menu: Format ➤ Point Style

Command entry: 'ddptype for transparent use

Summary

The Point Style dialog box (page 271) is displayed.

See also:

Draw Reference Points

Point Style Dialog Box

Shows the current point style and size. Change the point style by selecting an icon.
List of Options

The following options are displayed.

**Point Size**
Sets the point display size. The value you enter can be relative to the screen or in absolute units. The point display size is stored in the `PDSIZE` (page 1429) system variable. Subsequent point objects that you draw use the new value.

- **Set Size Relative to Screen** Sets the point display size as a percentage of the screen size. The point display does not change when you zoom in or out.

- **Set Size in Absolute Units** Sets the point display size as the actual units you specify under Point Size. Points are displayed larger or smaller when you zoom in or out.

**Point Style**
Specifies the image used to display point objects. The point style is stored in the `PDMODE` (page 1429) system variable.

See also:
- Draw Reference Points
DELAY

Provides a timed pause within a script.

Access Methods

Command entry: 'delay for transparent use

Summary

Specifies the duration of a pause. Entering delay 1000 in your script delays the start of execution of the next command for about one second. The longest delay available is 32767, which is slightly less than 33 seconds.

See also:

Overview of Command Scripts

DELCONSTRAINT

Removes all geometric and dimensional constraints from a selection set of objects.

Access Methods

Button

Toolbar: Drafting tool set ➤ Parametric tool group (expanded) ➤ Delete

Menu: Parametric ➤ Delete Constraints

Summary

The number of constraints removed are displayed on the command line.
Removes all geometric and dimensional constraints from the selected objects.

See also:

Modify Objects with Dimensional Constraints Applied
**DIM and DIM1**

Accesses Dimensioning mode commands.

**Summary**

The Dim prompt indicates that you're in Dimensioning mode, in which you can use a special set of dimensioning commands (page 274). (DIM and DIM1 are provided only for compatibility with previous releases.)

Use DIM to remain in Dimensioning mode after you have used a dimensioning command. Use DIM1 to execute a dimensioning command and immediately return to the Command prompt. To exit Dimensioning mode, enter `e` or `exit`, or press Esc.

**List of Prompts**

The following prompts are displayed.

**Dim:** *Enter a Dimensioning mode command*

**Dimensioning Mode Commands**

The following commands are available at the DIM prompt.

<table>
<thead>
<tr>
<th>Dimensioning mode commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command</td>
</tr>
<tr>
<td>---------------</td>
</tr>
<tr>
<td>EXIT</td>
</tr>
<tr>
<td>REDRAW</td>
</tr>
<tr>
<td>STYLE</td>
</tr>
<tr>
<td>UNDO or U</td>
</tr>
</tbody>
</table>
The following table shows which AutoCAD commands are equivalent to the rest of the Dimensioning mode commands. For information about these Dimensioning mode commands, see the equivalent AutoCAD command.

<table>
<thead>
<tr>
<th>Dimensioning mode command</th>
<th>Equivalent command</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALIGNED</td>
<td>DIMALIGNED (page 276)</td>
</tr>
<tr>
<td>ANGULAR</td>
<td>DIMANGULAR (page 279)</td>
</tr>
<tr>
<td>BASELINE</td>
<td>DIMBASELINE (page 284)</td>
</tr>
<tr>
<td>CENTER</td>
<td>DIMCENTER (page 288)</td>
</tr>
<tr>
<td>CONTINUE</td>
<td>DIMCONTINUE (page 291)</td>
</tr>
<tr>
<td>DIAMETER</td>
<td>DIMDIAMETER (page 293)</td>
</tr>
<tr>
<td>HOMETEXT</td>
<td>DIMEDIT (page 295) Home</td>
</tr>
<tr>
<td>HORIZONTAL</td>
<td>DIMLINEAR (page 304) Horizontal</td>
</tr>
<tr>
<td>LEADER</td>
<td>LEADER (page 570)</td>
</tr>
<tr>
<td>JOG</td>
<td>DIMJOGGED (page 301)</td>
</tr>
<tr>
<td>NEWTEXT</td>
<td>DIMEDIT (page 295) New</td>
</tr>
<tr>
<td>OBLIQUE</td>
<td>DIMEDIT (page 295) Oblique</td>
</tr>
<tr>
<td>ORDINATE</td>
<td>DIMORDINATE (page 308)</td>
</tr>
<tr>
<td>OVERRIDE</td>
<td>DIMOVERRIDE (page 310)</td>
</tr>
<tr>
<td>RADIUS</td>
<td>DIMRADIUS (page 311)</td>
</tr>
</tbody>
</table>
## Dimensioning mode command equivalents

<table>
<thead>
<tr>
<th>Dimensioning mode command</th>
<th>Equivalent command</th>
</tr>
</thead>
<tbody>
<tr>
<td>RESTORE</td>
<td>-DIMSTYLE (page 319) Restore</td>
</tr>
<tr>
<td>ROTATED</td>
<td>DIMLINEAR (page 304) Rotated</td>
</tr>
<tr>
<td>SAVE</td>
<td>-DIMSTYLE (page 319) Save</td>
</tr>
<tr>
<td>STATUS</td>
<td>-DIMSTYLE (page 319) Status</td>
</tr>
<tr>
<td>TEDIT</td>
<td>DIMTEDIT (page 355)</td>
</tr>
<tr>
<td>TROTATE</td>
<td>DIMEDIT (page 295) Rotate</td>
</tr>
<tr>
<td>UPDATE</td>
<td>-DIMSTYLE (page 319) Apply</td>
</tr>
<tr>
<td>VARIABLES</td>
<td>-DIMSTYLE (page 319) Variables</td>
</tr>
<tr>
<td>VERTICAL</td>
<td>DIMLINEAR (page 304) Vertical</td>
</tr>
</tbody>
</table>

See also:
Overview of Dimensioning

## DIMALIGNED

Creates an aligned linear dimension.

### Access Methods

Button

_toolbar: Annotation tool set ➤ Dimensions tool group ➤ Aligned
Menu: Dimension ▶ Aligned

Summary

Creates a linear dimension that is aligned with the origin points of the extension lines.

List of Prompts

The following prompts are displayed.

Specify first extension line origin (page 277) or <select object (page 277)>: Specify a point for manual extension lines, or press Enter for automatic extension lines

After you specify either manual or automatic extension lines, the following prompt is displayed:

Specify dimension line location (page 278) or [Mtext (page 278)/Text (page 278)/Angle (page 278)]: Specify a point or enter an option

Extension Line Origin Specifies the first extension line origin (1). You are prompted to specify the second one.

Object Selection Automatically determines the origin points of the first and second extension lines after you select an object.

For polylines and other explodable objects, only the individual line and arc segments are dimensioned. You cannot select objects in a nonuniformly scaled block reference.

If you select a line or an arc, its endpoints are used as the origins of the extension lines. The extension lines are offset from the endpoints by the distance specified in Offset from Origin on the Lines and Arrows tab of the New, Modify, and Override Dimension Style dialog boxes (see DIMSTYLE (page 319)). This value is stored in the DIMEXO (page 1269) system variable.
If you select a circle, the endpoints of its diameter are used as the origins of the extension line. The point used to select the circle defines the origin of the first extension line.

**Dimension Line Location** Specifies the placement of the dimension line and determines the direction to draw the extension lines. After you specify the location, the DIMALIGNED command ends.

**Mtext** Displays the In-Place Text Editor (page 678), which you can use to edit the dimension text. The generated measurement is represented with angle brackets (< >). To add a prefix or a suffix to the generated measurement, enter the prefix or suffix before or after the angle brackets. Use control codes and Unicode character strings to enter special characters or symbols. See Control Codes and Special Characters (page 1083).

To edit or replace the generated measurement, delete the angle brackets, enter the new dimension text, and then click OK. If alternate units are not turned on in the dimension style, you can display them by entering square brackets ([ ]). For more information, see Select and Modify Objects.

The current dimension style determines the appearance of the generated measurements.

**Text** Customizes the dimension text at the command prompt. The generated dimension measurement is displayed within angle brackets.

Enter the dimension text, or press Enter to accept the generated measurement.

To include the generated measurement, use angle brackets (< >) to represent the generated measurement. If alternate units are not turned on in the dimension style, you can display alternate units by entering square brackets ([ ]). Dimension text properties are set on the Text tab of the New, Modify, and Override Dimension Style dialog boxes.

**Angle** Changes the angle of the dimension text.
See also:
Create Aligned Dimensions

**DIMANGULAR**

Creates an angular dimension.

**Access Methods**

- **Button**

  - *Toolbar*: Annotation tool set ➤ Dimensions tool group ➤ Dimensions flyout ➤ Angular
  - *Menu*: Dimension ➤ Angular
Summary

Measures the angle between selected objects or 3 points. Objects that can be selected include arcs, circles, and lines, among others.

List of Prompts

The following prompts are displayed.
Select arc (page 280), circle (page 280), line (page 281), or <specify vertex (page 281)>: Select an arc, circle, or line, or press Enter to create the angular dimension by specifying three points

After you define the angle to dimension, the following prompt is displayed:
Specify dimension arc line location (page 281) or [Mtext (page 281)/Text (page 282)/Angle (page 282)/Quadrant (page 282)]:

Arc Selection
Uses points on the selected arc as the defining points for a three-point angular dimension. The center of the arc is the angle vertex. The arc endpoints become the origin points of the extension lines.

The dimension line is drawn as an arc between the extension lines. The extension lines are drawn from the angle endpoints to the intersection of the dimension line.

Circle Selection
Uses the selection point (1) as the origin of the first extension line. The center of the circle is the angle vertex.
The second angle endpoint is the origin of the second extension line and does not have to lie on the circle.

**Line Selection** Defines the angle using two lines.
The program determines the angle by using each line as a vector for the angle and the intersection of the lines for the angle vertex. The dimension line spans the angle between the two lines. If the dimension line does not intersect the lines being dimensioned, extension lines are added as needed to extend one or both lines. The arc is always less than 180 degrees.

**Three-Point Specification** Creates a dimension based on three points you specify.
The angle vertex can be the same as one of the angle endpoints. If you need extension lines, the endpoints are used as origin points.

The dimension line is drawn as an arc between the extension lines. The extension lines are drawn from the angle endpoints to the intersection of the dimension line.

**Dimension Arc Line Location** Specifies the placement of the dimension line and determines the direction to draw the extension lines.

**Mtext** Displays the In-Place Text Editor, which you can use to edit the dimension text. To add a prefix or a suffix, enter the prefix or suffix text before or after the generated measurement. Use control codes and Unicode character
strings to enter special characters or symbols. See Control Codes and Special Characters (page 1083).

For more information, see Select and Modify Objects.

The current dimension style determines the appearance of the generated measurements.

**Text** Customizes the dimension text at the Command prompt. The generated dimension measurement is displayed within angle brackets.

To include the generated measurement, use angle brackets (< >) to represent the generated measurement.

Dimension text properties are set on the Text tab of the New, Modify, and Override Dimension Style dialog boxes.

**Angle** Changes the angle of the dimension text.

**Quadrant** Specifies the quadrant that the dimension should be locked to. When quadrant behavior is on, the dimension line is extended past the extension line when the dimension text is positioned outside of the angular dimension.

**See also:**

Create Angular Dimensions
DIMARC

Creates an arc length dimension.

**Access Methods**

 Button

 Toolbar: Annotation tool set ➤ Dimensions tool group ➤ Dimensions flyout ➤ Arc Length

 Menu: Dimension ➤ Arc Length

**List of Prompts**

The following prompts are displayed.

Select arc or polyline arc segment: *Use an object selection method*
Specify **arc length dimension location** (page 283) or [Mtext (page 283)/Text (page 284)/Angle (page 284)/Partial (page 284)/Leader (page 284)]: Specify a point or enter an option

Arc length dimensions measure the distance along an arc or polyline arc segment. The extension lines of an arc length dimension can be orthogonal or radial. An arc symbol is displayed either above or preceding the dimension text.

**Arc Length Dimension Location** Specifies the placement of the dimension line and determines the direction of the extension lines.

**Mtext** Displays the In-Place Text Editor, which you can use to edit the dimension text. Use control codes and Unicode character strings to enter special characters or symbols. See *Control Codes and Special Characters* (page 1083).
If alternate units are not turned on in the dimension style, you can display them by entering square brackets ([ ]). For more information, see Select and Modify Objects.

The current dimension style determines the appearance of the generated measurements.

**Text** Customizes the dimension text at the Command prompt. The generated dimension measurement is displayed within angle brackets. To include the generated measurement, use angle brackets (< >) to represent the generated measurement. If alternate units are not turned on in the dimension style, you can display alternate units by entering square brackets ([ ]).

Dimension text properties are set on the Text tab of the New, Modify, and Override Dimension Style dialog boxes.

**Angle** Changes the angle of the dimension text.

**Partial** Reduces the length of the arc length dimension.

**Leader** Adds a leader object. This option is displayed only if the arc (or arc segment) is greater than 90 degrees. The leader is drawn radially, pointing towards the center of the arc being dimensioned.

**No Leader** Cancels the Leader option before the leader is created.

To remove a leader, delete the arc length dimension and recreate it without the leader option.

**See also:**

Create Arc Length Dimensions

### DIMBASELINE

Creates a linear, angular, or ordinate dimension from the baseline of the previous or selected dimension.

**Access Methods**

| Button |
**Toolbar:** Annotation tool set ➤ Dimensions tool group ➤ Continue flyout ➤ Baseline

**Menu:** Dimension ➤ Baseline

**Summary**

The default spacing between baseline dimensions can be set from the Dimension Style Manager, Lines tab, Baseline Spacing (DIMDLI (page 1268) system variable).

If no dimension was created in the current session, you are prompted to select a linear, ordinate, or angular dimension to use as the base for the baseline dimension.

**List of Prompts**

The following prompts are displayed.

Select base dimension:  Select a linear, ordinate, or angular dimension

Otherwise, the program skips this prompt and uses the dimension object that was last created in the current session. If the base dimension is linear or angular, the following prompt is displayed:

Specify a second extension line origin (page 285) or [Undo (page 286)/Select (page 286)] <Select>:  Specify a point, enter an option, or press Enter to select a base dimension

If the base dimension is ordinate, the following prompt is displayed:

Specify feature location (page 286) or [Undo/Select] <Select>:

To end the command, press Enter twice, or press Esc. The current dimension style determines the appearance of the text.

**Second Extension Line Origin** By default, the first extension line of the base dimension is used as the extension line origin for the baseline dimension. To override this default behavior, explicitly select the base dimension; the
extension line origin becomes the extension line of the base dimension closest to the pick point of the selection. When you select a second point, the baseline dimension is drawn and the Specify a Second Extension Line Origin prompt is redisplayed. To end the command, press Esc. To select another linear, ordinate, or angular dimension to use as the basis for the baseline dimension, press Enter.

Feature Location Uses the endpoint of the base dimension as the endpoint for the baseline dimension; you are prompted for the next feature location. When you select a feature location, the baseline dimension is drawn and the Specify Feature Location prompt is redisplayed. To select another linear, ordinate, or angular dimension to use as the basis for the baseline dimension, press Enter.

Undo Undoes the last baseline dimension entered during this command session.

Select Prompts you to select a linear, ordinate, or angular dimension to use as the base for the baseline dimension.

See also:

Create Baseline and Continued Dimensions

**DIMBREAK**

Breaks or restores dimension and extension lines where they cross other objects.

**Access Methods**

Button
Toolbar: Annotation tool set ➤ Dimensions tool group ➤ Break Dimension

Menu: Dimension ➤ Dimension Break

Summary

Dimension breaks can be added to linear, angular, and ordinate dimensions, among others.

List of Prompts

The following prompts are displayed.
Select a dimension to add/remove break or [Multiple (page 287)]: Select a dimension, or enter m and press Enter

After you select a dimension, the following prompt is displayed:
Select object to break dimension or [Auto (page 287)/Manual (page 288)/Remove (page 287)] <Auto>: Select an object that intersects the dimension or extension lines of the selected dimension, enter an option, or press Enter

After you select an object to break the dimension with, the following prompt is displayed:
Select object to break dimension: Select an object that passes through the dimension or press Enter to end the command

NOTE Dimension breaks can be added to dimensions for objects that do not intersect the dimension or extension lines using the by Manual option.

Multiple Specifies multiple dimensions to add breaks to or remove breaks from.

Auto Places dimension breaks automatically at all the intersection points of the objects that intersect the selected dimension. Any dimension break created using this option is updated automatically when the dimension or an intersecting object is modified.

When a new object is drawn over the top of a dimension that has any dimension breaks, no new dimension breaks are automatically applied at the intersecting points along the dimension object. To add the new dimension breaks, must be run the command again.

Remove Removes all dimension breaks from the selected dimensions.
Manual Places a dimension break manually. You specify two points on the dimension or extension lines for the location of the break. Any dimension break that is created using this option is not updated if the dimension or intersecting objects are modified. You can only place a single manual dimension break at a time with this option.

See also:
Break a Dimension Line

**DIMCENTER**

Creates the center mark or the centerlines of circles and arcs.

**Access Methods**

- **Button**

  Toolbar: Annotation tool set ➤ Dimensions tool group ➤ Center Mark

  Menu: Dimension ➤ Center Mark

**Summary**

The default sizes of the center mark components can be set from the Dimension Style Manager, Symbols and Arrows tab, Center Marks (DIMCEN system variable).

You can choose between center marks and centerlines and specify their size when you set up the dimension style. See DIMSTYLE (page 319). You can also change center mark settings using the DIMCEN (page 1265) system variable.
DIMCONSTRAINT

Applies dimensional constraints to selected objects or points on objects, or converts associative dimensions to dimensional constraints.

Access Methods

Toolbar: Drafting tool set ➤ Parametric tool group
Menu: Parametric ➤ Dimensional Constraints ➤ Aligned

Summary

Applies a dimensional constraint to a selected object or converts an associative dimension to a dimensional constraint.

**NOTE** The L option (last object drawn) is not allowed in the DIMCONSTRAINT command as the constraint behavior is dependent on where you pick the object.

The following table outlines the valid constraint points for an object.

<table>
<thead>
<tr>
<th>Objects</th>
<th>Valid Constraint Points</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>Endpoints, Midpoint</td>
</tr>
<tr>
<td>Arc</td>
<td>Center, Endpoints, Midpoint</td>
</tr>
<tr>
<td>Spline</td>
<td>Endpoints</td>
</tr>
<tr>
<td>Ellipse, Circle</td>
<td>Center</td>
</tr>
</tbody>
</table>
Valid Constraint Points

<table>
<thead>
<tr>
<th>Objects</th>
<th>Valid Constraint Points</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polyline</td>
<td>Endpoints, midpoints of line and arc subobjects, center of arc subobjects</td>
</tr>
<tr>
<td>Block, Xref, Text, Mtext, Attribute, Table</td>
<td>Insertion point</td>
</tr>
</tbody>
</table>

After you specify the dimensional constraint type, you can either enter an expression value or accept the default (*constraintname=value*).

The `DIMCONSTRAINT` command gives the same options as the following commands:

**Linear** (*DCLINEAR* (page 265))

Creates a horizontal, vertical, or rotated constraint based on the locations of the extension line origins and the dimension line.

**Horizontal** (*DCHORIZONTAL* (page 264))

Constrains the X distance between points on an object, or between two points on different objects.

**Vertical** (*DCVERTICAL* (page 268))

Constrains the Y distance between points on an object, or between two points on different objects.

**Aligned** (*DCALIGNED* (page 257))

Constrains the distance between two points on different objects.

**Angular** (*DCANGULAR* (page 259))

Constrains the angle between line or polyline segments, the angle swept out by an arc or a polyline arc segment, or the angle between three points on objects.

**Radius** (*DCRADIUS* (page 267))

Constrains the radius of a circle or an arc.

**Diameter** (*DCDIAMETER* (page 262))

Constrains the diameter of a circle or an arc.

**Form** (*DCFORM* (page 263))

Specifies whether the dimensional constraint being created is dynamic or annotational.

**Convert** (*DCCONVERT* (page 261))

Converts associative dimensions to dimensional constraints.
DIMCONTINUE

Creates a dimension that starts from an extension line of a previously created dimension.

Access Methods

Button

Toolbar: Annotation tool set ➤ Dimensions tool group ➤ Continue flyout ➤ Continue

Menu: Dimension ➤ Continue

Summary

Automatically continues creating additional dimensions from the last linear, angular, or ordinate dimension created, or from a selected extension line. The dimension lines are lined up automatically.

If no dimension was created in the current session, you are prompted to select a linear, ordinate, or angular dimension to use as the base for the continued dimension.

List of Prompts

The following prompts are displayed.
Select continued dimension: *Select a linear, ordinate, or angular dimension*

Otherwise, the program skips this prompt and uses the dimension object that was last created in the current session. If the base dimension is linear or angular, the following prompt is displayed:

Specify a second extension line origin (page 292) or [Undo (page 293)/Select (page 293)] <Select>: *Specify a point, enter an option, or press Enter to select a base dimension*

If the base dimension is ordinate, the following prompt is displayed:

Specify feature location (page 292) or [Undo/Select] <Select>:

To end the command, press Enter twice, or press Esc. The current dimension style determines the appearance of the text.

**Second Extension Line Origin** Uses the second extension line origin of the continued dimension for the first extension line origin of the next dimension. The current dimension style determines the appearance of the text.

After you select a continued dimension, the Specify a Second Extension Line Origin prompt is redisplayed. To end the command, press Esc. To select another linear, ordinate, or angular dimension to use as the basis for the continued dimension, press Enter.

Select continued dimension: *Select a linear, ordinate, or angular dimension*

Select a base dimension, or press Esc to end the command.

**Feature Location** Uses the endpoint of the base dimension as the endpoint for the continued dimension; you are prompted for the next feature location. When you select a feature location, the continued dimension is drawn and the Specify Feature Location prompt is redisplayed. To end the command,
press Esc. To select another linear, ordinate, or angular dimension to use as the basis for the continued dimension, press Enter.
Select continued dimension: Select a linear, ordinate, or angular dimension
Select a base dimension, or press Esc to end the command.

Undo Undoes the last continued dimension entered during the command session.

Select Prompts you to select a linear, ordinate, or angular dimension to use as the continued dimension. After you select a continued dimension, the Specify a Second Extension Line Origin prompt or the Specify Feature Location prompt is redisplayed. To end the command, press Esc.

See also:
Create Baseline and Continued Dimensions

**DIMDIAMETER**

Creates a diameter dimension for a circle or an arc.

**Access Methods**

- **Button**
- **Toolbar:** Annotation tool set ➤ Dimensions tool group ➤ Dimension flyout ➤ Diameter
- **Menu:** Dimension ➤ Diameter

**Summary**

Measures the diameter of a selected circle or arc, and displays the dimension text with a diameter symbol in front of it. You can use grips to easily reposition the resulting diameter dimension.
List of Prompts

The following prompts are displayed.
Select arc or circle:
Specify dimension line location (page 294) or [Mtext (page 294)/Text (page 294)/Angle (page 294)]: Specify a point or enter an option

Dimension Line Location Determines the angle of the dimension line and the location of the dimension text. If the dimension is placed off of an arc resulting in the dimension pointing outside the arc, AutoCAD automatically draws an arc extension line.

Mtext Displays the In-Place Text Editor, which you can use to edit the dimension text. Use control codes and Unicode character strings to enter special characters or symbols. See Control Codes and Special Characters (page 1083).

If alternate units are not turned on in the dimension style, you can display them by entering square brackets ([]). For more information, see Select and Modify Objects.

The current dimension style determines the appearance of the dimension text.

Text Customizes the dimension text at the Command prompt. The generated dimension measurement is displayed within angle brackets.

To include the generated measurement, use angle brackets (<>) to represent the generated measurement. If alternate units are not turned on in the dimension style, you can display alternate units by entering square brackets ([ ]).

Dimension text properties are set on the Text tab of the New, Modify, and Override Dimension Style dialog boxes.

Angle Changes the angle of the dimension text.
See also:

Create Radial Dimensions

**DIMDISASSOCIATE**

Removes associativity from selected dimensions.

**Summary**

DIMDISASSOCIATE filters the selection set to include only associative dimensions that are not on locked layers, and that are not in a different space than the current space (for example, if model space is active, associative dimensions in paper space are excluded). DIMDISASSOCIATE then disassociates these dimensions and reports the number of dimensions that are filtered out and the number that are disassociated.

See also:

Change Dimension Associativity

**DIMEDIT**

Edits dimension text and extension lines.

**Access Methods**

- **Button**
- **Toolbar:** Annotation tool set ➤ Dimensions tool group (expanded) ➤ Oblique
- **Menu:** Dimension ➤ Oblique

**Summary**

Rotates, modifies, or restores dimension text. Changes the oblique angle of extension lines. The companion command that moves text and the dimension line is **DIMTEDIT** (page 355).
List of Prompts

The following prompts are displayed.

Enter type of dimension editing [Home (page 296)/New (page 296)/Rotate (page 296)/Oblique (page 297)] <Home>: Enter an option or press Enter

Home Moves rotated dimension text back to its default position.

![Before Home](image1.png) ![After Home](image2.png)

The selected dimension text is returned to its default position and rotation as specified in its dimension style.

New Changes dimension text using the In-Place Text Editor (page 678).

![Before New](image3.png) ![After New](image4.png)

The generated measurement is represented with angle brackets (<>). Use control codes and Unicode character strings to enter special characters or symbols. See Control Codes and Special Characters (page 1083).

To edit or replace the generated measurement, delete the angle brackets, enter the new dimension text, and then choose OK. If alternate units are not turned on in the dimension style, you can display them by entering square brackets ([ ]). For more information, see Select and Modify Objects.

Rotate Rotates dimension text. This option is similar to the Angle option of DIMTEDIT (page 355).

Entering 0 places the text in its default orientation, which is determined by the vertical and horizontal text settings on the Text tab of the New, Modify, and Override Dimension Style dialog boxes. See DIMSTYLE (page 319). The DIMTIP (page 1283) and DIMTOH (page 1286) system variables control this orientation.
Oblique
The Oblique option is useful when extension lines conflict with other features of the drawing. The oblique angle is measured from the X axis of the UCS.

See also:
Modify Dimension Text

DIMINSPECT

Adds or removes inspection information for a selected dimension.

Access Methods

Button

Toolbar: Annotation tool set ➤ Dimensions tool group ➤ Inspect Dimension
Menu: Dimension ➤ Inspection
Summary

Inspection dimensions specify how frequently manufactured parts should be checked to ensure that the dimension value and tolerances of the parts are within the specified range.

The Inspection Dimension dialog box (page 298) is displayed and allows you to add or remove inspection dimensions from an existing dimension. Inspection dimensions allow you to effectively communicate how frequently manufactured parts should be checked to ensure that the dimension value and tolerances of the parts are within the specified range.

If you enter `-diminspect` at the Command prompt, options are displayed (page 300).

See also:

Convert Dimensions into Inspection Dimensions

Inspection Dimension Dialog Box

Allows you to add or remove an inspection dimension from selected dimensions.
Summary

Use the Shape and Inspection Label/Rate settings to the appearance of the frame of the inspection dimension and the inspection rate value.

List of Options

The following options are displayed.

Select Dimensions

Specifies the dimensions that an inspection dimension should be added to or removed from.

Remove Inspection

Removes the inspection dimension from the selected dimension.

Shape

Controls the shape of the frame that is drawn around the label, dimension value, and inspection rate of the inspection dimension.

Round

Creates a frame with semi-circles on the two ends; the fields within the frame are separated by vertical lines.

Angular

Creates a frame with lines that form a 90-degree angle on the two ends; the fields within the frame are separated by vertical lines.

None
Specifies that no frame is drawn around the values; the fields are not separated by vertical lines.

**Label/Inspection Rate**

Specifies the label text and inspection rate for an inspection dimension.

**Label**

Turns the display of the label field on and off.

**Label Value**

Specifies the label text. The label is displayed in the leftmost section of the inspection dimension when the Label check box is selected.

**Inspection Rate**

Turns the display of the rate field on and off.

**Inspection Rate Value**

Specifies how frequently a part should be inspected. The value is expressed as a percentage, and the valid range is 0 to 100. The inspection rate is displayed in the rightmost section of the inspection dimension when the Inspection Rate check box is selected.

**See also:**

Convert Dimensions into Inspection Dimensions

-DIMINSPECT

**List of Prompts**

The following prompts are displayed.

*Add inspection data (page 300) or [Remove (page 301)] <Add>: Enter an option or press Enter*

**Add**

Adds an inspection dimension to the selected dimensions.

**Round** Creates a frame with semi-circles on the two ends; the fields within the frame are separated by vertical lines.

**Angular** Creates a frame with lines that form a 90-degree angle on the two ends; the fields within the frame are separated by vertical lines.
None Specifies that no frame is drawn around the values; the fields are not separated by vertical lines.

None No label is displayed with the inspection dimension.

**Remove**
Removes the inspection dimension from the selected dimensions.

**See also:**
- Convert Dimensions into Inspection Dimensions

**DIMJOGGED**

Creates jogged dimensions for circles and arcs.

**Access Methods**

- **Button**
  - Toolbar: Annotation tool set ➤ Dimensions tool group ➤ Dimension flyout ➤ Jogged
  - Menu: Dimension ➤ Jogged

**Summary**

DIMJOGGED measures the radius of the selected object and displays the dimension text with a radius symbol in front of it. The origin point of the dimension line can be specified at any convenient location.

---

**NOTE** Jogged radius dimensions are also called foreshortened radius dimensions.

Creates jogged radius dimensions when the center of an arc or circle is located off the layout and cannot be displayed in its true location. The origin point of the dimension can be specified at a more convenient location called the center location override.
List of Prompts

The following prompts are displayed.

Select arc or circle: Select an arc, circle, or polyline arc segment
Specify center location override: Specify a point

Accepts a new center point for a jogged radius dimension that takes the place of the true center point of the arc or circle.

Specify dimension line location (page 302) or [Mtext (page 302)/Text (page 302)/Angle (page 303)]: Specify a point or enter an option

Dimension Line Location Determines the angle of the dimension line and the location of the dimension text. If the dimension is placed off of an arc resulting in the dimension pointing outside the arc, AutoCAD automatically draws an arc extension line.

Mtext Displays the In-Place Text Editor, which you can use to edit the dimension text. Use control codes and Unicode character strings to enter special characters or symbols. See Control Codes and Special Characters (page 1083).

If alternate units are not turned on in the dimension style, you can display them by entering square brackets ([ ]). For more information, see Select and Modify Objects.

The current dimension style determines the appearance of the generated measurements.

Text Customizes the dimension text at the Command prompt. The generated dimension measurement is displayed within angle brackets.

To include the generated measurement, use angle brackets (< >) to represent the generated measurement. If alternate units are not turned on in the dimension style, you can display alternate units by entering square brackets ([ ]).
Dimension text properties are set on the Text tab of the New, Modify, and Override Dimension Style dialog boxes.

**Angle** Changes the angle of the dimension text. Also determines the angle of the dimension line and the location of the dimension text.

**Specify Jog Location** Locates the middle point of the jog. The transverse angle of the jog is determined by the Dimension Style Manager.

**See also:**
Create Radial Dimensions

**DIMJOGLINE**

Adds or removes a jog line on a linear or aligned dimension.

**Access Methods**

Button

- **Toolbar:** Annotation tool set ➤ Dimensions tool group ➤ Jog Line
- **Menu:** Dimension ➤ Jogged Linear

**Summary**

Jog lines in a dimension indicate a break in the objects being dimensioned. The dimension value represents the actual distance, rather than the measured distance in the drawing.
List of Prompts

The following prompts are displayed.
Select dimension to add jog (page 304) or [Remove (page 304)]:
Select a linear or aligned dimension

Add Jog Specifies the linear or aligned dimension to which to add a jog. You are prompted for the location of the jog.
Press Enter to place the jog at the midpoint between the dimension text and the first extension line or the midpoint of the dimension line based on the location of the dimension text

Remove Specifies the linear or aligned dimension from which to remove the jog.

See also:
Dimension Jog

DIMLINEAR

Creates a linear dimension.

Access Methods

Button

Toolbar: Annotation tool set ➤ Dimensions tool group ➤ Dimension flyout ➤ Linear Dimension

Menu: Dimension ➤ Linear

Summary

Creates a linear dimension with a horizontal, vertical, or rotated dimension line. This command replaces the DIMHORIZONTAL and DIMVERTICAL commands.
List of Prompts

The following prompts are displayed.

Specify first extension line origin (page 305) or <select object (page 307)>: Specify a point or press Enter to select an object to dimension.

After you specify the extension line origin points or the object to dimension, the following prompt is displayed:

Specify dimension line location (page 305) or [Mtext (page 306)/Text (page 306)/Angle (page 306)/Horizontal (page 306)/Vertical (page 307)/Rotated (page 307)]: Specify a point or enter an option

First Extension Line Origin

Prompts for the origin point of the second extension line after you specify the origin point of the first.

Dimension Line Location

Uses the point you specify to locate the dimension line and determines the direction to draw the extension lines. After you specify the location, the dimension is drawn.
**Mtext**
Displays the In-Place Text Editor, which you can use to edit the dimension text. Use control codes and Unicode character strings to enter special characters or symbols. See Control Codes and Special Characters (page 1083).

If alternate units are not turned on in the dimension style, you can display them by entering square brackets ([ ]). For more information about formatting dimension text, see Select and Modify Objects.

The current dimension style determines the appearance of the generated measurements.

**Text**
Customizes the dimension text at the Command prompt. The generated dimension measurement is displayed within angle brackets.

To include the generated measurement, use angle brackets (< >) to represent the generated measurement. If alternate units are not turned on in the dimension style, you can display alternate units by entering square brackets ([ ]).

Dimension text properties are set on the Text tab of the New, Modify, and Override Dimension Style dialog boxes.

**Angle**
Changes the angle of the dimension text.

**Horizontal**
Creates horizontal linear dimensions.
Dimension Line Location Uses the point you specify to locate the dimension line.
- Mtext (page 306)
- Text (page 306)
- Angle (page 306)

**Vertical**
Creates vertical linear dimensions.

**Rotated**
Creates rotated linear dimensions.

**Object Selection**
Automatically determines the origin points of the first and second extension lines after you select an object.
For polylines and other explodable objects, only the individual line and arc segments are dimensioned. You cannot select objects in a non-uniformly scaled block reference.

If you select a line or an arc, the line or arc endpoints are used as the origins of the extension lines. The extension lines are offset from the endpoints by the distance you specify in Offset from Origin in the Lines and Arrows tab of the New, Modify, and Override Dimension Style dialog boxes. See DIMSTYLE (page 319). This value is stored in the DIMEXO (page 1269) system variable.

If you select a circle, the diameter endpoints are used as the origins of the extension line. When the point used to select the circle is close to the north or south quadrant point, a horizontal dimension is drawn. When the point used to select the circle is close to the east or west quadrant point, a vertical dimension is drawn.

See also:

Create Linear Dimensions

**DIMORDINATE**

Creates ordinate dimensions.

**Access Methods**

- **Button**
- **Toolbar**: Annotation tool set ➤ Dimensions tool group ➤ Dimension flyout ➤ Ordinate
- **Menu**: Dimension ➤ Ordinate
Summary

Ordinate dimensions measure the horizontal or vertical distance from an origin point called the datum to a feature, such as a hole in a part. These dimensions prevent escalating errors by maintaining accurate offsets of the features from the datum.

List of Prompts

The following prompts are displayed.

Specify feature location: Specify a point or snap to an object
Specify leader endpoint (page 309) or [Xdatum (page 309)/Ydatum (page 310)/Mtext (page 310)/Text (page 310)/Angle (page 310)]: Specify a point or enter an option

Leader Endpoint Specification Uses the difference between the feature location and the leader endpoint to determine whether it is an X or a Y ordinate dimension. If the difference in the Y ordinate is greater, the dimension measures the X ordinate. Otherwise, it measures the Y ordinate.

Xdatum Measures the X ordinate and determines the orientation of the leader line and dimension text. The Leader Endpoint prompt is displayed, where you can specify the endpoint.
**Ydatum** Measures the Y ordinate and determines the orientation of the leader line and dimension text. The Leader Endpoint prompts are displayed, where you can specify the endpoint.

**Mtext** Displays the In-Place Text Editor, which you can use to edit the dimension text. Use control codes and Unicode character strings to enter special characters or symbols. See [Control Codes and Special Characters](page 1083).

If alternate units are not turned on in the dimension style, you can display them by entering square brackets ([ ]). For more information about formatting dimension text, see Select and Modify Objects.

The current dimension style determines the appearance of the generated measurements.

**Text** Customizes the dimension text at the Command prompt. The generated dimension measurement is displayed within angle brackets.

To include the generated measurement, use angle brackets (< >) to represent the generated measurement. If alternate units are not turned on in the dimension style, you can display alternate units by entering square brackets ([ ]). Dimension text properties are set on the Text tab of the New, Modify, and Override Dimension Style dialog boxes.

**Angle** Changes the angle of the dimension text.

**See also:**

Create Ordinate Dimensions

**DIMOVERRIDE**

Controls overrides of system variables used in selected dimensions.
Access Methods

Button

Toolbar: Annotation tool set ➤ Dimensions tool group (expanded)
➤ Override

Menu: Dimension ➤ Override

Summary

Overrides a specified dimensioning system variable for selected dimensions, or clears the overrides of selected dimension objects, returning them to the settings defined by their dimension style.

List of Prompts

The following prompts are displayed.
Enter dimension variable name to override (page 311) or [Clear overrides (page 311)]: Enter the name of a dimension variable, or enter c

Dimension Variable Name to Override Overrides the value of the dimensioning system variable you specify.

Clear Overrides Clears any overrides on selected dimensions.
The dimension objects return to the settings defined by their dimension style.

See also:

Override a Dimension Style

DIMRADIUS

Creates a radius dimension for a circle or an arc.

Access Methods

Button
Toolbar: Annotation tool set ➤ Dimensions tool group ➤ Dimension flyout ➤ Radius
Menu: Dimension ➤ Radius

Summary
Measures the radius of a selected circle or arc and displays the dimension text with a radius symbol in front of it. You can use grips to reposition the resulting radius dimension easily.

List of Prompts
The following prompts are displayed.
Select arc or circle:
Specify dimension line location (page 312) or [Mtext (page 312)/Text (page 313)/Angle (page 313)]: Specify a point or enter an option

Dimension Line Location Determines the angle of the dimension line and the location of the dimension text. If the dimension is placed off of an arc resulting in the dimension pointing outside the arc, AutoCAD automatically draws an arc extension line.

Mtext Displays the In-Place Text Editor, which you can use to edit the dimension text. Use control codes and Unicode character strings to enter special characters or symbols. See Control Codes and Special Characters (page 1083).

If alternate units are not turned on in the dimension style, you can display them by entering square brackets ([ ]). For more information about formatting dimension text, see Select and Modify Objects.
The current dimension style determines the appearance of the generated measurements.
Text Customizes the dimension text at the Command prompt. The generated dimension measurement is displayed within angle brackets. To include the generated measurement, use angle brackets (< >) to represent the generated measurement. If alternate units are not turned on in the dimension style, you can display alternate units by entering square brackets ([ ]). Dimension text properties are set on the Text tab of the New, Modify, and Override Dimension Style dialog boxes.

Angle Changes the angle of the dimension text.

See also:
  Create Radial Dimensions

**DIMREASSOCIATE**

Associates or reassociates selected dimensions to objects or points on objects.

**Access Methods**

**Button**

 Toolbar: Annotation tool set ➤ Dimensions tool group ➤ Reassociate Dimension

Menu: Dimension ➤ Reassociate Dimensions

**Summary**

Each selected dimension is highlighted in turn, and prompts for association points appropriate for the selected dimension are displayed.

A marker is displayed for each association point prompt.

- If the definition point of the current dimension is not associated to a geometric object, the marker appears as an X
- If the definition point is associated, the marker appears as an X inside a box.

**NOTE** The marker disappears if you pan or zoom.
List of Prompts

The following prompts are displayed.
Select dimensions to reassociate...
Select objects or [Disassociated]: Select the dimension objects to reassociate or press D to select all disassociated dimensions.

Press Esc to terminate the command without losing the changes that were already specified. Use UNDO (page 1125) to restore the previous state of the changed dimensions.

The prompts for the different types of dimensions are:

**Linear** Specify first extension line origin or [Select object] <next>: Specify an object snap location, enter s and select a geometric object, or press Enter to skip to the next prompt
Specify second extension line origin <next>: Specify an object snap location, or press Enter to skip to the next dimension object, if any

**Aligned** Specify first extension line origin or [Select object] <next>: Specify an object snap location, enter s and select a geometric object, or press Enter to skip to the next prompt
Specify second extension line origin <next>: Specify an object snap location, or press Enter to skip to the next dimension object, if any

**Angular (Three Point)** Specify angle vertex or [Select arc or circle] <next>: Specify an object snap location, enter s and select an arc or a circle, or press Enter to skip to the next prompt
Specify first angle endpoint <next>: Specify an object snap location or press Enter to skip to the next prompt
Specify second angle endpoint <next>: Specify an object snap location or press Enter to skip to the next dimension object, if any

**Angular (Two Line)** Select first line <next>: Select a line, or press Enter to skip to the next prompt
Select second line <next>: Select another line, or press Enter to skip to the next dimension object, if any

**Diameter** Select arc or circle <next>: Select an arc or a circle, or press Enter to skip to the next dimension object, if any

**Leader** Specify leader association point <next>: Specify an object snap location, or press Enter to skip to the next dimension object, if any

**Ordinate** Specify feature location <next>: Specify an object snap location, or press Enter to skip to the next dimension object, if any
Radius Select arc or circle <next>:

Select an arc or a circle, or press Enter to skip to the next dimension object, if any.

**NOTE** DIMREASSOCIATE does not change the setting of DIMLFAC (page 1273) in a dimension. Use DIMOVERRIDE (page 310) to clear dimension linear factors in legacy drawings.

See also:

Change Dimension Associativity

**DIMREGEN**

Updates the locations of all associative dimensions.

**Summary**

The locations of all associative dimensions in the current drawing are updated. Associative dimensions need to be updated manually with DIMREGEN in the following cases:

- After panning or zooming with a wheel mouse in a layout with model space active; update associative dimensions created in paper space.
- After opening a drawing containing external references that are dimensioned in the current drawing; update associative dimensions if the associated external reference geometry has been modified.

**NOTE** After opening a drawing that has been modified with a previous version, the association between dimensions and objects or points may need to be updated. You can use the DIMREASSOCIATE (page 313) command to reassociate modified dimensions with the objects or points that they dimension.

See also:

Associative Dimensions

**DIMROTATED**

Creates a rotated linear dimension.
Summary

Creates a linear dimension with a rotated dimension line.

List of Prompts

The following prompts are displayed.
Specify angle of dimension line <0>: Specify an angle or press Enter to accept the default value
Specify first extension line origin (page 316) or <select object (page 317)>: Specify a point or press Enter to select an object to dimension

After you specify the extension line origin points or the object to dimension, the following prompt is displayed:
Specify dimension line location (page 316) or [Mtext (page 316)/Text (page 316)/Angle (page 317)]: Specify a point or enter an option

First Extension Line Origin
Prompts for the origin point of the second extension line after you specify the origin point of the first.

Dimension Line Location
Uses the point you specify to locate the dimension line and determines the direction to draw the extension lines. After you specify the location, the dimension is drawn.

Mtext
Displays the In-Place Text Editor, which you can use to edit the dimension text. Use control codes and Unicode character strings to enter special characters or symbols. See Control Codes and Special Characters (page 1083).

If alternate units are not turned on in the dimension style, you can display them by entering square brackets ([ ]). For more information about formatting dimension text, see Select and Modify Objects.

The current dimension style determines the appearance of the generated measurements.

Text
Customizes the dimension text at the Command prompt. The generated dimension measurement is displayed within angle brackets.

To include the generated measurement, use angle brackets (< >) to represent the generated measurement. If alternate units are not turned on in the dimension style, you can display alternate units by entering square brackets ([ ]).
Dimension text properties are set on the Text tab of the New, Modify, and Override Dimension Style dialog boxes.

**Angle**
Changes the angle of the dimension text.

**Object Selection**
Automatically determines the origin points of the first and second extension lines after you select an object.

For polylines and other explodable objects, only the individual line and arc segments are dimensioned. You cannot select objects in a non-uniformly scaled block reference.

If you select a line or an arc, the line or arc endpoints are used as the origins of the extension lines. The extension lines are offset from the endpoints by the distance you specify in Offset from Origin in the Lines and Arrows tab of the New, Modify, and Override Dimension Style dialog boxes. See [DIMSTYLE](page 319). This value is stored in the [DIMEXO](page 1269) system variable.

If you select a circle, the location of the origins for the extension lines is calculated based on the center of the circle and the angle of the rotated dimension line.

**See also:**
Create Linear Dimensions

**DIMSPACE**
Adjusts the spacing between linear dimensions or angular dimensions.

**Access Methods**

![Button]

**Toolbar:** Annotation tool set ➤ Dimensions tool group ➤ Adjust Dimension Space

**Menu:** Dimension ➤ Dimension Space
Summary

The spacing between parallel dimension lines is made equal. You can also make the dimension lines of a series of linear or angular dimensions line up by using a spacing value of 0.

Spacing is applied only to parallel linear dimensions or to angular dimensions that share a common vertex.

List of Prompts

The following prompts are displayed.

Select base dimension: Select a parallel linear or angular dimension
Select dimensions to space: Select a parallel linear or angular dimension to equally space from the base dimension and press Enter
Enter value (page 318) or [Auto (page 318)] <Auto>: Specify a spacing distance or press Enter

Enter Spacing Value Applies a spacing value to the selected dimensions from the base dimension. For example, if you enter a value of 0.5000, all selected dimensions will be separated by a distance of 0.5000.

You can use a spacing value of 0 (zero) to align the dimension lines of selected linear and angular dimensions end to end.

Auto Calculates the spacing distance automatically based on the text height specified in the dimension style of the selected base dimension. The resulting spacing value is twice the height of the dimension text.

See also:

Adjust Dimension Spacing
**DIMSTYLE**

Creates and modifies dimension styles.

**Access Methods**

Menu: Format ➤ Dimension Style

**Summary**

The Dimension Style Manager (page 319) is displayed.

A dimension style is a named collection of dimension settings that control the appearance of dimensions. You create dimension styles to specify the format of dimensions quickly, and to ensure that dimensions conform to standards.

If you enter `-dimstyle` at the Command prompt, options are displayed (page 352).

**See also:**

Use Dimension Styles

**Dimension Style Manager**

Creates new styles, sets the current style, modifies styles, sets overrides on the current style, and compares styles.
List of Options

The following options are displayed.

**Current Dimension Style**

Displays the name of the dimension style that is current. The default dimension style is STANDARD. The current style is applied to dimensions you create.

**Styles**

Lists dimension styles in the drawing. The current style is highlighted. Right-click in the list to display a shortcut menu with options to set the current style, rename styles, and delete styles. You cannot delete a style that is current or in use in the current drawing. A 🎨 icon before the style name indicates that the style is annotative.

Unless you select Don't List Styles in Xrefs, dimension styles are displayed in externally referenced drawings using the syntax for externally referenced named objects. (See Overview of Referenced Drawings [Xrefs].) Although you cannot change, rename, or make current externally referenced dimension styles, you can create new styles based on them.

The item selected in List controls the dimension styles displayed.
**New**
Displays the Create New Dimension Style dialog box (page 322), in which you can define a new dimension style.

**Delete**
Deletes the dimension style selected in the Styles list. A style that is being used in the drawing cannot be deleted.

**Options**
Manages the dimension styles in the list.

**Set Current**
Sets the style selected under Styles to current. The current style is applied to dimensions you create.

**Modify**
Displays the Modify Dimension Styles dialog box (page 323), in which you can modify dimension styles. Dialog box options are identical to those in the New Dimension Style dialog box.

**Override**
Displays the Override Current Style dialog box (page 323), in which you can set temporary overrides to dimension styles. Dialog box options are identical to those in the New Dimension Style dialog box. Overrides are displayed as unsaved changes under the dimension style in the Styles list.

**Compare**
Displays the Compare Dimension Styles dialog box (page 351), in which you can compare two dimension styles or list all the properties of one dimension style.

**Rename**
Edits the name of the style selected in the list.

**List**
Controls the display of styles in the Styles list. Select All Styles if you want to see all dimension styles in a drawing. Select Styles in Use if you want to see only the dimension styles currently used by dimensions in the drawing.

**Don’t List Styles in Xrefs**
When selected, suppresses display of dimension styles in externally referenced drawings in the Styles list.

**Preview**
Shows a graphic representation of the style selected in the Styles list.

**Description**
Describes the style selected in the Styles list relative to the current style. If the description is longer than the space provided, you can click in the pane and use arrow keys to scroll down.

See also:

Use Dimension Styles
Create New Dimension Style Dialog Box

Names the new dimension style, sets the style on which to start the new one, and indicates the dimension types to which you want the new style to apply.

List of Options

The following options are displayed.

New Style Name
Specifies the new dimension style name.

Start With
Sets a style to use as a basis for the new one. For the new style, you change only the properties that differ from the properties you start with.

Annotative
Specifies that the dimension style is annotative. Click the information icon to learn more about annotative objects.

Use For
Creates a dimension substyle that applies only to specific dimension types. For example, you could create a version of the STANDARD dimension style to be used only for diameter dimensions.

Continue
Displays the New Dimension Style dialog box (page 323), in which you define the new dimension style properties.

See also:

Use Dimension Styles
New, Modify, and Override Dimension Style Dialog Boxes

Set properties for dimension styles.

Summary

When you choose Continue in the Create New Dimension Style dialog box, the New Dimension Style dialog box is displayed. You define the properties for the new style in this dialog box. The dialog box initially displays the properties of the dimension style that you selected to start the new style in the Create New Dimension Style dialog box.

Choosing either Modify or Override in the Dimension Style Manager displays the Modify Dimension Style or the Override Dimension Style dialog box. The content of these dialog boxes is identical to the New Dimension Style dialog box, although you are modifying or overriding an existing dimension style rather than creating a new one.

The sample image on each tab displays the effects of each option.

List of Tabs

- **Lines** (page 324)
- **Symbols and Arrows** (page 328)
- **Text** (page 332)
- **Fit** (page 336)
- **Primary Units** (page 341)
- **Alternate Units** (page 344)
- **Tolerances** (page 347)

See also:

Use Dimension Styles

Lines Tab

Sets the format and properties for dimension lines, extension lines, arrowheads, and center marks.
Summary
Sets the dimension line properties.

List of Options
The following options are displayed.

Dimension Lines
Color
Displays and sets the color for the dimension line. If you click Select Color (at the bottom of the Color list), the Color Palette dialog box (page 205) is displayed. You can also enter a color name or number. (DIMCLRD (page 1266) system variable)

Linetype
Sets the linetype of the dimension line. (DIMLTYPE (page 1274) system variable)

Lineweight
Sets the lineweight of the dimension line. (DIMLWD (page 1275) system variable)

Extend Beyond Ticks
Specifies a distance to extend the dimension line past the extension line when you use oblique, architectural, tick, integral, and no marks for arrowheads. (DIMDLE (page 1268) system variable)

Baseline Spacing

Sets the spacing between the dimension lines of a baseline dimension. Enter a distance. For information about baseline dimensions, see DIMBASELINE (page 284). (DIMDLI (page 1268) system variable)

Suppress

Suppresses display of dimension lines. Dimension Line 1 suppresses the first dimension line; Dimension Line 2 suppresses the second dimension line. (DIMSD1 (page 1278) and DIMSD2 (page 1279) system variables)

Extension Lines

Controls the appearance of the extension lines.

Color

Sets the color for the extension line. If you click Select Color (at the bottom of the Color list), the Color Palette dialog box (page 205) is displayed. You can also enter a color name or number. (DIMCLRE (page 1266) system variable.)

Linetype Ext Line 1
Sets the linetype of the first extension line. (DIMLTEX1 (page 1274) system variable)

**Linetype Ext Line 2**

Sets the linetype of the second extension line. (DIMLTEX2 (page 1274) system variable)

**Lineweight**

Sets the lineweight of the extension line. (DIMLWE (page 1276) system variable)

**Suppress**

Suppresses the display of extension lines. Extension Line 1 suppresses the first extension line; Extension Line 2 suppresses the second extension line. (DIMSE1 (page 1279) and DIMSE2 (page 1280) system variables)

**Extend Beyond Dim Lines**

Specifies a distance to extend the extension lines above the dimension line. (DIMEXE (page 1269) system variable)

**Offset From Origin**

Sets the distance to offset the extension lines from the points on the drawing that define the dimension. (DIMEXO (page 1269) system variable)

**Fixed Length Extension Lines**

Enables fixed length extension lines. (DIMFXLON (page 1270) system variable)

**Length**
Sets the total length of the extension lines starting from the dimension line toward the dimension origin. (DIMFXL (page 1270) system variable)

**Preview**
Displays sample dimension images that show the effects of changes you make to dimension style settings.

**See also:**
Use Dimension Styles

**Symbols and Arrows Tab**
Sets the format and placement for arrowheads, center marks, arc length symbols, and jogged radius dimensions.
Summary

Controls the appearance of the dimension arrowheads.

List of Options

The following options are displayed.

**Arrowheads**

**First**
Sets the arrowhead for the first dimension line. When you change the first arrowhead type, the second arrowhead automatically changes to match it. ([DIMBLK1](page 1264) system variable)
To specify a user-defined arrowhead block, select User Arrow. The Select Custom Arrow Block dialog box is displayed. Select the name of a user-defined arrowhead block. (The block must be in the drawing.)

**Second**
Sets the arrowhead for the second dimension line. ([DIMBLK2](page 1265) system variable)
To specify a user-defined arrowhead block, select User Arrow. The Select Custom Arrow Block dialog box is displayed. Select the name of a user-defined arrowhead block. (The block must be in the drawing.)

**Leader**

Sets the arrowhead for the leader line. ([DIMLDRBLK](page 1272) system variable)

To specify a user-defined arrowhead block, select User Arrow. The Select Custom Arrow Block dialog box is displayed. Select the name of a user-defined arrowhead block. (The block must be in the drawing.)

**Arrow Size**

Displays and sets the size of arrowheads. ([DIMASZ](page 1260) system variable)

**NOTE** Annotative blocks cannot be used as custom arrowheads for dimensions or leaders.

**Dimension Break**

Controls the gap width of dimension breaks.

**Break Size**

Displays and sets the size of the gap used for dimension breaks.

**Center Marks**

Controls the appearance of center marks and centerlines for diameter and radial dimensions. The [DIMCENTER](page 288), [DIMDIAMETER](page 293), and [DIMRADIUS](page 311) commands use center marks and centerlines. For DIMDIAMETER and DIMRADIUS, the center mark is drawn only if you place the dimension line outside the circle or arc.

**Type**

Sets the type of center mark or line to use.

**None**

Creates no center mark or centerline. The value is stored as 0 in the DIMCEN system variable.

**Mark**

Creates a center mark. The size of the center mark is stored as a positive value in the [DIMCEN](page 1265) system variable.

**Line**

Creates a centerline. The size of the centerline is stored as a negative value in the DIMCEN system variable.
**Size**
Displays and sets the size of the center mark or centerline. (DIMCEN system variable)

**Radius Jog Dimension**
Controls the display of jogged (zigzag) radius dimensions. Jogged radius dimensions are often created when the center point of a circle or arc is located off the page.

**Jog Angle**
Determines the angle of the transverse segment of the dimension line in a jogged radius dimension. (DIMJOGANG (page 1271) system variable)

**Arc Length Symbol**
Controls the display of the arc symbol in an arc length dimension. (DIMARCSYM (page 1259) system variable)

**Preceding Dimension Text**
Places arc length symbols before the dimension text. (DIMARCSYM (page 1259) system variable)

**Above Dimension Text**
Places arc length symbols above the dimension text. (DIMARCSYM (page 1259) system variable)

**None**
 Suppresses the display of arc length symbols. (DIMARCSYM (page 1259) system variable)
**Linear Jog Dimension**
Controls the display of the jog for linear dimensions. Jog lines are often added to linear dimensions when the actual measurement is not accurately represent by the dimension. Typically the actual measurement is smaller than the desired value.

![Jog Height Factor](image)

**Jog Height Factor**
Determines the height of the of the jog, which is determined by the distance between the two vertices of the angles that make up the jog.

**Preview**
Displays sample dimension images that show the effects of changes you make to dimension style settings.

**See also:**
- Use Dimension Styles

**Text Tab**
Sets the format, placement, and alignment of dimension text.
List of Options

The following options are displayed.

**Text Appearance**
Controls the dimension text format and size.

**Text Style**
Lists the available text styles.

**Text Style Button**
Displays the Text Style Dialog Box (page 1041) where you can create or modify text styles. (DIMTXSTY system variable)

**Text Color**
Sets the color for the dimension text. If you click Select Color (at the bottom of the Color list), the Color Palette dialog box (page 205) is displayed. You can also enter color name or number. (DIMCLRT (page 1266) system variable)

**Fill Color**
Sets the color for the text background in dimensions. If you click Select Color (at the bottom of the Color list), the Color Palette dialog box (page 205) is
displayed. You can also enter color name or number. (DIMTFILL (page 1283) and DIMTFILLCLR (page 1283) system variables)

**Text Height**

Sets the height of the current dimension text style. Enter a value in the text box. If a fixed text height is set in the Text Style (that is, the text style height is greater than 0), that height overrides the text height set here. If you want to use the height set on the Text tab, make sure the text height in the Text Style is set to 0. (DIMTXT (page 1289) system variable)

**Fraction Height Scale**

Sets the scale of fractions relative to dimension text. This option is available only when Fractional is selected as the Unit Format on the Primary Units tab. The value entered here is multiplied by the text height to determine the height of dimension fractions relative to dimension text. (DIMTFAC (page 1282) system variable)

**Show Text Frame**

When selected, draws a frame around dimension text. Selecting this option changes the value stored in the DIMGAP (page 1271) system variable to a negative value.

**Placement**

Controls the placement of dimension text.

**Vertical**

Controls the vertical placement of dimension text in relation to the dimension line. (DIMTAD (page 1281) system variable)

Vertical position options include the following:

- **Centered**: Centers the dimension text between the two parts of the dimension line.
- **Above**: Places the dimension text above the dimension line. The distance from the dimension line to the baseline of the lowest line of text is the current text gap. See the Offset from Dim Line option.
- **Outside**: Places the dimension text on the side of the dimension line farthest away from the first defining point.
- **JIS**: Places the dimension text to conform to a Japanese Industrial Standards (JIS) representation.
- **Below**: Places the dimension text under the dimension line. The distance from the dimension line to the baseline of the lowest line of text is the current text gap. See the Offset from Dim Line option.
Horizontal

Controls the horizontal placement of dimension text along the dimension line, in relation to the extension lines. \texttt{(DIMJUST (page 1272) system variable)}

Horizontal position options include the following:

- **Centered**: Centers the dimension text along the dimension line between the extension lines.
- **At Ext Line 1**: Left-justifies the text with the first extension line along the dimension line. The distance between the extension line and the text is twice the arrowhead size plus the text gap value. See Arrowheads and Offset from Dim Line.
- **At Ext Line 2**: Right-justifies the text with the second extension line along the dimension line. The distance between the extension line and the text is twice the arrowhead size plus the text gap value. See Arrowheads and Offset from Dim Line.
- **Over Ext Line 1**: Positions the text over or along the first extension line.
- **Over Ext Line 2**: Positions the text over or along the second extension line.
View Direction
Controls the dimension text viewing direction. (DIMTXTDIRECTION (page 1289) system variable)
View Direction includes the following options:
- Left-to-Right: Places the text to enable reading from left to right.
- Right-to-Left: Places the text to enable reading from right to left.

Offset from Dim Line
Sets the current text gap, which is the distance around the dimension text when the dimension line is broken to accommodate the dimension text. This value is also used as the minimum length required for dimension line segments.
Text is positioned inside the extension lines only if the resulting segments are at least as long as the text gap. Text above or below the dimension line is placed inside only if the arrowheads, dimension text, and a margin leave enough room for the text gap. (DIMGAP (page 1271) system variable)

<table>
<thead>
<tr>
<th>DIMGAP = 0</th>
<th>DIMGAP = 0.1</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>15</td>
</tr>
</tbody>
</table>

Alignment
Controls the orientation (horizontal or aligned) of dimension text whether it is inside or outside the extension lines. (DIMTIH (page 1283) and DIMTOH (page 1286) system variables)

Horizontal
Places text in a horizontal position.

<table>
<thead>
<tr>
<th>Aligned with Dimension Line</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aligns text with the dimension line.</td>
</tr>
</tbody>
</table>

ISO Standard
Aligns text with the dimension line when text is inside the extension lines, but aligns it horizontally when text is outside the extension lines.
**Preview**
Displays sample dimension images that show the effects of changes you make to dimension style settings.

**See also:**
- Use Dimension Styles

**Fit Tab**
Controls the placement of dimension text, arrowheads, leader lines, and the dimension line.

**List of Options**
The following options are displayed.
**Fit Options**
Controls the placement of text and arrowheads based on the space available between the extension lines.

When space is available, text and arrowheads are placed between the extension lines. Otherwise, text and arrowheads are placed according to the Fit options. *(DIMATFIT (page 1261), DIMTIX (page 1284), and DIMSOXD (page 1280) system variables)*

**Either Text or Arrows (Best Fit)**
Moves either the text or the arrowheads outside the extension lines based on the best fit *(DIMATFIT (page 1261) system variable).*
- When enough space is available for text and arrowheads, places both between the extension lines. Otherwise, either the text or the arrowheads are moved based on the best fit.
- When enough space is available for text only, places text between the extension lines and places arrowheads outside the extension lines.
- When enough space is available for arrowheads only, places them between the extension lines and places text outside the extension lines.
- When space is available for neither text nor arrowheads, places them both outside the extension lines.

**Arrows**
Moves arrowheads outside the extension lines first, then text *(DIMATFIT (page 1261) system variable).*
- When enough space is available for text and arrowheads, places both between the extension lines.
- When space is available for arrowheads only, places them between the extension lines and places text outside them.
- When not enough space is available for arrowheads, places both text and arrowheads outside the extension lines.

**Text**
Moves text outside the extension lines first, then arrowheads (DIMATFIT (page 1261) system variable).

- When space is available for text and arrowheads, places both between the extension lines.
- When space is available for text only, places the text between the extension lines and places arrowheads outside them.
- When not enough space is available for text, places both text and arrowheads outside the extension lines.

**Both Text and Arrows**

When not enough space is available for text and arrowheads, moves both outside the extension lines (DIMATFIT (page 1261) system variable).

**Always Keep Text Between Ext Lines**

Always places text between extension lines. (DIMTIX (page 1284) system variable)

**Suppress Arrows If They Don't Fit Inside Extension Lines**

Suppresses arrowheads if not enough space is available inside the extension lines. (DIMSOXD (page 1280) system variable)

**Text Placement**

Sets the placement of dimension text when it is moved from the default position, that is, the position defined by the dimension style. (DIMTMOVE (page 1285) system variable)

**Beside the Dimension Line**

If selected, moves the dimension line whenever dimension text is moved. (DIMTMOVE (page 1285) system variable)
Over the Dimension Line, with Leader
If selected, dimension lines are not moved when text is moved. If text is moved away from the dimension line, a leader line is created connecting the text to the dimension line. The leader line is omitted when text is too close to the dimension line. (DIMTMOVE (page 1285) system variable)

Over the Dimension Line, Without Leader
If selected, dimension lines are not moved when text is moved. Text that is moved away from the dimension line is not connected to the dimension line with a leader. (DIMTMOVE (page 1285) system variable)

Scale for Dimension Features
Sets the overall dimension scale value or the paper space scaling.

Annotative
Specifies that the dimension is annotative. Click the information icon to learn more about annotative objects.

Scale Dimensions To Layout
Determines a scale factor based on the scaling between the current model space viewport and paper space. (DIMSCALE system variable)
When you work in paper space, but not in a model space viewport, or when TILEMODE (page 1511) is set to 1, the default scale factor of 1.0 is used or the DIMSCALE system variable.

Use Overall Scale Of
Sets a scale for all dimension style settings that specify size, distance, or spacing, including text and arrowhead sizes. This scale does not change dimension measurement values. (DIMSCALE (page 1278) system variable)

Fine Tuning
Provides additional options for placing dimension text.

Place Text Manually
Ignores any horizontal justification settings and places the text at the position you specify at the Dimension Line Location prompt. (DIMUPT (page 1290) system variable)

**Draw Dim Line Between Ext Lines**

Draws dimension lines between the measured points even when the arrowheads are placed outside the measured points. (DIMTOFL (page 1285) system variable)

**Preview**

Displays sample dimension images that show the effects of changes you make to dimension style settings.

**See also:**

Use Dimension Styles

**Primary Units Tab**

Sets the format and precision of primary dimension units and sets prefixes and suffixes for dimension text.
List of Options

The following options are displayed.

**Linear Dimensions**
Sets the format and precision for linear dimensions.

**Unit Format**
Sets the current units format for all dimension types except Angular. (DIMLUNIT (page 1275) system variable)
The relative sizes of numbers in stacked fractions are based on the DIMTFAC (page 1282) system variable (in the same way that tolerance values use this system variable).

**Precision**
Displays and sets the number of decimal places in the dimension text. (DIMDEC (page 1267) system variable)

**Fraction Format**
Sets the format for fractions. (DIMFRAC (page 1269) system variable)

**Decimal Separator**
Sets the separator for decimal formats. (DIMDSEP (page 1268) system variable)

**Round Off**
Sets rounding rules for dimension measurements for all dimension types except Angular. If you enter a value of **0.25**, all distances are rounded to the nearest 0.25 unit. If you enter a value of **1.0**, all dimension distances are rounded to the nearest integer. The number of digits displayed after the decimal point depends on the Precision setting. (DIMRND system variable)

**Prefix**
Includes a prefix in the dimension text. You can enter text or use control codes to display special symbols. For example, entering the control code `%%c` displays the diameter symbol. When you enter a prefix, it overrides any default prefixes such as those used in diameter and radius dimensioning. (DIMPOST (page 1276) system variable)

\[ \phi 1.00 \]

If you specify tolerances, the prefix is added to the tolerances as well as to the main dimension.
For more information, see Control Codes and Special Characters (page 1083).
Suffix

Includes a suffix in the dimension text. You can enter text or use control codes to display special symbols. For example, entering the text `mm` results in dimension text similar to that shown in the illustration. When you enter a suffix, it overrides any default suffixes. *(DIMPOST (page 1276) system variable)*

If you specify tolerances, the suffix is added to the tolerances as well as to the main dimension.

For more information, see Control Codes and Special Characters (page 1083).

Scale Factor

Sets a scale factor for linear dimension measurements. It is recommended that you do not change this value from the default value of 1.00. For example, if you enter `2`, the dimension for a 1-inch line is displayed as two inches. The value does not apply to angular dimensions and is not applied to rounding values or to plus or minus tolerance values. *(DIMLFAC (page 1273) system variable)*

Apply to Layout Dimension Only

Applies the measurement scale factor only to dimensions created in layout viewports. Except when using nonassociative dimensions, this setting should remain unchecked. *(DIMLFAC (page 1273) system variable)*

Zero Suppression

Controls the suppression of leading and trailing zeros and of feet and inches that have a value of zero. *(DIMZIN (page 1291) system variable)*

Zero suppression settings also affect real-to-string conversions performed by the AutoLISP® `rtos` and `angtos` functions.

Leading

Suppresses leading zeros in all decimal dimensions. For example, 0.5000 becomes .5000. Select leading to enable display of dimension distances less than one unit in sub units.

Sub-units factor

Sets the number of sub units to a unit. It is used to calculate the dimension distance in a sub unit when the distance is less than one unit. For example, enter `100` if the suffix is `m` and the sub-unit suffix is to display in `cm`.

Sub-unit suffix
Includes a suffix to the dimension value sub unit. You can enter text or use control codes to display special symbols. For example, enter `cm` for `.96m` to display as `96cm`.

**Trailing**

Suppresses trailing zeros in all decimal dimensions. For example, `12.5000` becomes `12.5`, and `30.0000` becomes `30`.

**0 Feet**

Suppresses the feet portion of a feet-and-inches dimension when the distance is less than one foot. For example, `0'-6 1/2"` becomes `6 1/2"`.

**0 Inches**

Suppresses the inches portion of a feet-and-inches dimension when the distance is an integral number of feet. For example, `1'-0"` becomes `1`.

**Angular Dimensions**

Displays and sets the current angle format for angular dimensions.

**Units Format**

Sets the angular units format. ([DIMAUNIT](page 1261) system variable)

**Precision**

Sets the number of decimal places for angular dimensions. ([DIMADEC](page 1254) system variable)

**Zero Suppression**

Controls the suppression of leading and trailing zeros. ([DIMAZIN](page 1262) system variable)

**Leading**

Suppresses leading zeros in angular decimal dimensions. For example, `0.5000` becomes `.5000`.

You can also display dimension distances less than one unit in sub units.

**Trailing**

Suppresses trailing zeros in angular decimal dimensions. For example, `12.5000` becomes `12.5`, and `30.0000` becomes `30`.

**Preview**

Displays sample dimension images that show the effects of changes you make to dimension style settings.
See also:

Use Dimension Styles

**Alternate Units Tab**

Specifies display of alternate units in dimension measurements and sets their format and precision.

![Modify Dimension Style: Standard](image)

**List of Options**

The following options are displayed.

**Display Alternate Units**

Adds alternate measurement units to dimension text. Sets the `DIMALT` (page 1254) system variable to 1.

**Alternate Units**

Displays and sets the current alternate units format for all dimension types except Angular.

**Unit Format**
Sets the unit format for alternate units. *(DIMALTU* (page 1257) system variable)*

The relative sizes of numbers in stacked fractions are based on *DIMTFAC* (page 1282) (in the same way that tolerance values use this system variable).

**Precision**

Sets the number of decimal places for alternate units. *(DIMALTD* (page 1254) system variable)*

**Multiplier for Alt Units**

Specifies the multiplier used as the conversion factor between primary and alternate units. For example, to convert inches to millimeters, enter 25.4. The value has no effect on angular dimensions, and it is not applied to the rounding value or the plus or minus tolerance values. *(DIMALTF* (page 1255) system variable)*

**Round Distances To**

Sets rounding rules for alternate units for all dimension types except Angular. If you enter a value of 0.25, all alternate measurements are rounded to the nearest 0.25 unit. If you enter a value of 1.0, all dimension measurements are rounded to the nearest integer. The number of digits displayed after the decimal point depends on the Precision setting. *(DIMALTRND* (page 1255) system variable)*

**Prefix**

Includes a prefix in the alternate dimension text. You can enter text or use control codes to display special symbols. For example, entering the control code %%c displays the diameter symbol. *(DIMAPOST* (page 1259) system variable)*

For more information, see *Control Codes and Special Characters* (page 1083).

\[
\text{Ø}1.00[\#25.4]
\]

**Suffix**

Includes a suffix in the alternate dimension text. You can enter text or use control codes to display special symbols. For example, entering the text cm results in dimension text similar to that shown in the illustration. When you enter a suffix, it overrides any default suffixes. *(DIMAPOST* (page 1259) system variable)*

For more information, see *Control Codes and Special Characters* (page 1083).
Zero Suppression

Controls the suppression of leading and trailing zeros and of feet and inches that have a value of zero. (DIMALTZ (page 1257) system variable)

**Leading**

Suppresses leading zeros in all decimal dimensions. For example, 0.5000 becomes .5000.

**Sub-units factor**

Sets the number of sub units to a unit. It is used to calculate the dimension distance in a sub unit when the distance is less than one unit. For example, enter **100** if the suffix is **m** and the sub-unit suffix is to display in **cm**.

**Sub-unit suffix**

Includes a suffix to the dimension value sub unit. You can enter text or use control codes to display special symbols. For example, enter **cm** for .96m to display as 96cm.

**Trailing**

Suppresses trailing zeros in all decimal dimensions. For example, 12.5000 becomes 12.5, and 30.0000 becomes 30.

**0 Feet**

Suppresses the feet portion of a feet-and-inches dimension when the distance is less than 1 foot. For example, 0'-6 1/2" becomes 6 1/2".

**0 Inches**

Suppresses the inches portion of a feet-and-inches dimension when the distance is an integral number of feet. For example, 1'-0" becomes 1'.

**Placement**

Controls the placement of alternate units in dimension text.

**After Primary Value**

Places alternate units after the primary units in dimension text.

**Below Primary Value**

Places alternate units below the primary units in dimension text.
**Preview**
Displays sample dimension images that show the effects of changes you make to dimension style settings.

**See also:**
Use Dimension Styles

**Tolerances Tab**
Specifies the display and format of dimension text tolerances.

**List of Options**
The following options are displayed.

**Tolerance Format**
Controls the tolerance format.

**Method**
Sets the method for calculating the tolerance. (DIMTOL (page 1286) system variable)

- **None**: Does not add a tolerance. The DIMTOL (page 1286) system variable is set to 0.

- **Symmetrical**: Adds a plus/minus expression of tolerance in which a single value of variation is applied to the dimension measurement. A plus-or-minus sign appears after the dimension. Enter the tolerance value in Upper Value. The DIMTOL (page 1286) system variable is set to 1. The DIMLIM (page 1273) system variable is set to 0.

\[10.00 \pm 0.15\]

- **Deviation**: Adds a plus/minus tolerance expression. Different plus and minus values of variation are applied to the dimension measurement. A plus sign (+) precedes the tolerance value entered in Upper Value, and a minus sign (-) precedes the tolerance value entered in Lower Value. The DIMTOL (page 1286) system variable is set to 1. The DIMLIM (page 1273) system variable is set to 0.

\[10.00 \pm 0.15\]

- **Limits**: Creates a limit dimension. A maximum and a minimum value are displayed, one over the other. The maximum value is the dimension value plus the value entered in Upper Value. The minimum value is the dimension value minus the value entered in Lower Value. The DIMTOL (page 1286) system variable is set to 0. The DIMLIM (page 1273) system variable is set to 1.

\[10.15\]
\[9.90\]

- **Basic**: Creates a basic dimension, which displays a box around the full extents of the dimension. The distance between the text and the box is stored as a negative value in the DIMGAP (page 1271) system variable.

\[10.15\]
Sets the number of decimal places. *(DIMTDEC (page 1282) system variable)*

**Upper Value**
Sets the maximum or upper tolerance value. When you select Symmetrical in Method, this value is used for the tolerance. *(DIMTP (page 1287) system variable)*

**Lower Value**
Sets the minimum or lower tolerance value. *(DIMTM (page 1284) system variable)*

**Scaling for Height**
Sets the current height for the tolerance text. The ratio of the tolerance height to the main dimension text height is calculated and stored in the *DIMTFAC* (page 1282) system variable.

**Vertical Position**
Controls text justification for symmetrical and deviation tolerances.

- **Top:** Aligns the tolerance text with the top of the main dimension text. When you select this option, the *DIMTOLJ* (page 1287) system variable is set to 2.

  \[10.03\pm0.15\]

- **Middle:** Aligns the tolerance text with the middle of the main dimension text. When you select this option, the *DIMTOLJ* system variable is set to 1.

  \[10.03\pm0.15\]

- **Bottom:** Aligns the tolerance text with the bottom of the main dimension text. When you select this option, the *DIMTOLJ* system variable is set to 0.

  \[10.03\pm0.15\]

**Align**
Controls the alignment of upper and lower tolerance values when stacked

**Decimal Separators**
Values are stacked by their decimal separators.

**Operational Symbols**

Values are stacked by their operational symbols.

**Suppress**

Controls the suppression of leading and trailing zeros and of feet and inches that have a value of zero. *(DIMTZIN (page 1290) system variable)*

Zero suppression settings also affect real-to-string conversions performed by the AutoLISP® `rtos` and `angtos` functions.

**Leading Zeros**

Suppresses leading zeros in all decimal dimensions. For example, 0.5000 becomes .5000.

**Trailing Zeros**

Suppresses trailing zeros in all decimal dimensions. For example, 12.5000 becomes 12.5, and 30.0000 becomes 30.

**0 Feet**

Suppresses the feet portion of a feet-and-inches dimension when the distance is less than 1 foot. For example, 0'-6 1/2" becomes 6 1/2".

**0 Inches**

Suppresses the inches portion of a feet-and-inches dimension when the distance is an integral number of feet. For example, 1'-0" becomes 1'.

**Alternate Unit Tolerance**

Formats alternate tolerance units.

**Precision**

Displays and sets the number of decimal places. *(DIMALTTD (page 1256) system variable)*

**Suppress**

Controls the suppression of leading and trailing zeros and of feet and inches that have a value of zero. *(DIMALTTZ (page 1256) system variable)*

**Leading Zeros**

Suppresses leading zeros in all decimal dimensions. For example, 0.5000 becomes .5000.

**Trailing Zeros**
Suppresses trailing zeros in all decimal dimensions. For example, 12.5000 becomes 12.5, and 30.0000 becomes 30.

0 Feet
Suppresses the feet portion of a feet-and-inches dimension when the distance is less than 1 foot. For example, 0'-6 1/2" becomes 6 1/2".

0 Inches
Suppresses the inches portion of a feet-and-inches dimension when the distance is an integral number of feet. For example, 1'-0" becomes 1'.

Preview
Displays sample dimension images that show the effects of changes you make to dimension style settings.

See also:
Use Dimension Styles

Compare Dimension Styles Dialog Box

Compares the properties of two dimension styles or displays all properties of one style.
Summary
You can output the results of the comparison to the Clipboard, and then paste to other applications.

List of Options
The following options are displayed.

Compare
Specifies the first dimension style for the comparison.

With
Specifies the second dimension style for the comparison. If you set the second style to <none> or to the same style as the first, all the properties of the dimension style are displayed.
Comparison results are displayed automatically under the following headings:
■ Description of the dimension style property
■ System variable that controls the property
■ System variable values of style properties that differ for each dimension style

Results
Displays the results of the dimension style comparison. If you compare two different styles, the properties that differ are displayed. If you set the second style to <none> or to the same style as the first, all the properties of the dimension style are displayed.

Copy to Clipboard button
Copies the results of the comparison to the Clipboard. You can then paste the results to other applications, such as word processors and spreadsheets.

See also:
 Use Dimension Styles

-DIMSTYLE
Creates and modifies dimension styles.
Summary
You can save or restore dimensioning system variables to a selected dimension style.

List of Prompts
The following prompts are displayed.
Current dimension style: <current> Annotative: <current>
Enter a dimension style option
[ANnotative (page 353)/Save (page 353)/Restore (page 353)/STatus (page 354)/Variables (page 354)/Apply (page 354)/? (page 354)]
<Restore>: Enter an option or press Enter

Annotative
Creates an annotative dimension style.

Save
Saves the current settings of dimensioning system variables to a dimension style.

Name Saves the current settings of dimensioning system variables to a new dimension style using the name you enter. The new dimension style becomes the current one.
If you enter the name of an existing dimension style, the following prompts are displayed:
That name is already in use, redefine it? <N>: Enter y or press Enter
If you enter y, associative dimensions that use the redefined dimension style are regenerated.
To display the differences between the dimension style name you want to save and the current style, enter a tilde (~) followed by the style name at the Enter Name for New Dimension Style prompt. Only settings that differ are displayed, with the current setting in the first column, and the setting of the compared style in the second column.

?—List Dimension Styles Lists the named dimension styles in the current drawing.

Restore
Restores dimensioning system variable settings to those of a selected dimension style.

Name Makes the dimension style you enter the current dimension style.
To display the differences between the dimension style name you want to restore and the current style, enter a tilde (~) followed by the style name at
the Enter Dimension Style Name prompt. Only settings that differ are displayed, with the current setting in the first column, and the setting of the compared style in the second column. After the differences are displayed, the previous prompt returns.

?—List Dimension Styles Lists the named dimension styles in the current drawing.

Select Dimension Makes the dimension style of the selected object the current dimension style.

Status Displays the current values of all dimension system variables.

Variables Lists the dimension system variable settings of a dimension style or selected dimensions without modifying the current settings.

Name Lists the settings of dimension system variables for the dimension style name you enter.

To display the differences between a particular dimension style and the current style, enter a tilde (~) followed by the style name at the Enter Dimension Style Name prompt. Only settings that differ are displayed, with the current setting in the first column, and the setting of the compared style in the second column.

?—List Dimension Styles Lists the named dimension styles in the current drawing.

Select Dimension Lists the dimension style and any dimension overrides for the dimension object you select.

Apply Applies the current dimensioning system variable settings to selected dimension objects, permanently overriding any existing dimension styles applied to these objects.

The dimension line spacing between existing baseline dimensions is not updated (see the DIMDLI (page 1268) system variable); dimension text variable settings do not update existing leader text.

?—List Dimension Styles Lists the named dimension styles in the current drawing.

See also:

Use Dimension Styles
DIMTEDIT

Moves and rotates dimension text and relocates the dimension line.

**Access Methods**

- **Button**
  - ![Toolbar: Annotation tool set ➤ Dimensions tool group (expanded) ➤ Text Angle](image)
  - ![Toolbar: Annotation tool set ➤ Dimensions tool group (expanded) ➤ Left Justify, Center Justify, Right Justify](image)
  - **Menu: Dimension ➤ Align Text ➤ Angle**

**Summary**

The companion command that edits the dimension text and changes the extension line angle is DIMEDIT.

**List of Prompts**

The following prompts are displayed.

**Select dimension:** *Select a dimension object*

You are prompted for the new location of the dimension text.

**Specify new location for dimension text** (page 355) or [Left (page 355)/Right (page 356)/Center (page 356)/Home (page 356)/Angle (page 357)]: *Specify a point or enter an option*

**Location for Dimension Text** Updates the location of the dimension text dynamically as you drag it. To determine whether text appears above, below, or in the middle of the dimension line, use the Text tab in the New, Modify, and Override Dimension Style dialog box.

**Left** Left-justifies the dimension text along the dimension line.

This option works only with linear, radius, and diameter dimensions.
Right  Right-justifies the dimension text along the dimension line. This option works only with linear, radius, and diameter dimensions.

Center  Centers the dimension text on the dimension line. This option works only with linear, radius, and diameter dimensions.

Home  Moves the dimension text back to its default position.
For example:
**Angle** Changes the angle of the dimension text. The center point of the text does not change. If the text moves or the dimension is regenerated, the orientation set by the text angle is retained. Entering an angle of 0 degrees puts the text in its default orientation.

The text angle is measured from the X axis of the UCS.

**See also:**
Modify Dimension Text

**DIST**

Measures the distance and angle between two points.

**Access Method**

Command entry: 'dist' for transparent use
Summary

In general, the DIST command reports 3D distances in model space and 2D distances on a layout in paper space.

In model space, changes in X, Y, and Z component distances and angles are measured in 3D relative to the current UCS.

In paper space, distances are normally reported in 2D paper space units. However, when using object snaps on model space objects that are displayed in a single viewport, distances are reported as 2D model space distances projected onto a plane parallel to your screen.

List of Prompts

The following prompts are displayed.
Specify first point: Specify a point
Specify second point or <Multiple points>: Specify a second point

The distance is displayed in the current units format.

DIST assumes the current elevation for the first or second point if you omit the Z coordinate value.

NOTE When using the DIST command for 3D distances, it is recommended that you switch to model space.

Multiple Points If you specify multiple points, a running total of the distance based on the existing line segments and the current rubberband line is displayed in the tooltip. A dynamic dimension is also displayed. The distance is updated as you move the cursor.

See also:

Obtain Distances, Angles, and Point Locations
DISTANTLIGHT

Creates a distant light.

Access Methods

Button

Toolbar: Modeling tool set ➤ Lights tool group (expanded) ➤ Distant Light
Menu: View ➤ Render ➤ Light ➤ New Distant Light

List of Prompts

The following prompts are displayed.
Specify light direction FROM <0,0,0> or [Vector]: Specify a point or enter v
Specify light direction TO <1,1,1>: Specify a point

If you enter the Vector option, the following prompt is displayed:
Specify vector direction <0.0000,-0.0100,1.0000>: Enter a vector

After you specify the light direction and if the LIGHTINGUNITS system variable is set to 0, the following prompt is displayed:
Enter an option to change [Name (page 359)/Intensity (page 360)/Status (page 360)/Shadow (page 360)/Color (page 361)/eXit] <eXit>:

If the LIGHTINGUNITS system variable is set to 1 or 2, the following prompt is displayed:
Enter an option to change [Name (page 359)/Intensity factor (page 360)/Photometry (page 360)/FilterColor (page 361)/eXit] <eXit>:

NOTE When the LIGHTINGUNITS system variable is set to 1 or 2, the Attenuation option has no affect on the creation of the light. It is only maintained for scripting compatibility.

Name

Specifies the name of the light. You can use uppercase and lowercase letters, numbers, spaces, hyphens (-), and underscores (_) in the name. The maximum length is 256 characters.
**Intensity/Intensity Factor**
Sets the intensity or brightness of the light. The range is 0.00 to the maximum value that is supported by your system.

**Status**
Turns the light on and off. If lighting is not enabled in the drawing, this setting has no effect.

**Photometry**
Photometry is available when the LIGHTINGUNITS system variable is set to 1 or 2. Photometry is the measurement of the luminous intensities of visible light sources.

In photometry, luminous intensity is a measure of the perceived power emitted by a light source in a particular direction. Luminous flux is the perceived power per unit of solid angle. The total luminous flux is the perceived power emitted in all directions. Luminance is the total luminous flux incident on a surface, per unit area.

**Intensity** Enter an intensity value in candelas, the perceived power in a luminous flux value, or illuminance value for the total luminous flux incident on a surface.
- Candela (symbol: cd) is the SI unit of luminous intensity (perceived power emitted by a light source in a particular direction). Cd/Sr
- Lux (symbol: lx) is the SI unit of illuminance. Lm/m²
- Foot-candle (symbol: fc) is the American unit of illuminance. Lm/ft²

Enter f to specify the perceived power in a luminous flux value.
If you enter i, you can specify the intensity of the light based on an illuminance value.

The illuminance value can be specified in either lux or foot-candles. Enter d to specify a distance to use to calculate illuminance.

**Color** Specify the color of the light based on a color name or a Kelvin temperature. Enter ? to display a list of color names.

Enter a text string using wild card characters to display a partial listing of color names, or an asterick (*) to display all the possible choices.

If you enter k, you can specify the color of the light based on a Kelvin temperature value.

**Shadow**
Makes the light cast shadows.

**Off** Turns off display and calculation of shadows for the light. Turning shadows off increases performance.
**Sharp** Displays shadows with sharp edges. Use this option to increase performance.

**Soft Mapped** Displays realistic shadows with soft edges. Specifies the amount of memory that should be used to calculate the shadow map. Specifies the softness to use to calculate the shadow map.

**Color/Filter Color**
Controls the color of the light.

- **True Color** Specifies a True Color. Enter in the format R,G,B (red, green, blue).
- **Index** Specifies an ACI (AutoCAD Color Index) color.
- **HSL** Specifies an HSL (hue, saturation, luminance) color.
- **Color Book** Specifies a color from a color book.

See also:
- Use Distant Lights

### DIVIDE

Creates evenly spaced point objects or blocks along the length or perimeter of an object.

**Access Methods**

- **Button**
- **Toolbar: Drafting tool set ➤ Open Shapes tool group (expanded) ➤ Point flyout ➤ Divide**
- **Menu: Draw ➤ Point ➤ Divide**

**List of Prompts**

The following prompts are displayed.
Select object to divide: **Use an object selection method**
Enter **number of segments** (page 362) or **[Block (page 362)]**: **Enter a value from 2 through 32,767, or enter b**
**Number of Segments**
Places point objects at equal intervals along the selected objects.

Use **DDPTYPE** (page 271) to set the style and size of all point objects in a drawing.

**Block**
Places blocks at equal intervals along the selected object. If the block has variable attributes, these attributes are not included.

*Yes* Specifies that the X axes of the inserted blocks be tangent to, or collinear with, the divided object at the dividing points.

*No* Aligns the blocks according to their normal orientation.

The illustration shows an arc divided into five equal parts using a block consisting of a vertically oriented ellipse.

**See also:**
Divide an Object into Equal Segments
DONUT

Creates a filled circle or a wide ring.

Access Methods

Button

Toolbar: Drafting tool set ➤ Closed Shapes tool group (expanded) ➤ Donut
Menu: Draw ➤ Donut

Summary

A donut consists of two arc polylines that are joined end-to-end to create a circular shape. The width of the polylines is determined by the specified inside and outside diameters. To create solid-filled circles, specify an inside diameter of zero.

List of Prompts

The following prompts are displayed.
Specify inside diameter of donut <current>: Specify a distance or press Enter
If you specify an inside diameter of 0, the donut is a filled circle.
Specify outside diameter of donut <current>: Specify a distance or press Enter
Specify center of donut or <exit>: Specify a point (1) or press Enter to end the command
The location of the donut is set based on the center point. After you specify the diameters, you are prompted for the locations at which to draw donuts. A donut is drawn at each point specified (2). How the interior of a donut is filled depends on the current setting of the FILL (page 435) command.

See also:
   Draw Donuts

**DRAGMODE**

Controls the way dragged objects are displayed.

**Access Method**

Command entry: 'dragmode for transparent use

**List of Prompts**

The following prompts are displayed.
Enter new value [ON (page 364)/OFF (page 365)/Auto (page 365)]
<current>: Enter an option or press Enter

On Permits dragging, but you must enter drag where appropriate in a drawing or editing command to initiate dragging.
**Off** Ignores all dragging requests, including those embedded in menu items.

**Auto** Turns on dragging for every command that supports it. Dragging is performed whenever it is possible. Entering `drag` each time is not necessary.

**See also:**
- Set Up the Drawing Area

**DRAWINGRECOVERY**

Displays a list of drawing files that can be recovered after a program or system failure.

**Access Methods**

- **Menu:** Help ➤ Recover Files

**Summary**

Opens the Files Recovered dialog box (page 365).

**See also:**
- Recover from a System Failure

**Files Recovered Dialog Box**

Displays a list of all drawing files that were open at the time of a program or system failure.
Summary
You can preview and open each drawing or backup file to choose which one should be saved as the primary DWG file.

List of Options
The following options are displayed.

Backup Files
Displays the drawings that may need to be recovered after a program or system failure. A top-level drawing node contains a set of files associated with each drawing. If available, up to four files are displayed including
- The recovered drawing file saved at the time of a program failure (DWG)
- The automatic save file, also called the “autosave” file (SV$)
- The drawing backup file (BAK)
- The original drawing file (DWG)

Once a drawing or backup file is opened and saved, the corresponding top-level drawing node is removed from the Backup Files area.

Preview
Displays a thumbnail preview of the currently selected drawing or backup file.

Click the arrows below the current thumbnail preview to cycle through the previews of all the drawing or backup files that can be recovered.

Shortcut Menu Options
Right-click a drawing node, drawing or backup file, or a blank area in the Backup Files area to display a shortcut menu with relevant options.

Reveal in Finder Opens Finder to the location of the selected drawing or backup file.

Select All Selects all the drawing or backup files that can be recovered.

Select None Deselects all the currently selected drawing or backup files.

Select Most Recent Selects the most recent drawing or backup files that can be recovered. All other files are deselected.

Delete File Moves the selected file to the Trash. Applies to SV$ or BAK files only.

Show this screen after crash Specifies whether the Files Recovered dialog box is displayed the next time AutoCAD is started after a program or system failure.
See also:

Recover from a System Failure

**DRAWINGRECOVERYHIDE**

Closes the Files Recovered dialog box.

See also:

Recover from a System Failure

**DRAWORDER**

Changes the draw order of images and other objects.

**Access Methods**

Button

- **Toolbar**: Drafting tool set ➤ Move/Rotate/Scale tool group (expanded) ➤ Draw Order flyout
- **Menu**: Tools ➤ Draw Order ➤ Bring to Front
- **Shortcut menu**: Select an object, right-click, and then click Draw Order.

**Summary**

Use the DRAWORDERCTL system variable to control the default display behavior of overlapping objects. In addition, the TEXTTOFRONT command brings all text, dimensions, or leaders in a drawing in front of other objects, and the HATCHTOBACK command sends all hatch objects behind other objects.

**List of Prompts**

The following prompts are displayed.

*Select objects*: *Use an object selection method*
Enter object ordering option [Above objects (page 368)/Under objects (page 368)/Front (page 368)/Back (page 368)] <Back>:

Above Objects Moves the selected object above the specified reference objects.

Under Objects Moves the selected objects below the specified reference objects.

Front Moves the selected objects to the top of the order of objects in the drawing.

Back Moves the selected objects to the bottom of the order of objects in the drawing.

When you change the draw order (display and plotting order) of multiple objects, the relative draw order of the selected objects is maintained.

By default, when you create new objects from existing ones (for example, FILLET or PEDIT), the new objects are assigned the draw order of the original object you selected first. By default, while you edit an object (for example, MOVE or STRETCH), the object is displayed on top of all objects in the drawing. When you are finished editing, your drawing is partially regenerated so that the object is displayed according to its correct draw order. This can result in some edit operations taking slightly longer. You can use DRAWORDERCTL (page 1311) to change the default draw order settings.

See also:

Control How Overlapping Objects Are Displayed

DSETTINGS

Sets grid and snap, polar and object snap tracking, object snap modes, and Dynamic Input.

Access Methods

Menu: Tools ➤ Drafting Settings

Shortcut menu: Right-click Snap Mode, Grid Display, Polar Tracking, Object Snap, Object Snap Tracking, or Dynamic Input on the status bar. Choose Settings.

Summary

The Drafting Settings dialog box (page 369) is displayed.
See also:

Use Precision Tools

Drafting Settings Dialog Box

Specifies drafting settings organized for drawing aids.

Summary

The following categories are available.

- Snap and Grid (page 369)
- Polar Tracking (page 373)
- Object Snap (page 375)
- 3D Object Snap (page 379)
- Dynamic Input (page 383)

List of Options

The following options are displayed.

Snap and Grid Tab (Drafting Settings Dialog Box)

Specifies Snap and Grid settings.
Snap On

Turns Snap mode on or off. You can also turn Snap mode on or off by clicking Snap on the status bar, by pressing F9, or by using the SNAPMODE (page 1483) system variable.

Snap Spacing

Controls an invisible, rectangular grid of snap locations that restricts cursor movement to specified X and Y intervals.

Snap X Spacing

Specifies the snap spacing in the X direction. The value must be a positive real number. (SNAPUNIT (page 1484) system variable)

Snap Y Spacing

Specifies the snap spacing in the Y direction. The value must be a positive real number. (SNAPUNIT (page 1484) system variable)

Equal X and Y Spacing
Forces the X and Y spacing to the same values for snap spacing and for grid spacing. The snap spacing intervals can be different from the grid spacing intervals.

**Polar Spacing**
Controls the PolarSnap™ increment distance.

**Polar Distance**
Sets the snap increment distance when PolarSnap is selected under Snap Type & Style. If this value is 0, the PolarSnap distance assumes the value for Snap X Spacing. The Polar Distance setting is used in conjunction with polar tracking and/or object snap tracking. If neither tracking feature is enabled, the Polar Distance setting has no effect. ([POLARDIST](page 1441) system variable)

**Snap Type**
Sets the snap style and snap type.

**Grid Snap**
Sets the snap type to Grid. When you specify points, the cursor snaps along vertical or horizontal grid points. ([SNAPTYPE](page 1484) system variable)

**Rectangular Snap:**
Sets the snap style to standard Rectangular snap mode. When the snap type is set to Grid snap and Snap mode is on, the cursor snaps to a rectangular snap grid. ([SNAPSTYL](page 1483) system variable)

**Isometric Snap**
Sets the snap style to Isometric snap mode. When the snap type is set to Grid snap and Snap mode is on, the cursor snaps to an isometric snap grid. ([SNAPSTYL](page 1483) system variable)

**PolarSnap**
Sets the snap type to Polar. When Snap mode is on and you specify points with polar tracking turned on, the cursor snaps along polar alignment angles set on the Polar Tracking tab relative to the starting polar tracking point. ([SNAPTYPE](page 1484) system variable)

**Grid On**
Turns the grid on or off. You can also turn grid mode on or off by clicking Grid on the status bar, by pressing Fn-F7, or by using the [GRIDMODE](page 1345) system variable.

**Grid Style**
Sets the grid style in 2D contexts. You can also set grid style by using the [GRIDSTYLE](page 1345) system variable.
Dot Grid in 2D Model Space
Sets the grid style to dotted grid for 2D model space. (GRIDSTYLE (page 1345) system variable)

Dot Grid in Paper Space
Sets the grid style to dotted grid for sheet and layout. (GRIDSTYLE (page 1345) system variable)

Grid Spacing
Controls the display of a grid that helps you visualize distances.

NOTE  The limits of the grid are controlled by the LIMITS (page 575) command and the GRIDDISPLAY (page 1343) system variable.

Grid X Spacing
Specifies the grid spacing in the X direction. If this value is 0, the grid assumes the value set for Snap X Spacing. (GRIDUNIT (page 1346) system variable)

Grid Y Spacing
Specifies the grid spacing in the Y direction. If this value is 0, the grid assumes the value set for Snap Y Spacing. (GRIDUNIT (page 1346) system variable)

Major Line Every
Specifies the frequency of major grid lines compared to minor grid lines. Grid lines rather than grid dots are displayed when GRIDSTYLE (page 1345) is set to 0. (GRIDMAJOR (page 1344) system variable)

Grid Behavior
Controls the appearance of the grid lines that are displayed when GRIDSTYLE (page 1345) is set to 0.

Adaptive Grid
Limits the density of the grid when zoomed out. (GRIDDISP (page 1343) system variable)
Allow Subdivision Below Grid Spacing:
Generates additional, more closely spaced grid lines when zoomed in. The frequency of these grid lines is determined by the frequency of the major grid lines. (GRIDDISP (page 1343) and GRIDMAJOR (page 1344) system variables)

Display Grid Beyond Limits
Displays the grid beyond the area specified by the LIMITS (page 575) command. (GRIDDISP (page 1343) system variable)
Follow Dynamic UCS
Changes the grid plane to follow the XY plane of the dynamic UCS. (GRIDDISPLAY (page 1343) system variable)

**Polar Tracking Tab (Drafting Settings Dialog Box)**
Controls the AutoTrack settings.

**Polar Tracking On**
Turns polar tracking on and off. You can also turn polar tracking on or off by pressing F10 or by using the AUTOSNAP (page 1217) system variable.

**Polar Angle Settings**
Sets the alignment angles for polar tracking. (POLARANG (page 1441) system variable)

**Increment Angle**
Sets the polar increment angle used to display polar tracking alignment paths. You can enter any angle, or select a common angle of 90, 45, 30, 22.5, 18, 15, 10, or 5 degrees from the list. (POLARANG (page 1441) system variable)
Additional Angles

Makes any additional angles in the list available for polar tracking. The Additional Angles check box is also controlled by the POLARMODE (page 1441) system variable, and the list of additional angles is also controlled by the POLARADDANG (page 1440) system variable.

**NOTE** Additional angles are absolute, not incremental.

List of Angles

If Additional Angles is selected, lists the additional angles that are available. To add new angles, click New. To remove existing angles, click Delete. (POLARADDANG system variable)

**New** Displays the Add New Angle dialog box. Up to 10 additional polar tracking alignment angles can be added.

**NOTE** Before adding fractional angles, you must set the AUPREC (page 1215) system variable to the appropriate decimal precision to avoid undesired rounding. For example, if the value of AUPREC is 0 (the default value), all fractional angles you enter are rounded to the nearest whole number.

Delete

Deletes selected additional angles.

**Object Snap Tracking Settings**

Sets options for object snap tracking.

**Track Orthogonally Only**

Displays only orthogonal (horizontal/vertical) object snap tracking paths for acquired object snap points when object snap tracking is on. (POLARMODE system variable)

**Track Using All Polar Angle Settings**

Applies polar tracking settings to object snap tracking. When you use object snap tracking, the cursor tracks along polar alignment angles from acquired object snap points. (POLARMODE system variable)

**NOTE** Clicking Polar and Otrack on the status bar also turns polar tracking and object snap tracking on and off.

**Polar Angle Measurement**

Sets the basis by which polar tracking alignment angles are measured.

**Absolute**

Bases polar tracking angles on the current user coordinate system (UCS).
Relative to Last Segment

Bases polar tracking angles on the last segment drawn.

**Object Snap Tab (Drafting Settings Dialog Box)**

Controls running object snap settings. With running object snap settings, also called Osnap, you can specify a snap point at an exact location on an object. When more than one option is selected, the selected snap modes are applied to return a point closest to the center of the aperture box. Press TAB to cycle through the options.

**Object Snap On**

Turns running object snaps on and off. The object snaps selected under Object Snap Modes are active while object snap is on. *(OSMODE* (page 1421) *system variable)*

**Object Snap Tracking On**

Turns object snap tracking on and off. With object snap tracking, the cursor can track along alignment paths based on other object snap points when
specifying points in a command. To use object snap tracking, you must turn on one or more object snaps. (*AUTOSNAP* (page 1217) system variable)

**Object Snap Modes**

Lists object snaps that you can turn on as running object snaps.

**Endpoint**

Snaps to the closest endpoint of an arc, elliptical arc, line, multilineline, polyline segment, spline, region, or ray, or to the closest corner of a trace, solid, or 3D face.

**Midpoint**

Snaps to the midpoint of an arc, ellipse, elliptical arc, line, multilineline, polyline segment, region, solid, spline, or xline.

**Center**

Snaps to the center of an arc, circle, ellipse, or elliptical arc.

**Node**

Snaps to a point object, dimension definition point, or dimension text origin.

**Quadrant**
Snaps to a quadrant point of an arc, circle, ellipse, or elliptical arc.

Intersection
Snaps to the intersection of an arc, circle, ellipse, elliptical arc, line, multiline, polyline, ray, region, spline, or xline. Extended Intersection is not available as a running object snap.

Interference and Extended Intersection do not work with edges or corners of 3D solids.

NOTE You might get varying results if you have both the Intersection and Apparent Intersection running object snaps turned on at the same time.

Extension
Causes a temporary extension line or arc to be displayed when you pass the cursor over the endpoint of objects, so you can specify points on the extension.

NOTE When working in perspective view, you cannot track along the extension line of an arc or elliptical arc.

Insertion
Snaps to the insertion point of an attribute, a block, a shape, or text.

Perpendicular
Snaps to a point perpendicular to an arc, circle, ellipse, elliptical arc, line, multiline, polyline, ray, region, spline, or xline. Deferred Perpendicular snap mode is automatically turned on when the object you are drawing requires that you complete more than one perpendicular snap. You can use a line, arc, circle, polyline, ray, xline, multiline, or 3D solid edge as an object from which to draw a perpendicular line. You can use Deferred Perpendicular to draw perpendicular lines between such objects. When the aperture box passes over a Deferred Perpendicular snap point, an AutoSnap tooltip and marker are displayed.
Tangent
Snaps to the tangent of an arc, circle, ellipse, elliptical arc, or spline. Deferred Tangent snap mode is automatically turned on when the object you are drawing requires that you complete more than one tangent snap. You can use Deferred Tangent to draw a line or xline that is tangent to arcs, polyline arcs, or circles. When the aperture box passes over a Deferred Tangent snap point, a marker and an AutoSnap tooltip are displayed.

NOTE When you use the From option in conjunction with the Tangent snap mode to draw objects other than lines from arcs or circles, the first point drawn is tangent to the arc or circle in relation to the last point selected in the drawing area.

Nearest
Snaps to the nearest point on an arc, circle, ellipse, elliptical arc, line, multiline, point, polyline, ray, spline, or xline.

Apparent Intersection
Snaps to the visual intersection of two objects that are not in the same plane but may appear to intersect in the current view. Extended Apparent Intersection is not available as a running object snap. Apparent and Extended Apparent Intersection do not work with edges or corners of 3D solids.

NOTE You might get varying results if you have both the Intersection and Apparent Intersection running object snaps turned on at the same time.

Parallel
Constrains a line segment, polyline segment, ray or xline to be parallel to another linear object. After you specify the first point of a linear object, specify the parallel object snap. Unlike other object snap modes, you move the cursor and hover over another linear object until the angle is acquired. Then, move the cursor back toward the object that you are creating. When the path of the
object is parallel to the previous linear object, an alignment path is displayed, which you can use to create the parallel object.

**NOTE** Turn off ORTHO mode before using the parallel object snap. Object snap tracking and polar snap are turned off automatically during a parallel object snap operation. You must specify the first point of a linear object before using the parallel object snap.

**Select All**

Turns on all object snap modes.

**Clear All**

Turns off all object snap modes.

**3D Object Snap Tab (Drafting Settings Dialog Box)**

Controls running object snap settings for 3D objects. With running object snap settings, also called Osnap, you can specify a snap point at an exact location on an object. When more than one option is selected, the selected snap modes are applied to return a point closest to the center of the aperture box. Press TAB to cycle through the options.
**3D Object Snap On**

Turns 3D object snaps on and off. The 3D object snaps selected under 3D Object Snap Modes are active while object snap is on. (*3DOSMODE* (page 1201) system variable)

**3D Object Snap Modes**

Lists the 3D object snaps modes.

**Vertex**

Snaps to the closest vertex of a 3D object.

**Midpoint on Edge**

Snaps to the midpoint of a face edge.
Center of Face
Snaps to the center of a face.

Knot
Snaps to a knot on a spline.

**Perpendicular**

Snaps to a point perpendicular to a face.
Nearest to Face
Snaps to a point that is nearest to a 3D object face.

Select All
Turns on all 3D object snap modes.

Clear All
Turns off all 3D object snap modes.

Dynamic Input Tab (Drafting Settings Dialog Box)
Controls pointer input, dimension input, dynamic prompting, and the appearance of drafting tooltips.
Enable Pointer Input

Turns on pointer input. When pointer input and dimensional input are both turned on, dimensional input supersedes pointer input when it is available. (DYNMODE (page 1317) system variable)

**Pointer Input**

Displays the location of the crosshairs as coordinate values in a tooltip near the cursor. When a command prompts you for a point, you can enter coordinate values in the tooltip instead of in the Command window.

**Preview Area**

Shows an example of pointer input.

**Settings**
Displays the Pointer Input Settings dialog box (page 386).

**Enable Dimension Input where Possible**

Turns on dimensional input. Dimensional input is not available for some commands that prompt for a second point. (DYNMODE (page 1317) system variable)

**Dimension Input**

Displays a dimension with tooltips for distance value and angle value when a command prompts you for a second point or a distance. The values in the dimension tooltips change as you move the cursor. You can enter values in the tooltip instead of on the command line.

**Preview Area**

Shows an example of dimensional input.

**Settings**

Displays the Dimension Input Settings dialog box (page 387).

**Dynamic Prompts**

Displays prompts in a tooltip near the cursor when necessary in order to complete the command. You can enter values in the tooltip instead of on the command line.

**Preview Area**

Shows an example of dynamic prompts.

**Show Command Prompting and Command Input near Crosshairs**

Displays prompts in Dynamic Input tooltips. (DYNPROMPT (page 1320) system variable)

**Show Additional Tips with Command Prompting**

Controls whether tips for using Shift and Ctrl for grip manipulation are displayed. (DYNINFOTIPS (page 1317) system variable)

**Drafting Tooltip Appearance**

Displays the Tooltip Appearance dialog box. (page 388)

See also:

Use Precision Tools
**Pointer Input Settings Dialog Box**

Controls the settings of pointer input tooltips.

**List of Options**

The following options are displayed.

**Format**

Controls coordinate format in the tooltips that are displayed when pointer input is turned on.

**Polar Format**

Displays the tooltip for the second or next point in polar coordinate format. Enter a comma (,) to change to Cartesian format. ([DYNPIFORMAT](page 1319) system variable)

**Cartesian Format**

Displays the tooltip for the second or next point in Cartesian coordinate format. Enter an angle symbol (<) to change to polar format. ([DYNPIFORMAT](page 1319) system variable)

**Relative Coordinates**

Displays the tooltip for the second or next point in relative coordinate format. Enter a pound sign (#) to change to absolute format. ([DYNPICOORDS](page 1318) system variable)

**Absolute Coordinates**

Displays the tooltip for the second or next point in absolute coordinate format. Enter an at sign ( ) to change to relative format. Note that you cannot use the direct distance method when this option is selected. ([DYNPICOORDS](page 1318) system variable)

**Visibility**

Controls when pointer input is displayed. ([DYNPIVIS](page 1319) system variable)

**As Soon As I Type Coordinate Data**

When pointer input is turned on, displays tooltips only when you start to enter coordinate data. ([DYNPIVIS](page 1319) system variable)

**When a Command Asks for a Point**

When pointer input is turned on, displays tooltips whenever a command prompts you for a point. ([DYNPIVIS](page 1319) system variable)
Always—Even When Not in a Command

Always displays tooltips when pointer input is turned on. (DYNPIVIS (page 1319) system variable)

See also:
Use Dynamic Input

**Dimension Input Settings Dialog Box**

Controls the settings of dimension input tooltips.

**List of Options**

The following options are displayed.

**Visibility**

Controls which tooltips are displayed during grip stretching when dimensional input is turned on. (DYNDIVIS (page 1316) system variable)

**Show Only 1 Dimension Input Field at a Time**

Displays only the length change dimensional input tooltip when you are using grip editing to stretch an object. (DYNDIVIS (page 1316) system variable)

**Show 2 Dimension Input Fields at a Time**

Displays the length change and resulting dimensional input tooltips when you are using grip editing to stretch an object. (DYNDIVIS (page 1316) system variable)

**Show the Following Dimension Input Fields Simultaneously**

When you are using grip editing to stretch an object, displays the dimensional input tooltips that are selected below. (DYNDIVIS (page 1316) and DYNDIGRIP (page 1315) system variables)

**Resulting Dimension**

Displays a length dimensional tooltip that is updated as you move the grip.

**Length Change**

Displays the change in length as you move the grip.

**Absolute Angle**

Displays an angle dimensional tooltip that is updated as you move the grip.
Angle Change
Displays the change in the angle as you move the grip.

Arc Radius
Displays the radius of an arc, which is updated as you move the grip.

See also:
Use Dynamic Input

Tooltip Appearance Dialog Box
Controls the appearance of tooltips.

Summary
Use the TOOLTIPMERGE (page 1517) system variable to combine drafting tooltips into a single tooltip.
For more information about tooltips, see Set Interface Options.

List of Options
The following options are displayed.

Previews
Displays an example of the current tooltip appearance settings.

Size
Specifies a size for tooltips. The default size is 0. Use the slider to make tooltips larger or smaller.

Transparency
Controls the transparency of tooltips. The lower the setting, the less transparent the tooltip. A value of 0 sets the tooltip to opaque.

Apply To
Specifies whether the settings apply to all drafting tooltips or only to Dynamic Input tooltips. (DYNTOOLTIPS (page 1320) system variable)

Override OS Settings for All Drafting Tooltips
Applies the settings to all tooltips, overriding the settings in the operating system.

Use Settings Only for Dynamic Input Tooltips
Applies the settings only to the drafting tooltips used in Dynamic Input.

See also:
Use Dynamic Input

**DVIEW**

Defines parallel projection or perspective views by using a camera and target.

**Summary**

**NOTE** Transparent ZOOM (page 1188) and PAN (page 767) are not available in DVIEW. When you define a perspective view, ZOOM, PAN, transparent ZOOM and PAN are not available while that view is current.

**List of Prompts**

The following prompts are displayed.

- Select objects (page 389) or <use>.DVIEWBLOCK (page 389)
- Enter option
  - [CAmera (page 390)/TArget (page 391)/Distance (page 392)/POints (page 393)/PAn (page 394)/Zoom (page 394)/TWist (page 395)/CLip (page 395)/Hide (page 396)/Off (page 396)/Undo (page 396)]: Specify a point (page 390) with your pointing device, or enter an option

**Object Selection**

Specifies objects to use in the preview image as you change views. Selecting too many objects slows image dragging and updating.

**DVIEWBLOCK**

If you press Enter at the Select Objects prompt, DVIEWBLOCK displays a preview image. You can create your own DVIEWBLOCK block in a 1 unit by
1 unit by 1 unit area, with its origin at the lower-left corner. The following illustration shows an example of using the default DVIEWBLOCK to set the view (moving the graphics cursor adjusts the view).

**Point Specification**
Rolls the view under the camera. The point you select with your pointing device is a start point for the dragging operation. Your viewing direction changes about the target point as you move the pointing device.

The angles must be positive. The direction angle indicates the front of the view, and the magnitude angle determines how far the view rolls.

**Camera**
Specifies a new camera position by rotating the camera about the target point. Two angles determine the amount of rotation.

**Camera Location** Sets the camera's position based on the specified point.

**Enter Angle from the XY Plane** Sets the camera's position at an angle above or below the XY plane. An angle of 90 degrees looks down from above, and an angle of -90 looks up from below. A camera angle of 0 degrees places the camera parallel to the XY plane of the user coordinate system (UCS).

**Toggle (Angle In)** Switches between two angle input modes. Entering an angle at the Command prompt locks the cursor movement so you see only the positions available for that angle. Toggle unlocks the cursor movement for the angle, and you can use the cursor to rotate the camera.
**Enter Angle in XY Plane from X Axis** Sets the position at an angle in the XY plane relative to the X axis of the current UCS. This angle measures from -180 to 180 degrees. A rotation angle of 0 degrees looks down the X axis of the UCS toward the origin.

The illustration shows the camera rotating to the left from its initial position, leaving its angle from the XY plane unchanged.

**Toggle (Angle From)** Switches between two angle input modes. Entering an angle at the Command prompt locks the cursor movement so you see only the positions available for that angle. Toggle unlocks the cursor movement for the angle, and you can use the cursor to rotate the camera.

**Target**
Specifies a new position for the target by rotating it around the camera. The effect is like turning your head to see different parts of the drawing from one vantage point. Two angles determine the amount of rotation.

**Enter Angle from the XY Plane** *Enter Angle from the XY Plane* (page 390)

**Toggle (Angle In)** *Toggle (Angle In)* (page 390)

**Enter Angle in XY Plane from X Axis** *Enter Angle in XY Plane from X Axis* (page 391) The illustration shows the effect of moving the target point from left to right, leaving its angle from the XY plane unchanged.
Toggle (Angle From) Toggle (Angle From) (page 391)

**Distance**
Moves the camera in or out along the line of sight relative to the target. This option turns on perspective viewing, which causes objects farther from the camera to appear smaller than those closer to the camera. A special perspective icon replaces the coordinate system icon. You are prompted for the new camera-to-target distance.

A slider bar along the top of the drawing area is labeled from 0x to 16x, with 1x representing the current distance. Moving the slider bar to the right increases the distance between camera and target. Moving it to the left decreases that distance. To turn off perspective viewing, click the Off option from the main DVIEW prompt.

If the target and camera points are close together, or if you specify a long-focal-length lens, you might see very little of your drawing when you specify a new distance. If you see little or none of your drawing, try the maximum scale value (16x) or enter a large distance. To magnify the drawing without turning perspective viewing on, use the Zoom option of DVIEW.
The illustration shows the effect of moving the camera along the line of sight relative to the target, where the field of view remains constant.

**Points**
Locates the camera and target points using X,Y,Z coordinates. You can use XYZ point filters.

To help you define a new line of sight, a rubber-band line is drawn from the current camera position to the crosshairs. You are prompted for a new camera location.

A rubber-band line connects the target point to the crosshairs to help you place the camera relative to the target. The illustration shows the change in view as you swap the camera and target points. Lens and distance settings are the same in each case.
For information about entering direction and magnitude angles, see Point Specification.

**Pan**
Shifts the image without changing the level of magnification.

**Zoom**
If perspective viewing is off, dynamically increases or decreases the apparent size of objects in the current viewport.

A slider bar along the top of the drawing area is labeled from 0x to 16x, with 1x representing the current scale. Moving the slider bar to the right increases the scale. Moving it to the left decreases the scale.

If perspective viewing is on, Zoom adjusts the camera lens length, which changes the field of view and causes more or less of the drawing to be visible at a given camera and target distance. The default lens length is 50mm, simulating what you’d see with a 35mm camera and a 50mm lens. Increasing the lens length is similar to switching to a telephoto lens. Decreasing the lens length widens the field of view, as with a wide-angle lens.

A slider bar along the top of the drawing area is labeled from 0x to 16x, with 1x representing the current lens length. Moving the slider bar to the right increases the lens length. Moving it to the left decreases the lens length.
Twist
Twists or tilts the view around the line of sight. The twist angle is measured counterclockwise, with 0 degrees to the right.

Clip
Clips the view, obscuring portions of the drawing that are behind or in front of the front clipping plane. The front and back clipping planes are invisible walls that you can position perpendicular to the line of sight between the camera and target.

Back Obscures objects located behind the back clipping plane.
- **Distance from Target.** Positions the back clipping plane and turns on back clipping. A positive distance places the clipping plane between the target and the camera. A negative distance places it beyond the target. You can use the slider bar to drag the clipping plane.
- **On.** Turns on back clipping at the current clipping distance.
- **Off.** Turns off back clipping.
**Front** Obscures objects located between the camera and the front clipping plane.

- **Distance from Target.** Positions the front clipping plane and turns on front clipping. A positive distance places the clipping plane between the target and the camera. A negative distance places it beyond the target. You can use the slider bar to drag the clipping plane.

- **Eye.** Positions the front clipping plane at the camera.

- **On.** Turns on front clipping. This option is available only when perspective viewing is off.

- **Off.** Turns off front clipping. This option is available only when perspective viewing is off.

**Off** Turns off both front and back clipping. If perspective viewing is on, front clipping remains on at the camera position.

**Hide**

Suppresses hidden lines on the selected objects to aid in visualization. Circles, solids, traces, regions, wide polyline segments, 3D faces, polygon meshes, and the extruded edges of objects with nonzero thickness are considered to be opaque surfaces that hide objects. This hidden line suppression is quicker than that performed by **HIDE** (page 507), but it cannot be plotted.

**Off**

Turns off perspective viewing. The Distance option turns on perspective viewing.

**Undo**

Reverses the effects of the last DVIEW action. You can undo multiple DVIEW operations.

**See also:**

Specify 3D Views
**DXBIN**

Imports an AutoCAD DXB (drawing interchange binary) file.

**Access Methods**

- **Menu**: Insert ➤ Drawing Exchange Binary

**Summary**

AutoCAD DXB files contain only 2D vectors in binary format with 16-bit integer precision. These vectors are imported as line objects, and they assume the current layer and object properties.

The Select DXB File dialog box (a standard file selection dialog box (page 723)) is displayed. Enter the name of the file to import.

**See also:**

- Convert DXF and DXB Files to DWG Format

**E Commands**

**EATTEDIT**

Edits attributes in a block reference.

**Access Methods**

- **Button**
  - **Toolbar**: Drafting tool set ➤ Block tool group ➤ Edit Attributes flyout
  - Multiple
  - **Menu**: Modify ➤ Object ➤ Attribute ➤ Single

**Summary**

Edits the values, text options, and properties of each attribute in a block.
List of Prompts

The following prompts are displayed.

Select a block:

After you select a block with attributes, the Enhanced Attribute Editor (page 398) is displayed.

See also:

Modify a Block Attribute Definition

Enhanced Attribute Editor

Lists the attributes in a selected block instance and displays the properties of each attribute.

Summary

The Enhanced Attribute Editor contains the following tabs:

- Attribute (page 398)
- Text Options (page 399)
- Properties (page 401)

List of Options

The following options are displayed.

Block

Name of the block whose attributes you are editing.

Tag

Tag identifying the attribute.

Select Block

Temporarily closes the dialog box while you select a block with your pointing device.

Attribute Tab (Enhanced Attribute Editor)

Displays the tag, prompt, and value assigned to each attribute. You can change only the attribute value.
List

Lists the attributes in the selected block instance and displays the tag, prompt, and value for each attribute.

Value

Assigns a new value to the selected attribute. Single-line attributes include a button to insert a field. When clicked, the Insert Field dialog box (page 432) is displayed. Multiple-line attributes include a button with an ellipsis. Click to open the In-Place Text Editor (page 678) with the ruler. Depending on the setting of the ATTICE (page 1212) system variable, the Attribute Editor visor displayed is either the abbreviated version, or the full version.

Text Options Tab (Enhanced Attribute Editor)

Sets the properties that define the way an attribute's text is displayed in the drawing. Change the color of attribute text on the Properties tab.
Rotation
Specifies the rotation angle of the attribute text.

Oblique Angle
Specifies the angle that the attribute text is slanted away from its vertical axis. Not available for multiple-line attributes.

Height
Specifies the height of the attribute text.

Width Factor
Sets the character spacing for the attribute text. Entering a value less than 1.0 condenses the text. Entering a value greater than 1.0 expands it.

Multiline Text Width
Specifies the maximum length of the lines of text in a multiple-line attribute before wrapping to the next line. A value of 0.000 means that there is no restriction on the length of a line of text. Not available for single-line attributes.

Text Style
Specifies the text style for the attribute text. Default values for this text style are assigned to the text properties displayed in this dialog box.
**Backwards**
Specifies whether or not the attribute text is displayed backwards. Not available for multiple-line attributes.

**Upside Down**
Specifies whether or not the attribute text is displayed upside down. Not available for multiple-line attributes.

**Annotative**
Specifies that the attribute is annotative. Click the information icon to learn more about annotative objects.

**Justification**
Specifies how the attribute text is justified (left-, center-, or right-justified).

**Properties Tab (Enhanced Attribute Editor)**
Defines the layer that the attribute is on and the lineweight, linetype, and color for the attribute text. If the drawing uses plot styles, you can assign a plot style to the attribute using the Properties tab.

![Enhanced Attribute Editor](image)

**Layer**
Specifies the layer that the attribute is on.
Linetype
Specifies the linetype of the attribute.

Color
Specifies the color of the attribute.

Lineweight
Specifies the linewidth of the attribute. Changes you make to this option are not displayed if the LWDISPLAY (page 1404) system variable is off.

Plot Style
Specifies the plot style of the attribute. If the current drawing uses color-dependent plot styles, the Plot Style list is not available.

See also:
Modify a Block Attribute Definition

EDGE
Changes the visibility of 3D face edges.

Summary
This command only affects objects created using the 3DFACE command.

List of Prompts
The following prompts are displayed.
Specify edge of 3D face to toggle visibility or [Display]:

Edge of 3D face to toggle visibility
Controls the visibility of the edges you select.
If the edges of one or more 3D faces are collinear, the program alters the visibility of each collinear edge.

**Display**
Selects invisible edges of 3D faces so that you can redisplay them.

![Image of 3D model with hidden edges]

**All** Selects the hidden edges of all 3D faces in the drawing and displays them. If you want to make the edges of the 3D faces visible once again, use the Edge option. You must select each edge with your pointing device to display it. AutoSnap™ markers and Snaptips are automatically displayed, indicating the apparent snap locations on each invisible edge.

**Select** Selects hidden edges of a partially visible 3D face and displays them.

![Image of partially visible 3D model with hidden edges]

If you want to make the edges of the 3D faces visible once again, use the Edge option. You must select each edge with your pointing device to display it. AutoSnap markers and Snaptips are automatically displayed, indicating the apparent snap locations on each invisible edge.

**See also:**
Modify 3D Subobjects

**EDGESURF**

Creates a mesh between four contiguous edges or curves.

**Access Methods**

- **Menu:** Draw ➤ 3D Modeling ➤ Meshes ➤ Edge Mesh

- **E Commands:**
Summary

Select four adjoining edges that define the mesh. The edges can be lines, arcs, splines, or open polylines. The edges must touch at their endpoints to form a single, closed loop.

You can select the four edges in any order. The first edge (SURFTAB1 (page 1500)) determines the M direction of the generated mesh, which extends from the endpoint closest to the selection point to the other end. The two edges that touch the first edge form the N edges (SURFTAB2 (page 1500)) of the mesh.

The MESHTYPE (page 1408) system variable sets which type of mesh is created. Mesh objects are created by default. Set the variable to 0 to create legacy polyface or polygon mesh.

List of Prompts

The following prompts are displayed.

Object 1 for surface edge Specifies the first edge to be used as a boundary.
Object 2 for surface edge Specifies the second edge to be used as a boundary.
Object 3 for surface edge Specifies the third edge to be used as a boundary.
Object 4 for surface edge Specifies the final edge to be used as a boundary.

See also:

Create Meshes from Other Objects
Edit PGP

Opens the Program Parameters (PGP) text file that defines command abbreviations

Access Methods

Button

Menu: Tools ➤ Customize ➤ Edit Command Aliases (PGP)

Summary

Commands can have abbreviated names called command aliases that you can enter at the Command prompt. Command aliases are defined in the PGP file.

If you edit the PGP file while the program is running, enter RE-INIT and then a value of 16 to use the revised file. You can also restart the program to reload the file automatically.

See also:

Enter Commands on the Command Line

ELEV

Sets elevation and extrusion thickness of new objects.

Access Methods

Command entry: 'elev' for transparent use

Summary

The ELEV command sets the default Z value for new objects above or below the XY plane of the current UCS. This value is stored in the ELEVATION system variable.

NOTE Generally, it is recommended that you leave the elevation set to zero and control the XY plane of the current UCS with the UCS (page 1106) command.
ELEV controls only new objects; it does not affect existing objects. The elevation is reset to 0.0 whenever you change the coordinate system to the world coordinate system (WCS).

**List of Prompts**

The following prompts are displayed.

**Specify New Default Elevation** The current elevation is the default Z value for new objects when you specify only X and Y values for a 3D point. The elevation setting is the same for all viewports regardless of their user coordinate systems (UCS definitions). New objects are created at the specified Z value relative to the current UCS in the viewport.

**Specify New Default Thickness** The thickness sets the distance to which a 2D object is extruded above or below its elevation. A positive value is extruded along the positive Z axis; a negative value is extruded along the negative Z axis.

See also:

Control the User Coordinate System (UCS)

**ELLIPSE**

Creates an ellipse or an elliptical arc.

**Access Methods**

Button
Summary

The first two points of the ellipse determine the location and length of the first axis. The third point determines the distance between the center of the ellipse and the end point of the second axis.

List of Prompts

The following prompts are displayed.
Specify axis endpoint (page 407) of ellipse or [Arc (page 408)/Center (page 409)/Isocircle (page 410)]: Specify a point or enter an option

Axis Endpoint
Defines the first axis by its two endpoints. The angle of the first axis determines the angle of the ellipse. The first axis can define either the major or the minor axis of the ellipse.

Distance to Other Axis Defines the second axis using the distance from the midpoint of the first axis to the endpoint of the second axis (3).

Rotation Creates the ellipse by appearing to rotate a circle about the first axis.
Move the crosshairs around the center of the ellipse and click. If you enter a value, the higher the value, the greater the eccentricity of the ellipse. Entering 0 defines a circular ellipse.

**Arc**
Creates an elliptical arc.

The angle of the first axis determines the angle of the elliptical arc. The first axis can define either the major or the minor axis depending on its size.

The first two points of the elliptical arc determine the location and length of the first axis. The third point determines the distance between the center of the elliptical arc and the endpoint of the second axis. The fourth and fifth points are the start and end angles.

**Rotation** Defines the major to minor axis ratio of the ellipse by rotating a circle about the first axis. The higher the value from 0 through 89.4 degrees, the greater the ratio of minor to major axis. Values between 89.4 degrees and 90.6 degrees are invalid because the ellipse would otherwise appear as a straight line. Multiples of these angle values result in a mirrored effect every 90 degrees.

**Start Angle** Defines the first endpoint of the elliptical arc. The Start Angle option toggles from Parameter mode to Angle mode. The mode controls how the ellipse is calculated.
**Parameter** Requires the same input as Start Angle, but creates the elliptical arc using the following parametric vector equation:

\[ p(u) = c + a \cos(u) + b \sin(u) \]

where \( c \) is the center of the ellipse and \( a \) and \( b \) are its major and minor axes, respectively.

- **End Parameter:** Defines the end angle of the elliptical arc by using a parametric vector equation. The Start Parameter option toggles from Angle mode to Parameter mode. The mode controls how the ellipse is calculated.

- **Angle:** Defines the end angle of the elliptical arc. The Angle option toggles from Parameter mode to Angle mode. The mode controls how the ellipse is calculated.

- **Included Angle:** Defines an included angle beginning at the start angle.

**Center**

Creates an ellipse using a center point, the endpoint of the first axis, and the length of the second axis. You can specify the distances by clicking a location at the desired distance or by entering a value for the length.

**Distance to Other Axis** Defines the second axis as the distance from the center of the ellipse, or midpoint of the first axis, to the point you specify.

**Rotation** Creates the ellipse by appearing to rotate a circle about the first axis. Move the crosshairs around the center of the ellipse and click. If you enter a value, the higher the value, the greater the eccentricity of the ellipse. Entering 0 defines a circle.
**Isocircle**  
Creates an isometric circle in the current isometric drawing plane.  

**NOTE** The Isocircle option is available only when you set the Style option of SNAP (page 986) to Isometric.

---

**Radius** Creates a circle using a radius you specify.  
**Diameter** Creates a circle using a diameter you specify.  
Specify diameter of isocircle: *Specify a distance*

**See also:**  
Draw Ellipses

---

**ERASE**

Removes objects from a drawing.

**Access Methods**

- **Button**
  - Toolbar: Drafting tool set ➤ Explode and Erase tool group ➤ Erase
  - Menu: Modify ➤ Erase
  - Shortcut menu: Select the objects to erase, right-click in the drawing area, and click Erase.

**Summary**

You can erase selected objects from the drawing. This method does not move objects to the Clipboard, where they can then be pasted to another location.

If you are working with 3D objects, you can also erase subobjects such as faces, meshes, and vertices.
Instead of selecting objects to erase, you can enter an option, such as L to erase the last object drawn, p to erase the previous selection set, or ALL to erase all objects. You can also enter ? to get a list of all options.

See also:
Erase Objects

**EXPLODE**

Breaks a compound object into its component objects.

**Access Methods**

Button

뇌 Toolbar: Drafting tool set ➤ Explode and Erase tool group ➤ Explode
뇌 Menu: Modify ➤ Explode

**Summary**

Explodes a compound object when you want to modify its components separately. Objects that can be exploded include blocks, polylines, and regions, among others.
The color, linetype, and lineweight of any exploded object might change. Other results differ depending on the type of compound object you’re exploding. See the following list of objects that can be exploded and the results for each.

To explode objects and change their properties at the same time, use XPL ode (page 1184).

**NOTE** If you're using a script or an Object ARX® function, you can explode only one object at a time.

2D and Lightweight Polyline Discards any associated width or tangent information. For wide polylines, the resulting lines and arcs are placed along the center of the polyline.

![before EXPLODE](image1) ![after EXPLODE](image2)

3D Polyline Explodes into line segments. Any linetype assigned to the 3D polyline is applied to each resulting line segment.

3D Solid Explodes planar faces into regions. Nonplanar faces explode into surfaces.

Annotative Objects Explodes the current scale representation into its constituent parts which are no longer annotative. Other scale representations are removed.

Arc If within a nonuniformly scaled block, explodes into elliptical arcs.
Block Removes one grouping level at a time. If a block contains a polyline or a nested block, exploding the block exposes the polyline or nested block object, which must then be exploded to expose its individual objects.

Blocks with equal X, Y, and Z scales explode into their component objects. Blocks with unequal X, Y, and Z scales (nonuniformly scaled blocks) might explode into unexpected objects.

When nonuniformly scaled blocks contain objects that cannot be exploded, they are collected into an anonymous block (named with a “*E” prefix) and referenced with the nonuniform scaling. If all the objects in such a block cannot be exploded, the selected block reference will not be exploded. Body, 3D Solid, and Region entities in a nonuniformly scaled block cannot be exploded.

Exploding a block that contains attributes deletes the attribute values and redisplay their attribute definitions.

Blocks inserted with MINsert (page 646) and external references (xrefs) and their dependent blocks cannot be exploded.

Body Explodes into a single-surface body (nonplanar surfaces), regions, or curves.

Circle If within a nonuniformly scaled block, explodes into ellipses.

Leaders Explodes into lines, splines, solids (arrow heads), block inserts (arrow heads, annotation blocks), multiline text, or tolerance objects, depending on the leader.

Mesh Objects Explodes each face into a separate 3D face object. Color and materials assignments are retained.

Multiline Text Explodes into text objects.

Multiline Explodes into lines and arcs.

Polyface Mesh Explodes one-vertex meshes into a point object. Two-vertex meshes explode into a line. Three-vertex meshes explode into 3D faces.

Region Explodes into lines, arcs, or splines.

See also:

Disassociate Compound Objects (Explode)
EXPORT

Saves the objects in a drawing to a different file format.

Access Methods

Menu: File ➤ Export

Summary

The Export Data dialog box (a standard file selection dialog box (page 723)) is displayed.

If you do not see the file format that you need in the Files of Type drop-down list, also check the PLOT command for other file types, including PDF.

NOTE The Export Data dialog box records the last used file format selection and stores it for use during the current drawing session and between drawing sessions.

The following output types are available:
- **ACIS (*.sat):** ACIS solid object file (see ACISOUT (page 56))
- **Bitmap (*.bmp):** Device-independent bitmap file (see BMPOUT (page 153))
- **Block (*.dwg):** Drawing file (see WBLOCK (page 1160))
- **DXX Extract (*.dxx):** Attribute extract DXF™ file (see -ATTEXT (page 126))
- **Encapsulated PS (*.eps):** Encapsulated PostScript file
- **Lithography (*.stl):** Solid object stereolithography file (see STLOUT (page 1037))
- **PDF Files (*.pdf):** Portable Document file (see PLOT (page 803))

See also:
Export Drawings to Other File Formats

EXTEND

Extends objects to meet the edges of other objects.
Access Methods

Button

_toolbar: Drafting tool set ➤ Modify tool group ➤ Extend
_menu: Modify ➤ Extend

Summary

To extend objects, first select the boundaries. Then press Enter and select the objects that you want to extend. To use all objects as boundaries, press Enter at the first Select Objects prompt.

List of Prompts

The following prompts are displayed.
Current settings: Projection = current, Edge = current
Select boundary edges...
Select objects (page 415) or <select all>: Select one or more objects and press Enter, or press Enter to select all displayed objects
Select object to extend (page 415) or shift-select to trim (page 416) or [Fence (page 416)/Crossing (page 416)/Project (page 416)/Edge (page 417)/Undo (page 418)]: Select objects to extend, or hold down Shift and select an object to trim, or enter an option

Boundary Object Selection
Uses the selected objects to define the boundary edges to which you want to extend an object.

Object to Extend
Specifies the objects to extend. Press Enter to end the command.
**Shift-Select to Trim**
Trims the selected objects to the nearest boundary rather than extending them. This is an easy method to switch between trimming and extending.

**Fence**
Selects all objects that cross the selection fence. The selection fence is a series of temporary line segments that you specify with two or more fence points. The selection fence does not form a closed loop.

**Crossing**
Selects objects within and crossing a rectangular area defined by two points.

**NOTE** Some crossing selections of objects to be extended are ambiguous. EXTEND resolves the selection by following along the rectangular crossing window in a clockwise direction from the first point to the first object encountered.

**Project**
Specifies the projection method used when extending objects.

- **None** Specifies no projection. Only objects that intersect with the boundary edge in 3D space are extended.

- **UCS** Specifies projection onto the XY plane of the current user coordinate system (UCS). Objects that do not intersect with the boundary objects in 3D space are extended.
**View** Specifies projection along the current view direction.

**Edge**
Extends the object to another object's implied edge, or only to an object that actually intersects it in 3D space.

**Extend** Extends the boundary object along its natural path to intersect another object or its implied edge in 3D space.

**No Extend** Specifies that the object is to extend only to a boundary object that actually intersects it in 3D space.
**Undo**  
Reverses the most recent changes made by EXTEND.

**See also:**  
Trim or Extend Objects

---

**EXTERNALREFERENCES**

Opens the Reference Manager palette.

**Access Methods**

Menu: Insert ➤ References Manager

**Summary**

The EXTERNALREFERENCES command opens the Reference Manager palette (page 418) when the palette is closed.

**NOTE** The FILEDIA (page 1334) system variable is ignored when attaching files from the Reference Manager palette.

**See also:**  
Attach and Detach Referenced Drawings

---

**Reference Manager Palette**

Manage external references attached to the current drawing.
Summary

The Reference Manager palette organizes, displays, and manages referenced files. The referenced files that can be managed from the Reference Manager palette are:

- External drawings (xrefs)
- Raster images
- Underlays (PDF files)
The Reference Manager palette contains a toolbar along the top. You can right-click over the files list to display a shortcut menu that allows you to attach or manage an attached external reference. Click the Show Details button on the toolbar to view details and thumbnail preview for the selected external reference.

See also:
Attach and Detach Referenced Drawings

Reference Manager Palette Toolbar

Use the toolbar at the top of the Reference Manager palette to attach a drawing and to refresh the status of a referenced file.

List of Options

The following options are displayed.

**Attach Reference**
Displays the Select Reference File dialog box. Select the file format you want to attach and then the file you want to attach to the drawing.

You can choose from the following reference file types:

- **Drawing (DWG) files.** Starts the XATTACH (page 1172) command.
- **Raster image files.** Starts the IMAGEATTACH (page 514) command.
- **PDF files.** Starts the PDFATTACH (page 772) command.

**Edit Reference**
Opens the selected file reference for edit in the current drawing window. (REFEDIT (page 883) command)

**Toggle References State**
Unloads the selected file reference or reloads the file reference if it is currently unloaded.

**Detach Referenced File**
Detaches the selected file reference from the drawing.

**Refresh Content**
Synchronizes the status of the selected file reference with the data in memory.
**Relink File**
Displays the Select <Reference Type> File to Relink dialog box where you can update the location of the selected file reference.

**Show Details**
Displays the Details and Preview panel (page 424) which displays a thumbnail preview and details for the selected file reference.

**See also:**
Attach and Detach Referenced Drawings

**File References Panel Shortcut Menus**
When working in the File References panel, there are several shortcut menus that can be displayed when you right-click on a file reference or an empty area. The following tables show the shortcut menu items that you are presented under certain conditions.

**Current Drawing File Selected**
When the current drawing file is selected, the top node in the tree, the shortcut menu presents the following functions:

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Details</td>
<td>Displays the thumbnail preview and details for the selected file reference.</td>
</tr>
<tr>
<td>Open a Copy</td>
<td>Opens the drawing in a new drawing window as read-only.</td>
</tr>
<tr>
<td>Reveal in Finder</td>
<td>Opens Finder and displays the location where the current drawing file is stored.</td>
</tr>
<tr>
<td>Print</td>
<td>Displays the Print dialog box.</td>
</tr>
<tr>
<td>Reload</td>
<td>Reloads all file referenced files attached to the current drawing. (Unavailable if no file references are attached.)</td>
</tr>
</tbody>
</table>
Menu Item | Description
--- | ---
Close File | Closes the drawing file. If changes were made, you are prompted to save or discard them before the drawing can be closed.

**No File Reference Selected**

When no file reference is selected, the shortcut menu presents the following functions:

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attach Reference</td>
<td>Displays the Select Reference File dialog box.</td>
</tr>
<tr>
<td>Reload All References</td>
<td>Reloads all file referenced files attached to the current drawing. (Unavailable if no file references are attached.)</td>
</tr>
</tbody>
</table>

**File Reference Selected**

When you select a file reference, the shortcut menu presents the following functions:

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
<th>Reference Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show in Model</td>
<td>Zooms to the location of the file reference attachment in the drawing so it is fully displayed in the drawing area.</td>
<td>Available only for file references with a Loaded status - Unavailable when Unloaded, Not Found or Unresolved.</td>
</tr>
<tr>
<td>Edit Xref in Place</td>
<td>Opens the selected file reference for edit in the current drawing window.</td>
<td>Available only for DWG file references with a Loaded status - Unavailable when Unloaded, Not Found or Unresolved.</td>
</tr>
<tr>
<td>Open File</td>
<td>Opens the selected file reference in the default editor (specified by the operating system).</td>
<td>Available only for file references with a Loaded status - Unavailable when Unloaded, Not Found or Unresolved.</td>
</tr>
<tr>
<td>Menu Item</td>
<td>Description</td>
<td>Reference Status</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show Details</td>
<td>Displays the thumbnail preview and details for the selected file reference.</td>
<td>Always available - status has no affect on this function.</td>
</tr>
<tr>
<td>Reveal in Finder</td>
<td>Opens Finder and displays the location where the file reference is stored.</td>
<td>Available only for file references with a Loaded status - Unavailable when Unloaded, Not Found or Unresolved.</td>
</tr>
<tr>
<td>Attach</td>
<td>Switches the selected DWG file reference to the Attach attachment type.</td>
<td>Always available for DWG file references - status has no affect on this function.</td>
</tr>
<tr>
<td>Overlay</td>
<td>Switches the selected DWG file reference to the Overlay attachment type.</td>
<td>Always available for DWG file references - status has no affect on this function.</td>
</tr>
<tr>
<td>Unload</td>
<td>Unloads the selected file references.</td>
<td>Always available - status has no affect on this function.</td>
</tr>
<tr>
<td>Reload</td>
<td>Reloads the selected file reference.</td>
<td>Always available - status has no affect on this function.</td>
</tr>
<tr>
<td>Relink File</td>
<td>Displays the Select <code>&lt;Reference Type&gt;</code> File to Relink dialog box where you can update the location of the selected file reference.</td>
<td>Always available - status has no affect on this function.</td>
</tr>
<tr>
<td>Bind</td>
<td>Binds the selected DWG reference to the current drawing. Xref-dependent named objects are changed from <code>blockname\definitionname</code> to <code>blockname\$\$definitionname</code> syntax. In this manner, unique named objects are created for all xref-dependent definition tables bound to the current drawing.</td>
<td>Available only for DWG file references with a Loaded status - Unavailable when Unloaded, Not Found or Unresolved.</td>
</tr>
</tbody>
</table>
### Menu Item | Description | Reference Status
---|---|---
**Bind-Insert** | Binds the DWG reference to the current drawing in a way similar to detaching and inserting the reference drawing. Rather than being renamed using `blockname$\_n$definitionname` syntax, xref-dependent named objects are stripped of the xref name. As with inserting drawings, no name-incrementing occurs if a local named object shares the same name as a bound xref-dependent named object. The bound xref-dependent named object assumes the properties of the locally defined named object. | Available only for DWG file references with a Loaded status - Unavailable when Unloaded, Not Found or Unresolved.  
**Detach** | Detaches the selected file reference. | Available for all file reference types.

**See also:**
Attach and Detach Referenced Drawings

### Details and Preview Panel

The Details and Preview panel, located below the File References panel, allows you to get information about the file reference in AutoCAD and information about the file on disk.
List of Options

The following options are displayed.

**Details**
Each file reference shares a common set of properties. Referenced images, display additional properties specific to the file type. The common set of details displayed for each file reference is name, status, file size, file type, creation date, saved path, and found at path. Some of the properties can be edited.

**Reference Name** Displays the file reference name. This property is editable for all file reference types.

**Status** Shows whether the file reference is loaded, unloaded or not found. This property cannot be edited.

**Size** Shows the file size of the selected file reference. The size is not displayed for file references that are not found. This property cannot be edited.

**Type** Indicates whether the file reference is an attachment or overlay, or the type of raster image file. This property cannot be edited. However, if the file reference is a DWG, the property can be toggled from the File Reference panel.
**Date** Displays the last date the file reference was modified. This date is not displayed if the file reference is not found. This property cannot be edited.

**Found At** Displays the absolute path of the selected file reference. This property cannot be edited.

**Saved Path** Displays the save location of the selected file reference. This is where the referenced file is saved and is not necessarily the same as the Found At location. Clicking the Open button displays the Open dialog box where you can select a different path or file name. You can also type directly into the path field. These changes are stored to the Saved Path property if the new path is valid.

**DWG Specific Properties**
If you select a referenced DWG (xref), additional properties are displayed. None of the added image properties can be edited.

**Block Unit** Specifies the INSUNITS (page 1373) value for the inserted block.

**Unit factor** Displays the unit scale factor, which is calculated based on the INSUNITS (page 1373) value of the block and the drawing units.

**Image Specific Properties**
If you select a referenced image, additional properties are displayed. None of the added image properties can be edited.

**Color System** Displays the color system.

**Color Depth** The amount of information that is stored in each pixel of a raster image. Higher color depth values produce smoother degrees of shading.

**Pixel Width** The width of the raster image measured in pixels.

**Pixel Height** The height of the raster image measured in pixels.

**Resolution** The width and height resolution in dots per inch (dpi).

**Default Size** The width and height of the raster image measured in AutoCAD units.

**Thumbnail Preview**
The thumbnail preview displays a small image of the file reference that was selected from the File References panel. If there is no preview available, the text “Preview not available” is displayed in the center of the pane.

**See also:**

Attach and Detach Referenced Drawings
EXTERNALREFERENCESCLOSE

Closes the Reference Manager palette.

Summary

The EXTERNALREFERENCESCLOSE command closes the Reference Managers palette (page 418) when currently displayed.

See also:

Attach and Detach Referenced Drawings

EXTRUDE

Creates a 3D solid or surface by extending a 2D or 3D curve.

Access Methods

Button

 Toolbar: Modeling tool set ➤ Solids - Create tool group ➤ Extrude
 Menu: Draw ➤ 3D Modeling ➤ Extrude

Summary

Extrusions can extend in the Z direction or be set to taper or follow a path. You can extrude an open or closed object to create a 3D surface or solid.

[Diagram of extrusion process]
The **DELOBJ** (page 1251) system variable controls whether the object(s) and path (if selected) are automatically deleted when the solid or surface is created or whether you are prompted to delete the object(s) and path.

You can use the following objects and subobjects with EXTRUDE:

### Objects That Can Be Extruded or Used as Paths

<table>
<thead>
<tr>
<th>Object type</th>
<th>Can be extruded?</th>
<th>Can be extrusion path?</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>3D faces</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Arcs</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Circles</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Ellipses</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Elliptical arcs</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Helixes</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Lines</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Meshes: faces</td>
<td>X</td>
<td></td>
<td>The MESHEXTRUDE command may provide better results.</td>
</tr>
<tr>
<td>Meshes: edges</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2D Polylines</td>
<td>X</td>
<td>X</td>
<td>2D polylines with crossing segments cannot be extruded. Thickness and width are ignored. The extrusion extends from the center line.</td>
</tr>
<tr>
<td>3D Polylines</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>
List of Prompts

The following prompts are displayed.

**Objects to Extrude** Specifies the objects to extrude.

![select object]

**NOTE** Select face and edge subobjects by pressing Ctrl while you select them.

**Mode** Controls whether the extruded object is a solid or a surface. Surfaces are extruded as either NURBS surfaces or procedural surfaces, depending on the SURFACEMODELINGMODE system variable.

**Height of extrusion** Extrudes selected objects along the positive or negative Z axis. The direction is based on the UCS that was current when the object was created, or (for multiple selections) on the original UCS of the most recently created object.
**Direction** Specifies the length and direction of the extrusion with two specified points. (The direction cannot be parallel to the plane of the sweep curve created by the extrusion.)

**Path** Specifies the extrusion path based on a selected object. The path is moved to the centroid of the profile. Then the profile of the selected object is extruded along the chosen path to create solids or surfaces.

**NOTE** Select face and edge subobjects by pressing Ctrl while you select them.

The path should not lie on the same plane as the object, nor should the path have areas of high curvature.

The extrusion starts from the plane of the object and maintains its orientation relative to the path.

If the path contains segments that are not tangent, the program extrudes the object along each segment and then miters the joint along the plane bisecting the angle formed by the segments. If the path is closed, the object should lie on the miter plane. This allows the start and end sections of the solid to match up. If the object is not on the miter plane, the object is rotated until it is on the miter plane.

Objects with multiple loops are extruded so that all of the loops appear on the same plane at the end section of the extruded solid.

**Taper angle** Specifies the taper angle for the extrusion.
Positive angles taper in from the base object. Negative angles taper out. The default angle, 0, extrudes a 2D object perpendicular to its 2D plane. All selected objects and loops are tapered to the same value.

Specifying a large taper angle or a long extrusion height can cause the object or portions of the object to taper to a point before reaching the extrusion height.

Individual loops of a region are always extruded to the same height.

When an arc is part of a tapered extrusion, the angle of the arc remains constant, and the radius of the arc changes.

- **Angle of taper.** Specifies the taper between -90 and +90 degrees.
- **Specify two points.** Specifies the taper angle based on two specified points. The taper angle is the distance between the two specified points.

Drag the cursor horizontally to specify and preview the taper angle. You can also drag the cursor to adjust and preview the height of the extrusion. The dynamic input origin should be placed on the extruded shape, on the projection of the point to the shape.

When you select the extruded object, the position of the taper grip is the correspondent point of the dynamic input origin on the top face of the extrusion.

**Expression** Enter a formula or equation to specify the extrusion height. See Constrain a Design with Formulas and Equations.

**See also:**

Create a Solid or Surface by Extruding
F Commands

FIELD

Creates a multiline text object with a field that can be updated automatically as the field value changes.

Access Methods

Button

Toolbar: Annotation tool set ➤ Fields tool group ➤ Insert Field

Menu: Insert ➤ Field

Shortcut menu: Right-click while editing text in an in-place text editor, and click Insert Field.

Summary

Fields can be inserted in any kind of text except tolerances. The FIELDDEVAL system variable and the UPDATEFIELD command determine how fields are updated.

The Insert Field dialog box (page 432) is displayed.

See also:

Use Fields in Text

Insert Field Dialog Box

Inserts a field in the drawing.
Summary

The options available change based on the selected field category and field name.

List of Options

The following options are displayed.

Field Category Sets the types of fields to be listed under Field Names (for example, Date & Time, Document, and Objects).

Field Names Lists the fields that are available in a category. Select a field name to display the options available for that field.

Preview Displays the current value of the field, or displays an empty string (----) if the field value is invalid.

The label for this item can vary based on the selected field name. For example, when Date is selected in the Field Names list, the label is Format and the selected date format is displayed; for example, M/d/yyyy.

Format List Lists options for display of the value of the field. For example, date fields can display the name of the day or not, and text strings can be uppercase, lowercase, first capital, or title case. The value displayed in the Fields dialog box reflects the format that you select.

Field Expression Displays the expression that underlies the field. The field expression cannot be edited, but you can learn how fields are constructed by reading this area.

Options for Project and Layout View Fields

Project Specifies the name of the project.
Use the list to choose one of the loaded project data (DST) files or click Load Project to load a project data file that is not currently loaded in the Project Manager.

**Project Navigation Tree** Displays a tree view of layouts or layout views in the selected project data (DST) file, from which you can select an item for the field.

**Property** Displays the properties available as fields for the item selected in the Project Navigation tree.

**NOTE** If you recreate the field, because the layout is already in a project, you should use a project property field, not a placeholder field.

Project fields (fields that were selected from the Project category) behave differently than other types of fields. By default, other types of fields update automatically when you save the drawing or when you use `REGEN` (page 889). In contrast, project fields store the last values that were used, and they display these stored values if the information referenced by the project field is not accessible. To update the value in a project field, use `UPDATEFIELD` (page 1135) command.

**NOTE** If the information referenced by a project field is not accessible, the value for the field will be displayed as “####.”

**Options for ProjectPlaceholder Fields**

**Type** Displays a list of available placeholder fields.

**Custom** When Type is set to Custom, you can enter the name of a custom property.

**Options for Fields in the Objects Field Category**

**Named Object Type/Object Type** When NamedObject is selected in Field Names, lists the types of named objects in the drawing. When Object is selected, displays the type of object selected. Use the Select Object button to temporarily close the dialog box and select an object in the drawing.

**Property/Name** When NamedObject is selected in Field Names, lists the names of all the objects in the drawing of the selected type. When Object is selected in Field Names, lists the properties of the selected object that are available as fields. When a block with attributes is selected, the attribute names are displayed in the list of properties.

**Formula**

When Formula is selected in Field Names, provides a place for creating a formula to insert in text or in a table cell.
Average/Sum/Count  When Formula is selected in Field Names, closes the Field dialog box temporarily while you specify table cells. The result is appended to the formula.

Cell  When Formula is selected in Field Names, closes the Field dialog box temporarily while you specify a table cell. The cell address is appended to the formula.

Precision  Specifies precision for fields based on the selected format. Select Current Precision to use the current setting of the LUPREC (page 1403) system variable.

Additional Format  Displays the Additional Format dialog box (page 1068).

See also:
  Use Fields in Text

**FILL**

Controls the filling of objects such as hatches, 2D solids, and wide polylines.

**List of Prompts**

The following prompts are displayed.

Enter mode [ON (page 435)/OFF (page 435)] <current>: Enter on or off, or press Enter

On  Turns on Fill mode. For the filling of a 3D object to be visible, its extrusion direction must be parallel to the current viewing direction, and hidden lines must not be suppressed.

Off  Turns off Fill mode. Only the outlines of objects are displayed and plotted. Changing Fill mode affects existing objects after the drawing is regenerated. The display of lineweights is not affected by the Fill mode setting.
Fill mode off

See also:

Control the Display of Polylines, Hatches, Gradient Fills, Lineweights, and Text

**FILLET**

Rounds and fillets the edges of objects.

**Access Methods**

- **Button**
  - Toolbar: Drafting tool set ➤ Modify tool group ➤ Fillet
  - Menu: Modify ➤ Fillet

**Summary**

In the example, an arc is created that is tangent to both of the selected lines. The lines are trimmed to the ends of the arc. To create a sharp corner instead, enter a radius of zero.
You can fillet arcs, circles, ellipses, elliptical arcs, lines, polylines, rays, splines, and xlines.

You can also fillet 3D solids and surfaces. If you select a mesh object for filleting, you can choose to convert the mesh to a solid or surface and continue the operation.

**List of Prompts**

The following prompts are displayed.

Current settings: Mode = *current*, Radius = *current*

Select first object (page 437) or [Undo (page 439)/Polyline (page 439)/Radius (page 440)/Trim (page 440)/Multiple (page 440)]: *Use an object selection method or enter an option*

**First Object**

Selects the first of two objects required to define a 2D fillet or selects the edge of a 3D solid to round or fillet the edge.

![First selected object](image)

Select second object or shift-select to apply corner: *Use an object selection method or hold down Shift and select an object to create a sharp corner*

If you select lines, arcs, or polylines, their lengths adjust to accommodate the fillet arc. You can hold down Shift while selecting the objects to override the current fillet radius with a value of 0.

If the selected objects are straight line segments of a 2D polyline, they can be adjacent or separated by one other segment. If they are separated by another polyline segment, FILLET deletes the segment that separates them and replaces it with the fillet.

More than one fillet can exist between arcs and circles. Select the objects close to where you want the endpoints of the fillet.
FILLET does not trim circles; the fillet arc meets the circle smoothly.

If you select a 3D solid, you can select multiple edges, but you must select the edges individually.

Enter fillet radius <current>: Specify a distance or press Enter
Select an edge or [Chain/Loop/Radius]: Select edge(s), enter c, l, or r
**Edge**
Selects a single edge. You can continue to select single edges until you press Enter.

![Selecting edges](image1.png) ![Single edge fillets](image2.png)

If you select three or more edges that converge at a vertex to form the corner of a box, FILLET computes a vertex blend that is part of a sphere if the three incident fillets have the same radii.

**Chain**
Changes from selection of single edges to selection of sequential tangent edges, called a *chain* selection.

**Edge Chain** Selects a tangential sequence of edges when you select a single edge. For example, if you select an edge on the top of a 3D solid box, FILLET also selects the other tangential edges on the top.

![Chain fillets](image3.png)

**Edge** Switches to a single-edge selection mode.

**Loop**
Specifies a loop of edges on the face of a solid. For any edge, there are two possible loops. After selecting a loop edge, you are prompted to *Accept* the current selection, or choose the *Next* loop.

**Radius**
Defines the radius of the rounded edge.

**Undo**
Reverses the previous action in the command.

**Polyline**
Inserts fillet arcs at each vertex of a 2D polyline where two line segments meet.
Select 2D polyline:

If one arc segment separates two line segments that converge as they approach the arc segment, FILLET removes the arc segment and replaces it with a fillet arc.

![Before and After Fillet](image)

**Radius**

Defines the radius of the fillet arc.

The value you enter becomes the current radius for subsequent FILLET commands. Changing this value does not affect existing fillet arcs.

**Trim**

Controls whether FILLET trims the selected edges to the fillet arc endpoints.

**Multiple**

Rounds the edges of more than one set of objects.

**See also:**

Create Fillets

---

**FILLETEDGE**

Rounds and fillets the edges of solid objects.

**Access Methods**

![Toolbar](image)

**Toolbar:** Modeling tool set ➤ Solids - Edit tool group ➤ Fillet Edge

**Menu:** Modify ➤ Solid Editing ➤ Fillet Edges

**Summary**

You can select more than one edge. Enter a value for the fillet radius or click and drag the fillet grip.
**List of Prompts**

The following prompts are displayed.

**Select an Edge** Specifies one or more edges on the same solid body to fillet. After pressing Enter, you can drag the fillet grip to specify a radius, or use the Radius option.

**Chain** Specifies more than one edge when the edges are tangent to one another.

**Loop** Specifies a loop of edges on the face of a solid. For any edge, there are two possible loops. After selecting a loop edge you are prompted to Accept the current selection or choose the Next loop.

**Radius** Specifies a radius value.

**See also:**

Create Fillets  
Modify Edges on 3D Objects

---

**FIND**

Finds the text that you specify, and can optionally replace it with other text.

**Access Methods**

**Button**

🔗 **Toolbar:** Annotation tool set ➤ Text tool group ➤ Find Text
Menu: Edit ➤ Find
Shortcut menu: With no commands active, right-click in the drawing area and click Find.

Summary

The Find and Replace dialog box (page 442) is displayed.

See also:

Find and Replace Text

Find and Replace Dialog Box - FIND

Specifies the text you want to find, replace, or select and controls the scope and results of the search.

List of Options

The following options are displayed.

Where to Check

Specifies whether to search the entire drawing, the current layout, or the currently-selected object. If an object is already selected, then Selected Objects is the default value. If no object is selected, then Entire Drawing is the default value.
value. You can use the Select Objects button to temporarily close the dialog box and create or modify the selection set.

**Find What**

Specifies the text string you want to find. Enter a text string, including any wild-card characters, or choose one of the six most recently used strings from the list.

For more information on wild-card searches, see Find and Replace Text in the User's Guide.

**Replace With**

Specifies the text string you want to use to replace the found text. Enter a string, or choose one of the most recently used strings from the list.

**Select Objects Button**

Closes the dialog box temporarily so that you can select objects in your drawing. Press Enter to return to the dialog box.

When you select objects, Where to Check displays Selected Objects by default.

**Replace**

Replaces found text with the text that you enter in Replace With and moves to the next instance of the found text if one exists.

**Replace All**

Finds all instances of the text that you enter in Find What and replaces it with the text in Replace With.

The Where to Check setting controls whether to find and replace text in the entire drawing or text in the currently selected object or objects.

**Find**

Finds the text that you enter in Find What. The first text object that matches the search criteria is zoomed to. Once you find the first instance of the text, the Find option acts like a Find Next, which you can use to find the next text object.

**Search Options**

Defines the type of objects and words to be found.

**Match Case**

Includes the case of the text in Find What as part of the search criteria.

**Find Whole Words Only**
Finds only whole words that match the text in Find What. For example, if you select Find Whole Words Only and search for “Front Door,” FIND does not locate the text string “Front Doormat.”

**Use Wildcards**

Allows the use of wild-card characters in searches. For more information on wild-card searches, see Find and Replace Text in the User’s Guide.

**Search XRefs**

Includes text in externally referenced files in search results.

**Search Blocks**

Includes text in blocks in search results.

**Ignore Hidden Items**

Ignores hidden items in search results. Hidden items include text on layers that are frozen or turned off, text in block attributes created in invisible mode, and text in visibility states within dynamic blocks.

**Match Diacritics**

Matches diacritical marks, or accents, in search results.

**Match Half or Full Width Forms**

Matches half- and full-width characters in search results.

**Text Types**

Specifies the type of text objects you want to include in the search. By default, all options are selected.

**Block Attribute Value**

Includes block attribute text values in search results.

**Dimension or Leader Text**

Includes dimension and leader object text in search results.

**Single-Line or Multiline Text**

Includes text objects such as single-line and multiline text in search results.

**Table Text**

Includes text found in AutoCAD table cells in search results.

**Hyperlink Description**
FLATSHOT

Creates a 2D representation of all 3D objects based on the current view.

Access Methods

Button

_toolbar: Modeling tool set ➤ Section tool group ➤ Flatshot

Summary

The Flatshot dialog box (page 446) is displayed.

The edges of all 3D solids, surfaces, and meshes are projected line-of-sight onto a plane parallel to the viewing plane. The 2D representations of these edges are inserted as a block on the XY plane of the UCS. This block can be exploded for additional changes.

See also:

Create a Flattened View
**Flatshot Dialog Box**

Creates a 2D representation of all 3D objects based on the current view.

**Summary**

The edges of all 3D solids and surfaces are projected line-of-sight onto a plane parallel to the viewing plane. The 2D representations of these edges are inserted as a block on the \( XY \) plane of the UCS. This block can be exploded for additional changes. The result can also be saved as a separate drawing file.

**List of Options**

The following options are displayed.

**Destination**
Controls where the flattened representation is created.

**Insert As New Block**
Specifies to insert the flattened representation as a block in the current drawing.
Replace Existing Block
Replaces an existing block in the drawing with the newly created block.

Select Block
Closes the dialog box temporarily while you select the block you are replacing in the drawing. When you finish selecting the block, press Enter to re-display the Flatshot dialog box.

Block Selected / No Block Selected
Indicates whether a block has been selected.

Export to a File
Saves the block to an external file.

Foreground Lines
Contains controls for setting the color and linetype of lines that are not obscured in the flattened view.

Color
Sets the color of lines that are not obscured in the flattened view.

Linetype
Sets the linetype of lines that are not obscured in the flattened view.

Obscured Lines
Controls whether lines that are obscured in the drawing are displayed in the flattened view, and sets the color and linetype of these obscured lines.

Show
Controls whether obscured lines are shown in the flattened representation. When selected, the 2D flattened representation displays lines hidden by other objects.

Color
Sets the color of lines that lie behind geometry in the flattened view.

Linetype
Sets the linetype of lines that lie behind geometry in the flattened view.

Include Tangential Lines
Creates silhouette edges for curved surfaces.

Create
Creates the flattened view.
See also:
Create a Flattened View

**FREESPOT**

Creates free spotlight which is similar to a spotlight without a specified target.

**List of Options**

The following options are displayed.
Specify source location <0,0,0>: *Enter coordinate values or use the pointing device*

If the LIGHTINGUNITS system variable is set to 0, the following prompt is displayed:
Enter an option to change [Name (page 448)/Intensity (page 448)/Status (page 449)/Hotspot (page 449)/Falloff (page 449)/shadow (page 450)/Attenuation (page 450)/Color (page 451)/eXit] <eXit>:

If the LIGHTINGUNITS system variable is set to 1 or 2, the following prompt is displayed:
Enter an option to change [Name (page 448)/Intensity factor (page 448)/Photometry (page 449)/Status (page 449)/Hotspot (page 449)/Falloff (page 449)/shadow (page 450)/filterColor (page 451)/eXit] <eXit>:

**NOTE** When the LIGHTINGUNITS system variable is set to 1 or 2, the Attenuation option has no affect on the creation of the light. It is only maintained for scripting compatibility.

**Name**
Specifies the name of the light. You can use uppercase and lowercase letters, numbers, spaces, hyphens (-), and underscores (_) in the name. The maximum length is 256 characters.

**Intensity/Intensity Factor**
Sets the intensity or brightness of the light. The range is 0.00 to the maximum value that is supported by your system.
Hotspot
Specifies the angle that defines the brightest cone of light, which is known to lighting designers as the beam angle. This value can range from 0 to 160 degrees or the equivalent values based on AUNITS (page 1215).

Falloff
Specifies the angle that defines the full cone of light, which is also known as the field angle. This value can range from 0 to 160 degrees. The default is 50 degrees or the equivalent values based on AUNITS (page 1215). The falloff angle must be greater than or equal to the hotspot angle.

Status
Turns the light on and off. If lighting is not enabled in the drawing, this setting has no effect.

Photometry
Photometry is available when the LIGHTINGUNITS system variable is set to 1 or 2. Photometry is the measurement of the luminous intensities of visible light sources.

In photometry, luminous intensity is a measure of the perceived power emitted by a light source in a particular direction. Luminous flux is the perceived power per unit of solid angle. The total luminous flux for a lamp is the perceived power emitted in all directions. Luminance is the total luminous flux incident on a surface, per unit area.

Intensity Enter an intensity value in candelas, the perceived power in a luminous flux value, or illuminance value for the total luminous flux incident on a surface.

- Candela (symbol: cd) is the SI unit of luminous intensity (perceived power emitted by a light source in a particular direction). Cd/Sr
- Lux (symbol: lx) is the SI unit of illuminance. Lm/m²
- Foot-candle (symbol: fc) is the American unit of illuminance. Lm/ft²

Enter f to specify the perceived power in a luminous flux value.
If you enter i, you can specify the intensity of the light based on an illuminance value.

The illuminance value can be specified in either lux or foot-candles. Enter d to specify a distance to use to calculate illuminance.

Color Specify the color of the light based on a color name or a Kelvin temperature. Enter ? to display a list of color names.
Enter a text string using wild card characters to display a partial listing of color names, or an asterisk (*) to display all the possible choices.
If you enter k, you can specify the color of the light based on a Kelvin temperature value.

**Shadow**
Makes the light cast shadows.

**Off** Turns off display and calculation of shadows for the light. Turning shadows off increases performance.

**Sharp** Displays shadows with sharp edges. Use this option to increase performance.

**Soft Mapped** Displays realistic shadows with soft edges.

**Map Size** Specifies the amount of memory that should be used to calculate the shadow map.

**Softness** Specifies the softness that should be used to calculate the shadow map.

**Soft Sampled** Displays realistic shadows with softer shadows (penumbra) based on extended light sources.

Specify the shape of the shadow by entering s and then the dimensions of the shape. (For example, the radius of the sphere or the length and width of a rectangle.)

Specify the sample size by entering a.

Specify the visibility of the shape by for the shadow by entering v.

**Attenuation**
Enter an option to change [attenuation Type/Use limits/attenuation start Limit/attenuation End limit/eXit]<eXit>:

**Attenuation Type** Controls how light diminishes over distance. The farther away an object is from a spotlight, the darker the object appears. Attenuation is also known as decay.

- **None.** Sets no attenuation. Objects far from the spotlight are as bright as objects close to the light.

- **Inverse Linear.** Sets attenuation to be the inverse of the linear distance from the light. For example, at a distance of 2 units, light is half as strong as at the spotlight; at a distance of 4 units, light is one quarter as strong. The default value for inverse linear is half the maximum intensity.

- **Inverse Squared.** Sets attenuation to be the inverse of the square of the distance from the light. For example, at a distance of 2 units, light is one quarter as strong as at the spotlight; at a distance of 4 units, light is one sixteenth as strong.
Use Limits Specifies whether to use limits or not.

Attenuation Start Limit Specifies the point where light starts as an offset from the center of the light. The default is 0.

Attenuation End Limit Specifies the point where light ends as an offset from the center of the light. No light is cast beyond this point. Setting an end limit increases performance where the effect of lighting is so minimal that the calculations are wasted processing time.

Color/Filter Color
Controls the color of the light.

True Color Specifies a True Color. Enter in the format R,G,B (red, green, blue).

Index Specifies an ACI (AutoCAD Color Index) color.

HSL Specifies an HSL (hue, saturation, luminance) color.

Color Book Specifies a color from a color book.

See also:
Use Spotlights

FREEWEB

Creates a free web light which is similar to a web light without a specified target.

List of Prompts

The following prompts are displayed.
Specify source location <0,0,0>: Enter coordinate values or use the pointing device
Enter an option to change [Name (page 452)/Intensity factor (page 452)/Status (page 452)/Photometry (page 452)/weB (page 453)/shadow (page 453)/filterColor (page 453)/eXit] <eXit>:

NOTE The LIGHTINGUNITS system variable must be set to a value other than 0 to create and use freeweb lights.
**Name**
Specifies the name of the light. You can use uppercase and lowercase letters, numbers, spaces, hyphens (-), and underscores (_) in the name. The maximum length is 256 characters.

**Intensity Factor**
Sets the intensity or brightness of the light. The range is 0.00 to the maximum value that is supported by your system.

**Status**
Turns the light on and off. If lighting is not enabled in the drawing, this setting has no effect.

**Photometry**
Photometry is available when the LIGHTINGUNITS system variable is set to 1 or 2. Photometry is the measurement of the luminous intensities of visible light sources.

In photometry, luminous intensity is a measure of the perceived power emitted by a light source in a particular direction. Luminous flux is the perceived power per unit of solid angle. The total luminous flux for a lamp is the perceived power emitted in all directions. Luminance is the total luminous flux incident on a surface, per unit area.

**Intensity** Enter an intensity value in candelas, the perceived power in a luminous flux value, or illuminance value for the total luminous flux incident on a surface.
- Candela (symbol: cd) is the SI unit of luminous intensity (perceived power emitted by a light source in a particular direction). Cd/Sr
- Lux (symbol: lx) is the SI unit of illuminance. Lm/m^2
- Foot-candle (symbol: fc) is the American unit of illuminance. Lm/ft^2

Enter f to specify the perceived power in a luminous flux value.

If you enter i, you can specify the intensity of the light based on an illuminance value.

The illuminance value can be specified in either lux or foot-candles. Enter d to specify a distance to use to calculate illuminance.

**Color** Specify the color of the light based on a color name or a Kelvin temperature. Enter ? to display a list of color names.

Enter a text string using wild card characters to display a partial listing of color names, or an asterisk (*) to display all the possible choices.

If you enter k, you can specify the color of the light based on a Kelvin temperature value.
Web
Specifies the intensity for a light at points on a spherical grid.

File Specifies which web file to use to define the properties of the web. Web files have the file extension .ies.

X Specifies the X rotation for the web.

Y Specifies the Y rotation for the web.

Z Specifies the Z rotation for the web.

Shadow
Makes the light cast shadows.

Off Turns off display and calculation of shadows for the light. Turning shadows off increases performance.

Sharp Displays shadows with sharp edges. Use this option to increase performance.

Soft Mapped Displays realistic shadows with soft edges.
Specifies the amount of memory to use to calculate the shadow map.

Softness Specifies the softness that should be used to calculate the shadow map.

Soft Sampled Displays realistic shadows with softer shadows (penumbra) based on extended light sources.
Specify the shape of the shadow by entering s and then the dimensions of the shape. (For example, the radius of the sphere or the length and width of a rectangle.)
Specify the sample size by entering a.
Specify the visibility of the shape by for the shadow by entering v.

Filter Color
Controls the color of the light.

True Color Specifies a True Color. Enter in the format R,G,B (red, green, blue).

Index Specifies an ACI (AutoCAD Color Index) color.

HSL Specifies an HSL (hue, saturation, luminance) color.

Color Book Specifies a color from a color book.

See also:

Overview of Weblights
G Commands

GCCOINCIDENT

Constrains two points together or a point to a curve (or an extension of a curve).

Access Methods

Button

Toolbar: Drafting tool set ➤ Parametric tool group ➤ Geometric Constraints flyout ➤ Coincident

Menu: Parametric ➤ Geometric Constraints ➤ Coincident

Summary

This command is equivalent to the Coincident option in GEOMCONSTRAINT (page 467).

A constraint point on an object can be made coincident with an object or a constraint point on another object.

Following are the valid constraint objects and points:

- Line
- Polyline segment
- Circle
- Arc
- Polyline arc
- Ellipse
- Spline
- Two valid constraint points

List of Prompts

The following prompts are displayed.
Select first point (page 455) or [Object (page 455)/Autoconstrain (page 455)] <Object>: Select a constraint point, or an object, or enter to apply constraints to selected objects

**Point**
Specifies a point to be constrained.

**First Point** Specifies the first point of the object to be constrained.

**Second Point** Specifies the second point of the object to be constrained.

**Object**
Selects an object to be constrained.

**Point Point** (page 455)

**Multiple** Picks successive points to coincide with the first object. The Multiple option is displayed when you use the Object option to select the first object.

**Autoconstrain**
Selects multiple objects. Coincident constraints are applied to selected objects with unconstrained points that are coincident to each other.

The number of constraints applied is displayed at the Command prompt.

When a coincident constraint is applied between a point and an arc or line, the point can lie on the line or arc or the extension of the line or arc.

**See also:**
Apply or Remove Geometric Constraints

**GCCOLLINEAR**

Causes two or more line segments to lie along the same line.

**Access Methods**

![Button]

**Toolbar:** Drafting tool set ➤ Parametric tool group ➤ Geometric Constraints flyout ➤ Collinear

**Menu:** Parametric ➤ Geometric Constraints ➤ Collinear
Summary

This command is equivalent to the Collinear option in GEOMCONSTRAINT (page 467).

Following are the valid constraint objects and points:
- Line
- Polyline segment
- Ellipse
- Multiline text

List of Prompts

The following prompts are displayed.

Select first object (page 456) or [Multiple (page 456)]: Select an object or enter m to select multiple points or objects

Object
Selects an object to be constrained.

First object Selects the first object to be constrained.

Second object Selects the second object to be constrained.

Multiple
Picks successive points or objects to be made collinear with the first object.

See also:
Apply or Remove Geometric Constraints

GCCONCENTRIC

Constrains two arcs, circles, or ellipses to the same center point.

Access Methods

Button

 Toolbar: Drafting tool set ➤ Parametric tool group ➤ Geometric Constraints flyout ➤ Concentric
**Menu: Parametric ➤ Geometric Constraints ➤ Concentric**

**Summary**

This command is equivalent to the Concentric option in GEOMCONSTRAINT (page 467).

Following are the valid constraint objects and points:

- Circle
- Arc
- Polyline arc
- Ellipse

**List of Prompts**

The following prompts are displayed.

*Select first object (page 457): Select a circle, arc, or ellipse*

**Object**

Selects an object to be constrained.

**First object** Selects the first circle, arc, or ellipse to be constrained.

**Second object** Selects the second circle, arc, or ellipse to be constrained.

**See also:**

- Apply or Remove Geometric Constraints

**GCEQUAL**

Resizes selected arcs and circles to the same radius, or selected lines to the same length.

**Access Methods**

- **Toolbar:** Drafting tool set ➤ Parametric tool group ➤ Geometric Constraints flyout ➤ Equal
- **Menu:** Parametric ➤ Geometric Constraints ➤ Equal
Summary

This command is equivalent to the Equal option in GEOMCONSTRAINT (page 467).

Following are the valid constraint objects and points:
- Line
- Polyline segment
- Circle
- Arc
- Polyline arc

List of Prompts

The following prompts are displayed.
Select first object (page 458) or [Multiple (page 458)]: Select an object or enter m to select multiple objects

Object
Selects an object to be constrained.

First object Selects the first object to be constrained.

Second object Selects the second object to be made equal with the first object.

Multiple
Picks successive objects to be made equal with the first object.

See also:
- Apply or Remove Geometric Constraints

GCFIX

Locks points and curves in position.

Access Methods

 Toolbar: Drafting tool set ➤ Parametric tool group ➤ Geometric Constraints flyout ➤ Fix
 Menu: Parametric ➤ Geometric Constraints ➤ Fix
Summary

This command is equivalent to the Fix option in GEOMCONSTRAINT (page 467).

When you apply the Fix constraint to a point on an object, you lock the node in place. You can move the object around the locked node.

When you apply the Fix constraint to an object, the object is locked and cannot be moved.

Following are the valid constraint objects and points:
- Line
- Polyline segment
- Circle
- Arc
- Polyline arc
- Ellipse
- Spline

See also:
- Apply or Remove Geometric Constraints

GCHORIZONTAL

Causes lines or pairs of points to lie parallel to the X axis of the current coordinate system.

Access Methods

Button

Toolbar: Drafting tool set ➤ Parametric tool group ➤ Geometric Constraints flyout ➤ Horizontal
Menu: Parametric ➤ Geometric Constraints ➤ Horizontal
Summary

This command is equivalent to the Horizontal option in GEOMCONSTRAINT (page 467).

You can select different constraint points on the same object or different objects.

The following are the valid constraint objects and points:
- Line
- Polyline segment
- Ellipse
- Multiline text
- Two valid constraint points

List of Prompts

The following prompts are displayed.
Select an object or [2Points (page 460)] <2Points>: Select an object or two constraint points

2Points
Selects two constraint points instead of an object.

The second selected point on an object is made horizontal to the first selected point.

See also:

Apply or Remove Geometric Constraints
**GCPARALLEL**

Causes selected lines to lie parallel to each other.

**Access Methods**

- **Button**
  - Toolbar: Drafting tool set ➤ Parametric tool group ➤ Geometric Constraints flyout ➤ Parallel
  - Menu: Parametric ➤ Geometric Constraints ➤ Parallel

**Summary**

This command is equivalent to the Parallel option in GEOMCONSTRAINT (page 467).

Following are the valid constraint objects and points:
- Line
- Polyline segment
- Ellipse
- Multiline text

**See also:**
- Apply or Remove Geometric Constraints

**GCPERPENDICULAR**

Causes selected lines to lie 90 degrees to one another.

**Access Methods**

- **Button**
  - Toolbar: Drafting tool set ➤ Parametric tool group ➤ Geometric Constraints flyout ➤ Perpendicular
Menu: Parametric ➤ Geometric Constraints ➤ Perpendicular

Summary

This command is equivalent to the Perpendicular option in GEOMCONSTRAINT (page 467).

Lines do not have to intersect to be perpendicular.

Following are the valid constraint objects and points:
- Line
- Polyline segment
- Ellipse
- Multiline text

See also:
- Apply or Remove Geometric Constraints

GCSMOOTH

Constrains a spline to be contiguous and maintain G2 continuity with another spline, line, arc, or polyline.

Access Methods

Button

Toolbar: Drafting tool set ➤ Parametric tool group ➤ Geometric Constraints flyout ➤ Smooth

Menu: Parametric ➤ Geometric Constraints ➤ Smooth

Summary

This command is equivalent to the Smooth option in GEOMCONSTRAINT (page 467).

Following are the valid constraint objects and points:
- Spline, line
- Polyline segment
Arc
- Polyline arc

The splines are updated to be contiguous with one another.

NOTE
Endpoints of the curves to which you apply the smooth constraints are made coincident.

List of Prompts

The following prompts are displayed.
Select first spline curve (page 463): Select a spline object

Curve
Selects an endpoint of a curve.
First Spline Curve Selects the first spline curve to be constrained.
Second Curve Selects the second curve to be made continuous with the first spline curve.

See also:
Apply or Remove Geometric Constraints

GCSYMMETRIC

Causes selected objects to become symmetrically constrained about a selected line.

Access Methods

Button

Toolbar: Drafting tool set ➤ Parametric tool group ➤ Geometric Constraints flyout ➤ Symmetric
Menu: Parametric ➤ Geometric Constraints ➤ Symmetric
Summary

This command is equivalent to the Symmetric option in GEOMCONSTRAINT (page 467).

For lines, the line's angle is made symmetric (and not the endpoints). For arcs and circles, the center and radius are made symmetric (not the endpoints of the arc).

Following are the valid constraint objects and points:

- Line
- Polyline segment
- Circle
- Arc
- Polyline arc
- Ellipse

**NOTE** You must have an axis around which you will constrain the objects or points to be symmetrical. This is referred to as the symmetry line.

List of Prompts

The following prompts are displayed.

Select first object (page 464) or [2Points (page 464)]

<2Points>: Select an object or two constrained points

**Object**

Selects an object to be constrained.

**First Object** Selects the first object to be made symmetrical.

**Second Object** Selects the second object to be made symmetrical.

**Symmetric Line** Specifies the axis in which the objects and points are made to be symmetrical.

**2Points**

Selects two points and a symmetry line.

**First Point** Selects the first point to be made symmetrical.

**Second Point** Selects the second point to be made symmetrical.

**Select Symmetric Line** Specifies the axis in which the objects and points are made to be symmetrical.
See also:
   Apply or Remove Geometric Constraints

**GCTANGENT**

Constrains two curves to maintain a point of tangency to each other or their extensions.

**Access Methods**

*Button*

**Toolbar:** Drafting tool set ➤ Parametric tool group ➤ Geometric Constraints flyout ➤ Tangent

**Menu:** Parametric ➤ Geometric Constraints ➤ Tangent

**Summary**

This command is equivalent to the Tangent option in GEOMCONSTRAINT (page 467).

Following are the valid constraint objects and points:

- Line
- Polyline segment
- Circle, arc, polyline arc, ellipse
- Combination of circles, arcs, or ellipses

A circle can be tangent to a line even if the circle does not touch the line. A curve can be tangent to another even if they do not physically share a point.

See also:
   Apply or Remove Geometric Constraints
GCVERTICAL

Causes lines or pairs of points to lie parallel to the Y axis of the current coordinate system.

Access Methods

Button

◊ Toolbar: Drafting tool set ➤ Parametric tool group ➤ Geometric Constraints flyout ➤ Vertical
◊ Menu: Parametric ➤ Geometric Constraints ➤ Vertical

Summary

This command is equivalent to the Vertical option in GEOMCONSTRAINT (page 467).

Following are the valid constraint objects and points:
■ Line
■ Polyline segment
■ Ellipse
■ Multiline text
■ Two valid constraint points

You can select different constraint points on the same object or two separate objects.

List of Prompts

The following prompts are displayed.
Select an object or [2Points (page 466)] <2Points>: Select an object or two constraint points

2Points
Selects two constraint points instead of an object.

See also:

Apply or Remove Geometric Constraints
GEOMCONSTRAINT

Applies or persists geometric relationships between objects or points on objects.

Access Methods

Menu: Parametric ➤ Geometric Constraints

Summary

When you apply a geometric constraint to a pair of objects, the order in which the objects are selected and the point on which each object is selected can affect how the objects are positioned relative to each other.

The following table outlines the valid constraint points for an object.

<table>
<thead>
<tr>
<th>Objects</th>
<th>Valid Constraint Points</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>Endpoints, midpoint</td>
</tr>
<tr>
<td>Arc</td>
<td>Center, endpoints, midpoint</td>
</tr>
<tr>
<td>Spline</td>
<td>Endpoints</td>
</tr>
<tr>
<td>Circle</td>
<td>Center</td>
</tr>
<tr>
<td>Ellipse</td>
<td>Center, major and minor axes</td>
</tr>
<tr>
<td>Polyline</td>
<td>Endpoints, midpoints of line and arc subobjects, center of arc subobjects</td>
</tr>
<tr>
<td>Xref, attribute, table</td>
<td>Insertion point</td>
</tr>
<tr>
<td>Block</td>
<td>Insertion point, nested entities</td>
</tr>
<tr>
<td>Text, multiline text</td>
<td>Insertion point, alignment point</td>
</tr>
</tbody>
</table>

The following commands are equivalent to each GEOMCONSTRAINT option:

Horizontal (GCHORIZONTAL (page 459))
Causes lines or pairs of points to lie parallel to the X axis of the current coordinate system.

**Vertical** (*GCVERTICAL* (page 466))
Causes lines or pairs of points to lie parallel to the Y axis of the current coordinate system.

**Perpendicular** (*GCPERPENDICULAR* (page 461))
Causes selected lines to lie 90 degrees to one another.

**Parallel** (*GCPARALLEL* (page 461))
Causes selected lines to lie parallel to each other.

**Tangent** (*GCTANGENT* (page 465))
Constraints two curves to maintain a point of tangency to each other or their extensions.

**Smooth** (*GCSMOOTH* (page 462))
Constraints a spline to be contiguous and maintain G2 continuity with another spline, line, arc, or polyline.

**Coincident** (*GCCOINCIDENT* (page 454))
Constraints two points together or a point to a curve (or an extension of a curve).

**Concentric** (*GCCONCENTRIC* (page 456))
Constraints two arcs, circles, or ellipses to the same center point.

**Collinear** (*GCCOLLINEAR* (page 455))
Causes two or more line segments to lie along the same line.

**Symmetric** (*GCSYMMETRIC* (page 463))
Causes selected objects to become symmetrically constrained about a selected line.

**Equal** (*GCEQUAL* (page 457))
Resizes selected arcs and circles to the same radius, or selected lines to the same length.

**Fix** (*GCFIX* (page 458))
Locks points and curves in position.

**See also:**

- Apply or Remove Geometric Constraints
GRADIENT

Fills an enclosed area or selected objects with a gradient fill.

Access Methods

Button

_toolbar: Drafting tool set ➤ Closed Shapes tool group ➤ Gradient

Menu: Draw ➤ Gradient

Summary

The Gradient visor or Hatch and Gradient dialog box (page 475) is displayed. A gradient fill creates a smooth transition between one or two colors.

See also:

Choose a Hatch Pattern or Fill

GRID

Displays a grid pattern in the current viewport.

Access Methods

_menu: Tools ➤ Drafting Settings
List of Prompts

The following prompts are displayed.
Specify grid spacing(X) (page 470) or [ON (page 470)/OFF (page 470)/Snap (page 470)/Major (page 470)/aDaptive (page 470)/Limits (page 470)/Follow (page 470)/Aspect (page 470)] <current>: Specify a value or enter an option

Grid Spacing (X) Sets the grid to the specified value. Entering x after the value sets the grid spacing to the specified value multiplied by the snap interval.

On Turns on the grid using the current spacing.

Off Turns off the grid.

Snap Sets the grid spacing to the snap interval specified by the SNAP (page 986) command.

Major Specifies the frequency of major grid lines compared to minor grid lines. Grid lines rather than grid dots are displayed in any visual style except 2D Wireframe. (GRIDMAJOR (page 1344) system variable)

Adaptive Controls the density of grid lines when zoomed in or out.
 ▪ Adaptive Behavior. Limits the density of grid lines or dots when zoomed out. This setting is also controlled by the GRIDDISPLAY (page 1343) system variable.
 ▪ Allow Subdivision Below Grid Spacing. If turned on, generates additional, more closely spaced grid lines or dots when zoomed in. The frequency of these grid lines is determined by the frequency of the major grid lines.

Limits Displays the grid beyond the area specified by the LIMITS (page 575) command.

Follow Changes the grid plane to follow the XY plane of the dynamic UCS. This setting is also controlled by the GRIDDISPLAY (page 1343) system variable.

Aspect Changes the grid spacing in the X and Y directions, which can have different values.
Entering x following either value defines it as a multiple of the snap interval rather than the drawing units.
The Aspect option is not available when the current snap style is Isometric.

See also:

Adjust Grid and Grid Snap

GROUP

Creates saved sets of objects called groups.

Access Methods

Menu: Tools ➤ Group

Summary

If you enter -group at the Command prompt, options are displayed (page 471).

List of Prompts

The following prompts are displayed.
Select objects or [Name/Description]: Select objects to add to the new group or enter an option

Name Specifies the group name. Group names can be up to 31 characters long and can include letters, numbers, and the special characters dollar sign ($), hyphen (-), and underscore (_) but not spaces. The name is converted to uppercase characters.

Description Specifies the description for the group. You can use up to 64 characters for a description.

See also:

Group Objects

-GROUP

Creates and manages saved sets of objects called groups.
List of Prompts

The following prompts are displayed.
Enter a group option [? (page 472)/Order (page 472)/Add (page 472)/Remove (page 472)/Explode (page 472)/REName (page 472)/Selectable (page 472)/Create (page 472)] <Create>: Enter an option or press Enter

?—List Groups
Lists names and descriptions of groups defined in the drawing.

Order
Changes the numerical order of objects within a group. Reordering is useful when creating tool paths. For example, you can change the cut order for the horizontal and vertical lines of a tool path pattern.

Position Number Specifies the position number of the object to reorder. To reorder a range of objects, specify the first object's position number.

Reverse Order Reverses the order of all members in a group.

Add
Adds objects to a group.

Remove
Removes objects from a group.

If you remove all the group's objects, the group remains defined. You can remove the group definition from the drawing by using the Explode option.

Explode
Deletes a group definition by exploding the group into its component objects.

Rename
Assigns a new name to an existing group.

Selectable
Specifies whether a group is selectable. When a group is selectable, selecting one object in the group selects the whole group. Objects on locked or frozen layers are not selected.

Create
Creates a group.

Group names can be up to 31 characters long and can include letters, numbers, and special characters dollar sign ($), hyphen (-), and underscore (_) but not spaces. The name is converted to uppercase characters.
GROUPEDIT

Adds and removes objects from the selected group, or renames a selected group.

Summary

For existing groups, add or remove objects; or rename a group.
The following prompts are displayed.

Select group or [Name]:

In the drawing area, select a group or enter the name of a group. If a selected object is not included in a group, you are prompted again.

List of Options

When a group is selected, the following options are displayed.
Enter an option [Add objects (page 473)/Remove objects (page 473)/REName (page 473)]:

Add Objects Select objects to add to the current group.
Remove Objects Select grouped objects to remove from the current group.
Rename Name or rename the current group.

See also:

Group Objects

H Commands

HATCH

Fills an enclosed area or selected objects with a hatch pattern, solid fill, or gradient fill.
Access Methods

Button

Toolbar: Drafting tool set ➤ Closed Shapes tool group ➤ Hatch
Menu: Draw ➤ Hatch

Summary

The Hatch visor (page 486) or Hatch and Gradient dialog box (page 475) is displayed.

If you enter -hatch at the Command prompt, options are displayed (page 491).

NOTE To prevent the creation of an enormous number of hatch lines, the maximum number of hatch lines created in a single hatch operation is limited. This limit prevents memory and performance problems. However, you can change the maximum number of hatch lines with the HPMAXLINES (page 1364) system variable.

Choose from several methods to specify the boundaries of a hatch.
- Specify a point in an area that is enclosed by objects.
- Select objects that enclose an area.
- Specify boundary points using the -HATCH Draw option.

See also:

Overview of Hatch Patterns and Fills
Hatch and Gradient Dialog Box

Defines the boundaries, pattern, or fill properties, and other parameters for hatches and fills.

List of Options

The dialog box includes the following:

- Hatch tab (page 478)
- Gradient tab (page 481)
- More Options section (page 483)
- Add: Pick Points (page 475)
- Add: Select Objects (page 476)
- Remove Boundaries (page 476)
- Recreate Boundary (page 477)
- View Selections (page 477)
- Display Boundary Objects (page 477)
- Options (page 477)
- Preview (page 478)

Add: Pick Points

Determines a boundary from existing objects that form an enclosed area around the specified point.

If you turn on Island Detection, objects that enclose areas within the outermost boundary are detected as islands. How HATCH detects objects using this option depends on which island detection method is specified.
NOTE Red circles are displayed at unconnected endpoints of boundary objects to identify gaps in the hatch boundary. These circles are temporary and can be removed with REDRAW (page 881) or REGEN (page 889).

**Add: Select Objects**
Determines a boundary from selected objects that form an enclosed area.

Interior objects are not automatically detected. You must select the objects within the selected boundary to hatch or fill those objects according to the current island detection style.

Each time you click Add: Select Objects, HATCH clears the previous selection set.

**Remove Boundaries**
Removes from the boundary definition any of the objects that were added previously.
Recreate Boundary
Creates a polyline or region around the selected hatch or fill, and optionally associates the hatch object with it.

View Selections
Displays the currently defined boundaries with the current hatch or fill settings. This option is available only when a boundary has been defined.

Display Boundary Objects
Selects the objects that form the boundaries of the selected associative hatch object. Use the displayed grips to modify the hatch boundaries.

NOTE This option is available only in the Hatch Edit dialog box (page 498) and replaces the View Selections option.

When you select an associative hatch, a single, circular grip called the control grip is displayed. No boundary grips are displayed because the boundaries of an associative hatch can be modified only by changing its associated boundary objects. Use the Select Boundary Objects option to select and grip-edit the boundary objects.

To modify the boundaries of a nonassociative hatch, you modify the boundaries of the hatch object itself. Thus, when you select a nonassociative hatch, both the control grip and the boundary grips are displayed.

Options
Controls several commonly used hatch or fill options.

Annotative Specifies that the hatch is annotative. This property automates the process of scaling annotations so that they plot or display at the correct size on the paper. (HPANNOTATIVE (page 1357) system variable)

Associative Specifies that the hatch or fill is associative. A hatch or fill that is associative is updated when you modify its boundary objects. (HPASSOC (page 1358) system variable)
**Separate Hatches** Controls whether a single hatch object or multiple hatch objects are created when several separate closed boundaries are specified. (HPSEPARATE (page 1368) system variable)

**Draw Order** Assigns a draw order to a hatch or fill. You can place a hatch or fill behind all other objects, in front of all other objects, behind the hatch boundary, or in front of the hatch boundary. (HPDRAWORDER (page 1361) system variable)

**Layer** Assigns new hatch objects to the specified layer, overriding the current layer. Select Use Current to use the current layer. (HPLAYER (page 1364) system variable)

**Transparency** Sets the transparency level for new hatch or fills, overriding the current object transparency. Select Use Current to use the current object transparency setting. (HPTRANSPARENCY (page 1368) system variable)

**Inherit Properties** Hatches or fills specified boundaries using the hatch or fill properties of a selected hatch object.

After selecting the hatch object whose properties you want the hatch to inherit, right-click in the drawing area and use the options on the shortcut menu to switch between the Select Objects and Pick Internal Point options.

The HPINHERIT (page 1362) system variable controls whether the hatch origin of the resulting hatch is determined by HPORIGIN (page 1365) or by the source object.

**Preview**

Displays the currently defined boundaries with the current hatch or fill settings. Click in the drawing area or press Esc to return to the dialog box. Right-click or press Enter to accept the hatch or fill.

**More Options**

Expands the dialog box to display more options (page 483).

**See also:**

Overview of Hatch Patterns and Fills

---

**Hatch Tab (Hatch and Gradient Dialog Box)**

Defines the appearance of the hatch pattern to be applied.
List of Options

The following options are displayed.

Type and Pattern

Specifies the hatch’s type, pattern, color, and background color.

Type

Specifies whether to create a predefined, user-defined, or custom hatch pattern. Predefined patterns are stored in the `acad.pat` or `acadiso.pat` files supplied with the program.

User-defined patterns are based on the current linetype in your drawing. A custom pattern is a pattern that is defined in any custom PAT files that you have added to the search path.

Pattern

Displays a selection of ANSI, ISO, and other industry-standard hatch patterns. Select SOLID to create solid fill. The Pattern option is available only when Type is set to Predefined. (HPNAME (page 1365) system variable)
Displays the Hatch Library (page 488), in which you can preview images for all predefined patterns.

**Hatch Color**

Overrides the current color with a specified color for hatch patterns and solid fills. *(HPCOLOR (page 1360) system variable)*

**Background Color**

Specifies the background color for new hatch objects. Choose None to turn off the background color. *(HPBACKGROUNDColor (page 1358) system variable)*

**Swatch**

Displays a preview of the selected pattern. Click the swatch to display the Hatch Library (page 488).

**Custom Pattern**

Lists the available custom patterns. The most recently used custom patterns appear at the top of the list. The Custom Pattern option is available only when Type is set to Custom. *(HPNAME (page 1365) system variable)*

** […] Button**

Displays the Hatch Library (page 488), in which you can preview images for all custom patterns.

**Angle and Scale**

Specifies an angle and scale for the selected hatch pattern.

**Angle**

Specifies an angle for the hatch pattern relative to the X axis of the current UCS. *(HPANG (page 1357) system variable)*

**Scale**

Expands or contracts a predefined or custom pattern. This option is available only when Type is set to Predefined or Custom. *(HPScale (page 1367) system variable)*

**Double**

For user-defined patterns, draws a second set of lines at 90 degrees to the original lines, creating a crosshatch. This option is available only when Type is set to User Defined. *(HPDOUBLE (page 1361) system variable)*

**Relative to Paper Space**
Scales the hatch pattern relative to paper space units. This allows you to display hatch patterns at a scale that is appropriate for your named layout. This option is available only from a named layout.

**Spacing**

Specifies the spacing of lines in a user-defined pattern. This option is available only when Type is set to User Defined. (HPSPACE (page 1368) system variable)

**ISO Pen Width**

Scales an ISO predefined pattern based on the selected pen width. This option is available only when Type is set to Predefined and Pattern is set to one of the available ISO patterns.

**Hatch Origin**

Controls the starting location of hatch pattern generation. Some hatches, such as brick patterns, are meant to be aligned with a point on the hatch boundary. By default, all hatch origins correspond to the current UCS origin.

**Use Current Origin**

Uses the hatch origin point stored in the HPORIGIN (page 1365) system variable.

**Specified Origin**

Assigns a new hatch origin using the following options.

**Click to Set New Origin**

Specifies the new hatch origin point directly.

**Default to Boundary Extents**

Calculates a new origin based on the rectangular extents of the boundary for the hatch object. Choices include each of the four corners of the extents and its center. (HPORIGINMODE (page 1366) system variable)

**Store as Default Origin**

Stores the value of the new hatch origin in the HPORIGIN system variable.

See also:

- Overview of Hatch Patterns and Fills

**Gradient Tab (Hatch and Gradient Dialog Box)**

Defines the appearance of the gradient fill to be applied.
List of Options

The following options are displayed.

**Color**
Specifies whether to fill the hatch boundary with a monochromatic or two-color blend.

**One Color**
Specifies a fill that uses a smooth transition between a color and a specified tint (the color mixed with white) or between a color and a specified shade (the color mixed with black). ([GFCLRSTATE](page 1342) system variable)

**Two Color**
Specifies a fill that uses a smooth transition between two colors. ([GFCLRSTATE](page 1342) system variable)

**Color Swatches**
Specifies the colors for the gradient fill (either one color or two colors). Click the Browse button [...] to display the Color Palette dialog box (page 205), where
you can select an AutoCAD Color Index (ACI) color, true color, or color book color. (GFCLR1 (page 1340) and GFCLR2 (page 1341) system variables)

Shade and Tint Slider
Specifies the tint (the selected color mixed with white) or shade (the selected color mixed with black) of a color to be used for a gradient fill of one color. (GFCLRLUM (page 1341) system variable)

Gradient Patterns
Displays fixed patterns for gradient fills. These patterns include linear sweep, spherical, and parabolic.

Orientation
Specifies the angle of the gradient and whether it is symmetrical.

Centered
Specifies a symmetrical gradient configuration. If this option is not selected, the gradient fill is shifted up and to the left, creating the illusion of a light source to the left of the object. (GFSHIFT (page 1343) system variable)

Angle
Specifies the angle of the gradient fill. The specified angle is relative to the current UCS. This option is independent of the angle specified for hatch patterns. (GFANG (page 1340) system variable)

See also:
Overview of Hatch Patterns and Fills

More Options (Hatch and Gradient Dialog Box)
Controls the operation of islands and boundaries.

List of Options
The following options are displayed.

Islands
Specifies the method used to hatch or fill boundaries within the outermost boundary.

Island Detection
Controls whether internal closed boundaries, called islands, are detected. (HPISLANDDETECTIONMODE (page 1363) system variable)
Normal
Hatches or fills inward from the outer boundary. If an internal island is encountered, hatching or filling is turned off until another island within the island is encountered. (HPISLANDDETECTION (page 1363) system variable)

Outer (Recommended)
Hatches or fills inward from the outer boundary. This option hatches or fills only the specified area and leaves the internal islands unaffected. (HPISLANDDETECTION (page 1363) system variable)

Ignore
Ignores all internal objects and hatches or fills through them. (HPISLANDDETECTION (page 1363) system variable)

The Normal, Outer, and Ignore options are also available from a shortcut menu by right-clicking in the drawing area while you specify points or select objects to define your boundaries.

Boundary Retention
Specifies whether to create an object that encloses the hatch.
Retain Boundaries
Creates an object that encloses each hatch object. (HPBOUNDRETAIN (page 1359) system variable)
Object Type
Controls the type of the new boundary object. The resulting boundary object can be either a polyline or a region object. This option is available only when Retain Boundaries is selected. (HPBOUND (page 1359) system variable)
For more information about regions, see Create and Combine Areas (Regions).

Boundary Set
Defines the set of objects analyzed when defining a boundary from a specified point. The selected boundary set has no effect when you use Select Objects to define a boundary.
By default, when you use the Add: Pick Point option to define a boundary, HATCH analyzes all objects in the current viewport extents. By redefining the boundary set, you can disregard certain objects when defining boundaries without having to hide or remove those objects. For large drawings, redefining the boundary set can also produce the boundary faster because HATCH examines fewer objects.

Current Viewport Defines the boundary set from all objects within the extents of the current viewport.
Existing Set Defines the boundary set from the objects selected with the New option.
New
Specifies a limited set of objects for evaluation by the pick point when creating the hatch.

Gap Tolerance
Sets the maximum size of gaps that can be ignored when objects are used as a hatch boundary. The default value, 0, specifies that the objects must enclose the area with no gaps.
Enter a value, in drawing units, from 0 to 5000 to set the maximum size of gaps that can be ignored when the objects serve as a hatch boundary. Any gaps equal to or smaller than the value you specify are ignored, and the boundary is treated as closed. (HPGAPTOL (page 1362) system variable)

Inherit Options
Controls whether to inherit the hatch origin when you create a hatch with the Inherit Properties option. (HPINHERIT (page 1362) system variable)
Use Current Origin Uses the current hatch origin setting.
Use Source Hatch Origin Uses the hatch origin of the source hatch.
See also:
Overview of Hatch Patterns and Fills

Hatch Visor

Defines the boundaries, pattern or fill properties, and other parameters for hatch and fills.

Hatch pattern controls

Solid fill controls

Gradient fill controls

Summary

The Hatch visor is displayed when you start the HATCH or GRADIENT command, or select an existing hatch or fill in a drawing.

When multiple hatches or fills of different types are selected in a drawing, some of the controls on the Hatch visor are disabled.

List of Options

The following options are displayed.

Pattern
Displays a preview image of the current hatch pattern or fill.

Click the preview image to display the Hatch Library palette and select a new pattern to use, or click the button to the right of the preview image to switch the type of hatch pattern or fill being created.

Properties
Color (Hatch Patterns and Solid Fills) Overrides the current color for hatch patterns and solid fills. (HPCOLOR (page 1360) system variable)
Background Color (Hatch Patterns) Specifies the color for hatch pattern backgrounds. Not available when using the Solid pattern. (HPBACKGROUND-COLOR (page 1358) system variable)

Gradient Color 1 (Gradient Fills) Specifies the first of two gradient colors. (GFCLR1 (page 1340) system variable)

Gradient Color 2 (Gradient Fills) Specifies the second gradient color. (GFCLR2 (page 1341) system variable)

Angle (Hatch Patterns and Gradient Fills) Specifies an angle for the hatch or fill relative to the X axis of the current UCS. Valid values are from 0 to 359. (HPANG (page 1357) system variable)

Scale (Hatch Patterns) Expands or contracts a predefined or custom hatch pattern. This option is available only when Hatch Type is set to Pattern. (HPSCALE (page 1367) system variable)

Pick Points
Determines the boundary to hatch or fill from existing objects that form an enclosed area around a specified point.

Select Boundary
Determines the boundary to hatch or fill from selected objects that form an enclosed area.

H Commands | 487
When you use the Select Boundary option, HATCH does not automatically detect interior objects. You must select the objects within the selected boundary to hatch or fill those objects according to the current island detection style. Right-click and choose Settings to change the current island detection style.

**Remove Boundary**
Removes from the boundary definition any of the objects that were previously added. Option is only available after a boundary has been defined.

**Create Boundary**
Creates a polyline or region around the selected hatch or fill, and optionally associates the hatch or fill object with it. Option is only available when modifying an existing hatch or fill object.

**Create Separated Hatches**
Controls whether a single hatch or fill object or multiple hatch or fill objects are created when several separate closed boundaries are specified. ([HPSEPARATE](page 1368) system variable)

**Match Hatch Properties**
Sets the properties of a hatch or fill with a selected hatch or fill object.

**Exit the Hatch Editor and Close the Visor**
Quits the current command and closes the visor.

See also:
- Overview of Hatch Patterns and Fills

**Hatch Library**
Displays preview images for all predefined and custom patterns, and gradient fill patterns.
The Hatch Library can be displayed as a dialog box when using the Hatch and Gradient dialog box, or as a palette from the Hatch or Gradient visors.
The Hatch Library can be displayed as a dialog box when using the Hatch and Gradient dialog box, or as a palette from the Hatch or Gradient visors.

Summary
Organizes patterns into five categories, with patterns listed alphabetically. Click an image to select a pattern.

List of Options
The following options are displayed.

Pattern Category
Lists the pattern categories used to group related hatch and gradient patterns.

The following categories are listed:

- **Show All.** Shows all patterns in all categories.
- **ANSI.** Displays all ANSI patterns shipped with the program.
- **ISO.** Displays all ISO patterns shipped with the program.
- **Other Predefined.** Displays all patterns other than ANSI and ISO shipped with the program.
- **Custom.** Displays a list of custom PAT files that you have added to the Support File Search Path of the program.
- **Gradient.** Displays all gradient patterns.

Add Patterns Loads a PAT file into the Hatch Library.

Find in Finder Displays the PAT file in Finder that contains the selected pattern in the Pattern list.

Pattern List
Displays a list of all available patterns based on the selected pattern category.

List/Icon View
Toggles the view of the pattern previews between List and Icon only. List view displays a small preview image and the name of the pattern.

Search
Filters the Pattern list based on the entered text string. Click 'X' to clear the current text string.

See also:
Overview of Hatch Patterns and Fills
-HATCH

Uses command prompts to fill an enclosed area or selected objects with a hatch pattern, solid fill, or gradient fill.

List of Prompts

The following prompts are displayed.
Specify internal point (page 491) or [Properties (page 491)/Select objects (page 492)/DRAW boundary (page 493)/remove Boundaries (page 493)/Advanced (page 493)/DRAW order (page 496)/Origin (page 496)/ANnotative (page 497)/hatch Color (page 497)/LAYER (page 497)/Transparency (page 497)]: Specify a point or enter an option

**Internal Point**

Determines a boundary from existing objects that form an enclosed area around the specified point.

**Pick Internal Point** While specifying internal points, you can right-click in the drawing area at any time to display a shortcut menu that contains several options.

If you turn on Island Detection, objects that enclose areas within the outermost boundary are detected as islands. How HATCH detects objects using this option depends on which island detection method is specified.

**NOTE** Red circles are displayed at unconnected endpoints of boundary objects to identify gaps in the hatch boundary. These circles are temporary and can be removed with REDRAW (page 881) or REGEN (page 889).

**Properties**

Specifies new hatch pattern properties to apply.
Pattern Name—Predefined or Custom Specifies a predefined pattern in the acad.pat or acadiso.pat file or a custom pattern in its own PAT file.
Enter the pattern name followed by an optional hatch style code. Precede the pattern name with an asterisk (*) to fill the area with individual lines instead of a hatch object.

?—List Pattern Names Lists and describes the hatch patterns defined in the acad.pat file.

Solid Specifies a solid fill and redisplay the first HATCH prompt, where you can define a boundary.

User Defined Specifies a user-defined pattern. Enter u, followed by an optional hatch style code. Precede the u with an asterisk (*) to fill the area with individual lines instead of a hatch object.

Double Hatch Area Specifies a second set of lines to be drawn at 90 degrees to the original lines.

Select Objects
Determines a boundary from selected objects that form an enclosed area.

Select Objects Interior objects are not automatically detected. You must select the objects within the selected boundary to hatch or fill those objects according to the current island detection style.

Each time you click Select Objects, HATCH clears the previous selection set.
While selecting objects, you can right-click at any time in the drawing area to display a shortcut menu. You can undo the last selection or all selections, change the selection method, change the island detection style, or preview the hatch or fill.

**Draw Boundary**  
Uses specified points to define the boundary of a hatch or fill.

The options that are available as you specify points are also available in PLINE (page 796). When you complete the polyline boundary, press Enter. You can then create additional polyline boundaries, or press Enter to twice to apply the hatch.

**NOTE** To enclose an area completely, use the Close option. Do not make the first and last points coincident.

**Remove Boundaries**  
Removes from the boundary definition any of the objects that were previously added.

**Select Objects** Removes objects from the boundary definition.

**Add Boundaries** Adds objects to the boundary definition.

**Advanced**  
Sets the method used to create the hatch boundary.

**Boundary Set**  
Specifies a limited set of objects, called a boundary set, for evaluation by the pick point of the hatch

**New** Creates a boundary set from the selected objects.

**Everything** Creates a boundary set from everything visible in the current viewport. Selecting this option discards any current boundary set and uses everything visible in the drawing or in the current viewport.

**Retain Boundary**  
Creates an object that encloses each hatch object.

**Island Detection**  
Specifies whether to use objects within the outermost boundary as boundary objects.

Specifying no island detection prompts for the ray casting method.

**Nearest** Runs a line from the point you specify to the nearest object and then traces the boundary in a counterclockwise direction.
+X Runs a line in the positive X direction from the point you specify to the first object encountered and then traces the boundary in a counterclockwise direction.

-X Runs a line in the negative X direction from the point you specify to the first object encountered and then traces the boundary in a counterclockwise direction.

+Y Runs a line in the positive Y direction from the point you specify to the first object encountered and then traces the boundary in a counterclockwise direction.

-Y Runs a line in the negative Y direction from the point you specify to the first object encountered and then traces the boundary in a counterclockwise direction.
Angle Runs a line at the specified angle from the point you specify to the first object encountered and then traces the boundary in a counterclockwise direction.

**Style**
Specifies the method used to hatch or fill objects within the outermost hatch boundary. If you have selected no internal objects, a hatching style has no effect. Because you can define a precise set of boundaries, it’s often best to use the Normal style.

Ignore Ignores all internal objects and hatches or fills through them.

**Outer (Recommended)** Hatches or fills inward from the outer boundary. HATCH turns hatching or filling off if it encounters an internal island. This option hatches or fills only the outermost level of the structure and leaves the internal structure blank.

**Normal** Hatches or fills inward from the outer boundary. If HATCH encounters an internal island, it turns off hatching or filling until it encounters another island within the island.
**Associativity**
Specifies that the new hatch pattern is updated when its boundaries are modified.

A new hatch pattern’s associativity is set by the HPASSOC (page 1358) system variable. Changing the associativity setting here also changes the setting in the HPASSOC system variable.

**Gap Tolerance**
Sets the maximum size of gaps that can be ignored when objects are used as a hatch boundary. The default value, 0, specifies that the objects must enclose the area with no gaps.

Any gaps equal to or smaller than the value you specify in the gap tolerance are ignored, and the boundary is treated as closed.

**Separate Hatches**
Controls whether the command creates a single hatch object or multiple hatch objects when several separate closed boundaries are specified.

**Draw Order**
Assigns the draw order to a hatch or fill. You can place a hatch or fill behind all other objects, in front of all other objects, behind the hatch boundary, or in front of the hatch boundary.

**Origin**
Controls the starting location of hatch pattern generation. Some hatches, such as brick patterns, are meant to be aligned with a point on the hatch boundary. By default, all hatch origins correspond to the current UCS origin.

**Use Current Origin** Sets the value of the HPORIGINMODE (page 1366) system variable. The last 5 options listed below correspond to the values 1-5.

**Set New Origin** Specifies the new hatch origin point directly.

**Default to Boundary Extents** Calculates a new origin based on the rectangular extents of the hatch. Choices include each of the four corners of the extents and its center. You can also store the value of the new hatch origin in the HPORIGIN (page 1365) system variable.
**Annotative**
Specifies that the hatch is annotative. This property automates the process of scaling annotations so that they plot or display at the correct size on the paper.

**Hatch Color**
Overrides the current color with a specified color for hatch patterns and solid fills. The color value is stored in the HPCOLOR (page 1360) system variable. When Hatch Type is set to Pattern, you can also specify a new background color. The background color value is stored in the HPBACKGROUND COLOR (page 1358) system variable.

To set the hatch color back to the current color for objects, enter "." or **Use Current**. To turn off the background color, enter "." or **none**.

**Default Object Color** Enter the color number (1 through 255) or the color name (the names for the first seven colors). For example, you can specify the color red by entering the ACI (AutoCAD Color Index) number 1 or the ACI name **red**. You can also set the hatch color to ByLayer or ByBlock.

**Truecolor** Specify an RGB color expressed as values from 0 to 255, such as **210,155,95**.

**Colorbook** Specify a custom color from a color book installed on your system.

**Layer**
Assigns new hatch objects to the specified layer, overriding the current layer. Enter **Use Current** or "." to use the current layer. (HPLAYER (page 1364) system variable)

**Transparency**
Sets the transparency level for new hatches or fills, overriding the current object transparency. Enter **Use Current** or "." to use the current object transparency setting. (HPTRANSPARENCY (page 1368) system variable)

See also:
- Overview of Hatch Patterns and Fills

**HATCHEDIT**
Modifies an existing hatch or fill.

**Access Methods**

- **Menu**: Modify ➤ Object ➤ Hatch
Toolbar: Select a hatch or fill to edit its properties on the Hatch visor.

Shortcut menu: Select a hatch or fill to edit. Right-click in the drawing area and click Hatch Edit.

Pointing device: Double-click a hatch or gradient fill.

Summary

Modifies hatch-specific properties, such as pattern, scale, and angle for an existing hatch or fill.

If you enter `-hatchedit` at the Command prompt, the associated options are displayed (page 499) in the command line.

Selecting a hatch or fill displays the Hatch visor (page 486).

When multiple hatches or fills of different types are selected in a drawing, some of the controls on the Hatch visor are disabled.

List of Options

The following options are displayed.

Select hatch object: Use an object selection method

The Hatch Edit dialog box (page 498) is displayed.

See also:

Modify Hatches and Fills

Hatch Edit Dialog Box

Modifies hatch-specific properties, such as pattern, scale and angle for an existing hatch or fill.

Summary

The options in the Hatch Edit dialog box are the same as the options for the Hatch and Gradient dialog box (page 475). Certain options are available only when creating hatches.

See also:

Modify Hatches and Fills
-HATCHEDIT

Uses command prompts to modify hatch-specific properties, such as pattern, scale, and angle for existing hatches or fills.

List of Prompts

The following prompts are displayed.
Select hatch objects:
Enter hatch option [Disassociate (page 499)/Style (page 499)/Properties (page 499)/Draw order (page 499)/Add boundaries (page 500)/Remove boundaries (page 500)/recreate Boundary (page 500)/Assocate (page 500)/separate Hatches (page 500)/Origin (page 500)/Annotation (page 501)/hatch Color (page 497)/Layer (page 497)/Transparency (page 497)] <Properties>: Enter an option or press Enter

Disassociate
Removes the associative quality from an associative hatch or fill.

Style
Specifies the method used to hatch or fill boundaries within the outermost boundary.

Ignore Ignores all internal objects and hatches or fills through them.

Outer (Recommended) Hatches or fills inward from the outer boundary. HATCH turns hatching or filling off if it encounters an internal island. This option hatches or fills only the outermost level of the structure and leaves the internal structure blank.

Normal Hatches or fills inward from the outer boundary. If HATCH encounters an internal island, it turns off hatching or filling until it encounters another island within the island.

Properties
Specifies new hatch properties for the selected hatch or hatches. You can specify a new pattern or pattern type and then enter the pertinent properties. For an explanation of setting pattern and fill properties at the Command prompt, see -HATCH (page 491).

Draw Order
Assigns a draw order to selected hatches or fills. You can place a hatch or fill behind all other objects, in front of all other objects, behind the hatch boundary, or in front of the hatch boundary. (HPDRAWORDER (page 1361) system variable)
Add Boundaries
Modifies the area of a single hatch or fill by adding boundaries.
Available when editing a single hatch or fill.
For more information, see Add: Pick Points (page 475) or Add: Select Objects (page 476).

Remove Boundaries
Modifies the area of a single hatch or fill by removing boundaries.
Available when editing a single hatch or fill.
For more information, see Remove Boundaries (page 476).

Recreate Boundary
Creates a polyline or region around the selected hatch or fill, and optionally associated with the hatch object with it.
Available when editing a single hatch or fill.
For more information, see Recreate Boundary (page 477).

Associate
Specifies that the hatch or fill is associative. A hatch or fill that is associative is updated when you modify its boundary objects.

Specify Internal Point Determines a boundary from existing objects that form an enclosed area around the specified point, and associates the selected hatch with the boundary objects.

Select Objects Determines a boundary from selected objects that form an enclosed area, and associates the selected hatch with the boundary objects.

Separate Hatches
Separates multiple hatch objects that were created as a single object into individual hatch objects.

Origin
Controls the starting location of hatch pattern generation. Some hatches, such as brick patterns, are meant to be aligned with a point on the hatch boundary. By default, all hatch origins correspond to the current UCS origin.

Use Current Origin Sets the hatch origin to use the value set in the HPORIGINMODE (page 1366) system variable.

Set New Origin Specifies the new hatch origin point directly.

Default to Boundary Extents Calculates a new origin based on the rectangular extents of the hatch. Choices include each of the four corners of the extents.
and its center. You can also store the value of the new hatch origin in the HPORIGIN (page 1365) system variable.

**Annotative**
Specifies that hatches in the selection set are annotative. This property automates the process of scaling annotations so that they plot or display at the correct size on the paper.

**Hatch Color**
Overides the current color with a specified color for hatch patterns and solid fills. The color value is stored in the HPCOLOR (page 1360) system variable. When Hatch Type is set to Pattern, you can also specify a new background color. The background color value is stored in the HPBACKGROUND COLOR (page 1358) system variable.

To set the hatch color back to the current color for objects, enter “.” or **Use Current**. To turn off the background color, enter “.” or **none**.

**Default object color** Enter the color number (1 through 255) or the color name (the names for the first seven colors). For example, you can specify the color red by entering the ACI (AutoCAD Color Index) number 1 or the ACI name **red**. You can also set the hatch color to ByLayer or ByBlock.

**Truecolor** Specify an RGB color expressed as values from 0 to 255, such as **210,155,95**.

**Colorbook** Specify a custom color from a color book installed on your system.

**Layer**
Assigns new hatch objects to the specified layer, overriding the current layer. Enter **Use Current** or “.” to use the current layer.

**Transparency**
Sets the transparency level for new hatches or fills, overriding the current object transparency. Enter **Use Current** or “.” to use the current object transparency setting.

See also:
* Modify Hatches and Fills

**HATCHGENERATEBOUNDARY**

Creates a non-associated polyline around a selected hatch.
Access Methods

Shortcut menu: Select a hatch object. Right-click and choose Generate Boundary.

Summary
Create a new non-associative polyline boundary around the selected hatch.

List of Prompts

The following prompts are displayed.
Select hatch objects: Use an object selection method and press Enter.

See also:
Set Property Overrides for Hatches and Fills
Control How Overlapping Objects Are Displayed

HATCHSETBOUNDARY

Redefines a selected hatch or fill to conform to a different closed boundary.

Access Methods

Shortcut menu: Select a hatch object. Right-click and choose Set Boundary.

Summary
Trims a selected hatch to within a selected boundary or geometry.

List of Prompts

The following prompts are displayed.
Select hatch object: Select hatch object to be trimmed.
Select objects to be used for the new boundary: Select the new boundary or geometry and press Enter.

See also:
Set Property Overrides for Hatches and Fills
Control How Overlapping Objects Are Displayed
HATCHSETORIGIN

Controls the starting location of hatch pattern generation for a selected hatch.

Access Methods

Shortcut menu: Select a hatch object. Right-click and choose Set Origin.

Summary

Controls the hatch origin location point for solid and gradient hatches. You can select and change multiple hatch objects and change their hatch origin for multiple hatches at the same time.

List of Prompts

The following prompts are displayed.
Select hatch object: Select the hatch object.
Select new hatch origin: Click inside the hatch to change the origin point.

See also:

Set Property Overrides for Hatches and Fills
Control How Overlapping Objects Are Displayed

HATCHTOBACK

Sets the draw order for all hatches in the drawing to be behind all other objects.

Access Methods

Button

Toolbar: Drafting tool set ➤ Move/Rotate/Scale tool group (expanded)
➤ Draw Order flyout ➤ Send Hatches to Back
Menu: Tools ➤ Draw Order ➤ Send Hatches to Back
Summary

Selects all hatches in the drawing, including hatch patterns, solid fills, and gradient fills, and sets their draw order to be behind all other objects. Hatch objects on locked layers are also modified.

See also:
- Set Property Overrides for Hatches and Fills
- Control How Overlapping Objects Are Displayed

HELIX

Creates a 2D spiral or 3D spring.

Access Methods

Button

 Toolbar: Modeling tool set ➤ Open Shapes tool group (expanded) ➤ Helix

Menu: Draw ➤ Helix

Summary

Use a helix as a sweep path for the SWEEP (page 1062) command to create springs, threads, and circular stairways.
Initially, the default base radius is set to 1. During a drawing session, the default value for the base radius is always the previously entered base radius value for any solid primitive or helix.

The default value for the top radius is always the value of the base radius.

The base radius and top radius cannot both be set to 0.

**List of Prompts**

The following prompts are displayed.

Number of turns = 3 (*default*)

Twist = CCW (*default*)

Specify center point of base: *Specify a point*

Specify base radius or [Diameter (page 505)] <1.0000>: *Specify a base radius, enter d to specify the diameter, or press Enter to specify the default base radius value*

Specify top radius or [Diameter (page 505)] <1.0000>: *Specify a top radius, enter d to specify the diameter, or press Enter to specify the default top radius value*

Specify helix height or [Axis endpoint (page 505)/Turns (page 506)/turn Height (page 506)/tWist (page 506)] <1.0000>: *Specify a helix height, or enter an option*

**Diameter (Base)**

Specifies the diameter of the base of the helix.

Specify diameter <2.0000>: *Specify a diameter or press Enter to specify the default value*

Initially, the default base diameter is set to 2. During a drawing session, the default value for the base diameter is always the previously entered base diameter value.

**Diameter (Top)**

Specifies the diameter of the top of the helix.

Specify diameter <2.0000>: *Specify a diameter or press Enter to specify the default value*

The default value for the top diameter is always the value of the base diameter.

**Axis Endpoint**

Specifies the endpoint location for the helix axis. The axis endpoint can be located anywhere in 3D space. The axis endpoint defines the length and orientation of the helix.
Specify axis endpoint: Specify a point

**Turns**
Specifies the number of turns (revolutions) for the helix. The number of turns for a helix cannot exceed 500.

Initially, the default value for the number of turns is three. During a drawing session, the default value for the number of turns is always the previously entered number of turns value.

Enter number of turns: Enter a number

**Turn Height**
Specifies the height of one complete turn within the helix.

The number of turns in the helix will automatically update accordingly when a turn height value is specified. If the number of turns for the helix has been specified, you cannot enter a value for the turn height.

Specify distance between turns <default>: Enter a number to specify the height for each turn in the helix

**Twist**
Specifies whether the helix is drawn in the clockwise (CW) or the counterclockwise (CCW) direction. The default value for the helix twist is CCW.

Enter twist direction of helix [CW/CCW] <CCW>: Specify a twist direction for the helix

See also:
- Draw Helixes

**HELP**
Displays Help.

**Access Methods**

- **Menu:** Help ➤ AutoCAD Help
- **Command entry:** Cmd-/> or Fn-F1 (or 'help for transparent use)
Summary

Executing the HELP command while a command is active displays Help for that command. You can also click the Help icon that appears on the right side of the command line when a command is active. Clicking the Help button in a dialog box displays Help for that dialog box.

See also:
Access and Search the Product Help

HIDE

Regenerates a 3D wireframe model with hidden lines suppressed.

Access Methods

Menu: View ➤ Hide

Summary

When you use VPOINT (page 1149), DVIEW (page 389), or VIEW (page 1139) to create a 3D view of your 2D drawing, a wireframe is displayed in the current viewport. All lines are present, including those hidden by other objects. HIDE eliminates the hidden lines from the screen.

HIDE considers the following to be opaque surfaces that hide objects: circles, solids, traces, text, regions, wide polyline segments, 3D faces, polygon meshes, and the extruded edges of objects with nonzero thickness.

If they are extruded, circles, solids, traces, and wide polyline segments are treated as solid objects with top and bottom faces. You cannot use HIDE on objects whose layers have been frozen; however, you can use HIDE on objects whose layers have been turned off.

To hide text created with MTEXT or TEXT, the HIDETEXT (page 1356) system variable must be set to 1 or the text must be assigned a thickness value.
When using the HIDE command, if the `INTERSECTIONDISPLAY` (page 1380) system variable is on, face-to-face intersections of 3D surfaces are displayed as polylines.

The 3D Hidden visual style does not honor the setting of `INTERSECTIONDISPLAY`.

If the `DISPSILH` (page 1293) system variable is on, HIDE displays 3D solid objects with silhouette edges only. It won’t show the internal edges produced by objects that have facets.

If the `HIDETEXT` system variable is off, HIDE ignores text objects when producing the hidden view. Text objects are always displayed regardless of whether they are obscured by other objects, and objects obscured by text objects are unaffected.

**See also:**

Use a Visual Style to Display Your Model
HIDEOBJECTS

Hides selected objects.

Access Methods

Button

Menu: Tools ➤ Isolate ➤ Hide Objects
Shortcut menu: Right-click in the drawing area and click Isolate ➤ Hide Objects.

Summary

Temporarily hides selected objects in the current view. All other objects are visible.

List of Prompts

The following prompt is displayed.
Select objects:  Use an object selection method

See also:
Control the Display of Objects

HIDEPALETTES

Hides all currently displayed palettes, including the command window.

Access Methods

Command entry: Tab

Summary

Hides all currently displayed palettes such as the Command Line, Layers, and Properties Inspector.
See also:

Specify the Behavior of Palettes

I Commands

ID

Displays the UCS coordinate values of a specified location.

Access Methods

- Menu: Tools ➤ Inquiry ➤ ID Point
- Command entry: ‘id’ for transparent use

Summary

ID lists the X, Y, and Z values of the specified point and stores the coordinate of the specified point as the last point. You can reference the last point by entering @ at the next prompt that requests a point.

List of Prompts

The following prompts are displayed.

Specify Point: Use the pointing device to specify a point

The UCS coordinate values of the location are displayed at the Command prompt.

If you snap to an object in 3D space, the Z coordinate value is the same as that of the selected feature of the object.

See also:

- Obtain Distances, Angles, and Point Locations

IMAGE

Displays the Reference Manager palette.
Access Methods

Menu: File ➤ Attach
Menu: Insert ➤ Reference Manager

Summary

The Reference Manager palette (page 418) is displayed.
If you enter -image at the Command prompt, options are displayed (page 511).

See also:

Attach Raster Images

-IMAGE

Attaches a raster image to the drawing.

List of Prompts

The following prompts are displayed.
Enter image option [? (page 511)/Detach (page 511)/Path (page 511)/Reload (page 512)/Unload (page 512)/Attach (page 512)]
<Attach>: Enter an option or press Enter

?—List Images
Lists the images by name in alphabetical order, the number of times each is attached to the drawing, and the path where the image is stored. Images are listed in alphabetical order, regardless of the setting of the MAXSORT (page 1406) system variable.

Detach
Detaches the named image from the drawing, marks it for deletion, and erases all occurrences of the image.

Path
Updates the path name (including file name) associated with a particular image. This option is useful if you change the location of an image file, rename the file, or replace an old image file with a new file; for instance, you can update image01.png and save it as image02.png.

If you enter an asterisk (*), the following prompt is displayed:
Old path: *Lists the current path name for each image*

Enter New path: *Enter the new path name for the specified image*

**Reload**
Reloads the selected images, making that information available for display and plotting.

**Unload**
Removes image data from working memory so that the images are not displayed, thus improving performance. All information associated with the image remains stored with the drawing. The image frame of each attached image remains visible.

**Attach**
Attaches a new image or a copy of an attached image to the current drawing. The Select Image File dialog box (a standard file selection dialog box (page 723)) is displayed.

The file name without the extension is assigned as the image name. Image names can include up to 255 characters and contain letters, digits, spaces, and any special characters not used by the operating system or this program. If the file name is not a valid name for a non-graphical object, the Substitute Image Name dialog box is displayed. A valid image name is generated from the file name and an underscore and number are appended to the name.

If a definition with the same name and path exists in the drawing, the following prompts are displayed and the image is inserted as a copy:

- Image file name has already been loaded.
- Use IMAGE Reload to update its definition.
- Specify insertion point <0,0>: *Specify an insertion point*
- Base image size: Width: *current width*, Height: *current height, current unit*
- Specify scale factor: *Enter a value or press Enter*
- Specify rotation angle <0>: *Enter a value or press Enter*

If the FILEDIA (page 1334) system variable is set to 0, the following prompt is displayed instead of the dialog box:

Enter image file name to attach <last>: *Enter an image name*

The last image name attached to the drawing during the current session is the default. To avoid errors when entering an image name, it is recommended that you specify both the image name and the file name as follows:

*imagename=path name/long file name.bmp*
If you enter a valid image name without a file extension, the program searches for the file in this order: first, an existing image definition in the drawing, and second, an image file in the folders in order of the search path. The program searches for all the image files with the specified name, regardless of extension, and uses the first name found. If no image name or image file is found, the message “Image Not Found” is displayed and the prompt is repeated.

To specify a long file name that does not conform to this program's naming rules, enter the name as follows:

"imagename=filename"

You can use a dialog box to search for image files but still enter the imagename=filename convention at the Command prompt. Enter a tilde (~) at the Enter Image File Name to Attach prompt. If you press Esc after the dialog box opens, the Enter Image Name prompt is displayed.

See also:
Attach Raster Images

**IMAGEADJUST (-IMAGEADJUST)**

Controls the image display of the brightness, contrast, and fade values of images.

**Access Methods**

Menu: Modify ➤ Object ➤ Image ➤ Adjust

**List of Prompts**

The following prompts are displayed.

If you select a single image, the default values for Brightness, Contrast, and Fade are the current property settings of the image. If you select multiple images, the default values for Brightness, Contrast, and Fade are 50, 50, and 0, respectively.

Contrast Controls the contrast, and indirectly, the fading effect of the image. The greater the value, the more each pixel is forced to its primary or secondary color.
**Brightness** Controls the brightness, and indirectly the contrast, of the image. The greater the value, the brighter the image and the more pixels that become white when you increase contrast.

**Fade** Controls the fading effect of the image. The greater the value, the more the image blends with the current background color. A value of 100 blends the image completely into the background. Changing the screen background color causes the image to fade to the new color. In plotting, the background color for fade is white.

**See also:**
Change Raster Image Brightness, Contrast, and Fade

---

**IMAGEATTACH**

Inserts a reference to an image file.

**Access Methods**

Menu: Insert ➤ Raster Image Reference

**Summary**

When you attach an image file, you link that referenced file to the current drawing. Any changes to the referenced file are displayed in the current drawing when it is opened or reloaded.

The Select Reference File dialog box (a standard file selection dialog box (page 723)) is displayed. Once you select an image file, the Attach Image dialog box (page 514) is displayed.

**See also:**
Attach Raster Images

**Attach Image Dialog Box**

Locates, inserts, names, and defines the parameters and details of attached images.
List of Options

The following options are displayed.

**Name**
Identifies the image you have selected to attach.

**Browse**
Opens the Select Reference File dialog (a standard file selection dialog box (page 723)).

**Preview**
Displays the image that you have selected to attach.

**Insertion Point**
Specifies the insertion point for the selected image file. Specify On-Screen is the default. The default insertion point is 0,0,0.

**Specify On-Screen** Directs input at the Command prompt or the pointing device. If Specify On-Screen is cleared, enter the insertion point in X, Y, and Z.

X Sets the X coordinate value.
Y Sets the Y coordinate value.
Z Sets the Z coordinate value.

**Scale**
Specifies the scale factor of the selected image.
If **INSUNITS** (page 1373) is set to “unitless” or if the image does not contain resolution information, the scale factor becomes the image width in AutoCAD units. If **INSUNITS** has a value such as millimeters, centimeters, inches, or feet, and the image has resolution information, the scale factor is applied after the true width of the image in AutoCAD units is determined.

**Specify On-Screen** Allows you to input at the Command prompt or the pointing device. If Specify On-Screen is cleared, enter a value for the scale factor. The default scale factor is 1.

**Scale Factor Field** Enter a value for the scale factor. The default scale factor is 1.

**Rotation**
Specifies the rotation angle of the selected image.

**Specify On-Screen** If Specify On-Screen is selected, you may wait until you exit the dialog box to rotate the object with your pointing device or enter a rotation angle value at the Command prompt.

**Angle** If Specify On-Screen is cleared, enter the rotation angle value in the dialog box. The default rotation angle is 0.

**Path Type**
Select the full (absolute) path, the relative path to the image file, or No Path, the name of the image file (the image file must be located in the same folder as the current drawing file).

**Details**
Displays details about the selected image file.

**Resolution** Displays the number of horizontal and vertical pixels per the current unit measurement in AutoCAD.

**Unit** Displays the current AutoCAD unit.

**Image Size in Pixels** Displays the width and height of the raster image measured in pixels.

**Image Size in Units** Displays the width and height of the raster image measured in AutoCAD units.

**Path**
- **Found In.** Displays the path where the image file is located.
- **Saved Path.** Displays the path that is saved with the drawing when the image file is attached. The path is dependent upon the Path Type setting.
See also:
Attach Raster Images

Image Visor

Displays options for modifying attached images.

Summary

The Image visor is displayed when you select an attached image.

List of Options

The following options are displayed.

Brightness Controls the brightness and the contrast of the image. The greater the value, the brighter the image. (IMAGEADJUST (page 513) command)

Contrast Controls the contrast and the fading effect of the image. The greater the value, the more the image fades. (IMAGEADJUST (page 513) command)

Fade Controls the fading of an image. The greater the value, the more the image blends with the current background color. (IMAGEADJUST (page 513) command)

Background Transparency Toggles the use of background transparency so that objects beneath the image are visible.

Visibility Toggles the display of the image.

Create the Clipping Boundary Crops the display of the selected image to a specified boundary. (IMAGECLIP (page 518) command)

Delete the Clipping Boundary Removes the clipping boundary from the selected image. (IMAGECLIP (page 518) command)

External reference Manager Opens or closes the Reference Manager palette. (EXTERNALREFERENCES (page 418) command)
See also:
Attach Raster Images

**IMAGECLIP**

Crops the display of a selected image to a specified boundary.

**Access Methods**

Menu: Modify ➤ Clip ➤ Image
Shortcut menu: Select an image to clip. Right-click in the drawing area and choose Clip Image.

**Summary**

The clipping boundary determines the portion of a raster image that is hidden, either outside or inside the boundary. The visibility of the clipping boundary is controlled by the IMAGEFRAME (page 1369) system variable. The boundary you specify must be in a plane parallel to the image object.

**Tip** Use the CLIP (page 201) command to clip any type of referenced file: images, external references, viewports, and PDF underlays.

**List of Prompts**

The following prompts are displayed.

**On**
Turns on clipping and displays the image clipped to the previously defined boundary.

**Off**
Turns off clipping and displays the entire image and frame.

If you reclip the image while clipping is turned off, clipping is automatically turned back on. You are prompted to delete the old boundary even when clipping is turned off and the clipping boundary is not visible.

**Delete**
Removes a predefined clipping boundary and redisplays the full original image.
**New Boundary**
Defines a rectangular or polygonal clipping boundary, or generates a polygonal clipping boundary from a polyline.

**NOTE**
You can only create a new clipping boundary for a selected IMAGE underlay after the old boundary is deleted.

**Select Polyline** Defines the boundary with the selected polyline. The polyline can be open but must consist of straight line segments and cannot intersect itself.

**Polygonal** Defines a polygonal clipping boundary with three or more points that you specify for the vertices of a polygon.

**Rectangular** Defines a rectangular boundary with the points that you specify for opposite corners.

**Invert Clip** Inverts the mode of the clipping boundary: objects are clipped either outside the boundary or inside the boundary.

**See also:**
Clip Raster Images

**IMAGEQUALITY**
Controls the display quality of images.

**Access Methods**

*Menu: Modify ➤ Object ➤ Image ➤ Quality*

**Summary**
The quality setting affects display performance; high-quality images take longer to display. Changing the setting updates the display immediately without causing a regeneration of the drawing.

**NOTE** Images are always plotted using a high-quality setting.
List of Prompts

The following prompts are displayed.

**High** Produces a high-quality display of the image.

**Draft** Produces a lower-quality display of the image.

See also:

  Improve the Display Speed of Raster Images

**IMPORT**

Imports files of different formats into the current drawing.

**Access Methods**

Menu: File ➤ Import

**Summary**

You can import data files, other than DWG files, that were created with other applications into the current drawing. The import process translates data into the corresponding DWG file data.

The Import File dialog box (a standard file selection dialog box (page 723)) is displayed.

In Files of type, select the file format to import. In File Name, select the file name to import. The file is imported into the drawing. The following formats are available for import:

- **ACIS (*.sat)**: ACIS solid object files (see ACISIN (page 55))

If **FILEDIA** (page 1334) = 0, the following prompt is displayed:

Enter import file name: *Enter path and file name*

See also:

Import Other File Formats
IMPRINT

Imprints 2D geometry on a 3D solid or surface, creating additional edges on planar faces.

Access Methods

Menu: Modify ➤ Solid Editing ➤ Imprint Edges

Summary

2D geometry located on a face or the intersection of a 3D solid with a face can be combined with that face to create additional edges. These edges can provide a visual effect, and can be pressed and pulled to create indentations and extrusions.

The object to be imprinted must intersect one or more faces on the selected solid in order for imprinting to be successful. Imprinting is limited to the following objects: arcs, circles, lines, 2D and 3D polylines, ellipses, splines, regions, bodies, and 3D solids.

List of Prompts

The following prompts are displayed.

Select a 3D solid or surface Specifies a 3D solid or surface object to be imprinted.

Select an object to imprint Specifies an object that intersects the 3D object you selected.

Delete the source object Specifies whether to remove the object whose shape served as the imprint outline.
INSERT

Inserts a block or drawing into the current drawing.

Access Methods

Button

'icon' Toolbar: Drafting tool set ➤ Block tool group ➤ Insert
'icon' Menu: Insert ➤ Block

Summary

The Insert Block dialog box (page 522) is displayed.

If you enter -insert at the Command prompt, options are displayed (page 525).

A good practice is to insert a block from a block library. A block library can be a drawing file that stores related block definitions or it can be a folder that contains related drawing files, each of which can be inserted as a block. With either method, blocks are standardized and accessible to multiple users.

See also:

Insert Blocks

Insert Dialog Box

Specifies the name and position of the block or drawing to insert.
Summary

The position of the inserted block depends on the orientation of the UCS.

Name

Specifies the name of a block to insert, or the name of a file to insert as a block.

Browse

Opens the Select Drawing File dialog box (a standard file selection dialog box) where you can select a block or drawing file to insert.

Path

Specifies the path to the block.

Explode Block

Explodes the block and inserts the individual parts of the block. When Explode is selected, you can specify a uniform scale factor only.
Component objects of a block drawn on layer 0 remain on that layer. Objects having color BYBLOCK are white. Objects with linetype BYBLOCK have the CONTINUOUS linetype.

**Description** Displays the description that was saved with the block.

**Preview**
Displays a preview of the specified block to insert. A lightning bolt icon in the lower-right corner of the preview indicates that the block is dynamic. A icon indicates that the block is annotative.

**Show\Hide Insertion Options**
Expands or collapses the Insertion Options section to allow you to specify the insertion point, rotation and scale for the block reference being created.

**Insertion Point**
Specifies the insertion point for the block.

**Specify On-Screen**
Specifies the insertion point of the block using the pointing device.

X
Sets the X coordinate value.

Y
Sets the Y coordinate value.

Z
Sets the Z coordinate value.

**Scale**
Specifies the scale for the inserted block. Specifying negative values for the X, Y, and Z scale factors inserts a mirror image of a block.

**Specify On-Screen**
Specifies the scale of the block using the pointing device.

X
Sets the X scale factor.
Y
Sets the Y scale factor.

Z
Sets the Z scale factor.

Uniform Scale
Specifies a single scale value for X, Y, and Z coordinates.

Rotation
Specifies the rotation angle for the inserted block in the current UCS.

Specify On-Screen
Specifies the rotation of the block using the pointing device.

Angle
Sets a rotation angle for the inserted block.

Block Unit
Displays information about the block units.

Unit
Specifies the INSUNITS (page 1373) value for the inserted block.

Factor
Displays the unit scale factor, which is calculated based on the INSUNITS (page 1373) value of the block and the drawing units.

See also:
Insert Blocks

-INSERT
Inserts a block or drawing into the current drawing.

List of Prompts
The following prompts are displayed.
Enter block name (page 526) or [? (page 527)] <last>: Enter a name, enter ?, enter ~, or press Enter.

Units: <INSUNITS (page 1373) specified for inserted block> Conversion: <conversion scale>

Specify insertion point (page 527) or [Basepoint (page 527)/Scale (page 527)/X (page 527)/Y (page 527)/Z (page 527)/Rotate (page 527)]: Specify a point or enter an option.

**Block Name**

Entering a tilde (~) displays the Select Drawing File dialog box (a standard file selection dialog box (page 723)).

You can control block insertion behavior in response to the Enter Block Name prompt by following the listed examples.

- **Inserting Exploded Blocks:** Preceding the name of the block with an asterisk (*) explodes the block and inserts the individual parts of it. The block definition is not added to the drawing.

- **Updating a Block Path:** If you enter a block name without a path name, INSERT searches the current drawing data for an existing block definition by that name. You can replace an existing block definition with an external file by entering the following at the Enter Block Name prompt:

  block name=file name

- **Updating a Block Definition:** If you make changes to a block file that is inserted in your drawing and you want to change the existing block definition without creating a new block insertion, enter the following at the Specify Insertion Point prompt (following the Enter Block Name prompt):

  block name=

  If you enter = after the block name, the following prompt is displayed:
  Block 'current' already exists. Redefine it? [Yes/No] <Yes/No>: Entry, enter n, or press Enter.
  If you choose to redefine the block, the existing block definition is replaced with the new block definition. The drawing is regenerated, and the new definition is applied to all existing insertions of the block definition. Press Esc when prompted for the insertion point if you do not want to insert a new block into the drawing.

**NOTE** Grouped objects in an inserted drawing are inserted as unnamed groups. You can list unnamed groups with the GROUP command.
—List Block Names
Lists the blocks currently defined in the drawing.

Insertion Point
Specifies a location for the block or drawing.

Scale Factor All X and Y dimensions of the block or drawing are multiplied by the X and Y scale factors. The block or drawing is rotated by the specified angle, using the insertion point as the center of rotation.

Corner Defines the X and Y scale factors at the same time, using the insertion point and another point as the corners of a box. The X and Y dimensions of the box become the X and Y scale factors. The insertion point is the first corner.

XYZ Sets X, Y, and Z scale factors.

Basepoint Temporarily drops the block in the drawing where it is currently positioned and allows you to specify a new base point for the block reference as it is dragged into position. This does not affect the actual base point defined for the block reference.

Scale Sets the scale factor for the X, Y, and Z axes. The scale for the Z axis is the absolute value of the specified scale factor.

X Sets the X scale factor.

Y Sets the Y scale factor.

Z Sets the Z scale factor.

Rotate Sets the angle of insertion for the block.

See also:
Insert Blocks
INTERFERE

Creates a temporary 3D solid from the interferences between two sets of selected 3D solids.

Access Methods

Button

 pä Menu: Modify ➤ 3D Operations ➤ Interference Checking

Summary

Interferences are highlighted with a temporary 3D solid that represents the intersecting volume. You can also choose to retain the overlapping volumes.

If you define a single selection set, INTERFERE checks all the solids in the set against one another. If you define two selection sets, INTERFERE checks the solids in the first selection set against those in the second selection set. If you include the same 3D solid in both selection sets, INTERFERE considers the 3D solid part of the first selection set and ignores it in the second selection set.
Pressing Enter starts the interference testing of pairs of 3D solids and displays the Interference Checking dialog box (page 530).

If you enter -interfere at the Command prompt, options are displayed (page 532).

**List of Prompts**

The following prompts are displayed.

**First set of objects** Specifies a set of objects to be checked. If you do not select a second set of objects, all objects in this selection set are checked against each other.
- **Second set of objects** (page 529)
- **Nested selection** (page 529)
- **Settings** (page 529)

**Second set of objects** Specifies an additional set of objects to be compared against the first set of objects. If you select the same object twice, the object is handled as part of the first selection set.
- **Second set of objects** (page 529)
- **Nested selection** (page 529)
- **Check first set.** Initiates interference checking for only the first selection set and displays the Interference Checking dialog box.
- **Check.** Initiates interference checking for both sets of objects and displays the Interference Checking dialog box.

**Nested selection** Provides access to individual solid objects that are nested in blocks and xrefs.
- **Select nested objects.** Specifies which nested objects to include in the selection set.
- **Exit.** Restores normal object selection (not nested).

**Settings** Displays the Interference Settings dialog box (page 530).

**See also:**

Check 3D Models for Interferences
Interference Settings Dialog Box

Controls the display of interference objects

List of Options

The following options are displayed.

Interference Objects
Specifies the visual style and color for interference objects.

Visual Style
Specifies the visual style for interference objects (INTERFEREOBJVS (page 1379)).

Color
Specifies the color for interference objects (INTERFERENCECOLOR (page 1378)).

Highlight Interfering Pair
Highlights the interfering pair of solids.

Highlight Interference
Highlights the interference objects created from the interfering pair.

Viewport
Specifies the viewport display while checking for interferences.

Visual Style
Specifies the visual style for the viewport while checking for interferences (INTERFEREVPVS (page 1379)).

See also:

Check 3D Models for Interferences

Interference Checking Dialog Box

Cycles through, zooms, and deletes or retains interference objects.
List of Options

The following options are displayed.

**Interfering Objects**
Displays the number of interferences found between each set during the `INTERFERE` (page 528) command.

**First Set**
Displays the number of objects selected in the first set.

**Second Set**
Displays the number of objects selected in the second set.

**Interfering Pairs Found**
Displays the number of interferences found among the selected objects.

**Zoom**
Closes the dialog box and starts the `ZOOM` (page 1188) command.

**Pan**
Closes the dialog box and starts the `PAN` (page 767) command.

**3D Orbit**
Closes the dialog box and starts the `3DORBIT` (page 40) command.

**Delete Interference Objects Created on Close**
Deletes the interference objects when the dialog box is closed.

**Zoom to Pair**
Zooms to interference objects while using Previous and Next.

**Previous**
Highlights the previous interference object.
Next
Highlights the next interference object.

Close
Closes the dialog box and deletes the interference objects if that option is selected.

See also:
Check 3D Models for Interferences

-INTERFERE

Summary
INTERFERE highlights all interfering 3D solids and displays the number of objects selected and the number of interfering pairs.

If you define a single selection set, INTERFERE checks all the solids in the set against one another. If you define two selection sets, INTERFERE checks the solids in the first selection set against those in the second selection set. If you include the same 3D solids in both selection sets, INTERFERE considers the 3D solid part of the first selection set and ignores it in the second selection set.

List of Prompts
The following prompts are displayed.
Check for interferences between 2 sets of objects or within 1 set of objects...
Select first set of objects or [Nested selection (page 533)]: Use an object selection method or enter an option
Select second set of objects or [Nested selection (page 533)/check current] <check>: Use an object selection method, enter n, or press Enter to check for interferences

Create Interference Objects Creates and highlights new 3D solids on the current layer that are the intersections of the interfering pairs of 3D solids.
If there are more than two interfering 3D solids, it may not be clear which pairs are interfering if all the interfering 3D objects are highlighted at once.
- Zoom to pairs of interfering objects
Next Pair Cycles through the interfering pairs of 3D solids.

Nested Selection
Allows you to select individual solid objects that are nested in blocks and xrefs.

See also:
Check 3D Models for Interferences

INTERSECT

Creates a 3D solid, surface, or 2D region from overlapping solids, surfaces, or regions.

Access Methods

Button

Toolbar: Modeling tool set ➤ Solids - Edit tool group ➤ Booleans flyout
➤ Intersect

Menu: Modify ➤ Solid Editing ➤ Intersect

Summary

With INTERSECT, you can create a 3D solid from the common volume of two or more existing 3D solids, surfaces, or regions. If you select a mesh, you can convert it to a solid or surface before completing the operation.

You can extrude 2D profiles and then intersect them to create a complex model efficiently.
The selection set can contain regions, solids, and surfaces that lie in any number of arbitrary planes. INTERSECT divides the selection set into subsets and tests for intersections within each subset. The first subset contains all the solids and surfaces in the selection set. The second subset contains the first selected region and all subsequent coplanar regions. The third subset contains the next region that is not coplanar with the first region and all subsequent coplanar regions, and so on until all regions belong to a subset.

See also:
Create Composite Objects

**ISOLATEOBJECTS**

Displays selected objects across layers; unselected objects are hidden.

**Access Methods**

* Menu: Tools ➤ Isolate ➤ Isolate Objects
* Shortcut menu: Right-click in the drawing area and click Isolate ➤ Isolate Objects.

**Summary**

Displays selected objects in the current view. All other objects are temporarily hidden.

**List of Prompts**

The following prompt is displayed.
* Select objects: *Use an object selection method*
See also:
Control the Display of Objects

**ISOPLANE**

Specifies the current isometric plane.

**Access Methods**

**Command entry:** `isoplane` for transparent use

**Summary**

The isometric plane affects the cursor movement keys only when Snap mode is on and the snap style is Isometric. If the snap style is Isometric, Ortho mode uses the appropriate axis pair even if Snap mode is off. The current isometric plane also determines the orientation of isometric circles drawn by **ELLIPSE** (page 406).

You can cycle through the isometric planes by pressing Fn-F5 (or F5).

**List of Prompts**

The following prompts are displayed.

Enter isometric plane setting [Left (page 535)/Top (page 535)/Right (page 536)] <Top>: **Enter an option or press** Enter

**Left**

Selects the left-hand plane, defined by the 90-degree and 150-degree axis pair.

**Top**
Selects the top face of the cube, called the top plane, defined by the 30-degree and 150-degree axis pair.

Right

Selects the right-hand plane, defined by the 90-degree and 30-degree axis pair.

See also:
Set Isometric Grid and Snap

J Commands

JOIN

Joins the endpoints of linear and curved objects to create a single object.

Access Methods

Button

Toolbar: Drafting tool set ➤ Modify tool group (expanded) ➤ Join
Menu: Modify ➤ Join

Summary

Combines a series of finite linear and open curved objects at their common endpoints to create a single 2D or 3D object. The type of object that results depends on the types of objects selected, the type of object selected first, and whether the objects are coplanar.
You can join objects in different planes if the source object is a spline or a 3D polyline. Each type of object has additional restrictions.

**NOTE** Construction lines, rays, and closed objects cannot be joined.

**List of Prompts**

The following prompts are displayed.

*Select source object or multiple objects to join at once:*
*Select lines, polylines, 3D polylines, arcs, elliptical arcs, helixes, or splines.*

**Source Object**

Specifies a single source object to which you can join other objects. Press Enter after selecting the source object to begin selecting the objects to join. The following rules apply for each type of source object:

**Line** Only line objects can be joined to the source line. The line objects must all be collinear, but can have gaps between them.

**Polyline** Lines, polylines, and arcs can be joined to the source polyline. All objects must be contiguous and coplanar. The resulting object is a single polyline.

**3D Polyline** Any linear or curved object can be joined to the source 3D polyline. All the objects must be contiguous, but can be noncoplanar. The resulting object is either a single 3D polyline or a single spline, depending on whether you are joining to a linear or a curved object respectively.

**Arc** Only arcs can be joined to the source arc. All the arc objects must have the same radius and center point, but can have gaps between them. The arcs are joined in a counterclockwise direction starting from the source arc. The Close option converts the source arc into a circle.
**Elliptical Arc** Only elliptical arcs can be joined to the source elliptical arc. The elliptical arcs must be coplanar and have the same major and minor axes, but can have gaps between them. The elliptical arcs are joined counterclockwise starting from the source elliptical arc.

The Close option converts the source elliptical arc into an ellipse.

**Helix** Any linear or curved object can be joined to the source helix. All objects must be contiguous, but can be noncoplanar. The resulting object is a single spline.

**Spline** Any linear or curved object can be joined to the source spline. All objects must be contiguous, but can be noncoplanar. The resulting object is a single spline.

**Multiple Objects to Join at Once**

Joins multiple objects without specifying a source object. The rules and resulting object types are as follows:

- A line object results from joining collinear lines. The lines can have gaps between their endpoints.
- An arc or circle object results from joining coplanar arcs with the same center point and radius. The arcs can have gaps between their endpoints. Lengthening occurs in a counterclockwise direction. A circle object results if the joined arcs form a complete circle.
- A spline object results from joining splines, elliptical arcs, or helixes together, or to other objects. The objects can be noncoplanar.
- A polyline object results from joining coplanar lines, arcs, polylines, or 3D polylines.
- A 3D polyline results from joining noncoplanar objects other than curved objects.

**See also:**

Break and Join Objects

**JPGOUT**

Saves selected objects to a file in JPEG file format.
Summary

The Create Raster File dialog box (a standard file selection dialog box (page 723)) is displayed. Enter the file name in the dialog box.

List of Prompts

The following prompts are displayed.
Select objects or <all objects and viewports>: Press Enter to select all objects and viewports or use an object selection method and press Enter

A JPEG file is created that contains the objects you select. Shade Plot options are preserved in the file when you use this command.

Light glyphs that are displayed in the drawing appear in the new file, even if the Plot Glyph property of the lights is set to No.

NOTE When the FILEDIA (page 1334) system variable is set to 0 (Off), command prompts are displayed.

See also:

Export Raster Files

L Commands

LAYER

Manages layers and layer properties.

Access Methods

Menu: Format ➤ Layer
Command entry: 'layer for transparent use

Summary

The Layers Palette (page 540) is displayed.
If you enter -layer at the Command prompt, options are displayed (page 553).
Use layers to control the visibility of objects and to assign properties such as color and linetype. Objects on a layer normally assume the properties of that layer. However, you can override any layer property of an object. For example, if an object’s color property is set to BYLAYER, the object displays the color of that layer. If the object’s color is set to Red, the object displays as red, regardless of the color assigned to that layer.

See also:
Use Layers to Manage Complexity

Layers Palette
Displays a list of the layers in the drawing and their properties.
Summary

You can add, delete, and rename layers, change their properties, set property overrides for layout viewports, or add layer descriptions and apply changes in realtime.

When switching layouts or when activating a viewport on named (paper space) layout, the Layers palette is updated and displays the current state of the layer properties in the current space.

List of Options

The following options are displayed.

Layer Drop-down
Displays the current layer and its color, along with some of its common properties. Click the drop-down list to adjust a layer's On/Off, Lock/Unlock, or Thaw/Freeze state. You can also select a layer to set it current.

Toolbar
Make Current Sets the current layer to that of a selected object. (See LAYMCUR (page 562) command)

Layer Match Changes the layer of a selected object to match the destination layer. (See LAYMCH (page 561) command)
**Previous Layer** Undoes the last change or set of changes made to layer settings. (See LAYERP (page 557) command)

**Isolate Layer** Hides or locks all layers except those of the selected objects. (See LAYISO (page 559) command)

**Unisolate Layer** Restores all layers that were hidden or locked with the LAYISO command. (See LAYUNISO (page 569) command)

**Freeze Layer** Freezes the layer of selected objects. (See LAYFRZ (page 558) command)

**Layer Off** Turns off the layer of a selected object. (See LAYOFF (page 564) command)

**Lock Layer** Locks the layer of a selected object. (See LAYLCK (page 561) command)

**Unlock Layer** Unlocks the layer of a selected object. (See LAYULK (page 568) command)

**Show/Hide Layer List**
Displays or hides the Layer list which you use to modify the properties of the layers in the current drawing.

**Layer List**
Displays the layers and layer groups in the current drawing and their properties.

Click in the columns for a layer to change its properties.

**Status** Indicates the status of the layer: layer in use, empty layer, or current layer.

**Object Selection** Indicates if the layer is assigned to an object that is currently selected. Objects must be selected when no command is active.

**Visibility** Indicates if the layer is on and off. When a layer is on, it is visible and available for plotting. When a layer is off, it is invisible and not plotted, even if Plot is on.

**Description** Text string that describes the layer.

**Name** Displays the name of the layer.
Press Fn-F2 to enter a new name or click over the name when the layer is highlighted.

**Freeze** Indicates if the layer is frozen or thawed.
Layers can be frozen in all layouts and viewports, including the Model layout. You can freeze layers to speed up ZOOM (page 1188), PAN (page 767), and many
other operations; improve object selection performance; and reduce regeneration time for complex drawings.

Objects on frozen layers are not displayed, plotted, hidden, rendered, or regenerated.

Freeze the layers you want to be invisible for long periods. If you plan to switch visibility settings frequently, use the On/Off property to avoid regenerating the drawing. You can freeze a layer in all viewports, in the current layout viewport, or in new layout viewports as they are created.

**Lock** Indicates if the layer is locked or unlocked. Objects on a locked layer cannot be modified.

**Lineweight** Displays the lineweight associated with the layer. Clicking the lineweight name displays a drop-down list with the available lineweights.

**Linetype** Displays the linetype associated with the layer. Clicking the linetype name displays a drop-down list with the loaded linetypes. Choose Other at the bottom of the drop-down list to display the Select Linetype dialog box (page 552).

**Transparency** Controls the visibility of all objects on the selected layer. When transparency is applied to individual objects, the objects’ transparency property overrides the transparency setting of the layer. Drag the slider to adjust the transparency of objects on the layer.

**Plot (Print)** Indicates if the objects on layer should be plotted or not. If you turn off plotting for a layer, the objects on that layer are still displayed. Layers that are off or frozen are not plotted, regardless of the Plot setting.

**Plot Style** Displays the plot style associated with the layer. If you are working with color-dependent plot styles (the PSTYLEPOLICY (page 1451) system variable is set to 1), you cannot change the plot style associated with a layer. Clicking the plot style name displays a drop-down list with the available plot styles.

**New VP Freeze** Freezes the layer in new viewports created on a named (paper space) layout. For example, freezing the DIMENSIONS layer in all new viewports restricts the display of dimensions on that layer in any newly created named layout viewports but does not affect the DIMENSIONS layer in existing viewports. If you later create a viewport that requires dimensions, you can override the default setting by changing the current viewport setting.

**VP Freeze (not available on the Model layout)** Freezes the layer in the current named (paper space) layout viewport. You can freeze or thaw layers in the current viewport without affecting layer visibility in other viewports.
VP Freeze overrides the Thaw setting for a layer in the drawing. That is, you can freeze a layer in the current viewport if it’s thawed in the drawing, but you can’t thaw a layer in the current viewport if it’s frozen or off in the drawing. A layer is not visible when it is set to Off or Frozen in the drawing.

**VP Color (not available on the Model layout)** Sets an override for the color associated with the selected layer for the active named (paper space) layout viewport.

**VP Lineweight (not available on the Model layout)** Sets an override for the lineweight associated with the selected layer for the active named (paper space) layout viewport.

**VP Linetype (not available on the Model layout)** Sets an override for the linetype associated with the selected layer for the active named (paper space) layout viewport.

**VP Transparency (not available on the Model layout)** Sets an override for transparency associated with the selected layer for the active named (paper space) layout viewport.

**VP Plot Style (not available on the Model layout)** Sets an override for the plot style associated with the selected layer for the active named (paper space) layout viewport. Override settings are not visible in the viewport or plotted when the visual style in the drawing is set to Conceptual or Realistic. If you are working with color-dependent plot styles (the PSTYLEPOLICY (page 1451) system variable is set to 1), you cannot set a plot style override.

**Layer List - Column Heading Label Shortcut Menu**
- **Display All Layer Colors** Toggles the display of the White color swatch in the Color column of the Layer list.
- **Optimize All Columns** Changes the width of all columns to maximize display of the column content.
- **Optimize Column** Changes the width of a column to maximize display of the column content.
- **Restore All Columns to Defaults** Restores all columns to their default display and width settings.

**Layer List - Layer Item Shortcut Menu**
- **Make Active** Sets the selected layer as the current layer. (See CLAYER (page 1229) system variable)
- **Layer Status** Toggles the Freeze, Lock, Freeze in New Viewports, or Prints layer status of the selected layers. The Isolate option isolates the selected layers in
the drawing. All layers except those selected, are turned off and locked. (See LAYISO (page 559) command)

Remove Viewport Overrides For (not available on the Model layout)
Removes the layer property overrides assigned to all layers in the drawing or only for the selected layers in the current viewport only or in all viewports.

Rename Renames the selected layer.

Delete Deletes the selected layer from the drawing. You can delete only unreferenced layers. Referenced layers include layers 0 and DEFPOINTS, layers containing objects (including objects in block definitions), the current layer, and xref-dependent layers.

NOTE Be careful about deleting layers if you are working on a drawing in a shared project or one based on a set of layering standards.

Duplicate Layer Creates a new layer based on the selected layer. The new layer inherits all properties and statuses of the selected layer.

Combine with Layer Displays the Choose a Layer dialog box (page 551) which allows you to merge the selected layers to a specified layer. After the layers are merged, the selected layers are removed from the drawing. (See -LAYMRG (page 563))

Create Group from Layers Creates a new layer group and adds the selected layers as references of the layer group.

Move to Group Displays the Choose a Group dialog box (page 550) which allows you to add the selected layers as references to a specified layer group.

Remove From Group Removes the selected layers from the layer group.

Create Group from Similar Layers Displays the New Dynamic Group dialog box (page 548) and defines a rule for each of the layer's properties. Name the new dynamic group or modify the rules for the new dynamic group before creating the dynamic group.

New Layer Creates a new layer. The layer list displays a layer named Layer1. You can edit the name immediately. The new layer inherits the properties of the currently selected layer in the layer list (color, on or off state, and so on).

New Group Creates a new layer group. The layer list displays a layer group named Group1. You can edit the name immediately.

New Dynamic Group Displays the New Dynamic Group dialog box (page 548) and allows you to create a layer group that contains all the layers based on the layer properties specified.
Select All Layers Selects all layers displayed in the list view.

Select All Others Selects all other layers in the list view except the current selected layers.

Layer List - Layer Group Item Shortcut Menu

Edit Group (Applies to dynamic layer groups only) Displays the New Dynamic Group dialog box and allows you to modify the groups rules.

Group Layer Status Toggles the Visibility, Freeze, or Lock, Freeze in New Viewports, or Prints layer status of the selected layers. The Isolate option isolates the selected layers in the drawing. All layers except those selected, are turned off and locked. (See LAYISO (page 559) command)

Rename Group Renames the selected layer group.

Delete Group Deletes the selected layer group. You have the option to delete just the layer group, or the layer group and the layers that the group references. The GROUPPLAYERDELETABLE (page 1352) system variable controls the removal behavior of layers referenced by a layer group when it is being deleted.

Duplicate Group Creates a new layer group based on the selected layer group. The new layer group inherits the references to all the layers of the selected layer group.

Merge Group Layers Displays the Choose a Layer dialog box (page 551) which allows you to merge the layers in the selected layer group to a specified layer. After the layers are merged, the selected layers are removed from the drawing. (See -LAYMRG (page 563) command)

Convert to Group Creates a layer group from the selected dynamic layer group. When new layers are added or changed, they are no longer automatically added to or removed from the group based on their properties.

New Layer Creates a new layer. The layer list displays a layer named Layer1. You can edit the name immediately. The new layer inherits the properties of the currently selected layer in the layer list (color, on or off state, and so on).

New Group Creates a new layer group. The layer list displays a layer group named Group1. You can edit the name immediately.

New Dynamic Group Displays the New Dynamic Group dialog box and allows you to create a layer group that contains all the layers based on the layer properties specified.

Select Layers in Group Selects all the layers in the selected layer group.
**New Layer**
Creates a new layer. The layer list displays a layer named Layer1. You can edit the name immediately. The new layer inherits the properties of the currently selected layer in the layer list (color, on or off state, and so on).

**New Layer Group**
Creates a new layer group. The layer list displays a layer group named Group1. You can edit the name immediately.

**New Dynamic Layer Group**
Displays the New Dynamic Group dialog box and allows you to create a layer group that contains all the layers based on the layer properties specified.

**Delete Selected (-)**
Deletes the selected layers or layer groups.

You can delete only unreferenced layers. Referenced layers include layers 0 and DEFPOINTS, layers containing objects (including objects in block definitions), the current layer, and xref-dependent layers.

**NOTE** Be careful about deleting layers or layer groups if you are working on a drawing in a shared project or one based on a set of layering standards.

**Display Settings**
Displays a menu of options that controls the display of layer groups, layers, and column headers in the Layer list.

- **Show Layer Groups** Toggles the display of all layer groups. (See `SHOWGROUPS` (page 1473) system variable)
  - **Show Groups on Top.** Displays all layer groups sorted at the top of the Layer list. (See `GROUPSONTOP` (page 1352) system variable)
  - **Show Groups on Bottom.** Displays all layer groups sorted at the bottom of the Layer list. (See `GROUPSONTOP` (page 1352) system variable)

- **Show Empty Groups** Toggles the display of empty layer groups. (See `SHOWEMPTYGROUPS` (page 1472) system variable)

- **Show Xref Layers** Toggles the display of all layers in attached external references (xrefs). (See `SHOWXREFLAYERS` (page 1476) system variable)

- **Show Automatic Groups** Toggles the display of layer groups that are populated dynamically by the product.
  - **All Used Layers.** Toggles the display of the All Used Layers layer group. This layer group dynamically updates to list all the layers that do not currently have any objects on them. (See `SHOWALLUSEDLAYERGROUP` (page 1472) system variable)
■ **External References.** Toggles the display of the Xref layer group. This layer group dynamically updates to list all attached external references (xrefs) as nested layer groups and their layers. Show Xref Layers must be enabled before this layer group can be displayed. (See `SHOWXREFGROUPS` (page 1476) system variable)

■ **Layers with Overrides.** Toggles the display of the Viewport Overrides layer group. This layer group dynamically updates to list all the layers in the active layout viewport that contain property overrides. (See `SHOWVPPOVERRIDESGROUP` (page 1475) system variable)

■ **Unreconciled Layers.** Toggles the display of the Unreconciled Layers layer group. This layer group dynamically updates to list all the layers that have not been reconciled. (See `SHOWUNRECONCILEDLAYERSGROUP` (page 1475) system variable)

**View Options** Toggles the display of the column headings, and provides options to automatically adjust the size of all or the selected column to its maximum width in the Layer list.

**Search for Layer**
Filters the Layer list by name quickly as you enter characters. This filter is not saved when you close the Layers palette.

**See also:**
- Work with Layers

**New Dynamic Group Dialog Box**

Groups layers based on the criteria you select.
Summary

When a dynamic layer group is added to the Layers palette (page 540), layers that match the rules are displayed in the Layer list under the layer group when expanded.

List of Options

The following options are displayed.

Group Name
Provides a space to enter a name for the layer group.

Parent Group
Displays a list of all the layer groups that the new dynamic layer group can be nested under.

Rules
Displays the properties of layers. You can use one or more properties to define the layer group. For example, you can define a layer group that displays all layers that are either Red or Blue and in use. To include more than one color, linetype, or lineweight, add another rule and select a different setting.

Name Use wild-card characters in the edit field to filter layer names. For example, enter *mech* to include all layers with the letters mech in the name.

Freeze State Selects Frozen or Thawed layers.

Viewport Visibility Selects Visible (On) or Hidden (Off) layers.

Lock State Selects Locked or Unlocked layers.

Plot State Selects Plotting or Non-plotting layers.

Color Selects layers that match or do not match the selected color. Choose Select Color to display the Color Palette dialog box (page 205).

Linetype Selects layers that match or do not match the selected linetype. Choose Manage to display the Select Linetype dialog box (page 552).

Lineweight Selects layers that match or do not match the selected lineweight. Choose Manage to display the Lineweight Settings dialog box (page 597).

Transparency Selects layers that match or do not match the specified transparency. Drag the slider to specify a transparency level.

Plot Style (Applies to drawings that use named plot styles) Selects layers that match or do not match the selected named plot style.

New VP Freeze State Selects Frozen or Thawed layers in new viewports.
Viewport Color Selects layers that have a color override, and match or do not match the selected color. Choose Select Color to display the Color Palette dialog box (page 205).

Viewport Freeze State Selects Frozen or thawed layers in the current viewport.

Viewport Linetype Selects layers that have a linetype override, and match or do not match the selected linetype. Choose Manage to display the Select Linetype dialog box (page 552).

Viewport Lineweight Selects layers that have a lineweight override, and match or do not match the selected lineweight. Choose Manage to display the Lineweight Settings dialog box (page 597).

Viewport Transparency Selects layers that have a transparency override, and match or do not match the specified transparency. Drag the slider to specify a transparency level.

Viewport Plot Style (Applies to drawings that use named plot styles) Selects layers that have a plot style override, and match or do not match the selected named plot style.

Layer Selects Used or Not-Used layers in Model space or a viewport.

Remove Rule
Removes a single rule or a grouping of rules.

Create Rule Group
Creates an And grouping of rules. Grouping rules allows you to make complex filters.

Add Rule
Adds a new rule. Use the new set of controls to specify the layer properties and conditions for the rule.

Create Group
Adds the new dynamic group to the Layers palette.

See also:
  Work with Layers

Choose a Group Dialog Box

Adds references of the selected layers to a specified layer group.
List of Options

The following options are displayed.

**Choose a Group to Add the Layer To**
Lists the layer groups that you can add selected layers to.

**Search for Group** Filters the Layer Group list by name as you enter characters.

**Layer Group List** Lists all the layer groups in the current drawing or the layer groups that match the characters entered in the Search for Group text box.

**Add the Layer to a New Group**
Adds the layers selected in the Layers palette to the new layer group.

**Group Name** Specifies the name of the new layer group.

See also:
Work with Layers

**Choose a Layer Dialog Box**

Merges selected layers to a specified layer.
List of Options

The following options are displayed.

**Choose an existing layer to move content to**

Lists the available layers in the current drawing that you can merge the selected layers with from the Layers palette. All objects on the selected layers from the Layers palette are moved to the specified layer and then the layers are removed from the drawing.

**See also:**

Work with Layers

**Select Linetype Dialog Box**

Displays linetypes available in the current drawing.
List of Options

The following options are displayed.

Loaded Linetypes

Displays the list of linetypes loaded in the current drawing.

Load

Displays the Load or Reload Linetypes dialog box (page 581), in which you can load selected linetypes into the drawing and add them to the list of linetypes.

See also:

- Work with Layers

-LAYER

Manages layers and layer properties.

List of Prompts

The following prompts are displayed.

Current layer: "current"

Enter an option [? (page 554)/Make (page 554)/Set (page 554)/New (page 554)/Rename (page 554)/ON (page 554)/OFF (page 554)/Color
NOTE The Pstyle option is available only when you are using named plot styles.

?—List Layers
Displays a list of the currently defined layers, showing their names, states, color numbers, linetypes, lineweights, and whether they are externally dependent layers.

Make
Creates a layer and makes it current. New objects are drawn on the current layer.

If no layer exists for the name you enter, a new layer with that name is created. The new layer is on and assumes the following properties by default: color number 7, the CONTINUOUS linetype, and a lineweight of DEFAULT.

If the layer exists but is turned off, it is turned on.

Set
Specifies a new current layer but does not create the layer if it does not already exist. If the layer exists but is turned off, it is turned on and made current. A frozen layer cannot be made current.

New
Creates layers. You can create two or more layers by entering names separated by commas.

Rename
Renames an existing layer.

On
Makes selected layers visible and available for plotting.

Off
Makes selected layers invisible and excludes them from plotting.

Color
Changes the color associated with a layer. Enter a color name or a number from 1 through 255.

True Color Specifies a true color to be used for the selected object. Enter three integer values from 0 to 255 separated by commas to specify a true color.
Color Book Specifies a color from a loaded color book, guide, or set to use for the selected object. Enter the name of a color book that has been installed, such as "DIC COLOR GUIDE(R)$DIC 43".

The color is assigned to the layer or layers, and the layers are turned on. To assign a color but turn off the layer, precede the color with a minus sign (-).

Ltype Changes the linetype associated with a layer.

Lweight Changes the lineweight associated with a layer.

If you enter a valid lineweight, the current lineweight is set to the new value. If you enter a lineweight that is not valid, the current lineweight is set to the nearest fixed lineweight value. If you would like to plot an object with a custom width not found in the list of fixed lineweight values, you can use the Plot Style Table Editor to customize plotted lineweights.

Transparency Changes the transparency level associated with a layer. Enter a value from 0 to 90.

After specifying a transparency value, the following prompt is displayed:

Enter name list of layer(s) for transparency specified value% <0>: Enter the names of the layers to which to apply this transparency level, or press Enter to apply it to the current layer only

Material Attaches a material to a layer. The material must be available in the drawing before it can be assigned to a layer.

Plot Controls whether visible layers are plotted. If a layer is set to plot but is currently frozen or turned off, the layer is not plotted.

Pstyle Sets the plot style assigned to a layer. This option is not available if you are using color-dependent plot styles in the current drawing (the PSTYLEPOLICY (page 1451) system variable is set to 1).

If you select a plot style other than NORMAL, the following prompt is displayed:

Enter name list of layer(s) for plot style current <current>: Enter the names of the layers to use this plot style, or press Enter to apply the style to the current layer only
**Freeze**
Freezes layers, making them invisible and excluding them from regeneration and plotting.

**Thaw**
Thaws frozen layers, making them visible and available for regeneration and plotting.

**Lock**
Locks layers, preventing editing of objects on those layers.

**Unlock**
Unlocks selected locked layers, permitting editing of objects on those layers.

**State**
Saves and restores the state and property settings of the layers in a drawing.

?—List Named Layer States Lists the named layer state (LAS) files in the support path for the drawing.

**Save** Saves the state and properties settings of the layers in a drawing under a specified layer state name. When saving a layer state, you specify which layer settings are affected when the layer state is later restored.

**Restore** Restores the state and property settings of all layers to previously saved settings. Restores only those layer state and property settings that were selected when the layer state was saved.

**Edit** Changes the saved layer settings for a specified layer state. When the layer state is restored, the specified settings are used.

**Name** Changes the name of a saved layer state.

**Delete** Removes a saved layer state.

**Import** Loads a previously exported layer state (LAS) file, or layers states from a file (DWG, DWT) into the current drawing. Additional layers may be created as a result of importing a layer state file.

**Export** Saves a selected named layer state to a layer state (LAS) file.

**Description**
Sets the description property value of the existing layer.

A warning prompt is displayed when you enter a description to a layer with an existing description.

**Reconcile**
Sets the unreconciled property of an unreconciled layer.

? - Name List of Layers Displays a list of all unreconciled layers.
See also:
Use Layers to Manage Complexity

### LAYERCLOSE

Closes the Layers palette.

**Summary**

Closes the Layers palette if it is open.

See also:
Work with Layers

### LAYERP

Undoes the last change or set of changes made to layer settings.

**Access Methods**

- **Button**
- **Toolbar**: Layers palette ➤ Previous Layer
- **Menu**: Format ➤ Layer Tools ➤ Layer Previous

**Summary**

Undoes changes you have made to layer settings such as color or linetype. If settings are restored, a message is displayed: “Restored previous layer states.”

When you use Layer Previous, it undoes the most recent change using the Layers palette or -LAYER command. Every change you make to layer settings is tracked and can be undone by Layer Previous.

LAYERP (Layer Previous) does not undo the following changes:
- **Renamed layers**: If you rename a layer and change its properties, Layer Previous restores the original properties but not the original name.
- **Deleted layers:** If you delete or purge a layer, using Layer Previous does not restore it.
- **Added layers:** If you add a new layer to a drawing, using Layer Previous does not remove it.

**See also:**
- Change Layer Settings and Layer Properties

**LAYERPMODE**

Turns on and off the tracking of changes made to layer settings.

**Summary**

When Layer Previous mode is on, changes made to layers are tracked. When Layer Previous mode is off, changes made to layers are no longer tracked.

**See also:**
- Change Layer Settings and Layer Properties

**LAYFRZ**

Freezes the layer of selected objects.

**Access Methods**

- **Button**

- **Toolbar:** Layers palette ➤ Freeze Layer
- **Menu:** Format ➤ Layer Tools ➤ Layer Freeze

**Summary**

Objects on frozen layers are invisible. In large drawings, freezing unneeded layers speeds up operations involving display and regeneration. In a layout, you can freeze layers in individual layout viewports.
List of Prompts

The following prompts are displayed.
Current settings: Viewports=\textit{current}, Block nesting level=\textit{current}
Select an object on a layer to be frozen (page 559) or [Settings (page 559)/Undo (page 559)]: Select an object or enter s or u
Layer \textit{<layer name>} has been frozen.

Select an Object on a Layer to be Frozen
Specifies the layer to be frozen.
Layer \textit{"<layer name>"} has been frozen.

Settings
Displays settings for viewports and block definitions. The setting you choose persists from session to session.
Enter setting type for [Viewports/Block selection]:

Viewports Displays settings for viewports.
In paper space viewport use [Freeze/Vpfreeze] <Vpfreeze>: \texttt{Enter} to freeze objects in all viewports or \texttt{v} to freeze an object in the current viewport only

Block Selection Displays settings for block definitions.
- Block. If a selected object is nested in a block, freezes the layer of that block. If a selected object is nested in an xref, freezes the layer of the object.
- Entity. Freezes the layers of selected objects even if they are nested in an xref or a block.
- None. If a block or an xref is selected, freezes the layer containing that block or xref.

Undo
Cancels the previous layer selection.

See also:
Use Layers to Manage Complexity

LAYISO

Hides or locks all layers except those of the selected objects.
Access Methods

Button

 Toolbar: Layers palette ➤ Isolate Layer
 Menu: Format ➤ Layer Tools ➤ Layer Isolate

Summary

All layers except the layers of the selected objects are either turned off, frozen in the current layout viewport, or locked, depending on the current setting. The layers that remain visible and unlocked are called isolated.

List of Prompts

The following prompts are displayed.

Current setting: <current settings>
Select objects on the layer(s) to be isolated or [Settings]:
Select objects or enters

Select Objects on the Layer(s) to be Isolated
After selecting one or more objects, all layers except the layers of the selected objects are either turned off, frozen in the current layout viewport, or locked, depending on the current setting. The layers that remain visible and unlocked are termed isolated.

NOTE Locked layers are faded by default. You can specify the percent of the fading from the Lock option in this command. You can later change the value with the LAYLOCKFADECTL (page 1387) system variable.

If you make changes to layers within a session and you want to restore the layers to the state they were in immediately before you entered the LAYISO command, use the LAYUNISO (page 569) command.

Settings
Controls whether layers are turned off, frozen in the current layout viewports, or locked.

Off Turns off or freezes all layers except the layers of the selected objects.
Vpfreeze In a layout, freezes all but the selected layers in the current layout viewport only. Other layout viewports in the drawing are unchanged. If not in a layout, all other layers are turned off instead.
Off Turns off all but the selected layers in all viewports.

Lock and Fade
Locks all layers except the layers of the selected objects, and sets the fading for locked layers.

See also:
Use Layers to Manage Complexity

LAYLCK
Locks the layer of a selected object.

Access Methods

Button

Toolbar: Layers palette ➤ Lock Layer
Menu: Format ➤ Layer Tools ➤ Layer Lock

Summary
Using this command, you can prevent objects on a layer from being accidentally modified. You can also fade the objects on a locked layer using the LAYLOCKFADECTL system variable.

See also:
Prevent Objects from Being Selected

LAYMCH
Changes the layer of a selected object to match the destination layer.

Access Methods

Button
**Toolbar:** Layers palette ➤ Layer Match
**Menu:** Format ➤ Layer Tools ➤ Layer Match

**List of Prompts**

The following prompts are displayed.

Select objects to be changed: *Select an object to change its layer*

Select object on destination layer (page 562) or [Name (page 562)]: *Select an object or enter n to open the Change to Layer dialog box*

**Select Object on Destination Layer** Select an object on the destination layer.

**Name** Displays the Change to Layer dialog box (page 562).

If you create an object on the wrong layer, you can change its layer to the one you want using LAYMCH.

**See also:**

Use Layers to Manage Complexity

**Change to Layer Dialog Box**

Displays a list of layers to choose as the destination layer. You can also create a new destination layer.

**List of Options**

The following options are displayed.

**Current Layer** Displays the currently selected layer. Create a new layer name by entering a name.

**Destination Layer list** Displays a list of layers in the drawing.

**See also:**

Use Layers to Manage Complexity

**LAYMCUR**

Sets the current layer to that of a selected object.
Access Methods

Button

Toolbar: Layers palette ➤ Make Current
Menu: Format ➤ Layer Tools ➤ Make Object’s Layer Current

Summary

You can change the current layer by selecting an object on that layer. This is a convenient alternative to specifying the layer name in the Layers palette.

See also:

Use Layers to Manage Complexity

LAYMRG (-LAYMRG)

Merges selected layers into a target layer, removing the previous layers from the drawing.

Summary

You can reduce the number of layers in a drawing by merging them. Objects on merged layers are moved to the target layer, and the original layers are purged from the drawing.

List of Prompts

The following prompts are displayed.
Select object on layer to merge (page 563) or [Name (page 563)]: Select an object or enter \( n \) to select a layer from a list of layers

After you selected the layer(s) to merge, the following prompt is displayed:
Select object on target layer (page 564) or [Name (page 564)]: Select an object or enter \( n \) to select a target layer from a list of layers

Select Object on Layer to Merge
Select an object on the destination layer.

Name
Displays a list of layers, where you can select layers to merge.
Select Object on Target Layer
Select an object on the target layer.

Name
Displays a list of layers onto which you can merge the selected object or layer.

See also:
Use Layers to Manage Complexity

LAYOFF

Turns off the layer of a selected object.

Access Methods

 Toolbar: Layers palette ➤ Layer Off
 Menu: Format ➤ Layer Tools ➤ Layer Off

Summary
Turning off the layer of a selected object makes that object invisible. This command is useful if you need an unobstructed view when working in a drawing or if you don’t want to plot details such as reference lines.

List of Prompts
The following prompts are displayed.
Current settings: Viewports=\textit{current}, Block nesting level=\textit{current}
Select an object on the layer to be turned off (page 564) or [Settings (page 564)/Undo (page 565)]: Select an object, enter s, or enter u

Select an Object on the Layer to be Turned Off
Selects one or more objects whose layers you want to turn off.

Settings
Displays the Viewports and Block Definition setting types. The setting you choose persists from session to session.

Viewports Displays the Viewports setting types.
Returns the following prompt:

- **Vpfreeze**: In paper space, freezes the layer selected in the current viewport.
- **Off**: In paper space, turns off selected layers in all viewports.

**Block Selection** Displays the Block Selection setting types, where you can freeze layers of selected objects.

- **Block**: Turns off the layers of selected objects. If a selected object is nested in a block, the layer containing that block is turned off. If a selected object is nested in an xref, the layer of the object is turned off.
- **Entity**: Turns off layers of selected objects even if they are nested in an xref or a block.
- **None**: Turns off the layers of selected objects. If a block or an xref is selected, the layer containing that block or xref is turned off.

**Undo**
Cancels the previous layer selection.

**See also:**
Use Layers to Manage Complexity

**LAYON**

Turns on all layers in the drawing.

**Summary**

All layers that were previously turned off are turned back on. Objects created on those layers become visible, unless the layers are also frozen.

**See also:**
Use Layers to Manage Complexity

**LAYOUT**

Creates and modifies drawing layouts.
Access Methods

- Menu: Insert ➤ Layout ➤ New Layout
- Menu: Insert ➤ Layout ➤ Layout from Template
- Toolbar: Status bar ➤ Layout drop-down ➤ Create New Layout

List of Prompts

The following prompts are displayed.
Enter layout option [Copy (page 566)/Delete (page 566)/New (page 566)/Template (page 566)/Rename (page 566)/SAveas (page 566)/Set (page 567)/? (page 567)] <set>:

**NOTE** Many of these options are available by right-clicking a layout tab name.

**Copy** Copies a layout. If you do not provide a name, the new layout assumes the name of the copied layout with an incremental number in parentheses.

**Delete** Deletes a layout. The most current layout is the default. The Model layout cannot be deleted. To remove all the geometry from the Model layout, you must select all geometry and use the ERASE (page 410) command.

**New** Creates a new layout. Up to 255 layouts can be created in a single drawing. Layout names must be unique. Layout names can be up to 255 characters long and are not case sensitive.

**Template** Creates a new layout based on an existing layout in a template (DWT), drawing (DWG), or drawing interchange (DXF) file. If the FILEDIA (page 1334) system variable is set to 1, a standard file selection dialog box (page 723) is displayed for selecting a DWT, DWG, or DXF file. After you select a file, the Insert Layouts dialog box is displayed, which lists the layouts saved in the selected file. After you select a layout, the layout and all objects from the specified template or drawing file are inserted into the current drawing.

**Rename** Renames a layout. The last current layout is used as the default for the layout to rename. Layout names must be unique. Layout names can be up to 255 characters long and are not case sensitive.

**Saveas** Saves a layout as a drawing template (DWT) file without saving any unreferenced symbol table and block definition information. You can then use the template to create new layouts in your drawings without having to
eliminate unnecessary information. See “Reuse Layouts and Layout Settings” in the User’s Guide.

The last current layout is used as the default for the layout to save as a template. If the FILEDIA (page 1334) system variable is set to 1, a standard file selection dialog box is displayed in which you can specify the template file in which to save the layout.

The default layout template directory is specified in the Application Preferences dialog box.

Set Makes a layout current.

?—List Layouts Lists all the layouts defined in the drawing.

See also:

Create Multiple-View Drawing Layouts (Paper Space)

## Layout Visor

Create new layouts, and modify the page setup settings for and print the current layout.

### Summary

The Layout visor is displayed when you switch to a named layout and the PAPERSPACEVISOR (page 1425) system variable is set to 1.

### List of Options

The following options are displayed.

**New Viewport**

Creates and controls layout viewports. (MVIEW (page 702) command)

**Edit Page Setup**

Edits the page setup settings for the current layout. (PAGESETUPEDIT (page 765) command)
**Print Layout**
Outputs the current layout to a printer or file. *(PLOT (page 803) command)*

**Close the Visor**
Closes the Layout visor. The visor is not displayed when switching named layouts until the `PAPERSPACEVISOR` (page 1425) system variable is set back to 1.

**See also:**
- Work on a Named Layout

**LAYTHW**
Thaws all layers in the drawing.

**Summary**
All layers that were previously frozen are unfrozen. Objects created on those layers become visible, unless the layers are also turned off or have been frozen in individual layout viewports. Layers that are frozen in individual layout viewports must be thawed layer by layer.

**NOTE** LAYTHW does not thaw layers in a viewport. Use the `VPLAYER` (page 1145) command to thaw layers in a viewport.

**See also:**
- Use Layers to Manage Complexity

**LAYULK**
Unlocks the layer of a selected object.

**Access Methods**

- **Button**
- **Toolbar:** Layers palette ➤ Unlock Layer
- **Menu:** Format ➤ Layer Tools ➤ Layer Unlock
Summary

When you move the cursor over objects on locked layers, the locked icon is displayed.

You can select an object on a locked layer and unlock that layer without specifying the name of the layer. Objects on unlocked layers can be selected and modified.

See also:

Prevent Objects from Being Selected

LAYUNISO

Restores all layers that were hidden or locked with the LAYISO command.

Access Methods

Button

Toolbar: Layers palette ➤ Unisolate Layer
Menu: Format ➤ Layer Tools ➤ Layer Unisolate

Summary

Reverses the effects of the previous LAYISO command. Any additional changes made to layer settings after you use the LAYISO command will be retained.

LAYUNISO restores layers to the state they were in just before you entered the LAYISO (page 559) command. Changes to layer settings after LAYISO is used are retained when you enter the LAYUNISO command. If LAYISO was not used, LAYUNISO does not restore any layers.

NOTE You can also restore layers to their previous layer state by using the LAYERP (page 557) command as long as you have not made any changes to layer settings.

See also:

Use Layers to Manage Complexity
LEADER

Creates a line that connects annotation to a feature.

Summary

It is recommended that you use the workflow available through the MLEADER (page 654) command to create leader objects.

List of Prompts

The following prompts are displayed.
Specify leader start point:
Specify next point:

A leader line segment is drawn and prompts for points and options are displayed.
Specify next point (page 570) or [Annotation (page 570)/Format (page 571)/Undo (page 572)] <Annotation>: Specify a point, enter an option, or press Enter

Point Specification

Draws a leader line segment to the point specified and continues to prompt you for points and options.

Annotation

Inserts an annotation at the end of the leader line. The annotation can be single or multiple lines of text, a feature control frame containing geometric tolerances, or a block.

If you press Enter at the Annotation prompt without entering text first, the following options are displayed:

Tolerance Creates a feature control frame containing geometric tolerances using the Geometric Tolerance dialog box (see TOLERANCE (page 1091)).

You can create datum indicators and basic dimension notation in these dialog boxes. After you specify the geometric tolerance, LEADER ends.
Copy Copies text, a multiline text object, a feature control frame with geometric tolerances, or a block and connects the copy to the end of the leader line. The copy is associated with the leader line, meaning that if the copied object moves, the end of the leader line moves with it. The display of the hook line depends on the object copied.

The value of the current text gap (see DIMSTYLE (page 319) or the DIMGAP (page 1271) system variable) determines where the text and multiline text objects are inserted. Blocks or feature control frames with geometric tolerances are attached to the end of the leader line.

Block Inserts a block at the end of the leader line. The prompts are the same as for INSERT (page 522). The block reference is inserted at an offset from the end of the leader line and is associated to the leader line, meaning that if the block moves, the end of the leader line moves with it. No hook line is displayed.

None Ends the command without adding any annotation to the leader line.

Mtext Creates text using the In-Place Text Editor (page 678) when you specify an insertion point and a second point for the text boundary.

Enter the characters for the text. Enclose format strings for prefixes and suffixes in angle brackets (< >). Enclose format strings for alternate units in square brackets ([ ]). For more information about adding a prefix or suffix, see “Control the Display of Dimension Units” in the User’s Guide.

The units settings and the current text style determine how the text is displayed. The multiline text is vertically centered and horizontally aligned according to the X axis direction of the last two vertices of the leader line. The text is offset from the hook line by the distance specified under Offset from Dim Line on the Text tab of the New, Modify, or Override Dimension Style dialog box (page 323). If the offset specified is negative, the multiline text is enclosed in a box as a basic dimension.

Format Controls the way the leader is drawn and whether it has an arrowhead.
**Spline** Draws the leader line as a spline. The vertices of the leader line are the control points, each of equal unit weight.

**Straight** Draws the leader line as a set of straight line segments.

**Arrow** Draws an arrowhead at the start point of the leader line.

**None** Draws a leader line with no arrowhead at the start point.

**Undo** Undoes the last vertex point on the leader line. The previous prompt is displayed.

**See also:**
  - Create Leaders
  - Modify Leaders Using Grips

**LENGTHEN**

Changes the length of objects and the included angle of arcs.

**Access Methods**

**Button**

- **Toolbar:** Drafting tool set ➤ Modify tool group ➤ Lengthen
- **Menu:** Modify ➤ Lengthen

**Summary**

You can specify changes as a percentage, an increment, or as a final length or angle. LENGTHEN is an alternative to using TRIM or EXTEND.
List of Prompts

The following prompts are displayed.
Select an object (page 573) or [Delta (page 573)/Percent (page 574)/Total (page 574)/Dynamic (page 574)]: Select one object or enter an option

Object Selection
Displays the length and, where applicable, the included angle of the object.

LENGTHEN does not affect closed objects. The extrusion direction of the selected object need not be parallel to the Z axis of the current user coordinate system (UCS).

Delta
Changes the length of an object by a specified increment, measured from the endpoint that is closest to the selection point. Delta also changes the angle of an arc by a specified increment, measured from the endpoint that is closest to the selection point. A positive value extends the object; a negative value trims it.

Delta Length Changes the length of the object by the specified increment.

Angle Changes the included angle of the selected arc by the specified angle.
Percent
Sets the length of an object by a specified percentage of its total length.

Total
Sets the length of a selected object by specifying the total absolute length from the fixed endpoint. Total also sets the included angle of a selected arc by a specified total angle.

Total Length
Lengthens the object to the specified value from the endpoint that is closest to the selection point.

Angle
Sets the included angle of the selected arc.

Dynamic
Turns on Dynamic Dragging mode. You change the length of a selected object by dragging one of its endpoints. The other end remains fixed.

See also:
Resize or Reshape Objects
LIGHT

Creates a light.

List of Prompts

Depending on the type of light you specify, the prompts that are displayed are identical to the prompts in the POINTLIGHT (page 827), SPOTLIGHT (page 1031), WEBLIGHT (page 1164), TARGETPOINT (page 1075), FREESPOT (page 448), FREEWEB (page 451) or DISTANTLIGHT (page 359) command.

See also:

Guidelines for Lighting

LIMITS

Sets and controls the limits of the grid display in the current Model or named layout.

Access Methods

Menu: Format ➤ Drawing Limits
Command entry: 'limits' for transparent use

List of Prompts

The following prompts are displayed.
Specify lower left corner (page 575) or [ON (page 576)/OFF (page 576)] <current>: Specify a point, enter on or off, or press Enter

Lower-Left Corner Specifies the lower-left corner for the grid limits.
On  Turns on limits checking. When limits checking is on, you cannot enter points outside the grid limits. Because limits checking tests only points that you enter, portions of objects such as circles can extend outside the grid limits.

Off  Turns off limits checking but maintains the current values for the next time you turn on limits checking.

See also:
   Adjust Grid and Grid Snap

LINE

Creates straight line segments.

Access Methods

Button

Toolbar: Drafting tool set ➤ Open Shapes tool group ➤ Line
Menu: Draw ➤ Line

Summary

With LINE, you can create a series of contiguous line segments. Each segment is a line object that can be edited separately.

List of Prompts

The following prompts are displayed.
Specify first point: Specify a point or press Enter to continue (page 577) from the last drawn line or arc
Specify next point or [Close (page 577)/Undo (page 577)]:

**Continue** Continues a line from the endpoint of the most recently drawn line.

![Before pressing ENTER](image1.png) ![After pressing ENTER](image2.png)

If the most recently drawn object is an arc, its endpoint defines the starting point of the line, and the line is drawn tangent to the arc.

![Before pressing ENTER](image3.png) ![After pressing ENTER](image4.png)

**Close** Ends the last line segment at the beginning of the first line segment, which forms a closed loop of line segments. You can use Close after you have drawn a series of two or more segments.

![Before entering](image5.png) ![After entering](image6.png)

**Undo** Erases the most recent segment of a line sequence.
Entering **u** more than once backtracks through line segments in the order you created them.

See also:
- Draw Lines

**LINETYPE**

Loads, sets, and modifies linetypes.

**Access Methods**

- **Menu: Format ➤ Linetype**
- **Command entry: 'linetype** for transparent use

**Summary**

The Linetype Manager (page 578) is displayed.

If you enter `-linetype` at the Command prompt, options are displayed (page 582).

See also:
- Work with Linetypes

**Linetype Manager**

Loads linetypes and sets the current linetype.
List of Options

The following options are displayed.

**Linetype Filters**

Determines which linetypes to display in the linetype list. You can filter linetypes based on whether they are xref-dependent, or whether they are referenced by objects.

**List of Linetypes**

Displays the loaded linetypes according to the option specified in Linetype Filters. To quickly select all or clear all linetypes, right-click in the linetype list to display the shortcut menu.

**Current** Indicates which linetype is current.

Double-click a linetype to set it as the current linetype. Setting the current linetype to BYLAYER means that an object assumes the linetype that is assigned to a particular layer. Setting the linetype to BYBLOCK means that an object assumes the CONTINUOUS linetype until it is grouped into a block. Whenever the block is inserted, all objects inherit the block's linetype. The CELTYPE (page 1225) system variable stores the linetype name.
Linetype Displays names of loaded linetypes. To rename a linetype, select it and then click it again and enter a new name. BYLAYER, BYBLOCK, CONTINUOUS, and xref-dependent linetypes cannot be renamed.

Appearance Displays a sample of selected linetypes.

Description Displays descriptions of the linetypes, which can be edited in the Details area.

Load (+) Displays the Load or Reload Linetypes dialog box (page 581), in which you can load into the drawing selected linetypes from the acad.lin file and add them to the linetype list.

Delete (-) Deletes selected linetypes from the drawing. You can delete only unused linetypes. The BYLAYER, BYBLOCK, and CONTINUOUS linetypes cannot be deleted.

NOTE Be careful about deleting linetypes if you are working on a drawing in a shared project or one based on a set of layering standards. The deleted linetype definition remains stored in the acad.lin or acadiso.lin file and can be reloaded.

Details Provides alternative access to properties and additional settings.

Name Displays the selected linetype name, which can be edited.

Description Displays the description of the selected linetype, which can be edited.

Global Scale Factor Displays the global scale factor for all linetypes. (LTSCALE (page 596) system variable)

Current Object Scale Sets linetype scale for newly created objects. The resulting scale is the global scale factor multiplied by the object’s scale factor. (CELTSCALE (page 1224) system variable)

ISO Pen Width Sets the linetype scale to one of a list of standard ISO values. The resulting scale is the global scale factor multiplied by the object’s scale factor.

Use Paper Space Units for Scaling
Scales linetypes in paper space and model space identically. Useful when working with multiple viewports. (PSLTSCALE (page 1449) system variable)

See also:

Work with Linetypes

Load or Reload Linetypes Dialog Box

Loads a linetype whose definition exists in a linetype library (LIN) file.

Summary

The acad.lin file contains the standard linetypes.

List of Options

The following options are displayed.

File Name

Displays the name of the current LIN file. You can enter the name of another LIN file or click the File button to select a file from the Select Linetype File dialog box.

Browse

Displays the Select Linetype File dialog box, in which you can select a different linetype (LIN) file.

Available Linetypes
Displays the linetypes available to load. To select or clear all of the linetypes on the list, right-click and choose Select All or Clear All.

**See also:**

- Work with Linetypes

---

**-LINETYPE**

Loads, sets, and modifies linetypes.

**List of Prompts**

The following prompts are displayed.

Enter an option [? (page 582)/Create (page 582)/Load (page 583)/Set (page 583)]:

?-List Linetypes Displays the Select Linetype File dialog box (a standard file selection dialog box (page 723)). After you select an LIN file, the linetypes available in the file are listed.

Create Creates a new linetype and stores it in an LIN file.

The Create or Append Linetype File dialog box (a standard file selection dialog box (page 723)) is displayed. Specify the file to which you want the linetype added.

You cannot create complex linetypes with LINETYPE. For more information, see Custom Linetypes in the *Customization Guide*.

Descriptive Text Enter a linetype description up to 47 characters long. The description can be a comment or a series of underscores, dots, dashes, and spaces to show a simple representation of the linetype pattern.

Linetype Pattern Enter a pattern definition as a series of numbers separated by commas. Enter positive values to specify lengths of dashes, and enter negative values to specify lengths of spaces. Use a zero to represent a dot.

```
2.5 , - . 5 , . 5 , - . 5 the pattern is repeated
```

The “A” in the pattern definition prompt specifies the pattern alignment used at the ends of individual lines, circles, and arcs. Only A-type alignment is supported. With A-type alignment, lines and arcs are guaranteed to start and end with a dash. The A is automatically included in the definition. If you use
a text editor to create a linetype, you must enter `a` at the beginning of the definition.

After creating a linetype, you must load it to make it accessible.

**Load** Loads a linetype whose definition exists in a file. The `acad.lin` file contains the standard linetypes.

The Select Linetype File dialog box (a standard file selection dialog box (page 723)) is displayed. Enter or select the file in which the linetype you want to load is stored.

**Set** Sets the current linetype for objects that will be drawn subsequently. You can control the linetype of objects individually or by layer.

The linetype you enter becomes the current linetype. All new objects are drawn with this linetype, regardless of the current layer. If the linetype you request is not loaded, the program searches for its definition in the `acad.lin` file. If the linetype is neither loaded nor in `acad.lin`, the program displays a message and returns you to the Command prompt.

Enter `?` to list all loaded linetype names. If you enter `bylayer`, new objects inherit the linetype associated with the layer on which the object is drawn. If you enter `byblock`, new objects are drawn using the CONTINUOUS linetype until they are grouped into a block. Whenever you insert that block, the objects inherit the linetype of the block.

See also:

Work with Linetypes

**LIST**

Displays property data for selected objects.

**Access Methods**

Menu: Tools ➤ Inquiry ➤ List

**Summary**

You can use LIST to display and then copy the properties of selected objects to a text file.
The text window displays the object type, object layer, and the X,Y,Z position relative to the current user coordinate system (UCS) and whether the object is in model space or paper space.

LIST also reports the following information:

- Color, linetype, lineweight, and transparency information, if these properties are not set to BYLAYER.
- The thickness of an object, if it is nonzero.
- Elevation (Z coordinate information).
- Extrusion direction (UCS coordinates), if the extrusion direction differs from the Z axis (0,0,1) of the current UCS.
- Additional information related to the specific object type. For example, for dimensional constraint objects, LIST displays the constraint type (annotation or dynamic), reference type (yes or no), name, expression, and value.

See also:

Display and Change the Properties of Objects

LIVESECTION

Turns on live sectioning for a selected section object.

Access Methods

Shortcut menu: Select a section plane object. Right-click and choose Activate Live Sectioning.

Summary

When turned on, the cross sections of 3D objects intersected by the section object are displayed. Live sectioning only works with objects that were created with SECTIONPLANE.
**List of Prompts**

The following prompts are displayed.

**Select section object** Turns on live sectioning for the section object you select.

**See also:**

- Use Live Section to Adjust the Cross Section

**LOAD**

Makes shapes available for use by the SHAPE command.

**Summary**

The Select Shape File dialog box (a standard file selection dialog box (page 723)) is displayed. Enter the shape file name, or select a file name from the list.

You must load a shape (SHP) file the first time you need it; it is loaded automatically thereafter. The shape file must be available each time you edit the drawing.

**See also:**

- Overview of Shape Files

**LOFT**

Creates a 3D solid or surface in the space between several cross sections.
Access Methods

**Button**

- Toolbar: Modeling tool set ➤ Solids - Create tool group ➤ Loft
- Menu: Draw ➤ 3D Modeling ➤ Loft

**Summary**

Creates a 3D solid or surface by specifying a series of cross sections. The cross sections define the shape of the resulting solid or surface. You must specify at least two cross sections.

Loft profiles can be open or closed, planar or non-planar, and can also be edge subobjects. Use the mode option to select whether to create a surface or a solid.

When creating surfaces, use `SURFACEMODELINGMODE` (page 1500) to control whether the surface is a NURBS surface or a procedural surface. Use `SURFACE-ASSOCIATIVITY` (page 1498) to control whether procedural surfaces are associative.
You can use the following objects and subobjects with LOFT:

<table>
<thead>
<tr>
<th>Objects That Can Be Used as Cross Sections</th>
<th>Objects That Can Be Used as a Loft Path</th>
<th>Objects That Can Be Used as Guides</th>
</tr>
</thead>
<tbody>
<tr>
<td>2D polyline</td>
<td>Spline</td>
<td>2D spline</td>
</tr>
<tr>
<td>2D solid</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2D spline</td>
<td>Helix</td>
<td>3D spline</td>
</tr>
<tr>
<td>Arc</td>
<td>Arc</td>
<td>Arc</td>
</tr>
<tr>
<td>Circle</td>
<td>Circle</td>
<td>2D polyline</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NOTE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2D polylines can be used as guides if they contain only 1 segment.</td>
</tr>
<tr>
<td>Edge sub-objects</td>
<td>Edge subobjects</td>
<td>Edge subobjects</td>
</tr>
<tr>
<td>Ellipse</td>
<td>Ellipse</td>
<td>3D polyline</td>
</tr>
<tr>
<td>Elliptical arc</td>
<td>Elliptical arc</td>
<td>Elliptical arc</td>
</tr>
<tr>
<td>Helix</td>
<td>2D polyline</td>
<td></td>
</tr>
<tr>
<td>Line</td>
<td>Line</td>
<td>Line</td>
</tr>
<tr>
<td>Planar or non-planar face of solid</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Planar or non-planar surface</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Points (first and last cross section only)</td>
<td>3D polyline</td>
<td></td>
</tr>
</tbody>
</table>
Objects That Can Be Used as Cross Sections | Objects That Can Be Used as a Loft Path | Objects That Can Be Used as Guides
---|---|---
Region | Trace |
Trace |

To automatically delete the cross sections, guides, and paths, use `DELOBJ` (page 1251). If `surface associativity` (page 1498) is on, DELOBJ is ignored and the originating geometry is not deleted.

**List of Prompts**

The following prompts are displayed.

**Cross Sections in Lofting Order** Specifies open or closed curves in the order in which the surface or solid will pass through them.

**Point** If you select the Point option, you must also select a closed curve.

**Join Multiple Curves** Joins multiple, end-to-end curves as one cross section.

**Mode** Controls whether the lofted object is a solid or a surface.

**Options**
- Guides (page 589)
- Path (page 589)
- Cross sections only (page 590)
- Settings (page 590)

**Continuity** This option only displays if the `LOFTNORMALS` (page 1397) system variable is set to 1 (smooth fit). Specifies whether the continuity is G0, G1, or G2 where the surfaces meet.
**Bulge Magnitude** This option only displays if the LOFTNORMALS (page 1397) system variable is set to 1 (smooth fit). Specifies a bulge magnitude value for objects that have a continuity of G1 or G2.

![Bulge Magnitude Example](image)

**Guides**
Specifies guide curves that control the shape of the lofted solid or surface. You can use guide curves to control how points are matched up on corresponding cross sections to prevent undesired results, such as wrinkles in the resulting solid or surface.

![Guides Example](image)

- Intersects each cross section
- Starts on the first cross section
- Ends on the last cross section

Select any number of guide curves for the lofted surface or solid and press Enter.

**Path**
Specifies a single path for the lofted solid or surface.
The path curve must intersect all planes of the cross sections.

**Cross Sections Only**
Creates lofted objects without using guides or paths.

**Settings**
Displays the Loft Settings dialog box (page 590).

**See also:**
- Create a Solid or Surface by Lofting

**Loft Settings Dialog Box**

Controls the contour of a lofted surface at its cross sections. Also allows you to close the surface or solid.
List of Options

The following options are displayed.

**Ruled**

Specifies that the solid or surface is ruled (straight) between the cross sections and has sharp edges at the cross sections. (*LOFTNORMALS* (page 1397) system variable)

![Ruled Option](image)

**Smooth Fit**

Specifies that a smooth solid or surface is drawn between the cross sections and has sharp edges at the start and end cross sections. (*LOFTNORMALS* (page 1397) system variable)
Start Continuity
Sets the tangency and curvature of the first cross section.

Start Bulge Magnitude
Sets the size of the curve of the first cross section.

End Continuity
Sets the tangency and curvature of the last cross section.

End Bulge Magnitude
Sets the size of the curve of the last cross section.

Normal To
Controls the surface normal of the solid or surface where it passes through the cross sections. (LOFTNORMALS (page 1397) system variable)

Start Cross Section Specifies that the surface normal is normal to the start cross section.

End Cross Section Specifies that the surface normal is normal to the end cross section.

Start and End Cross Sections Specifies that the surface normal is normal to both the start and end cross sections.

All Cross Sections Specifies that the surface normal is normal to all cross sections.

Draft Angles
Controls the draft angle and magnitude of the first and last cross sections of the lofted solid or surface. The draft angle is the beginning direction of the
surface. 0 is defined as outward from the plane of the curve. (LOFTNORMALS (page 1397) system variable)

The following illustration shows the affect of using a different draft angle for the first and last cross sections of a lofted solid. The first cross section is assigned a draft angle of 45 degrees, while the last cross section is assigned a draft angle of 135 degrees.

You can also use the draft angle handle to adjust the draft angle (triangular grip) and magnitude (circular grip).
Start Angle

Specifies the draft angle for the start cross section. \( \text{LOFTANG1} \) (page 1395) system variable

Start Magnitude

Controls the relative distance of the surface from the start cross section in the direction of the draft angle before the surface starts to bend toward the next cross section. \( \text{LOFTMAG1} \) (page 1396) system variable

End Angle

Specifies the draft angle for the end cross section. \( \text{LOFTANG2} \) (page 1396) system variable

End Magnitude

Controls the relative distance of the surface from the end cross section in the direction of the draft angle before the surface starts to bend toward the previous cross section. \( \text{LOFTMAG2} \) (page 1396) system variable

Close Surface or Solid

Closes and opens a surface or solid. When using this option, the cross sections should form a torus-shaped pattern so that the lofted surface or solid can form a closed tube. \( \text{LOFTPARAM} \) (page 1397) system variable
Periodic (Smooth Ends)

Creates a smooth, closed surface whose seam will not kink if it is reshaped. This option is only available if the loft is ruled or smooth fit and the Close Surface or solid option is selected.

See also:
Create a Solid or Surface by Lofting

LOGFILEOFF

Closes the command history log file opened by LOGFILEON.

Summary

The program stops recording the text window contents and closes the log file. Each drawing saves a log file (with the extension .log) that may need periodic deletion as the number of log files continues to grow.

See also:
View and Edit Within the Command History

LOGFILEON

Writes the contents of the command history to a file.
Summary

The contents of the text window are recorded in the log file until you exit the program or use the LOGFILEOFF (page 595) command.

Each drawing saves a log file (with the extension .log) that may need periodic deletion as the number of log files continues to grow.

See also:

- View and Edit Within the Command History

**LTSCALE**

Sets the global linetype scale factor.

**Access Methods**

- Command entry: ‘Ltscale’ for transparent use

**Summary**

Use LTSCALE to change the scale factor of linetypes for all objects in a drawing. Changing the linetype scale factor causes the drawing to be regenerated.

```
------
|------
|------

LTSCALE = 1

------
|------
|------

LTSCALE = .5

------
|------
|------

LTSCALE = .25
```

See also:

- Control Linetype Scale

**LWEIGHT**

Sets the current lineweight, lineweight display options, and lineweight units.
Access Methods

Menu: Format ➤ Lineweight
Shortcut menu: Right-click Show/Hide Lineweight on the status bar and choose Settings.
Command entry: `lweight` for transparent use

Summary

The Lineweight Settings dialog box (page 597) is displayed.

If you enter `-lweight` at the Command prompt, options are displayed (page 599).

See also:

Overview of Lineweights

Lineweight Settings Dialog Box

Sets the current lineweight, sets the lineweight units, controls the display and display scale of lineweights, and sets the DEFAULT lineweight value for layers.
Summary

For a table of valid lineweights, see Overview of Lineweights in the User’s Guide.

List of Options

The following options are displayed.

**Units**

Specifies whether lineweights are displayed in millimeters or inches. You can also set Units for Listing by using the `LWUNITS` (page 1404) system variable.

**Millimeters (mm)**

Specifies lineweight values in millimeters.

**Inches (in.)**

Specifies lineweight values in inches.

**Default**

Controls the DEFAULT lineweight for layers. The initial DEFAULT lineweight is 0.01 inches or 0.25 mm. (LWDEFAULT system variable)

**Lineweights**

Displays the available lineweight values and shows which lineweight is current. The current lineweight is shown highlighted in the list. Lineweight values consist of standard settings including BYLAYER, BYBLOCK, and DEFAULT. The DEFAULT value is set by the `LWDEFAULT` (page 1404) system variable, which has an initial value of 0.01 inches or 0.25 mm. All new layers use the default setting. The lineweight value of 0 plots at the thinnest lineweight available on the specified plotting device and is displayed at one pixel wide in model space.

**NOTE** Use the `LWDISPLAY` (page 1404) system variable or toggle the Show/Hide Lineweights button on the status bar to display lineweights in the drawing area. Regeneration time increases with lineweights that are represented by more than one pixel. This option does not affect how objects are plotted.

**Preview Scaling**

Controls the display scale of lineweights on the Model layout. On the Model layout, lineweights are displayed in pixels. Lineweights are displayed using a pixel width in proportion to the real-world unit value at which they plot. If you are using a high-resolution monitor, you can adjust the lineweight display.
scale to better display different lineweight widths. The Lineweight list reflects the current display scale. Objects with lineweights that are displayed with a width of more than one pixel may increase regeneration time. If you want to optimize performance when working in the Model layout, set the lineweight display scale to the minimum value or turn off lineweight display altogether.

See also:
Overview of Lineweights

-LWEIGHT

Sets the current lineweight, lineweight display options, and lineweight units.

List of Prompts

The following prompts are displayed.
Current lineweight: current
Enter default lineweight (page 599) for new objects or [? (page 599)]: Enter a valid lineweight or enter ?

The current lineweight value is displayed; if the value is not BYLAYER, BYBLOCK or DEFAULT, the value is displayed in millimeters or inches.

Default Lineweight Sets the current default lineweight. Lineweight values consist of fixed settings, including BYLAYER, BYBLOCK, and DEFAULT. Values are calculated in either inches or millimeters; millimeters are the default. If you enter a valid lineweight value, the current default lineweight is set to the new value. If you enter any other value, the default is set to the nearest valid value.

To plot an object with a lineweight that is not found in the list of fixed lineweight values, you can use plot styles to control plotted lineweights. See Control Plotted Lineweight and Linetype in the User’s Guide. The DEFAULT value is set by the LWDEFAULT system variable and has an initial value of 0.01 inches or 0.25 mm. The lineweight value of 0 plots at the thinnest lineweight available on the specified plotting device and is displayed at a value of one pixel in model space.

?—List Lineweights Displays a list of valid lineweight values in the current lineweight units.
NOTE If you save a drawing using the AutoCAD Release 14, or earlier, format, the drawing preview displays lineweights even though the drawing saved in the earlier format does not display lineweights.

See also:

Overview of Lineweights

M Commands

MASSPROP

Calculates the mass properties of regions or 3D solids.

Access Methods

Menu: Tools ➤ Inquiry ➤ Region/Mass Properties

Summary

Refer to the Help system for a complete list of definitions for each of the region or mass properties computed.

List of Prompts

The following prompts are displayed.

Select objects: Use an object selection method

If you select multiple regions, only those that are coplanar with the first selected region are accepted.

MASSPROP displays the mass properties in the text window, and then asks if you want to write the mass properties to a text file (.mpr).

The properties that MASSPROP displays depend on whether the selected objects are regions, and whether the selected regions are coplanar with the XY plane of the current user coordinate system (UCS), or 3D solids. For a list of the parameters that control the MASSPROP units, see Calculations Based on the Current UCS (page 603).
**Regions**
The following table shows the mass properties that are displayed for all regions.

### Mass properties for all regions

<table>
<thead>
<tr>
<th>Mass property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area</td>
<td>The surface area of solids or the enclosed area of regions.</td>
</tr>
<tr>
<td>Perimeter</td>
<td>The total length of the inside and outside loops of a region. The perimeter of a solid is not calculated.</td>
</tr>
<tr>
<td>Bounding box</td>
<td>The two coordinates that define the bounding box. For regions that are coplanar with the XY plane of the current user coordinate system, the bounding box is defined by the diagonally opposite corners of a rectangle that encloses the region. For regions that are not coplanar with the XY plane of the current UCS, the bounding box is defined by the diagonally opposite corners of a 3D box that encloses the region.</td>
</tr>
<tr>
<td>Centroid</td>
<td>A 2D or 3D coordinate that is the center of area for regions. For regions that are coplanar with the XY plane of the current UCS, this coordinate is a 2D point. For regions that are not coplanar with the XY plane of the current UCS, this coordinate is a 3D point.</td>
</tr>
</tbody>
</table>

If the regions are coplanar with the XY plane of the current UCS, the additional properties shown in the following table are displayed.

### Additional mass properties for coplanar regions

<table>
<thead>
<tr>
<th>Mass property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Moments of inertia</td>
<td>A value used when computing the distributed loads, such as fluid pressure on a plate, or when calculating the forces inside a bending or twisting beam. The formula for determining area moments of inertia is $\text{area_moments_of_inertia} = \text{area_of_interest} \times \text{radius}^2$. The area moments of inertia has units of distance to the fourth power.</td>
</tr>
</tbody>
</table>
Additional mass properties for coplanar regions

<table>
<thead>
<tr>
<th>Mass property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Products of inertia</td>
<td>Property used to determine the forces causing the motion of an object. It is always calculated with respect to two orthogonal planes. The formula for product of inertia for the YZ plane and XZ plane is $\text{product_of_inertia}<em>{YZ,XZ} = \text{mass} \times \text{dist}</em>{\text{centroid_to_YZ}} \times \text{dist}_{\text{centroid_to_XZ}}$. This $XY$ value is expressed in mass units times the length squared.</td>
</tr>
<tr>
<td>Radii of gyration</td>
<td>Another way of indicating the moments of inertia of a 3D solid. The formula for the radii of gyration is $\text{gyration_radii} = (\text{moments_of_inertia}/\text{body_mass})^{1/2}$. Radii of gyration are expressed in distance units.</td>
</tr>
<tr>
<td>Principal moments and $X,Y,Z$ directions about centroid</td>
<td>Calculations that are derived from the products of inertia and that have the same unit values. The moment of inertia is highest through a certain axis at the centroid of an object. The moment of inertia is lowest through the second axis that is normal to the first axis and that also passes through the centroid. A third value included in the results is somewhere between the high and low values.</td>
</tr>
</tbody>
</table>

3D Solids
The following table shows the mass properties that are displayed for solids.

<table>
<thead>
<tr>
<th>Mass property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mass</td>
<td>The measure of inertia of a body. Because a density of one is used, mass and volume have the same value.</td>
</tr>
<tr>
<td>Volume</td>
<td>The amount of 3D space that a solid encloses.</td>
</tr>
<tr>
<td>Bounding box</td>
<td>The diagonally opposite corners of a 3D box that encloses the solid.</td>
</tr>
<tr>
<td>Centroid</td>
<td>A 3D point that is the center of mass for solids. A solid of uniform density is assumed.</td>
</tr>
</tbody>
</table>
Mass properties for solids

<table>
<thead>
<tr>
<th>Mass property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Moments of inertia</td>
<td>The mass moments of inertia, which is used when computing the force required to rotate an object about a given axis, such as a wheel rotating about an axle. The formula for mass moments of inertia is $\text{mass_moments_of_inertia} = \text{object_mass} \times \text{radius}^2$  Mass moments of inertia unit is mass (grams or slugs) times the distance squared.</td>
</tr>
<tr>
<td>Products of inertia</td>
<td>Property used to determine the forces causing the motion of an object. It is always calculated with respect to two orthogonal planes. The formula for product of inertia for the $YZ$ plane and $XZ$ plane is $\text{product_of_inertia}<em>{YZ,XZ} = \text{mass} \times \text{dist}</em>{\text{centroid_to_YZ}} \times \text{dist}_{\text{centroid_to_XZ}}$ This $XY$ value is expressed in mass units times the length squared.</td>
</tr>
<tr>
<td>Radii of gyration</td>
<td>Another way of indicating the moments of inertia of a solid. The formula for the radii of gyration is $\text{gyration_radii} = (\text{moments_of_inertia}/\text{body_mass})^{1/2}$ Radii of gyration are expressed in distance units.</td>
</tr>
<tr>
<td>Principal moments and $X,Y,Z$ directions about centroid</td>
<td>Calculations that are derived from the products of inertia and that have the same unit values. The moment of inertia is highest through a certain axis at the centroid of an object. The moment of inertia is lowest through the second axis that is normal to the first axis and that also passes through the centroid. A third value included in the results is somewhere between the high and low values.</td>
</tr>
</tbody>
</table>

Calculations Based on the Current UCS
The following table shows the parameters that control the units in which mass properties are calculated.

Parameters that control MASSPROP units

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Used to calculate</th>
</tr>
</thead>
<tbody>
<tr>
<td>DENSITY</td>
<td>Mass of solids</td>
</tr>
<tr>
<td>LENGTH</td>
<td>Volume of solids</td>
</tr>
</tbody>
</table>
Parameters that control MASSPROP units

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Used to calculate</th>
</tr>
</thead>
<tbody>
<tr>
<td>LENGTH*LENGTH</td>
<td>Area of regions and surface area of solids</td>
</tr>
<tr>
<td>LENGTH<em>LENGTH</em>LENGTH</td>
<td>Bounding box, radii of gyration, centroid, and perimeter</td>
</tr>
<tr>
<td>DENSITY<em>LENGTH</em>LENGTH</td>
<td>Moments of inertia, products of inertia, and principal moments</td>
</tr>
</tbody>
</table>

See also:

Obtain Area and Mass Properties Information

**MATBROWSERCLOSE**

Closes the Materials Browser.

**Summary**

This command closes the Materials Browser (page 605).

See also:

Browse Material Library

**MATBROWSEROPEN**

Opens the Materials Browser.

**Access Methods**

Button

![Toolbar: Modeling tool set ➤ Materials tool group ➤ Material Browser]
Menu: View ➤ Render ➤ Materials Browser

Summary

The Materials Browser (page 605) is displayed.

See also:

Browse Material Library

Materials Browser

The Materials Browser allows you to navigate and manage your materials.
Summary

You can also manage your material libraries in the Materials Browser. It also allows you search and sort materials in all open libraries and in the drawing.

List of Prompts

The following prompts are displayed.

Search
Searches for materials in the loaded library.

Document Materials
Displays the materials saved with the current drawing.

Use the drop-down list on the right to filter which materials and how they are displayed in the list. The following filters and options are available:

Document Materials Controls which materials are displayed in the list.
- **Show All.** Display all materials in the current drawing. (Default option)
- **Show Applied.** Display only the materials being used in the current drawing.
- **Show Selected.** Display only the materials applied to the selected objects in the current drawing.
- **Show Unused.** Display only the materials that are not used in the current drawing.
- **Purge All Unused.** Removes all unused materials from current drawing.

View Type Controls the details view display of the library content.
- **Thumbnail View.** All materials are represented by a thumbnail and the name of the material below.
- **List View.** All materials are displayed in a grid with thumbnail, name, type, and category in columns. (Default option)
- **Text View.** All materials are displayed in a grid with name, type, and category in columns. No thumbnail is displayed.

Sort Controls the order in which document materials are displayed.
- **By Name.** Lists materials alphabetically by name. (Default option)
- **By Type.** Lists materials according to the type of material that it was created from.
- **By Material Color.** Lists materials by their assigned color. The color might not be the same that is displayed in the material swatch preview.
**Thumbnail Size** Adjusts the size of the material swatches in the list.
- **16 x16.** Thumbnails are scaled to a size of 16 x 16 pixels. (Default option)
- **24 x24.** Thumbnails are scaled to a size of 24 x 24 pixels.
- **32 x32.** Thumbnails are scaled to a size of 32 x 32 pixels.
- **64 x64.** Thumbnails are scaled to a size of 64 x 64 pixels.

**Current Library**
Displays the materials from the selected library. Expand a library to display the associated materials in the Materials list.

Use the drop-down list on the right to filter how the materials in the selected library are displayed in the list. The following filters and options are available:

**Library** Controls which library is current and the visibility of the library tree.
- **Autodesk Libray.** The standard library which contains the *Autodesk Materials.*
- **Hide/Show Library Tree.** Controls the visibility of the library tree.

**View Type** Controls the details view display of the library content.
- **Thumbnail View.** All materials are represented by a thumbnail and the name of the material below. (Default option)
- **List View.** All materials are displayed in a grid with thumbnail, name, type, and category in columns.
- **Text View.** All materials are displayed in a grid with name, type, and category in columns. No thumbnail is displayed.

**Sort** Controls the order in which materials in the library are displayed.
- **By Name.** Lists materials in the selected library alphabetically by name. (Default option)
- **By Type.** Lists materials in the selected library according to the type of material that it was created from.
- **By Material Color.** Lists materials in the selected library by their assigned color. The color might not be the same that is displayed in the material swatch preview.
- **By Category.** Lists materials in the selected library according to the category of material it was added to.

**Thumbnail Size** Adjusts the size of the material swatches in the list.
- **16 x16.** Thumbnails are scaled to a size of 16 x 16 pixels. (Default option)
- **24 x24.** Thumbnails are scaled to a size of 24 x 24 pixels.
■ **32 x32.** Thumbnails are scaled to a size of 32 x 32 pixels.
■ **64 x64.** Thumbnails are scaled to a size of 64 x 64 pixels.

**See also:**
Browse Material Library

**MATCHCELL**

Applies the properties of a selected table cell to other table cells.

**Access Methods**

פה **Button**

 الاقتصادية **Toolbar:** With a table and table cell selected, on the Table Cell visor, click Match Cell.

**Summary**

All the properties of the source cell are copied to the destination cells except for the cell type: text or block.

**List of Prompts**

The following prompts are displayed.
Select source cell: *Click inside a cell in a table whose properties you want to copy*
Select destination cell: *Click inside table cells to copy properties from the source cell, and right-click or press Enter or Esc to exit*

**See also:**
Add Text and Blocks to Tables

**MATCHPROP**

Applies the properties of a selected object to other objects.
Access Methods

Menu: Modify ➤ Match Properties
Command entry: painter (or 'matchprop' for transparent use)

Summary

The types of properties that can be applied include color, layer, linetype, linetype scale, linewidth, plot style, transparency, and other specified properties.

List of Prompts

The following prompts are displayed.
Current active settings: Currently selected matchprop settings
Select destination object(s) or [Settings]: Enter s or select one or more objects to copy properties to

Destination Object(s) Specifies the objects to which you want to copy the properties of the source object.

Settings Displays the Match Properties Settings dialog box (page 609), in which you can control which object properties to copy to the destination objects. By default, all object properties are selected for copying.

See also:

Copy Properties Between Objects

Match Properties Settings Dialog Box

Specifies the properties that are copied from the select source object to the destination objects.
Summary

Specifies which basic properties and special properties to copy from the source object to the destination objects.

List of Options

The following options are displayed.

Basic Properties

Color
Changes the color of the destination object to that of the source object. Available for all objects.

Layer
Changes the layer of the destination object to that of the source object. Available for all objects.

Linetype
Changes the linetype of the destination object to that of the source object. Available for all objects except attributes, hatches, multiline text, points, and viewports.

Linetype Scale
Changes the linetype scale factor of the destination object to that of the source object. Available for all objects except attributes, hatches, multiline text, points, and viewports.

**Lineweight**

Changes the lineweight of the destination object to that of the source object. Available for all objects.

**Transparency**

Changes the transparency of the destination object to that of the source object. Available for all objects.

**Thickness**

Changes the thickness of the destination object to that of the source object. Available only for arcs, attributes, circles, lines, points, 2D polylines, regions, and text.

**Plot Style**

Changes the plot style of the destination object to that of the source object. If you are working in color-dependent plot style mode (PSTYLEPOLICY (page 1451) is set to 1), this option is unavailable. Available for all objects, except those with the Jitter edge modifier applied.

**Special Properties**

**Dimension**

In addition to basic object properties, changes the dimension style and annotative properties of the destination object to that of the source object. Available only for dimension, leader, and tolerance objects.

**Polyline**

In addition to basic object properties, changes the width and linetype generation properties of the destination polyline to those of the source polyline. The fit/smooth property and the elevation of the source polyline are not transferred to the destination polyline. If the source polyline has variable width, the width property is not transferred to the destination polyline.

**Material**

In addition to basic object properties, changes the material applied to the object. If the source object does not have a material assigned and the destination object does, the material is removed from the destination object.

**Text**
In addition to basic object properties, changes the text style and annotative properties of the destination object to that of the source object. Available only for single-line and multiline text objects.

**Viewport**

In addition to basic object properties, changes the following properties of the destination paper space viewport to match those of the source viewport: on/off, display locking, standard or custom scale, shade plot, snap, grid, and UCS icon visibility and location. The settings for clipping and for UCS per viewport and the freeze/thaw state of the layers are not transferred to the destination object.

**Shadow Display**

In addition to basic object properties, changes the shadow display. The object can cast shadows, receive shadows, or both, or it can ignore shadows.

**Hatch**

In addition to basic object properties, changes the hatch properties (including its annotative properties) of the destination object to that of the source object. To match the hatch origin, use Inherit Properties in HATCH or HATCHEDIT. Available only for hatch objects.

**Table**

In addition to basic object properties, changes the table style of the destination object to that of the source object. Available only for table objects.

**Multileader**

In addition to basic object properties, changes the multileader style and annotative properties of the destination object to that of the source object. Available only for multileader objects.

**See also:**

Copy Properties Between Objects

---

**MATERIALASSIGN**

Uses the current material defined in the CMATERIAL system variable.

**List of Prompts**

The following prompts are displayed.
Select objects: Pick one or more objects
Select objects or [Undo]: Press Enter to exit the command

See also:
Browse Material Library

MATERIALS

Opens the Materials Browser.

Access Methods

Button

Toolbar: Modeling tool set ➤ Materials tool group ➤ Material Browser
Menu: View ➤ Render ➤ Materials Browser
Command entry: Cmd-9

Summary

The Materials Browser (page 605) is displayed.
The Materials Browser allows you navigate and manage your materials. You can organize, sort, search, and select materials for use in your drawing.

See also:
Browse Material Library

MATERIALSCLOSE

Closes the Materials Browser.

Summary

Closes the Materials Browser (page 605).
See also:
Browse Material Library

**MEASURE**

Creates point objects or blocks at measured intervals along the length or perimeter of an object.

**Access Methods**

- **Button**
  - Toolbar: Drafting tool set ➤ Open Shapes tool group (expanded) ➤ Point flyout ➤ Measure
  - **Menu:** Draw ➤ Point ➤ Measure

**Summary**

The resulting points or blocks are always located on the selected object and their orientation is parallel to the XY plane of the UCS.

Use DDPTYPE to set the style and size of all point objects in a drawing.

The points or blocks are placed in the Previous selection set, so you can select them all by entering p at the next Select Objects prompt. You can use the Node object snap to draw an object by snapping to the point objects. You can then remove the points by entering erase previous.
List of Prompts

The following prompts are displayed.
Select object to measure:
Specify length of segment (page 615) or [Block (page 615)]:
Specify a distance or enter b

Length of Segment Places point objects at the specified interval along the selected object, starting at the endpoint closest to the point you used to select the object.
Measurement of closed polylines starts at their initial vertex (the first one drawn).
Measurement of circles starts at the angle from the center set as the current snap rotation angle. If the snap rotation angle is 0, then the measurement of the circle starts to the right of center, on its circumference.

The illustration shows how MEASURE marks 0.5-unit distances along a polyline, with the PDMODE (page 1429) system variable set to 35.

Block Places blocks at a specified interval along the selected object.

Align Block With Object

- **Yes.** The block is rotated about its insertion point so that its horizontal lines are aligned with, and drawn tangent to, the object being measured.
- **No.** The block is always inserted with a 0 rotation angle.

After you specify the segment length, the block is inserted at the specified interval. If the block has variable attributes, these attributes are not included.
See also:
Specify Measured Intervals on Objects

MEASUREGEOM

Measures the distance, radius, angle, area, and volume of selected objects or sequence of points.

Access Methods

Button

Toolbar: Drafting tool set ➤ Utilities tool group ➤ Measure flyout ➤ Distance
Menu: Tools ➤ Inquiry ➤ Distance

Summary

The MEASUREGEOM command performs many of the same calculations as the following commands:
■ AREA (page 78)
■ DIST (page 357)
■ MASSPROP (page 600)

List of Prompts

The following prompts are displayed.

Enter an option [Distance (page 616)/Radius (page 617)/Angle (page 617)/Area (page 617)/Volume (page 617)] <Distance>: Specify Distance, Radius, Angle, Area, or Volume

Information displays at the Command prompt and in the tooltip in the current units format.

Distance
Measures the distance between specified points. The following display at the Command prompt and in the tooltip:
■ The current UCS X axis
- Distance in X direction (Delta X)
- Distance in Y direction (Delta Y)

**Multiple Points** A running total of distance based on existing line segments and the current rubber-band line is calculated. The total updates as you move the cursor and displays in the tooltip.

If you enter Arc, Length, or Undo Options for Selecting Polylines (page 618) display.

**Radius**
Measures the radius and diameter of a specified arc or circle.

**Angle**
Measures the angle of a specified arc, circle, line, or vertex.

- **Arc** Measures the angle of an arc.
- **Circle** Measures a specified angle within a circle. The angle updates as you move the cursor.
- **Line** Measures the angle between two lines.
- **Vertex** Measures the angle of a vertex.

**Area**
Measures the area and perimeter of an object or defined area.

**NOTE** MEASUREGEOM cannot calculate the area of a self-intersecting object.

**Specify Corner Points** Calculates the area and perimeter defined by specified points.

If you enter Arc, Length, or Undo, Options for Selecting Polylines (page 618) display.

**Add Area** Turns on Add mode and keeps a running total of area as you define areas. You can use the Add Area option to calculate the
- Individual areas of defined areas and objects
- Individual perimeters of defined areas and objects
- Total area of all defined areas and objects
- Total perimeter of all defined areas and objects

**Subtract Area** Subtracts a specified area from the total area. The total area and perimeter displays at the Command prompt and in the tooltip.

**Volume**
Measures the volume of an object or a defined area.
Object Measures the volume of an object or defined area. You can select a 3D solids or 2D objects. If you select a 2D object you must specify a height for that object.

If you define an object by specifying points, you must specify at least three points to define a polygon. All must lie on a plane parallel to the XY plane of the UCS. If you do not close the polygon, an area will be calculated as if a line existed between the first and last points entered.

If you enter Arc, Length, or Undo Options for Selecting Polylines (page 618) display.

Add Volume Turns on Add mode and keeps a running total of volume as you define areas.

Subtract Volume Turns on Subtract mode and subtracts a specified volume from the total volume.

Options for Selecting Polylines You can select polylines when using the Distance, Area, and Volume options.

Arc Adds arc segments to the polyline.

Endpoint of Arc Draws an arc segment. The arc segment is tangent to the previous segment of the polyline.

Angle Specifies the included angle of the arc segment from the start point. Entering a positive number creates counterclockwise arc segments. Entering a negative number creates clockwise arc segments.

Radius Specifies the radius of the arc segment.

Center Specifies the center of the arc segment.

Length Specifies the chord length of the arc segment. If the previous segment is an arc, the new arc segment is drawn tangent to the previous arc segment.

Close Draws an arc segment from the last point specified to the starting point, creating a closed polyline. At least two points must be specified to use this option.

Direction Specifies a starting direction for the arc segment.
Half width Specifies the width from the center of a wide polyline segment to one of its edges.
The starting half-width becomes the default ending half-width. The ending half-width becomes the uniform half-width for all subsequent segments until you change the half-width again. The starting and ending points of wide line segments are at the center of the line.
Typically, the intersections of adjacent wide polyline segments are beveled. No beveling is performed for nontangent arc segments or very acute angles or when a dot-dash linetype is used.

Radius Specifies the radius of the arc segment.
- Endpoint of Arc (page 798)
- Angle (page 798)

Second Pt Specifies the second point and endpoint of a three-point arc.
- Endpoint of Arc (page 798)

Width Specifies the width of the next arc segment.
The starting width becomes the default ending width. The ending width becomes the uniform width for all subsequent segments until you change the width again. The starting and ending points of wide line segments are at the center of the line.
Typically, the intersections of adjacent wide polyline segments are beveled. No beveling is performed for nontangent arc segments, very acute angles, or when a dot-dash linetype is used.

Length Draws a line segment of a specified length at the same angle as the previous segment. If the previous segment is an arc, the new line segment is drawn tangent to that arc segment.

Undo Removes the most recent arc segment added to the polyline.

Close Draws an arc segment from the last point specified to the starting point, creating a closed polyline. At least two points must be specified to use this option.

See also:
- Obtain Distances, Angles, and Point Locations
- Obtain Area and Mass Properties Information
MESH

Creates a 3D mesh primitive object such as a box, cone, cylinder, pyramid, sphere, wedge, or torus.

Access Methods

鸾 Menu: Draw ➤ 3D Modeling ➤ Meshes ➤ Primitives ➤ Box

Summary

The basic mesh forms, known as mesh primitives, are the equivalent of the primitive forms for 3D solids.

You can reshape mesh objects by smoothing, creasing, refining, and splitting faces. You can also drag edges, faces, and vertices to mold the overall form.

NOTE By default, new mesh primitives are created with no smoothness. To change the default smoothness, enter mesh at the Command prompt. Specify the Settings option before you specify the type of mesh primitive you want to create.

List of Prompts

The following prompts are displayed.
Select primitive [Box (page 620)/Cone (page 621)/Cylinder (page 624)/Pyramid (page 626)/Sphere (page 628)/Wedge (page 629)/Torus (page 630)/Settings (page 632)]

Box

Creates a 3D mesh box.

Specify the length of the sides.
First corner / Corner Sets the first corner of the mesh box.

- **Other corner.** Sets the opposite corner of the mesh box.

- **Cube** (page 621)
- **Length** (page 621)

Center Sets the center of the mesh box.

- **Corner.** Sets the opposite corner of the mesh box.

- **Cube** (page 621)
- **Length** (page 621)

**Cube** Sets all edges of the box to be of equal length.

- **Length** (page 621)

**Length** Sets the length of the mesh box along the X axis.

- **Width** (page 621) (not available for cubes)

**Width** Sets the width of the mesh box along the Y axis.

- **Height** (page 621)
- **2Point (height)** (page 621)

**Height** Sets the height of the mesh box along the Z axis.

**2Point (height)** Sets the height based on the distance between two points:

- **First point.** Sets the first point of a two-point distance.
- **Second point.** Sets the second point of a two-point distance.

**Cone**

Creates a 3D mesh with a circular or elliptical base that tapers symmetrically to a point or to a planar face.
Specify the diameter and height.  
**Center point of base** Sets the center point of the base of the mesh cone.  
- **Base radius** (page 623)  
- **Diameter** (page 623)  

**3P (three points)** Sets the location, size, and plane of the mesh cone by specifying three points:  
- **First point.** Sets the first point on the circumference of the mesh cone base.  
- **Second point.** Sets a second point on the circumference of the mesh cone base.  
- **Third point.** Sets the size and planar rotation of the mesh cone base.  
  - **Height** (page 623)  
  - **2Point (height)** (page 623)  
  - **Axis endpoint** (page 624)  
  - **Top radius** (page 624)  

**2P (diameter)** Defines the base diameter of the mesh cone based on two points:  
- **First endpoint of diameter.** Sets the first location on the circumference of the mesh cone base.  
- **Second endpoint of diameter.** Determines the general location and size of the mesh cone base by setting the endpoint of the diameter.  
  - **Height** (page 623)  
  - **2Point (height)** (page 623)  
  - **Axis endpoint** (page 624)  
  - **Top radius** (page 624)  

**Ttr (tangent, tangent, radius)** Defines the base of the mesh cone with a specified radius that is tangent to two objects:  
- **Point on object for first tangent.** Sets a point on an object to serve as the first tangent point.  
- **Point on object for second tangent.** Sets a point on an object to serve as the second tangent point.  
- **Radius of circle.** Sets the radius of the mesh cone base.  
  - **Height** (page 623)
If the specified criteria can produce multiple results, the closest tangent points are used.

**Elliptical** Specifies an elliptical base for the mesh cone.
- **Endpoint of first axis.** Sets the start point for the first axis of the mesh cone base and then specifies the other axis endpoints:
  - **Other endpoint of first axis.** Sets the first axis endpoint.
  - **Endpoint of second axis.** Sets the second axis endpoint.

- **Center.** Specifies the method for creating an elliptical mesh cone base that starts with the center point of the base:
  - **Center point.** Sets the center of the mesh cone base.
  - **Distance to first axis.** Sets the radius of the first axis.
  - **Endpoint of second axis.** Sets the endpoint of the second axis.

**Base radius** Sets the radius of the mesh cone base.
- **Height** (page 623)
- **2Point (height)** (page 623)
- **Axis endpoint** (page 624)
- **Top radius** (page 624)

**Diameter** Sets the diameter for the base of the cone.
- **Height** (page 623)
- **2Point (height)** (page 623)
- **Axis endpoint** (page 624)
- **Top radius** (page 624)

**Height** Sets the height of the mesh cone along an axis that is perpendicular to the plane of the base.
- **2Point (height)** Defines the height of the mesh cone by specifying the distance between two points:
  - **First point.** Sets the first point of a two-point distance.
■ **Second point.** Sets the second point of a two-point distance.

**Axis endpoint** Sets the location of the top point of the cone or the center of the top face of a cone frustum. The orientation of the axis endpoint can be anywhere in 3D space.

**Top radius** Specifies the top radius of the cone, creating a cone frustum.
- **Height** (page 623)
- **2Point (height)** (page 623)
- **Axis endpoint** (page 624)

**Cylinder**

Creates a 3D mesh cylinder.

Specify the size of the base and height.

**Center point of base** Sets the center point of the mesh cylinder base.
- **Base Radius** (page 625)
- **Diameter** (page 625)

**3P (three points)** Sets the location, size, and plane of the mesh cylinder by specifying three points:
- **First point.** Sets the first point on the circumference of the mesh cylinder base.
- **Second point.** Sets a second point on the circumference of the mesh cylinder base.
- **Third point.** Sets the size and planar rotation of the mesh cylinder base.
  - **Height** (page 626)
  - **2Point (height)** (page 625)
  - **Axis endpoint** (page 626)
2P (diameter) Sets the diameter of the mesh cylinder base by specifying two points:
- **First endpoint of diameter.** Sets the first point on the diameter of the mesh cylinder base.
- **Second endpoint of diameter.** Sets the second point on the diameter of the mesh cylinder base.
  - **Height** (page 626)
  - **2Point (height)** (page 625)
  - **Axis endpoint** (page 626)

2Point (height) Defines the height of the mesh cylinder by specifying the distance between two points:
- **First point.** Sets the first point of a two-point distance.
- **Second point.** Sets the second point of a two-point distance.

Ttr (tangent, tangent, radius) Defines the base of the mesh cylinder with a specified radius that is tangent to two objects. If the specified criteria can produce multiple results, the closest tangent points are used.
- **Point on object for first tangent.** Sets a point on an object to serve as the first tangent point.
- **Point on object for second tangent.** Sets a point on an object to serve as the second tangent point.
- **Radius of circle.** Sets the radius of the mesh cylinder base.
  - **Height** (page 626)
  - **2Point (height)** (page 625)
  - **Axis endpoint** (page 626)

Base Radius Sets the radius of the mesh cylinder base.
- **Height** (page 626)
- **2Point (height)** (page 625)
- **Axis endpoint** (page 626)

Diameter Sets the diameter for the base of the cylinder.
- **Height** (page 626)
- **2Point (height)** (page 625)
- **Axis endpoint** (page 626)
**Height** Sets the height of the mesh cylinder along an axis that is perpendicular to the plane of the base.

**Axis endpoint** Sets the location of the top face of the cylinder. The orientation of the axis endpoint can be anywhere in 3D space.

**Elliptical** Specifies an elliptical base for the mesh cylinder.
- **Endpoint of first axis.** Sets the start point for the first axis of the mesh cone base.
  - **Other endpoint of first axis.** Sets the first axis endpoint.
  - **Endpoint of second axis.** Sets the second axis endpoint.

- **Center.** Specifies the method for creating an elliptical mesh cone base that starts with the center point of the base.
  - **Center point.** Sets the center of the mesh cone base.
  - **Distance to first axis.** Sets the radius of the first axis.
  - **Endpoint of second axis.** Sets the endpoint of the second axis.

**Pyramid**
Creates a 3D mesh pyramid.

Specify the diameter and height.

**Center point of base** Sets the center point of the mesh pyramid base.
- **Base radius (page 627)**
- **Inscribed (page 627)**

**Edge** Sets the length of the one edge of the mesh pyramid base, as indicated by two points that you specify:
- **First endpoint of edge.** Sets the first location of the edge of the mesh pyramid.
- **Second endpoint of edge.** Sets the second location of the edge of the mesh pyramid.
  - **Height** (page 627)
  - **2Point (height)** (page 627)
  - **Axis endpoint** (page 627)
  - **Top radius** (page 627)

**Sides** Sets the number of sides for the mesh pyramid. Enter a positive value from 3-32.
- **Center point of base** (page 626)
- **Edge** (page 626)
- **Sides.** Resets the number of sides for the mesh pyramid.

**Base radius** Sets the radius of the mesh pyramid base.
- **Height** (page 627)
- **2Point (height)** (page 627)
- **Axis endpoint** (page 627)
- **Top radius** (page 627)

**Inscribed** Specifies that the base of the mesh pyramid is inscribed, or drawn within, the base radius.
- **Base radius** (page 627)
- **Circumscribed** (page 628)

**Height** Sets the height of the mesh pyramid along an axis that is perpendicular to the plane of the base.

**2Point (height)** Defines the height of the mesh cylinder by specifying the distance between two points:
- **First point.** Sets the first point of a two-point distance.
- **Second point.** Sets the second point of a two-point distance.

**Axis endpoint** Sets the location of the top point of the pyramid or the center of the top face of a pyramid frustum. The orientation of the axis endpoint can be anywhere in 3D space.

**Top radius** Specifies the top radius of the mesh pyramid, creating a pyramid frustum.
- **Height** (page 627)
Circumscribed Specifies that the base of the pyramid is circumscribed, or is drawn around, the base radius.
- **Base radius** (page 627)
- **Inscribed** (page 627)

**Sphere**
Creates a 3D mesh sphere.

Specify the size of the sphere (diameter or radius).
- **Center point** Sets the center point of the sphere.
  - **Radius.** Creates a mesh sphere based on a specified radius.
  - **Diameter.** Creates a mesh sphere based on a specified diameter.

**3P (three points)** Sets the location, size, and plane of the mesh sphere by specifying three points:
- **First point.** Sets the first point on the circumference of the mesh sphere.
- **Second point.** Sets a second point on the circumference of the mesh sphere.
- **Third point.** Sets the size and planar rotation of the mesh sphere.

**2P (diameter)** Sets the diameter of the mesh sphere by specifying two points:
- **First endpoint of diameter.** Sets the first point on the diameter of the mesh sphere.
- **Second endpoint of diameter.** Sets the opposite point on the diameter of the mesh sphere.
**Ttr (tangent, tangent, radius)** Defines a mesh sphere with a specified radius that is tangent to two objects:
- **Point on object for first tangent.** Sets a point on an object to serve as the first tangent point.
- **Point on object for second tangent.** Sets a point on an object to serve as the second tangent point.
- **Radius of circle.** Sets the radius of the mesh sphere.

If the specified criteria can produce multiple results, the closest tangent points are used.

**Wedge**
Creates a 3D mesh wedge.

Specify the length and width of the base and the height.
**First corner** Sets the first corner of the mesh wedge base.
- **Other corner.** Sets the opposite corner of the mesh wedge base, located on the X,Y plane.
  - **Height** (page 630)
  - **2Point (height)** (page 630)
- **Cube** (page 630)
- **Length** (page 630)

**Center** Sets the center point of the mesh wedge base.
- **Corner.** Sets one corner of the mesh wedge base.
  - **Height** (page 630)
  - **2Point (height)** (page 630)
- **Cube** (page 630)
- **Length** (page 630)

**Cube**
Sets all edges of the mesh wedge base to be of equal length.

- **Length** (page 630)

**Length**
Sets the length of the mesh wedge base along the X axis.

- **Width** (page 630) (not available for Cube)

**Width**
Sets the width of the mesh box along the Y axis.

- **Height** (page 630)
- **2Point (height)** (page 630)

**Height**
Sets the height of the mesh wedge. Enter a positive value to draw the height along the positive Z axis of the current UCS. Enter a negative value to draw the height along the negative Z axis.

**2Point (height)**
Defines the height of the mesh wedge by specifying the distance between two points:

- **First point**. Sets the first point of a two-point distance.
- **Second point**. Sets the second point of a two-point distance.

**Torus**
Creates a 3D mesh primitive torus.

Specify two values: the size of the tube and the distance from the center of the torus to the center of the tube.

**Center point**
Sets the center point of the mesh torus.

- **Radius (torus)** (page 631)
- **Diameter (torus)** (page 632)
3P (three points) Sets the location, size, and rotation of the mesh torus by specifying three points. The path of the tube passes through the specified points:

- **First point.** Sets the first point on the path of the tube.
- **Second point.** Sets the second point on the path of the tube.
- **Third point.** Sets the third point on the path of the tube.
  - Tube radius (page 632)
  - 2Point (tube radius) (page 632)
  - Diameter (tube) (page 632)

2P (torus diameter) Sets the diameter of the mesh torus by specifying two points. The diameter is calculated from the center point of the torus to the center point of the tube.

- **First endpoint of diameter.** Sets the first point used to specify the torus diameter distance.
- **Second endpoint of diameter.** Sets the second point used to specify the torus diameter distance.
  - Tube radius (page 632)
  - 2Point (tube radius) (page 632)
  - Diameter (tube) (page 632)

Ttr (tangent, tangent, radius) Defines a mesh torus radius that is tangent to two objects. The specified tangent points are projected into the current UCS:

- **Point on object for first tangent.** Sets a point on an object to serve as the first tangent point.
- **Point on object for second tangent.** Sets a point on an object to serve as the second tangent point.
- **Radius of circle.** Sets the radius of the mesh torus.

If the specified criteria can produce multiple results, the closest tangent points are used.

Radius (torus) Sets the radius of the mesh torus, measured from the center point of the torus to the center point of the tube.

- Tube radius (page 632)
- 2Point (tube radius) (page 632)
- Diameter (tube) (page 632)
**Diameter (torus)** Sets the diameter of the mesh torus, measured from the center point of the torus to the center point of the tube.
- **Tube radius** (page 632)
- **2Point (tube radius)** (page 632)
- **Diameter (tube)** (page 632)

**Tube radius** Sets the radius of the profile that is swept around the mesh torus path.

**2Point (tube radius)** Sets the radius of the profile of the tube based on the distance between two points that you specify:
- **First point**. Sets the first point of a two-point distance.
- **Second point**. Sets the second point of a two-point distance.

**Tube diameter** Sets the diameter of the profile of the mesh torus tube.

**Settings**
Modifies the smoothness and tessellation values for the new mesh object.

**Level of smoothness** Sets the initial degree of smoothness, or roundness, to be applied to the mesh. Enter 0 to eliminate smoothness. Enter a positive integer up to 4 for increased degrees of smoothness. The value is retained for the current drawing session.

This smoothness value is limited by the value of `SMOOTHMESHMAXLEV` (page 1481).

**Tessellation** Enter a tessellation values (the number of faces) for each dimension of a mesh primitive option.

**See also:**
- Create 3D Mesh Primitives

### MESHCAP

**MESHCAP**

Creates a mesh face that connects open edges.

**Access Methods**

- **Menu**: Modify ➤ Mesh Editing ➤ Close Hole
Summary

You can close gaps in mesh objects by selecting the edges of the surrounding mesh faces. For best results, the faces should be on the same plane.

List of Prompts

The following prompts are displayed.

Select connecting mesh edges to create a new mesh face  Specifies which mesh edges form the boundary for the closure. Click the edges to select them.

Select edges or [CHain]

Edges Selects individual edges and adds them to the selection set.

Chain Selects contiguous edges of mesh objects connected end-to-end.

See also:

Create and Close Mesh Gaps

MESHCOLLAPSE

Merges the vertices of selected mesh faces or edges.

Access Methods

Menu: Modify ➤ Mesh Editing ➤ Collapse Face or Edge
Summary

You can cause the vertices of surrounding mesh faces to converge at the center of a selected edge or face. The shapes of surrounding faces change to accommodate the loss of one or more vertices.

List of Prompts

The following prompts are displayed.

Select mesh face or edge to collapse Specifies a mesh edge or a face whose midpoint becomes the point of convergence for the surrounding faces. Click a single mesh edge or face.

See also:

Modify Mesh Faces

MESHCREASE

Sharpens the edges of selected mesh subobjects.

Access Methods

Menu: Modify ➤ Mesh Editing ➤ Crease

Summary

You can sharpen, or crease, the edges of mesh objects. Creasing deforms mesh faces and edges that are adjacent to the selected subobject. Creases added to mesh that has no smoothness are not apparent until the mesh is smoothed.
You can also apply creases to mesh subobjects by changing the crease type and crease level in the Properties Inspector palette (page 844).

**List of Prompts**

The following prompts are displayed.

**Select mesh subobjects to crease** Specifies the mesh subobjects to crease. Click mesh faces, edges, and vertices to crease their associated edges. Press Shift+click to remove a subobject from the selection set.

- **Crease value** (page 635)
- **Always** (page 635)

**Crease value** Sets highest smoothing level at which the crease is retained. If the smoothing level exceeds this value, the crease is also smoothed. Enter a value of 0 to remove an existing crease.

**Always** Specifies that the crease is always retained, even if the object or subobject is smoothed or refined. A crease value of -1 is the same as Always.

**See also:**

Add Creases to Mesh

**MESHEXTRUDE**

Extends a mesh face into 3D space.

**Access Methods**

Menu: Modify ➤ Mesh Editing ➤ Extrude Face
Summary

When you extrude, or extend, a mesh face, you can specify several options to determine the shape of the extrusion. You can also determine whether extruding multiple mesh faces results in joined or separate extrusions.

List of Prompts

The following prompts are displayed.

Mesh face(s) to extrude Specifies the mesh faces to extrude. Click one or more faces to select them.
- Height of extrusion (page 637)
- Direction (page 637)
- Path (page 637)
- Taper angle (page 637)

Setting (Available only when you start the command before selecting faces) Sets the style for extruding multiple adjacent mesh faces.
- Join adjacent mesh faces when extruding Specifies whether adjacent mesh faces are extruded singly or as a unit. (The difference between the two options is not always apparent on a mesh that has not been smoothed.)
  - Yes. Extrudes all adjacent faces as a unit.
  - No. Extrudes each adjacent face separately.
**Height of extrusion** Extrudes mesh faces along the Z axis. Enter a positive value to extrude the face along the positive Z axis. Enter a negative value to extrude along the negative Z axis. Multiple mesh faces do not need to be parallel to the same plane.

**Direction** Specifies the length and direction of the extrusion. (The direction cannot be parallel to the plane of the sweep curve created by the extrusion.)

- **Start point of direction.** Specifies the first point in the direction vector.
- **End point of direction.** Specifies the second point in the direction vector.

**Path** Specifies an object, such as a line or spline, that determines the path and length of the extrusion. The outline of the mesh face is swept along the path. The new orientation of the swept mesh face is perpendicular to the endpoint of the path.

The path should not lie on the same plane as the mesh face or have areas of high curvature. For extrusions that adhere closely to the curved path, use a spline, not an arced polyline, as the path.

**Taper angle** Sets an angle of taper for an extrusion.
Positive angles taper inward from the base mesh face. Negative angles taper outward. The default angle, 0, extrudes the face perpendicular to the plane of the mesh.

If the adjacent faces are not set to be joined, the faces that are selected for extrusion are tapered to the same value. However, for joined extrusions, the taper is applied only to the portion of the extrusion that is not adjacent to another extruded face.

Specifying a large taper angle or a long extrusion height can cause the object or portions of the object to taper to a point before reaching the extrusion height.

- **Angle of taper.** Sets an angle between -90 and +90 degrees.
- **Specify two points.** Sets the taper angle to be the distance between two specified points.

**See also:**
- Modify Mesh Faces

**MESHMERGE**

Merges adjacent faces into a single face.

**Access Methods**

\[ \text{Menu: Modify} \quad \text{Mesh Editing} \quad \text{Merge Face} \]

**Summary**

You can merge two or more adjacent mesh faces to form a single face.
The merge operation is performed only on mesh faces that are adjacent. Other types of subobjects are removed from the selection set.

Merging mesh faces that wrap a corner can have unintended results when you try to edit the mesh or convert it to other types of solid objects. For example, the mesh might no longer be watertight. For best results, restrict mesh merging to faces that are on the same plane.

**List of Prompts**

The following prompts are displayed.

**Select adjacent faces to merge** Specifies the mesh faces to combine. Click each face to select it.

**See also:**
- Modify Mesh Faces

**MESHREFINE**

Multiplies the number of faces in selected mesh objects or faces.

**Access Methods**

Menu: Modify ➤ Mesh Editing ➤ Refine Mesh

**Summary**

Refining a mesh object increases the number of editable faces, providing additional control over fine modeling details. To preserve program memory, you can refine specific faces instead of the entire object.
Refining an object resets the smoothing level that was assigned to the object to 0 (zero). This level of smoothness becomes the new baseline for the object. That is, the smoothness level can no longer be decreased beyond that level. Refining a subobject does not reset the smoothing level.

**List of Prompts**

The following prompts are displayed.

**Mesh object or face subobjects to refine** Specifies 3D mesh objects or mesh faces to be refined. Press Ctrl+click to isolate a specific face.

**See also:**

Refine Mesh Objects or Subobjects

---

**MESHSMOOTH**

Converts 3D objects such as polygon meshes, surfaces, and solids to mesh objects.

**Access Methods**

Menu: Draw ➤ 3D Modeling ➤ Meshes ➤ Smooth Mesh

**Summary**

Take advantage of the detailed modeling capabilities of 3D mesh by converting objects such as 3D solids and surfaces to mesh.

Use this method to convert 3D faces (3DFACE) and legacy polygonal and polyface meshes (from AutoCAD 2009 and earlier). You can also convert 2D objects such as regions and closed polylines.
The level of smoothness upon conversion depends on the mesh type setting (FACETERMESHTYPE (page 1329) system variable). If the mesh type is not set to be optimized, the converted object is not smoothed.

To convert mesh objects to 3D surfaces or solids, use CONVTOSOLID (page 229) or CONVTOSURFACE (page 232) commands.

**Objects That Can Be Converted to Mesh**

<table>
<thead>
<tr>
<th>Object type</th>
</tr>
</thead>
<tbody>
<tr>
<td>3D solids</td>
</tr>
<tr>
<td>3D surfaces</td>
</tr>
<tr>
<td>3D faces</td>
</tr>
<tr>
<td>Polyface and polygon meshes (legacy)</td>
</tr>
<tr>
<td>Regions</td>
</tr>
<tr>
<td>Closed polylines</td>
</tr>
</tbody>
</table>

See also:
Create Meshes by Conversion

**MESHSMOOTHLESS**

Decreases the level of smoothness for mesh objects by one level.

**Access Methods**

Menu: Modify ➤ Mesh Editing ➤ Smooth Less

**Summary**

Decrease the smoothness of selected mesh objects by one level. You can only decrease the smoothness of objects whose level of smoothness is 1 or higher. You cannot decrease the smoothness level of objects that have been refined.
You can decrease the smoothness of multiple objects. If the selected objects have different levels of smoothness, their respective levels are decreased by one. If the selection set contains ineligible objects, those objects can be filtered out.

**See also:**
- Change Mesh Smoothness Levels

**MESHSMOOTHMORE**

Increases the level of smoothness for mesh objects by one level.

**Access Methods**

Menu: Modify ➤ Mesh Editing ➤ Smooth More

**Summary**

Smoothing increases the number of facets in the mesh, resulting in a rounder object.
Facets are the underlying components of each mesh face. You can increase the smoothness level up to the value of `SMOOTHMESHMAXLEV` (page 1481) as long as the number of faces does not exceed the value in the `SMOOTHMESHMAXFACE` (page 1480) system variable. If you select multiple objects with differing levels of smoothness, their respective levels are increased by one.

You can only smooth mesh objects. However, you have the option of converting some types of objects to mesh during the smoothing operation. You can also filter out ineligible objects that you do not want to convert. For a list of objects that can be converted, see `MESHSMOOTH` (page 640).

See also:

- Change Mesh Smoothness Levels

### MESHSPIN

Spins the adjoining edge of two triangular mesh faces.

**Access Methods**

- **Menu:** Modify ➤ Mesh Editing ➤ Spin Triangle Face

**Summary**

You can rotate the edge that joins two triangular mesh faces to modify the shapes of the faces. The edge shared by the selected faces spins to intersect the apex of each face.
NOTE You can use MESH_SPLIT (page 644) to divide a rectangular face into two triangular faces. If you plan to spin the edge between the triangular faces, use the Vertex option to ensure that the split extends precisely from one vertex to the other.

List of Prompts

The following prompts are displayed.

First triangular mesh face to spin Specifies one of two faces to be modified. Click a triangular mesh face.

Second adjacent triangular mesh face to spin Specifies the second of two faces to be modified. Click a triangular mesh face that is next to the first selected face.

See also:

Modify Mesh Faces

MESH_SPLIT

Splits a mesh face into two faces.

Access Methods

Menu: Modify ➤ Mesh Editing ➤ Split Face

Summary

Split a face to add more definition to an area without having to refine it. Because you specify the start and endpoint of the split, this method provides greater control over the location of the split.
For more precision in the placement of the split, you can specify that the split starts or ends at a vertex. The Vertex option is useful for creating two triangular faces from a rectangular face. It provides the precision you need if you later want to spin the new edge using MESHSPIN (page 643).

List of Prompts

The following prompts are displayed:

Face to split In the drawing area, specifies which mesh face to split.

- First split point on face edge. Sets the location on an edge of the mesh face to start the split.
- Second split point on face edge. Sets a second location on an edge of the mesh face to define the path of the split.

Vertex

Vertex Limits the first endpoint of the split to a mesh vertex.

- First vertex for the split. Specifies a vertex on a mesh face.
- Second split point on face edge. Sets the second location on an edge of the mesh face to define the path of the split.
- Vertex. Limits the second endpoint so that it can only intersect with a vertex.
- Second vertex for the split. Specifies a second vertex on the same mesh face.

See also:

Modify Mesh Faces
**MESHUNCREESE**

Removes the crease from selected mesh faces, edges, or vertices.

**Access Methods**

∪ Menu: Modify ➤ Mesh Editing ➤ Uncrease

**Summary**

Restore smoothness to an edge that has been creased.

You can also remove a selected crease in the Crease area of Properties Inspector (page 844) by changing the Type value to None when a face on a mesh is selected.

**List of Prompts**

The following prompt is displayed:

Select crease to remove Specifies which creased edges to smooth. You do not need to press Ctrl to select a creased subobject.

**See also:**

Add Creases to Mesh

**MINsert**

 Inserts multiple instances of a block in a rectangular array.
Summary

Options at the insertion point preset the scale and rotation of a block before you specify its position. Presetting is useful for dragging a block using a scale factor and a rotation other than 1 or 0. If you enter one of the options, respond to the prompts by specifying a distance for the scale options or an angle for rotation.

Blocks inserted using MINSERT cannot be exploded.

You cannot use MINSERT with annotative blocks.

List of Prompts

The following prompts are displayed.

Enter block name or [?] : Enter a name, enter ? to list the currently defined blocks in the drawing, or enter ~ to display the Select Drawing File dialog box

NOTE You cannot precede the name of a block with an asterisk to explode the block’s objects during insertion, as you can with INSERT (page 522).

Specify insertion point (page 647) or [Basepoint (page 648)/Scale (page 648)/X (page 648)/Y (page 649)/Z (page 649)/Rotate (page 649)]: Specify a point or enter an option

Insertion Point

Specifies a location for the blocks.

Enter X scale factor, specify opposite corner, or [Corner/XYZ] <1>: Enter a value, enter an option, or press Enter

X Scale Factor Sets X and Y scale factors.

Specify Rotation Angle The rotation angle sets the angle of the individual block inserts and also sets the angle of the entire array.

Number of Rows/Columns Specifies the number of rows and columns in the array.

Distance Between Rows Specifies the distance (in units) between rows. You can use the pointing device to specify the distance between rows, or specify two points to define a box whose width and height represent the distance between rows and between columns.

Distance Between Columns Specifies the distance (in units) between columns.
**Corner** Sets the scale factor by using the block insertion point and the opposite corner.
- **Specify Rotation Angle** (page 647)
- **Number of Rows/Columns** (page 647)
- **Distance Between Rows** (page 647)
- **Distance Between Columns** (page 647)

**XYZ** Sets X, Y, and Z scale factors.
- **X Scale Factor** (page 647)
- **Corner** (page 648)
- **Specify Rotation Angle** (page 647)
- **Number of Rows/Columns** (page 647)
- **Distance Between Rows** (page 647)
- **Distance Between Columns** (page 647)

**Basepoint**
Temporarily drops the block in the drawing where it is currently positioned and allows you to specify a new base point for the block reference as it is dragged into position. This does not affect the actual base point defined for the block reference.

**Scale**
Sets the scale factor for the X, Y, and Z axes. The scale for the Z axis is the absolute value of the specified scale factor.
- **XYZ** (page 648)
- **Specify Rotation Angle** (page 647)
- **Number of Rows/Columns** (page 647)
- **Distance Between Rows** (page 647)
- **Distance Between Columns** (page 647)

**X**
Sets the X scale factor.
- **Specify Rotation Angle** (page 647)
- **Number of Rows/Columns** (page 647)
- **Distance Between Rows** (page 647)
- **Distance Between Columns** (page 647)
**Y**
Sets the Y scale factor.
- Specify Rotation Angle (page 647)
- Number of Rows/Columns (page 647)
- Distance Between Rows (page 647)
- Distance Between Columns (page 647)

**Z**
Sets the Z scale factor.
- Specify Rotation Angle (page 647)
- Number of Rows/Columns (page 647)
- Distance Between Rows (page 647)
- Distance Between Columns (page 647)

**Rotate**
Sets the angle of insertion for both the individual blocks and the entire array.
- Specify Rotation Angle (page 647)
- X Scale Factor (page 647)
- Number of Rows/Columns (page 647)
- Distance Between Rows (page 647)
- Distance Between Columns (page 647)
- Corner (page 648)
- XYZ (page 648)

**Preview Scale**
Sets the scale factor for the X, Y, and Z axes to control the display of the block as it is dragged into position.
- X Scale Factor (page 647)
- Corner (page 648)
- XYZ (page 648)

**Preview X**
Sets the scale factor for the X axis to control the display of the block as it is dragged into position.
- X Scale Factor (page 647)
■ Corner (page 648)
■ XYZ (page 648)

**Preview Y**
Sets the scale factor for the Y axis to control the display of the block as it is dragged into position.
■ X Scale Factor (page 647)
■ Corner (page 648)
■ XYZ (page 648)

**Preview Z**
Sets the scale factor for the Z axis to control the display of the block as it is dragged into position.
■ X Scale Factor (page 647)
■ Corner (page 648)
■ XYZ (page 648)

**Preview Rotate**
Sets the rotation angle of the block as it is dragged into position.
■ X Scale Factor (page 647)
■ Corner (page 648)
■ XYZ (page 648)

See also:
Insert Blocks

**MIRROR**

Creates a mirrored copy of selected objects.

**Access Methods**

Button

 Toolbar: Drafting tool set ➤ Copy tool group ➤ Mirror
Menu: Modify ➤ Mirror

Summary

You can create objects that represent half of a drawing, select them, and mirror them across a specified line to create the other half.

NOTE By default, when you mirror a text object, the direction of the text is not changed. Set the MIRRTEXT (page 1409) system variable to 1 if you do want the text to be reversed.

List of Prompts

The following prompts are displayed.
Select objects: *Use an object selection method and press Enter to finish*
Specify first point of mirror line: *Specify a point*
Specify second point of mirror line: *Specify a point*

The two specified points become the endpoints of a line about which the selected objects are mirrored. For mirroring in 3D, this line defines a mirroring...
plane perpendicular to the XY plane of the user coordinate system (UCS) containing the mirror line.

Erase source objects? [Yes/No] <N>: Enter y or n, or press Enter

Yes Places the mirrored image into the drawing and erases the original objects.

No Places the mirrored image into the drawing and retains the original objects.

See also:
   Mirror Objects

**MIRROR3D**

Creates a mirrored copy of selected objects across a mirroring plane.

**Access Methods**

![Button]

Button

- **Toolbar:** Modeling tool set ➤ Copy tool group ➤ 3D Mirror
- **Menu:** Modify ➤ 3D Operations ➤ 3D Mirror

**Summary**

It is recommended that you use the gizmos available through the 3DMOVE (page 36), 3DROTATE (page 47), and 3DScale (page 50) commands to manipulate 3D objects. For more information about using gizmos, see Use Gizmos to Modify Objects.

For example:
List of Prompts

The following prompts are displayed.

Select objects: *Use an object selection method and press Enter to finish*

Specify first point of mirror plane (3 points) or [Object (page 653)/Last (page 653)/Zaxis (page 653)/View (page 654)/XY/YZ/ZX (page 654)/3points (page 654)] <3points>: *Enter an option, specify a point, or press Enter*

**Object** Uses the plane of a selected planar object as the mirroring plane.

**Delete Source Objects** If you enter **y**, the reflected object is placed into the drawing and the original objects are deleted. If you enter **n** or press Enter, the reflected object is placed into the drawing and the original objects are retained.

**Last** Mirrors the selected objects about the last defined mirroring plane.

**Z Axis** Defines the mirroring plane by a point on the plane and a point normal to the plane.
**View** Aligns the mirroring plane with the viewing plane of the current viewport through a point.

**XY/YZ/ZX** Aligns the mirroring plane with one of the standard planes (XY, YZ, or ZX) through a specified point.

**3 Points** Defines the mirroring plane by three points. If you select this option by specifying a point, the First Point on Mirror Plane prompt is not displayed.

**See also:**

Mirror Objects

**MLEADER**

Creates a multileader object.
Access Methods

Button

خدام Toolbar: Annotation tool set ➤ Leaders tool group ➤ Multileader
خدام Menu: Dimension ➤ Multileader

Summary

A multileader object typically consists of an arrowhead, a horizontal landing, a leader line or curve, and either a multiline text object or a block.

Multileaders can be created [arrowhead first (page 655), leader landing first (page 656), or content first (page 656)]. If a multileader style has been used, then the multileader can be created from that specified style.

List of Prompts

The following prompts are displayed.
Specify leader arrowhead location (page 655) or [leader landing first (page 656)/Content first (page 656)/Options (page 656)]<Options>:

Leader Arrowhead First
Specifies a location for the arrowhead of the multileader object.

Specify Leader Landing Location Sets placement of the leader landing for the new multileader object.

If you exit the command at this point, then no text is associated with the multileader object.
**Leader Landing First**
Specifies a location for the landing line of the multileader object.

**Specify Leader Arrowhead Location** Sets placement of the arrowhead for the new multileader object.
If you exit the command at this point, then no text is associated with the multileader line.

**Content First**
Specifies a location for the text or block associated with the multileader object.

**Point Selection** Sets placement for the text box for the text label associated with the multileader object. When you finish entering your text, click OK or click outside the text box.
If you choose End at this point, then no landing line is associated with the multileader object.

**Options**
Specifies options for placing the multileader object.

**Leader Type** Specifies a straight, spline, or no leader line.
- **Straight.**
- **Spline.**
- **None.**

**Leader Landing** Changes the distance of the horizontal landing line
- **Yes.**
- **No.**
If you choose No at this point, then no landing line is associated with the multileader object.

**Content Type** Specifies the type of content that will be used for the multileader.
- **Block** (page 656)
- **Mtext** (page 657)
- **None** (page 657)

**Block** Specifies a block within your drawing to associate with the new multileader.
- **Enter block name.**
**Mtext** Specifies that multiline text is included with the multileader.

- **Enter the multiline text.**

**None** Specifies no content type.

**Maxpoints** Specifies a maximum number of points for the new leader line.

- **Enter the maximum points for leader line.**
- **None.**

**First Angle** Constrains the angle of the first point in the new leader line.

- **Enter first angle constraint.**
- **None.**

**Second Angle** Constrains the second angle in the new leader line.

- **Enter second angle constraint.**
- **None.**

See also:

- Create and Modify Leaders

**MLEADERALIGN**

Aligns and spaces selected multileader objects.

**Access Methods**

- **Button**
- **Toolbar:** Annotation tool set ➤ Leaders tool group ➤ Align Leaders
- **Menu:** Modify ➤ Object ➤ Multileader ➤ Align

**Summary**

After multileaders have been selected, specify the multileader to which all others are aligned.
List of Prompts

The following prompts are displayed.
Select multileader to align to or [Options (page 658)]:

**Options**
Specifies options for aligning and spacing the selected multileaders.

- **Distribute** Spaces content evenly between two selected points.
- **Make Leader Segments Parallel** Places content so that each of the last leader segments in the selected multileaders are parallel.
- **Specify Spacing** Specifies spacing between the extents of the content of selected multileaders.
- **Use Current Spacing** Uses the current spacing between multileader content.

See also:
- Create and Modify Leaders

**MLEADERCOLLECT**

Organizes selected multileaders that contain blocks into rows or columns, and displays the result with a single leader.

**Access Methods**

- **Button**
- **Toolbar**: Annotation tool set ➤ Leaders tool group ➤ Collect Leaders
Menu: Modify ➤ Object ➤ Multileader ➤ Collect

Summary

After you select multileaders, you can specify their placement.

For example:

![Diagram of multileader placement]

List of Prompts

The following prompts are displayed.

Specify collected multileader location (page 659) or [Vertical (page 659)/Horizontal (page 659)/Wrap (page 659)]

Specify Collected Multileader Location Specifies the point for placing the multileader collection in the upper-left corner of the collection.

Vertical Places the multileader collection in one or more columns.

Horizontal Places the multileader collection in one or more rows.

Wrap Specifies a width for a wrapped multileader collection.

Specify wrap width.

Number. Specifies a maximum number of blocks per row in the multileader collection.

See also:

Create and Modify Leaders

MLEADEREDIT

Adds leader lines to, or removes leader lines from, a multileader object.
Access Methods

**Button**

- **Toolbar:** Annotation tool set ➤ Leaders tool group ➤ Add Leader, Remove Leader
- **Menu:** Modify ➤ Object ➤ Multileader ➤ Add Leader

**Pointing device:** Hover over Landing grip and choose Add Leader; hover over leader endpoint grip and choose Remove Leader

List of Prompts

The following prompts are displayed.

- Specify leader arrowhead location (page 660) or [Remove Leaders (page 660)]

**Add Leader**

Adds a leader line to a selected multileader object. The new leader line is added to the left or right of the selected multileader, depending on the location of the cursor.

**Remove Leaders** Removes a leader line from a selected multileader object.

For example:
MLEADERSTYLE

Creates and modifies multileader styles.

Access Methods

Menu: Format ➤ Multileader Style

Summary

The Multileader Style Manager (page 661) is displayed.

See also:

Work with Leader Styles

Multileader Style Manager

Creates and modifies styles that you can use to create multileader objects
Summary

Sets the current multileader style and creates, modifies, and deletes multileader styles.

The appearance of multileaders is controlled by multileader styles. These styles specify formatting for landing lines, leader lines, arrowheads, and content.

List of Options

The following options are displayed.

**Current Multileader Style**

Displays the name of the multileader style that is applied to multileaders you create. The default multileader style is Standard.

**Styles**

Displays a list of multileader styles. The current style is highlighted.
List
Controls the contents of the Styles list. Click All Styles to display all multileader styles available in the drawing. Click Styles In Use to display only the multileader styles that are referenced by multileaders in the current drawing.

Preview Of
Displays a preview image of the style that is selected in the Styles list.

New (+)
Displays the Create New Multileader Style dialog box, in which you can define new multileader styles.

Delete (-)
Deletes the multileader style selected in the Styles list. A style that is being used in the drawing cannot be deleted.

Options
Manages the multileader styles in the list.

Set Current
Sets the multileader style selected in the Styles list as the current style. All new multileaders are created using this multileader style.

Modify
Displays the Modify Multileader Style dialog box, in which you can modify multileader styles.

Rename
Edits the name of the style selected in the list.

See also:
Work with Leader Styles

Modify Multileader Style Dialog Box
Modifies an existing multileader style.
Summary

Controls the general appearance of the multileader.

List of Options

The following options are displayed.

Preview

 Displays a preview image of the style being modified.

List of Tabs

The following tabs are displayed.

- Leader Format Tab (page 665)
- Leader Structure Tab (page 666)
- Content Tab (page 667)

See also:

 Work with Leader Styles
Leader Format Tab

Controls the formatting of the leader lines and arrowheads for the multileader.

**General**
Controls the general settings of the arrowheads.

**Type**
Determines the type of leader line. You can choose a straight leader, a spline, or no leader line.

**Color**
Determines the color of the leader line.

**Linetype**
Determines the linetype of the leader line.

**Lineweight**
Determines the lineweight of the leader line.

**Arrowhead**
Controls the appearance of the multileader arrowheads.

**Symbol**
Sets the arrowhead symbol for the multileader.

**Size**
Displays and sets the size of arrowheads.

**Leader Break**
Controls the settings used when adding a dimension break to a multileader.

**Break Size**
Displays and sets the break size used for the DIMBREAK command when the multileader is selected.

See also:

- Work with Leader Styles
Leader Structure Tab

Controls the number of leader points, landing size, and scale for the multileader.

Constrain
Controls the constraints of the multileader.
Maximum Leader Points
Specifies a maximum number of points for the leader line.
First Segment Angle
Specifies the angle of the first point in the leader line.
Second Segment Angle
Specifies the angle of the second point in the multileader landing line.

Landing
Controls the landing settings of the multileader.
Automatically Include
Attaches a horizontal landing line to the multileader content.
Set Distance
Determines the fixed distance for the multileader landing line.

Scale
Controls the scaling of the multileader.
Annotative
Specifies that the multileader is annotative.
Scale to Layout
Determines a scaling factor for the multileader based on the scaling in the model space and paper space viewports.
Specify Scale
Specifies the scale for the multileader.

See also:
   Work with Leader Styles
Content Tab

Controls the type of content attached to the multileader.

Multileader Type
Determines whether the multileader contains text or a block.

MText: Text Options
Controls the appearance of the text for the multileader.

Default Text
Sets default text for the multileader content. The [...] button launches the MTEXT In Place Editor.

Text Style
Lists the available text styles.

Text Style Button
Displays the Text Style dialog box (page 1041) where you can create or modify text styles.

Text Angle
Specifies the rotation angle of the multileader text.

Text Color
Specifies the color of the multileader text.

Text Height
Specifies the height of the multileader text.

Left Justify
Specifies that the multileader text is always left justified.

Frame Text
Frames the multileader text content with a text box. Control the separation between the text and frame by modifying the Landing Gap setting.

Mtext: Leader Connection
Controls the leader connection settings of the multileader.

Attachment
Specifies how the multiline text should be attached to the multileader.
**Horizontal**
Inserts the leader to the left or right of the text content. A horizontal attachment includes a landing line between the text and the leader.

**Left** Controls the attachment of the landing line to the multileader text when the text is to the right of the leader.

**Right** Controls the attachment of the landing line to the multileader text when the text is to the left of the leader.

**Landing Gap** Specifies the distance between the landing line and the multileader text.

**Extend Leader to Text** Extends the landing line to end at the edge of the text line where the leader is attached, not at the edge of the multiline text box. The length of the multiline text box is determined by the length of the longest line of text, not the length of the bounding box.

**Vertical**
Inserts the leader at the top or bottom of the text content. A vertical attachment does not include a landing line between the text and the leader.

**Top** Attaches the leader to the top center of the text content. Click the drop-down to insert an overline between the leader attachment and the text content.

**Bottom** Attaches the leader to the bottom of the text content. Click the drop-down to insert an underline between the leader attachment and the text content.

**Landing Gap** Specifies the distance between the landing line and the multileader text.

**Block: Block Options**
Controls the properties of block content in a multileader object.

**Source block**
Specifies the block used for multileader content.

**Attachment**
Specifies the way the block is attached to the multileader object. You can attach the block by specifying the insertion point of the block or the center point of the block.

**Color**
Specifies the color of the multileader block content. The Block color control in the MLEADERSTYLE Content tab only takes effect if the object color included in the block is set to ByBlock.

**Scale**

Specifies the scale of the block upon insertion. For example, if the block is a 1 inch square and the scale specified is 0.5000, then the block is inserted as a 1/2 inch square.

**See also:**
- Work with Leader Styles

---

**Create New Multileader Style Dialog Box**

Specifications a name for the new multileader style and specifies the existing multileader style on which the new multileader style will be based.

**List of Options**

The following options are displayed.

**New Style Name**

Names the new multileader style.

**Start With**

Specifies an existing multileader style whose settings are the default for the new multileader style.

**Annotative**

Specifies that the multileader object is annotative.

**Continue**

Displays the Multileader Style Manager (page 661), in which you define the new multileader style.

**See also:**
- Work with Leader Styles
MLEEDIT (-MLEEDIT)

Edits multiline intersections, breaks, and vertices.

Access Methods

Menu: Modify ► Object ► Multiline

Summary

If you enter `-mledit` at the Command prompt, options are displayed (page 670).

See also:

Modify Multilines

-MLEDIT

Edits multiline intersections, breaks, and vertices.

List of Prompts

The following prompts are displayed.

CC Creates a closed-cross intersection between two multilines.

OC Creates an open-cross intersection between two multilines. Breaks are inserted in all elements of the first multiline and only the outside elements of the second multiline.

MC Creates a merged-cross intersection between two multilines. The order in which you select the multilines is not important.

CT Creates a closed-tee intersection between two multilines. The first multiline is trimmed or extended to its intersection with the second multiline.

OT Creates an open-tee intersection between two multilines. The first multiline is trimmed or extended to its intersection with the second multiline.

MT Creates a merged-tee intersection between two multilines. The multiline is trimmed or extended to its intersection with the other multiline.
CJ Creates a corner joint between multilines. The multilines are trimmed or extended to their intersection.

AV Adds a vertex to a multiline.

DV Deletes a vertex from a multiline.

CS Creates a visual break in a selected element of a multiline.

CA Creates a visual break through the entire multiline.

WA Rejoins multiline segments that have been cut.

See also:
   Modify Multilines

MLINE

Creates multiple parallel lines.

Access Methods

Menu: Draw ➤ Multiline

List of Prompts

The following prompts are displayed.
Specify start point (page 671) or [Justification (page 672)/Scale (page 673)/STyle (page 673)]: Specify a point or enter an option

Start Point
Specifies the next vertex of the multiline.

If you create a multiline with two or more segments, the prompt includes the Close option.

Next Point Draws a multiline segment to the specified point using the current multiline style and continues to prompt for points.
**Undo** Undoes the last vertex point on the multiline.

**Close** Closes the multiline by joining the last segments with the first segments.

---

**Justification**
Determines how the multiline is drawn between the points you specify.

- **Top** (page 672)
- **Zero** (page 672)
- **Bottom** (page 672)

**Top** Draws the multiline below the cursor, so that the line with the most positive offset is at the specified points.

```
\text{top}
```

**Zero** Draws the multiline with its origin centered at the cursor, so that the element with an offset of 0.0 is at the specified points.

```
\text{zero}
```

**Bottom** Draws the multiline above the cursor, so that the line with the most negative offset is at the specified points.

```
\text{bottom}
```
**Scale**
Controls the overall width of the multiline. This scale does not affect linetype scale.

The scale factor is based on the width established in the multiline style definition. A scale factor of 2 produces a multiline twice as wide as the style definition. A negative scale factor flips the order of the offset line—the smallest on top when the multiline is drawn from left to right. A negative scale value also alters the scale by the absolute value. A scale factor of 0 collapses the multiline into a single line.

---

| scale at 1 | scale at 2 |

**Style**
Specifies a style to use for the multiline.

- **Style Name** (page 673)
- **?** (page 673)

**Style Name** Specifies the name of a style that has already been loaded or that's defined in a multiline library (MLN) file you've created.

?-**List Styles** Lists the loaded multiline styles.

**See also:**
- Draw Multiline Objects

**MODEL**
Switches from a named (paper space) layout to the Model layout.

**Access Methods**
When a viewing a layout, enter **model** at the command prompt or click the Model tab below the drawing window.

- **Toolbar:** Status bar ➤ Quick View ➤ Model
- **Toolbar:** Status bar ➤ Layout drop down ➤ Model
Summary

On the Model layout, you can create drawings in model space. The Model layout automatically sets the TILEMODE (page 1511) system variable to 1, and you can create model viewports to display various views of your drawing. Once you have completed your drawing, you can choose a named (paper space) layout to begin designing a layout environment from which to plot.

For possible performance gains when you switch between layouts or between the Model and named layouts, use the LAYOUTREGENCTL (page 1389) system variable to control how the display list is updated.

See also:

Work with Model Space and Paper Space

MOVE

Moves objects a specified distance in a specified direction.

Access Methods

Button

Sex Toolbar: Drafting tool set ➤ Move/Rotate/Scale tool group ➤ Move
Sex Menu: Modify ➤ Move

Shortcut menu: Select the objects to move. Right-click in the drawing area and click Move.

Summary

Use coordinates, grid snaps, object snaps, and other tools to move objects with precision.
List of Prompts

The following prompts are displayed.
Select objects:
Specify base point or [Displacement]:
Specify second point or <use first point as displacement>:

The two points you specify define a vector that indicates how far the selected objects are to be moved and in what direction.

If you press Enter at the Specify Second Point prompt, the first point is interpreted as a relative X,Y,Z displacement. For example, if you specify 2,3 for the base point and press Enter at the next prompt, the objects move 2 units in the X direction and 3 units in the Y direction from their current position.

**Displacement** Enter coordinates to represent a vector
The coordinate values that you enter specify a relative distance and direction.

See also:
Move Objects

**MREDO**

Reverses the effects of several previous UNDO or U commands.

List of Prompts

The following prompts are displayed.
Enter number of actions (page 676) or [All (page 676)/Last (page 676)]:

M Commands | 675
**Number of Actions** Reverses the specified number of actions.

All Reverses all previous actions.

Last Reverses only the last action.

**See also:**
- Correct Mistakes

**MSPACE**

In a layout, switches from paper space to model space in a layout viewport.

**Access Methods**

**Pointing device:** Double-click over a viewport on a named layout.

Double-click outside of a viewport on a named layout to return to paper space.

**Summary**

Commands operate in either model space or paper space. You use model space (the Model layout) to do drafting and design work and to create two-dimensional drawings or three-dimensional models. You use paper space (a named layout) to create a finished layout of a drawing for plotting.

When you are in a layout, you can enter `mSPACE` at the Command prompt to make the last viewport in the layout current, and then work in model space in that viewport within the layout.

**See also:**
- Work with Model Space and Paper Space

**MTEDIT**

Edits multiline text.

**Access Methods**

**Pointing device:** Double-click a multiline text object.
Summary
Displays either the Text Editor visor and the In-Place Text Editor to modify the formatting or content of the selected multiline text object.

The In-Place Text Editor (page 678) is displayed.

See also:
Change Multiline Text

MTEXT
Creates a multiline text object.

Access Methods

Button

 enthusiasts 
 Toolbar: Annotation tool set ➤ Text tool group ➤ Multiline flyout ➤ Multiline Text

 Menu: Draw ➤ Text ➤ Multiline Text

Summary
You can create several paragraphs of text as a single multiline text (mtext) object. With the built-in editor, you can format the text appearance, columns, and boundaries.

After you specify the point for the opposite corner the Text Editor visor (page 682) is displayed which contains text formatting options.

If you specify one of the other options, or if you enter -mtext at the Command prompt, MTEXT bypasses the In-Place Text editor and displays additional Command prompts (page 698).

See also:
Overview of Multiline Text
Symbols and Special Characters (page 695)
In-Place Text Editor

Creates or modifies single or multiline text objects.

Summary

You can import or paste text from other files to use in multiline text, set tabs, adjust paragraph and line spacing and alignment, and create and modify columns.

The In-Place Text Editor includes

- Text Editor visor (page 682)
- Paragraph dialog box (page 684)
- Column Settings dialog box (page 687)
- Background Mask dialog box (page 689)
- Columns menu (page 686)

When a table cell is selected for editing, the In-Place Text Editor displays column letters and row numbers.

**NOTE** Not all options available when creating single-line text.

List of Options

The following options are displayed.

**Text Editor Shortcut Menu**

Select All Selects all the text in the text editor.

Clipboard Contains options to Cut, Copy, and Paste text to or from the clipboard. The Paste Special option allows you to paste without character or paragraph formatting.
Insert Field  Displays the Insert Field dialog box (page 432).

Symbol  Displays a list of available symbols. You can also select a Non-breaking space and open the Characters dialog box for additional symbols.

Import Text  Displays the Select File dialog box (a standard file selection dialog box (page 723)). Select any file that is in ASCII or RTF format. Imported text retains its original character formatting and style properties, but you can edit and format the imported text in the editor. After you select a text file to import, you can replace either selected text or all text, or append the inserted text to text selected within the text boundary. The file size for imported text is limited to 32 KB. (Not available for single-line text.)

The editor automatically sets the text color to BYLAYER. When black characters are inserted and the background color is black, the editor automatically changes to white or the current color.

Paragraph Alignment  Sets alignment for the multiline text object. You can choose to align your text to the left, center, or right. You can justify your text, or align the first and last characters of your text with the margins of your mtext box, or center each line of text within the margins of your mtext box. Spaces entered at the end of a line are included as part of the text and affect the justification of the line. (Not available for single-line text.)

Paragraph  Displays options for paragraph formatting. See the Paragraph dialog box (page 684). (Not available for single-line text.)

Bullets and Lists  Displays the options for numbering lists. (Not available for single-line text.)

Displays options for creating lists. (Not available for table cells.) The list is indented to align with the first selected paragraph.

- Off: When selected, removes letters, numbers, and bullets from selected text that has list formatting applied. Indentation is not changed.
- Lettered: Applies list formatting that uses letters with periods for the items in the list. If the list has more items than the alphabet has letters, the sequence continues by using double letters.
- Numbered: Applies list formatting that uses numbers with periods for the items in the list.
- Bulleted: Applies list formatting that uses bullets for the items in the list.
- Restart: Starts a new letter or number sequence in list formatting. If the selected items are in the middle of a list, unselected items below them also become part of the new list.
Continue: Adds the selected paragraphs to the last list above and continues the sequence. If list items rather than paragraphs are selected, unselected items below the selected items continue the sequence.

Allow Auto-list: Applies list formatting as you type. The following characters can be used as punctuation after letters and numbers and cannot be used as bullets: period (.), comma (,), close parenthesis ()), close angle bracket (]), close square bracket ([], and close curly bracket (}).

Use Tab Delimiter Only: Limits the Allow Auto-list and Allow Bullets and Lists options. List formatting is applied to text only when the space after the letter, number, or bullet character was created by Tab, not Space.

Allow Bullets and Lists: When this option is selected, list formatting is applied to all plain text in the multiline text object that looks like a list. Text that meets the following criteria is considered to be a list. The line begins with (1) one or more letters or numbers or a symbol, followed by (2) punctuation after a letter or number, (3) a space created by pressing Tab, and (4) some text before the line is ended by Enter or Shift+Enter.

When you clear the check mark, any list formatting in the multiline text object is removed and the items are converted to plain text. Allow Auto-list is turned off, and all the Bullets and Lists options are unavailable except Allow Bullets and Lists.

Columns Displays options for columns. See the Columns menu (page 686). (Not available for single-line text.)

Find and Replace Displays the Find and Replace dialog box (page 690).

Change Case Changes the case of selected text. Options are Uppercase and Lowercase.

AutoCAPS Converts all new and imported text to uppercase. AutoCAPS does not affect existing text. To change the case of existing text, select the text and right-click. Click Change Case.

Character Set Displays a menu of code pages. Select a code page to apply it to the selected text. (Not available for single-line text.)

Combine Paragraphs Combines selected paragraphs into a single paragraph and replaces each paragraph return with a space. (Not available for single-line text.)

Remove Formatting Removes character formatting for selected characters, paragraph formatting for a selected paragraph, or all formatting from a selected paragraph. (Not available for single-line text.)
Background Mask Displays the Background Mask dialog box (page 689). (Not available for table cells and single-line text.)

Stack Creates stacked text, for example, fractions, if the selected text contains stack characters. Also, unstacks text if stacked text is selected. When the stack characters, carat (^), forward slash (/), and pound sign (#), are used, the text to the left of the stack character is stacked on top of the text to the right.

By default, text that contains a carat converts to left-justified tolerance values. Text that contains the forward slash converts to center-justified fractional numbers; the slash is converted to a horizontal bar the length of the longer text string. Text that contains the pound sign converts to a fraction separated by a diagonal bar the height of the two text strings. The characters above the diagonal fraction bar are bottom-right aligned; the characters beneath the diagonal bar are top-left aligned.

Editor Settings Displays a list of options for the text editor. See Editor Settings (page 681) for more information.

Editor Settings Provides options for changing the behavior of the text editor and provides additional editing options. Options are specific to the Editor Settings menu and are not available elsewhere in the text editor.

NOTE Some options may not be available depending on what you are editing.

Always Display As WYSIWYG (What You See Is What You Get) Controls display of the In-Place Text Editor and the text within it. When unchecked, the drawing view is zoomed and rotated if needed so the text that would otherwise be difficult to read (if it is very small, very large, or is rotated) is displayed at a legible size and is oriented horizontally so that you can easily read and edit it.

When this option is checked, the MTEXTFIXED (page 1412) system variable will be set to 0. Otherwise, MTEXTFIXED will be set to 2.

Show Ruler Controls the display of the ruler.

Opaque Background When selected, makes the background of the editor opaque. (Not available for table cells.)

Check Spelling Determines whether As-You-Type spell checking is on or off.

Check Spelling Settings Displays the Check Spelling Settings dialog box (page 1018), where you can specify text options that will be checked for spelling errors within your drawing.

Text Highlight Color Specifies the highlight color when text is selected.
See also:

Overview of Multiline Text

**Text Editor Visor**

Formats the text of the current multiline text object.

**List of Options**

The following options are displayed.

**Text Editor Visor - Row 1**

**Style Options**

<table>
<thead>
<tr>
<th>Style</th>
<th>Applies a text style to the multiline text object. The Standard text style is active by default.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text Height</td>
<td>Sets the character height in drawing units for new text or changes the height of selected text. If the current text style has no fixed height, the text height is the value stored in the TEXTSIZE (page 1509) system variable. A multiline text object can contain characters of various heights.</td>
</tr>
</tbody>
</table>

**Formatting Options**

<table>
<thead>
<tr>
<th>Bold</th>
<th>Turns bold formatting on and off for new or selected text. This option is available only for characters using TrueType fonts.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Italic</td>
<td>Turns italic formatting on and off for new or selected text. This option is available only for characters using TrueType fonts.</td>
</tr>
<tr>
<td>Strikethrough</td>
<td>Turns strikethrough on and off for new or selected text.</td>
</tr>
<tr>
<td>Underline</td>
<td>Turns underlining on and off for new or selected text.</td>
</tr>
<tr>
<td>Overline</td>
<td>Turns overline on and off for new or selected text.</td>
</tr>
</tbody>
</table>
**Editor Options**

**Undo**
Undoes actions in the text editor, including changes to either text content or text formatting.

**Redo**
Redoes actions in the text editor, including changes to either text content or text formatting.

**Cancel**
Closes the text editor and changes are ignored.

**Save**
Closes the text editor and saves your changes.

**More Options**
Displays the second row of the visor which contains additional formatting options.

**Text Editor Visor - Row 2**

**Additional Formatting Options**

**Font**
Specifies a font for new text or changes the font of selected text. TrueType fonts are listed by font family name. AutoCAD compiled shape (SHX) fonts are listed by the name of the file in which the fonts are stored. Custom fonts and third-party fonts are displayed in the editor with Autodesk-supplied proxy fonts.

**Color**
Specifies a color for new text or changes the color of selected text.

**Paragraph Options**

**MText Justification**
Displays the MText Justification menu with nine alignment options available. Top Left is the default. See the Paragraph dialog box (page 684) for a list of additional options.

**Insert Options**

**Insert Symbols**
Inserts a symbol or a nonbreaking space at the cursor position. You can also insert symbols manually. See Symbols and Special Characters (page 695). Commonly used symbols are listed on the submenu, along with their control code or Unicode string. Click Other to display the Character
dialog box, which contains the entire character set for each font available on your system. When you have selected the character that you want to use, click Insert to place the character in the text editor. Close the Characters dialog box when you are done inserting special characters.

Symbols are not supported in vertical text.

Insert Field Displays the Insert Field dialog box (page 432), where you can select a field to insert in the text. When the dialog box closes, the current value of the field is displayed in the text.

**Tools Options**

Find and Replace Displays the Find and Replace dialog box (page 690).

**See also:**

Overview of Multiline Text

**Paragraph Dialog Box**

Sets indentation for paragraphs and the first lines of paragraphs.
Summary

Specifies tab stops, indents, controls paragraph alignment, paragraph spacing, and paragraph line spacing.

NOTE  Not all of the new options for paragraph and paragraph line spacing are supported in AutoCAD 2007 and previous releases. See MTEXT Paragraph and Paragraph Line Spacing in Previous Releases in the User's Guide.

List of Options

The following options are displayed.

Tab

Specifies the tab stops and decimal styles to use for the paragraph.
Tab Stops
Displays tab setting options, including adding and removing tabs. Options include setting left, center, right, and decimal tabs. You can also set tabs from the Tab selection button on the In-Place Editor’s ruler.

Decimal style
Sets the decimal style based on current user locale. Options include setting the decimal style as period, comma, and space. This setting is preserved with the drawing even if the locale setting is changed.

Indent
Controls the left and right indents for the paragraph.

Left
Sets the indent value for the first line or hanging indent to the selected or current paragraphs.

Right
Applies the indent to the entire selected or current paragraph.

Alignment & Spacing
Defines the alignment and spacing for the paragraph.

Paragraph Alignment
Sets the alignment properties for the current or selected paragraphs.

Paragraph Spacing
Specifies the spacing before or after the current or selected paragraphs. The distance between two paragraphs is determined by the total of the after paragraph spacing value of the upper paragraph and the before paragraph spacing value of the lower paragraph.

Line Spacing
Sets the spacing between individual lines in the current or selected paragraphs.

See also:
Overview of Multiline Text

Columns Menu
Allows you to format an mtext object into multiple columns.
Summary

You can specify column and gutter width, height, and number of columns. You can edit column width and height with grip-editing.

To create multiple columns you always start with a single column. Depending on the column mode you choose, you have two different methods for creating and manipulating columns – static mode or dynamic mode.

List of Options

The following options are displayed.

No Columns Specifies no columns for the current mtext object.

Dynamic Columns Sets dynamic columns mode to the current mtext object. Dynamic columns are text driven. Adjusting columns affects text flow and text flow causes columns to be added or removed. Auto height or Manual height options are available.

Static Columns Sets static columns mode to the current mtext object. You can specify the total width and height of the mtext object, and the number of columns. All the columns share the same height and are aligned at both sides.

Insert Column Break Alt+Enter Inserts a manual column break.

Column Settings Displays Column Settings dialog box (page 687).

See also:

Overview of Multiline Text

Column Settings Dialog Box

Displays options for setting up columns such as the type, number of columns, height, and width, and gutter size.
List of Options

The following options are displayed.

**Column Type**

Lists choices for the type of columns you want to create.

**Height**

Displays the height of the multiline text object when Auto Height with Dynamic or Static Columns is selected.

**Number**

Sets the number of columns. This is only active when you select Static Columns.

**Width**

Displays and specifies control column and gutter width values. The gutter value is five times the default multiline text height.
Also displays the total width value of the multiline text object.

See also:
- Overview of Multiline Text

**Background Mask Dialog Box**

Controls using an opaque background behind multiline text.

![Background Mask Dialog Box](image)

**List of Options**

The following options are displayed.

**Use Background Mask**

Puts an opaque background behind the text.

**NOTE** When you apply a background mask to mtext multiple columns only the column areas will be masked. The space between the columns commonly referred to as gutters will be unmasked.

**Offset**

Specifies the margin around the text for the opaque background. The value is based on the text height. A factor of 1.0 exactly fits the multiline text object. A factor of 1.5 extends the background by 0.5 times the text height.

**Use Background Drawing Color**

Provides a background that is the same color as the background of the drawing.

**Fill Color**

Specifies the color for the background.

**Color**

Specifies a color for the opaque background. You can select one of the colors in the list or click Select Color to open the Color Palette dialog box (page 205).
See also:

Overview of Multiline Text

Find and Replace Dialog Box - MTEXT

Searches for specified text strings and replaces them with new text.

![Find and Replace Dialog Box](image)

**Access Methods**

**Shortcut menu:** Select the Find and Replace icon in the text editor or from the MTEXT shortcut menu

**List of Options**

The following options are displayed.

**Find What**
Provides a space for you to type the text you want to find.

**Replace With**
Provides a space for you to type the text you want to replace the text you typed in Find What.

**Find Next**
Finds the next instance of the text specified in Find What.
**Replace**
Finds the next instance of the text specified in Find What and replaces it with the text in Replace With.

**Replace All**
Finds all instances of the text specified in Find What and replaces it with the text in Replace With.

**Hide Options**
Specifies advanced find options.

**Match Case** Finds only text with uppercase and lowercase characters as specified in Find What.
The case of all characters in the text string must match the case of the text in Find What. When this option is cleared, a match is found for specified text strings regardless of case.

**Match Whole Word Only** Finds only whole words specified in Find What.
Text that is part of another word is ignored. When this option is cleared, a match is found for text strings, whether they are single words or parts of other words.

**Use Wildcards** Allows the use of wildcard characters in searches.
For more information on wildcard searches, see Find and Replace Text.

**Match Diacritics** Matches diacritical marks, or accents, in search results.

**Match Half/Full Width Forms (East Asian Languages)** Matches half- and full-width characters in search results.

**See also:**
Overview of Multiline Text

**Stack Properties Dialog Box**
Edits the text, stack type, alignment, and size of stacked text.
Summary

To open the Stack Properties dialog box, select the stacked text, right-click, and click Stack Properties on the shortcut menu.

You can edit the upper and lower text separately. The Appearance options control the stack style, position, and text size of the stacked text.

List of Options

The following options are displayed.

Text

Changes the upper and lower numbers of a stacked fraction.

Upper

Edits the number in the upper part or first half of a stacked fraction.

Lower

Edits the number in the lower part or second half of a stacked fraction.

Appearance

Edits the style, position, or text size of a stacked fraction.

Style

Specifies a style format for stacked text: horizontal fraction, diagonal fraction, tolerance, and decimal.

Fraction (Horizontal) Stacks the selected text with the first number on top of the second number separated by a horizontal line.

Fraction (Diagonal) Stacks the selected text with the first number on top of the second number separated by a diagonal line.
NOTE Releasing AutoCAD earlier than AutoCAD 2000 do not support diagonal fractions. If a multiline text object contains diagonal fractions, the fractions are converted to horizontal fractions when you save the drawing to pre-AutoCAD 2000 releases. Diagonal fractions are restored when the drawing is re-opened in AutoCAD 2000 or a later release. If a single multiline text object contains both horizontal and diagonal fractions, all fractions are converted to diagonal fractions when the drawing is reopened in AutoCAD 2000 or a later release.

**Tolerance** Stacks the selected text with the first number on top of the second number. There is no line between the numbers.

**Decimal** A variation of the Tolerance style that aligns the decimal point of both the upper and lower numbers of selected text.

**Position**
Specifies how fractions are aligned. Center alignment is the default. All stacked text in an object uses the same alignment.
- **Top** Aligns the top of the fraction with the top of the text line.
- **Center** Centers the fraction vertically at the center of the text line.
- **Bottom** Aligns the bottom of the fraction with the text baseline.

**Text Size**
Controls the size of the stacked text as a percentage of the size of the current text style (from 25 to 125 percent).

**Defaults**
Saves the new settings as defaults or restores the previous default values to the current stacked text.

**AutoStack Button**
Displays the AutoStack Properties dialog box (page 693). AutoStack only stacks numeric characters immediately before and after the carat, slash, and pound characters. To stack nonnumeric characters, or text that includes spaces, select the text and choose Stack from the text editor shortcut menu.

See also:
- Overview of Multiline Text

**AutoStack Properties Dialog Box**
Sets the defaults for automatically stacking characters.
Access Methods

Shortcut menu: Select stacked text in the text editor. Right-click and click Stack Properties on the shortcut menu. In the Stack Properties dialog box, click AutoStack.

List of Options

The following options are displayed.

Enable AutoStacking

Automatically stacks numeric characters entered before and after the carat, slash, or pound character. For example, if you type 1#3 followed by a nonnumeric character or space, the text is automatically stacked as a diagonal fraction.

Remove Leading Blank

Removes blanks between a whole number and a fraction.

Convert It to a Diagonal Fraction

Converts the slash character to a diagonal fraction when AutoStack is on.

Convert It to a Horizontal Fraction

Converts the slash character to a horizontal fraction when AutoStack is on.

NOTE Whether AutoStack is on or off, the pound character is always converted to a diagonal fraction, and the carat character is always converted to a tolerance format.

See also:

Overview of Multiline Text
Symbols and Special Characters

You can include special characters and symbols by entering a control code or a Unicode string.

With the In-Place Text Editor (page 678), you can right-click and click Symbol on the shortcut menu.

**NOTE** Symbols are not supported in vertical text.

## Unicode strings and control codes

<table>
<thead>
<tr>
<th>Control Codes</th>
<th>Unicode Strings</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>%%d</code></td>
<td><code>\U+00B0</code></td>
<td>Degree symbol (°)</td>
</tr>
<tr>
<td><code>%%p</code></td>
<td><code>\U+00B1</code></td>
<td>Tolerance symbol (±)</td>
</tr>
<tr>
<td><code>%%c</code></td>
<td><code>\U+2205</code></td>
<td>Diameter symbol (⌀)</td>
</tr>
</tbody>
</table>

To insert the following text symbols, click Symbol on the expanded Text Formatting toolbar or enter the appropriate Unicode string:

## Text symbols and Unicode strings

<table>
<thead>
<tr>
<th>Name</th>
<th>Symbol</th>
<th>Unicode String</th>
</tr>
</thead>
<tbody>
<tr>
<td>Almost equal</td>
<td>≈</td>
<td><code>\U+2248</code></td>
</tr>
<tr>
<td>Angle</td>
<td></td>
<td><code>\U+2220</code></td>
</tr>
<tr>
<td>Boundary line</td>
<td></td>
<td><code>\U+E100</code></td>
</tr>
<tr>
<td>Centerline</td>
<td></td>
<td><code>\U+2104</code></td>
</tr>
</tbody>
</table>

M Commands | 695
## Text symbols and Unicode strings

<table>
<thead>
<tr>
<th>Name</th>
<th>Symbol</th>
<th>Unicode String</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delta</td>
<td>Δ</td>
<td>\U+0394</td>
</tr>
<tr>
<td>Electrical phase</td>
<td>Φ</td>
<td>\U+0278</td>
</tr>
<tr>
<td>Flow line</td>
<td>⦰</td>
<td>\U+1E01</td>
</tr>
<tr>
<td>Identity</td>
<td>≡</td>
<td>\U+2261</td>
</tr>
<tr>
<td>Initial length</td>
<td>⦫</td>
<td>\U+1E00</td>
</tr>
<tr>
<td>Monument line</td>
<td>⦬</td>
<td>\U+1E02</td>
</tr>
<tr>
<td>Not equal</td>
<td>≠</td>
<td>\U+2260</td>
</tr>
<tr>
<td>Ohm</td>
<td>Ω</td>
<td>\U+2126</td>
</tr>
<tr>
<td>Omega</td>
<td>Ω</td>
<td>\U+03A9</td>
</tr>
<tr>
<td>Plate/property line</td>
<td>⦱</td>
<td>\U+214A</td>
</tr>
</tbody>
</table>
Text symbols and Unicode strings

<table>
<thead>
<tr>
<th>Name</th>
<th>Symbol</th>
<th>Unicode String</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subscript 2</td>
<td>2</td>
<td>\U+2082</td>
</tr>
<tr>
<td>Squared</td>
<td>2</td>
<td>\U+00B2</td>
</tr>
<tr>
<td>Cubed</td>
<td>3</td>
<td>\U+00B3</td>
</tr>
</tbody>
</table>

These text symbols are available in the following True Type (TTF) and SHX fonts:
- Simplex*
- Romans*
- gdt*
- amgdt*
- Isocp
- Isocp2
- Isocp3
- Isoct
- Isoct2
- Isoct3
- Isocpeur (TTF only)*
- Isocpeur italic (TTF only)
- Isocteur (TTF only)
- Isocteur italic (TTF only)

* These fonts also include the Initial Length symbol used for arc length dimensions.

See also:
Overview of Multiline Text
-MTEXT

Creates a multiline text object.

List of Prompts

The following prompts are displayed.
Specify first corner.
Specify opposite corner (page 698) or [Height (page 698)/Justify (page 698)/Line spacing (page 700)/Rotation (page 701)/Style (page 701)/Width (page 701)/Columns (page 701)].

Opposite Corner
As you drag the pointing device to specify the opposite corner, a rectangle is displayed to show the location and size of the multiline text object. Arrows within the rectangle indicate the direction of the paragraph’s text flow.

Height
Specifies the text height to use for multiline text characters.

- Specify Height.

The Specify Height prompt is displayed only if the current text style is not annotative.

- Specify Paper Text Height.

The Specify Paper Text Height prompt is displayed only if the current text style is annotative.

The default height, if nonzero, is the height of the current style; otherwise, it is the height stored in the TEXTSIZE (page 1509) system variable. Character height is calculated in drawing units. Changing the height updates the value stored in TEXTSIZE.

Justify
Determines both text justification and text flow, for new or selected text, in relation to the text boundary. The current justification is applied to new text. The text is justified within the specified rectangle based on the justification setting and one of nine justification points on the rectangle. The justification point is based on the first point used to specify the rectangle. Text is center-, left-, or right-justified with respect to the left and right text boundaries. Spaces entered at the end of a line are included as part of the text and affect the justification of the line. Text flow controls whether text is aligned from the
middle, the top, or the bottom of the paragraph with respect to the top and bottom text boundaries.


<table>
<thead>
<tr>
<th>Option</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>TL</td>
<td>Top Left</td>
</tr>
<tr>
<td>TC</td>
<td>Top Center</td>
</tr>
<tr>
<td>TR</td>
<td>Top Right</td>
</tr>
<tr>
<td>ML</td>
<td>Middle Left</td>
</tr>
<tr>
<td>MC</td>
<td>Middle Center</td>
</tr>
<tr>
<td>MR</td>
<td>Middle Right</td>
</tr>
<tr>
<td>BL</td>
<td>Bottom Left</td>
</tr>
<tr>
<td>BC</td>
<td>Bottom Center</td>
</tr>
<tr>
<td>BR</td>
<td>Bottom Right</td>
</tr>
</tbody>
</table>

The following illustrations show each justification option.
Line Spacing
Specifies line spacing for the multiline text object. Line spacing is the vertical distance between the bottom (or baseline) of one line of text and the bottom of the next line of text.

**NOTE** Exact spacing is recommended when you use MTEXT to create a table. Use a smaller text height than the specified line spacing to ensure that text does not overlap.

At Least Adjusts lines of text automatically based on the height of the largest character in the line. When At Least is selected, lines of text with taller characters have added space between lines.

Distance Sets the line spacing to an absolute value measured in drawing units. Valid values must be between 0.0833 (0.25x) and 1.3333 (4x).
Exactly Forces the line spacing to be the same for all lines of text in the multiline text object. Spacing is based on the text height of the object or text style.

Spacing Factor Sets the line spacing to a multiple of single-line spacing. Single spacing is 1.66 times the height of the text characters. You can enter a spacing factor as a number followed by \textit{x} to indicate a multiple of single spacing. For example, specify single spacing by entering \textit{1x}, or specify double spacing by entering \textit{2x}.

Rotation Specifies the rotation angle of the text boundary.

\textbf{Specify rotation angle.}

If you use the pointing device to specify a point, the rotation angle is determined by the angle between the \textit{X} axis and the line defined by the most recently entered point (default 0,0,0) and the specified point.

The previous prompt is redisplayed until you specify the opposite corner of the text boundary.

Style Specifies the text style to use for multiline text.

\textbf{Style Name} Specifies a text style name. Text styles can be defined and saved using the \textit{STYLE} (page 1040) command.

\textit{?—List Styles} Lists text style names and characteristics.

The previous prompt is redisplayed until you specify the opposite corner of the text boundary.

Width Specifies the width of the text boundary.

If you use the pointing device to specify a point, the width is calculated as the distance between the start point and the specified point. Words within each line of the multiline text object wrap to fit the width of the text boundary. If you specify a width of 0, word wrap is turned off and the width of the multiline text object is as wide as the longest line of text. You can end a line of text at a specific point by typing the text and pressing Enter. To end the command, press Enter at the MTEXT prompt.

Columns Specifies the column options for an mtext object.

\textbf{Static} Specifies the total column width, the number of columns, the gutter width (the space between the columns), and the height of columns.
**Dynamic** Specifies column width, gutter width and column height. Dynamic columns are text driven. Adjusting columns affect text flow and text flow causes columns to be added or removed.

**No columns** Sets no column mode to current mtext object.

The default column setting is stored in the MTEXTCOLUMN (page 1411) system variable.

*See also:*

   Overview of Multiline Text

**MULTIPLE**

Repeats the next command until canceled.

**Summary**

The command that you enter is repeated until you press Esc. Because MULTIPLE repeats only the command name, any parameters must be specified each time.

MULTIPLE does not repeat commands that display dialog boxes.

---

**NOTE** You cannot use MULTIPLE as an argument to the AutoLISP® command function.

*See also:*

   Enter Commands on the Command Line

**MVIEW**

Creates and controls layout viewports.

**Access Methods**

- **Toolbar:** Layout visor ➤ New Viewport
- **Shortcut menu:** Right-click the drawing area when a named layout is current and click New Viewport.
Summary

In a layout, you can create as many viewports as you want, but only up to 64 viewports can be active at one time (see MAXACTVP (page 1405)). Objects in model space are visible only in active viewports. Viewports that are not active are blank. Use the On and Off options to control whether viewports are active.

List of Prompts

The following prompts are displayed.
Specify corner of viewport (page 703) or [ON (page 703)/OFF (page 703)/Fit (page 703)/Shadeplot (page 703)/Lock (page 704)/Object (page 704)/Polygonal (page 704)/Restore (page 704)/Layer (page 705)/2 (page 705)/3 (page 705)/4 (page 706)].

Corner of Viewport
Specifies the first corner of a rectangular viewport.

On
Makes a selected viewport active. An active viewport displays objects in model space. The MAXACTVP system variable controls the maximum number of viewports that can be active at one time. If your drawing contains more viewports than the number specified in MAXACTVP, you must turn one off to make another one active.

Off
Makes a selected viewport inactive. Objects in model space are not displayed in an inactive viewport.

Fit
Creates one viewport that fills the layout to the edges of the printable area. When the paper background and printable area are turned off, the viewport fills the display.

Shadeplot
Specifies how viewports in named (paper space) layouts are plotted.
As Displayed Specifies that a viewport is plotted the same way it is displayed.
**Wireframe** Specifies that a viewport is plotted wireframe regardless of the current display.

**Hidden** Specifies that a viewport is plotted with hidden lines removed regardless of the current display.

**All Visual Styles** Specifies that a viewport is plotted using the specified visual style.

**All Render Presets** Specifies that a viewport is plotted using the specified render preset.

**Lock**
Prevents the zoom scale factor in the selected viewport from being changed when working in model space.

**Object**
Specifies a closed polyline, ellipse, spline, region, or circle to convert into a viewport. The polyline you specify must be closed and contain at least three vertices. It can be self-intersecting, and it can contain an arc as well as line segments.

**Polygonal**
Creates an irregularly shaped viewport using specified points.

**Arc** Adds arc segments to the polygonal viewport.
For a description of the options for creating arc segments, see the Arc option in PLINE (page 796).

**Close** Closes the boundary. If you press Enter after specifying at least three points, the boundary is closed automatically.

**Length** Draws a line segment of a specified length at the same angle as the previous segment. If the previous segment is an arc, the new line segment is drawn tangent to that arc segment.

**Undo** Removes the most recent line or arc segment added to the polygonal viewport.

**Restore**
Restores viewport configurations saved with the VPORTS (page 1151) command.

- **Enter Viewport Configuration Name.**
- **?**

**First Corner** Positions and sizes new viewports using the window selection method; the viewports are fit into the selected area.
Fit Sizes the viewports to fill the drawing area.

**Layer**
Resets layer property overrides for the selected viewport to their global layer properties.

- **Reset Viewport Layer Property Overrides Back To Global Properties.** Enter Y to remove all layer property overrides.
- **Select Viewports.**

2
Divides the specified area horizontally or vertically into two viewports of equal size.

**Enter Viewport Arrangement.**

```
2/vertical
```

**First Corner** Positions and sizes new viewports using the window selection method; the viewports are fit into the selected area.

Fit Sizes the viewports to fill the drawing area.

3
Divides the specified area into three viewports.

The Horizontal and Vertical options split the specified area into thirds. The other options split the area into three viewports: one large viewport and two smaller ones. The Above, Below, Left, and Right options specify where the larger viewport is placed.

```
3/right
```

- **First Corner** (page 705)
Fit (page 705)

Divides the specified area horizontally and vertically into four viewports of equal size.

See also:
Create and Modify Layout Viewports

MVSETUP

Sets up the specifications of a drawing.

Summary
When you enter `mvsetup`, the prompts displayed depend on whether you are on the Model layout (model space) (page 706) or on a named layout (paper space) (page 707).

See also:
Create and Modify Layout Viewports

MVSETUP on the Model Layout

The Model layout is most useful for plotting multiple views of a drawing within a single border.
On the Model layout, you set the units type, drawing scale factor, and paper size at the Command prompt using MVSETUP. Using the settings you provide, a rectangular border is drawn at the grid limits.

**List of Prompts**

When the TILEMODE (page 1511) system variable is on (the default), the following prompt are displayed:

```
Enable paper space? [No/Yes] <Y>: Enter or press Enter
```

Pressing Enter turns off TILEMODE and proceeds as described in the following section, Using MVSETUP on a Layout Tab. (page 707)

Entering `n` displays the following prompt:

```
Enter units type
[Scientific/Decimal/Engineering/Architectural/Metric]: Enter an option
```

A list of available units and prompts for the scale factor and paper size are displayed.

```
Enter the scale factor: Enter a value
Enter the paper width: Enter a value
Enter the paper height: Enter a value
```

A bounding box is drawn and the command ends.

**See also:**

Create and Modify Layout Viewports

**MVSETUP on a Named Layout**

On a named layout, you can insert one of several predefined title blocks into the drawing and create a set of layout viewports within the title block.

You can specify a global scale as the ratio between the scale of the title block in the layout and the drawing on the Model layout.

To easily specify all layout page settings and prepare your drawing for plotting, you can also use the Page Setup Manager.
List of Prompts

When the TILEMODE (page 1511) system variable is off, or when you enter \textit{y} or press Enter at the Enable Paper Space prompt, the following prompts are displayed:

Enter an option [\textit{Align} (page 708)/\textit{Create} (page 708)/\textit{Scale viewports} (page 709)/\textit{Options} (page 709)/\textit{Title block} (page 710)/\textit{Undo} (page 709)]: \textit{Enter an option or press Enter to end the command}

\textbf{Align}

Pans the view in a viewport so that it aligns with a base point in another viewport. The current viewport is the viewport that the other point moves to.

\textbf{Angled}

Pans the view in a viewport in a specified direction.

The next two prompts specify the distance and angle from the base point to the second point.

\textbf{Horizontal}

Pans the view in one viewport until it aligns horizontally with a base point in another viewport. This option should be used only if the two viewports are oriented horizontally. Otherwise, the view might be panned outside the limits of the viewport.

\textbf{Vertical Alignment}

Pans the view in one viewport until it aligns vertically with a base point in another viewport. This option should be used only if the two viewports are oriented vertically. Otherwise, the view might be panned outside the limits of the viewport.

\textbf{Rotate View}

Rotates the view in a viewport about a base point.

\textbf{Undo}

Reverses operations performed in the current MVSETUP session.

\textbf{Create}

Creates viewports.

\textbf{Delete Objects}

Deletes existing viewports.

\textbf{Create Viewports}

Displays options for creating viewports.

\textbf{Layout Number to Load}

Controls creation of viewports.

Entering \textbf{0} or pressing Enter creates no viewports.

Entering \textbf{1} creates a single viewport whose size is determined by the following prompts.

Entering \textbf{2} creates four viewports by dividing a specified area into quadrants. You are prompted for the area to be divided and the distance between the viewports.
The viewing angle for each quadrant is set as shown in the table.

<table>
<thead>
<tr>
<th>Quadrant</th>
<th>View</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upper-left</td>
<td>Top (XY plane of UCS)</td>
</tr>
<tr>
<td>Upper-right</td>
<td>SE isometric view</td>
</tr>
<tr>
<td>Lower-left</td>
<td>Front (XZ plane of UCS)</td>
</tr>
<tr>
<td>Lower-right</td>
<td>Right side (YZ plane of UCS)</td>
</tr>
</tbody>
</table>

Entering **3** defines a matrix of viewports along the X and Y axes. Specifying points at the next two prompts defines the rectangular area of the drawing that contains the viewport configuration. If you have inserted a title block, the Specify First Corner prompt also includes an option for selecting a default area.

If you enter more than one viewport in each direction, the following prompts are displayed:

- Specify distance between viewports in X direction <0.0>
- Specify distance between viewports in Y direction <0.0>

The array of viewports is inserted into the defined area.

**Redisplay** Redisplays the list of viewport layout options.

**Undo**
Reverses operations performed in the current MVSETUP session.

**Scale Viewports**
Adjusts the zoom scale factor of the objects displayed in the viewports. The zoom scale factor is a ratio between the scale of the border in paper space and the scale of the drawing objects displayed in the viewports.

**Interactively** Selects one viewport at a time and displays the following prompts for each:

For example, for an engineering drawing at a scale of 1:4, or quarter scale, enter **1** for paper space units and **4** for model space units.

**Uniform** Sets the same scale factor for all viewports.

**Options**
Sets the MVSETUP preferences before you change your drawing.

**Layer** Specifies a layer on which to insert the title block.
Limits Specifies whether to reset the grid limits to the drawing extents after a title block has been inserted.

Units Specifies whether the sizes and point locations are translated to inch or millimeter paper units.

Xref Specifies whether the title block is inserted or externally referenced.

Title Block Prepares paper space, orients the drawing by setting the origin, and creates a drawing border and a title block.

Delete Objects Deletes objects from paper space.

Origin Relocates the origin point for this sheet.

Undo Reverses operations performed in the current MVSETUP session.

Insert Displays title block options.

Title Block to Load Inserts a border and a title block. Entering 0 or pressing Enter inserts no border. Entering 1 through 13 creates a standard border of the appropriate size. The list includes ANSI and DIN/ISO standard sheets.

Add Adds title block options to the list. Selecting this option prompts you to enter the title block description to be displayed in the list and the name of a drawing to insert.

A line similar to the following example is added after the last entry in the mvsetup.dfs default file:

```
A/E (24 x 18in),arch-b.dwg,(1.12 0.99 0.00),(18.63 17.02 0.00),in
```

The last field of the line specifies whether the title block has been created in inches or in millimeters. The units field allows title blocks created in either unit system to be changed by setting the unit type using the Options option. You can also add title blocks that have variable attributes.

Delete Removes entries from the list.

Redisplay Redisplays the list of title block options.

Undo Reverses operations performed in the current MVSETUP session.

See also:

Create and Modify Layout Viewports
NAVVCUBE

Indicates the current viewing direction. Dragging or clicking the ViewCube tool rotates the scene.

Access Methods

Menu: View ➤ Display ➤ ViewCube ➤ On

Toolbar: Status bar ➤ ViewCube

Summary

Click the ViewCube tool to rotate and fill the window with the entire model or an object selected in the view. The Home button displayed near the ViewCube tool rotates the model to a three-fourths view or a user-defined view while performing a fit-to-view. Use the ViewCube menu to define the Home view for the model.

List of Prompts

The following prompts are displayed.

Enter an option [ON (page 711)/OFF (page 711)/Settings (page 711)] <ON>:

On Displays the ViewCube tool.

Off Turns off the display of the ViewCube tool.

Settings Displays the ViewCube Settings dialog box (page 711), in which you can control the appearance and location of the ViewCube.

See also:

Use ViewCube Tool

ViewCube Settings Dialog Box

Controls the display properties of the ViewCube tool.
List of Options

The following options are displayed.

Display

Location

Identifies the corner in a viewport where the ViewCube tool is displayed. (NAVVCUBELOCATION (page 1414) system variable)

Size

Specifies the size of the ViewCube tool. (NAVVCUBESIZE (page 1415) system variable)

Select Automatic to have the size of the ViewCube tool adjust based on the current size of the active viewport, zoom factor of the active layout, or drawing window.

Inactive Opacity

Controls the opacity of the ViewCube tool when inactive. (NAVVCUBEOPACITY (page 1414) system variable)

When Dragging

Snap to Closest View
Specifies if the current view is adjusted to the closest preset view when changing the view by dragging the ViewCube tool.

**When Clicking**  
**Zoom to Extents**  
Specifies if the model is forced to fit the current viewport after a view change.

**Orient ViewCube to Current UCS**  
Controls whether the ViewCube tool reflects the current UCS or WCS.  
*(NAVVCUBEORIENT (page 1415) system variable)*

**Animate When Switching Views**  
Controls the use of smooth view transitions when switching between views.

**Show**  
**UCS Menu** Controls the display of the UCS drop-down menu below the ViewCube tool.

**Compass** Controls whether the compass is displayed below the ViewCube tool. The North direction indicated on the compass is the value defined by the NORTHDIRECTION system variable.

**Keep**  
**Scene Upright** Specifies whether the viewpoint of the model can be turned upside-down.

**Restore Defaults**  
Applies the default settings for the ViewCube tool.

**See also:**  
Use ViewCube Tool

**NEW**

Creates a new drawing.

**Access Methods**  

Menu: File ➤ New
Summary

If the FILEDIA system variable is set to 0 instead of 1, a Command prompt is displayed (page 714).

See also:

   Overview of Starting a New Drawing

NEW Command Prompt

Summary

Enter a tilde (~) at the prompt to display the Select Template dialog box (a standard file selection dialog box (page 723)).

List of Prompts

The following prompts are displayed.

Enter template file name or [. (for none)] <current>: Enter a name, enter a period (.), or press Enter

See also:

   Overview of Starting a New Drawing

NEWSHEETSET

Creates a new project data (DST) file that manages drawing layouts, file paths, and project information.

Access Methods

Menu: File ➤ New Project
Toolbar: Project Manager palette ➤ Create action button ➤ Create New Project

Summary

The New Project dialog box (page 972) allows you to create a new blank project data (DST) file, or use a project template or existing project data file to create
a new project. After a project data file is created, you can create new layouts or add layouts from existing drawings to the project.

See also:
Create a Project

O Commands

OBJECTSCALE

Adds or deletes supported scales for annotative objects.

Access Methods

Button

 Toolbar: Annotation tool set ➤ Annotation Scaling tool group ➤ Add/Delete Scales
 Menu: Modify ➤ Annotative Object Scale ➤ Add/Delete Scales
Shortcut menu: Select an annotative object. Right-click in the drawing area and click Annotative Object Scale ➤ Add/Delete Scales.
 Command entry: 'objectscale for transparent use

Summary

An annotative object can support several annotation scales for views at different scales. You can add or delete scales from the list of scales assigned to the selected annotative objects.

If you enter objectscale, you are prompted to select annotative objects.

The Annotation Object Scale List dialog box (page 716) is displayed.

If you enter -objectscale at the Command prompt, options are displayed (page 718).

See also:
Set Annotation Scale
Annotation Object Scale List Dialog Box

Adds or deletes supported scales for the selected annotative object.

List of Options

The following options are displayed.

Object Scale List
Displays the list of scales supported by the selected object.

List all scales for selected objects
Specifies that all scales supported by the selected objects are displayed in the Object Scale List.

List scales common to all selected objects only
Specifies that only the supported scales that are common to all selected objects are displayed in the Object Scale List.

Add (+)
Displays the Add Scales to Object Dialog Box (page 717).

Delete (-)
Removes the selected scale from the scale list.

**NOTE** The current scale or scales referenced by objects or views cannot be deleted.
Add Scales to Object Dialog Box

Adds a new scale to the selected annotative object.

List of Options

The following option is displayed.

Scale List

Displays the list of scales that can be added to the selected annotative object.

Multiple scales can be selected by holding down the Shift or Command key while selecting the scales.

Use the SCALELISTEDIT (page 930) command to add custom scales to this list.

See also:

Scale Views in Layout Viewports
**-OBJECTSCALE**

**List of Prompts**

The following prompts are displayed.

Select annotative objects: *Use an object selection method*

Enter an option [Add (page 718)/Delete (page 718)/? (page 718)]

<Add>: Enter a or d or press Enter

**Add**

Adds an annotation scale to the selected annotative objects.

When created, an annotative object supports one annotation scale: the current annotation scale. However, an annotative object can be updated to support additional annotation scales for views at different scales.

- **Enter named scale to add.**
- **? (page 718)**

? Displays the list of scales in the scale list.

**Delete**

Removes a specified current annotation scale from the selected objects.

If an annotative object supports a single scale, that scale cannot be deleted from the object.

- **Enter named scale to delete.**
- **? (page 718)**

? Displays the union of all scales of the selected objects.

**See also:**

   Scale Views in Layout Viewports

**OFFSET**

Creates concentric circles, parallel lines, and parallel curves.
Access Methods

Button

 Toolbar: Drafting tool set ➤ Copy tool group ➤ Offset
 Menu: Modify ➤ Offset

Summary

You can offset an object at a specified distance or through a point. After you offset objects, you can trim and extend them as an efficient method to create drawings containing many parallel lines and curves.

The OFFSET command repeats for convenience. To exit the command, press Enter.

List of Prompts

The following prompts are displayed.

Current settings: Erase source = current Layer = current
OFFSETGAPTYPE = current
Specify Offset Distance (page 720) or [Through (page 720)/Erase (page 720)/Layer (page 720)] <current>: Specify a distance, enter an option, or press Enter
**Offset Distance**
Creates an object at a specified distance from an existing object.

Exit Exits the OFFSET command.

Multiple Enters the Multiple offset mode, which repeats the offset operation using the current offset distance.

Undo Reverses the previous offset.

**Through**
Creates an object passing through a specified point.

**NOTE** For best results when you offset a polyline with corners, specify the through point near the midpoint of a line segment, not near a corner.

**Erase**
Erases the source object after it is offset.

**Layer**
Determines whether offset objects are created on the current layer or on the layer of the source object.

See also:

Offset an Object
OFFSETEDGE

Creates a closed polyline or spline object that is offset at a specified distance from the edges of a selected planar face on a 3D solid or surface.

Summary

You can offset the edges of a planar face on a 3D solid or surface. The result is a closed polyline or spline that is located on the same plane as the selected face or surface, and can be inside or outside the original edges.

TIP You can use the resulting object with PRESSPULL (page 838) or EXTRUDE (page 427) to create new solids.

List of Prompts

The following prompts are displayed.

Corner = current
Select face: Select a planar face on a 3D solid or surface
Specify through point or [Distance/Corner] <current>: Specify a point, or enter an option

Through Point

Creates an offset object that passes through the specified point. This point is always projected line-of-sight onto the plane of the selected face.

Distance

Creates an offset object at a specified distance from the edges of the selected face.

Specify distance: <current> Enter the offset distance, or press Enter to accept the current distance.
Specify point on side to offset Specify a point location to determine whether the offset distance is applied inside or outside the edges of the face.

Corner
Specifies the type of corners on the offset object when it is created outside the edges of the selected face.

Sharp Creates sharp corners between offset linear segments.
Rounded Creates rounded corners between offset linear segments, using a radius that is equal to the offset distance.

See also:
Offset an Object
Add Facets to Faces on Solids and Surfaces

OOPS
Restores erased objects.

Summary
OOPS restores objects erased by the last ERASE (page 410) command.

You can also use OOPS after BLOCK (page 148) or WBLOCK (page 1160) because these commands can erase the selected objects after creating a block.

You cannot use OOPS to restore objects on a layer that has been removed with the PURGE (page 861) command.

See also:
Erase Objects
OPEN

Opens an existing drawing file.

Access Methods

Menu: File ➤ Open

Summary

The Select File dialog box (a standard file selection dialog box (page 723)) is displayed.

When FILEDIA (page 1334) is set to 0 (zero), OPEN displays a Command prompt (page 726).

See also:

Open a Drawing

Standard File Selection Dialog Boxes

Several commands display standard file selection dialog boxes, in which you can navigate through the files and folders on a local and network drive. While each dialog box may vary slightly, the following is a list of common options.
List of Options

The following options are displayed.

Task Pane

Provides access to categories that represent locations files might be stored in; devices, shared and predefined places, and media. You can reorder the items under a category by dragging them to a new position. To add a new item to Places, drag a folder from the list. Changes to Places affect all standard file selection dialog boxes.

Devices

Lists the local storage devices attached to your computer.

Shared

Lists the network location paths added to your computer.
Places
Lists a number of predefined, user added, or Smart folders that are dependent on your user profile.

Documents Displays the contents of the Documents folder for the current user profile.

Desktop Displays the contents of your desktop.

Search For
Lists the files that you most recently searched for.

Media
Lists folders related to media located on your computer, such as photos or movies.

Back
Returns to the previous file location.

Forward
Returns you to the file location before Back was clicked.

Views
Controls the appearance of the icons for the files and folders in the current place, specifies whether to show a preview image when a file is selected.

Icon Displays each file or folder as an icon. The icons used are determined by the operating system, or a thumbnail preview of the contents of a file might be used.

List Displays a list of the files and folders. Folders can be expanded to show the hierarchy of the files or folders they contain.

Column Displays a multi-column list with each column representing a folder in the hierarchy of the contents on your computer. When a file is selected, a preview and details of the file are displayed in the next available column.

Where
Displays the current folder or drive. Click the dropdown arrow to view the hierarchy of the folder path, and to navigate to a previous folder, drive, or recent place. The REMEMBERFOLDERS system variable controls whether the last used paths in each standard file selection dialog box are stored across sessions.
Search
Allows you to search for a file or folder located on the computer using Spotlight. Search results can be saved as Smart folders under Places in the Task Pane.

Files List
Displays the files and folders in the current place. Use the Views buttons to control navigation behavior, and how files and folders are listed.

File Format
When you are opening or saving files, File Format specifies the format of the files you can select for open or in which the file is saved.

Read Only
Indicates if the file should be opened as read-only. You cannot save changes to the file using the original file name.

Open/Save
Depending on the purpose of the specific file selection dialog box, opens or saves the selected file or enters the path of the selected folder in the previous dialog box.

New Folder
Creates a new folder in the current place using a name that you specify.

See also:
Save a Drawing

OPEN Command Prompt
Opens an existing drawing file.

When FILEDIA (page 1334) is set to 0 (zero), OPEN displays the following Command prompt.

Enter name of drawing to open:

Enter ~ (tilde) at the prompt to ignore FILEDIA and display the Select File dialog box (page 723), a standard file selection dialog box.

See also:
Open a Drawing

726 | Chapter 2  Commands
OPENSHEETSET

Opens a selected project data (DST) file.

Access Methods

Menu:  File ➤  Open Project

Toolbar:  Project Manager palette ➤  Project action button ➤  Open Project

Summary

The Open Project dialog box (a standard file selection dialog box (page 723)) is displayed.

In this dialog box, you can select a project data (DST) file to load into the Project Manager.

See also:

Create and Manage a Project

OPTIONS

Customizes the program settings.

Access Methods

Menu:  AutoCAD 2013 ➤  Preferences

Shortcut menu:  With no commands active and no objects selected, right-click in the drawing area. Click Preferences.

Summary

The Application Preferences dialog box (page 728) is displayed.

See also:

Set Up the Drawing Area
Application Preferences Dialog Box

Customizes the program settings.

List of Tabs

The Application Preferences dialog box includes the following tabs:

- General (page 728)
- Cursor & Selection (page 730)
- Units & Guides (page 733)
- Look & Feel (page 735)
- Application (page 738)
- Document Settings (page 742)

See also:

Set Up the Drawing Area

General Tab (Application Preferences Dialog Box)

Controls the behavior of program features.
List of Options

The following options are displayed.

**Mouse & Trackpad Customization**
Controls the behavior of the mouse or trackpad.

**Enable Quick Secondary Click as Return Key**
Controls right-click behavior.
A quick click is the same as pressing Enter. A longer click displays a shortcut menu. You can set the duration of the longer click in milliseconds. (DBLCLKEDIT (page 1245) system variable)

**Reverse Zoom Direction**
Toggles the direction of transparent zoom operations when you scroll the middle mouse wheel. (ZOOMWHEEL (page 1577) system variable)

**Spacebar Customization**
Controls the behavior of the spacebar when pressed or held.

**Enable Spacebar Hold to Pan**
Toggles if you can hold down the Spacebar to enable panning. (SPACEPAN (page 1486) system variable)

**Viewport Controls**
Controls the display of the menus in the upper-left corner of all viewports.

**Display the Viewport Controls**
Controls whether the menus for viewport tools, views, and visual styles that are located in the upper-left corner of every viewport are displayed. (VPCONTROL (page 1537) system variable)

**File Save Precautions**
Assists in avoiding data loss.

**Automatic Save**
Saves your drawing automatically at the intervals you specify. You can specify the location of all Autosave files by using the SAVEFILEPATH (page 1464) system variable. SAVEFILE (page 1464) (read-only) stores the name of the Autosave file.

**NOTE**
Automatic save is disabled when the Block Editor (page 143) is open.

**Minutes Between Saves:**
When Automatic Save is on, specifies how often the drawing is saved. (SAVETIME (page 1465) system variable)

**Zoom Adjustment**
Controls the zoom behavior of the input device.

**Zoom Speed**
Controls how much the magnification changes when the mouse wheel is rolled forward or backward, or you single swipe on Magic Mouse or a trackpad. (ZOOMFACTOR (page 1577) system variable)
**Layout Elements**
Controls the tasks that the program performs when a new layout is created.

*Create Viewports in New Layouts* Creates a single viewport automatically when you create a new layout. ([LAYOUTCREATEVIEWPORT](page 1388) system variable)

*Show Page Setup Manager* Displays the [Page Setup Manager](page 753) the first time you click a named (paper space) layout. Use this dialog box to set options related to paper and print settings. ([SHOWPAGESETUPFORNEWLAYOUTS](page 1474) system variable)

**Adaptive Degradation**
Controls settings related to configuration of the graphics display system.

*Automatically decrease display quality to improve performance* Controls whether adaptive degradation is on or off. With adaptive degradation on, if performance goes below a specified level, effects are disabled or reduced to maintain an acceptable level of performance.

**See also:**
Set Up the Drawing Area

**Cursor & Selection Tab (Application Preferences Dialog Box)**
Controls the appearance and behavior of the cursor and selection.
List of Options

The following options are displayed.

Selection Modes
Controls the selection of objects in the drawing area.

Use Shift Key to Add to Selection Controls whether subsequent selections replace the current selection set or add to it.

To clear a selection set quickly, draw a selection window in a blank area of the drawing. (PICKADD (page 1432) system variable)

Click and Drag to Start Selection Controls the method of drawing a selection window.

If this option is cleared, you can draw a selection window by selecting two separate points with the pointing device. (PICKDRAG (page 1434) system variable)
**Selection Tool**
Controls the appearance of the cursor in the drawing area.

**Preview** Shows a representation of how the crosshair, ObjectSnap aperture, and pickbox will appear in the drawing area.

**Crosshair Color** Controls the color of the crosshair, ObjectSnap aperture, and pickbox in the drawing area. Automatic is the default color. When set to Automatic, the actual color applied changes between white and black based on the background color of the drawing area.

**Crosshair Lines Length** Determines the size of the crosshairs as a percentage of the screen size.
Valid settings range from 1 to 100 percent. When set to 100, the crosshairs are full-screen and the ends of the crosshairs are never visible. When less than 100, the ends of the crosshairs may be visible when the cursor is moved to one edge of the screen. (**CURSORSIZE** (page 1244) system variable)

**ObjectSnap Aperture Size** Sets the display size for the object snap target box, in pixels.
Aperture size determines how close to a snap point you can be before the magnet locks the aperture box to the snap point. Values range from 1 to 50 pixels. (**APERTURE** (page 69) system variable)

**Pickbox Size** Sets the object selection target height, in pixels. (**PICKBOX** (page 1433) system variable)

**Autosnap Marker**
Controls the appearance of the Autosnap Marker.

**Marker Size** Sets the display size for the AutoSnap marker.

**Grips**
Grips are small squares displayed on an object after it has been selected.

**Enable Grips** Controls the display of grips on selected objects. You can edit an object with grips by selecting a grip and using the shortcut menu. Displaying grips in a drawing significantly affects performance. Clear this option to optimize performance. (**GRIPS** (page 1349) system variable)

**Enable Grips with Blocks** Controls the display of grip tips and Ctrl-cycling tooltips. (**GRIPBLOCK** (page 1346) system variable)
Enable Grips Tips Controls the display of grip tips and Ctrl-cycling tooltips. This option has no effect on standard objects. (GRPTIPS (page 1351) system variable)

Limit Grip Display To N Selected Objects Suppresses the display of grips when the selection set includes more than the specified number of objects. The valid range is 1 to 32,767. The default setting is 100. (GRPOBJLIMIT (page 1349) system variable)

Grip Size Sets the size of the grip box in pixels. (GRPSIZE (page 1349) system variable)

3D Modeling Dynamic Input
Controls dynamic input in 3D.

Show Z Field for Pointer Input Displays a field for the Z coordinate when using dynamic input.

See also:
   Set Up the Drawing Area

Units & Guides Tab (Application Preferences Dialog Box)
Controls the units used when inserting blocks or referencing objects, and which drafting guides are enabled.
List of Options

The following options are displayed.

**Insertion Scale**
Controls the default scale for inserting blocks and drawings into a drawing.

**Source Content Units** Sets source content units value when INSUNITS is set to 0.
If Unspecified-Unitless is selected, the object is not scaled when inserted. (INSUNITSDEFSOURCE (page 1375) system variable)

**Target Drawing Units** Sets target drawing units value when INSUNITS is set to 0. (INSUNITSDEFTARGET (page 1376) system variable)

**Coordinate Display**
Controls the display of the coordinates display.

**Display Coordinates on Drawing** Toggles the coordinates display in the lower-right corner of the drawing area. (VPCOORDDISPLAY (page 1538) system variable)

**3D Objects**
Controls the number of isolines to display for surfaces and meshes.

**U Size** Sets the surface density for PEDIT Smooth in the M direction and the U isolines density on surface objects. (SURFU (page 1501) system variable)

**V Size** Sets the surface density for PEDIT Smooth in the N direction and the V isolines density on surface objects. (SURFV (page 1502) system variable)
**AutoTrack Settings**

Controls the settings that relate to AutoTrack™ behavior, which is available when polar tracking or object snap tracking is turned on (see DSETTINGS (page 368)).

**Display Polar Tracking Vector** Displays a vector along specified angles when polar tracking is on. With polar tracking, you can draw lines along angles. Polar angles are 90-degree divisors, such as 45, 30, and 15 degrees. (TRACKPATH (page 1518) system variable = 2)

In a 3D view, a polar tracking vector parallel to the Z axis of the UCS is also displayed, and the tooltip displays +Z or -Z for the angle depending on the direction along the Z axis.

**Display Full-screen Tracking Vector** Tracking vectors are construction lines from which you can draw objects at specific angles or in specific relationships to other objects. If this option is selected, alignment vectors are displayed as infinite lines. (TRACKPATH system variable = 1)

**Display AutoTrack Tooltip** Controls the display of the AutoSnap marker, tooltip, and magnet. (AUTOSNAP (page 1217) system variable)

**Drawing Scale**

Defines the default scales used by the program.

**Default Scales List** Displays the Default Scale List dialog box (page 745). Use this dialog box to manage the default list of scales displayed in several dialog boxes associated with layout viewports and printing. You can delete all custom scales and restore the default list of scales.

**Fields**

Sets preferences related to fields.

**Display Background of Fields** Controls whether fields are displayed with a gray background.

When this option is cleared, fields are displayed with the same background as any text. (FIELDDISPLAY (page 1333) system variable)

**See also:**

   - Set Up the Drawing Area

**Look & Feel Tab (Application Preferences Dialog Box)**

Controls the appearance of the program user interface.
List of Options

The following options are displayed.

**Interface Theme**
Defines the color scheme for the user interface.

**Themes** Controls which theme to apply to elements such as the status bar, palettes, and the drawing windows. You can choose from a Dark or Light theme.

**Tooltip Appearance**
Controls the appearance of drafting tooltips.

**Size** Specifies a size for tooltips. The default size is 0. Use the slider to make tooltips larger or smaller.
Transparency Controls the transparency of tooltips. The lower the setting, the less transparent the tooltip. A value of 0 sets the tooltip to opaque.

Interface Overrides
Overides used to fine tune the colors applied to the background of the drawing area.

Model Space Specifies the background color of the drawing area when the Model layout is active. Choose a color or Select Color to specify one of the non-standard colors.

Paper Space Specifies the background color of the drawing area when a named (paper space) layout is active.

Block Editor Specifies the background color of the drawing area when the Block Editor environment is active.

Navigation Controls
Controls the display of the ViewCube and the UCS icon.

Display UCS Icon in Controls when the UCS icon should be displayed in a viewport.

■ 2D Model Space - Display UCS icon when the 2D Wireframe visual style is current.
■ 3D Model Space - Display UCS icon when a 3D visual style is current.

Display ViewCube in Controls when the ViewCube tool should be displayed in a viewport.

■ 2D Model Space - Display the ViewCube tool when the 2D Wireframe visual style is current.
■ 3D Model Space - Display the ViewCube tool when a 3D visual style is current.

ViewCube Settings
Displays the ViewCube Settings dialog box (page 711).

Fade Controls
Controls the fading intensity value for annotative objects and xrefs.

Annotative Objects Specifies the fading intensity value for objects during in-place reference editing. Objects that are not being edited are displayed at a lesser intensity. (XFADECTL (page 1574) system variable)

With in-place reference editing, you can edit a block reference or external reference from within the current drawing. The valid range is 0 through 90 percent.
Xrefs Controls the dimming for all DWG xref objects. (XDWGFADECTL (page 1573) system variable)
This option only affects the display on the screen. It does not affect plotting or plot preview.

**Tool Set & Status Bar Icons**
Controls the size of the icons used in parts of the user interface.

**Icon Size** Specifies the size of the icons displayed on the Tool Sets palette and status bar. (ICONSIZE (page 1369) system variable)

See also:
Set Up the Drawing Area

**Application Tab (Application Preferences Dialog Box)**

Lists the folders in which the program searches for support, driver, menu, and other files. Also lists optional, user-defined settings such as which dictionary to use for checking spelling.

![Application Preferences Dialog Box](image)

**List of Options**
The following options are displayed.

**Support File Search Path**
Specifies the folders in which the program should look for text fonts, customization files, plug-ins, drawings to insert, linetypes, and hatch patterns that are not in the current folder.
Working Support File Search Path
Displays the active directories that the program searches for support files specific to your system. The list is read-only and displays valid paths from the Support Files Search Path that exist within the current directory structure and network mappings.

Device Driver File Search Path
Specifies the search path for device drivers for the video display, pointing devices, printers, and plotters.

WARNING Do NOT remove the DRV path and always add paths as secondary paths.

Project Files Search Path
Specifies a project name for the drawing. The project name corresponds to a search path for external reference (xref) files associated with the project. You can create any number of project names with associated folders, but each drawing can have only one project name.

Customization Files
Specifies the names and locations of various types of files.

Main Customization File Specifies the default location of the main customization file (acad.cuix).

Custom Icon Location Specifies the location for custom icons referenced by your customization files.

Command Aliases Specifies the location of the PGP file that should be loaded when AutoCAD is started.

Help and Miscellaneous File Names
Specifies the names and locations of various types of files.

Help File Specifies the location of the local Help file. (HELPPREFIX (page 1355) system variable)

Default Internet Location Specifies the default Internet location used by the BROWSER (page 163) command.

Configuration File Specifies the location of the configuration file used to store hardware device driver information.

Text Editor, Dictionary, and Font File Names
Specifies a number of optional settings.

Alternate Font File Specifies the alternate font to be used when the specified font file cannot be located. (FONTALT (page 1336) system variable)
If you click Browse, the Alternate Font dialog box (page 744) is displayed, from which you can choose an available font.

Font Mapping File Specifies the font mapping file to be used. (FONTMAP (page 1337) system variable)

Print File, Spooler, and Prolog Section Names Specifies settings related to plotting.

Plot File Name for Legacy Plotting Scripts Specifies a default name for the temporary plot files used with plotting scripts created with AutoCAD Release 14 or earlier. The default name is the drawing name plus the .plt file extension. The default name used with AutoCAD 2000 and later drawings is the drawing name-layout name plus the .plt file name extension. Some plotting device drivers, however, use a different plot file extension.

Print Spool Executable Specifies the application to use for print spooling. You can enter the executable file name as well as any command line arguments you want to use. For example, you can enter myspool.sh %s to spool print files to myspool.sh and have a unique print file name automatically generated.

PostScript Prolog Section Name Present for legacy reasons only. Autodesk has dropped active support of PostScript and the PSIN, PSOUT, and PSPROLOG commands.

Printer Support File Path Specifies search path settings for printer support files.

Print Spooler File Location Specifies the path for print spool files.

Printer Configuration Search Path Specifies the path for printer configuration files.

Printer Description File Search Path Specifies the path for files with a .pmp file extension, or printer description files.

Plot Style Table Search Path Specifies the path for files with an .stb or .ctb extension, or plot style table files (both named plot style tables and color-dependent plot style tables).

Automatic Save File Location Specifies the path for the file created when you select Automatically Save on the General tab. (SAVEFILEPATH (page 1464) system variable)

Color Book Locations Specifies the path for color book files that can be used when specifying colors in the Color Palette dialog box (page 205). You can define multiple folders for each path specified. This option is saved with the user profile.
**Template Settings**
Specifies the drawing template settings.

**Drawing Template File Location** Specifies the path to locate drawing template files used by the Select Template dialog box.

**Project Template File Location** Specifies the path to locate project template files used by the New Project dialog box.

**Default Template File Name for QNEW** Specifies the drawing template file used by the QNEW (page 872) command.

**Default Template for Layout Creation and Page Setups Overrides** Specifies the default template file that is used for creating new layouts and to store page setup overrides that can be applied to Publish operations from the Project Manager.

**Log File Location**
Specifies the path for the log file created when you select Maintain a Log File on the Open and Save tab. (LOGFILEPATH (page 1401) system variable)

**Plot and Publish Log File Location**
Specifies the path for the log file that is created when you use the PLOT (page 803) command.

**Temporary Drawing File Location**
Specifies the location to store temporary files. This program creates temporary files and then deletes them when you exit the program. If you plan to run the program from a write-protected folder (for example, if you are working on a network or opening files from a CD), specify an alternate location for your temporary files. The folder you specify must not be write-protected.

A character limit of 255 for the combined file name and path length of temporary files is used.

The TEMPPREFIX (page 1506) system variable (read-only) stores the current location of temporary drawing files.

**Temporary External Reference File Location**
Creates a path for storing temporary copies of demand-loaded xref files. (XLOADPATH (page 1575) system variable)

**Texture Maps Search Path**
Specifies the folders to search for rendering texture maps.

**Web File Search Path**
Specifies the folders to search for photometric web files.

**Add**
Adds a search path for the selected folder.
**Remove**  
Removes the selected search path or file.

**Options**  
Edits or changes the order of a selected path.

**Change Path** Displays the Browse for Folder or Select a File dialog box, depending on what you selected in the Files list.

**Move Item Up** Moves the selected search path above the preceding search path.

**Move Item Down** Moves the selected search path below the following search path.

**Set as Current** Makes the selected project or spelling dictionary current.

**Reset Hidden Messages**  
Resets the display of all message boxes that you marked to not display again or to always use a specified option in them.

**Reset Application Options**  
Displays the Reset Application Options dialog box. Click Restart AutoCAD to restore the program defaults.

Before the program is reset, many of the files that you can customize are backed up to an archive file with the naming convention of *Settings Backup <Date> <Time>*.tgz. The archive file is saved to `/Users/<user name>/Library/Application Support/Autodesk`.

The archive contains many of the customization files located in the following folders:

- `/Users/<user name>/Library/Application Support/Autodesk/local/AutoCAD 2013`
- `/Users/<user name>/Library/Application Support/Autodesk/roaming/AutoCAD 2013`

**See also:**  
Set Up the Drawing Area

**Document Settings Tab (Application Preferences Dialog Box)**  
Controls the display settings for a drawing.
List of Options

The following options are displayed.

**2D Display Resolution**
Controls the display of 2D objects.

**Polyline Curve Segments**
Sets the number of line segments to be generated for each spline-fit polyline generated by the Spline option of the PEDIT command. (*SPLINESEGS* (page 1488) system variable)

**Arc & Circle Smoothness**
Sets the resolution for objects in the current viewport. (*VIEWRES* (page 1143) command)

**3D Display Resolution**
Controls the display of 3D objects.

**Contour Lines per Surface**
Specifies the number of contour lines per surface on objects. (*ISOLINES* (page 1381) system variable)

**Smoothness for 3D Printing and Rendering**
Adjusts the smoothness of shaded and rendered objects and objects with hidden lines removed. (*FACETRES* (page 1333) system variable)
See also:
Set Up the Drawing Area

Select Alternate Font Dialog Box

Specifies the location of the font file to use if the original font cannot be located and an alternate font is not specified in the font mapping file.

Access Methods

**Pointing device:** Application Preferences dialog box, Application tab

Summary

You can also set the location of Alternate Font File by using the `FONTALT` (page 1336) system variable.

If you do not specify an alternate font, when you open a drawing containing fonts that cannot be located, a dialog box is displayed in which you specify a font to use for each missing font.

List of Options

The following options are displayed.

Font Name
Lists the font family name for all registered TrueType fonts and all SHX fonts in the Fonts folder.

Font Style

Specifies font character formatting, such as italic, bold, or regular. If the missing font is a Big Font, this option changes to Big Font and lists all available Asian-language Big Font files.

See also:

Substitute Fonts

Default Scale List Dialog Box

Controls the default list of scales stored in the registry.

Access Methods

Pointing device: Application Preferences dialog box, Units & Guides tab

Summary

When the scale list in a drawing is reset, the list is restored to the default list of scales defined in the Default Scale List dialog box.

NOTE To control the list of scales for the current drawing, use the SCALELISTEDIT (page 930) command. After you add a new scale to the default scale list in the registry, you can use the Reset button in the Edit Drawing Scales dialog box to add the new scale to your drawing.

List of Options

The following options are displayed.

Scale List

Metric Displays the default list of metric scales.

Imperial Displays the default list of imperial scales.

If a scale name is duplicated, but has a different value, a number is appended to the name.

Add

Creates a new scale in the scale list.
Press Tab to move between the fields of the scale being edited.

**Delete**
Removes the selected scale from the scale list.

**Options**
Manages items in the scale list.

**Edit** Edits the selected scale in-place in the scale list.
Press Tab to move between the fields of the scale being edited.

**Reset** Deletes all custom scales and restores the default list of scales defined in AutoCAD.

**See also:**
- Scale Views in Layout Viewports

**ORTHO**

Constrains cursor movement to the horizontal or vertical direction.

**Access Methods**

- **Menu:** Tools ➤ Drafting Settings
- **Toolbar:** Status bar ➤ Ortho
- **Command entry:** F8
- **Command entry:** ‘ortho for transparent use

**Summary**

In the illustration, a line is drawn using Ortho mode. Point 1 is the first point specified, and point 2 is the position of the cursor when the second point is specified.
Ortho mode is used when you specify an angle or distance by means of two points using a pointing device. In Ortho mode, cursor movement is constrained to the horizontal or vertical direction relative to the UCS.

Horizontal is defined as being parallel to the X axis of the UCS and vertical as being parallel to the Y axis.

In a 3D view, ORTHO is additionally defined as being parallel to the Z axis of the UCS, and the tooltip displays +Z or -Z for the angle depending on the direction along the Z axis.

See also:
Use Orthogonal Locking (Ortho Mode)

OSNAP

Sets running object snap modes.

Access Methods

Menu: Tools ➤ Drafting Settings

Toolbar: Status bar ➤ Osnap

Shortcut menu: Press Shift while right-clicking in the drawing area and choose Osnap Settings.

Command entry: F3

Command entry: 'osnap for transparent use

Summary

The Object Snap tab of the Drafting Settings dialog box (page 369) is displayed.

If you enter -osnap at the Command prompt, the following prompts are displayed.

List of Prompts

The following prompts are displayed.

Current osnap modes: current

Enter list of object snap modes (page 748): Enter names of object snap modes separated with commas, or enter none or off
Object Snap Modes
Specify one or more object snap modes by entering the first three characters of the name. If you enter more than one name, separate the names with commas.

<table>
<thead>
<tr>
<th>ENDpoint</th>
<th>CENter</th>
<th>TANgent</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIDpoint</td>
<td>NODE</td>
<td>NEArest</td>
</tr>
<tr>
<td>INTersection</td>
<td>QUAdrant</td>
<td>PARallel</td>
</tr>
<tr>
<td>EXTension</td>
<td>INSertion</td>
<td></td>
</tr>
<tr>
<td>APParent Intersection</td>
<td>PERpendicular</td>
<td></td>
</tr>
</tbody>
</table>

For a description of each of these object snap modes, see the Object Snaps tab of the Drafting Settings dialog box (page 369).

QUick Snaps to the first snap point found. Quick must be used in conjunction with other object snap modes.

NONE Turns off object snap modes.

See also:
Use Object Snaps

OVERKILL

Removes duplicate or overlapping lines, arcs, and polylines. Also, combines partially overlapping or contiguous ones.

Access Methods

Button

Toolbar: Drafting tool set ➤ Explode tool set ➤ Delete Duplicate Objects
Menu: Modify ➤ Delete Duplicate Objects
Summary

Displays the Delete Duplicate Objects dialog box (page 749).

Removes redundant geometry.
■ Duplicate copies of objects are deleted
■ Arcs drawn over portions of circles are deleted
■ Lines, partially overlapping, drawn at the same angle are combined into a single line
■ Duplicate line or arc segments overlapping polyline segments are deleted

If you enter -overkill at the Command prompt, options are displayed.

See also:
   Erase Objects

Delete Duplicate Objects Dialog Box

Removes duplicate geometry as well as overlapping lines, arcs, and polylines. Also, combines partially overlapping or contiguous ones.
List of Prompts

The following options are displayed.

**Object Difference Tolerance**
Controls the precision with which OVERKILL makes numeric comparisons. If this value is 0, the two objects being compared must match before OVERKILL modifies or deletes one of them.

**Ignore Object Property:**
Use these settings to determine which object properties are ignored during comparison.

- **Color** Object color is ignored.
- **Layer** Object layers are ignored.
- **Linetype** Object linetypes are ignored.
- **Linetype Scale** Object linetype scale is ignored.
Lineweight  Object lineweight is ignored.
Thickness  Object thickness is ignored.
Transparency  Object transparency is ignored.
Plot style  Object plot style is ignored.
Material  Object material is ignored.

Options
Use these settings to control how OVERKILL deals with lines, arcs, and polylines.

Optimize polyline segments When selected, individual line and arc segments within selected polylines are examined. Duplicate vertices and segments are removed.
Also, OVERKILL compares individual polyline segments with completely separate line and arc segments. If a polyline segment duplicates a line or arc object, one of them is deleted.
If this option is not selected, polylines are compared as discreet objects and two sub-options are not selectable.

■ Ignore polyline segment width. Ignores segment width, while optimizing polyline segments.
■ Do not break polylines. Polyline objects are unchanged.

Combine co-linear objects that partially overlap Overlapping objects are combined into single objects.

Combine co-linear objects when aligned end-to-end Objects that have common endpoints are combined into single objects.

Maintain associative objects Associative objects are not deleted or modified.

See also:
Erase Objects

-OVERKILL

Removes duplicate or overlapping lines, arcs, and polylines. Also, combines partially overlapping or contiguous ones.
**List of Prompts**

The following prompts are displayed.

Select objects: **Use an object selection method**

Enter an option to change [Ignore (page 752)/Tolerance (page 752)/Optimize Plines (page 752)/Combine partial overlap (page 753)/Combine Endtoend (page 753)/Associativity (page 753)]

<done>:

**List of Options**

**Ignore**

Ignores one or more of the following properties during object comparison

- None
- All
- Color
- Layer
- Ltype
- Ltscale
- LWeight
- Thickness
- Transparency
- PlotStyle
- Material

**Tolerance** Defines the value within which OVERKILL makes numeric comparisons for determining object duplication.

**Optimize Polylines** Optimize segments within plines [segment width/Break polyline/Yes/No] <Yes>:

- **Segment Width**: ignore polyline segment width
- **Break Polyline**: maintains polylines when optimizing polyline segments
- **Yes**: Enabled by default. Honors polylines as discreet objects and deletes non-polyline objects that overlap polylines.
- **No**: Forces OVERKILL to examine polyline segments individually. Polyline segments may be deleted as duplicates of non-polyline objects.
Combine Partial Overlap Overlapping objects area combined into single objects.

Combine End to End Objects that have common endpoints are combined into single objects.

Associativity Associative objects are not deleted or modified.

See also:
- Erase Objects

## P Commands

### PAGESETUP

Controls the page layout, plotting device, paper size, and other settings for each new layout.

#### Access Methods

- **Menu:** File ➤ Page Setup Manager
- **Toolbar:** Status bar ➤ Quick View. In the Quick View dialog box, right-click a layout and click Page Setup.

#### Summary

The Page Setup Manager (page 753) is displayed.

A page setup is a collection of plot device and other settings that determine the appearance and format of your final output. These settings are stored in the drawing file and can be modified and applied to other layouts.

See also:
- Specify Page Setup Settings

### Page Setup Manager

Specifies the page setup for the current layout or drawing sheet.
Summary

You can also create named page setups, modify existing ones, or import page setups from other drawings.

List of Options

The following options are displayed.

Current Layout
Lists the current layout to which the page setup will be applied.

Page Setups
Displays the current page setup, sets a different page setup as current, creates a new page setup, modifies an existing page setup, and imports page setups from other drawings.
Current Page Setup
Indicated by a triangle to the left of the page setup name.

Page Setup List
Lists the page setups that are available to apply to the current layout. The list includes the named and default layout page setups that are available in the drawing. Double-click the column to the left of a page setup in this list to set it as the current page setup for the current layout or double-click in the Page Setups column to rename a page setup.

Create a New Page Setup (+)
Displays the New Page Setup dialog box (page 756), in which you can enter a name for the new page setup and specify the page setup to use as a starting point.

Delete the Selected Page Setup (-) Removes the selected page setup. A page setup assigned to a layout or is the default page setup for a layout cannot be removed.

Settings
Allows you to manage and import page setups.

Edit
Displays the Page Setup dialog box (page 757) in which you can modify the settings for the selected page setup.

Set Current Sets the selected page setup as the current page setup for the current layout.
You cannot set the current layout as the current page setup.

Rename Allows you to change the name of the selected page setup.
You cannot rename the default page setups for a named layout.

Delete Removes the selected page setup.
A page setup assigned to a layout or is the default page setup for a layout cannot be removed.

Import
Displays the Select Page Setup From File dialog box (a standard file selection dialog box), in which you can select a drawing format (DWG), DWT, or drawing interchange format (DXF) file from which to import one or more page setups.
If you select DWT as the file type, the Template folder opens automatically in the Select Page Setup From File dialog box. When you click Open, the Import Page Setups dialog box (page 763) is displayed.

**Details**
Displays information about the selected page setup.

**Device Name**
Displays the name of the output device specified in the currently selected page setup.

**Printer**
Displays the type of output device specified in the currently selected page setup.

**Page Size**
Displays the paper size and orientation specified in the currently selected page setup.

**Where**
Displays the physical location of the output device specified in the currently selected page setup.

**Description**
Displays descriptive text about the output device specified in the currently selected page setup.

**See also:**
Specify Page Setup Settings

**New Page Setup Dialog Box**

Specifies a name for the new page setup, as well as the page setup to use as a starting point.
List of Options

The following options are displayed.

**New Page Setup Name**

Specifies the name for the new page setup.

**Start From**

Specifies a page setup to use as a starting point for the new page setup. When you click Continue, the Page Setup dialog box (page 757) is displayed with the settings of the selected page setup, which you can modify as necessary.

<Default Output Device> Specifies that the default output device is set as the printer in the new page setup.

**See also:**

Specify Page Setup Settings

**Page Setup Dialog Box**

Specifies page layout and plotting device settings.
Summary

The Page Setup dialog box is displayed in the following cases:

- When you create a new page setup through the Page Setup Manager (page 753)
- When you modify an existing page setup through the Page Setup Manager (page 753)
- When you modify an existing page setup through the Print dialog box (page 804)

The page setup settings that you specify are stored with the layout and can be applied to other layouts or imported into other drawings.

List of Options

The following options are displayed.
**Page Setup Name**
Displays the name of the current page setup.

**Printer/Plotter**
Specifies a configured output device to use when printing layouts.

Printer Lists the available system printers from which you can select to print the current layout.

Where Displays the physical location of the output device specified in the currently selected page setup.

Description Displays descriptive text about the output device specified in the currently selected page setup.

**Paper Size**
Displays standard paper sizes that are available for the selected plotting device. If the selected plotter does not support the layout's selected paper size, a warning is displayed, and you can select the plotter's default paper size or a custom paper size.

**Orientation**
Specifies the orientation of the drawing on the paper for plotters that support landscape or portrait orientation.

Portrait Orients and plots the drawing so that the short edge of the paper represents the top of the page.

Landscape Orients and plots the drawing so that the long edge of the paper represents the top of the page.

**NOTE** The orientation of plots is also affected by the PLOTROTMODE (page 1438) system variable.

**What to Print**
Specifies the area of the drawing to be plotted.

Display Plots the view in the current viewport in the current layout.

Extents Plots the portion of the current space of the drawing that contains objects. All geometry in the current layout is plotted. The drawing may be regenerated to recalculate the extents before plotting.

Window Plots any portion of the drawing that you specify. When you specify the two corners of the area to plot, the Window button becomes available.
Click the Window button to use the pointing device to specify the two corners of the area to be plotted, or enter coordinate values.

**Model/Layout Views** Plots a view that was previously saved with the -VIEW (page 1139) command.

**Layout/Limits** When plotting a layout, plots everything within the printable area of the specified paper size, with the origin calculated from 0,0 in the layout.

When plotting from the Model layout, plots the entire drawing area that is defined by the grid limits. If the current viewport does not display a plan view, this option has the same effect as the Extents option.

**Scale**
Controls the relative size of drawing units to plotted units.

**NOTE** If the Layout option is specified in What to Print, the layout is plotted at 1:1 regardless of the setting specified in Scale.

**Fit to Paper** Scales the plot to fit within the selected paper size and displays the custom scale factor in the Scale, Inch =, and Units boxes.

**Scale** Defines the exact scale for the output. *Custom* defines a user-defined scale. You can create a custom scale by entering the number of inches (or millimeters) equal to the number of drawing units.

**NOTE** You can modify the list of scales with SCALELISTEDIT (page 930).

**Inch(es) =/mm =** Specifies the number of inches or millimeters equal to the specified number of units.

**Inch/mm** Specifies inches or mm for display of units. The default is based on the paper size and changes each time a new paper size is selected.

**Unit** Specifies the number of units equal to the specified number of inches or millimeters.

**Scale Lineweights** Scales lineweights in proportion to the plot scale. Lineweights normally specify the line width of output objects and are output with the line width size regardless of the scale.

**Offset for Printable Area**
Specifies an offset of the plot area relative to the lower-left corner of the printable area or to the edge of the paper, depending on the value of the PLOTOFFSET (page 1438) system variable.
The printable area of a drawing sheet is defined by the selected output device and is represented by a dashed line in a layout. When you change to another output device, the printable area may change.

You can offset the geometry on the paper by entering a positive or negative value in the X and Y offset boxes. The plotter unit values are in inches or millimeters on the paper.

Center on Page Automatically calculates the X and Y offset values to center the plot on the paper.

X Specifies the plot origin in the X direction relative to the value of PLOTOFFSET.

Y Specifies the plot origin in the Y direction relative to the value of PLOTOFFSET.

More/Fewer Options
Expands or collapses the dialog box to show or hide additional output options.

Plot Style Table
Sets the plot style table to use with the page setup.

Name Displays a list of available plot style tables.

Print with Plot Styles Specifies whether plot styles applied to objects and layers are printed.

Display Plot Styles Controls whether the properties of plot styles assigned to objects are displayed on the screen.

3D Viewports
Specifies how shaded and rendered viewports are plotted and determines their resolution levels and dots per inch (dpi).

Shading Specifies how views are plotted. To specify this setting for a viewport on a layout tab, select the viewport and then, on the Mac OS menu bar click Tools ➤ Palettes ➤ Properties.

From the Model layout, you can select from the following options:

- **As Displayed**: Plots objects the way they are displayed on the screen.
- **Legacy Wireframe**: Plots objects in wireframe regardless of the way they are displayed on the screen.
- **Legacy Hidden**: Plots objects with hidden lines removed regardless of the way they are displayed on the screen.
- **Conceptual**: Plots objects with the Conceptual visual style applied regardless of the way the objects are displayed on the screen.
- **Hidden**: Plots objects with the Hidden visual style applied regardless of the way the objects are displayed on the screen.
- **Realistic**: Plots objects with the Realistic visual style applied regardless of the way the objects are displayed on the screen.
- **Shaded**: Plots objects with Shaded visual style applied regardless of the way the objects are displayed on the screen.
- **Shaded with Edges**: Plots objects with Shaded with Edges visual style applied regardless of the way the objects are displayed on the screen.
- **Shades of Gray**: Plots objects with Shades of Gray visual style applied regardless of the way the objects are displayed on the screen.
- **Sketchy**: Plots objects with Sketchy visual style applied regardless of the way the objects are displayed on the screen.
- **Wireframe**: Plots objects with the Wireframe visual style applied regardless of the way the objects are displayed on the screen.
- **X-ray**: Plots objects with x-ray visual style applied regardless of the way the objects are displayed on the screen.

**Quality** Specifies the resolution at which shaded viewports are plotted. You can select from the following options:

- **Draft**: Sets rendered and shaded model space views to be plotted as wireframe.
- **Preview**: Sets rendered and shaded model space views to be plotted at one quarter of the current device resolution, to a maximum of 150 dpi.
- **Normal**: Sets rendered and shaded model space views to be plotted at one half of the current device resolution, to a maximum of 300 dpi.
- **Presentation**: Sets rendered and shaded model space views to be plotted at the current device resolution, to a maximum of 600 dpi.
- **Maximum**: Sets rendered and shaded model space views to be plotted at the current device resolution with no maximum.
- **Custom**: Sets rendered and shaded model space views to be plotted at the resolution setting that you specify in the DPI box, up to the current device resolution.

**DPI** Specifies the dots per inch for shaded and rendered views, up to the maximum resolution of the current plotting device.

**Plot Stamp**
Controls the placement of a plot stamp on each layout and/or logs it to a file.
Plot stamp settings are specified in the Plot Stamp Settings dialog box (page 812), in which you can specify the information that you want applied to the plot stamp, such as drawing name, date and time, plot scale, and so on.

**Include Plot Stamp** Turns on plot stamping for the layout.

**Plot Stamp Settings** Displays the Plot Stamp Settings dialog box when Include Plot Stamp is selected.

**Print Options**

Specifies options for lineweights, transparency, and the order in which objects are plotted.

**Print Object Lineweights** Specifies whether lineweights assigned to objects and layers are printed.

**Print Transparency** Specifies whether object transparency is printed. This option should only be used when printing drawings with transparent objects.

**Print Paper Space Last** Prints model space geometry first. Paper space geometry is usually printed before model space geometry.

**Hide Paper Space Objects** Specifies whether the `HIDE` (page 507) operation applies to objects in the paper space viewport. This option is available only from a named (paper space) layout. This setting is reflected in the output, but not in the display of the layout.

**Print Upside Down** Orients and prints the drawing upside-down.

**Sharing**

Allows you to import settings from a PC3 file.

**Import Device Settings From** Enables importing of settings from a PC3 file.

**PC3 Files List** Lists the available PC3 files that you can select from to import print settings file.

The program looks in the location specified by the value in Printer Support File Path ➤ Printer Configuration Search Path under Application in the Application Preferences dialog box (page 728).

**See also:**

Specify Page Setup Settings

**Import Page Setups Dialog Box**

Displays the page setups in the selected drawing that are available to import.
List of Options

The following options are displayed.

**Source Drawing**
Displays the source drawing that contains the listed page setups that are available to import.

**Page Setups**
Lists the page setups that are available to import and their location in the source drawing. Selected page setups are imported into the current drawing when you click OK.

When you import page setups into a page setup overrides file for a sheet set, only page setups with Plot Area set to Layout or Extents are listed.

**Name**
Specifies the name of the page setup available to import.

**Location**
Specifies the location (Model or named layout) of the page setup in the drawing from which you are importing the page setup.

**Details**
Displays information about the selected page setup.
Device Name
Displays the name of the plot device specified in the currently selected page setup.

Printer
Displays the type of output device specified in the currently selected page setup.

Page Size
Displays the paper size and orientation specified in the currently selected page setup.

Where
Displays the physical location of the output device specified in the currently selected page setup.

Description
Displays descriptive text about the output device specified in the currently selected page setup.

See also:
Specify Page Setup Settings

PAGESETUPEDIT
Edits the page setup settings for the current layout, Model or named.

Access Methods

 Toolbar: Layout visor ➤ Edit Page Setup
Shortcut menu: Right-click the drawing area when a named layout is current and click Edit Page Setup.

Summary
The Page Setup dialog box (page 757) is displayed.

See also:
Specify Page Setup Settings
PALETTEICONOFF

Restores the display of all palettes collapsed by PALETTEICONON.

Access Methods

- **Menu**: Tools ➤ Palettes ➤ Show Palettes as Icons
- **Menu**: Window ➤ Show Full Palettes
- **Toolbar**: On a palette, in the upper-right corner, click the Collapse as Icons/Show as Palettes button
- **Shortcut menu**: Right-click the palette bar and choose Show as Palettes

See also:

- Specify the Behavior of Palettes

PALETTEICONON

Collapses all open palettes, except command line and status bar, to a small bar displayed along the left or right side of the screen.

Access Methods

- **Menu**: Tools ➤ Palettes ➤ Show Palettes as Icons
- **Menu**: Window ➤ Show Palettes as Icons
- **Toolbar**: On a palette, in the upper-right corner, click the Collapse as Icons/Show as Palettes button
- **Shortcut menu**: Right-click the title bar of a palette and choose Collapse as Icons (Left), Collapse as Icons (Right)

Summary

All open palettes with the exception of the command line and status bar are collapsed to an icon state. While icon state is active, each additional palette opened is added to the palette bar that is displayed along the left or right side of the screen.

Click a button on the bar to display the associated palette. The palette will remain open until you click the button again or click a different button on the palette bar. Use the PALETTEICONOFF (page 766) command to return to palette state.
See also:

Specify the Behavior of Palettes

**PAN**

Moves the view planar to the screen.

**Access Methods**

- **Menu:** View ➤ Pan ➤ Realtime
- **Toolbar:** Status bar ➤ Pan
- **Shortcut menu:** With no objects selected, right-click in the drawing area and click Pan.

**Summary**

You can **pan the drawing display in real time** (page 767).

**List of Prompts**

The following prompts are displayed.
Press Esc or Enter to exit, or right-click to display a shortcut menu (page 768).

If you enter `-pan` at the Command prompt, PAN displays **command prompts** (page 769), and you can specify a displacement to pan the drawing display.

Position the cursor at the start location and press the mouse button down. Drag the cursor to the new location. You can also press the mouse scroll wheel or middle button down and drag the cursor to pan.

See also:

Pan or Zoom a View

**Panning in Real Time**

As a view is being panned, the cursor updates to let you know when you have reached the extents of the drawing.
**Summary**

The cursor changes to a hand cursor. By holding down the pick button on the pointing device, you lock the cursor to its current location relative to the viewport coordinate system. The drawing display is moved in the same direction as the cursor.

When you reach a logical extent (edge of the drawing space), a bar is displayed on the hand cursor on that edge. Depending on whether the logical extent is at the top, bottom, or side of the drawing, the bar is either horizontal (top or bottom) or vertical (left or right side).

When you release the pick button, panning stops. You can release the pick button, move the cursor to another location in the drawing, and then press the pick button again to pan the display from that location.

To stop panning at any time, press Enter or Esc.

**See also:**

Pan or Zoom a View

**Pan Shortcut Menu**

Pan and Zoom shortcut menu allows for switching between navigation tools and cancelling the current navigation tool.

To access the Pan shortcut menu, right-click in the drawing area while PAN is active.

**List of Options**

The following options are displayed.

- **Exit** Cancels PAN or ZOOM.
- **Pan** Switches to PAN.
- **Zoom** Switches to ZOOM in real time.
- **3D Orbit** Switches to 3DORBIT.
**Zoom Window** Zooms to display an area specified by a rectangular window.

**Zoom Original** Restores the original view.

**Zoom Extents** Zooms to display the drawing extents.

**See also:**

- Pan or Zoom a View

---

**-PAN**

Moves the view planar to the screen by specifying a distance and direction the view should be moved in.

**List of Prompts**

The following prompts are displayed.

*Specify base point or displacement:*  *Specify a point*

You can specify a single point, indicating the relative displacement of the drawing with respect to the current location, or (more commonly) you can specify two points, in which case the displacement is computed from the first point to the second point.

If you press Enter, the drawing is moved by the amount you specified in the Specify Base Point or Displacement prompt. For example, if you specify 2,2 at the first prompt and press Enter at the second prompt, the drawing is moved 2 units in the X direction and 2 units in the Y direction. If you specify a point at the Specify Second Point prompt, the location of the first point is moved to the location of the second point.

You cannot use PAN transparently during **VPOINT** (page 1149) or **DVIEW** (page 389), or while another **ZOOM** (page 1188), **PAN**, or **VIEW** (page 1139) command is in progress.
PARAMETERS (-PARAMETERS)

Manages all dimensional constraint parameters, reference parameters, and user variables in the current drawing from the Command prompt.

List of Prompts

The following prompts are displayed.

Enter a parameter option [New (page 770)/Edit (page 770)/Rename (page 770)/Delete (page 770)/? (page 770)]:

NOTE You cannot use the -PARAMETERS command in the Block Editor (page 143).

New Creates a user variable.
Edit Edits the expression of the specified user variable.
Rename Renames the user variable.
Delete Removes the user variable from the list.
? — List Parameters Lists available user variables in the drawing.

See also:
Add Constraints to Geometry

PASTECLIP

Pastes objects from the Clipboard into the current drawing.

Access Methods

Menu: Edit ➤ Paste
Shortcut menu: With no command active, right-click in the drawing area, and click Clipboard ➤ Paste
Command entry: Cmd-V
Summary

If the Clipboard contains ASCII text, the text is inserted as a multiline text (mtext) object using the MTEXT (page 677) defaults. A spreadsheet is inserted as a table object.

When you copy objects to the Clipboard, information is stored in all available formats. When you paste the Clipboard contents into a drawing, the format that retains the most information is used. You can also use Copy and Paste to transfer objects between drawings.

**NOTE** If the cursor is in the drawing area, PASTECLIP behaves as described. If the cursor is at the Command prompt, text from the Clipboard is pasted at the current prompt.

See also:

Cut, Copy, and Paste with the Clipboard

**PDFADJUST**

Adjust the fade, contrast, and monochrome settings of a PDF underlay.

**Access Methods**

 Toolbar: PDF Underlay visor ➤ Fade or Monochrome
 Toolbar: Properties Inspector ➤ Contrast, Fade, or Monochrome

**Summary**

If you select a single PDF underlay, the default values for Fade, Contrast, and Monochrome are the current property settings of the selected underlay. If you select multiple underlays, the default values for Fade, Contrast, and Monochrome remain as they were set the last time the command was used.

**NOTE** Use the Properties Inspector to control if the colors of an underlay are adjusted for the current background color.

**List of Prompts**

The following prompts are displayed.
**Fade** Controls the fade effect of the underlay. Values range from 0 through 100, default value is 0. The greater the value, the lighter the linework in the underlay appears. Works indirectly with the contrast effect; a higher contrast value blends the underlay in the background when fade is set to a higher value.

**Contrast** Controls the contrast, and indirectly the fading effect, of the underlay. Values range from 0 through 100, default value is 100. The greater the value, the more each pixel is forced to its primary or secondary color.

**Monochrome** Controls the color saturation of all linework while maintaining the luminance. When turned on, the linework appears in varying shades of gray starting at black if the background color luminance is 50 percent or more. If the background color luminance is less than 50 percent, then the colors are inverted, with the darkest linework displaying in white, and the lightest linework displaying in black.

**See also:**

Adjust PDF Underlay Contrast, Fade, Monochrome, and Colors for the Background

---

**PDFATTACH**

Attach a PDF file as an underlay into the current drawing.

**Access Methods**

- **Menu:** Insert ➤ PDF Underlay
- **Toolbar:** Reference Manager palette ➤ Attach Reference

**Summary**

When you attach a PDF file as an underlay, you link that referenced file to the current drawing. Any changes to the referenced file are displayed in the current drawing when it is opened or reloaded.

The Select Reference File dialog box (a standard file selection dialog box (page 723)) is displayed. After the PDF file is attached, you can adjust and clip the underlay from the PDF Underlay visor (page 775).

**See also:**

Attach PDF Files as Underlays
**Attach PDF Underlay Dialog Box**

Names, locates, and defines the insertion point, scale, and rotation of attached PDF underlays.

![Attach PDF Underlay Dialogue Box](image)

**List of Options**

The following options are displayed.

**Name**
Identifies the PDF file you have selected to attach.

**Browse**
Opens the Select Reference File dialog (a standard file selection dialog box (page 723)).

**Details**
- **Saved Path** Displays the path that is saved with the drawing when the PDF file is attached. The path is dependent upon the Path Type setting.
- **Found In** Displays the path to the PDF file.
Select page(s)
Displays all of the pages that are found in the PDF file. If the PDF file only contains a single page, that page is listed. You can select multiple pages by holding Shift or Cmd and selecting the pages to attach.

Show\Hide Attachment Options
Expands or collapses the Attachment Options section to allow you to specify the insertion point, rotation and scale for the PDF underlay being attached.

Insertion Point
Specifies the insertion point for the selected PDF file.

Specify On-Screen Directs input at the Command prompt or the pointing device.
X Sets the X coordinate value.
Y Sets the Y coordinate value.
Z Sets the Z coordinate value.

Rotation
Specifies the rotation angle of the selected PDF underlay.

Specify on-screen If Specify On-Screen is selected, you may wait until you exit the dialog box to rotate the object with your pointing device or enter a rotation angle value at the Command prompt.
Angle If Specify On-Screen is cleared, enter the rotation angle value in the dialog box. The default rotation angle is 0.

Path Type
Select the full (absolute) path, the relative path to the PDF file, or No Path, and the name of the PDF file. For the No Path option, the PDF file must be located in the same folder as the current drawing file.

Scale
Specifies the scale factor of the selected PDF underlay.

If INSUNITS (page 1373) is set to “unitless” or if the underlay does not contain resolution information, the scale factor becomes the underlay width in AutoCAD units. If INSUNITS has a value such as millimeters, centimeters, inches, or feet, and the underlay has resolution information, the scale factor is applied after the true width of the underlay in AutoCAD units is determined.

Specify On-screen Inputs information at the Command prompt or with the pointing device. If Specify On-Screen is cleared, enter a value for the scale factor.

Scale Factor Field Enter a value for the scale factor.
See also:
Attach PDF Files as Underlays

PDF Underlay Visor

Displays options for modifying PDF underlays.

Summary

The PDF Underlay visor is displayed when you select a PDF underlay.

List of Options

The following options are displayed.

**Scale** Enlarges or reduces the size of the PDF underlay. (*SCALE* (page 928) command)

**Fade** Controls the appearance of the linework. The greater the value, the lighter the linework in the PDF underlay is displayed. (*PDFADJUST* (page 771) command)

**Visibility** Controls the visibility of the graphics and text within the PDF underlay.

**Monochrome** Controls the color saturation of all linework while maintaining the luminance. (*PDFADJUST* (page 771) command)

**Enable Object Snap** Controls whether object snapping is active for geometry in all attached PDF underlays that contain vector graphics. (*PDFOSNAP* (page 1428) system variable)

**Create the Clipping Boundary** Crops the display of the selected PDF underlay to a specified boundary. (*PDFCLIP* (page 777) command)

**Delete the Clipping Boundary** Removes the clipping boundary from the selected PDF underlay. (*PDFCLIP* (page 777) command)

**Underlay Layers** Controls the display of layers in a PDF underlay. (*ULAYERS* (page 1122) command)
**External Reference Manager** Opens or closes the Reference Manager palette. **(EXTERNALREFERENCES (page 418) command)**

**See also:**
Attach PDF Files as Underlays

---

**-PDFATTACH**

Attach a PDF underlay from the command line.

**Summary**

When you attach a PDF file as an underlay, you link that referenced file to the current drawing. Any changes to the referenced file are displayed in the current drawing when it is opened or reloaded.

**List of Prompts**

The following prompts are displayed.

**Path to PDF File to Attach** Enters the full path name to the PDF underlay file.

Entering a tilde (~) displays the Select PDF File dialog box (a standard file selection dialog box (page 723)).

To avoid errors when entering a file name, it is recommended that you specify both the PDF file and path as follows:

*path name/filename.pdf*

or

"*path name/filename.pdf"*

If you enter a valid PDF file name without a file extension, the program adds the extension and searches for the file.

**Enter Page Number or [?]** Enter a page number. For a list of pages, enter ?.

**Enter Page(s) to List** Lists the pages available in the selected PDF file.

**Insertion Point** Specifies the insertion point for the selected PDF file.

**Scale Factor or [Unit]** Specifies the scale factor of the selected PDF underlay and the scale factor units.

If INSUNITS (page 1373) is set to “unitless” or if the underlay does not contain resolution information, the scale factor becomes the underlay width in
AutoCAD units. If INSUNITS has a value such as millimeters, centimeters, inches, or feet, and the underlay has resolution information, the scale factor is applied after the true width of the underlay in AutoCAD units is determined.

**Rotation** Specifies the rotation angle of the selected PDF underlay.

**See also:**
- Attach PDF Files as Underlays

## PDFCLIP

Crops the display of a selected PDF underlay to a specified boundary.

### Access Methods

**Command entry:** PDF Underlay visor ➤ Create the Clipping Boundary

**Shortcut menu:** Select a PDF underlay. Right-click in the drawing area and click Clip PDF.

### Summary

The clipping boundary determines the portion of an image outside the boundary that is hidden. The visibility of the clipping boundary is controlled by the PDFFRAME and FRAME system variables.

The boundary you specify must be in a plane parallel to the PDF underlay.

**TIP** Use the CLIP (page 201) command to clip any type of referenced file: images, external references, viewports, and PDF underlays.

### List of Prompts

The following prompts are displayed.

**On**

Turns on clipping and displays the PDF underlay clipped to the previously defined boundary.

**Off**

Turns off clipping and displays the entire PDF underlay and frame.

If you re-clip the PDF underlay while clipping is turned off, clipping is automatically turned back on. You are prompted to delete the old boundary even when clipping is turned off and the clipping boundary is not visible.
Delete
Removes a predefined clipping boundary and displays the full original underlay.

New Boundary
Defines a rectangular or polygonal clipping boundary, or generates a polygonal clipping boundary from a polyline.

Select Polyline Defines the boundary with the selected polyline. The polyline can be open but must consist of straight line segments and cannot intersect itself.

Polygonal Defines a polygonal clipping boundary with three or more points that you specify for the vertices of a polygon.

Rectangular Defines a rectangular boundary with the points that you specify for opposite corners.

Invert Clip Inverts the mode of the clipping boundary: objects are clipped either outside the boundary or inside the boundary.

**NOTE** You can only create a new clipping boundary for a selected PDF underlay when the old boundary is deleted.

**See also:**
- Clip PDF Underlays

**PDFLAYERS**

Controls the display of layers in a PDF underlay.

**Access Methods**

<table>
<thead>
<tr>
<th>Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbar: PDF Underlay visor ➤ Underlay Layers</td>
</tr>
</tbody>
</table>

**Shortcut menu:** Select an underlay. Right-click in the drawing area and choose View PDF Layers.

**Summary**

The Underlay Layers dialog box (page 1123) is displayed.
The ULAYERS (page 1122) command manages the layers of all underlays in the current document.

See also:

Control the Display of Layers in a PDF Underlay

**PEDIT**

Edits polylines and 3D polygon meshes.

**Access Methods**

Menu: Modify ➤ Object ➤ Polyline

Shortcut menu: Select a polyline to edit. Right-click in the drawing area and click Polyline Edit.

**Summary**

Common uses for PEDIT include joining 2D polylines, converting lines and arcs into 2D polylines, and converting polylines into curves that approximate B-splines (spline-fit polylines).

**List of Prompts**

The following prompts are displayed.

Select polyline or [MULTIPLE (page 702)]: Use an object selection method or enter m

The remaining prompts depend on whether you have selected a 2D polyline (page 780), a 3D polyline (page 788), or 3D polygon mesh (page 790).

If the selected object is a line, arc, or a spline, the following prompt is displayed:

Object selected is not a polyline.
Do you want it to turn into one? <Y>: Enter y or n, or press Enter

If you enter y, the object is converted into a single-segment 2D polyline that you can edit. You can use this operation to join lines and arcs into a polyline.

Before the selected spline is converted to a polyline, the following prompt is displayed:

Specify a precision <10>: Enter a new precision value or press Enter
The precision value determines how accurately the resulting polyline is to fit to the source spline. Valid value is an integer between 0 and 99.

**NOTE**  A high precision value may cause performance problems.

The PLINECONVERTMODE (page 1436) system variable determines whether the polylines are created with linear or arc segments. When the PEDITACCEPT (page 1429) system variable is set to 1, this prompt is suppressed, and the selected object is automatically converted to a polyline.

**See also:**
Modify Polylines

**Multiple Selection (PEDIT)**

Enables selection for more than one object.

If the selection set includes lines, arcs, or splines, the following prompt is displayed:

**List of Prompts**

The following prompts are displayed.

Convert Lines, Arcs and Splines to polylines [Yes/No]? <Y>:

*Enter y or n or press Enter*

Specify a precision for spline conversion <10>: *Enter a new precision value or press Enter*

The entered precision value affects all splines in the selection set. The precision value is an integer between 0 and 99.

**2D Polyline Selection (PEDIT)**

If you select a 2D polyline, the following prompt is displayed:

**List of Prompts**

The following prompts are displayed.
Enter an option [Close/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/Reverse/Undo]: Enter an option or press Enter to end the command

**NOTE** You can select a single arc or line segment, also called a subobject, within a polyline by pressing the Ctrl key when you click over it.

If the polyline you select is a closed polyline, Open replaces the Close option in the prompt. You can edit a 2D polyline if its normal is parallel to and in the same direction as the $Z$ axis of the current UCS.

**Close**
Creates the closing segment of the polyline, connecting the last segment with the first. The polyline is considered open unless you close it using the Close option.

![before Close](image1.png) ![after Close](image2.png)

**Open**
Removes the closing segment of the polyline. The polyline is considered closed unless you open it using the Open option.

**Join**
Adds lines, arcs, or polylines to the end of an open polyline and removes the curve fitting from a curve-fit polyline. For objects to join the polyline, their endpoints must touch unless you use the Multiple option at the first PEDIT prompt. In this case, you can join polylines that do not touch if the fuzz distance is set to a value large enough to include the endpoints.

**Jointype**
Sets the method of joining selected polylines.

- **Extend** Joins the selected polylines by extending or trimming the segments to the nearest endpoints.
- **Add** Joins the selected polylines by adding a straight segment between the nearest endpoints.
- **Both** Joins the selected polylines by extending or trimming if possible. Otherwise joins the selected polylines by adding a straight segment between the nearest endpoints.
Width
Specifies a new uniform width for the entire polyline.

You can use the Width option of the Edit Vertex option to change the starting and ending widths of a segment.

Edit Vertex
Marks the first vertex of the polyline by drawing an X on the screen. If you have specified a tangent direction for this vertex, an arrow is also drawn in that direction.

Next
Moves the X marker to the next vertex. The marker does not wrap around from the end to the start of the polyline even if the polyline is closed.

Previous
Moves the X marker to the previous vertex. The marker does not wrap around from the start to the end of the polyline even if the polyline is closed.

Break
Saves the location of the marked vertex while you move the X marker to any other vertex.

If one of the specified vertices is at an end of the polyline, the result is one truncated polyline. If both specified vertices are at endpoints of the polyline, or if just one vertex is specified and it is at an endpoint, you cannot use Break.
Go Deletes any segments and vertices between the two vertices you specify and returns to Edit Vertex mode.

Exit Exits Break and returns to Edit Vertex mode.

**Insert**
Adds a new vertex to the polyline after the marked vertex.

**Move**
Moves the marked vertex.

**Regen**
Regenerates the polyline.

**Straighten**
Saves the location of the marked vertex while you move the X marker to any other vertex.
If you want to remove an arc segment that connects two straight segments of a polyline and then extend the straight segments until they intersect, use the FILLET (page 436) command with a fillet radius of 0.

Next Moves the X marker to the next vertex.

Previous Moves the X marker to the previous vertex.

Go Deletes any segments and vertices between the two vertices you select, replaces them with single straight line segments, and returns to Edit Vertex mode. If you specify only one vertex by entering go without moving the X marker, the segment following that vertex is straightened if it is an arc.

Exit Exits Straighten and returns to Edit Vertex mode.

Tangent

Attaches a tangent direction to the marked vertex for use later in curve fitting.

Width
Changes the starting and ending widths for the segment that immediately follows the marked vertex.

You must regenerate the polyline to display the new width.

Exit
Exits Edit Vertex mode.

Fit
Creates an arc-fit polyline, a smooth curve consisting of arcs joining each pair of vertices. The curve passes through all vertices of the polyline and uses any tangent direction you specify.
Spline
Uses the vertices of the selected polyline as the control points, or frame, of a curve approximating a B-spline. This curve, called a spline-fit polyline, passes through the first and last control points unless the original polyline was closed. The curve is pulled toward the other points but does not necessarily pass through them. The more control points you specify in a particular part of the frame, the more pull they exert on the curve. Quadratic and cubic spline-fit polylines can be generated.

Spline-fit polylines are very different from the curves produced by the Fit option. Fit constructs pairs of arcs that pass through every control point. Both of these curves are different from true B-splines produced with the SPLINE (page 1022) command.

If the original polyline included arc segments, they are straightened when the spline’s frame is formed. If the frame has width, the resulting spline tapers smoothly from the width of the first vertex to the width of the last vertex. All intermediate width information is ignored. Once spline-fit, the frame, if displayed, is shown with zero width and CONTINUOUS linetype. Tangent specifications on control point vertices have no effect on spline-fitting.

When a spline-fit curve is fit to a polyline, the spline-fit curve's frame is stored so that it can be recalled by a subsequent decurving. You can turn a spline-fit curve back into its frame polyline by using the PEDIT Decurve option. This option works on fit curves in the same manner as it does on splines.

Most editing commands act the same when applied to spline-fit polylines or fit curves.

- MOVE (page 674), ERASE (page 410), COPY (page 235), MIRROR (page 650), ROTATE (page 919), and SCALE (page 928) operate on both the spline curve and its frame, whether the frame is visible or not.
- EXTEND (page 414) changes the frame by adding a new vertex where the initial or final line of the frame intersects the boundary geometry.
- **BREAK** (page 159) and **TRIM** (page 1101) generate a polyline with only the fit spline, which is consistent with fit curves, where the curve fitting is permanent.
- **EXPLODE** (page 411) deletes the frame and generates lines and arcs to approximate the spline-fit polyline.
- **OFFSET** (page 718) generates a polyline with only the fit spline, which is consistent with its behavior with fit curves.
- **DIVIDE** (page 361), **MEASURE** (page 614), and the Object option of **AREA** (page 78) and **HATCH** (page 473) see only the fit spline, not the frame.
- **STRETCH** (page 1038) refits the spline to the stretched frame after a spline is stretched.

The Join option of **PEDIT** decurves the spline and discards the spline information of the original and any added polylines. Once the Join operation is complete, you can fit a new spline to the resulting polyline.

The Edit Vertex options of **PEDIT** have the following effect:

- The Next and Previous options move the X marker only to points on the frame of the spline, whether visible or not.
- The Break option discards the spline.
- The Insert, Move, Straighten, and Width options automatically refit the spline.
- The Tangent option has no effect on splines.

Object snap uses only the spline-fit curve itself, not the frame. If you want to snap to the frame control points, use **PEDIT** to recall the polyline frame first.

The **SPLINETYPE** (page 1489) system variable controls the type of spline curve approximated. Setting SPLINETYPE to 5 approximates a quadratic B-spline. Setting SPLINETYPE to 6 approximates a cubic B-spline.

You can examine or change the fineness or coarseness of the spline approximation with the **SPLINESEGS** (page 1488) system variable, or you can use AutoLISP®. The default value is 8. If you set the value higher, a greater number of line segments are drawn and the approximation to the ideal spline
becomes more precise. The generated spline occupies more space in the drawing file and takes longer to generate.

If you set SPLINESEGS to a negative value, the program generates segments using the absolute value of the setting and then applies a fit-type curve to those segments. Fit-type curves use arcs as the approximating segments. Using arcs yields a smoother generated curve when few segments are specified, but the curve can take longer to generate.

If you set SPLINESEGS to a negative value, the program generates segments using the absolute value of the setting and then applies a fit-type curve to those segments. Fit-type curves use arcs as the approximating segments. Using arcs yields a smoother generated curve when few segments are specified, but the curve can take longer to generate.

To change the number of segments used to fit an existing spline, change SPLINESEGS and respline the curve. You do not have to decurve it first.

**Decurve**
Removes extra vertices inserted by a fit or spline curve and straightens all segments of the polyline. Retains tangent information assigned to the polyline vertices for use in subsequent fit curve requests. If you edit a spline-fit polyline with a command such as BREAK (page 159) or TRIM (page 1101), you cannot use the Decurve option.

**Ltype Gen**
Generates the linetype in a continuous pattern through the vertices of the polyline. When turned off, this option generates the linetype starting and ending with a dash at each vertex. Ltype Gen does not apply to polylines with tapered segments.

**Reverse**
Reverses the order of vertices of the polyline. Use this option to reverse the direction of objects that use linetypes with included text. For example, depending on the direction in which a polyline was created, the text in the linetype might be displayed upside down.

**Undo**
Reverses operations as far back as the beginning of the PEDIT session.
3D Polyline Selection (PEDIT)

If you select a 3D polyline, the following prompt is displayed:

**List of Prompts**

The following prompts are displayed.

```
Enter an option [Close/Join/Edit vertex/Spline curve/Decurve/Reverse/Undo]: Enter an option or press Enter
```

If the polyline you select is closed, Open replaces the Close option in the prompt.

**Close**

Creates the closing segment of the polyline, connecting the last segment with the first. The polyline is considered open unless you close it with Close.

**Open**

Removes the closing segment of the polyline. The polyline is considered closed unless you open it with Open.

**Join**

Joins an open curve to the 3D polyline. The curve can be on a different plane, but must be contiguous with the 3D polyline.

**Edit Vertex**

Performs various editing tasks on one vertex of the polyline and segments that follow it.

**Next**

Moves the X marker to the next vertex. The marker does not wrap around from the end to the start of the polyline, even if the polyline is closed.

**Previous**

Moves the X marker to the previous vertex. The marker does not wrap around from the start to the end of the polyline, even if the polyline is closed.

**Break**

Saves the location of the marked vertex while you move the X marker to any other vertex.

- **Next** (page 788)
- **Previous** (page 782)

**Go**

Deletes any segments and vertices between the two vertices you specify and returns to Edit Vertex mode.
**Exit** Exits Break and returns to Edit Vertex mode.

If one of the specified vertices is at an end of the polyline, the polyline is truncated. If both specified vertices are at endpoints of the polyline, or if just one vertex is specified and it is at an endpoint, you cannot use Break mode.

**Insert**
Adds a new vertex to the polyline after the marked vertex.

**Move**
Moves the marked vertex.

**Regen**
Regenerates the polyline.

**Straighten**
Saves the location of the marked vertex while you move the X marker to any other vertex.

**Next** Moves the X marker to the next vertex.

**Previous** Moves the X marker to the previous vertex.

**Go** Deletes any segments and vertices between the two vertices you select, replaces them with single straight line segments, and returns to Edit Vertex mode. If you specify only one vertex by entering `go` without moving the X marker, the segment following that vertex is made straight if it is an arc.

**Exit** Exits Straighten and returns to Edit Vertex mode.

To remove an arc segment that connects two straight segments of a polyline and then to extend the straight segments until they intersect, use the [FILLET](page 436) command with a fillet radius of 0.

**Exit**
Exits Edit Vertex mode.

**Spline Curve**
Fits a 3D B-spline curve to its control points. The SPLFRAME (page 1488) system variable controls the accuracy and display of the control points for the 3D B-spline, whose curves can be approximated only by line segments. Negative values for spline segments are ignored.
Decurve
Removes extra vertices inserted by a fit or spline curve and straightens all segments of the polyline. Retains tangent information assigned to the polyline vertices for use in subsequent fit curve requests. If you edit a spline-fit polyline with a command such as `BREAK` (page 159) or `TRIM` (page 1101), you cannot use the Decurve option.

Reverse
Reverses the order of vertices of the polyline. Use this option to reverse the direction of objects that use linetypes with included text. For example, depending on the direction in which a polyline was created, the text in the linetype might be displayed upside down.

Undo
Reverses operations as far back as the beginning of the PEDIT session.

### 3D Polygon Mesh Selection (PEDIT)

If you select a polygon mesh, the following prompt is displayed:

**List of Prompts**

The following prompts are displayed.

```plaintext
Enter an option [Edit vertex/Smooth surface/Desmooth/Mclose/Nclose/Undo]: Enter an option or press Enter to end the command
```

Mclose and Nclose are replaced by Mopen and Nopen if the polygon mesh is currently closed in the $M$ or $N$ direction.

**Edit Vertex**

Edits individual vertices of a polygon mesh that can be seen as a rectangular $M$ by $N$ array, where $M$ and $N$ are the dimensions specified in `3DMESH` (page 35). The `SURFTAB1` (page 1500) and `SURFTAB2` (page 1500) system variables store
M and N values for RULESURF (page 924), TABSURF (page 1073), REVSURF (page 917), and EDGESURF (page 403).

Pressing Enter accepts the current default, which is either Next or Previous.

**Next** Moves the X marker to the next vertex. The marker does not wrap around from the end to the start of the mesh, even if the mesh is closed.

**Previous** Moves the X marker to the previous vertex. The marker does not wrap around from the start to the end of the mesh, even if the mesh is closed.

**Left** Moves the X marker to the previous vertex in the N direction. The marker does not wrap around from the start to the end of the mesh, even if the mesh is closed.

**Right** Moves the X marker to the next vertex in the N direction. The marker does not wrap around from the end to the start of the mesh, even if the mesh is closed.

**Up** Moves the X marker to the next vertex in the M direction. The marker does not wrap around from the end to the start of the mesh, even if the mesh is closed.

**Down** Moves the X marker to the previous vertex in the M direction. The marker does not wrap around from the start to the end of the mesh, even if the mesh is closed.

**Move** Repositions the vertex and moves the editing mark.

**Regen** Regenerates the polygon mesh.

**Exit** Exits Edit Vertex mode.

**Smooth Surface**
Fits a smooth surface. The SURFTYPE (page 1501) system variable controls the type of surface this option fits. The types of surfaces include quadratic B-spline, cubic B-spline, and Bezier.
**Desmooth**  
Restores the original control-point polygon mesh.

**Mclose**  
Closes the $M$-direction polylines if the polygon mesh is open in the $M$ direction.

**Mopen**  
Opens the $M$-direction polylines if the polygon mesh is closed in the $M$ direction.

**Nclose**  
Closes the $N$-direction polylines if the polygon mesh is open in the $N$ direction.

**Nopen**  
Opens the $N$-direction polylines if the polygon mesh is closed in the $N$ direction.

**Undo**  
Reverses operations as far back as the beginning of the PEDIT session.

**PFACE**  
Creates a 3D polyface mesh vertex by vertex.
List of Prompts

The following prompts are displayed.

Specify location for vertex (page 793) 1: Specify a point
Specify location for vertex 2 or <define faces (page 793)>:
Specify a point or press Enter
Specify location for vertex n or <define faces>: Specify a point or press Enter

Vertex Location

You specify all vertices used in the mesh. The vertex numbers displayed in the prompts are the numbers used to reference each vertex. The prompt is repeated until you press Enter. If you press Enter on a blank line, you are prompted for the vertices to be assigned to each face.

Define Faces

Vertex Number You define each face by entering vertex numbers for all the vertices of that face. The mesh is drawn after you have defined the last face and pressed Enter after the prompt.

To make an edge invisible, you can enter a negative vertex number for the beginning vertex of the edge.

You can create polygons with any number of edges. PFACE automatically breaks them into multiple face objects with the appropriate invisible edges. Faces with one or two vertices behave like point or line objects without the special properties of Point Display modes or linetypes. You can use them to embed wireframe images within a mesh. Use Endpoint object snap to snap to a face composed of one or two vertices. All object snap modes that apply to line objects work with visible edges of polyface meshes. You cannot use PEDIT (page 779) to edit polyface meshes.

Color Faces created with PFACE adopt the current layer and color. Unlike polyline vertices, polyface mesh faces can be created with layer and color properties different from their parent object.

You can enter a color from the AutoCAD Color Index (a color name or number), a true color, or a color from a color book.

Layer Faces created with PFACE adopt the current layer and color. Unlike polyline vertices, polyface mesh faces can be created with layer and color properties different from their parent object. Layer visibility behaves normally on faces of a polyface mesh. However, if you create a polyface mesh on a frozen layer, the program does not generate any of its faces, including those on non-frozen layers.
**PLAN**

Displays an orthographic view of the XY plane of a specified user coordinate system.

**Access Methods**

☐ **Menu: View ➤ 3D Views ➤ Plan View ➤ World UCS**

**List of Options**

The following options are displayed.

**Current UCS** Regenerates a plan view of the display so that the drawing extents fit in the current viewport of the current UCS.

**UCS** Changes to a plan view of a previously saved UCS and regenerates the display.

Enter name of UCS or [?]: *Enter a name or enter ? to list all UCSs in the drawing*

If you enter ? at the prompt, the following prompt is displayed:

Enter UCS name(s) to list <*>: *Enter a name or enter * to list all UCSs in the drawing*
UCS

World Regenerates a plan view of the display so that the drawing extents fit on the screen of the world coordinate system.

See also:
Change to a View of the XY Plane

PLANESURF

Creates a planar surface.

Access Methods

Button

 Toolbar: Modeling tool set ➤ Surfaces - Create tool group ➤ Planar Surface

Menu: Draw ➤ 3D Modeling ➤ Surfaces ➤ Planar

Summary

You can create a planar surface by selecting closed objects or by specifying the opposite corners of a rectangular surface. Supports pick-first selection and generates a planar surface out of a closed profile. When you specify the corners
of the surface through the command, the surface is created parallel to the work plane.

The SURFU (page 1501) and SURFV (page 1502) system variables control the number of lines displayed on the surface.

**List of Prompts**

The following prompts are displayed.

Specify first corner or [Object]: Specify the first point for the planar surface
Specify other corner: Specify second point (other corner) for the planar surface

**Object**

Creates a planar or trimmed surface by object selection. You can select one closed object or multiple objects that form a closed area.

Similar to the REGION (page 891) command, valid objects include: line, circle, arc, ellipse, elliptical arc, 2D polyline, planar 3D polyline, and planar spline.

The DELOBJ (page 1251) system variable controls whether the object(s) you select are automatically deleted when the surface is created or whether you are prompted to delete the object(s).

See also:

Overview of Creating Surfaces
Convert Objects to Procedural Surfaces

**PLINE**

Creates a 2D polyline, a single object that is composed of line and arc segments.
Access Methods

Button

 Toolbar: Drafting tool set ➤ Open Shapes tool group ➤ Polyline

 Menu: Draw ➤ Polyline

Summary

A 2D polyline is a connected sequence of segments created as a single planar object. You can create straight line segments, arc segments, or a combination of the two.

NOTE A temporary plus-shaped marker displays at the first point. This marker can be useful when you create long and complicated polylines. It is removed when you complete the polyline.

The PLINEGEN (page 1436) system variable controls the linetype pattern display around and the smoothness of the vertices of a 2D polyline. Setting PLINEGEN to 1 generates new polylines in a continuous pattern around the vertices of the completed polyline. Setting PLINEGEN to 0 starts and ends the polyline with a dash at each vertex. PLINEGEN does not apply to polylines with tapered segments.
List of Prompts

The following prompts are displayed.
Specify start point: Specify a point
Current line-width is <current>
Specify next point (page 798) or [Arc (page 798)/Close (page 801)/Halfwidth (page 802)/Length (page 802)/Undo (page 802)/Width (page 802)]: Specify a point or enter an option

Next Point
Draws a line segment. The previous prompt is repeated.

Arc
Adds arc segments to the polyline.
Specify endpoint of arc or
[Angle/CEnter/CLOSE/Direction/Halfwidth/Line/Radius/Second pt/Undo/Width]: Specify a point (2) or enter an option

NOTE For the Center option of the PLINE command, enter ce; for the Center object snap, enter cen or center.

Endpoint of Arc
Draws an arc segment. The arc segment is tangent to the previous segment of the polyline. The previous prompt is repeated.

Angle
Specifies the included angle of the arc segment from the start point.
Specify included angle:

Entering a positive number creates counterclockwise arc segments. Entering a negative number creates clockwise arc segments.
Specify endpoint of arc or [Center/Radius]: Specify a point or enter an option

**Endpoint of Arc** Specifies the endpoint and draws the arc segment.

**Center** Specifies the center of the arc segment.
Specify center point of arc:

**Radius** Specifies the radius of the arc segment.
Specify radius of arc: Specify a distance
Specify direction of chord for arc <current>: Specify a point or press Enter

**Center**
Specifies the center of the arc segment.
Specify center point of arc: Specify a point (2)

Specify endpoint of arc or [Angle/Length]: Specify a point (3) or enter an option

![Diagram of an arc segment](image)

**Endpoint of Arc** Specifies the endpoint and draws the arc segment.

**Angle** Specifies the included angle of the arc segment from the start point.
Specify included angle:

**Length** Specifies the chord length of the arc segment. If the previous segment is an arc, the new arc segment is drawn tangent to the previous arc segment.
Specify length of chord:

**Close**
Draws an arc segment from the last point specified to the starting point, creating a closed polyline. At least two points must be specified to use this option.

![Diagram of closed polyline](image)

**Direction**
Specifies a starting direction for the arc segment.
Specify the tangent direction from the start point of arc: Specify a point (2)
Specify endpoint of arc: Specify a point (3)
**Halfwidth**
Specifies the width from the center of a wide polyline segment to one of its edges.

Specify starting half-width `<current>`: Enter a value or press Enter

Specify ending half-width `<starting width>`: Enter a value or press Enter

The starting half-width becomes the default ending half-width. The ending half-width becomes the uniform half-width for all subsequent segments until you change the half-width again. The starting and ending points of wide line segments are at the center of the line.

```
  half-width
```

Typically, the intersections of adjacent wide polyline segments are beveled. No beveling is performed for nontangent arc segments or very acute angles or when a dot-dash linetype is used.

**Line**
Exits the Arc option and returns to the initial PLINE command prompts.

**Radius**
Specifies the radius of the arc segment.

Specify radius of arc: Specify a distance

Specify endpoint of arc or [Angle]: Specify a point or enter a

```
  radius
```

**Endpoint of Arc** Specifies the endpoint and draws the arc segment.

**Angle** Specifies the included angle for the arc segment.

Specify included angle:
Specify direction of chord for arc <current>: Specify an angle or press Enter

**Second Pt**
Specifies the second point and endpoint of a three-point arc.

Specify second point on arc: Specify a point (2)
Specify end point of arc: Specify a point (3)

**Undo**
Removes the most recent arc segment added to the polyline.

**Width**
Specifies the width of the next arc segment.

Specify starting width <current>: Enter a value or press Enter
Specify ending width <starting width>: Enter a value or press Enter

The starting width becomes the default ending width. The ending width becomes the uniform width for all subsequent segments until you change the width again. The starting and ending points of wide line segments are at the center of the line.

Typically, the intersections of adjacent wide polyline segments are beveled. No beveling is performed for nontangent arc segments, very acute angles, or when a dot-dash linetype is used.

**Close**
Draws a line segment from the last point specified to the starting point, creating a closed polyline. At least two points must be specified to use this option.
**Halfwidth**
Specifies the width from the center of a wide polyline line segment to one of its edges.

Specify starting half-width `<current>`: Enter a value or press Enter

Specify ending half-width `<current>`: Enter a value or press Enter

The starting half-width becomes the default ending half-width. The ending half-width becomes the uniform half-width for all subsequent segments until you change the half-width again. The starting and ending points of wide line segments are at the center of the line.

Typically, the intersections of adjacent wide polyline segments are beveled. No beveling is performed for nontangent arc segments or very acute angles or when a dot-dash linetype is used.

**Length**
Draws a line segment of a specified length at the same angle as the previous segment. If the previous segment is an arc, the new line segment is drawn tangent to that arc segment.

Specify length of line: Specify a distance

**Undo**
Removes the most recent line segment added to the polyline.

**Width**
Specifies the width of the next line segment.

Specify starting width `<current>`: Enter a value or press Enter

Specify ending width `<starting width>`: Enter a value or press Enter
The starting width becomes the default ending width. The ending width becomes the uniform width for all subsequent segments until you change the width again. The starting and ending points of wide line segments are at the center of the line.

Typically, the intersections of adjacent wide polyline segments are beveled. No beveling is performed for nontangent arc segments or very acute angles or when a dot-dash linetype is used.

See also:
Draw Polylines

**PLOT**

Outputs a drawing to a printer or file.

**Access Methods**

- **Menu**: File ➤ Print
- **Toolbar**: Layout visor ➤ Print Layout
- **Toolbar**: Status bar ➤ Quick View. In the Quick View window, right-click a layout and click Print.
- **Shortcut menu**: Right-click the drawing area when a named layout is current and click Print Layout

**Summary**

The **Print dialog box** (page 804) is displayed. Click OK to begin printing with the current settings.

If you enter `-plot` at the Command prompt, **options are displayed** (page 807).

See also:
Overview of Plotting
Print Dialog Box

Specifies device and media settings, and plots your drawing.

Summary

You can display more options by clicking the Show Advanced Settings button to the right of the Printer drop-down list.

Printing allows you to output a single layout at a time. If you want to print more than one layout at a time, use the PUBLISH command.

List of Options

The following options are displayed.
**Printer**  
Specifies an output device to use when printing layouts.

If the selected output device does not support the layout’s selected paper size, a warning is displayed and you can select the device’s default paper size or a custom paper size.

Click the disclosure triangle to the right of the Printer drop-down list to expand the Print dialog box. When the dialog box is expanded, additional settings are available that allow you to control the printing of the layout.

**Presets**  
Specifies the named print preset to use for printing the current layout.

Print presets store the following information:

- Number of Copies
- Collated
- Two-sided
- Paper size
- Orientation

**Copies**  
Specifies the number of copies to print. This option is not available when you print to an electronic file, such as a PDF file.

**Collated**  
Controls if multi-page prints should be collated.

**Two-sided**  
Controls if multi-page prints should be printed on both sides of a page.

**List of Options - Single Layout**  
The following options are available when printing a layout.

**Paper Size**  
Displays standard paper sizes that are available for the selected output device. If no output device is selected, the full standard paper size list is displayed and available for selection.

**Orientation**  
Specifies the orientation of the drawing on the paper for plotters that support landscape or portrait orientation. The paper icon represents the media orientation of the selected paper. The letter icon represents the orientation of the drawing on the page.
NOTE Drawing orientation is also affected by the PLOTROTMODE (page 1438) system variable.

Print Options
Specifies which advanced print settings should be used for printing. Select AutoCAD to use the page setup assigned to the layout. See the Mac OS Help documentation for information on the other options.

Page Setup
Lists the named page setup assigned to the layout and allows you to edit the page setup settings for the layout.

Name Displays the name of the assigned page setup.

Edit Page Setup Displays the Page Setup dialog box (page 757) in which you can edit the page setup settings for the layout.

What to Print
Specifies the area of the drawing to be plotted.

Display Outputs the view in the current viewport in the current layout.

Extents Outputs the portion of the current space of the drawing that contains objects. All geometry in the current layout is outputted. The drawing may be regenerated to recalculate the extents before outputting.

Model/Layout Views Outputs a view that was previously saved with the -VIEW (page 1139) command.

Window Outputs any portion of the drawing that you specify. When you specify the two corners of the area to output, the Window button becomes available.

Click the Window button to use the pointing device to specify the two corners of the area to be outputted, or enter coordinate values.

Layout/Limits When outputting a layout, everything within the printable area of the specified paper size, with the origin calculated from 0,0 in the layout.

When outputting from the Model layout, the entire drawing area that is defined by the grid limits. If the current viewport does not display a plan view, this option has the same effect as the Extents option.

Scale Controls the relative size of drawing units to plotted units.

NOTE If the Layout option is specified in What to Print, the layout is plotted at 1:1 regardless of the setting specified in Scale.
**Fit to Paper** Scales the plot to fit within the selected paper size and displays the custom scale factor in the Scale, Inch =, and Units boxes.

**Scale** Defines the exact scale for the output. *Custom* defines a user-defined scale. You can create a custom scale by entering the number of inches (or millimeters) equal to the number of drawing units.

**NOTE** You can modify the list of scales with SCALELISTEDIT (page 930).

**Inch(es) =/mm =** Specifies the number of inches or millimeters equal to the specified number of units.

**Inch/mm** Specifies inches or mm for display of units. The default is based on the paper size and changes each time a new paper size is selected.

**Unit** Specifies the number of units equal to the specified number of inches or millimeters.

**Scale Lineweights** Scales lineweights in proportion to the plot scale. Lineweights normally specify the line width of output objects and are output with the line width size regardless of the scale.

**PDF**
Lists options for printing to an electronic file. Some of the available options allow you to create PDF and PostScript files.

**Preview**
Displays the drawing as it will appear when printed on paper. (PREVIEW (page 840) command)

Exit the print preview and return to the Print dialog box to complete the print.

See also:

Overview of Plotting

**-PLOT**

Plots a drawing to a plotter, printer, or file in the command line.

If you enter **-plot** at the Command prompt, the following prompts are displayed.

**List of Prompts**

The following prompts are displayed.
Detailed plot configuration [Yes (page 808)/No (page 808)]

No:
Enter y or n or press Enter

Indicates that you do not want a detailed plot configuration for this plot.

Enter a layout name or [?] <current>:

Enter a page setup name < >:

Enter an output device name or [?] <current>:

Write the plot to a file [Yes/No] <current>:

Enter file name: <dwgname-layoutname.plt>:

Save changes to layout [Yes/No] <No>:

Proceed with Plot [Yes/No] <Y>:

For information about these prompts, see the description for Yes.

Yes:
Specifies detailed page settings for the Model layout or layout you are plotting.

Enter a layout name or [?] <current>: Specify the name of the layout tab you want to plot

Enter an output device name or [?] <current>: Specify the name of the output device to which you want to plot the Model tab or layout tab you selected

If you enter a new device name without an extension, the program assumes that the device is a PC3 file (Autodesk® HDI plotter configuration file). If no PC3 file is found, the program searches for a Windows system printer with that device name.

Enter paper size or [?] <current>: Specify the paper size to use for the plot or enter ? to view the actual list of paper sizes defined for the plotter driver

You must specify a paper size exactly as it is defined by the plotter driver.

Enter paper units [Inches/Millimeters] <current>:

The Enter Paper Units prompt is not displayed if you are plotting a raster image, such as a BMP or TIFF file, because the size of the plot is assumed to be in pixels.

Enter drawing orientation [Portrait/Landscape] <current>:

Portrait: Orients and plots the drawing so that the short edge of the paper represents the top of the page.
**Landscape** Orients and plots the drawing so that the long edge of the paper represents the top of the page.

Plot upside down [Yes/No] <No>:

Orients and plots the drawing upside down.

Enter plot area [Display/Extents/Limits/Layout/View/Window] <current>:

**Display** Plots the view in the current viewport on the Model layout or the current view in the layout, depending on which tab you select to plot.

**Extents** Plots all of the objects in the current viewport, except objects on frozen layers. From a layout, plots all the geometry in paper space. The drawing may be regenerated to recalculate the extents before plotting.

If you plot the drawing’s extents with a perspective view active and the camera position is within the drawing extents, this option has the same effect as the Display option.

**Limits** Plots the drawing area defined by the grid limits. Available only when the Model tab is selected.

**Layout** Plots everything within the printable area of the specified paper size, with the origin calculated from 0,0 in the layout. Available only when a layout tab is selected.

**View** Plots a view saved previously with the `VIEW` (page 1139) command. You can select a named view from the list provided. If there are no saved views in the drawing, this option is unavailable.

**Window** Plots any portion of the drawing you specify. This option prompts you to specify the corners of the window.

Enter lower left corner of window: Specify a point

Enter upper right corner of window: Specify a point

Enter plot scale (Plotted Inches = Drawing Units) or [Fit] <current>: Specify the scale of the plot

**Plotted Inches = Drawing Units** Calculates the plot scale based on the inches or millimeters to drawing units that you specify. You can also enter a real number as a fraction (for example, you can enter 1=2 or .5).

**Fit** Calculates the scale to fit the area on the sheet of paper.

The default scale setting is 1:1 when you are plotting a layout, unless you modified and saved the setting. The default setting is Fit when plotting a Model tab.
Enter plot offset (x, y) or [Center] <current>: Specify the plot offset in either the X or Y direction, or enter c to center the plot on the paper

Plot with plot styles [Yes/No] <current>: Specify whether to plot using the plot styles applied to objects and defined in the plot style table

If you specify Yes to plot with plot styles, the following prompt is displayed:

Enter plot style table name or [?] (enter . for none) <current>: Enter a plot style table name, ? to view plot style tables, or . (period) for none

All style definitions with different property characteristics are stored in the current plot style table and can be attached to the geometry. This setting replaces pen mapping in earlier releases of the program.

Plot with lineweights [Yes/No] <current>:

Scale lineweights [Yes/No] <current>:

NOTE The Scale Lineweights with Plot Scale prompt is displayed only when you plot from a layout tab. Settings for the shaded plotting type are available only when you plot from the Model layout. To control shaded plotting settings of viewports in a layout, use the Shadeplot option of the -vports command when you create a viewport.

Enter shade plot setting [As displayed/Wireframe/Hidden/Visual styles/Rendered] <As displayed>: Enter a shade plot option

Specifies how model space views are plotted.

As Displayed Specifies that a model space view is plotted the same way it is displayed.

Wireframe Specifies that a model space view is plotted in wireframe regardless of display.

Hidden Specifies that a model space view is plotted with hidden lines removed regardless of display.

Rendered Specifies that model space view plots are rendered regardless of display.

Write the plot to a file [Yes/No] <current>: Entry if you want to write the plotted drawing to a file, or press Enter to plot to an output device

If you specify Yes, the following prompt is displayed:

Enter file name: <dwgname-layoutname.plt>: Enter a file name

Save changes to page setup? Or set shade plot quality? [Yes/No/Quality] <No>: 

810 | Chapter 2 Commands
If you enter `y`, the current settings in the Page Setup dialog box are saved. If you enter `q`, you are prompted for the shaded plotting quality and are given the option of providing a custom dpi. Then you are prompted to save the page setup with the added quality settings.

Enter shade plot quality
[Draft/Preview/Normal/pResentation/Maximum/Custom] <Normal>: Enter
if you want to specify a dpi, or to use a preset dpi, specify a different quality option
Enter custom dpi <150>:

Save changes to page setup [Yes/No]? <No>:

Plot paper space first [Yes/No] <current>:

Paper space geometry is usually plotted before model space geometry. If you enter `n`, the model space geometry is plotted first, and paper space geometry is plotted last. This option is available only if you are plotting from a layout tab.

Hide paperspace objects? [Yes/No] <No>:

Specifies whether the Hide operation applies to objects in the paper space viewport. This option is available only from a layout tab.

Proceed with plot [Yes/No] <Y>:

See also:
- Overview of Plotting

**PLOTSTAMP**

Places a plot stamp on a specified corner of each drawing and logs it to a file.

**Summary**

The Plot Stamp Settings dialog box (page 812) is displayed.

If you enter `-plotstamp` at the Command prompt, options are displayed (page 817).

See also:
- Set Options for Plotted Objects
Plot Stamp Settings Dialog Box

Specifies the information for the plot stamp.

List of Options

The following options are displayed.

**AutoCAD Fields**
Specifies the drawing information you want applied to the plot stamp. The selected fields are separated by commas and a space.

**Drawing Name**
Includes the drawing name and path in the plot stamp information.
Layout Name
Includes the name of the layout in the plot stamp information.

Date and Time
Includes the date and time in the plot stamp information.

NOTE A plot stamp uses the current date and time format setting of the operating system. Plot stamp specifically uses the short date style for dates.

Login Name
Includes the user login name in the plot stamp information.
The user login name is contained in the LOGINNAME system variable.

Device Name
Includes the current plotting device name in the plot stamp information.

Paper Size
Includes the paper size for the currently configured plotting device in the plot stamp information.

Plot Scale
Includes the plot scale in the plot stamp information.

User Defined Fields
Provides text that can optionally be plotted, logged, or both plotted and logged at plot time. The selected value in each user-defined list will be plotted. For example, you might populate one list with media types or prices and the other with job names. If the user-defined value is set to <none>, then no user-defined information is plotted.

Add/Edit
Displays the Add User Defined Fields dialog box (page 816), where you can add, edit, or delete user-defined fields.

Parameter File
Stores plot stamp information in a file with a .pss extension. Multiple users can access the same file and stamp their plots based on company standard settings.

Two PSS files are provided, Mm.pss and Inches.pss, which are located in the Support folder. The initial default plot stamp parameter file name is determined by the regional settings of the operating system when the program is installed.

Path
Specifies the location of the plot stamp parameter file.

Load
Displays the Plotstamp Parameter File Name dialog box (a standard file selection dialog box) in which you can specify the location of the parameter file you want to use.

Save As
Saves the current plot stamp settings in a new parameter file.

Show/Hide Advanced Settings
Expands or collapses the Advanced Settings section which contains placement and text options for the plot stamp.

Location and Offset
Determines the plot stamp location, the orientation of the plot stamp, and the offset you want to apply relative to either the printable area or the paper border.

Location
Indicates the area where you want to place the plot stamp. Selections include Top Left, Bottom Left (default), Bottom Right, and Top Right. The location is relative to the image orientation of the drawing on the page.

Orientation
Indicates the rotation of the plot stamp in relation to the specified page. The options are Horizontal and Vertical for each of the locations (for example, Top Left Horizontal and Top Left Vertical).

Stamp Upside-Down
Rotates the plot stamp upside down.

X Offset
Determines the X offset value that is calculated from either the corner of the paper or the corner of the printable area, depending on which setting you specify. If you specify Offset Relative to Paper Border, the offset value is calculated so that the plot stamp information fits within the paper size.

Y Offset
Determines the Y offset value that is calculated from either the corner of the paper or the corner of the printable area, depending on which setting you specify. If you specify Offset Relative to Paper Border, the offset value is calculated so that the plot stamp information fits within the paper size.
Offset Relative to Printable Area
Calculates the offset values that you specify from the corner of the printable area of the paper (not the corner of the paper).

Offset Relative to Paper Border
Calculates the offset values that you specify from the corner of the paper (not the corner of the printable area of the paper).

Text and Units
Determines the font, height, and number of lines you want to apply to the plot stamp text.

Font
Specifies the TrueType font you want to apply to the text used for the plot stamp information.

Height
Specifies the text height you want to apply to the plot stamp information.

Single Line Plot Stamp
Places the plot stamp information in a single line of text. The plot stamp information can consist of up to two lines of text, but the placement and offset values you specify must accommodate text wrapping and text height. If this option is cleared, plot stamp text is wrapped after the third field.

Units
Specifies the units to use to calculate the height of the text: inches, millimeters, and pixels.

Log File
Writes the plot stamp information to a log file instead of, or in addition to, stamping the current plot. If plot stamping is turned off, the log file can still be created.

Create a Log File
Writes the plot stamp information to a log file. The default log file is plot.log, and it is located in the main application folder. You can specify a different file name and path. After the initial plot.log file is created, the plot stamp information in each succeeding plotted drawing is added to this file. Each drawing's plot stamp information is a single line of text. The plot stamp log file can be placed on a network drive and shared by multiple users. Plot stamp information from each user is appended to the plot.log file.
Log File Name

Specifies the file name for the log file you are creating. Enter a new file name if you do not want to use the default file name, plot.log.

Browse

Lists the currently saved plot stamp log files. You can choose to overwrite an existing plot stamp log file with the currently specified plot stamp information, and then to save this file.

See also:

- Set Options for Plotted Objects

Add User Defined Fields Dialog Box

Create and manage user-defined fields.

Summary

User-defined fields are created and edited using the User Defined Fields dialog box, which is displayed when you choose the Add/Edit button in the Plot Stamp dialog box.

List of Options

The following options are displayed.

Fields

Lists the available user-defined fields. Double-click the text of a user-defined field to edit the value.

Add (+)

Adds an editable user-defined field.

Delete (-)

Deletes the selected user-defined field.

See also:

- Set Options for Plotted Objects
**-PLOTSTAMP**

Places a plot stamp on a specified corner of each drawing and logs it to a file.

If you enter `-plotstamp` at the Command prompt, the following prompts are displayed. The settings in the PSS file are displayed as defaults for each prompt.

You can use `-PLOTSTAMP` as part of a plotting script to modify plot stamp information for a drawing.

**List of Prompts**

The following prompts are displayed.

Enter an option [On (page 817)/OFF (page 817)/Fields (page 817)/User fields (page 817)/Log file (page 817)/LOCation (page 818)/Text properties (page 818)/UNits (page 818)]:

- **On** Turns on the plot stamp for the current drawing.
- **OFF** Turns off the plot stamp for the current drawing.
- **Fields** Specifies the plot stamp field information you want to apply to the current plot stamp.
  - **Stamp drawing name? [Yes/No] <Yes>:**
  - **Stamp layout name? [Yes/No] <Yes>:**
  - **Stamp date and time? [Yes/No] <Yes>:**
  - **Stamp login name? [Yes/No] <Yes>:**
  - **Stamp plot device name? [Yes/No] <Yes>:**
  - **Stamp paper size? [Yes/No] <Yes>:**
  - **Stamp plot scale? [Yes/No] <Yes>:**

- **User Fields** Specifies the user-defined fields you want to apply to the current plot stamp.
  - Enter User field 1 <>: *Enter any user-defined field*
  - Enter User field 2 <>: *Enter any user-defined field*

- **Log File** Specifies writing the current plot stamp information to a log file rather than applying this information to the current plotted drawing. The default log file is `plot.log`, unless you specify another file path.
  - Write plot stamp to log file? [Yes/No] <Yes>:
  - Enter log file path <plot.log>: 

---

P Commands | 817
Location Determines the location of the plot stamp on the page based on offset, orientation, and relationship to either the printable area or the border of the paper.

Location selections include and are relative to the printable area or the border of the paper, depending on what you specify at the prompt.

Enter stamp location [TL/TR/BL/BR] <BL>:

- **TL**: Top Left
- **TR**: Top Right
- **BL**: Bottom Left
- **BR**: Bottom Right

Text orientation indicates the rotation angle of the plot stamp in relation to the page.

Enter text orientation [Horizontal/Vertical] <Horizontal>:

- **Horizontal**: Plot stamp will be horizontal relative to the page.
- **Vertical**: Plot stamp will be vertical relative to the page.

Stamp upside-down [Yes/No] <No>:

Specify plot stamp offset <0.1000, 0.1000>:

Specifying an offset relative to the paper border calculates the offset values that you specify from the corner of the paper. Specifying an offset relative to the printable area calculates the offset values that you specify from the corner of the printable area.

Specify offset relative to [paper Border/printable Area] <printable Area>:

Text Properties Determines the font name and text height for the current plot stamp text. You can also specify to place the text on one line or to wrap the text to two lines. The placement and offset values you specify for this plot stamp must accommodate the text wrapping and the text height.

Enter font name <>: Enter a font name

Enter text height <0.1500>: Enter a value

Place plot stamp on single line? [Yes/No] <No>:

Units Specifies the units used to measure X offset, Y offset, and height. You can define units using inches, millimeters, or pixels.

Enter measurement units [Inches/Millimeters/Pixels] <Inches>:

See also:

Set Options for Plotted Objects
PLOTSTYLE

Create and edit plot style files.

Access Methods

 thiểu Menu: Format ➤ Plot Style

Summary

Displays the Edit Plot Style Table dialog box (page 819).
If you enter -plotstyle at the Command prompt, options are displayed (page 825).

See also:

Use Plot Styles to Control Plotted Objects

Edit Plot Style Table Dialog Box

Create or edit plot style table files.

List of Options

The following options are displayed.

Plot Style Table Displays a list of the available plot style files that can be edited. A plot style is a collection of property settings used in plotting. Along
with selecting a plot style to edit from the list, you can also select one of the following:

- **Reveal in Finder.** Opens Finder to the folder that contains the listed plot styles. The location in which AutoCAD locates plot styles can be changed under Printer Support File Path ➤ Plot Style Table Search Path on the Application tab of the Application Preferences dialog box (OPTIONS (page 727) command).

- **New.** Displays the Plot Style Table Editor (page 820) with the default properties for a new plot style. The type of new plot style created depends on the type of plot style being used in the current drawing.

**Edit** Displays the Plot Style Table Editor with the properties of the selected plot style.

**See also:**

- Use Plot Styles to Control Plotted Objects

**Plot Style Table Editor**

Edits the properties of a plot style table file.
Summary

Lists all of the plot styles in the plot style table and their settings.

Plot styles are displayed in columns from left to right. The first plot style in a named plot style table is NORMAL and represents an object's default properties (no plot style applied). You cannot modify or delete the NORMAL style.
List of Options

The following options are displayed.

**Plot Styles**
Displays the names of plot styles in named plot style tables. Plot styles in named plot style tables can be changed. Plot style names in color-dependent plot style tables are tied to object color and cannot be changed. The program accepts up to 255 characters for style names.

**Add Style (+)**
Adds a new plot style to a named plot style table.
The plot style is based on Normal, which uses an object's properties and doesn't apply any overrides by default. You must specify the overrides you want to apply after you create the new plot style. You cannot add a new plot style to a color-dependent plot style table; a color-dependent plot style table has 255 plot styles mapped to color. You also cannot add a plot style to a named plot style table that has a translation table.

**Delete Style (-)**
Deletes the selected style from a named plot style table.
Objects assigned this plot style retain the plot style assignment but plot as Normal because the plot style is no longer defined in the plot style table. You cannot delete a plot style from a named plot style table that has a translation table, or from a color-dependent plot style table.

**Color**
Specifies the plotted color for an object. The default setting for plot style color is Use Object Color. If you assign a plot style color, the color overrides the object's color at plot time.

You can choose Select Color to display the Color Palette dialog box (page 205) and select one of the 255 AutoCAD Color Index (ACI) colors, a true color, or a color from a color book. The color you specify is displayed in the plot style color list as Custom Color. If the plot device does not support the color you specify, it plots the nearest available color or, in the case of monochrome devices, black.

**Dithering**
Enables dithering. A plotter uses dithering to approximate colors with dot patterns, giving the impression of plotting more colors than available in the AutoCAD Color Index (ACI). If the plotter does not support dithering, the dithering setting is ignored.

Dithering is usually turned off in order to avoid false line typing that results from dithering of thin vectors. Turning off dithering also makes dim colors
more visible. When you turn off dithering, the program maps colors to the nearest color, resulting in a smaller range of colors when plotting.

**Grayscale**
Converts the object’s colors to grayscale if the plotter supports grayscale. If you clear Convert to Grayscale, the RGB values are used for object colors. Dithering is available whether you use the object’s color or assign a plot style color.

**Screening**
Specifies a color intensity setting that determines the amount of ink placed on the paper while plotting. Selecting 0 reduces the color to white. Selecting 100 displays the color at its full intensity. The Dithering option must be selected for screening.

**Linetype**
Displays a list with a sample and a description of each linetype. If you assign a plot style linetype, the linetype overrides the object's linetype at plot time.

**Adaptive**
Adjusts the scale of the linetype to complete the linetype pattern.

If you do not select Adaptive, the line might end in the middle of a pattern. Turn off Adaptive if linetype scale is important. Turn on Adaptive if complete linetype patterns are more important than correct linetype scaling.

**Lineweight**
Displays a sample of the lineweight as well as its numeric value. You can specify the numeric value of each lineweight in millimeters.

If you assign a plot style lineweight, the lineweight overrides the object's lineweight when it is plotted.

**Edit Lineweights** Modifies the widths values of existing lineweights.
Displays the Edit Lineweights dialog box.
There are 28 lineweights available to apply to plot styles in plot style tables. If the lineweight you need does not exist in the list of lineweights stored in the plot style table, you can edit an existing lineweight. You cannot add or delete lineweights from the list in the plot style table.

**Line End Style**
If you assign a line end style, the line end style overrides the object's line end style at plot time.

**Line Join Style**
If you assign a line join style, the line join style overrides the object's line join style at plot time.
**Fill Style**
If you assign a fill style, the fill style overrides the object's fill style at plot time.

**Pen#**
Specifies a pen to use when plotting objects that use this plot style. Available pens range from 1 to 32. If plot style color is set to Use Object Color, or you are editing a plot style in a color-dependent plot style table, the value is set to Automatic.

If you specify 0, the field updates to read Automatic. The program determines the pen of the closest color to the object you are plotting using the information specified as part of the plotter.

**Virtual Pen#**
Specifies a virtual pen number between 1 and 255. Many non-pen plotters can simulate pen plotters using virtual pens. For many devices, you can program the pen's width, fill pattern, end style, join style, and color/screening from the front panel on the plotter.

Enter 0 or Automatic to specify that the program should make the virtual pen assignment from the AutoCAD Color Index.

The virtual pen setting in a plot style is used only by non-pen plotters and only if they are configured for virtual pens. If this is the case, all the other style settings are ignored and only the virtual pen is used. If a non-pen plotter is not configured for virtual pens, then the virtual and physical pen information in the plot style is ignored and all the other settings are used.

**Description**
Provides a description for each plot style.

**Details**
Displays additional information and properties of the plot style being edited.

**File name** Displays the name of the plot style file.

**Description** Provides a description for the plot style file.

**Number of Styles** Lists the number of plot styles contained in the plot style file.

**Path** Displays the path in which the plot style file is stored.

**Version** Displays the file format version of the plot style file.

**Apply Global Scale Factor to Non-ISO Linetypes** Scales all the non-ISO linetypes and fill patterns in the plot styles of objects controlled by this plot style table.
**Scale Factor** Specifies the amount to scale non-ISO linetypes and fill patterns.

**Save As**
Displays the Save dialog box and saves the plot style table to a new name.

**See also:**
Use Plot Styles to Control Plotted Objects

---

**-PLOTSTYLE**

Lists all available plot styles in the current drawing and to set a plot style current.

**List of Prompts**

The following prompts are displayed.

- Current plot style is "current"
- Enter an option [?/Current]:

  - ?—List Plot Styles Lists the plot styles in the attached plot style table.
  - Current Specifies the plot style to use for new objects.

**See also:**
Use Plot Styles to Control Plotted Objects

---

**PNGOUT**

Saves selected objects to a file in a Portable Network Graphics format.

**Summary**

The Create Raster File dialog box (a standard file selection dialog box (page 723)) is displayed. Enter the file name in the dialog box.

**List of Prompts**

The following prompts are displayed.

- Select objects or <all objects and viewports>: Press Enter to select all objects and viewports or use an object selection method and press Enter
A Portable Network Graphics file is created that contains the objects you select. The file reflects what is displayed on the screen. Light glyphs that are displayed in the drawing appear in the new file, even if the Plot Glyph property of the lights is set to No.

**NOTE** When the FILEDIA (page 1334) system variable is set to 0 (Off), prompts are displayed at the Command prompt.

See also:
   - Export Raster Files

### POINT

Creates a point object.

**Access Methods**

- **Button**
  - ![Toolbar: Drafting tool set ➤ Open Shapes tool group (expanded) ➤ Point flyout ➤ Multiple Points](image)
- **Menu:** Draw ➤ Point ➤ Single

**Summary**

Points can act as nodes to which you can snap objects. You can specify a full three-dimensional location for a point. The current elevation is assumed if you omit the Z coordinate value.

The **PDMODE** (page 1429) and **PDSIZE** (page 1429) system variables control the appearance of point objects. PDMODE values 0, 2, 3, and 4 specify a figure to draw through the point. A value of 1 specifies that nothing is displayed.

The values represent:

```
   .  +  ×  1
0  1  2  3  4
```

Specifying the value 32, 64, or 96 selects a shape to draw around the point, in addition to the figure drawn through it:
PDSIZE controls the size of the point figures, except for PDMODE values 0 and 1. A setting of 0 generates the point at 5 percent of the drawing area height. A positive PDSIZE value specifies an absolute size for the point figures. A negative value is interpreted as a percentage of the viewport size.

After you change PDMODE and PDSIZE, the appearance of existing points changes the next time the drawing is regenerated.

You can use MEASURE and DIVIDE to create points along an object. Use DDPTYYPE to specify point size and styles easily.

**List of Prompts**

Specify a point: Specify a point in the drawing

See also:

Draw Reference Points

**POINTLIGHT**

Creates a point light that radiates light in all directions from its location.
### Access Methods

![Access Methods](image)

**Button**

- **Toolbar**: Modeling tool set ➤ Lights tool group ➤ Point Light
- **Menu**: View ➤ Render ➤ Light ➤ New Point Light

### Summary

Use point lights for general lighting effects.

### List of Prompts

The following prompts are displayed.

Specify source location <0,0,0>:  *Enter coordinate values or use the pointing device*

If the LIGHTINGUNITS system variable is set to 0, the following prompt is displayed:

Enter an option to change [Name (page 828)/Intensity (page 829)/Status (page 829)/Shadow (page 830)/Attenuation (page 830)/Color (page 831)/eXit (page 832)] <eXit>:

If the LIGHTINGUNITS system variable is set to 1 or 2, the following prompt is displayed:

Enter an option to change [Name (page 828)/Intensity factor (page 829)/Photometry (page 829)/Shadow (page 830)/Attenuation (page 830)/filterColor (page 831)/eXit (page 832)] <eXit>:

**NOTE** When the LIGHTINGUNITS system variable is set to 1 or 2, the Attenuation option has no affect on the creation of the light. It is only maintained for scripting compatibility.

### Name

Specifies the name of the light. You can use uppercase and lowercase letters, numbers, spaces, hyphens (-), and underscores (_) in the name. The maximum length is 256 characters.

Enter light name:
**Intensity/Intensity Factor**
Sets the intensity or brightness of the light. The range is 0.00 to the maximum value that is supported by your system.

Enter intensity (0.00-max float) <1.0000>:

**Status**
Turns the light on and off. If lighting is not enabled in the drawing, this setting has no effect

Enter status [oN/oFf] <On>:

**Photometry**
Photometry is available when the LIGHTINGUNITS system variable is set to 1 or 2. Photometry is the measurement of the luminous intensities of visible light sources.

In photometry, luminous intensity is a measure of the perceived power emitted by a light source in a particular direction. Luminous flux is the perceived power per unit of solid angle. The total luminous flux for a is the perceived power emitted in all directions. Luminance is the total luminous flux incident on a surface, per unit area.

Enter a photometric option to change [Intensity/Color/eXit] <I>:

**Intensity** Enter intensity (Cd) or enter an option [Flux/Illuminance] <1500.0000>:
Enter an intensity value in candelas, the perceived power in a luminous flux value, or illuminance value for the total luminous flux incident on a surface.

- **Candela (symbol: cd)** is the SI unit of luminous intensity (perceived power emitted by a light source in a particular direction). Cd/Sr
- **Lux (symbol: lx)** is the SI unit of illuminance. Lm/m^2
- **Foot-candle (symbol: fc)** is the American unit of illuminance. Lm/ft^2

Enter f to specify the perceived power in a luminous flux value.

Enter Flux (Lm) <18849.5556>:
If you enter i, you can specify the intensity of the light based on an illuminance value.

Enter Illuminance ("Lx"|"Fc") or enter an option [Distance] <1500.0000>:
The illuminance value can be specified in either lux or foot-candles. Enter d to specify a distance to use to calculate illuminance.

Enter Distance <1.0000>:

**Color** Enter color name or enter an option [?/Kelvin] <D65White>:
Specify the color of the light based on a color name or a Kelvin temperature. Enter ? to display a list of color names.
Enter color name(s) to list <*>:
Enter a text string using wild card characters to display a partial listing of color names, or an asterisk (*) to display all the possible choices.
If you enter k, you can specify the color of the light based on a Kelvin temperature value.
Enter Kelvin temperature <3600.0000>:

Exit Exits the command option.

Shadow
Makes the light cast shadows.
Enter shadow settings [Off/Sharp/soFtmapped/softsAmpled] <Sharp>:
Off Turns off display and calculation of shadows for the light. Turning shadows off increases performance.
Sharp Displays shadows with sharp edges. Use this option to increase performance.
Soft Mapped Displays realistic shadows with soft edges.
Enter map size [64/128/256/512/1024/2048/4096] <256>:
Specifies the amount of memory to use to calculate the shadow map.
Enter softness (1-10) <1>:
Specifies the softness to use to calculate the shadow map.
Soft Sampled Displays realistic shadows with softer shadows (penumbra) based on extended light sources.
Enter an option to change [Shape/sAmiples/Visible/eXit]<eXit>:
Specify the shape of the shadow by entering s and then the dimensions of the shape. (For example, the radius of the sphere or the length and width of a rectangle.)
Enter shape [Linear, Disk, Rect, Sphere,Cylinder] <Sphere>:
Specify the sample size by entering a.
Enter Shadow Sample <16.0000>:
Specify the visibility of the shape by for the shadow by entering v.
Enter Shape Visibility [Yes/No]<No>:

Attenuation
Enter an option to change [attenuation Type/Use limits/attenuation start Limit/attenuation End limit/eXit]<eXit>:
**Attenuation Type** Controls how light diminishes over distance. The farther away an object is from a point light, the darker the object appears. Attenuation is also known as decay.

Enter attenuation type [None/Inverse linear/inverse Squared] <Inverse linear>:

- None. Sets no attenuation. Objects far from the point light are as bright as objects close to the light.

- Inverse Linear. Sets attenuation to be the inverse of the linear distance from the light. For example, at a distance of 2 units, light is half as strong as at the point light; at a distance of 4 units, light is one quarter as strong. The default value for inverse linear is half the maximum intensity.

- Inverse Squared. Sets attenuation to be the inverse of the square of the distance from the light. For example, at a distance of 2 units, light is one quarter as strong as at the point light; at a distance of 4 units, light is one sixteenth as strong.

**Use Limits** Specifies whether to use limits or not.

Limits [oN/oFf] <Off>:

**Attenuation Start Limit** Specifies the point where light starts as an offset from the center of the light. The default is 0.

Specify start limit offset <1.0000>:

**Attenuation End Limit** Specifies the point where light ends as an offset from the center of the light. No light is cast beyond this point. Setting an end limit increases performance where the effect of lighting is so minimal that the calculations are wasted processing time.

Specify end limit offset <10.0000>:

**Color/Filter Color**

Controls the color of the light.

Enter true color (R,G,B) or enter an option [Index color/Hsl/colorBook] <255,255,255>:

- **True Color** Specifies a True Color. Enter in the format R,G,B (red, green, blue).
- **Index** Specifies an ACI (AutoCAD Color Index) color.
  
  Enter color name or number (1-255):

- **HSL** Specifies an HSL (hue, saturation, luminance) color.
  
  Enter HSL color (H,S,L) <0,0,100>:

- **Color Book** Specifies a color from a color book.
  
  Enter Color Book name:
Exit
Exits the command.

See also:
Use Point Lights

POLYGON
Creates an equilateral closed polyline.

Access Methods

Button

Toolbar: Drafting tool set ➤ Closed Shapes tool group (expanded) ➤ Polygon

Menu: Draw ➤ Polygon

List of Prompts
The following prompts are displayed.
Enter number of sides <current>: Enter a value between 3 and 1024 or press
Enter
Specify center of polygon (page 832) or [Edge (page 833)]: Specify
a point (1) or enter e

Center of Polygon
Defines the center of the polygon.
Enter an option [Inscribed in circle/Circumscribed about circle] <current>: Enter or press Enter
**Inscribed in Circle** Specifies the radius of a circle on which all vertices of the polygon lie.
Specify radius of circle: *Specify a point (2) or enter a value*

Specifying the radius with your pointing device determines the rotation and size of the polygon. Specifying the radius with a value draws the bottom edge of the polygon at the current snap rotation angle.

**Circumscribed about Circle** Specifies the distance from the center of the polygon to the midpoints of the edges of the polygon.
Specify radius of circle: *Specify a distance*

Specifying the radius with your pointing device determines the rotation and size of the polygon. Specifying the radius with a value draws the bottom edge of the polygon at the current snap rotation angle.

**Edge**
Defines a polygon by specifying the endpoints of the first edge.

Specify first endpoint of edge: *Specify a point (1)*
Specify second endpoint of edge: *Specify a point (2)*
You can specify the different parameters of the polygon including the number of sides. The difference between the inscribed and circumscribed options is shown.

See also:
Draw Rectangles and Polygons

**POLYSOLID**

Creates a 3D wall-like polysolid.

**Access Methods**

**Button**

- **Toolbar:** Modeling tool set ➤ Solids - Create tool group ➤ Solid Primitives flyout ➤ Polysolid
- **Menu:** Draw ➤ 3D Modeling ➤ Polysolid

**Summary**

You can create walls with straight and curved segments of constant height and width.
With the POLYSOLID command, you can convert an existing line, 2D polyline, arc, or circle to a solid with a rectangular profile. A polysolid can have curved segments, but the profile is always rectangular by default.

You can draw a solid with POLYSOLID just as you would a polyline. The PSOLWIDTH (page 1451) system variable sets the default width for the solid. The PSOLHEIGHT (page 1450) system variable sets the default height for the solid.

**List of Prompts**

The following prompts are displayed.

Specify start point or [Object (page 836)/Height (page 836)/Width (page 836)/Justify (page 836)] <Object>: Specify a start point for the profile of the solid, press Enter to specify an object to convert to a solid, or enter an option.
Specify the next point (page 836) or [Arc (page 837)/Undo (page 838)]: Specify the next point for the profile of the solid, or enter an option

**Object**
Specifies an object to convert to a solid. You can convert:
- Line
- Arc
- 2D polyline
- Circle

Select object: Select an object to convert to a solid

**Height**
Specifies the height of the solid. The default height is set to the current PSOLHEIGHT (page 1450) setting.

Specify height <default>: Specify a value for the height, or press Enter to specify the default value

The specified height value will update the PSOLHEIGHT (page 1450) setting.

**Width**
Specifies the width of the solid. The default width is set to the current PSOLWIDTH (page 1451) setting.

Specify width <current>: Specify a value for the width by entering a value or specifying two points, or press Enter to specify the current width value

The specified width value will update the PSOLWIDTH (page 1451) setting.

**Justify**
Sets the width and height as the solid to be left, right, or center justified when defining the profile with the command. The justification is based on the starting direction of the first segment of the profile.

Enter justification [Left/Center/Right] <Center>: Enter an option for the justification or press Enter to specify center justification

**Next Point**
Specify the next point or [Arc/Close/Undo]: Specify the next point for the profile of the solid, enter an option, or press Enter to end the command

**Arc** Adds an arc segment to the solid. The default starting direction of the arc is tangent to the last drawn segment. You can specify a different starting direction with the Direction option.
Specify endpoint of arc or [Close/Direction/Line/Second point/Undo]: Specify an endpoint or enter an option

- **Close.** Closes the solid by creating a line or arc segment from the last point specified to the starting point of the solid. At least two points must be specified to use this option.

- **Direction.** Specifies a starting direction for the arc segment.
  - Specify the tangent direction from the start point of arc: Specify a point
  - Specify endpoint of arc: Specify a point

- **Line.** Exits the Arc option and returns to the initial POLYSOLID command prompts.

- **Second Point.** Specifies the second point and endpoint of a three-point arc segment.
  - Specify second point on arc: Specify a point
  - Specify end point of arc: Specify a point

- **Undo.** Removes the most recent arc segment added to the solid.

**Close** Closes the solid by creating a line or arc segment from the last point specified to the starting point of the solid. At least three points must be specified to use this option.

**Undo** Removes the most recent arc segment added to the solid.

**Arc**
Adds an arc segment to the solid. The default starting direction of the arc is tangent to the last drawn segment. You can specify a different starting direction with the Direction option.

Specify endpoint of arc or [Close/Direction/Line/Second point/Undo]: Specify an endpoint or enter an option

**Close** Closes the solid by creating a linear or arc segment from the last vertex to the start of the solid.

**Direction** Specifies a starting direction for the arc segment.
Specify the tangent direction from the start point of arc: Specify a point
Specify endpoint of arc: Specify a point

**Line** Exits the Arc option and returns to the initial POLYSOLID command prompts.

**Second Point** Specifies the second point and endpoint of a three-point arc segment.
Specify second point on arc: Specify a point
Specify end point of arc: *Specify a point*

**Undo** Removes the most recent arc segment added to the solid.

**Undo** Removes the most recent segment added to the solid.

See also:
- Create a Polysolid

**PRESSPULL**

Dynamically modifies objects by extrusion and offset.

**Access Methods**

- **Button**
- **Toolbar:** Modeling tool set ➤ Solids - Create tool group ➤ Presspull

**Summary**

Get visual feedback as you move the cursor after selecting a 2D object, an area formed by a closed boundary or a 3D solid face. The press or pull behavior responds to the type of object you select to create extrusions and offsets. In this example, the area between two polylines is pulled to create a 3D solid wall.
Presspull behavior

<table>
<thead>
<tr>
<th>Selection</th>
<th>Presspull behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open 2D object (such as an arc)</td>
<td>Extrudes to create a surface</td>
</tr>
<tr>
<td>Closed 2D object (such as a circle)</td>
<td>Extrudes to create a 3D solid</td>
</tr>
<tr>
<td>Inside a bounded area</td>
<td>Extrudes to create a 3D solid</td>
</tr>
<tr>
<td>3D solid face</td>
<td>Offsets the face, expanding or condensing the 3D solid</td>
</tr>
</tbody>
</table>

The command repeats automatically until you press Esc, Enter, or the Spacebar.

**List of Prompts**

The following prompts are displayed.

**Object or bounded area** Select the object, bounded area, 3D solid face, or 3D solid edge that you want to modify.

Selecting a face extrudes the face without affecting the adjacent faces. If you Ctrl+click a face, the face is offset, and the change also affects the adjacent faces.

**Multiple** Specifies that you want to make more than one selection. You can also Shift+click to make multiple selections.

**Offset distance** If you selected the face of a 3D solid, specify the offset by moving the cursor or entering a distance.

**Extrusion height** If you selected a 2D object or clicked inside a closed area, specify an extrusion height by moving the cursor or entering a distance.
extrusion direction of planar objects is normal to planar objects and in the Z
direction of the current UCS for non-planar objects.

See also:
- Pressing or Pulling Areas, Faces, and Edges

### PREVIEW

Displays the drawing as it will be printed.

**Summary**

The preview is based on the current print configuration, as defined by the
settings in the Page Setup dialog box (page 757). It shows exactly how the
drawing will look when printed, including lineweights, fill patterns, and other
print options.

**NOTE** An output device must be assigned to the layout before a preview can be
generated.

The toolbar along the top of the Preview window allows you to view different
areas of the print, search for text, and copy a selected area to the Clipboard.

**Preview Window Toolbar (Mac OS X Lion)**

Provides options in the Preview window.

- **Zoom** Reduces or enlarges the preview image. Click (-) to reduce the preview
  image and (+) to enlarge the preview image.
- **Move** Moves the preview image planar to the screen.
- **Text** Allows you to select text objects. (Not available in AutoCAD)
- **Select** Creates a selection window in the preview image that allows you to
copy part of the preview to the Clipboard.
- **View** Controls the view type to use when previewing multi-pages.
- **Search** Allows you to search for a text string in the preview. (Not available in
  AutoCAD)

**Preview Window Toolbar (Mac OS X Snow Leopard)**

Provides options in the Preview window.

- **Previous** Displays the previous page in a multi-page preview.
Next Displays the next page in a multi-page preview.
Zoom Reduces or enlarges the preview image. Click (-) to reduce the preview image and (+) to enlarge the preview image.
Move Moves the preview image planar to the screen.
Text Allows you to select text objects. (Not available in AutoCAD)
Select Creates a selection window in the preview image that allows you to copy part of the preview to the Clipboard.
Sidebar Displays a secondary pane that contains thumbnails for multi-page previews.
Search Allows you to search for a text string in the preview. (Not available in AutoCAD)

See also:
Preview a Plot

PROJECTGEOMETRY

Projects points, lines, or curves onto a 3D solid or surface from different directions.

Summary

By projecting geometry you can do on of the following:
- Project points or curves onto a 3D solid or surface.
- Project and trim a selected 3D solid or surface.

To trim the surface, set the SURFACEAUTOTRIM (page 1499) system variable to 1.

You can project any curve (line, arc, circle, ellipse, 2D polyline, 2D spline-fit polyline, 2D curve-fit polyline, 3D polyline, 3D spline-fit polyline, spline, or helix) onto any type of surface or solid.

List of Prompts

The following prompts are displayed.

Project to UCS
Projects the geometry along the positive or negative Z axis of the current UCS.

Project to View
Projects the geometry based on the current view.

Project to Two Points
Projects the geometry along a path between two points.

See also:
Trim and Untrim Surfaces
PROPERTIES

Controls properties of existing objects.

Access Methods

Menu: Modify ➤ Properties
Shortcut menu: Select the objects whose properties you want to view or modify, right-click in the drawing area, and click Properties.

Summary

The Properties Inspector palette (page 844) is displayed and lists the properties of the selected objects.

When more than one object is selected, only those properties common to all selected objects are displayed.

When no objects are selected, only the current settings of general properties are displayed.

You can also view or modify properties of third-party application objects that are based on AutoCAD application programming interface (API) standards.

There are several general properties (page 845) common to all objects. All other object properties are specific to the type of object.

See also:

Display and Change the Properties of Objects
Properties Inspector Palette

Displays the properties of the selected object or set of objects.

Summary

When more than one object is selected, only those properties common to all selected objects are displayed. When no objects are selected, only the current settings of general properties are displayed.

You can specify a new value to modify any property that can be changed. Click the value and use one of the following methods:

■ Enter a new value.
■ Click the down arrow at the right and select a value from the list.
■ Click the Pick Point button to use the pointing device to change a coordinate value.
■ Click the […] button and change the property value in a dialog box.
■ Select or clear a check box to toggle a property on or off.
■ Drag a slider left or right.
List of Options

The following options are displayed.

Current Displays the properties for the current drawing or selected objects.

Layer Displays the properties for the layer selected in the Layer list of the Layers palette.

Object Type Displays the type of objects that are selected and filters which objects you are modifying.

Essentials Displays the most commonly edited or viewed properties for the current drawing or selected objects.

All Displays all the properties associated with the current drawing or the selected objects.

Match Properties Applies the properties of a selected object to other objects.

Drawing/Objects/Layer Properties Displays a list of available properties that can currently be edited. The list of properties show is based on the following conditions:

■ No objects selected in the current drawing. Drawing specific properties are displayed.
■ Objects selected in the current drawing. Properties common to all selected objects are displayed.
■ Layer selected from the Layer list in the Layers palette. Layer properties are displayed.

See also:
Display and Change the Properties of Objects

General Properties of Objects

Each graphical object in a drawing shares a common set of properties known as the general properties.

Summary

The following general properties are common to most objects and custom objects (third-party application objects based on AutoCAD API standards).
**NOTE** Layers or objects that are assigned property overrides in viewports display a ByLayer (VP) value and a background color for applicable properties.

List of Options

The following options are displayed.

**Color** Specifies the color for objects. Selecting Select Color in the color list allows you to define the color of objects by selecting from the 255 AutoCAD Color Index (ACI) colors, true colors, and color book colors (see COLOR (page 205)).

**Layer** Specifies the current layer of the object. The list shows all layers in the current drawing (see LAYER (page 539)).

**Linetype** Specifies the current linetype of the object. The list shows all linetypes in the current drawing (see LINETYPE (page 578)).

**Linetype Scale** Specifies the linetype scale factor of the object (see LTSCALE (page 596)).

**Plot Style** Lists NORMAL, BYLAYER, BYBLOCK, plus any plot styles contained in the current plot style table (see PLOTSTYLE (page 819)).

**Lineweight** Specifies the lineweight of the object. The list shows all available lineweights in the current drawing (see LWEIGHT (page 596)).

**Transparency** Specifies the transparency of the object (see TRANSPARENCY (page 1100)).

**Thickness** Sets the current 3D thickness. This property does not apply to all objects (see CHPROP (page 194)).

See also:

- Display and Change the Properties of Objects

846 | Chapter 2  Commands
Cell Border Properties Dialog Box

Sets the properties of the borders of table cells.

Access Methods

**Pointing device:** With a table cell selected and the Properties Inspector palette open, click All. Under the Cell section, click the button to the right of the Border Style field.

List of Options

The following options are displayed.

**Properties**

Controls the properties of the borders of the selected table cells.

**Lineweight**
Sets the lineweight to be used for borders that are displayed. If you use a heavy lineweight, you may have to change the cell margins.

**Linetype**

Sets the linetype to be used for borders that are displayed.

**Color**

Sets the color to be used for borders that are displayed.

**Double Line**

When checked, a double line border will be added to the selected cells.

**Spacing**

Determines the spacing of double-line borders. The default value is .1800.

**Preview**

Displays a preview of how the borders of the selected table will look.

---

**NOTE** Linetypes will not display in the preview.

**All Borders**

Applies the border properties settings to all borders of the selected table cells.

**Outside Borders**

Applies the border properties settings to the outside borders of the selected table cells.

**Inside Borders**

Applies the border properties settings to the inside borders of the selected table cells.

**No Borders**

Applies the border properties settings to none of the borders of the selected table cells.

**Top Border** Applies the border properties setting to the top borders of the selected table cells.

**Inside Horizontal Border** Applies the border properties setting to the inside horizontal borders of the selected table cells.

**Bottom Border** Applies the border properties setting to the bottom borders of the selected table cells.
**Left Border** Applies the border properties setting to the left borders of the selected table cells.

**Inside Vertical Border** Applies the border properties setting to the inside vertical border of the selected table cells.

**Right Border** Applies the border properties setting to the right border of the selected table cells.

**See also:**
- Display and Change the Properties of Objects

**Lighting Properties**

Sets the properties of the lights.

**Summary**

Different properties area available depending on the lighting units (standard or photometric) and lighting type (Spotlight (page 1031), Pointlight (page 827), or Weblight (page 1164)). Other lighting types such as Freespot (page 448), Targetpoint (page 1075), and Freeweb (page 451) display similar properties. By right-clicking on a light and clicking Properties, the Lighting category of the Properties Inspector palette (page 844) is displayed.

**List of Options**

The following options are displayed.

**General Properties**

The following property settings are available:

**Name** Specifies the name of the light.

**Type (Light Distribution)** Specifies the type of light. Determines the distribution of light from the . The type of lighting can be changed after the light has been added to the drawings.

- Spotlight - Default value for Spotlight and Freespot lights.
- Point - Default for Pointlight and Targetpoint lights.
- Web - Default for Weblight and Freeweb lights.

**On/Off Status** Indicates whether the light is on or off.
Shadows Indicates if the light is casting a shadow.

Hotspot Angle (Spotlight and Freespot only) Specifies the angle of the brightest cone of light.

Falloff Angle (Spotlight and Freespot only) Specifies the outer extremity of the light, where it meets the darkness.

Intensity Factor Magnifies the effect of the skylight.

Filter Color Specifies the secondary color of the light. Represents the color of a physical filter over the lamp. Default color is white.

When lighting is set to photometric units this represents a secondary color filter on the light. When lighting is set to generic lighting this represents the total color of the light.

Plot Glyph Allows the ability to plot the drawing with the glyphs on.

Photometric Properties
The following property settings are available:

Lamp Color Specifies the inherent color of the light in Kelvin temperature or standard.

Resulting Color Reports the final color of the light. This is determined by a combination of the Lamp Color and the Filter Color. (Read-only)

Intensity Method Specifies the value in which light intensity should be measured.

- **Intensity (Candela).** Specifies the number of candelas (cd) is the SI unit of luminous intensity (perceived power emitted by a light source in a particular direction).

- **Flux (Lumen).** Represents the rate of total energy leaving the lamp. It is specified in lumens (SI and American). Mathematically, the flux is the integral of the luminous intensity over the sphere. The calculation of flux depends on the distribution of intensities. For a point light with constant intensity, the flux is simply the product of the intensity and the solid angle of a sphere: \(4 \pi \times \text{Intensity} \). For a spot light, the flux is the product of the intensity and the solid angle of the hotspot cone, plus the incremental solid angle of the fall-off region. For a weblight, there isn’t any analytical formula. The flux is obtained by numerically integrating the intensities provided in the web file.

- **Illuminance (Foot-candles).** Represents the energy per area arriving at a surface (Area-flux-density). It is specified in lux (SI) and foot-candles (American). For a near light, because the light rays are diverging, you have to talk about the illuminance at a specific distance from the lamp. So this
requires an extra control to specify this distance and an additional affordance in the viewport to show the distance.

**Lamp Intensity** Specifies the brightness of a lamp. More specifically, it represents the luminous intensity, or power in a particular direction.

**Intensity Factor** Magnifies the effect of the skylight.

**Resulting Intensity** Reports the final brightness of the light. This is determined by the product of the Lamp Intensity and the Intensity factor. (Read-only)

**PhotometricWeb**

The following property settings are available for Web and Freeweb lights:

**Web File** Specifies the data file describing the intensity distribution of the light.

**Web Offsets**
Under the Web offsets panel, the following property settings are available under the Weblight and Freeweb types of lights:

**Rotate X** Specifies a rotational offset of the web about the optical X axis.

**Rotate Y** Specifies a rotational offset of the web about the optical Y axis.

**Rotate Z** Specifies a rotational offset of the web about the optical Z axis.

**Geometry**
Under the Geometry panel, the following property settings are available:

**Position X** Specifies the X coordinate position of the light.

**Position Y** Specifies the Y coordinate position of the light.

**Position Z** Specifies the Z coordinate position of the light.

**Target X** Specifies the X coordinate target position of the light. (Spotlight, Targetpoint, and Weblight only)

**Target Y** Specifies the Y coordinate target position of the light. (Spotlight, Targetpoint, and Weblight only)

**Target Z** Specifies the Z coordinate target position of the light. (Spotlight, Targetpoint, and Weblight only)

**Targeted** Specifies if the light displays a target grip for orienting the light. Disabled is the default for Freespot, Pointlight, and Freeweb. Enabled is the default for Spotlight, Targetpoint, and Weblight.
**Attenuation**

In the real world, the intensity of light diminishes over distance. Objects far from the light source appear darker than objects near the source. This effect is known as attenuation. Attenuation is available under standard lighting workflow only. Under the Attenuation panel the following property settings are available:

**Type** Controls how light diminishes over distance. The farther away an object is from a spotlight, the darker the object appears. Attenuation is also known as decay.

- **Inverse Linear** (Standard lights only). Sets attenuation to be the inverse of the linear distance from the light. For example, at a distance of 2 units, light is half as strong as at the point light; at a distance of 4 units, light is one quarter as strong. The default value for inverse linear is half the maximum intensity.

- **Inverse Square** (Photometric lights). Sets attenuation to be the inverse of the square of the distance from the light. For example, at a distance of 2 units, light is one quarter as strong as at the spotlight; at a distance of 4 units, light is one sixteenth as strong.

- **None** (Standard lights only). Sets no attenuation. Objects far from the point light are as bright as objects close to the light.

**Use Limits** Specifies whether to use limits. The default is No. (Standard lights only)

**Rendered Shadow Details**

Under the Rendered Shadow Details panel, the following property settings are available:

**Type** Specifies the type of shadow cast by the light.

- **Soft** (shadow map). Sets the type to Soft. This selection activates additional options for Map size and Softness.

- **Sharp** (default). Sets the rendered shadow to sharp.

- **Soft** (sampled). Sets attenuation to be the inverse of the square of the distance from the light. For example, at a distance of 2 units, light is one quarter as strong as at the spotlight; at a distance of 4 units, light is one sixteenth as strong.

**Map Size** Specifies the size of the shadow map. (Soft shadow map type only)

**Softness** Specifies the softness or fuzziness of the shadow-mapped shadow. (Soft shadow map type only)
Samples Specifies the number of shadow rays for the light. (Soft sampled type only)

Visible in Render Specifies whether the light shape is actually rendered. The default is No. (Soft sampled type only)

Shape Specifies the shape of the lamp bulb. For the Spotlight distribution type selection under the General panel, options are Rectangle (default) and Disk. For Point and Web types the options are Linear, Rectangle, Disk, Cylinder and Sphere (default). (Soft sampled type only)

Length Specifies spacial dimension of shadow shape for the length of the shadow. (Soft sampled type only)

Width Specifies spacial dimension of shape for the width of the shadow. (Soft sampled type only)

Radius Specifies spacial radius dimension of the shape selection of disk, cylinder, or sphere. (Soft sampled type only)

See also:
Control Light Properties

Sun & Sky Properties

Sets the properties of the sun and sky.

List of Options

The following options are displayed.

Sun - Sun Angle
Source Vector Displays the coordinates of the direction of the sun. This setting is read-only.

Date and Time Displays the current date and time setting.

Longitude Displays the longitude of the current location. You can enter a value or select a location on the map. (LONGITUDE (page 1402) system variable)
The valid range is -180 to +180 as a floating point number.

Latitude Sets the latitude of the current location. You can enter a value or select a location on the map. (LATITUDE (page 1383) system variable)
The valid range is -90 and +90 as a floating point number.
**Daylight Saving** Displays the current setting for daylight saving time.

**Azimuth** Displays the angle of the sun along the horizon clockwise from due north. This setting is read-only.

**Altitude** Displays the angle of the sun vertically from the horizon. The maximum is 90 degrees, or directly overhead. This setting is read-only.

**Display Sun Light** Turns the sun on and off. If lighting is not enabled in the drawing, this setting has no effect.

**Intensity Factor** Sets the intensity or brightness of the sun. The range is from 0 (no light) to maximum. The higher the number, the brighter the light.

**Color** Controls the color of the light.

**Cast Shadows** Turns display and calculation of shadows for the sun on and off. Turning shadows off increases performance.

**Sun - Sun Disk Appearance**

**Disk Scale** Specifies the scale of the sun disk (1.0 = correct size).

**Glow Intensity** Specifies the intensity of the sun glow. Values are 0.0-25.0.

**Disk Intensity** Specifies the intensity of the sun disk. Values are 0.0-25.0.

**Sky**

**Display Sky** Determines if the sky illumination is computed at render time. This has no impact on the viewport illumination or the background. It simply makes the sky available as a gathered light source for rendering. Note this does not control the background.

**Intensity Factor** Provides a way to magnify the effect of the skylight. Values are 0.0-MAX. [1.0] is default.

**Haze** Determines the magnitude of scattering effects in the atmosphere. Values are 0.0-15.0. [0.0] is default.

**Sky - Sky Horizon**

**Height** Determines the absolute position of the ground plane relative to world zero. This parameter represents a world-space length and should be formatted in the current length unit. Values are -10.0 to +10.0 [0.0] is default.

**Blur** Determines the amount of blurring between ground plane and sky. Values are 0-10. [.1] is default.

**Ground Color** Determines the color of the ground plane.

**Sky - Advanced Sky**

**Night Color** Specifies the color of the night sky.
Aerial Perspective  Specifies if aerial perspective is applied. Values are On/Off.

Visibility Distance  Specifies the distance at which 10% haze occlusion results. Values are 0.0-MAX.

Rendered Shadow Details
Type  Displays the setting for shadow type. This setting is read-only when display of shadows is turned off. The selections are Sharp, Soft (mapped) which display the Map size option and Soft (area) which displays the Samples option. Soft (area) is the only option for the sun in photometric workflow (LIGHTINGUNITS = 1 or 2).

Samples  Specifies the number of samples to take on the solar disk. This setting is read-only when display of shadows is turned off. Values are 0-1000.

Softness  Displays the setting for the appearance of the edges of shadows. This setting is read-only when display of shadows is turned off. Values are 1-10.

See also:
Sun and Sky Simulation

PROPERTIESCLOSE
Closes the Properties Inspector palette.

Summary
The Properties Inspector palette closes.

See also:
Display and Change the Properties of Objects

PSETUPIN
Imports a user-defined page setup into a new drawing layout.

Summary
The Select Page Setup From File dialog box (a standard file selection dialog box (page 723)) is displayed in which you can select the drawing (.dwg), template
(.dwt), or drawing interchange format (.dxf) file whose page setups you want to import.

If FILEDIA (page 1334) is set to 0 (zero) and you enter \texttt{-psetupin} at the Command prompt, PSETUPIN displays command prompts (page 856).

When you select the drawing file that you want to use, the Import Page Setups dialog box (page 763) is displayed.

See also:

Specify Page Setup Settings

\textbf{-PSETUPIN}

If you enter \texttt{-psetupin} at the Command prompt, the following prompts are displayed.

Enter file name: \textit{Enter the name of the drawing file that contains the pagesetup to import}

Enter user defined page setup to import or [?] : \textit{Enter the name of the page setup to import}

See also:

Specify Page Setup Settings

\textbf{PSPACE}

In a layout, switches from model space in a viewport to paper space.

\textbf{Summary}

The program switches from model space to paper space when you are working on a named (paper space) layout.
On the named layout, use paper space to create a finished layout of a drawing for printing. As part of designing your layout, you create layout viewports, which are windows containing different views of the model. By switching from paper space to model space (see MSPACE (page 676)), you can edit the model and views within the current layout viewport.

You can make a viewport current by double-clicking inside it. You can switch to paper space by double-clicking an area of the paper space layout that is not within a viewport.

You can also switch between layouts by using the Layouts drop-down list or QuickView on the status bar.

See also:
- Work in Model Space
- Work on a Named Layout

**PUBLISH**

Publishes a set of drawings to PDF files or printers.

**Access Methods**

Menu: File ➤ Batch Publish

**Summary**

The Batch Publish dialog box (page 857) is displayed. You can assemble a collection of drawings, and create a PDF file or hardcopy of the selected drawings. PDF files can be viewed with a PDF viewer.

See also:
- Overview of Publishing

**Batch Publish Dialog Box**

Specifies drawing sheets that you can assemble, reorder, and publish as a multi-sheet drawing set.
Summary

You can publish the drawing set to a PDF file or send it to the printer named in the page setup for hardcopy output.

List of Options

The following options are displayed.

**Publish To:**
Defines how to layouts should be published. You can publish to either a PDF file (an electronic drawing set) or to the printer specified in the page setup (a paper drawing set).

**PDF** Indicates that the layouts should be published to a PDF file.

**Printer from Page Setup** Indicates that the output device given for each layout's page setup will be used.

**Preview**
Displays a preview of the selected layout in the Sheet list. Click the Next and Previous buttons to preview another layout in the Sheet list.
Sheet List
Contains the list of drawing sheets to be included for publishing. Click the page setup column to change the sheet’s settings. Use the shortcut menu to add sheets or make other changes to the list.

Sheet Name Combines the drawing name and the layout name with a dash (-). Drawing sheet names must be unique within a single PDF file.

Page Setup Displays the named page setup for the sheet. You can change the page setup by clicking the page setup name and selecting another page setup from the list. Only Model page setups can be applied to Model sheets, and only named layout page setups can be applied to named layout sheets.

Status Displays the status of the sheet when it is loaded to the list of sheets.

Manage Sheet List
Adds and removes layouts from the Sheet list.

Add Sheets (+) Displays the Select Drawings dialog box (a standard file selection dialog box (page 723)), in which you can select drawings to add to the list of sheets. The layout names from those files are extracted, and one sheet is added to the list for each Model and named layout in the drawing. You can use the Add Content list to specify to extract the Model layout only, named layouts only, or both.

The initial sheet names are constructed from the base drawing name and the layout name or the word Model separated by a dash (-).

Remove Sheets (-)
Deletes the selected sheets from the list.

Add Open Drawings
Adds the Model layout and all named layouts from the drawings that are currently open.

Sheet List Shortcut Menu
The following options are available when you right-click a sheet:

Move to Top Moves the selected sheets to the top of the list.
Move Up Moves the selected sheets up one position in the list.
Move Down Moves the selected sheets down one position in the list.
Move to Bottom Moves the selected sheets to the bottom of the list.
Sheet Details
Displays the following information about the selected sheet: status, source
drawing, drawing location, layout name, plot device, plot size, plot scale, and
page setup details.

Printer from Page Setup Options
The following options are specific to publishing to a printer.

Number of Copies Specifies the number of copies to publish.

Include Plot Stamp Places a plot stamp on a specified corner of each drawing
and logs it to a file. Click Configure Plot Stamp to display the Plot Stamp
Settings dialog box (page 812), and specify the content and look of the plot
stamp.

PDF Options
The following options are specific to publishing to a PDF file.

Show/Hide Advanced Options
Displays additional options that are available when publishing to PDF files.

Location
Specifies the location to save the PDF file to and display the PDF when
publishing is complete.

Use Predefined Save Location Specify the default location to save the PDF
files to. When publishing to a single PDF file, you can specify the location of
the file after clicking Publish as well.

Open when Complete When publishing completes, the PDF file will open
in a viewer application.

Output Options
Specifies how the layouts should be output for PDF files and if a plot stamp
is included on each layout.

Create a Single PDF A multi-sheet PDF file is created that contains all the
layouts in the Sheet list.

Create individual PDFs per Layout A single PDF file is created for each layout
in the Sheet list.

Include Plot Stamp Places a plot stamp on a specified corner of each drawing
and logs it to a file. Click Configure Plot Stamp to display the Plot Stamp
Settings dialog box (page 812), and specify the content and look of the plot
stamp.
**Publish**

Starts the publishing operation.

To display information about the published sheets, including any errors or warnings, click the Plotting Details Report message balloon to display the Print Details dialog box (page 1141). This information is also saved to the Plot and Publish log file.

See also:

- Overview of Publishing

---

**PURGE**

Removes unused items, such as block definitions and layers, from the drawing.

**Summary**

Entering `purge` or `-purge` at the Command prompt displays options related to removing unused named objects and some empty geometric objects (page 861).

Unused named objects can be removed from the current drawing. These include block definitions, dimension styles, groups, layers, linetypes, and text styles. Zero-length geometry and empty text objects can also be removed.

**NOTE** The PURGE command will not remove unnamed objects (zero-length geometry or empty text and mtext objects) from blocks or locked layers.

See also:

- Erase Objects

---

**-PURGE**

Removes unused named objects, such as block definitions and layers, from the drawing at the Command prompt.
**Summary**

Allows you to remove unused named objects from a drawing at the Command prompt. You can only remove one level of reference at a time. Repeat the command until there are no unreferenced, named objects.

**NOTE** The PURGE command will not remove unnamed objects (zero-length geometry or empty text and mtext objects) from blocks or locked layers.

**List of Prompts**

The following prompts are displayed.

**Type of Unused Objects to Purge**

Deletes unused applications from blocks, dimension styles, groups, layers, linetypes, materials, multileader styles, plot styles, shapes, text styles, multiline styles, table styles, visual styles, regapps, zero-length geometry, empty text objects, or all.

**Enter Name(s) to Purge** Enter an object name of * to list the objects.

**Verify Each Name to Be Purged?** Enter y to verify each name.

**See also:**

Erase Objects

**PYRAMID**

Creates a 3D solid pyramid.

**Access Methods**

- **Button**
  - **Toolbar:** Modeling tool set ➤ Solids - Create tool group ➤ Solid Primitives flyout ➤ Pyramid
  - **Menu:** Draw ➤ 3D Modeling ➤ Pyramid
Summary

By default, a pyramid is defined by the center of the base point, a point on the middle of the edge, and another point that determines the height.

Initially, the default base radius is not set to any value. During a drawing session, the default value for the base radius is always the previously entered base radius value for any solid primitive.

Use the Top Radius option to create a pyramid frustum.

List of Prompts

The following prompts are displayed.

**Edge** Specifies the length of one edge of the base of the pyramid; you pick two points.
Specify first endpoint of edge: *Specify a point*
Specify second endpoint of edge: *Specify a point*

**Sides** Specifies the number of sides for the pyramid. You can enter a number from 3 to 32.
Specify number of sides <default>: *Specify a diameter or press Enter to specify the default value*

Initially, the number of sides for the pyramid is set to 4. During a drawing session, the default value for the number of sides is always the previously entered value for the number of sides.

**Inscribed** Specifies that the base of the pyramid is inscribed within (drawn within) the base radius of the pyramid.

**Circumscribed** Specifies that the pyramid is circumscribed around (drawn around) the base radius of the pyramid.
2Point Specifies that the height of the pyramid is the distance between two specified points.
Specify first point: Specify a point
Specify second point: Specify a point

Axis Endpoint Specifies the endpoint location for the pyramid axis. This endpoint is the top of the pyramid. The axis endpoint can be located anywhere in 3D space. The axis endpoint defines the length and orientation of the pyramid.
Specify axis endpoint: Specify a point

Top Radius Specifies the top radius of the pyramid, creating a pyramid frustum.
Specify top radius: Enter a value
Initially, the default top radius is not set to any value. During a drawing session, the default value for the top radius is always the previously entered top radius value for any solid primitive.
Specify height or [2Point (Two Points)/Axis Endpoint] <default>: Specify a height, enter an option, or press Enter to specify the default height value
- 2Point. Specifies that the height of the pyramid is the distance between two specified points.
  Specify first point: Specify a point
  Specify second point: Specify a point
- Axis Endpoint. Specifies the endpoint location for the pyramid axis. This endpoint is the top of the pyramid. The axis endpoint can be located anywhere in 3D space. The axis endpoint defines the length and orientation of the pyramid.
  Specify axis endpoint: Specify a point

See also:
Create a Solid Pyramid

Q Commands

QDIM

Creates a series of dimensions quickly from selected objects.
Access Methods

Button

Toolbar: Annotation tool set ➤ Dimensions tool group ➤ Quick Dimension

Menu: Dimension ➤ Quick Dimension

Summary

This command is particularly useful for creating a series of baseline or continued dimensions, or for dimensioning a series of circles and arcs.

List of Prompts

The following prompts are displayed.
Select geometry to dimension: Select the objects you want to dimension or the dimensions you want to edit and press Enter
Specify dimension line position, or [Continuous (page 865)/Staggered (page 865)/Baseline (page 865)/Ordinate (page 865)/Radius (page 865)/Diameter (page 865)/datumPoint (page 865)/Edit (page 865)/settings (page 865)] <current>: Enter an option or press Enter

Continuous Creates a series of continued dimensions.

Staggered Creates a series of staggered dimensions.

Baseline Creates a series of baseline dimensions.

Ordinate Creates a series of ordinate dimensions.

Radius Creates a series of radial dimensions.

Diameter Creates a series of diameter dimensions.

Datum Point Sets a new datum point for baseline and ordinate dimensions.

Edit Edits a series of dimensions. You are prompted to add or remove points from existing dimensions.

Settings Sets the default object snap for specifying extension line origins.
See also:
Overview of Dimensioning

QLEADER

Creates a leader and leader annotation.

Summary

It is recommended that you use the workflow available through the MLEADER (page 654) command to create leader objects.

You can use QLEADER to
■ Specify leader annotation and annotation format
■ Set the location where leaders attach to multiline text annotation
■ Limit the number of leader points
■ Constrain the angle of the first and second leader segments

You can use the Leader Settings dialog box (page 867) to customize the command so that it prompts you for the number of leader points and the annotation type suited to your drawing needs.

If associative dimensioning is turned on with DIMASSOC, the leader start point can be associated with a location on an object. If the object is relocated, the arrowhead remains attached to the object and the leader line stretches, but the text or feature control frame remains in place.

List of Prompts

The following prompts are displayed.
Specify first leader point, or [Settings] <Settings>: Specify the first leader point, or press Enter to specify leader settings

First Leader Point
The Number of Points setting on the Leader Line & Arrow tab of the Leader Settings dialog box (page 867) determines the number of leader points you are prompted to specify.

Width If you set the text width value to 0.00, the width of the multiline text is unlimited.
Tolerance  If Tolerance is selected on the Annotation tab, the Geometric Tolerance dialog box (page 1092) is displayed. Use the dialog box to create the tolerance feature control frame.

Enter block name or [?]: Enter the name, or enter ? to display a list of blocks defined in the drawing

Insertion Point  For a description of the insertion options, see INSERT Command Line (page 525).

Settings  Displays the Leader Settings dialog box (page 867).

See also:
- Create Leaders
- Modify Leaders Using Grips

Leader Settings Dialog Box

Creates a leader and leader annotation.

Summary

Customizes the QLEADER command and sets properties for leaders and leader annotations.

The Leader Settings dialog box includes the following tabs: Annotation (page 868), Leader Line & Arrow (page 869), Attachment (page 870)

List of Tabs

The following tabs are displayed.
Annotation Tab (Leader Settings Dialog Box)

Annotation Type
Sets the leader annotation type. The type you select changes the QLEADER leader annotation prompt.

MText
Prompts you to create multiline text (mtext) annotation.

Copy an Object
Prompts you to copy a multiline text, single-line text, tolerance, or block reference object and connects the copy to the end of the leader line. The copy is associated with the leader line, meaning that if the copied object moves, the end of the leader line moves with it. The display of the hook line depends on the object copied.

Tolerance
Displays the Tolerance dialog box, which you can use to create a feature control frame to attach to the leader.

Block Reference
Prompts you to insert a block reference. The block reference is inserted at an offset from the end of the leader line and is associated to the leader line, meaning that if the block moves, the end of the leader line moves with it. No hook line is displayed.

None
Creates a leader with no annotation.
**MText Options**
The options are available only when the multiline text annotation type is selected.

**Prompt for Width**
Prompts you to specify the width of the multiline text annotation.

**Always Left Justify**
Left-justifies the multiline text annotation, regardless of leader location.

**Frame Text**
Places a frame around multiline text annotation.

**Annotation Reuse**
Sets options for reusing leader annotation.

**None**
Does not reuse leader annotation.

**Reuse Next**
Reuses the next annotation you create for all subsequent leaders.

**Reuse Current**
Reuses current annotation. This option is automatically selected when you reuse annotation after selecting Reuse Next.

**Leader Line & Arrow Tab (Leader Settings Dialog Box)**
**Leader Line**
Sets the leader line format.

**Straight**
Creates straight-line segments between the points you specify.

**Spline**
Creates a spline object using the leader points you specify as control points.

**Arrowhead**
Defines the leader arrowhead. The arrowheads are also available for dimension lines (DIMSTYLE (page 319) command). If you select User Arrow, a list of blocks in the drawing is displayed.

**Number of Points**
Sets the number of leader points that QLEADER prompts you to specify before prompting for the leader annotation. For example, if you set the points to 3, QLEADER automatically prompts you to specify the annotation after you specify two leader points. Set the number to one more than the number of leader segments you want to create.

If you set the option to No Limit, QLEADER prompts for leader points until you press Enter.

**Angle Constraints**
Sets angle constraints for the first and second leader lines.

**First Segment**
Sets the angle of the first leader segment.

**Second Segment**
Sets the angle of the second leader segment.

**Attachment Tab (Leader Settings Dialog Box)**
Sets the attachment location for leader lines and multiline text annotation. This tab is available only when Mtext is selected on the Annotation tab.
Top of Top Line
Attaches the leader line at the top of the top multiline text line.

Middle of Top Line
Attaches the leader line at the middle of the top multiline text line.

Middle of Multiline Text
Attaches the leader line at the middle of the multiline text.

Middle of Bottom Line
Attaches the leader line at the middle of the bottom multiline text line.

Bottom of Bottom Line
Attaches the leader line at the bottom of the bottom multiline text line.

Underline Bottom Line
Underlines the bottom multiline text line.

See also:
Create Leaders
Modify Leaders Using Grips
QNEW

Starts a new drawing from a selected drawing template file.

Summary

QNEW creates a new drawing from the default drawing template file and folder path specified in Default Template File Name for QNEW in the Application section of the Application Preferences dialog box.

When a default drawing template file is set to *None* or is not specified, QNEW displays the Select Template File dialog box (a standard file selection dialog box (page 723)).

If the system variable, FILEDIA, is set to 0 instead of 1, a Command prompt (page 714) is displayed.

See also:

Use a Drawing Template File

QSAVE

Saves the current drawing using the specified default file format.

Access Methods

☐ Menu: File ➤ Save

Summary

If the drawing is named, the program saves the drawing and does not request a new file name. Use the SAVEAS (page 926) command if you need to save a drawing with a different name. If the drawing is read-only, use the SAVEAS command to save the changed file under a different name.

If the drawing is unnamed, the Save Drawing As dialog box (see SAVEAS (page 926)) is displayed and the drawing is saved with the file name and format you specify.

See also:

Save a Drawing
QTEXT

Controls the display and plotting of text and attribute objects.

Summary

When QTEXT (Quick Text) is on, each text and attribute object is displayed as a bounding box around the text object. Turning QTEXT mode on reduces the time it takes the program to redraw and regenerate drawings that contain many text objects.

See also:
Control the Display of Polygons, Hatches, Gradient Fills, Lineweights, and Text

QUICKVIEW

Displays a list of all open drawings, and the layouts contained in the current drawing or the selected drawing when more than one drawing is open.

Access

Button

- Toolbar: Status bar ➤ Show Drawings & Layouts
- Toolbar: Status bar ➤ Model/Layout drop-down ➤ Show Drawings & Layouts
- Command entry: Cmd-.

Summary

Displays the QuickView dialog box.
Drawing previews are displayed vertically along the left, while the layout previews of the selected drawing are displayed on the right. The preview for Model is always located in the top-left of the layout previews.

See also:

Switch Between Layouts in the Current Drawing

QuickView Dialog Box

Displays a list of all open drawings and the layouts in the current drawing.

List of Options

The following options are displayed.

**Drawing List**
Displays a list of all open drawings.

Double-clicking a thumbnail to set that drawing current. You can also right-click a thumbnail to display a shortcut menu of additional file management options. The following items are on the Drawing shortcut menu:

- **Save.** - Saves the drawing using its current name and location.
- **Close `<drawing>`**. Closes the drawing. You are prompted to save changes if the drawing has been changed since it was last saved.

- **Close All**. Closes all open drawings. You are prompted to save any drawings that have been changed before they are closed.

- **Duplicate**. Allows you to create a copy of the drawing. The Save Drawing As dialog box is displayed (see `SAVEAS` (page 926)).

- **Create New Layout**. Adds a new layout to the drawing. The Create/Duplicate Layout dialog box is displayed. Enter a name for the new layout.

**Layouts List**

Displays a list of all layouts in the current drawings.

Double-clicking a thumbnail switches to that layout. You can also right-click a thumbnail to display a shortcut menu of additional layout management options. The following items are on the Layout shortcut menu:

- **Rename**. Allows you to change the name of the layout. The Model layout cannot be renamed.

- **Duplicate**. Creates a copy of the selected layout. The Create/Duplicate Layout dialog box is displayed. Enter a name for the new layout.

- **Delete**. Removes the layout from the drawing.

- **Duplicate**. Allows you to create a copy of the drawing. The Save Drawing As dialog box is displayed (see `SAVEAS` (page 926)).

- **Create New Layout**. Adds a new layout to the drawing. The Create/Duplicate Layout dialog box is displayed. Enter a name for the new layout.

- **Print**. Allows you to output the layout to hardcopy or PDF. The Print dialog box (page 804) is displayed when a single layout is selected or the Batch Publish dialog box (page 857) is displayed when more than one layout is selected.

- **Edit Page Setup**. Allows you to modify the current page setup settings for the layout. The Page Setup dialog box (page 757) is displayed.

- **Page Setup Manager**. Allows you to manage the output settings for the layout. The Page Setup Manager (page 753) is displayed.

See also:

- Switch Between Layouts in the Current Drawing
QUIT

Exits the program.

Access Methods

Menu: AutoCAD ➤ Quit AutoCAD

Summary

Quits the program if there have been no changes since the drawing was last saved. If the drawing has been modified, you are prompted to save or discard the changes before quitting.

You can quit a file that has been opened in read-only mode if you have made no modifications or if you are willing to discard them. To save modifications to a read-only drawing, use the SAVEAS (page 926) command to save the drawing under another name.

See also:

Start a Drawing

R Commands

RAY

Creates a line that starts at a point and continues to infinity.

Access Methods

Button

Toolbar: Drafting tool set ➤ Open Shapes tool group (expanded) ➤ Ray
Menu: Draw ➤ Ray
Summary

The ray is extended to the edge of the display in the direction defined by the starting point and the through point. The prompt for a through point is redisplayed so you can create multiple rays. Press Enter to end the command.

Lines that extend to infinity in one direction, known as rays, can be used as references for creating other objects.

List of Prompts

The following prompts are displayed.
Specify start point: Specify a point (1)
Specify through point: Specify a point for the ray to pass through (2)

See also:
   Draw Construction Lines (and Rays)

RECOVER

Repairs and then opens a damaged drawing file.
Summary

The program extracts as much material as it can from the damaged file. Files that can be recovered include DWG and DWT files. Performing a recover on a DXF file will only open the file.

In the Select File dialog box (a standard file selection dialog box (page 723)), enter the drawing file name or select the damaged drawing file. Results are displayed in the text window.

When FILEDIA (page 1334) is set to 0 (zero), RECOVER displays the following command prompt.

Enter ~ (tilde) at the prompt to ignore FILEDIA and display the Select File dialog box.

See also:

   Repair a Damaged Drawing File

RECTANG

Creates a rectangular polyline.

Access Methods

<table>
<thead>
<tr>
<th>Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbar: Drafting tool set ➤ Closed Shapes tool group ➤ Rectangle</td>
</tr>
<tr>
<td>Menu: Draw ➤ Rectangle</td>
</tr>
</tbody>
</table>

Summary

With this command, you can specify the rectangle parameters (length, width, rotation) and control the type of corners (fillet, chamfer, or square).
List of Prompts

The following prompts are displayed.
Current settings: Rotation = 0
Specify first corner point (page 879) or [Chamfer (page 879)/Elevation (page 879)/Fillet (page 879)/Thickness (page 880)/Width (page 880)]: Specify a point or enter an option

First Corner Point
Specifies a corner point of the rectangle.

Other Corner Point Creates a rectangle using the specified points as diagonally opposite corners.

Area Creates a rectangle using the area and either a length or a width. If the Chamfer or Fillet option is active, the area includes the effect of the chamfers or fillets on the corners of the rectangle.

Dimensions Creates a rectangle using length and width values.

Rotation Creates a rectangle at a specified rotation angle.

Chamfer
Sets the chamfer distances for the rectangle.

Elevation
Specifies the elevation of the rectangle.

Fillet
Specifies the fillet radius of the rectangle.
**Thickness**
Specifies the thickness of the rectangle.

**Width**
Specifies the polyline width of the rectangle to be drawn.

**See also:**
Draw Rectangles and Polygons

---

**REDEFINE**

Restores AutoCAD internal commands overridden by UNDEFINE.

**Summary**
If a command has been undefined, you can still use it if you precede the command name with a period. Enter the name of an AutoCAD command turned off by the UNDEFINE (page 1124) command.

**See also:**
Use Built-in Commands in Macros

---

**REDO**

Reverses the effects of previous UNDO or U command.

**Access Methods**

- **Menu:** Edit ➤ Redo
- **Shortcut menu:** With no command active and no objects selected, right-click in the drawing area and click Redo.
- **Command entry:** Cmd-Y

**Summary**
REDO reverses the effects of a single UNDO (page 1125) or U (page 1106) command. REDO must immediately follow the U or UNDO command.
See also:
  Correct Mistakes

REDRAW

Refreshes the display in the current viewport.

Access Methods

 Ramos Menu: View ➤ Redraw
 Gi Command entry: ‘redraw’ for transparent use

Summary

Removes temporary graphics left by some operations in the current viewport. To remove stray pixels, use the REGEN (page 889) command.

See also:
  Erase Objects

REDRAWALL

Refreshes the display in all viewports.

Access Methods

 Gi Command entry: ‘redrawall’ for transparent use

Summary

Removes temporary graphics left by some operations in all viewports. To remove stray pixels, use the REGENALL (page 889) command.

See also:
  Erase Objects
REFCLOSE

Saves back or discards changes made during in-place editing of a reference, either an xref or a block definition.

Access Methods

Toolbar: Reference Editor visor ➤ Save
Toolbar: Reference Editor visor ➤ Discard Changes

Summary

If you save or discard changes with REFCLOSE, you can still use the UNDO (page 1125) command to return to the reference editing session. If you have made unwanted changes to an xref and already saved back the changes, use UNDO to undo the unwanted changes; then use REFCLOSE to save back changes and restore the xref to its original state.

NOTE When you edit and save xrefs in place in a drawing, the preview image for the original reference drawing is no longer available unless you open and save the drawing again.

List of Prompts

The following prompts are displayed.

Enter option [Save/Discard reference changes] <Save>:

Save Saves back to the xref source drawing or to the block definition in the current drawing all changes made to objects in the working set. If you remove an object from the working set and save changes, the object is deleted from the reference and added to the current drawing.

NOTE If the file format of the xref source drawing is AutoCAD Release 14 or earlier, the file is saved in AutoCAD 2010 file format. The file format is not changed for xref source drawings in AutoCAD 2000 or later formats.

Discard Reference Changes Discards the working set; the source drawing or block definition is returned to its original state. Any changes you make to objects in the current drawing (not in the xref or block) are not discarded. If you delete any object that is not in the working set, the object is not restored even if you choose to discard changes.
See also:

Save Back Edited Referenced Drawings and Blocks

**REFEDIT**

Edits an xref or a block definition directly within the current drawing.

**Access Methods**

- **Button**
- **Menu**: Tools ➤ Edit Xref In-place
- **Toolbar**: External Reference visor ➤ Edit Reference in Place

**Summary**

The objects that you select from the selected xref or block are temporarily extracted and made available for editing in the current drawing. The set of extracted objects is called the working set, which can be modified and then saved back to update the xref or block definition.

**List of Prompts**

The following prompts are displayed.

*Select reference: Select an xref or a block in the current drawing*

The Reference Edit dialog box (page 884) is displayed. After the xref or block definition is opened for edit in the in-place editor, the Reference Editor visor (page 883) is displayed.

If you enter `-refedit` at the Command prompt, options are displayed (page 887).

See also:

Edit Selected Objects in Referenced Drawings and Blocks

**Reference Editor Visor**

Manages the working set of objects that are edited in a reference.
List of Options

The following options are displayed.

**Add to Working Set**
Adds objects to the current working set while editing an xref or a block definition in-place. *(REFSET (page 888) command)*

**Remove From Working Set**
Removes objects from the current working set while editing an xref or a block definition in-place. *(REFSET (page 888) command)*

**Discard Changes**
Discards the changes made to an xref or a block definition. *(REFCLOSE (page 882) command)*

**Save**
Saves back the changes made to an xref or a block definition. *(REFCLOSE (page 882) command)*

See also:
- Edit Selected Objects in Referenced Drawings and Blocks

**Reference Edit Dialog Box**

Specifies the reference to edit.

**Summary**

To select a reference to edit, select an object in the reference. If you select an object that is part of one or more nested references, the nested references are displayed in the dialog box.
List of Options

The following options are displayed.

Select a Reference to Edit

Displays the reference selected for in-place editing and any references nested within the selected reference. Nested references are displayed only if the selected object is part of a nested reference. If multiple references are displayed, choose a specific xref or block to modify. Only one reference can be edited in place at a time.

Preview

Displays a preview image of the currently selected reference. The preview image displays the reference as it was last saved in the drawing. The reference preview image is not updated when changes are saved back to the reference.
**Path**
Displays the file location of the selected reference. If the selected reference is a block, no path is displayed.

**Nested Objects**
Specifies how the selection of nested objects should be handled.

**Automatically Select All Nested Objects**
Controls whether nested objects are included automatically in the reference editing session.
If this option is checked, all the objects in the selected reference will be automatically included in the reference editing session.

**Prompt to Select Nested Objects**
Controls whether nested objects must be selected individually in the reference editing session.
If this option is checked, after you close the Reference Edit dialog box and enter the reference edit state, you are prompted to select the specific objects in the reference that you want to edit.

Select nested objects: *Select objects within the reference that you want to edit*

**Settings**
Provides options for editing references.

**Create Unique Layer, Style, and Block Names**
Controls whether layers and other named objects extracted from the reference are uniquely altered.
If selected, named objects in xrefs are altered (names are prefixed with $#$), similar to the way they are altered when you bind xrefs. If cleared, the names of layers and other named objects remain the same as in the reference drawing. Named objects that are not altered to make them unique assume the properties of those in the current host drawing that share the same name.

**Display Attribute Definitions for Editing**
Controls whether all variable attribute definitions in block references are extracted and displayed during reference editing.
If Display Attribute Definitions for Editing is selected, the attributes (except constant attributes) are made invisible, and the attribute definitions are available for editing along with the selected reference geometry. When changes are saved back to the block reference, the attributes of the original reference remain unchanged. The new or altered attribute definitions affect only subsequent insertions of the block; the attributes in existing block instances are not affected. Xrefs and block references without definitions are not affected by this option.
Lock Objects Not in Working Set
Locks all objects not in the working set. This prevents you from accidentally selecting and editing objects in the host drawing while in a reference editing state.
The behavior of locked objects is similar to objects on a locked layer. If you try to edit locked objects, they are filtered from the selection set.

See also:
Edit Selected Objects in Referenced Drawings and Blocks

-REFEDIT
Edits an xref or a block definition directly within the current drawing.

List of Prompts
The following prompts are displayed.
Select reference: Select an xref or block in the current drawing
Select nesting level [OK/Next] <Next>: Enter an option or press Enter

OK
Accepts the currently highlighted reference for in-place reference editing.

If you are editing a block reference with attributes, you can enter y to display the attribute definitions and make them available for editing. The attributes are made invisible, and the attribute definitions are available for editing along with the selected reference geometry. When changes are saved back to the block reference, the attributes of the original reference remain unchanged. The new or altered attribute definitions affect only subsequent insertions of the block; the attributes in existing block instances are not affected.

All Objects in the selected reference will be automatically included in the reference editing session.

Nested After you close the Reference Edit dialog box and enter the reference edit state, you are prompted to select the specific objects in the reference that you want to edit.

Next Advances through the reference and nested references available for selection. The currently selected reference is highlighted.
A working set is formed with the objects you have selected for editing. The working set includes objects that can be saved back to update the xref or block definition. When you save back changes, changes made to the objects in the reference file are saved without actually opening the reference drawing or recreating the block. The working set is visually distinct from the rest of the current drawing: all objects in the current drawing, except objects in the working set, appear faded. The XFADECTL (page 1574) system variable controls the fading of objects while you edit a reference in place.

You can select objects in xrefs for editing even if they are on a locked layer in the reference file. When a reference object is part of the working set, you can unlock the object’s layer and make changes to the object. Only the changes made to the object are saved back to the reference file; the xref layer remains locked in the reference file.

NOTE

Objects outside of the working set are not faded unless the visual style is set to 2D Wireframe during in-place reference editing.

See also:

Edit Selected Objects in Referenced Drawings and Blocks

REFSET

Adds or removes objects from a working set during in-place editing of a reference, either an xref or a block definition.

Access Methods

- **Toolbar:** Reference Editor visor ➤ Add to Working Set
- **Toolbar:** Reference Editor visor ➤ Remove from Working Set

Summary

Objects that are part of the working set are visually distinct from other objects in the current drawing. All objects in the current drawing, except objects in the working set, appear faded.

List of Prompts

The following prompts are displayed.
Transfer objects between the Refedit working set and host drawing...
Enter an option [Add (page 889)/Remove (page 889)] <Add>: Enter

Add ➔ Adds objects to the working set.
An object that is part of the working set is added to the reference when changes are saved back, and the object is removed from the current drawing.

Remove ➔ Removes objects from the working set.
An object that is removed from the working set is removed from the reference when changes are saved back; the object is also removed from the current drawing.

See also:
  Use the Working Set to Edit Referenced Drawings and Blocks

**REGEN**

Regenerates the entire drawing from the current viewport.

**Access Methods**

![Menu: View ➔ Regen](image)

**Summary**

REGEN regenerates the entire drawing and recomputes the screen coordinates for all objects in the current viewport. It also reindexes the drawing database for optimum display and object selection performance.

See also:
  Control the Display of Polylines, Hatches, Gradient Fills, Lineweights, and Text

**REGENALL**

Regenerates the drawing and refreshes all viewports.
**Access Methods**

Menu: View ➤ Regen All

**Summary**

REGENALL regenerates the entire drawing and recomputes the screen coordinates for all objects in all viewports. It also reindexes the drawing database for optimum display and object selection performance.

**See also:**
- Control the Display of Polylines, Hatches, Gradient Fills, Lineweights, and Text

**REGENAUTO**

Controls automatic regeneration of a drawing.

**Access Methods**

Command entry: ‘regenauto’ for transparent use

**List of Prompts**

The following prompts are displayed.

Enter mode [ON (page 890)/OFF (page 890)] <current>: Enter on or off, or press Enter

- **On** Regenerates the drawing immediately if any suppressed regenerations exist in the queue and continues to regenerate automatically whenever you perform an action that requires regeneration.

- **Off** Inhibits regeneration of the drawing until you use the REGEN (page 889) or REGENALL (page 889) command, or set REGENAUTO to on.

If you perform an action that requires a regeneration and that action is irrevocable (such as thawing layers), the following message is displayed:

Regen queued

If you perform an action that requires a regeneration and that action is revocable, the following message is displayed:

About to regen—proceed?
If you click OK, the drawing is regenerated. If you click Cancel, the last action is cancelled and the drawing is not regenerated.

See also:
Control the Display of Polylines, Hatches, Gradient Fills, Lineweights, and Text

REGION

Converts an object that encloses an area into a region object.

Access Methods

Button

Toolbar: Drafting tool set ➤ Closed Shapes tool group (expanded) ➤ Region
Menu: Draw ➤ Region

Summary

Regions are two-dimensional areas you create from closed shapes or loops. Closed polylines, lines, and curves are valid selections. Curves include circular arcs, circles, elliptical arcs, ellipses, and splines.

You can combine several regions into a single, complex region.

Closed 2D and exploded planar 3D polylines in the selection set are converted to separate regions and then converts polylines, lines, and curves to form
closed planar loops (outer boundaries and holes of a region). If more than two
curves share an endpoint, the resulting region might be arbitrary.

The boundary of the region consists of end-connected curves where each point
shares only two edges. All intersections and self-intersecting curves are rejected.

If a selected polyline has been smoothed by either the Spline or Fit option of
PEDIT (page 779), the resulting region contains the line or arc geometry of the
smoothed polyline. The polyline is not converted to a spline object.

REGION deletes the original objects after converting them to regions unless
the system variable DELOBJ (page 1251) is set to 0. If the original objects were
hatched, hatch associativity is lost. To restore associativity, rehatch the region.

See also:
  Create and Combine Areas (Regions)

RENAMEn

Changes the names assigned to items such as layers and dimension styles.

Access Methods

Menu: Format ➤ Rename

Summary

Named objects are categories of items such as layers, dimension styles, table
styles, text styles, and so on. It is strongly recommended that you create
standard naming conventions for them and save them in drawing template
files.

The Rename dialog box (page 893) is displayed.

If you enter -rename at the Command prompt, options are displayed (page
893).

See also:
  Resolve Name Conflicts in External References
Rename Dialog Box

Changes the names assigned to named objects such as layers and dimension styles.

![Rename Dialog Box](image)

List of Options

The following options are displayed.

**Named Objects**
Lists named objects in a drawing by category.

**Items**
Displays items of the type specified in Named Objects.

See also:
Resolve Name Conflicts in External References

-RENAME

Changes the names assigned to named objects from the Command prompt.

List of Prompts

The following prompts are displayed.
Enter object type to rename

Enter a named object type to rename an object
Enter old object name: Enter the old name
Enter new object name: Enter the new name

See also:
Resolve Name Conflicts in External References

RENDER

Creates a photorealistic or realistically shaded image of a 3D solid or surface model.

Access Methods

Button

Toolbar: Modeling tool set ➤ Render tool group ➤ Render
Menu: View ➤ Render ➤ Render

Summary

The RENDER command begins the rendering process and displays the rendered image in the Render Window (page 895).
By default, all objects in the current view in the drawing are rendered. If a named view is not specified, the current view is rendered.

If you enter `-render` at the Command prompt, options are displayed (page 902).

See also:
   Render 3D Objects for Realism

**Render Window**

Displays rendered output of the current model
Summary

From the Render Window, you can
- Save the image to a file.
- Monitor the progress of the current rendering.

List of Options

The following options are displayed.

**Image Pane**
Primary output target of the renderer.

**Progress Meter**
Displays the overall progress of the current rendering.

Clicking the X icon next to the progress meter, or by pressing Esc to cancel the current rendering.

**Save**
Displays the Render Output File dialog box (page 897) where you can save the image to disk.
Render Output File Dialog Box

Saves a rendering to a raster image file.

Summary

The Render Output File dialog box is a standard file selection dialog boxes (page 723). You specify the file name of the image you want to save and the output file format. In this dialog box, you can only choose from raster image output file formats.

The file formats for saving your rendered images to include the following:

List of Options

The following options are displayed.

BMP (*.bmp) BMP files are still-image bitmap files in the Windows bitmap (.bmp) format.
Clicking Save after choosing this format displays the BMP Image Options dialog box (page 898).

PCX (*.pcx) PCX files are relatively simple files that provide minimum compression using run length encoding (RLE).
Clicking Save after choosing this format displays the PCX Image Options dialog box (page 899).

TGA (*.tga) The Targa (TGA) format supports up to 32-bit true color. This format is typically used as a true color format to render still images.
Clicking Save after choosing this format displays the Targa Image Options dialog box (page 899).

TIF (*.tif) TIF (Tagged Image File) format is a multiplatform bitmap format. TIF is a common choice if you plan to send your output to a print service bureau or import the image into a page-layout program.
Clicking Save after choosing this format displays the TIFF Image Options dialog box (page 900).

JPEG (*.jpg) JPEG (.jpeg or .jpg) files follow the standards set by the Joint Photography Experts Group. These files use a variable compression method...
that is called lossy compression because of the loss of image quality as you increase the compression. However, the JPEG compression scheme is extremely good and you can sometimes compress the file up to 200:1 without severe loss of image quality. JPEG is consequently a popular format for posting image files on the Internet for minimum file size and minimum download time.

Clicking Save after choosing this format displays the JPEG Image Options dialog box (page 901).

**PNG (\*.png)** PNG (Portable Network Graphics) is a still-image file format developed for use with the Internet and World Wide Web. PNG is a format that generates a compressed image without any loss of quality, unlike the loss of quality found in JPEG files.

Clicking Save after choosing this format displays the PNG Image Options dialog box (page 901).

**See also:**

- Save a Rendered Image

---

**BMP Image Options Dialog Box**

Options used when saving a rendering to a BMP image file.

**Summary**

When BMP is chosen as the output format, the BMP Image Options dialog box is displayed.

**List of Options**

The following options are displayed.

**Color**

- **Monochrome** Creates a 2-bit black and white image.

- **8 Bits (256 Grayscale)** Creates an 8-bit grayscale image using 256 shades of gray.

- **8 Bits (256 Colors)** Renders a smaller, 8-bit color image from a palette of 256 colors.

- **24 Bits (16.7 Million Colors)** Renders a larger, true color (24-bit) file.
PCX Image Options Dialog Box

Options used when saving a rendering to a PCX image file.

Summary

When PCX is chosen as the output format, the PCX Image Options dialog box is displayed.

List of Options

The following options are displayed.

Color

Monochrome Creates a 2-bit black and white image.

8 Bits (256 Grayscale) Creates an 8-bit grayscale image using 256 shades of gray.

8 Bits (256 Colors) Renders a smaller, 8-bit color image from a palette of 256 colors.

See also:

Save a Rendered Image

Targa Image Options Dialog Box

Options used when saving a rendering to a TGA image file.

Summary

When TGA is chosen as the output format, the Targa Image Options dialog box is displayed.

List of Options

The following options are displayed.
**Color**

8 Bits (256 Grayscale) Creates an 8-bit grayscale image using 256 shades of gray.

8 Bits (256 Colors) Renders a smaller, 8-bit color image from a palette of 256 colors.

24 Bits (16.7 Million Colors) Creates a 24 bit color image that uses a 16.7 million color palette.

32 Bits (24 Bits + Alpha) Creates a 24 bit color image that includes an 8 bit alpha channel. Alpha is a type of data, found in 32-bit image files, that assigns transparency to the pixels in the image.

**Bottom Up**

Saves the image from bottom to top.

**See also:**

Save a Rendered Image

---

**TIFF Image Options Dialog Box**

Options used when saving a rendering to a TIFF image file.

**Summary**

When TIF is chosen as the output format, the TIFF Image Options dialog box is displayed.

**List of Options**

The following options are displayed.

**Color**

Monochrome Creates a 2-bit black and white image.

8 Bits (256 Grayscale) Creates an 8-bit grayscale image using 256 shades of gray.

8 Bits (256 Colors) Renders a smaller, 8-bit color image from a palette of 256 colors.

24 Bits (16.7 Million Colors) Creates a 24 bit color image that uses a 16.7 million color palette.
32 Bits (24 Bits + Alpha) Creates a 24 bit color image that includes an 8 bit alpha channel. Alpha is a type of data, found in 32-bit image files, that assigns transparency to the pixels in the image.

**Compressed**
Applies lossless compression to the file.

**Dots Per Inch**
Sets the dots per inch (dpi) for the saved image. This setting does not change the resolution of the final image, but can affect the way it prints in documents.

See also:
- Save a Rendered Image

### JPEG Image Options Dialog Box

Options used when saving a rendering to a JPEG image file.

**Summary**

When JPG is chosen as the output format, the JPEG Image Options dialog box is displayed.

**List of Options**

The following options are displayed.

**Image Control**

- **Quality** Sets the level of quality: the higher the quality, the larger the file size. In general, files compressed with the slider set to Best have compression ratios between 5:1 and 15:1.

- **File Size** Sets the size of file you want: the larger the file, the higher the quality.

See also:
- Save a Rendered Image

### PNG Image Options Dialog Box

Options used when saving a rendering to a PNG image file.
Summary

When PNG is chosen as the output format, the PNG Image Options dialog box is displayed.

List of Options

The following options are displayed.

**Color**

- **Monochrome** Creates a 2-bit black and white image.
- **8 Bits (256 Grayscale)** Creates an 8-bit grayscale image using 256 shades of gray.
- **8 Bits (256 Colors)** Renders a smaller, 8-bit color image from a palette of 256 colors.
- **16 Bits (65,536 Grayscale)** Creates a grayscale 16-bit image that uses 65,536 shades of gray.
- **24 Bits (16.7 Million Colors)** Creates a larger, true color (24-bit) file.
- **32 Bits (24 Bits + Alpha)** Creates a 24 bit color image that includes an 8 bit alpha channel. Alpha is a type of data, found in 32-bit image files, that assigns transparency to the pixels in the image.

**Progressive**

Provides faster display in Web browsers.

**Dots Per Inch**

Sets the dots per inch (dpi) for the saved image. This setting does not change the resolution of the final image, but can affect the way it prints in documents.

**See also:**

- Save a Rendered Image

**-RENDER**

Creates a photorealistic or realistically shaded image of a 3D solid or surface model from the Command prompt.

List of Prompts

The following prompts are displayed.
Specify render preset [Draft (page 903)/Low (page 903)/Medium (page 903)/High (page 904)/Presentation (page 904)/Other (page 904)] <Medium>: Enter an option or press Enter
Specify render destination [Render Window (page 904)/Viewport (page 904)] <Render Window>: Enter an option or press Enter

**Draft**

Draft is the lowest level standard render preset. This setting is intended for very fast, test renderings where anti-aliasing is bypassed and sample filtering is very low.

This render preset produces very low quality rendering, but results in the fastest rendering speed.

**Low**

The Low render preset provides better quality than the Draft preset. Anti-aliasing is bypassed but sample filtering is improved. Raytracing is also active, by default, so better quality shading occurs.

This preset is best used for test rendering that requires better quality than Draft.

**Medium**

You can expect much better sample filtering and anti-aliasing is active when you use the Medium render preset. Raytracing is active with increased reflection depth settings when compared to the Low render preset.

This preset offers a good balance between quality and render speed.
High

The High we preset matches the Medium preset settings with regards to anti-aliasing, but sample filtering and raytracing is improved. Due to the improved sample filtering and raytracing, rendered images take longer to process, but the image quality is much better.

Presentation

The Presentation render preset is used for high quality, photo-realistic rendered images and takes the longest to process. Sample filtering and raytracing is further improved. Since this preset is used for final renderings, global illumination settings are commonly used in conjunction.

Other

The Other option allows you to specify a custom render preset if one or more are present.

?—List Custom Render Presets Lists all the custom render presets that are stored with the model. Only custom render presets are listed.

Render Window

The image will be displayed in the render window when processing in complete.

Output Width/Height The output width and height values designate how wide and how tall the rendered image is going to be. Both values are measured in pixels.

Save rendering to a file You can save the image to one of the following file formats: BMP, TGA, TIF, PCX, JPG, or PNG. If you accept the default value of No, the Render Window is displayed and the image is rendered. Answering Yes results in another prompt:

Viewport

If you choose Viewport, anything that is currently displayed in the viewport gets rendered.
See also:

Render 3D Objects for Realism
Save a Rendered Image

**RENDERENVIRONMENT**

Controls visual cues for the apparent distance of objects.

**Access Methods**

- **Button**
  - Toolbar: Modeling tool set ➤ Render tool group ➤ Render Environment
  - Menu: View ➤ Render ➤ Render Environment

**Summary**

The *Render Environment dialog box* (page 905) is displayed.

See also:

Control the Rendering Environment

**Render Environment Dialog Box**

Defines the cues for distance between objects and the current viewing direction.
Summary

Fog and depth cueing are atmospheric effects that cause objects to appear to fade as they increase in distance from the camera. Fog uses a white color while depth cueing uses black.

List of Options

The following options are displayed.

**Fog and Depth Cue**

*Enable Fog* Turns fog on and off without affecting the other settings in the dialog box.

**Color** Specifies the color of the fog.

**Near Distance** Specifies the distance from the camera where the fog begins. It is specified as a percentage of the distance to the far clipping plane. The Near Distance setting cannot be greater than the Far Distance setting.

**Far Distance** Specifies the distance from the camera where the fog ends. It is specified as a percentage of the distance to the far clipping plane. The Far Distance setting cannot be less than the Near Distance setting.

**Near Fog Percentage** Specifies the opacity of the fog at the near distance.

**Far Fog Percentage** Specifies the opacity of the fog at the far distance.

See also:

- Control the Rendering Environment
RENDEROUTPUTSIZE

Specifies the image size to create when rendering a 3D model.

Summary

Displays the Output Size dialog box (page 907).

If you enter -renderoutputsize at the Command prompt, options are displayed (page 908).

See also:

Save a Rendered Image

Output Size Dialog Box

Sets the output image size when rendering a 3D model.

![Output Size Dialog Box](image)

List of Options

The following options are displayed.

Output Image Size (Pixels) List of commonly used output sizes. Choose Custom to specify the output width and height for the image.

Width (Pixels) Sets the width resolution of the output image, in pixels. The valid range for the width is 8 to 4096.

Height (Pixels) Sets the height resolution of the output image, in pixels. The valid range for the height is 8 to 4096.
**AspectRatio** Sets the aspect ratio, the ratio of width to height, of the rendered image.

Changing this value changes the Height value to maintain the correct dimensions for the active resolution. The image aspect value is always expressed as a multiplier value.

**Lock Aspect Ratio** Locks the aspect ratio when using a custom output resolution.

When it is locked, the Width and Height spinners are locked to each other; adjusting one alters the other to maintain the aspect-ratio value. When unlocked, changes to either Width or Height affects only the Aspect Ratio setting.

**NOTE** In viewports, the camera's frustum changes to reflect the image aspect ratio you set in the Output Size dialog box. This change takes place when you exit the dialog box.

**See also:**
- Save a Rendered Image

---

**-RENDEROUTPUTSIZE**

Specifies the image size to create when rendering a 3D model.

**List of Prompts**

The following prompts are displayed:

Enter render output width: *Enter a width and press Enter*

Enter render output height: *Enter a height and press Enter*

The valid range for the width and height is 8 to 4096.

**See also:**
- Save a Rendered Image

---

**RENDERWIN**

Displays the Render window without starting a rendering operation.
Access Methods

Button

_toolbar: Modeling tool set ➤ Render tool group (expanded) ➤ Show Render Window

Summary

The Render window (page 895) is displayed, but a rendering of the current drawing is not initiated.

If the drawing was previously rendered, you can view and save the rendered image.

See also:
- Basics of Rendering

RESETBLOCK

Resets one or more dynamic block references to the default values of the block definition.

Access Methods

Shortcut menu: Select a dynamic block reference in a drawing. Right-click in the drawing area and click Reset Block.

See also:
- Work with Dynamic Blocks in Drawings

RESETPALETTEs

Resets all palettes to their default placement settings.

Summary

Menu: Window ➤ Reset Palettes
Summary

The Reset Palettes message box is displayed. Resetting palettes closes and restarts AutoCAD.

List of Options

The following prompts are displayed.

**Reset Palettes** Closes and restarts AutoCAD. After AutoCAD restarts, the placement of all palettes is reset to their default settings.

See also:

Specify the Behavior of Palettes

RESUME

Continues an interrupted script.

Access Methods

Command entry: `resume` for transparent use

Summary

You can interrupt a macro script that is running by pressing Esc or Backspace. Any error encountered while processing input from a script file causes the script to be suspended. If a script is suspended while the program is active, you can use RESUME to continue the script.

See also:

Create Command Scripts

REV CLOUD

Creates a revision cloud using a polyline.
Access Methods

Button

🌿 Toolbar: Drafting tool set ➤ Closed Shapes tool group (expanded) ➤ Revision Cloud
🌿 Menu: Draw ➤ Revision Cloud

Summary

NOTE REV CLOUD stores the last used arc length in the system registry. This value is multiplied by DIMSCALE (page 1278) to provide consistency when the program is used with drawings that have different scale factors.

You can create a new revision cloud by dragging your cursor, or you can convert a closed object such as an ellipse or polyline into a revision cloud. Use revision clouds to highlight parts of a drawing that are being reviewed.

The resulting object is a polyline.
List of Prompts

The following prompts are displayed.
Minimum arc length: 0.5000 Maximum arc length: 0.5000
Specify start point or [Arc length/Object/Style] <Object>:

Drag to draw the revision cloud, enter an option, or press Enter

Arc Length Specifies the length of the arcs in a revision cloud.
The maximum arc length cannot be set to more than three times the minimum arc length.

Object Specifies an object to be converted to a revision cloud.

Style Specifies the style of the revision cloud.

See also:
Create Revision Clouds

REVERSE

Reverses the vertices of selected lines, polylines, splines, and helixes, which is useful for linetypes with included text, or wide polylines with differing beginning and ending widths.

Access Methods

Button

Toolbar: Drafting tool set ➤ Modify tool group (expanded) ➤ Reverse

Summary

Vertices of selected objects are reversed. Use the PLINEREVERSEWIDTHS (page 1436) system variable to control the direction of the polyline and appearance of polyline segments when reversed.

For example, when a linetype with text is specified with relative rotation in a LIN file, the text in the linetype might be displayed upside down. Reversing the vertices of the object changes the orientation of the text.
The REVERSE command does not change the orientation of text where rotation is specified as upright. For more information, see Text in Custom Linetypes.

See also:
   Modify Polylines

REVOLVE

Creates a 3D solid or surface by sweeping an object around an axis.

Access Methods

Button
   Toolbar: Modeling tool set ➤ Solids - Create tool group ➤ Solid Creation flyout ➤ Revolve
   Menu: Draw ➤ 3D Modeling ➤ Revolve

Summary

Open profiles create surfaces and closed profiles can create either a solid or a surface. The MOde option controls if a solid or surface is created. When creating a surface, SURFACEMODELINGMODE (page 1500) system variable controls if a procedural or NURBS surface is created.
Revolve path and profile curves can be:
- Open or closed
- Planar or non-planar
- Solid and surface edges
- A single object (to extrude multiple lines, convert them to a single object with the JOIN (page 536) command)
- A single region (to extrude multiple regions, convert them to a single object with the REGION (page 891) command)

To automatically delete the profile, use the DELOBJ (page 1251) system variable. If associativity (page 1498) is on, the DELOBJ system variable is ignored and the originating geometry is not deleted.

**Objects That Can Be Revolved**

<table>
<thead>
<tr>
<th>Surfaces</th>
<th>Elliptical arcs</th>
<th>2D solids</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solids</td>
<td>2D and 3D splines</td>
<td>Traces</td>
</tr>
<tr>
<td>Arcs</td>
<td>2D and 3D polylines</td>
<td>Ellipses</td>
</tr>
<tr>
<td>Circles</td>
<td>Regions</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE** Select face and edge subobjects by pressing Ctrl while you select them.

You cannot revolve objects contained within a block or objects that will self-intersect. REVOLVE ignores the width of a polyline and revolves from the center of the path of the polyline.

The right-hand rule determines the positive direction of rotation. For more information, see Understand the UCS in 3D.

**List of Prompts**

The following prompts are displayed.

**Objects to Revolve** Specifies the objects to be revolved about an axis.

**Mode** Controls whether the revolve action creates a solid or a surface. Surfaces are extended as either NURBS surfaces or procedural surfaces, depending on the SURFACEMODELINGMODE (page 1500) system variable.
**Axis Start Point** Specifies the first point of the axis of revolution. The positive axis direction is from the first to the second point.

**Axis Endpoint** Sets the endpoint for the axis of revolution.

**Start Angle** Specifies an offset for the revolution from the plane of the object being revolved.

Drag your cursor to specify and preview the start angle of the object.

**Angle of Revolution** Specifies how far the selected object revolves about the axis.

A positive angle revolves the objects in a counterclockwise direction. A negative angle revolves the objects in a clockwise direction. You can also drag the cursor to specify and preview the angle of revolution.

**Object** Specifies an existing object to be used as an axis. The positive axis direction is from the closest to the farthest endpoint of this object.

You can use lines, linear polyline segments, and linear edges of solids or surfaces as an axis.

**NOTE** Select an edge subobject by pressing Ctrl while you select an edge.

**X (Axis)** Sets the positive X axis of the current UCS as the positive axis direction.
Y (Axis) Sets the positive Y axis of the current UCS as the positive axis direction.

Z (Axis) Sets the positive Z axis of the current UCS as the positive axis direction.

Reverse Changes the direction of the revolve; similar to entering a - (minus) angle value. The revolved object on the right shows a spline revolved at the same angle as the object on the left, but using the reverse option.

Expression Enter a formula or equation to specify the revolve angle. See Constrain a Design with Formulas and Equations.

See also:
Create a Solid or Surface by Revolving
REVSURF

Creates a mesh by revolving a profile about an axis.

Access Methods

Menu: Draw ➤ 3D Modeling ➤ Meshes ➤ Revolved Meshes

Summary

Select a line, arc, circle, or 2D or 3D polyline to sweep in a circular path around a selected axis.

The MESHTYPE (page 1408) system variable sets which type of mesh is created. Mesh objects are created by default. Set the variable to 0 to create legacy polyface or polygon mesh.

The density of the generated mesh is controlled by the SURFTAB1 (page 1500) and SURFTAB2 (page 1500) system variables. SURFTAB1 specifies the number of tabulation lines that are drawn in the direction of revolution. If the path curve is a line, arc, circle, or spline-fit polyline, SURFTAB2 specifies the number of tabulation lines that are drawn to divide it into equal-sized intervals. If the path curve is a polyline that has not been spline fit, tabulation lines are drawn at the ends of straight segments, and each arc segment is divided into the number of intervals specified by SURFTAB2.
List of Prompts

The following prompts are displayed.

Current wire frame density: SURFTAB1=\textit{current} SURFTAB2=\textit{current}

Object to revolve Select a line, arc, circle, or 2D or 3D polyline.

Object that defines axis of revolution Select a line or open 2D or 3D polyline. The axis direction cannot be parallel to the plane of the original object.

The path curve is swept about the selected axis to define the mesh. The path curve defines the $N$ direction of the mesh. Selecting a circle or a closed polyline as the path curve closes the mesh in the $N$ direction.

The vector from the first to the last vertex of the polyline determines the rotation axis. Any intermediate vertices are ignored. The axis of revolution determines the $M$ direction of the mesh.

Start Angle If set to a nonzero value, starts the mesh of revolution at an offset from the generating path curve.

Specifying a start angle starts the mesh of revolution at an offset from the generating path curve.
**Included Angle** Specifies how far about the axis of revolution the mesh extends. The included angle is the distance through which the path curve is swept.

Entering an included angle that is less than a full circle prevents the circle from closing.

The point you use to select the axis of revolution affects the direction of revolution. The mesh in the following example was created by specifying a start angle of 0 degrees and an included angle of 90 degrees.

See also:

Create Meshes from Other Objects

**ROTATE**

Rotates objects around a base point.

**Access Methods**

**Button**

 وهذه الأزرار متوفرة:

**Toolbar:** Drafting tool set ➤ Move/Rotate/Scale tool group ➤ Rotate

**Menu:** Modify ➤ Rotate
Shortcut menu: Select the objects to rotate. Right-click in the drawing area and click Rotate.

Summary

You can rotate selected objects around a base point to an absolute angle.

List of Prompts

The following prompts are displayed.

Current positive angle in UCS: ANGDIR=Current ANGBASE=Current

Select objects: Use an object selection method and press Enter when you finish

Specify base point: Specify a point

Specify rotation angle (page 920) or [Copy (page 920)/Reference (page 920)]: Enter an angle, specify a point, enter c, or enter r

Rotation Angle Determines how far an object rotates around the base point. The axis of rotation passes through the specified base point and is parallel to the Z axis of the current UCS.

Copy Creates a copy of the selected objects for rotation.

Reference Rotates objects from a specified angle to a new, absolute angle. When you rotate a viewport object, the borders of the viewport remain parallel to the edges of the drawing area.

See also:

Rotate Objects
**ROTATE3D**

Moves objects about a 3D axis.

**Summary**

It is recommended that you use the gizmos available through the **3DMOVE** (page 36) and **3DROTATE** (page 47) commands to manipulate 3D objects. For more information about using gizmos, see Use Gizmos to Modify Objects.

**List of Prompts**

The following prompts are displayed.

Select objects: *Use an object selection method and press Enter when you finish*

Specify first point on axis or define axis by [Object (page 921)/Last (page 922)/View (page 922)/Xaxis/Yaxis/Zaxis (page 922)/2points (page 923)]: *Specify a point, enter an option, or press Enter*

- **Object**
  Aligns the axis of rotation with an existing object.

- **Line**
  Aligns the axis of rotation with the line selected.

- **Rotation Angle**
  Rotates the object about the selected axis the specified amount from the current orientation.

- **Reference**
  Specifies the reference angle and the new angle.
  The difference between the starting angle and the ending angle is the computed rotation angle.

- **Circle**
  Aligns the axis of rotation with the 3D axis of the circle (perpendicular to the plane of the circle and passing through the center of the circle).
  - **Rotation Angle** (page 921)
  - **Reference** (page 921)
**Arc**
Aligns the axis of rotation with the 3D axis of the arc (perpendicular to the plane of the arc and passing through the center of the arc).
- Rotation Angle (page 921)
- Reference (page 921)

**2D Polyline Segment**
Aligns the axis of rotation with a segment of the polyline. Treats a straight segment as a line segment. Treats an arc segment as an arc.
- Rotation Angle (page 921)
- Reference (page 921)

**Last**
Uses the last axis of rotation.
- Rotation Angle (page 921)
- Reference (page 921)

**View**
Aligns the axis of rotation with the viewing direction of the current viewport that passes through the selected point.
- Rotation Angle (page 921)
- Reference (page 921)

**X Axis, Y Axis, Z Axis**
Aligns the axis of rotation with one of the axes (X, Y, or Z) that pass through the selected point.
- Rotation Angle (page 921)
- Reference (page 921)
2 Points
Uses two points to define the axis of rotation.

■ Rotation Angle (page 921)
■ Reference (page 921)

See also:
Rotate Objects

RSCRIPT

Repeats a script file.

Summary

RSCRIPT is useful for demonstrations that repeat a script; for example, a script that must run over and over during a trade show or in a showroom.

If RSCRIPT is the last line in a script file, the file runs continuously until interrupted by Esc.

NOTE Consider turning off UNDO (page 1125) and any log files if you anticipate running the script over a long period; otherwise, these log files continue to grow and take up increasing amounts of disk space.

See also:
Create Command Scripts
RULESURF

Creates a mesh that represents the surface between two lines or curves.

Access Methods

Menu: Draw ➤ 3D Modeling ➤ Meshes ➤ Ruled Mesh

Summary

Select two edges that define the mesh. The edges can be lines, arcs, splines, circles, or polylines. If one of the edges is closed, then the other edge must also be closed. You can also use a point as one edge for either an open or a closed curve.

The MESHTYPE (page 1408) system variable sets which type of mesh is created. Mesh objects are created by default. Set the variable to 0 to create legacy polyface or polygon mesh.

For closed curves, the selection does not matter. If the curve is a circle, the ruled mesh begins at the 0-degree quadrant point, as determined by the current X axis plus the current value of the SNAPANG (page 1481) system variable. For closed polylines, the ruled mesh starts at the last vertex and proceeds backward along the segments of the polyline. Creating a ruled mesh between a circle and a closed polyline can be confusing. Substituting a closed semicircular polyline for the circle might be preferable.
The ruled mesh is constructed as a 2 by $N$ polygon mesh. RULESURF places half the mesh vertices at equal intervals along one defining curve, and the other half at equal intervals along the other curve. The number of intervals is specified by the SURFTAB1 (page 1500) system variable. It is the same for each curve; therefore, the distance between the vertices along the two curves differs if the curves are of different lengths.

The $N$ direction of the mesh is along the boundary curves. If both boundaries are closed, or if one is closed and the other is a point, the resulting polygon mesh is closed in the $N$ direction and $N$ equals SURFTAB1. If both boundaries are open, $N$ equals SURFTAB1 + 1, because division of a curve into $n$ parts requires $n + 1$ tabulations.

The 0,0 vertex of the mesh is the endpoint of the first selected curve nearest the point you used to select that curve.

Selecting objects at the same ends creates a polygon mesh.

Selecting objects at opposite ends creates a self-intersecting polygon mesh.

**List of Prompts**

The following prompts are displayed.

**First defining curve** Specifies an object and start point for the new mesh object.

**Second defining curve** Specifies an object and start point for the sweep of the new mesh object.

**See also:**

Create Meshes from Other Objects
S Commands

SAVE

Saves the drawing under the current file name or a specified name.

Obsolete. The SAVE command is functionally identical to the QSAVE (page 872) command. The Save option on the File menu is QSAVE.

Summary

The Save Drawing As dialog box (a standard file selection dialog box (page 723)) is displayed. Save the drawing under the current file name, or enter a different file name to save a copy of the drawing under that name.

If the drawing is read-only, use the SAVEAS (page 926) command to save changes under a different file name.

See also:

    Save a Drawing

SAVEAS

Saves a copy of the current drawing under a new file name.

Access Methods

▷ Menu: File ➤ Save As

Summary

The Save Drawing As standard file selection dialog box (page 723) is displayed. Enter a file name and type. Saving a drawing to any DXF™ format affects performance.

See Save Drawings to Previous Drawing File Formats for a description of the limitations that result from saving to an earlier version.

The file is saved with the specified file name. If the drawing is already named, the drawing is saved with the new file name. If you save the file as a drawing
template, the template options (page 927) are displayed, where you can set the units of measurement and provide a description for the template.

When FILEDIA (page 1334) is set to 0 (zero), SAVEAS displays command prompts (page 927).

See also:

Save a Drawing

**Template Options**

When a drawing is saved as a drawing template, you are prompted for the measurement to use when a new drawing is created from the drawing template and a description for the template.

**List of Prompts**

The following prompts are displayed.

Enter template measurement [English/Metric] <current>: Enter

Enter a template description: Enter a description and press Enter

See also:

Save a Drawing

**SAVEAS Command Prompts**

Saves a copy of the current drawing under a new file name.

**List of Prompts**

The following prompts are displayed.

Current file format: current


Save drawing as <current>: Enter a name or press Enter
See also:
   Save a Drawing

SAVEIMG

Saves a rendered image to a file.

**Summary**

The Render Output File dialog box (page 897) is displayed.

**NOTE** SAVEIMG is not available if the current rendering device does not support scan-line images.

See also:
   Save a Rendered Image

SCALE

Enlarges or reduces selected objects, keeping the proportions of the object the same after scaling.

**Access Methods**

**Button**

 Toolbar: Drafting tool set ➤ Move/Rotate/Scale tool group ➤ Scale

 Menu: Modify ➤ Scale

**Shortcut menu:** Select the objects to scale. Right-click in the drawing area and click Scale.

**Summary**

To scale an object, specify a base point and a scale factor. The base point acts as the center of the scaling operation and remains stationary. A scale factor greater than 1 enlarges the object. A scale factor between 0 and 1 shrinks the object.
List of Prompts

The following prompts are displayed.
Select objects: Use an object selection method and press Enter when you finish
Specify base point: Specify a point

The base point you specify identifies the point that remains in the same location as the selected objects change size (and thus move away from the stationary base point).

NOTE When you use the SCALE command with annotative objects, the position or location of the object is scaled relative to the base point of the scale operation, but the size of the object is not changed.

Specify scale factor (page 929) or [Copy (page 929)/Reference (page 929)]: Specify a scale, enter c, or enter r

Scale Factor Multiplies the dimensions of the selected objects by the specified scale. A scale factor greater than 1 enlarges the objects. A scale factor between 0 and 1 shrinks the objects. You can also drag the cursor to make the object larger or smaller.

Copy Creates a copy of the selected objects for scaling.

Reference Scales the selected objects based on a reference length and a specified new length.

See also:

Resize or Reshape Objects
SCALELISTEDIT

Controls the list of scales available for layout viewports, page layouts, and plotting.

Access Methods

Button

Toolbar: Annotation tool set ➤ Annotation Scaling tool group ➤ Scale List

Menu: Format ➤ Scale List

Command entry: `scalelistedit` for transparent use

Summary

Displays a list of predefined scales used throughout the program. This list can be easily modified to display only the scales you need.

The Edit Drawing Scales dialog box (page 930) is displayed.

If you enter `-scalelistedit` at the Command prompt, options are displayed (page 932).

See also:

Scale Views in Layout Viewports

Edit Drawing Scales Dialog Box

Controls the list of scales available for layout viewports, page layouts, and plotting.
List of Options

The following options are displayed.

**Scale List** Displays the list of currently defined scales. Also displays temporary scales that are imported when xrefs are attached. If a scale name is duplicated, but has a different value, a number is appended to the name.

**Add** Creates a new scale in the scale list.
Press Tab to move between the fields of the scale being edited.

**Delete** Removes the selected scale from the scale list.
**NOTE** You cannot delete a scale that is referenced by an annotative object.

**Options**
Manages items in the scale list.

**Edit** Edits the selected scale in-place in the scale list.
Press Tab to move between the fields of the scale being edited.
**NOTE** You cannot edit temporary scales.

**Reset** Deletes all custom scales and unused scales and restores the default list of scales.

**See also:**
Scale Views in Layout Viewports
-SCALELISTEDIT

Controls the list of scales available for layout viewports, page layouts, and plotting.

List of Prompts

The following prompts are displayed.

Enter option [?/Add/Delete/Reset/Exit] <Add>: Enter an option or press Enter

? Displays a list of defined scales.

Add Adds a new scale to the scale list. Enter a ratio in the format n:m, where n is the number of paper units and m is the number of drawing units.

Delete Removes a specified scale. If a scale is current or supported by an annotative object, it cannot be deleted.

Reset Deletes all custom scales as a result and restores the default list of scales.

See also:

Scale Views in Layout Viewports

SCRIPT

Executes a sequence of commands from a script file.

Access Methods

Command entry: 'script for transparent use

Summary

A script is a text file with an .scr file extension. Each line of the script file contains a command that can be completed at the Command prompt, including alternative versions of commands that normally display dialog boxes.

The Select Script File dialog box (a standard file selection dialog box (page 723)) is displayed. Enter the file name of a script to run that script.
When FILEDIA (page 1334) is set to 0 (zero), SCRIPT displays the following command prompt.

See also:
Overview of Command Scripts

SECTION

Uses the intersection of a plane and solids, surfaces, or mesh to create a region.

Summary

The SECTION command creates a region object that represents a 2D cross section of 3D objects, including 3D solids, surfaces, and meshes.

This method does not have the live sectioning capabilities that are available for section plane objects that are created using the SECTIONPLANE (page 935) command.

List of Prompts

The following prompts are displayed.

Select objects Selects one or more 3D objects. Selecting several objects creates separate regions for each object.
Specify the first point on the sectioning plane using one of the following methods:

- Object (page 934)
- Z Axis (page 934)
- View (page 934)
- XY (page 934)
- YZ (page 934)
- ZX (page 935)
Object Aligns the sectioning plane with a circle, ellipse, circular or elliptical arc, 2D spline, or 2D polyline segment.

Z Axis Defines the sectioning plane by specifying a point on the sectioning plane and another point on the Z axis, or normal, of the plane.

- **Point on the section plane.** Sets the first point on the plane.
- **Point on the Z-axis (normal) of the plane.** Specifies a point that defines the axis that is perpendicular to the plane.

View Aligns the sectioning plane with the viewing plane of the current view.

XY Aligns the sectioning plane with the XY plane of the current UCS.

YZ Aligns the sectioning plane with the YZ plane of the current UCS.
ZX Aligns the sectioning plane with the ZX plane of the current UCS.

3points Uses three points to define the sectioning plane:

See also:  
Create Section Objects

SECTIONPLANE

Creates a section object that acts as a cutting plane through 3D objects.

Access Methods

Button

 Toolbar: Modeling tool set ➤ Section tool group ➤ Section Plane
 Menu: Draw ➤ 3D Modeling ➤ Section Plane
Summary

Section plane objects create sections of 3D solids, surfaces, and meshes. Use live sectioning with section plane objects to analyze a model, and save sections as blocks for use in layouts.

List of Options

The following options are displayed.

Face or Any Point to Locate Section Line Specifies a face to establish the plane of the section object. Alternatively, you can select any point on the screen that is not on a face to create a section object independent of the solid or surface. The first point establishes a point around which the section object rotates.

Through point. Sets a second point that defines the plane of the section object.

Draw section Defines the section object with multiple points to create a section line with jogs. This option creates a section object in the Section Boundary state with live sectioning turned off.

Orthographic Aligns the section object to an orthographic orientation relative to the UCS.
A section object that contains all 3D objects is created with the specified orientation relative to the UCS (not the current view). This option creates a section object in the Section Plane state with live sectioning turned on.

- **Align section to.** Sets the position of the section object to align with one of the following UCS orientations that you specify:
  - Front
  - Back
  - Top
  - Bottom
  - Left
  - Right
See also:
Create Section Objects

SECTIONPLANEJOG

Adds a jogged segment to a section object.

Access Methods

Ribbon: Mesh Modeling tab ➤ Section panel ➤ Section Plane Jog
Shortcut menu: Select a section plane. Right-click in the drawing area and click Add Jog to Section.

Summary

You can insert a jog, or angle, into a section object as you create it. The jog is created on the section line. The jogged segment is created at a 90-degree angle to the section line.

NOTE The SECTIONPLANEJOG command was previously called JOGSECTION. Entering jogsection at the Command prompt runs SECTIONPLANE JOG.

List of Prompts

The following prompts are displayed.

Select section object Specifies which section line to modify.

Point on the section line to add jog Specifies the location of the jog.
See also:

Add Jogs to a Section

SECTIONPLANESETTINGS

Sets display options for the selected section plane.

Access Methods

Button

Toolbar: Modeling tool set ➤ Section tool group (expanded) ➤ Section Plane Settings
Shortcut menu: Select a live section object. Right-click in the drawing area and click Live Section Settings.

Summary

The Section Settings dialog box (page 939) is displayed.

See also:

Set Section Object States and Properties

Section Settings Dialog Box

Sets display options for section planes.
Summary

Contains display settings for creating 2D and 3D sections from the Generate Section / Elevation dialog box (page 946) and for live sectioning. All settings are stored with the section object.
List of Options

The following options are displayed.

Section Plane
If a section plane has not been selected, specifies a selection plane to be modified.

Select Section Plane Temporarily closes the Section Settings dialog box so that you can select a section object in the drawing area.

Setting Type
Specifies which setting types are displayed in the properties list.

2D Section / Elevation Block Creation Settings
Determines how a 2D section from a 3D object is displayed when generated.

3D Section Block Creation Settings
Determines how a 3D object is displayed when generated.

Live Section Settings
Determines how sectioned objects are displayed in the drawing when live sectioning is turned on.

Activate Live Section
Turns on live sectioning for the selected section object.

Properties
Sets the properties to be applied to the new section block.

Intersection Boundary Sets the appearance of line segments that outline the intersection surface of the section object plane.

■ Color. Sets the color of the intersection boundary.

■ Layer. Sets the layer. Select an existing layer, or select <Component_Name>*LayerByObject* to split the block component onto a separate layer. If you want to add a customized prefix or suffix to the *LayerByObject* name, click New Layer Name Settings to open the New Layer Name dialog box (page 944). (2D and 3D section blocks only)

■ Linetype. Sets the linetype to be ByLayer, ByBlock, or a type that you specify.

■ Linetype Scale. Sets the scale of the linetype.

■ Plot Style. Displays the current plot style. (2D and 3D section blocks only)
- **Lineweight.** Sets whether the lineweight is ByLayer, ByBlock, matches the default, or has a unique value.

- **Division Lines.** Sets whether division lines are displayed. (2D section blocks only)

- **Show.** Sets whether the intersection boundary is displayed. (3D section blocks only)

**Intersection Fill** Sets the optional fill that is displayed inside the boundary area of the cut surface where the section object intersects the 3D object.

- **Show.** Sets whether the intersection fill is displayed.

- **Face Hatch.** Sets the hatch pattern to be used for the face of the cut surface. To select a pattern from a list, click Select Hatch Pattern Type.

- **Angle.** Sets the hatch angle.

- **Hatch Scale.** Sets the hatch scale.

- **Hatch Spacing.** Sets the distance between hatch lines.

- **Color.** Sets the color of the intersection fill.

- **Layer.** Sets the layer. Select an existing layer, or select `<Component_Name>*LayerByObject*` to split the block component onto a separate layer. If you want to add a customized prefix or suffix to the *LayerByObject* name, click New Layer Name Settings to open the New Layer Name dialog box (page 944). (2D and 3D section blocks only.)

- **Lineweight.** Sets whether the lineweight is ByLayer, ByBlock, matches the default, or has a unique value.

- **Linetype Scale.** Sets the scale of the linetype.

- **Plot Style.** Displays the current plot style. (2D and 3D section blocks only)

- **Lineweight.** Sets whether the lineweight is ByLayer, ByBlock, matches the default, or has a unique value.

- **Surface Transparency.** Sets the percentage of transparency for the intersection fill. (Live Section only)

**Background Lines** Controls the display of background lines. (2D and 3D section blocks only)

- **Show.** Sets whether the component is displayed. (2D section blocks only)

- **Hidden Line.** Sets whether hidden lines (lines that are behind other lines in the 3D view) are displayed. (2D section blocks only)

- **Color.** Sets the color of the component.
- **Layer.** Sets the layer of the component. Select an existing layer, or select <Component_Name>*LayerByObject* to split the block component onto a separate layer. If you want to add a customized prefix or suffix to the *LayerByObject* name, click New Layer Name Settings to open the New Layer Name dialog box (page 944).

- **Linetype.** Sets the linetype to be ByLayer, ByBlock, or Continuous.

- **Linetype Scale.** Sets the scale of the linetype.

- **Plot Style.** Displays the current plot style.

- **Lineweight.** Sets whether the lineweight is ByLayer, ByBlock, matches the default, or has a unique value.

**Cut-away Geometry** Sets properties for the cut-away objects.

- **Show.** Sets whether the component is displayed.

- **Hidden Line.** Sets whether hidden lines (lines that are behind other lines in the 3D view) are displayed. (2D section blocks only)

- **Color.** Sets the color of the cutaway geometry.

- **Layer.** Sets the layer of the cutaway geometry. Select an existing layer, or select <Component_Name>*LayerByObject* to split the block component onto a separate layer. If you want to add a customized prefix or suffix to the *LayerByObject* name, click New Layer Name Settings to open the New Layer Name dialog box (page 944). (2D and 3D section blocks only)

- **Linetype.** Sets the linetype to be ByLayer, ByBlock, or Continuous.

- **Linetype Scale.** Sets the scale of the linetype.

- **Plot Style.** Displays the current plot style. (2D and 3D section blocks only)

- **Lineweight.** Sets whether the lineweight is ByLayer, ByBlock, matches the default, or has a unique value.

- **Face Transparency.** Sets the percentage of transparency of the face created where the live section object interfaces with the 3D objects. (Live Section only)

- **Edge Transparency.** Sets the percentage of transparency of the edges of the foreground lines. (Live Section only)

**Curve Tangency Lines** Controls the inclusion of curved lines that are tangent to the section plane. (2D section blocks only)

- **Show.** Sets whether the curve tangency lines are displayed.

- **Color.** Sets the color of the curve tangency lines.
Layer. Sets the layer of the curve tangency lines. Select an existing layer, or select <Component_Name>*LayerByObject* to split the block component onto a separate layer. If you want to add a customized prefix or suffix to the *LayerByObject* name, click New Layer Name Settings to open the New Layer Name dialog box (page 944).

Linetype. Sets the linetype to be ByLayer, ByBlock, or Continuous.

Linetype Scale. Sets the scale of the linetype.

Plot Style. Displays the current plot style.

Lineweight. Sets whether the lineweight is ByLayer, ByBlock, matches the default, or has a unique value.

Apply Settings to All Section Objects
When selected, applies all the settings to all section objects in the drawing. When cleared, applies settings to the current section object only.

Reset
Resets all settings in the dialog box to their default values.

See also:
Set Section Object States and Properties

New Layer Name Dialog Box
Adds a custom prefix or suffix to layer names to help organize components of a section block.
**Access Methods**

**Pointing device:** In the *Section Settings dialog box* (page 939), Layer list, click New Layer Name Settings.

**Summary**

By default, all section block geometry is placed on Layer 0 (zero). However, you can specify suffix or prefix labels to help organize section block components, such as intersection boundaries and fill. When the section block is inserted, the section block components are placed on new layers whose name combines the name of the layer that contains the sectioned object and the prefix or suffix you specify. If the section plane includes objects on two or more layers, two or more new object layers are created.

For example, suppose you create a suffix called "_kitchen" and then select *ObjectByLayer*_kitchen in the Section Settings dialog box, under Intersection Boundary. If you create a section block that bisects objects on the Walls and Cabinetry layers, two new layers are created to contain the block geometry for intersection boundaries: Walls_kitchen and Cabinetry_kitchen.

You can then easily modify the appearance of a set of block components by changing their properties. If a property such as Color is set as an object override in the Section Settings dialog box, you can change the property in that location. If the property is set to ByLayer, you can change it in the *Layers palette* (page 540).

**List of Options**

The following options are displayed.

**Added Text Type** Specifies whether or how identifying text is added to the layer name for the section block component.

- **None.** No additional text is added to the layer name. The section block geometry is placed on the same layer as the original geometry.
- **Prefix.** If the Layer property is specified as *ObjectByLayer* in the Section Settings dialog box, the label is added in front of the layer name.  

- **Suffix.** If the Layer property is specified as *ObjectByLayer* in the Section Settings dialog box, the label is added to the end of the layer name.

**Added Text**

Specifies identifying text to be added to the name of the layer that contains the component geometry when the section block is inserted.
See also:
   Set Section Object States and Properties

**SECTIONPLANETOBLOCK**

Saves selected section planes as 2D or 3D blocks.

**Access Methods**

**Shortcut menu:** Select a live section object. Right-click in the drawing area and click Generate 2D/3D Section.

**Summary**

The Generate Section /Elevation dialog box (page 946) is displayed.

See also:
   NO LABEL
   Save Sections as Blocks or Drawings

**Generate Section /Elevation Dialog Box**

Saves 2D and 3D sections as blocks.
Summary

Specifies the display settings for the cross sections that you save and reuse.

List of Options

The following options are displayed.

Section Plane
Select Section Plane Closes the dialog box so that you can select a section plane to modify or save as a block.

2D/3D
2D Section/Elevation
Creates and saves or inserts a block that represents a 2D cross section.

**3D Section**
Creates and saves or inserts a cutaway 3D block.

**Hide/Show Advanced Settings**
Controls the display of the Source Geometry, Destination, and Section Settings options.

**Source Geometry**
*Include All Objects*
Includes all 3D objects (3D solids, surfaces, and regions) in the drawing, including objects in xrefs and blocks.

*Select Objects to Include*
Specifies that you will manually select the 3D objects (3D solids, surfaces, meshes, and regions) from which to generate a section.

*Select Objects*
Closes the dialog box temporarily while you select the objects for the section. When you finish selecting objects, press Enter to redisplay the Generate Section/Elevation dialog box.

*Objects Selected*
Indicates the number of objects selected.

**Destination**
*Insert as New Block* Inserts the generated section as a block in the current drawing.

*Replace Existing Block* Replaces an existing block in the drawing with the newly generated section.

*Select Block*
Closes the dialog box temporarily while you select the block to be replaced in the drawing. When you finish selecting the block, press Enter to redisplay the Generate Section/Elevation dialog box.

*Export to a File* Saves the section to an external file.

*Filename and Path*
Specifies a file name and path where the section will be saved.

**Section Settings**
Opens the Section Settings dialog box (page 939).
Create

Creates the section.

See also:
Create Section Objects

SELECT

Places selected objects in the Previous selection set.

Access Methods

- **Button**

  Toolbar: Drafting tool set ➤ Selection tool group ➤ Select

Summary

A small box, called the object selection target or *pickbox*, replaces the crosshairs on the graphics cursor.

![Object Selection Target](image)

At the Select Objects prompt in a subsequent command, use the Previous option to retrieve the previous selection set.

You can also press and hold the Ctrl key to select original individual forms that are part of composite solids or vertices, edges, and faces on 3D solids. You can select one of these *subobjects*, or create a selection set of more than one subobject. Your selection set can include more than one type of subobject.

To view all options, enter `?` at the Command prompt.
List of Prompts

The following prompts are displayed.

Select objects: Use an object selection method

Expects a point or

Window (page 950)/Last (page 950)/Crossing (page 950)/BOX (page 950)/ALL (page 951)/Fence (page 951)/WPolygon (page 951)/CPolygon (page 951)/Group (page 952)/Add (page 952)/Remove (page 952)/Multiple (page 952)/Previous (page 952)/Undo (page 952)/AUtil (page 952)/SSingle (page 952)/SUbobject (page 953)/Object (page 953)

Select objects: Specify a point or enter an option

Window Selects all objects completely inside a rectangle defined by two points. Specifying the corners from left to right creates a window selection. (Specifying the corners from right to left creates a crossing selection.)

![Window Selection](image1.png)

Last Selects the most recently created visible object. The object must be in the current space, that is, model space or paper space, and its layer must not be set to frozen or off.

Crossing Selects objects within and crossing an area defined by two points. A crossing selection is displayed as dashed or otherwise highlighted to differentiate it from window selection.

![Crossing Selection](image2.png)

Box Selects all objects inside or crossing a rectangle specified by two points. If the rectangle's points are specified from right to left, Box is equivalent to Crossing. Otherwise, Box is equivalent to Window.
All Selects all objects in either model space or the current layout, except those objects on frozen or on locked layers.

Fence Selects all objects crossing a selection fence. The Fence method is similar to CPolygon except that the fence is not closed, and a fence can cross itself. Fence is not affected by the PICKADD (page 1432) system variable.

WPolygon Selects objects completely inside a polygon defined by points. The polygon can be any shape but cannot cross or touch itself. The last segment of the polygon is drawn so that it is closed at all times. WPolygon is not affected by the PICKADD (page 1432) system variable.

CPolygon Selects objects within and crossing a polygon defined by specifying points. The polygon can be any shape but cannot cross or touch itself. The last segment of the polygon is drawn so that it is closed at all times. CPolygon is not affected by the PICKADD (page 1432) system variable.
**Group** Selects all objects within a specified group.

**Add** Switches to the Add method: selected objects can be added to the selection set by using any of the object selection methods. Auto and Add are the default methods.

**Remove** Switches to the Remove method: objects can be removed from the current selection set using any object selection method. An alternative to Remove mode is to hold down Shift while selecting single objects or use the Automatic option.

**Multiple** Selects objects individually without highlighting them during object selection. This speeds up object selection for highly complex objects.

**Previous** Selects the most recent selection set. The Previous selection set is cleared by operations that delete objects from the drawing.

**NOTE** The Previous selection set is ignored if you switch spaces.

**Undo** Cancels the selection of the object most recently added to the selection set.

**Auto** Switches to automatic selection: pointing to an object selects the object. Pointing to a blank area inside or outside an object forms the first corner of a box defined by the Box method. Auto and Add are the default methods.

**Single** Switches to the Single method: selects the first object or set of objects designated rather than continuing to prompt for further selections.
**Subobject** Allows you to select original individual forms that are part of composite solids or vertices, edges, and faces on 3D solids. You can select one of these subobjects, or create a selection set of more than one subobject. Your selection set can include more than one type of subobject.

Pressing and holding the Ctrl key is the same as selecting the SELECT command’s Subobject option.

**Object** Ends the ability to select subobjects. Allows you to use object selection methods.

*See also:*

- Select Objects Individually
- SELECTSIMILAR

## SELECTSIMILAR

Adds similar objects to the selection set based on selected objects.

**Access Methods**

- **Button**
  
- **Toolbar: Drafting tool set ➤ Selection tool group ➤ Select Similar**

- **Shortcut menu:** Select the object that you want to use as the template object to select similar objects. Right-click in the drawing area and click Select Similar.

**Summary**

Selects similar objects of the same type based on specified matching properties, such as the color or block name.
List of Prompts

The following prompt is displayed.

Select objects or [SEttings]: Use an object selection method and press Enter

The Settings option displays the Select Similar Settings dialog box.

See also:

Select Objects by Properties

Select Similar Settings Dialog Box

Controls which properties must match for an object of the same type to be selected.

List of Options

The following options are displayed.

Color Considers objects with matching colors to be similar.
Layer Considers objects on matching layers to be similar.
Linetype Considers objects with matching linetypes to be similar.
Linetype scale Considers objects with matching linetype scales to be similar.
Lineweight Considers objects with matching lineweights to be similar.
Plot style Considers objects with matching plot styles to be similar.
Object style Considers objects with matching styles (such as text styles, dimension styles, and table styles) to be similar.
Name Considers referenced objects (such as blocks, xrefs, and images) with matching names to be similar.

See also:

Select Objects by Properties
SETVAR

Lists or changes the values of system variables.

Access Methods

Menu: Tools ➤ Inquiry ➤ Set Variable
Command entry: 'setvar for transparent use

List of Prompts

The following prompts are displayed.
Enter variable name (page 955) or [? (page 955)] <current>: Enter a variable name, enter ?, or press Enter

Variable Name Specifies the name of the system variable you want to set.
You can also change the value of system variables at the Command prompt by entering the name of the variable and its new value.

?—List Variables Lists all system variables in the drawing and their current settings.

See also:

Enter Commands on the Command Line

SHADEMODE

Starts the VSCURRENT command.

See also:

Use a Visual Style to Display Your Model

-SHADEMODE

Changes the shading used in the current viewport.

List of Prompts

The following prompts are displayed.
Enter option [2D wireframe (page 956)/3D wireframe (page 956)/Hidden (page 956)/Flat (page 956)/Gouraud (page 956)/Flat+edges (page 956)/Gouraud+edges (page 956)] <current>:

2D Wireframe Displays the objects using lines and curves to represent the boundaries. Raster images, linetypes, and lineweights are visible.

3D Wireframe Displays the objects using lines and curves to represent the boundaries. Material colors that you have applied to the objects are shown.

Hidden Displays the objects using 3D wireframe representation and hides lines representing back faces.

Flat Shaded Shades the objects between the polygon faces. The objects appear flatter and less smooth than Gouraud-shaded objects. Materials that you have applied to the objects show when the objects are flat shaded.

Gouraud Shaded Shades the objects and smooths the edges between polygon faces. This gives the objects a smooth, realistic appearance. Materials that you have applied to the objects show when the objects are Gouraud shaded.

Flat Shaded, Edges On Combines the Flat Shaded and Wireframe options. The objects are flat shaded with the wireframe showing through.

Gouraud Shaded, Edges On Combines the Gouraud Shaded and Wireframe options. The objects are Gouraud shaded with the wireframe showing through.

See also:

Use a Visual Style to Display Your Model

**SHAPE**

Inserts a shape from a shape file that has been loaded using LOAD.

**List of Prompts**

The following prompts are displayed.
Enter *shape name* (page 956) or [? (page 957)]: *Enter a name, or enter ?*

**Shape Name** Loads the shape.

If a shape belongs to an external reference (xref) attached to the current drawing, the shape file is identified as externally dependent. Externally
dependent shapes cannot be used in the current drawing unless they are reloaded.

?—List Shapes Lists shapes and the files in which the shapes are defined. If you enter an asterisk (*), the program lists shape names.

See also:
Overview of Shape Files

**SHEETSET**

Opens the Project Manager.

**Access Methods**

- **Menu:** Tools ➤ Palettes ➤ Project Manager
- **Menu:** Window ➤ Project Manager
- **Command entry:** Cmd-8

**Summary**

The Project Manager (page 957) organizes, displays, and manages projects, a named collection of layouts that represent a drawing set. Each layout in a project is a reference to a named layout stored in separate drawing (DWG) files.

See also:
Quick Start for Projects

**Project Manager Palette**

Displays and organizes named collections of layouts.

**Access Methods**

- **Menu:** Tools ➤ Palettes ➤ Project Manager
- **Menu:** Window ➤ Project Manager
- **Command entry:** Cmd-8
Summary

The Project Manager is not fully functional if
■ A command is active;
■ No drawing is open;
■ The project is locked; or
■ A layout is locked by another user.
Components of the Project Manager

The following explains which each of the components of the Project Manager are used for.

1 **Project Popup Menu.** Lists all the open and recently opened projects. Use the list to switch between open projects.

2 **Publish Project Button.** Displays and populates the Batch Publish dialog box with all the layouts in the current project.

3 **Project Tree View.** Displays an organized list of all layouts in the current project.
   - You can perform the following actions in the tree view:
     - Double-click a layout or view to open the associated drawing.
     - Right-click to access shortcut menus of the operations that are relevant to the currently selected item. For more information, see Project Tree View Shortcut Menus (page 961).
     - Drag items within the tree view to reorder them.

4 **Details Panel.** Displays the properties for the item selected in the Project tree view. Click the Show/Hide Details button at the bottom of the Project Manager to toggle the display of the Details panel.
   - For more information on the properties listed in the Details panel, see:
     - Project Properties (page 964)
     - Layout Properties (page 967)
     - Group Properties (page 970)
     - View Properties (page 971)

5 **Create Action Button.** Displays a popup menu that allows you to create a new project, or add layouts and groups to the current project.
   - **New Layout.** Displays the New Project Layout dialog box (page 974) and creates a new layout in the project or under the selected group.
   - **Add Existing Drawing.** Displays the Add Layout from Drawing dialog box and allows you to select a layout from an existing drawing to add to the project.
   - **New Group.** Creates a new group.
   - **Create New Project.** Displays the New Project dialog box (page 972) and creates a new project data (DST) file.

6 **Remove Button.** Removes the selected group or layout from the project. Removing a layout does not delete the associated drawing file.
7 **Show/Hide Details Button.** Toggles the display of the Details panel.

8 **Project Action Button.** Displays a popup menu that allows you open, close, or publish a project. You can also control how layouts are opened and renamed.
   - **Open Project.** Displays the Open Project dialog box and loads the information in the project data (DST) file into the Project Manager.
   - **Close Project.** Closes the current project.
   - **Batch Publish.** Displays the Batch Publish dialog box and adds the selected layout, or the layouts contained in the selected group or project.
   - **Page Setup Manager.** Displays the Page Setup Manager and allows you to modify the page setup overrides in the current project.
   - **Open Drawings to Model.** Controls whether the named layout or model space is set current when opening a project layout from the Project Manager.
   - **Show File Users.** Controls the display of the user that created the layout or currently has a layout opened appears below the layout in the Project tree view.
   - **Name Synchronization.** Controls the renaming of drawing (DWG) files and layouts when changing the name and numbers of a layout in the Project Manager.
     - **Layout Title.** When checked, renaming a layout in the Project Manager changes the layout name in the drawing (DWG) file.
     - **Prefix with Layout Number.** When checked, renaming a layout in the Project Manager changes the layout name in the drawing (DWG) file to a new name that prefixes the layout title with the layout number (<number> <title>).
     - **Drawing Title.** When checked, renaming a layout in the Project Manager changes both the drawing (DWG) file and layout names.
     - **Prefix with Layout Number.** When checked, renaming a layout in the Project Manager changes both the drawing (DWG) file and layout names to a new name that prefixes the layout title with the layout number (<number> <title>).

See also:
- Understand the Project Manager Interface
- Quick Start for Projects
- Use Projects in a Team
Project Tree View Shortcut Menus

When working in the Project tree view in the Project Manager, there are several shortcut menus that can be displayed when you right-click an item.

The following tables show the shortcut menu items that you are presented under certain conditions.

**Project Selected**

When the project is selected, the top node in the tree, the shortcut menu presents the following functions:

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close Project</td>
<td>Closes the current project data (DST) file.</td>
</tr>
<tr>
<td>New Layout</td>
<td>Displays the New Project Layout dialog box (page 974) and adds the new layout to the project.</td>
</tr>
<tr>
<td>Add Layout From Drawing</td>
<td>Displays the Add Layout from Drawing dialog box and adds all the named layouts to the project from the selected drawing.</td>
</tr>
<tr>
<td>New Group</td>
<td>Creates a new group.</td>
</tr>
<tr>
<td>Rename Project</td>
<td>Changes the name of the project.</td>
</tr>
<tr>
<td>Publish Project</td>
<td>Displays the Batch Publish dialog box and adds all layouts in the project.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> Groups and layouts that are designated as not to be included for publish are excluded from the Batch Publish dialog box.</td>
</tr>
<tr>
<td>Page Setup</td>
<td>Displays the Page Setup Manager and allows you to modify the page setup overrides in the current project.</td>
</tr>
<tr>
<td>Publish with Overrides</td>
<td>Publishes all the layouts in the project using the selected page setup override rather than the page setup specified in each drawing.</td>
</tr>
</tbody>
</table>
Page setup overrides are stored in the project’s Page Setup property under File Locations.

Reveal in Finder

Opens Finder and displays the location where the project data (DST) file is stored.

Properties

Toggles the display of the Details panel.

### Layout Selected

When a layout is selected, the shortcut menu presents the following functions:

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Layout</td>
<td>Opens the drawing (DWG) file associated with the layout and sets the layout current.</td>
</tr>
<tr>
<td>Open Layout Read-only</td>
<td>Opens the drawing (DWG) file associated with the layout as read-only and sets the layout current.</td>
</tr>
<tr>
<td>Duplicate Layout</td>
<td>Creates a copy of the drawing (DWG) file associated with the layout and imports the layout from the new drawing into the project.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> The new layout in the project might have a different title than the original layout.</td>
</tr>
<tr>
<td>Remove From Project</td>
<td>Removes the layout from the project.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> The drawing (DWG) file associated with the project layout is not removed from disk.</td>
</tr>
<tr>
<td>Rename</td>
<td>Changes the name of the layout.</td>
</tr>
<tr>
<td>Place Callout Block</td>
<td>Specifies and places a callout block onto a layout.</td>
</tr>
<tr>
<td>Publish Layout</td>
<td>Displays the Batch Publish dialog box and adds the layout.</td>
</tr>
</tbody>
</table>
NOTE When the Publish property for a layout is not enabled, the layout is excluded from the Batch Publish dialog box.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Setup</td>
<td>Displays the Page Setup Manager and allows you to modify the page setup overrides in the current project.</td>
</tr>
<tr>
<td>Publish with Overrides</td>
<td>Publishes the selected layouts using the selected page setup override rather than the page setup specified in each drawing. Page setup overrides are stored in the project’s Page Setup property under File Locations.</td>
</tr>
<tr>
<td>Reveal in Finder</td>
<td>Opens Finder and displays the location of the drawing (DWG) file associated with the layout.</td>
</tr>
<tr>
<td>Properties</td>
<td>Toggles the display of the Details panel.</td>
</tr>
</tbody>
</table>

**Group Selected**

When you select a group, the shortcut menu presents the following functions:

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Layout</td>
<td>Displays the New Project Layout dialog box (page 974) and adds the new layout to the group.</td>
</tr>
<tr>
<td>Add Layout From Drawing</td>
<td>Displays the Add Layout from Drawing dialog box and adds all the named layouts to the group from the selected drawing.</td>
</tr>
<tr>
<td>New Sub-Group</td>
<td>Creates a new group nested under the selected group.</td>
</tr>
<tr>
<td>Rename</td>
<td>Changes the name of the group.</td>
</tr>
</tbody>
</table>
| Delete Group       | Removes the group and all the layouts under it from the project. **NOTE** The drawing (DWG) files associated with the project layouts are not removed from disk.
<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publish Group</td>
<td>Displays the Batch Publish dialog box and adds all layouts in the group. <strong>NOTE</strong> When the Do Not Publish Layouts property for a group is not enabled, the layouts in the group are excluded from the Batch Publish dialog box.</td>
</tr>
<tr>
<td>Page Setup</td>
<td>Displays the Page Setup Manager and allows you to modify the page setup overrides in the current project.</td>
</tr>
<tr>
<td>Publish with Overrides</td>
<td>Publishes all the layouts in the group using the selected page setup override rather than the page setup specified in each drawing. Page setup overrides are stored in the project's Page Setup property under File Locations.</td>
</tr>
<tr>
<td>Reveal in Finder</td>
<td>Opens Finder and displays the folder location that the sub-group represents.</td>
</tr>
<tr>
<td>Properties</td>
<td>Toggles the display of the Details panel.</td>
</tr>
</tbody>
</table>

**View Selected**

When you select a view placed on a layout, the shortcut menu presents the following functions:

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to View</td>
<td>Opens the drawing (DWG) file that contains the layout in which the view is placed on.</td>
</tr>
<tr>
<td>Place Label Block</td>
<td>Places a view label block onto a layout.</td>
</tr>
</tbody>
</table>

**Project Properties (Project Manager)**

Displays information that is specific to the project.
List of Options

The following options are displayed.

**Project**
Displays fields commonly used to identify a project.

**Project Number** Specifies the number assigned to the project.

**Project Name** Specifies the name assigned to the project.

**Project Phase** Specifies the current phase of the project.

**Project Milestone** Specifies the current milestone of the project.

**Description** Specifies a description of the project.

**File Locations**
Displays the paths for the project, page setup overrides, and the callout and label blocks used by the project.

**Project File Name** Specifies the name of the project.
**Project File** Displays the path and file name of the project data (DST) file.

**Label Block** Displays the path and file name of the drawing template (DWT) or drawing (DWG) file that contains the label block for the project.

Click the Ellipsis button to display the Label Block for Views dialog box (page 977) and specify a label block for the project.

**Callout Blocks** Click Manage to display the Callout Blocks dialog box (page 976) and manage the callout blocks for the project.

**Page Setups** Displays the path and file name for the drawing template (DWT) file containing the page setup overrides for the project.

Click the Ellipsis button to specify the drawing template (DWT) file that contains the page setup overrides to use for the project.

**Layout Location** Displays the path and name of the folder where new drawing (DWG) files are saved when new layouts are created.

**NOTE** Clearing Layout Title and Drawing Title under the Name Synchronization item of the Project Action menu, located in the lower-right corner of the Project Manager palette, enables the Ellipsis button to specify a different folder for new drawing (DWG) files.

**Template Location** Displays settings used when creating a new layout in the current project.

**Layout Template** Displays the layout to use when creating a new layout.

The layouts displayed in the drop-down list come from the file specified in the Default Template property.

**Default Template** Specifies the drawing template (DWT) or drawing (DWG) file to use when creating new drawing files for the group.

**Prompt for Template** Controls whether the New Project Layout dialog box (page 974) is displayed in the expanded or collapsed state each time a new layout is added.

**Project Custom Properties** Displays the user-defined custom properties associated with the project.

You can manage user-defined custom properties by:

- Clicking Add Property to display the Add Custom Property dialog box (page 975) and create a new property.
- Right-clicking over a property and choosing Remove Custom Property to remove the property.

You can also choose New Custom Property to display the Add Custom Property dialog box and create a new property.
Layout Custom Properties
Displays the user-defined custom properties associated with each layout in the project.

You can manage user-defined custom properties by:

■ Clicking Add Property to display the Add Custom Property dialog box and create a new property.
■ Right-clicking over a property and choosing Remove Custom Property to remove the property.
   You can also choose New Custom Property to display the Add Custom Property dialog box and create a new property.

See also:
Include Information with Projects, Groups, Layouts, and Views
Create and Manage a Project

Layout Properties (Project Manager)
Displays information that is specific to the selected layout, such as the name, number, and whether it will be included in publishing operations. Also displays custom properties, if any.
List of Options

The following options are displayed.

**Layout**
Displays information used to identify the layout in the project.

**Layout Name** Displays the name of the layout in the project.

**Layout Number** Displays the number for the layout.

**Revision Number** Displays the revision number assigned to the layout.

**Revision Date** Displays the revision date for the layout.

**Purpose** Displays what the layout is used for.

**Category** Displays the name of the category the layout.
Page Size Displays the page size for the layout.

Description Displays the description for the layout.

Publish Controls whether the layout is added to the Batch Publish dialog box when publishing a group or all layouts in the project.

File Version Lists information about the associated drawing (DWG) file.

Last Modified Displays the date when the file was last modified.

Last Modified By Displays the name of the user who made the last modification to the file.

File Locations Displays the location of the drawing file that contains the project layout.

Layout Specifies which named layout in the drawing (DWG) file that should be associated with the layout in the project.

The drawing (DWG) file that contains the layout is specified in the Drawing Location property.

Drawing Location Specifies the path to and the drawing (DWG) file name where the layout was previously saved.

Reveal in Finder Opens Finder to the location of the drawing (DWG) file associated with the layout.

Found Layout Displays the name of the layout in the drawing (DWG) file associated with the layout in the project.

Found Location Displays the path and file name of the drawing where the layout was found.

File Size Displays the size of the drawing (DWG) file associated with the layout.

Layout Custom Properties Displays the user-defined custom properties associated with each layout in the project.

You can manage user-defined custom properties by:

- Clicking Add Property to display the Add Custom Property dialog box (page 975) and create a new property.
- Right-clicking over a property and choosing Remove Custom Property to remove the property.

You can also choose New Custom Property to display the Add Custom Property dialog box and create a new property.
**Preview**
Displays a preview image of the selected layout.

**See also:**
- Include Information with Projects, Groups, Layouts, and Views
- Work with Layouts in a Project

**Group Properties (Project Manager)**
Displays information that is specific to the selected group.

![Group Properties](image)

**List of Options**
The following options are displayed.

**Group**
Displays the name and if the group is included when publishing.

**Group Name**
Displays the name of the group.

**Do Not Publish Layouts**
Controls whether the layouts in the group are added to the Batch Publish dialog box when publishing the group or all layouts in the project.

**File Locations**
Displays information about the folder on disk that the group represents in the project.

**Folder Location**
Specifies the folder location for new drawing (DWG) files created as a result of adding a new layout to the group.

Does not impact the folder location of a drawing (DWG) file when adding layouts from an existing drawing.
Reveal in Finder Displays the resolved absolute path to the folder on disk that the group represents.

**Template Location**
Displays settings used when creating a new layout in the group.

**Layout Template** Displays the layout to use when creating a new layout. The layouts displayed in the drop-down list come from the file specified in the Default Template property.

**Default Template** Specifies the drawing template (DWT) or drawing (DWG) file to use when creating new drawing files for the project.

**Prompt for Template** Controls whether the New Project Layout dialog box (page 974) is displayed in the expanded or collapsed state each time a new layout is added.

**See also:**
Organize a Project
Work with Layouts in a Project

**View Properties (Project Manager)**
Displays information that is specific to the selected view.
Summary

Views represent named views that have been placed on a layout in the current project using the Sheet Set Manager in AutoCAD for Windows. Views cannot be modified or placed using the Project Manager.

List of Options

The following options are displayed.

**View**
Displays information about the view.

**View Name** Displays the name of the view.

**Category** Assigns a category to the view.

The Category list is populated by the current value of each model space view's View Category property when it was placed on a layout in the project.

**File Locations**
Displays information about the drawing file that the view is located in.

**Drawing Name** Displays the name of the drawing that contains the named view.

**Drawing Location** Displays the path of the drawing where the view is saved.

**Reveal in Finder** Displays the location of the drawing (DWG) file associated with the view in Finder.

**Preview**
Displays a preview image of the selected view.

See also:

- Work with Layouts in a Project

New Project Dialog Box

Creates a new blank project, or a project based on a project template or existing project data (DST) file.
List of Options

The following options are displayed.

**Project Name**
Specifies the name of the project.

**Project Location**
Specifies the path of the project data (DST) file. The name of the project data (DST) file is determined by the text entered for the Project Name.

Click Browse to select a folder in Finder.

**Description**
Specifies a description for the project.

**Create Blank Project**
Creates a new empty project using the default settings and property values.

**Use Template**
Creates a new project based on one of the standard project template files.

A project template contains a standard set of groups, label and callout blocks, and other property values specific to an industry and unit of measurement.

**Copy Existing Project Structure**
Creates a new project based on an existing project data (DST) file. The new project contains all the structure, layout references, and property values of the specified project data (DST) file.

Click Browse to select a project data (DST) file in Finder.
See also:
Create a Project

New Project Layout Dialog Box

Creates a new layout in the current project by creating a new drawing (DWG) file that includes a named layout with the same name as the drawing.

List of Options

The following options are displayed.

**Layout Number**
Specifies the number for the layout in the current project. It is recommended that you do not fill in the number when you first create a layout. By default the drawing name and layout name of the new layout will be the number together with layout title.

You can remove the number from the file name when you create the new layout, but the number will still be in the layout name.

**Layout Name**
Specifies the name of the named layout in the new drawing.

**Show/Hide Options**
Expands and collapses the Options section to which contains file path and drawing template (DWT) file options.

**File Location**
Displays the default folder for the new drawing file.
The default folder for a group is specified in the Details panel when the group is selected; and the default folder for a project is specified in the Details panel when the project name is selected.

Click Browse to select a folder in Finder for the new drawing.

**Template**

Specifies the drawing template (DWT) file and the named layout to use when creating a new layout in the project.

**Named Layout** Displays the name of the layout in the specified drawing template (DWT) file to use when creating a new drawing file.

**Template File Location** Displays the default drawing template (DWT) file to use for creating the new drawing file.

The default drawing template (DWT) file used for creating new drawings in a group is specified in the Details panel when the group is selected; the default drawing template (DWT) file for creating new drawings in a project is specified in the Details panel when the project name is selected.

Click Browse to select a drawing template (DWT) file in Finder.

**Open Drawing**

When checked, allows you to open the drawing after creation and edit directly within the file.

**See also:**

Create and Modify Layouts in a Project

**Add Custom Property Dialog Box**

Creates a custom property to be associated with the current project or with each layout.

![Add Custom Property Dialog Box](image)

**List of Options**

The following options are displayed.
**Owner**
Specifies whether the custom property will belong to the project or layout.

**Name**
Specifies the name of the new custom property.

**Default Value**
Specifies a value for the custom property.

**See also:**
Include Information with Projects, Groups, Layouts, and Views

---

**Callout Blocks Dialog Box**

Lists, adds, or removes callout blocks for use in the current project.

![Callout Blocks Dialog Box](image)

**List of Options**

The following options are displayed.

**Preview**
Displays a preview image when a block is selected.

**List of Blocks**
Displays the list of blocks available for use with the current project.
Add Block (+)
Displays the Select Drawing dialog box. Select the drawing file to use as a callout block or a drawing that contains the blocks you want to use.

Remove Block (-)
Removes the selected block from the list of callout blocks.

See also:
Create and Modify Layouts in a Project

Label Block for Views Dialog Box

Adds a new label block for use in the current project.

List of Options
The following options are displayed.

Preview
Displays a preview image when a block is selected.

Drawing File Location
Specifies the path and name of a drawing (DWG) file or the name and path of a drawing template (DWT) file to be used as the source of a block definition.
Click Browse to display the Select Drawing dialog box and select the drawing file to use.

**NOTE** The locations of the last five most recently selected drawing files are retained in the drop-down list.

**Use Drawing as Block**
Use the entire specified drawing or drawing template file as the block definition.

**Choose Block in the Drawing File**
Use a selected block definition from the specified drawing or drawing template file.

**See also:**
Create and Modify Layouts in a Project

**Repair Broken Layouts Dialog Box**
Updates the location of the layouts and drawing (DWG) files referenced by the project layouts in the current project.

**List of Options**
The following options are available.
**Status**
Current status of the layout in the project: missing or resolved.

**Project Layout**
Name of each missing layout in the current project.

**Project Drawing**
Drawing (DWG) file name in which the project layout is contained in.

**Drawing Name**
List of all the drawing (DWG) files that are referenced in the project or added to the dialog box using the Add Drawing (+) button.

**Drawing Layout**
Lists all the layouts in the drawing selected from the Drawing Name list.

**Add Drawing (+)**
Adds a drawing to the Drawing Name list.

**Remove Drawing (-)**
Removes a drawing currently not referenced by the project.

See also:
Create and Modify Layouts in a Project

**SHEETSET/HIDE**
Closes the Project Manager.

See also:
Create a Project

**SHOWPALETTES**
Restores the display of hidden palettes.

**Access Methods**

_Cmd Command entry:_ Tab
Summary

Restores the state of the display and position of palettes hidden by HIDEPALETTES (page 509).

Press Tab to switch between HIDEPALETTES and SHOWPALETTES.

NOTE If a palette was manually turned back on, it is not affected by SHOWPALETTES (even if it was manually closed again)

See also:

Specify the Behavior of Palettes

SKETCH

Creates a series of freehand line segments.

Summary

Sketching is useful for creating irregular boundaries or for tracing with a digitizer. Specify the object type (line, polyline, or spline), increment, and tolerance before sketching.

List of Prompts

The following prompts are displayed.
Specify Sketch (page 980) or [Type (page 981)/Increment (page 981)/tolerance (page 981)]:

Sketch Creates a sketch.
**Type** Specifies the object type for the sketch line. (*SKPOLY* (page 1478) system variable)
- **Line** (page 576)
- **Polyline** (page 796)
- **Spline** (page 1022)

**Increment** Defines the length of each freehand line segment. You must move the pointing device a distance greater than the increment value to generate a line. (*SKETCHINC* (page 1477) system variable)

**Tolerance** For Splines, specifies how closely the spline's curve fits to the freehand sketch. (*SKTOLERANCE* (page 1478) system variable)

**See also:**
- Draw Freehand Sketches

---

**SLICE**

Creates new 3D solids and surfaces by slicing, or dividing, existing objects.

**Access Methods**

- **Button**
  - **Toolbar**: Modeling tool set ➤ Solids - Edit tool group (expanded) ➤ Slice
  - **Menu**: Modify ➤ 3D Operations ➤ Slice

**Summary**

The cutting plane is defined with 2 or 3 points, by specifying a major plane of the UCS, or by selecting a surface object (but not a mesh). Either one or both sides of the sliced 3D solids can be retained.
The sliced objects retain the layer and color properties of the original solids. However, the resulting solid or surface objects do not retain a history of the original objects.

**Objects that Can Be Used in a Slice Operation**

<table>
<thead>
<tr>
<th>Objects that can be sliced</th>
<th>Objects that can be used as cutting planes</th>
</tr>
</thead>
<tbody>
<tr>
<td>3D solids</td>
<td>Surfaces</td>
</tr>
<tr>
<td>Surfaces</td>
<td>Circles</td>
</tr>
<tr>
<td></td>
<td>Ellipses</td>
</tr>
<tr>
<td></td>
<td>Circular or elliptical arcs</td>
</tr>
<tr>
<td></td>
<td>2D splines</td>
</tr>
<tr>
<td></td>
<td>3D polyline segments</td>
</tr>
</tbody>
</table>

**List of Prompts**

The following prompts are displayed.

**Objects to slice** Specifies the 3D solid or surface object that you want to slice. If you select a mesh object, you can choose to convert it to a 3D solid or surface before completing the slice operation.

- **Start point of slicing plane** (page 983)
- **Planar object** (page 983)
- **Surface** (page 983)
- **Z axis** (page 984)
- **View** (page 984)
- **XY** (page 984)
- **YZ** (page 985)
- **ZX** (page 985)
- **3points** (page 986)

**Start point of slicing plane** Sets the first of two points that define the angle of the slicing plane. The slicing plane is perpendicular to the XY plane of the current UCS.

- **Second point on plane.** Sets the second of two points on the slicing plane.
  - **Point on desired side** (page 986)
  - **Keep both sides** (page 986)

**Planar object** Aligns the cutting plane with a plane that contains a selected circle, ellipse, circular or elliptical arc, 2D spline, or 2D polyline segment.

- **Select a circle, ellipse, arc, 2D-spline, or 2D-polyline.** Specifies the object to use for alignment.

**Surface** Aligns the cutting plane with a surface.

- **Select a surface.** Specifies a surface to be used for alignment.
NOTE You cannot select meshes created with the EDGESURF (page 403), REVSURF (page 917), RULESURF (page 924), and TABSURF (page 1073) commands.

- Point on desired side (page 986)
- Keep both sides (page 986)

Z axis Defines the cutting plane by specifying a point on the plane and another point on the Z axis (normal) of the plane.

- Specify a point on the section plane. Sets a point on the slicing plane.
- Specify a point on the Z-axis (normal) of the plane. Specifies a point that defines the axis that is perpendicular to the slicing plane.
  - Point on desired side (page 986)
  - Keep both sides (page 986)

View Aligns the cutting plane with the current viewport's viewing plane. Specifying a point defines the location of the cutting plane.

- Specify a point on the current view plane. Sets a point on the object to start the slice.
  - Point on desired side (page 986)
  - Keep both sides (page 986)

XY Aligns the cutting plane with the XY plane of the current user coordinate system (UCS). Specifying a point defines the location of the cutting plane.
■ **Point on the XY-plane.** Sets the location of the slice.
  ■  ■ **Point on desired side** (page 986)
  ■  ■ **Keep both sides** (page 986)

YZ Aligns the cutting plane with the YZ plane of the current UCS. Specifying a point defines the location of the cutting plane.

■ **Point on the YZ-plane.** Sets the location of the slice.

ZX Aligns the cutting plane with the ZX plane of the current UCS. Specifying a point defines the location of the cutting plane.

■ **Point on the ZX-plane.** Sets the location of the slice.

If a single object is sliced into more than two objects, one solid or surface is created from the objects on one side of the plane and another solid or surface is created from the objects on the other side.
3points Defines the cutting plane using three points.

Point on desired side Uses a point to determine which side of the sliced solids your drawing retains. The point cannot lie on the cutting plane.

Keep both sides Retains both sides of the sliced solids. Slicing a single solid into two pieces creates two solids from the pieces on either side of the plane. SLICE never creates more than two new composite solids for each selected solid.

See also:
Create 3D Solids by Slicing

SNAP

Restricts cursor movement to specified intervals.
Access Methods

Menu: Tools ➤ Drafting Settings

Toolbar: Status bar ➤ Snap

Command entry: snap or ‘snap’ for transparent use

List of Prompts

The following prompts are displayed.
Specify snap spacing (page 987) or [ON (page 987)/OFF (page 987)/Aspect (page 987)/Legacy (page 987)/Style (page 988)/Type (page 988)] <current>: Specify a distance, enter an option, or press Enter

Snap Spacing
Activates Snap mode with the value you specify.

On
Activates Snap mode using the current settings of the snap grid. (SNAPMODE (page 1483) system variable)

Off
Turns off Snap mode but retains the current settings. (SNAPMODE (page 1483) system variable)

Aspect
Specifies different spacing in the X and Y directions. (SNAPUNIT (page 1484) system variable)

Legacy
Sets the cursor snap to the snap grid only when an operation is in progress. (SNAPGRIDLEGACY (page 1482) system variable)
**Style**  
Specifies the format of the snap grid, which is Standard or Isometric. *(SNAPSTYL* (page 1483) system variable)

**Standard**  
Sets a rectangular snap grid that is parallel to the XY plane of the current UCS.  
*X* and *Y* spacing may differ.  
**Spacing** Specifies the overall spacing of the snap grid.  
**Aspect** Specifies the horizontal and vertical spacing of the snap grid separately.

**Isometric**  
Sets an isometric snap grid, in which the snap locations are initially at 30-degree and 150-degree angles. Isometric snap cannot have different Aspect values. The lined grid does not follow the isometric snap grid.

![Isometric Snap Grids](image)

*ISOPLANE* (page 535) determines whether the crosshairs lie in the top isometric plane (30- and 150-degree angles), the left isoplane (90- and 150-degree angles), or the right isoplane (30- and 90-degree angles).

**Type**  
Specifies the snap type, polar or rectangular. This setting is also controlled by the *SNAPTYPE* (page 1484) system variable.

**Polar** Sets the polar angle increment. *(POLARANG* (page 1441) system variable)

**Grid** Sets the snap to Grid. When you specify points, the cursor snaps along vertical or horizontal grid points.

**See also:**  
Adjust Grid and Grid Snap

**SOLDRAW**

Generates profiles and sections in layout viewports created with SOLVIEW.
**Access Methods**

**Menu:** Draw ➤ 3D Modeling ➤ Setup ➤ Drawing

**Summary**

After using SOLVIEW, visible and hidden lines representing the silhouette and edges of solids in the viewport are created and then projected to a plane perpendicular to the viewing direction.

**List of Prompts**

The following prompts are displayed.

Select viewports to draw ...

Select objects: *Select the viewports to be drawn*

SOLDRAW can only be used in viewports that have been created with SOLVIEW (page 1009).

Visible and hidden lines representing the silhouette and edges of solids in the viewport are created and then projected to a plane perpendicular to the viewing direction. Silhouettes and edges are generated for all solids and portions of solids behind the cutting plane. For sectional views, cross-hatching is created using the current values of the HPNAME (page 1365), HPSCALE (page 1367), and HPANG (page 1357) system variables.

Any existing profiles and sections in the selected viewport are deleted, and new ones are generated. All layers, except those required to display the profile or section, are frozen in each viewport.

**WARNING** Do not place permanent drawing information on the view name-VIS, view name-HID, and view name-HAT layers. The information stored on these layers is deleted and updated when SOLDRAW is run.

To undo a viewport drawn by SOLDRAW, you must use the Back option of UNDO (page 1125).

**See also:**

Create a Flattened View

**SOLID**

Creates solid-filled triangles and quadrilaterals.
Summary

2D solids are filled only when the FILLMODE (page 1336) system variable is on (1) and the viewing direction is orthogonal to the 2D solid.

List of Prompts

The following prompts are displayed.
First point Sets the first point in the 2D solid.
Second point Sets the first edge of the 2D solid.
Third point Sets the corner that is opposite the second point.
Fourth point or <exit> The fourth point is diagonally opposite the first point. Pressing Enter at the Fourth Point prompt creates a filled triangle. Specifying a fifth point creates a quadrilateral area.

Specifying successive third and fourth points creates further connected triangles and four-sided polygons in a single solid object.

See also:
Overview of Hatch Patterns and Fills

SOLIDEEDIT

Edits faces and edges of 3D solid objects.
**Access Methods**

Button

_toolbar: Modeling tool set ➤ Solids - Edit tool group (expanded)

**Summary**

You can extrude, move, rotate, offset, taper, copy, delete, and assign colors and materials to faces. You can also copy and assign colors to edges. You can imprint, separate, shell, clean, and check the validity of the entire 3D solid object (body).

You cannot use SOLIDEDIT with mesh objects. However, if you select a closed mesh object, you will be prompted to convert it to a 3D solid.

**List of Prompts**

The following prompts are displayed.

```
Enter a solids editing option [Face/Edge/Body/Undo/Exit] <Exit>:
```

**Face**

**Face**

Edits selected 3D solid faces by extruding, moving, rotating, offsetting, tapering, deleting, copying, or changing their color.

Enter a face editing option [Extrude (page 991)/Move (page 995)/Rotate (page 996)/Offset (page 998)/Taper (page 999)/Delete (page 1000)/Copy (page 1000)/Color (page 1001)/Material (page 1001)/Undo (page 1002)/Exit (page 1002)]:

**Face: Extrude**

Extrude Extends a 3D solid face in the X, Y, or Z direction. You can change the shape of the object by moving its faces.
Select faces. Specifies which faces to modify.

Undo (page 992)

Remove (page 992)

Remove Removes previously selected faces from the selection set.

Remove faces. Removes the selected face from the solid object.

Undo (page 992)

Add (page 992)

All (page 993)

Undo Cancels the selection of the faces you added most recently to the selection set and redisplay the prompt.

Add Adds faces you select to the selection set.
Select faces. Selects specific faces (instead of all of them).
- **Undo** (page 992)
- **Remove** (page 992)
- **All** (page 993)

**All** Selects all faces and adds them to the selection set.

**Height of extrusion** Sets the direction and distance of the extrusion. Entering a positive value extrudes the face in the direction of its normal. Entering a negative value extrudes the face in the direction opposite to its normal.

**Angle of taper for extrusion.** Specify an angle between -90 and +90 degrees.
Tapering the selected face with a positive angle tapers the face in, and a negative angle tapers the face out. The default angle, 0, extrudes the face perpendicular to its plane. All selected faces in the selection set are tapered to the same value. If you specify a large taper angle or height, you can cause the face to taper to a point before it reaches the extrusion height.

Path Sets a path for the extrusion path based on a specified line or curve. All the profiles of the selected face are extruded along the chosen path to create the extrusion.

■ Select an extrusion path.

Lines, circles, arcs, ellipses, elliptical arcs, polylines, or splines can be paths. The path should not lie on the same plane as the face, nor should it have areas of high curvature.

The extruded face starts from the plane of the profile and ends on a plane perpendicular to the path at the path's endpoint. One of the endpoints of the path should be on the plane of the profile; if not, the path is moved to the center of the profile.
If the path is a spline, the path should be perpendicular to the plane of the profile and at one of the endpoints of the path. If not, the profile is rotated to be perpendicular to the spline path. If one of the endpoints of the spline is on the plane of the face, the face is rotated about the point; otherwise, the spline path is moved to the center of the profile and the profiles are rotated about its center.

If the path contains segments that are not tangent, the object is extruded along each segment and then the joint along the plane is mitred, bisecting the angle formed by the segments. If the path is closed, the profile lies on the miter plane. This allows the start and end sections of the solid to match up. If the profile is not on the miter plane, the path is rotated until it is on the miter plane.

**Face: Move**

**Move** Moves the selected face on a 3D solid object to a specified height or distance. You can select multiple faces at one time.

![Face Move Diagram]

- **Select faces** (page 996)
- **Undo**. Cancels selection of the faces that you selected most recently.
- **Remove** (page 992)
- **All** (page 993)

You can change the shape of the object by moving its faces. This option is recommended for minor adjustments.
Select faces Specifies the face to be moved.

- **Base point of displacement.** Sets the base point for the move. If you specify a single point, usually entered as a coordinate, and then press Enter, the coordinate is used as the new location.

- **Second point of displacement.** Sets a displacement vector that indicates how far the selected face is moved and in what direction.

**Face: Rotate**

Rotate Rotates one or more faces or a collection of features on a solid about a specified axis.

You can change the shape of the object by rotating its faces. This option is recommended for minor adjustments.

- **Select faces (rotate)** (page 996)
- **Undo.** Cancels selection of the faces that you selected most recently.
- **Remove** (page 992)
- **All** (page 993)

Select faces (rotate) Rotates the face according to the specified angle and axis. In the drawing area, select one or more faces.

- **Axis point** (page 996)
- **Axis by object** (page 997)
- **View** (page 997)
- **Xaxis, Yaxis, Zaxis** (page 998)
- **2Point** (page 996)

Axis point, 2Point Sets two points to define the axis of rotation.
Pressing Enter at the main Rotate prompt displays the following prompts. Specifying a point at the main prompt skips the prompt for the first point:

- **First point on the rotation axis.** Sets the first point on the axis of revolution.
- **Second point on the rotation axis.** Sets the second point on the axis.
  - **Rotation angle** (page 998)
  - **Reference** (page 998)

**Axis by object** Aligns the axis of rotation with an existing object. You can select the following objects:

- **Line:** Aligns the axis with the selected line.
- **Circle:** Aligns with the 3D axis of the circle (perpendicular to the plane of the circle and passing through the center of the circle).
- **Arc:** Aligns with the 3D axis of the arc (perpendicular to the plane of the arc and passing through the center of the arc).
- **Ellipse:** Aligns with the 3D axis of the ellipse (perpendicular to the plane of the ellipse and passing through the center of the ellipse).
- **2D polyline:** Aligns with the 3D axis formed by the polyline start points and endpoints.
- **3D polyline:** Aligns with the 3D axis formed by the polyline start points and endpoints.
- **Spline:** Aligns with the 3D axis formed by the spline's start points and endpoints.

**View** Aligns the axis of rotation with the viewing direction of the current viewport that passes through the selected point.

- **Origin of rotation** (page 998)
  - **Rotation angle** (page 998)
Xaxis, Yaxis, Zaxis Aligns the axis of rotation with the axis (X, Y, or Z) that passes through the selected point.

- **Origin of rotation** (page 998)
  - **Rotation angle** (page 998)
  - **Reference** (page 998)

**Origin of rotation** Sets the point of rotation.
- **Rotation angle** (page 998)
- **Reference** (page 998)

**Rotation angle** Rotates the object about the selected axis the specified amount from the current orientation.

**Reference** Specifies the reference angle and the new angle.
- **Reference (starting) angle.** Sets the start point for the angle.
- **Ending angle.** Sets the endpoint for the angle. The difference between the starting angle and the ending angle is the computed rotation angle.

**Face: Offset**

Offset Offsets faces equally by a specified distance or through a specified point. A positive value increases the size or volume of the solid. A negative value decreases the size or volume of the solid.

- **Select faces (offset)** (page 998)
- **Undo** (page 992)
- **Remove** (page 992)
- **All** (page 993)

**Select faces (offset)** Specifies the faces you want to offset.

**NOTE** The size of holes inside a solid object that is offset decreases as the volume of the solid increases.
Specify the offset distance. Sets a positive value to increase the size of the solid or a negative value to decrease the size of the solid.

Face: Taper

Taper Tapers faces on a 3D solid at a specified angle. The rotation of the taper angle is determined by the selection sequence of the base point and second point along the selected vector.

A positive angle tapers the face in, and a negative angle tapers the face out. The default angle, 0, extrudes the face perpendicular to its plane. All selected faces in the selection set are tapered to the same value.

Select faces (taper) (page 1000)

Undo (page 992)
- **Remove** (page 992)
- **All** (page 993)

**Select faces (taper)** Specifies the faces to be tapered and then sets the slope of the taper.

- **Base point.** Sets the first point for determining the plane.
- **Another point along the axis of tapering.** Sets the orientation of the axis that determines the direction of the taper.
- **Taper angle.** Specify an angle between -90 and +90 degrees to set the slope of the taper from the axis.

**Face: Delete**
Delete Deletes or removes faces, including fillets and chamfers.

Use this option to remove and later modify filleted and chamfered edges. The face is not deleted if the change results in a non-valid 3D solid.

![Image](image.png)

- **Select faces (copy)** (page 1001)
- **Undo.** Cancels the selection of the faces that you selected most recently.
- **Remove** (page 992)
- **All** (page 993)

**Select faces (delete)** Specifies the face to be removed. The face must be in a location that can be filled by surrounding faces after it is removed.

**Face: Copy**
Copy Copies faces as a region or a body. If you specify two points, SOLIDEDIT uses the first point as a base point and places a single copy relative to the base point. If you specify a single point (usually entered as a coordinate) and then press Enter, SOLIDEDIT uses the coordinate as the new location.
Creates a new object with the original orientation and profile of the face. The result can be used as a reference to create a new 3D solid.

- **Select faces (copy)** (page 1001)
- **Undo.** Cancels the selection of the faces that you selected most recently.
- **Remove** (page 992)
- **All** (page 993)

**Select faces (copy)** Specifies the face to be copied.

- **Base point or displacement.** Sets the first point to determine the distance and direction for the placement of the copied face (displacement).
- **Second point of displacement.** Sets the second displacement point.

**Face: Color**

Color Changes the color of faces.

Colored faces can be used to highlight details within a complex 3D solid model.

- **Select faces (color)** (page 1001)
- **Undo.** Cancels the selection of the faces that you selected most recently.
- **Remove** (page 992)
- **All** (page 993)

**Select faces (color)** Specifies the faces to be modified. The Color Palette dialog box (page 205) is displayed.

**Face: Material**

Material Assigns a material to selected faces.

- **Select faces (material)** (page 1002)
- **Undo.** Cancels the selection of the faces that you selected most recently.
- **Remove** (page 992)
- **All** (page 993)

Select faces (material) Specifies the faces to be modified. The **Color Palette dialog box** (page 205) is displayed.

- **Enter new material name.** Enter the name of the material to be assigned to the selected face. (The name of a material can be found by opening the Materials window and selecting the material swatch to display the name in the Name field.)

- **ByLayer.** Assigns the material based on the layer assignment.

**Face: Undo**
Reverses actions as far back as the beginning of the SOLIDEDIT session.

**Face: Exit**
Exits the face-editing options and displays the Enter a Solids Editing Option prompt.

**Edge**

**Edge**
Edits 3D solid objects by changing the color of or copying individual edges.

Enter an edge editing option [**Copy** (page 1002)/**coLor** (page 1003)/**Undo** (page 1003)/**eXit** (page 1004)] <**eXit>>:

**Edge: Copy**
Copies selected edges on a 3D solid as 2D arcs, circles, ellipses, lines, or splines.

![Diagram of edge selection and copying process]

edge selected  base point and second point selected  edge copied

Retains the angle of the edge and allows you to make modifications and extensions, and create new geometry based on the extracted edge.

Provides a method for making modifications, extensions, and new 3D solids based on the extracted edge.

- **Select Edges (copy)** (page 1003)
- **Undo** (page 1003)
- **Remove** (page 1003)

**Select Edges (copy)** Specifies the edges to copy. Press Ctrl+click to select the edge. Then set the displacement:

- **Base point of displacement.** Sets the first point for determining where the new object is placed.
- **Second point of displacement.** Sets the relative direction and distance for the new object.

**Undo** Cancels selection of the edges you added most recently to the selection set. The previous prompt is displayed. If all edges have been removed, the following prompt is displayed:

**Remove** Removes previously selected edges from the selection set. The prompt is redisplayed.

- **Remove edges.** Removes the edges you select from the current selection set.
- **Undo** (page 1003)
- **Add** (page 1003)

**Add** Adds edges to the selection set.

- **Select Edges (copy)** (page 1003)
- **Undo** (page 1003)
- **Remove** (page 1003)

**Edge: Color**
Changes the color of individual edges on a 3D solid object.

- **Select edges (color)** (page 1003)
- **Undo** (page 1003)
- **Remove** (page 1003)

**Select edges (color)**
Colored edges can be used to highlight intersections, interferences, or critical clearances.

Press Ctrl+click to select the edge.

**Edge: Undo**
Reverses actions as far back as the beginning of the SOLIDEDIT session.
**Edge: Exit**
Exits the face-editing options and displays the Enter a Solids Editing Option prompt.

**Body**

**Body**
Edits the entire solid object by imprinting other geometry on the solid, separating the solid into individual solid objects, shelling, cleaning, or checking the selected solid.

Enter a body editing option [Imprint (page 1004)/Separate solids (page 1004)/Shell (page 1005)/Clean (page 1006)/Check (page 1006)/Undo (page 1006)/Exit (page 1006)]

<Exit>:

**Body: Imprint**
Imprints an object on the selected solid. The object to be imprinted must intersect one or more faces on the selected solid in order for imprinting to be successful. Imprinting is limited to the following objects: arcs, circles, lines, 2D and 3D polylines, ellipses, splines, regions, bodies, and 3D solids.

- **Select a 3D solid.** Specifies the 3D solid to be imprinted.
- **Select an object to imprint.** Specifies an object that overlaps the first selection.
- **Delete the source object.** Specifies whether the object to imprint is removed when the operation is complete.

**Body: Separate Solids**
Separates 3D solid objects with disjointed volumes (sometimes called lumps) into independent 3D solid objects. Combining discrete solid objects using a union operation (UNION) can result in disjointed volumes.
A union or subtract operation can result in a single 3D solid that consists of more than one continuous volume. You can separate these volumes into independent 3D solids.

NOTE Separating solids does not separate Boolean objects that form a single volume.

Select a 3D solid Specifies the 3D solid object to separate. Press Ctrl+click to select the edge.

Body: Shell
Shelling creates a hollow, thin wall with a specified thickness. You can specify a constant wall thickness for all the faces. You can also exclude faces from the shell by selecting them. A 3D solid can have only one shell. New faces are created by offsetting existing ones outside their original positions.

It is recommended that you create a copy of a 3D solid before converting it into a shell. That way if you need to make significant modification, use the original version and shell it again.

Select a 3D solid (shell) Specifies a 3D solid.
- Remove faces. Specifies the face subobjects to be removed when the object is shelled.
- Undo. Reverses the last action.
■ **Add.** Press Ctrl+click an edge to indicate which faces to retain.

■ **All.** Temporarily selects all faces for removal. You can then use Add to add the faces you want to retain.

**Enter the shell offset distance** Sets the size of the offset. Specify a positive value to create a shell to the inside perimeter of the solid. Specify a negative value to create a shell on the outside perimeter of the solid.

**Body: Clean**
Removes shared edges or vertices having the same surface or curve definition on either side of the edge or vertex. Removes all redundant edges, vertices, and unused geometry. Does not remove imprinted edges.

In unusual circumstances, this option removes shared edges or vertices having the same surface or curve definition on either side of the edge or vertex.

![solid selected](image1)  ![solid cleaned](image2)

**Select a 3D solid (clean)** Specifies a 3D solid object that you want to clean.

**Body: Check**
Validates the 3D solid object as a valid solid, independent of the **SOLIDCHECK** (page 1485) setting.

■ **Select a 3D object (check).** Specifies the 3D solid object to be validated.

  If the object is valid, the following prompt is displayed:

  This object is a valid ShapeManager solid.

This option is used as a debugging tool to compare stages in a highly complex 3D solid model.

**Body: Undo**
Undoes the editing action.

**Body: Exit**
Exits the face-editing options and displays the Enter a Solids Editing Option prompt.
**Undo**

**Undo**
Undoes the editing action.

**Exit**

**Exit**
Exits the SOLIDEDIT command.

**See also:**

Clean and Check 3D Solids

---

**SOLPROF**

Creates 2D profile images of 3D solids for display in a layout viewport.

**Access Methods**

Menu: Draw ➤ 3D Modeling ➤ Setup ➤ Profile

**Summary**

The selected 3D solids are projected onto a 2D plane parallel with the current layout viewport. The resulting 2D objects are generated on separate layers for hidden and visible lines and are displayed only in that viewport.

**List of Prompts**

The following prompts are displayed.

Select objects: *Use an object selection method*

Display hidden profile lines on separate layer? [Yes (page 1007)/No (page 1008)] <Y>: Enter

*Yes* Generates only two blocks: one for the visible lines and one for the hidden lines of the entire selection set. When you generate hidden lines, solids can partially or completely hide other solids. The visible profile block is drawn in the BYLAYER linetype, and the hidden profile block is drawn in the HIDDEN linetype (if loaded). The visible and hidden profile blocks are placed on uniquely named layers using the following naming conventions:

PV-viewport handle for the visible profile layer
PH-viewport handle for the hidden profile layer

For example, if you create a profile in a viewport whose handle is 4B, the blocks containing the visible lines are inserted on layer PV-4B, and the block containing the hidden lines (if requested) is inserted on layer PH-4B. If these layers do not exist, the command creates them. If the layers do exist, the blocks are added to the information already on the layers.

**NOTE** To determine the handle of a viewport, select the viewport while in paper space and use the LIST (page 583) command. Choose a layout tab to move from model space to paper space.

SOLPROF does not change the display of layers; if you want to view only the profile lines that you have created, turn off the layer containing the original solid (usually the current layer).

**No** Treats all profile lines as visible lines and creates a block for the profile lines of each selected solid. All profile lines for each solid in the selection set are generated, even if a solid is partially or completely obscured by another solid. The visible profile blocks are drawn in the same linetype as the original solid and placed on a uniquely named layer using the naming convention described under the Yes option.

![profile with hidden lines removed](image1)

![profile with hidden lines displayed](image2)

**NOTE** Solids that overlap each other (share some common volume) produce dangling edges if you request hidden-line removal. This happens because the edges must be broken at the point where they enter another solid to separate them into visible and hidden portions. You can eliminate dangling edges by combining the overlapping solids (using UNION (page 1128)) before generating a profile.

**Yes** Creates the profile lines with 2D objects.

The 3D profile is projected onto a plane normal to the viewing direction and passing through the origin of the UCS. SOLPROF cleans up the 2D profile by eliminating lines that are parallel to the viewing direction and by converting arcs and circles that are viewed on edge into lines.
No Creates the profile lines with 3D objects.
The next prompt determines whether tangential edges are displayed. A
tangential edge is the transition line between two tangent faces. It's the
imaginary edge at which two faces meet and are tangent. For example, if you
fillet the edge of a box, tangential edges are created where the cylindrical face
of the fillet blends into the planar faces of the box. Tangential edges are not
shown for most drafting applications.

See also:
Create a Flattened View

SOLVIEW

Creates orthographic views, layers, and layout viewports automatically for 3D
solids.

Access Methods

Menu: Draw ➤ 3D Modeling ➤ Setup ➤ View

Summary

This command automates the manual process of creating views, layers, and
layout viewports for 3D models. For ongoing work, it is recommended that
you create drawing template (DWT) files customized for 3D.

NOTE SOLVIEW must be run on a layout tab. If the Model tab is current, the last
active layout tab is made current.
List of Prompts

The following prompts are displayed.
Enter an option [Ucs (page 1010)/Ortho (page 1012)/Auxiliary (page 1012)/Section (page 1013)]: Enter an option or press Enter to exit the command

SOLVIEW places the viewport objects on the VPORTS layer, which it creates if it does not already exist. The view-specific information that is saved with each viewport you create is used by SOLDRAW (page 988) to generate the final drawing view.

SOLVIEW creates layers that SOLDRAW uses to place the visible lines and hidden lines for each view, view name-VIS, view name-HID, view name-HAT, and a layer where you can place dimensions that are visible in individual viewports, view name-DIM.

**WARNING** The information stored on these layers is deleted and updated when you run SOLDRAW (page 988). Do not place permanent drawing information on these layers.

**UCS**

Creates a profile view relative to a user coordinate system. If no viewports exist in your drawing, the UCS option is a good way to create an initial viewport from which other views can be created. All other SOLVIEW options require an existing viewport.

You have the option of using the current UCS or a previously saved one as the profile plane. The viewport projection is created parallel to the XY plane of the UCS with the X axis facing right and the Y axis upward.
Named Uses the XY plane of a named UCS to create a profile view.
Enter the name of the UCS you want to use and the scale of your view. Entering
a scale is equivalent to zooming your viewport by a factor relative to paper
space.
The center is based on the current model space extents.

World Uses the XY plane of the WCS to create a profile view.
Enter the name of the UCS you want to use and the scale of your view. Entering
a scale is equivalent to zooming your viewport by a factor relative to paper
space.
The center is based on the current model space extents.

?—List Named UCs Lists the names of existing user coordinate systems. The
list is filtered using the wild-card combinations you enter (wild-card characters
accepted by the UCS command are valid).

Current Uses the XY plane of the current UCS to create a profile view.
Enter the name of the UCS you want to use and the scale of your view. Entering
a scale is equivalent to zooming your viewport by a factor relative to paper
space.
The center is based on the current model space extents.
Ortho
Creates a folded orthographic view from an existing view.

Once you select the side of the viewport you want to use for projecting the new view, a rubber-band line perpendicular to the side of the viewport helps you locate the center of the new view.

Auxiliary
Creates an auxiliary view from an existing view. An auxiliary view is one that is projected onto a plane perpendicular to one of the orthographic views and inclined in the adjacent view.
Two points define the inclined plane used for the auxiliary projection. Both points must be located in the same viewport.

A rubber-band line perpendicular to the inclined plane helps you select the center of the new viewport.

**Section**
Creates a drafting sectional view of solids, complete with cross-hatching. When you use **SOLDRAW** (page 988) on a sectional view created with this option, it creates a temporary copy of the solids and uses **SLICE** (page 981) to perform the operation at the cutting plane that you define. **SOLDRAW** then generates a profile of the visible half of the solids and discards the original copy. Finally **SOLDRAW** sections the solids. Solids not crossing the cutting plane are generated as full profiles. Because drafting standards recommend not drawing hidden lines in sectional views, **SOLVIEW** freezes the **View Name-HID** layer.
In the original viewport, specify two points to define the sectioning plane. Define the viewing side by specifying a point on one side of the cutting plane.

Enter the scale of the new view. Entering a scale is equivalent to zooming your viewport by a factor relative to paper space. The default value is a 1:1 scale, which is equivalent to \texttt{zoom 1.0xp}.

At the next prompt, specify the center of the new viewport. If you accepted the default scale (by pressing Enter), a rubber-band line perpendicular to the sectioning plane helps you locate the center of the new view. Otherwise, you can place the view anywhere.

\textbf{See also:}

- Create a Flattened View

\textbf{SPELL}

Checks spelling in a drawing.

\textbf{Access Methods}

\begin{itemize}
  \item \texttt{ABC}
  \item Button
\end{itemize}
Summary

When you enter `spell` at the Command prompt, the Check Spelling dialog box (page 1015) is displayed. Select the Start button to begin the spelling check.

If Check Spelling is set to Entire Drawing, spelling is checked on the Model layout, then on named (paper space) layouts. If a flagged word is identified, the drawing area highlights and zooms to that word.

**NOTE** Invisible text such as text on hidden layers, and hidden block attributes is not checked. Non-uniformly scaled blocks and objects not on the supported annotation scale are also not checked.

See also:

Check Spelling

Check Spelling Dialog Box

Displays the spelling checker dialog box that picks and displays the wrongly spelt words and suggests alternate words.
Summary

Checks the spelling in single-line text, multiline text, multileader text, text within block attributes, text within xrefs, and text added to dimensions.

In block attributes, only the attribute values are checked. The spelling in text objects within block references and nested block references is checked, but spell checking in block definitions is performed only if the associated block reference has been selected.

List of Options

The following options are displayed.

Search

Displays the areas you want checked for spelling.
Select Objects
Limits the spelling check to the selected single-line text, multiline text, dimension text, multileader text, text within block attributes, and text within xrefs.

Not in Dictionary
Displays the word identified as misspelled.

Suggestions
Displays a list of suggested replacement words from the current dictionary.
You can select another replacement word from the list, or edit or enter a replacement word in the top Suggestions text area.

Start
Starts checking text for spelling errors.

Change
Replaces the current word with the word in the Suggestions box.

Change All
Replaces the current word in all selected text objects in the spell check area.

Add Word
Adds the current word to the current custom dictionary. The maximum word length is 63 characters.

Ignore Once
Skips the current word.

Ignore All
Skips all remaining words that match the current word.

Undo
Reverses the previous check spelling action or series of actions, including Ignore, Ignore All, Change, Change All, and Add Word.

Show/Hide Options
Controls the display of advanced search options.

Include
Dimension Text
Searches dimension text.

Block Attributes
Searches block attributes text for spelling errors.

External References
Specifies to search external references for spelling errors.

**Options**

**Ignore Capitalized Words**
Specifies to ignore capitalized words.

**Ignore Words with Mixed Cases**
Specifies to ignore words that contain uppercase and lowercase letters.

**Ignore Words in Uppercase**
Specifies to ignore words that are in all uppercase.

**Ignore Words with Numbers**
Specifies to ignore words that include numbers.

**Ignore Words Containing Punctuation**
Specifies to ignore words that contain punctuation.

**See also:**
      Check Spelling

**Check Spelling Settings Dialog Box**

Provides options to change the way the default behavior of the spelling checker in the In-place Text editor.
Summary

Specifies specific text options that will be checked in your drawing.

List of Options

The following options are displayed.

Include

- **Dimension Text**
  Searches dimension text.
- **Block Attributes**
  Searches block attributes text for spelling errors.
- **External References**
  Specifies to search external references for spelling errors.

Options

- **Ignore Capitalized Words**
  Specifies to ignore capitalized words.
- **Ignore Words with Mixed Cases**
  Specifies to ignore words that contain uppercase and lowercase letters.
Ignore Words in Uppercase
Specifies to ignore words that are in all uppercase.

Ignore Words with Numbers
Specifies to ignore words that include numbers.

Ignore Words Containing Punctuation
Specifies to ignore words that contain punctuation.

See also:
Check Spelling

**SPHERE**

Creates a 3D solid sphere.

**Access Methods**

- **Button**
  - Toolbar: Modeling tool set ➤ Solids - Create tool group ➤ Solid Primitives flyout ➤ Sphere
  - Menu: Draw ➤ 3D Modeling ➤ Sphere

**Summary**

You can create a sphere by specifying a center point and a point on the radius. You can control the smoothness of curved 3D solids, such as a sphere, in a shaded or hidden visual style with the FACETRES system variable.
List of Prompts

The following prompts are displayed. Specify center point (page 1021) or [3P (page 1021)/2P (page 1021)/Ttr (page 1022)]: Specify a point or enter an option

Center Point
Specifies the center point of the sphere.

When you specify the center point, the sphere is positioned so that its central axis is parallel to the $Z$ axis of the current user coordinate system (UCS). Latitudinal lines are parallel to the $XY$ plane.

Radius Defines the radius of the sphere.

Diameter Defines the diameter of the sphere.

3P (Three Points)
Defines the circumference of the sphere by specifying three points anywhere in 3D space. The three specified points also define the plane of the circumference.

2P (Two Points)
Defines the circumference of the sphere by specifying two points anywhere in 3D space. The plane of the circumference is defined by the $Z$ value of the first point.
**TTR (Tangent, Tangent, Radius)**
Defines the sphere with a specified radius tangent to two objects. The specified
tangency points are projected onto the current UCS.

**See also:**
Create a Solid Sphere

**SPLINE**
Creates a smooth curve that passes through or near a set of fit points, or that is defined by the vertices in a control frame.

**Access Methods**

- **Button**
- **Toolbar:** Drafting tool set ➤ Open Shapes tool group ➤ Spline
- **Menu:** Draw ➤ Spline ➤ Fit Points
- **Menu:** Draw ➤ Spline ➤ Control Vertices

**Summary**
SPLINE creates curves called *nonuniform rational B-splines* (NURBS), referred to as splines for simplicity.

Splines are defined either with fit points, or with control vertices. By default, fit points coincide with the spline, while control vertices define a *control frame*. Control frames provide a convenient method to shape the spline. Each method has its advantages.
To display or hide the control vertices and control frame, select or deselect the spline, or use CVSHOW (page 253) and CVHIDE (page 248).

For splines created with control vertices, you can display the control frame by selecting the spline.

**List of Prompts**

The prompts that display depend on whether you create a spline with fit points or with control vertices.

For splines created with the fit point method:
Specify first point or [Method (page 1023)/Degree (page 1026)/Object (page 1024)]:

For splines created with the control vertices method:
Specify first point or [Method (page 1023)/Knots (page 1025)/Object (page 1024)]:

**First Point**
Specifies the first point of the spline, either the first fit point or the first control vertex, depending on the current method.

**Method**
Controls whether the spline is created with fit points or with control vertices. (SPLMETHOD (page 1490) system variable)

Fit Creates a degree 3 (cubic) B-spline by specifying fit points that the spline must pass through. When the tolerance value is greater than 0, the spline must be within the specified tolerance distance from each point.

Changing the Method updates the SPLMETHOD (page 1490) system variable.

**Control Vertices** Creates a spline by specifying control vertices. Use this method to create splines of degree 1 (linear), degree 2 (quadratic), degree 3...
(cubic), and so on up to degree 10. Adjusting the shape of a spline by moving control vertices often provides better results than moving fit points.

This is the preferred method if you are creating geometry to use with 3D NURBS surfaces.

**Object**
Converts 2D or 3D quadratic or cubic spline-fit polylines to equivalent splines. The original polyline is retained or discarded depending on the setting of the `DELOBJ` (page 1251) system variable.

**Next Point**
Creates additional spline segments until you press Enter.

**Undo**
Removes the last specified point.

**Close**
Closes the spline by defining the last point to be coincident with the first. By default, closed splines are periodic, maintaining curvature continuity (C2) along the entire loop.
Options for Splines with Fit Points

The following options are specific to the fit point method.

**Knots** Specifies the knot parameterization, one of several computational methods that determines how the component curves between successive fit points within a spline are blended. ([SPLKNOTS](page 1489) system variable)

- **Chord** (or Chord-Length method). Spaces the knots connecting each component curve to be proportional to the distances between each associated pair of fit points. An example is the green curve in the illustration.

- **Square Root** (or Centripetal method). Spaces the knots connecting each component curve to be proportional to the square root of the distance between each associated pair of fit points. This method usually produces “gentler” curves. An example is the blue curve in the illustration.

- **Uniform** (or Equidistant method). Spaces the knots of each component curve to be equal, regardless of the spacing of the fit points. This method often produces curves that overshoot the fit points. An example is the magenta curve in the illustration.

**Start Tangency** Specifies a tangent condition on the starting point of the spline.
End Tangency Specifies a tangent condition on the ending point of the spline.

Tolerance Specifies the distance by which the spline is allowed to deviate from the specified fit points. A tolerance value of 0 requires the resulting spline to pass directly through the fit points. The tolerance value applies to all fit points except the starting and ending fit points, which always have a tolerance of 0.

Options for Splines with Control Vertices

The following option is specific to the control vertices (CV) method. (SPLMETHOD (page 1490) system variable)

Degree Sets the polynomial degree of the resulting spline. Use this option to create splines of degree 1 (linear), degree 2 (quadratic), degree 3 (cubic), and so on up to degree 10.

See also:

Draw Splines
SPLINEDIT

Modifies the parameters of a spline or converts a spline-fit polyline to a spline.

Access Methods

Menu: Modify ➤ Object ➤ Spline
Shortcut menu: Select a spline to edit. Right-click in the drawing area and click Spline.

Summary

Modifies the data that defines a spline, such as the number and weight of control vertices, the fit tolerance, and the starting and ending tangents.

NOTE SPLINEDIT automatically converts spline-fit polylines to splines even if you immediately exit SPLINEDIT after selecting the spline-fit polyline.

The data that defines a spline is represented in one of two formats: as a control frame or as fit points. The format can change depending on how the spline was originally created, the options selected from the grip menus, or the options used in SPLINEDIT.

You can change any of following data:

■ Control frame data consists of control vertices, the polynomial degree of the spline, and the weights assigned to each control vertex.
■ Fit data consists of fit points, knot parameterization, the fit tolerance, and the tangents at the endpoints of the spline.

NOTE Switching from displaying control vertices to fit points automatically changes the selected spline to degree 3. Splines originally created using higher-degree equations will likely change shape as a result. In addition, if the spline was created using a positive tolerance value, the fit points will be relocated to the knots on the spline, and the tolerance value is reset to 0.

List of Prompts

The following prompts are displayed.
Select spline:
Enter an option [Close (page 1028)/Join (page 1028)/Fit data (page 1028)/Edit Vertex (page 1030)/convert to Polyline (page 1031)/Reverse (page 1031)/Undo (page 1031)] <eXit>: 
**Close/Open**

One of the following options displays, depending on whether the selected spline is open or closed. An open spline has two endpoints, while a closed spline forms a loop.

**Close** Closes an open spline by defining the last point to be coincident with the first. By default, closed splines are periodic, maintaining curvature continuity (C2) along the entire curve.

**Open** Opens a closed spline by removing the final curve segment between the first and last points specified when the spline was originally created.

**Join**

Combines a selected spline with other splines, lines, polylines, and arcs at coincident endpoints to form a larger spline. Objects are joined with kinks at the points where they are joined (C0 continuity).

**Fit Data**

Edits fit point data using the following options:

Enter a fit data option [Add (page 1028)/Close (page 1029)/Delete (page 1029)/Kink (page 1029)/Move (page 1029)/Purge (page 1029)/Tangents (page 1029)/toLerance (page 1030)/eXit (page 1030)] <eXit>:

**Add**

Adds fit points to the spline.

After selecting a fit point, specify a new fit point to be added to the spline in the direction of the next fit point, which is automatically highlighted.

If you select the last fit point on an open spline, the new fit point is added to the end of the spline.

If you select the first fit point on an open spline, you have the option of specifying whether the new fit point is added before or after the first point.

![Diagram showing fit points and spline](image.png)
**Close/Open**
One of the following options displays, depending on whether the selected spline is open or closed. An open spline has two endpoints, while a closed spline forms a loop.

Close Closes an open spline by defining the last point to be coincident with the first. By default, closed splines are periodic, maintaining curvature continuity (C2) along the entire curve.

Open Opens a closed spline by removing the final curve segment between the first and last points specified when the spline was originally created.

**Delete**
Removes selected fit points from a spline.

**Kink**
Adds a knot and fit point at the specified location on the spline, which does not maintain tangent or curvature continuity at that point.

**Move**
Moves fit points to new locations.

**New Location** Moves the selected fit point to the specified location.

**Next** Selects the next fit point.

**Previous** Selects the previous fit point.

**Select Point** Select any fit point on the spline.

**Purge**
Replaces the fit data from the spline with control vertices.

**Tangents**
Changes the starting and ending tangents of a spline. Specify a point to establish a tangent direction. You can use object snaps such as Perpendicular or Parallel.

If the spline is closed, the prompt becomes Specify Tangent or [System Default].
The System Default option calculates the default end tangents.

**Tolerance**
Refits the spline to the existing fit points using the new tolerance value.

![Diagram showing zero and positive tolerance]

**Exit**
Returns to the previous prompt.

**Edit Vertex**
Edits control frame data using the following options:

Enter a vertex editing option [Add (page 1030)/Delete (page 1030)/Elevate order (page 1030)/Move (page 1030)/Weight (page 1030)/eXit (page 1031)] <eXit>:

**Add**
Adds a new control vertex at the point you specify that is located between two existing control vertices.

**Delete**
Removes a selected control vertex.

**Elevate Order**
Increases the polynomial order (degree plus one) of the spline. This results in increasing the number of control vertices across the spline.

The maximum value is 26.

**Move**
Relocates a selected control vertex.

- **New Location** (page 1029)
- **Next** (page 1029)
- **Previous** (page 1029)
- **Select Point** (page 1029)

**Weight**
Changes the weight of a specified control vertex.
**New Weight** Recalculates the spline based on the new weight value for the specified control vertex. A larger value pulls the spline closer to the control vertex.

- **Next** (page 1029)
- **Previous** (page 1029)
- **Select Point** (page 1029)

**Exit**
Returns to the previous prompt.

**Convert to Polyline**
Converts the spline to a polyline.

The precision value determines how closely the resulting polyline matches the spline. Valid values are any integer between 0 and 99.

**NOTE** A high precision value will decrease performance.

The PLINECONVERTMODE (page 1436) system variable determines whether the polylines are created with linear or arc segments.

**Reverse**
Reverses the direction of the spline. This option is intended primarily for third-party applications.

**Undo**
Cancels the last action.

**Exit**
Returns to the Command prompt.

**See also:**
- Modify Splines

**SPOTLIGHT**

Creates a spotlight that emits a directional cone of light.

**Access Methods**

- **Button**
Summary

A spotlight distribution casts a focused beam of light like a flashlight, a follow spot in a theater, or a headlight.

List of Prompts

The following prompts are displayed.

Specify source location <0,0,0>: Enter coordinate values or use the pointing device

Specify target location <1,1,1>: Enter coordinate values or use the pointing device

If the LIGHTINGUNITS system variable is set to 0, the following prompt is displayed:

Enter an option to change [Name (page 1032)/Intensity (page 1032)/Status (page 1033)/Hotspot (page 1033)/Falloff (page 1033)/Shadow (page 1034)/Attenuation (page 1034)/Color (page 1035)/Exit (page 1035)] <Exit>:

If the LIGHTINGUNITS system variable is set to 1 or 2, the following prompt is displayed:

Enter an option to change [Name (page 1032)/Intensity factor (page 1032)/Photometry (page 1033)/Status (page 1033)/Hotspot (page 1033)/Falloff (page 1033)/Shadow (page 1034)/Attenuation (page 1034)/FilterColor (page 1035)/Exit (page 1035)] <Exit>:

**NOTE** When the LIGHTINGUNITS system variable is set to 1 or 2, the Attenuation option has no affect on the creation of the light. It is only maintained for scripting compatibility.

Name

Specifies the name of the light. You can use uppercase and lowercase letters, numbers, spaces, hyphens (-), and underscores (_) in the name.

Intensity/Intensity Factor

Sets the intensity or brightness of the light. The range is 0.00 to the maximum value that is supported by your system.
**Hotspot**
Specifies the angle that defines the brightest cone of light, which is known to lighting designers as the beam angle. This value can range from 0 to 160 degrees or the equivalent values based on AUNITS (page 1215).

**Falloff**
Specifies the angle that defines the full cone of light, which is also known as the field angle. This value can range from 0 to 160 degrees. The default is 50 degrees or the equivalent values based on AUNITS (page 1215). The falloff angle must be greater than or equal to the hotspot angle.

**Status**
Turns the light on and off.

**Photometry**
Photometry is the measurement of the luminous intensities of visible light sources. Photometry is available when the LIGHTINGUNITS system variable is set to 1 or 2.

In photometry, luminous intensity is a measure of the perceived power emitted by a light source in a particular direction. Luminous flux is the perceived power per unit of solid angle. The total luminous flux for a lamp is the perceived power emitted in all directions. Luminance is the total luminous flux incident on a surface, per unit area.

**Intensity** Enter an intensity value in candelas, the perceived power in a luminous flux value, or illuminance value for the total luminous flux incident on a surface.

- Candela (symbol: cd) is the SI unit of luminous intensity (perceived power emitted by a light source in a particular direction). Cd/Sr
- Lux (symbol: lx) is the SI unit of illuminance. Lm/m^2
- Foot-candle (symbol: fc) is the American unit of illuminance. Lm/ft^2

Enter f to specify the perceived power in a luminous flux value.
If you enter i, you can specify the intensity of the light based on an illuminance value.
The illuminance value can be specified in either lux or foot-candles. Enter d to specify a distance to use to calculate illuminance.

**Color** Specify the color of the light based on a color name or a Kelvin temperature. Enter ? to display a list of color names.
Enter a text string using wild card characters to display a partial listing of color names, or an asterisk (*) to display all the possible choices.
If you enter k, you can specify the color of the light based on a Kelvin temperature value.

**Shadow**

Makes the light cast shadows.

- **Off**
  - Turns off display and calculation of shadows for the light. Turning shadows off increases performance.

- **Sharp**
  - Displays shadows with sharp edges. Use this option to increase performance.

- **Soft Mapped**
  - Displays realistic shadows with soft edges.
    - **Map Size**
      - Specifies the amount of memory to use to calculate the shadow map.
    - **Softness**
      - Specifies the softness to use to calculate the shadow map.

- **Soft Sampled**
  - Displays realistic shadows with softer shadows (penumbra) based on extended light sources.
  - Specify the shape of the shadow by entering s and then the dimensions of the shape. (For example, the radius of the sphere or the length and width of a rectangle.)
  - Specify the sample size by entering a.
  - Specify the visibility of the shape by for the shadow by entering v.

**Attenuation**

**Attenuation Type** Controls how light diminishes over distance. The farther away an object is from a spotlight, the darker the object appears. Attenuation is also known as decay.

- **None**
  - Sets no attenuation. Objects far from the spotlight are as bright as objects close to the light.

- **Inverse Linear**
  - Sets attenuation to be the inverse of the linear distance from the light. For example, at a distance of 2 units, light is half as strong as at the spotlight; at a distance of 4 units, light is one quarter as strong. The default value for inverse linear is half the maximum intensity.

- **Inverse Squared**
  - Sets attenuation to be the inverse of the square of the distance from the light. For example, at a distance of 2 units, light is one quarter as strong as at the spotlight; at a distance of 4 units, light is one sixteenth as strong.

**Use Limits**

Specifies whether to use limits.

**Attenuation Start Limit**

Specifies the point where light starts as an offset from the center of the light. The default is 0.
**Attenuation End Limit** Specifies the point where light ends as an offset from the center of the light. No light is cast beyond this point. Setting an end limit increases performance where the effect of lighting is so minimal that the calculations are wasted processing time.

**Color/Filter Color**
Controls the color of the light.

- **True Color** Specifies a True Color. Enter in the format R,G,B (red, green, blue).
- **Index** Specifies an ACI (AutoCAD Color Index) color.
- **HSL** Specifies an HSL (hue, saturation, luminance) color.
- **Color Book** Specifies a color from a color book.

**Exit**
Exits the command.

**See also:**
Use Spotlights

---

**STATUS**
Displays drawing statistics, modes, and extents.

**Access Methods**

- **Menu:** Tools ➤ Inquiry ➤ Status
- **Command entry:** `status` for transparent use

**Summary**

All coordinates and distances are displayed by STATUS in the format specified by UNITS (page 1130).

STATUS reports the number of objects in the current drawing. This includes graphical objects such as arcs and polylines, and nongraphical objects such as layers and linetypes, and block definitions.

In addition to overall drawing statistics and settings, the amount of installed memory free on your system, the amount of disk space available, and the amount of free space in the swap file are also listed.
When used at the DIM prompt, STATUS reports the values and descriptions of all dimensioning system variables.

In addition, STATUS displays the following information.

**List of Options**

The following options are displayed.

**Model or Paper Space Limits Are** Displays the grid limits defined by LIMITS (page 575). The first line shows the XY coordinate of the limit's lower-left corner, stored in the LIMMIN (page 1393) system variable. The second line shows the XY coordinate of the limit's upper-right corner, stored in the LIMMAX (page 1393) system variable. The notation Off to the right of the Y coordinate value indicates that limits checking is set to 0.

**Model or Paper Space Uses** Displays the drawing extents, which includes all objects in the database and can exceed the grid limits. The first line shows the XY coordinate of the lower-left corner of the extents. The second line shows the XY coordinate of the upper-right corner. The notation Over to the right of the Y coordinate value indicates that the drawing extends outside the grid limits.

**Display Shows** Lists the portion of the drawing extents visible in the current viewport. The first line shows the XY coordinate of the display's lower-left corner. The second line shows the XY coordinate of the upper-right corner.

**Insertion Base Is** Specifies the point used when the drawing is inserted into another drawing as a block. (INSBASE (page 1373) system variable)

**Snap Resolution Is** Sets the snap spacing for the current viewport. (SNAPUNIT (page 1484) system variable)

**Grid Spacing Is** Specifies the grid spacing (X and Y) for the current viewport. (GRIDUNIT (page 1346) system variable)

**Current Space** Shows whether model space or paper space is active.

**Current Layout** Displays “Model” or the name of the current layout.

**Current Layer** Sets the current layer. (CLAYER (page 1229) system variable)

**Current Color** Sets the color of new objects. (CECOLOR (page 1224) system variable)

**Current Linetype** Sets the linetype of new objects. (CELTYPE (page 1225) system variable)
**Current Material** Sets the material of new objects. *(CMATERIAL (page 1230) system variable)*

**Current Lineweight** Sets the lineweight of new objects. *(CELWEIGHT (page 1225) system variable)*

**Current Plot Style** Sets the current plot style of new objects. *(CPlotStyle (page 1240) system variable)*

**Current Elevation** Stores the current elevation of new objects relative to the current UCS. *(ELEVATION (page 1321) system variable)*

**Thickness** Sets the current 3D thickness. *(THICKNESS (page 1510) system variable)*

**Fill, Grid, Ortho, Qtext, Snap, Tablet** Shows whether these modes are on or off.

**Object Snap Modes** Lists the running object snap modes. *(OSNAP (page 747) command)*

**See also:**
- Obtain General Drawing Information

## STLOUT

Stores solids in an ASCII or binary file.

**Summary**

The **FACETRES** (page 1333) system variable determines how the solid is triangulated. A higher value creates a finer mesh that more accurately represents the model. This also results in a much larger file.

**Select solids or watertight meshes**

You can select blocks or external references (xrefs) that contain solids or watertight meshes. Only solids and watertight meshes of the selected blocks of xrefs are included in the STL file. All other geometry is discarded.

Create a binary STL file? [Yes/No] <Yes>:

- To create a STL file, press \texttt{N} or \texttt{Enter}.
- To create an ASCII file, press \texttt{Y} or \texttt{Enter}.

The **Create STL File dialog box** (page 1038) displays.

The file is created with the .stl file name extension. The STL file format is compatible with stereolithography apparatus (SLA). The solid data is transferred...
to the SLA as a faceted representation of the model. The facets consist of a set of triangles (with outward pointing normals) that approximate the faces of the model. From the faceted data, the SLA workstation produces a set of contours that defines a series of layers representing the part to be built.

See also:
   Export Stereolithography STL Files

Create STL File Dialog Box

Saves a drawing as an STL file.

Summary

The Create STL File dialog box is a standard file selection dialog box.

The STL file format is preferred by 3D printing service providers. If you have prepared your drawing for 3D printing, you save it with the STLOUT command.

The FACETRES (page 1333) system variable determines how the solid is triangulated. A higher value creates a finer mesh that more accurately represents the model. This also results in a much larger file.

See also:
   Export Stereolithography STL Files

STRETCH

Stretches objects crossed by a selection window or polygon.

Access Methods

Button

 Toolbar: Drafting tool set ➤ Move/Rotate/Scale tool group ➤ Stretch
 Menu: Modify ➤ Stretch
Summary

Objects that are partially enclosed by a crossing window are stretched. Objects that are completely enclosed within the crossing window, or that are selected individually, are moved rather than stretched. Several objects such as circles, ellipses, and blocks, cannot be stretched.

List of Prompts

The following prompts are displayed.
Select objects to stretch by crossing-window or crossing-polygon...
Select objects: Use the cpolygon option or the crossing object selection method, and press Enter. Individually selected objects and objects that are completely enclosed by the crossing selection are moved rather than stretched.

STRETCH moves only the vertices and endpoints that lie inside the crossing selection, leaving those outside unchanged. STRETCH does not modify 3D solids, polyline width, tangent, or curve-fitting information.

Base Point
Specify base point or [Displacement] <last displacement>: Specify a base point or enter displacement coordinates
Specify second point or <use first point as displacement>: Specify a second point, or press Enter to use the previous coordinates as a displacement
Displacement
Specify displacement <last value>: Enter displacement values for X,Y (and optionally Z)

If you enter a second point, the objects are stretched the vector distance from the base point to the second point. If you press Enter at the Specify Second Point of Displacement prompt, the first point is treated as an X,Y,Z displacement.

See also:
Resize or Reshape Objects

STYLE

Creates, modifies, or specifies text styles.

Access Methods

Menu: Format ➤ Text Style
Command entry: 'style for transparent use

Summary

The Text Style dialog box (page 1041) is displayed.
If you enter -style at the Command prompt, options are displayed (page 1044).
You can specify the current text style to determine the appearance of all new text. A text style includes the font, size, obliquing angle, orientation, and other text characteristics.

See also:
Overview of Text Styles
Text Style Dialog Box

Creates, modifies, or specifies text styles.

## Summary

Creates, modifies, or sets named text styles.

## List of Options

The following options are displayed.

### Preview

Displays sample text that changes dynamically as you change fonts and modify the effects.

### Effects

Modifies characteristics of the font, such as its height, width factor, and obliquing angle and whether it is displayed upside down, backwards, or vertically aligned.

### Annotative ( )
Specifies that the text is annotative. Click the information icon to learn more about the annotative objects.

**Match Text Orientation to Layout**

Specifies that the orientation of the text in paper space viewports matches the orientation of the layout. This option is available when the Annotative option is selected.

**Upside Down**

Displays the characters upside down.

**Backwards**

Displays the characters backwards.

**Vertical**

Displays the characters aligned vertically. Vertical is available only if the selected font supports dual orientation. Vertical orientation is not available for TrueType fonts.

**Text Height**

Changes the size of the text. This option is available when the Annotative option is cleared.

**Paper Text Height**

Sets the text height based on the value you enter. Entering a height greater than 0.0 sets the text height for this style automatically. If you enter 0.0, the text height defaults to the last text height used, or the value stored in the drawing template file. TrueType fonts might be displayed at a smaller height than SHX fonts with the same height setting.

If the Annotative option is selected, the value entered sets the text height in paper space.

See “Set Text Height” for more information.

**Width Factor**

Sets the character spacing. Entering a value less than 1.0 condenses the text. Entering a value greater than 1.0 expands it.

**Angle**

Sets the obliquing angle of the text. Entering a value between -85 and 85 italicizes the text.
NOTE TrueType fonts using the effects described in this section might appear bold on the screen. Onscreen appearance has no effect on plotted output. Fonts are plotted as specified by applied character formatting.

**Styles**
Displays the list of styles in the drawing.
Style names can be up to 255 characters long. They can contain letters, numbers, and the special characters dollar sign ($), underscore (_), and hyphen (-).

**Family List**
Lists the font family name for all registered TrueType fonts and all compiled shape (SHX) fonts in the Fonts folder.

When you select a name from the list, the program reads the file for the specified font. The file's character definitions are loaded automatically unless the file is already in use by another text style. You can define several styles that use the same font. For more information, see “Assign Text Fonts”.

**Typeface**
Specifies font character formatting, such as italic, bold, or regular.

When a SHX font file is selected from the Family list, you can select a Big Font file name from the Asian Set list.

**Asian Set**
Lists the available Big Font files when an SHX file is selected from the Family list. Select None if you do not want to use a Big Font.

**New (+)**
Adds a new text style to the Styles list and automatically supplies the name “style[n]” (where n is the number of the supplied style) for the current settings.
You can accept the default or enter a name and close the Text Style dialog box to apply the current style settings to the new style name.

**Delete (-)**
Removes the selected text style.

NOTE You cannot remove text styles that are in use by an annotation object or style.

**Style List Filter**
The drop-down list specifies whether all styles or only the styles in use are displayed in the styles list.

**Family Filter**
Filters the fonts listed in the Family list.
See also:

Overview of Text Styles

**-STYLE**

Creates, modifies, or specifies text styles.

**List of Prompts**

The following prompts are displayed.

```
Enter name of text style \(\text{(page 1044)}\) or \([\,? \text{ (page 1045)}]\) <current>:
Enter a style name, enter ?, or press Enter
```

**Text Style Name** Specifies the text style name. To define a style that uses Big Fonts, you can use long file names that do not contain commas. Commas are used to separate SHX files and Big Font files for defining a Big Font file.

Enter a TrueType font family name or an SHX font file name. If you do not enter a file name extension, this program searches for an SHX file. If the file is not located, Windows substitutes the first located registered TrueType font.

All long file names except those containing commas are accepted at the prompt. The comma is reserved for the Big Font naming convention: an SHX file followed by a comma (,), followed by the Big Font file name. A space is interpreted as part of the font name, not as a carriage return.

If you enter **annotative**, you are prompted to create an annotative text style.

**Tilde (~)** Displays the Select Font File dialog box.

In the Select Font File dialog box, valid types include SHX and TTF. The character definitions of the selected font file are loaded automatically unless the file is already in use by another text style. You can define several styles that use the same font file.

**Match Text Orientation to Layout** If you enter **yes** the current text style orientation in paper space viewports matches the layout.

**Height of Text** If you enter a height of **0.0**, you are prompted for the text height each time you enter text using this style. Entering a height greater than **0.0** sets the Text Height (Non annotative), entering a height greater than **0.0** sets the Paper Text Height (Annotative), for this style.

**Width Factor** Entering a value less than **1.0** condenses the text. Entering a value greater than **1.0** expands it.
Obliquing Angle  Entering a value between -85 and 85 obliques the text.

Vertical  Vertical is available only if the selected font supports dual orientation.

?—List Text Styles  Lists the text styles available in the drawing.

At the Enter Text Style(s) to List prompt, entering the name of a style displays the name, font file, height, width factor, obliquing angle, and generation of the style and exits the command. Entering an asterisk (*) or pressing Enter displays the height, width factor, obliquing angle, and generation (whether text is drawn backwards, upside-down, vertically, or normally) of each style, and then exits the command.

See also:
Overview of Text Styles

STYLESMANAGER

Displays the folder in Finder that contains the plot style files used when plotting or publishing a drawing.

Access Methods

Menu: File ➤ Plot Styles

Summary

The location in which AutoCAD locates plot styles can be changed under Printer Support File Path ➤ Plot Style Table Search Path on the Application tab of the Application Preferences dialog box (OPTIONS (page 727) command).

Double-click a plot style (STB or CTB) file in Finder to start the Plot Style Table Editor (page 820).

See also:
Manage Plot Style Tables

SUBTRACT

Combines selected 3D solids or 2D regions by subtraction.
Access Methods

Button

Toolbar: Modeling tool set ➤ Solids - Edit tool group ➤ Booleans flyout ➤ Subtract

Summary

With SUBTRACT, you can create a 3D solid by subtracting one set of existing 3D solids from another, overlapping set. You can create a 2D region object by subtracting one set of existing region objects from another, overlapping set. You can select only regions for use with this command.

**NOTE** Using SUBTRACT with 3D surfaces is not recommended. Use the SURFTRIM (page 1059) command instead.

Select the objects that you want to keep, press Enter, then select the objects that you want to subtract.

Objects in the second selection set are subtracted from objects in the first selection set. A single new 3D solid, surface, or region is created.
Objects in the second selection set are subtracted from objects in the first selection set. A single new region is created.

You can only subtract regions from other regions that are on the same plane. However, you can perform simultaneous SUBTRACT actions by selecting sets of regions on different planes. The program then produces separate subtracted regions on each plane. Regions for which there are no other selected coplanar regions are rejected.

You cannot use SUBTRACT with mesh objects. However, if you select a mesh object, you will be prompted to convert it to a 3D solid or surface.

**List of Prompts**

The following prompts are displayed.

**Select objects (to subtract from)** Specifies the 3D solids, surfaces, or regions to be modified by subtraction.

**Select objects (to subtract)** Specifies the 3D solids, surfaces, or regions to subtract.

**See also:**

Create Composite Objects

**SURFBLEND**

Creates a continuous blend surface between two existing surfaces.

**Access Methods**

Button
Toolbar: Modeling tool set ➤ Surfaces - Create tool group ➤ Surface Blend

Menu: Draw ➤ 3D Modeling ➤ Surfaces ➤ Blend

Summary

When you blend two surfaces together, you specify surface continuity and bulge magnitude.

Set SURFACEASSOCIATIVITY (page 1498) to 1 to create a relationship between the blend surface and the originating curves.

List of Prompts

The following prompts are displayed.

Select Surface Edge
Selects an edge subobject or a surface or region (not the surface itself) as the first and second edges.

Chain
Selects contiguous, connected, edges.

Continuity
Measures how smoothly surfaces flow into each other. The default is G0. Select a value or use the grip to change the continuity.
**Bulge Magnitude**  
Sets the roundness of the blend surface edge where it meets the originating surface. The default is 0.5. Valid values are between 0 and 1.

See also:
- Blend a Surface

**SURFEXTEND**

Lengthens a surface by a specified distance.

**Access Methods**

- **Button**
- **Toolbar:** Modeling tool set ➤ Surfaces - Edit tool group (expanded) ➤ Surface Extend
- **Menu:** Modify ➤ Surface Editing ➤ Extend

**Summary**

The extension surface can be merged (part of the original surface) or appended (creating a second surface adjacent to the original surface).
List of Prompts

The following prompts are displayed.

Specify Extension Distance Specifies the extension length.

Expression Enter a formula or equation to specify the length of the surface extension. See Constrain a Design with Formulas and Equations.

Modes

- **Extend** - Extrudes the surface in a way that tries to mimic and continue the shape of the surface.

- **Stretch** - Extrudes the surface without trying to mimic and continue the shape of the surface.

Creation Type

- **Merge** - Extends the surface the specified distance without creating a new surface.

- **Append** - Creates a new extension surface that is adjacent to the original surface. If the originating surface is a NURBS surface, the new extension surface will also be a NURBS surface.

See also:

Extend a Surface

**SURFEXTRACTCURVE**

Creates curves on surfaces and 3D solids.
**Access Methods**

**Toolbar:** Modeling tool set ➤ Open Shapes tool group (expanded) ➤ Extract Isolines

**Menu:** Modify ➤ 3D Operations ➤ Extract Isolines

**Summary**

Creates curves, typically in the U and V directions, on a surface, a 3D solid, or a face on a 3D solid.

The curves can be lines, polylines, arcs, or splines based depending on the shape of the surface or 3D solid.

**List of Prompts**

The following prompts are displayed.

- **Select a Surface, Solid, or Face** Select a surface, 3D solid, or face of a 3D solid.

- **Select point on surface or [Chain/Direction/Spline points]** Click to extract curves, or choose an option. By default, isoline curves in the U direction are selected.

  - **Chain** Displays isolines across adjacent faces if the faces are parameterized in the same direction.

  - **Direction** Change the tracking direction (U or V) of isoline curve extraction.

  - **Spline Points** Dynamically tracks in both U and V directions to create a spline that passes through all specified points on the surface.

**See also:**

Create Wireframe Models

**SURFFILLET**

Creates a filleted surface between two other surfaces.

**Access Methods**

- **Button**
**Toolbar:** Modeling tool set ➤ Surfaces - Edit tool group ➤ Surface Fillet

**Menu:** Draw ➤ 3D Modeling ➤ Surfaces ➤ Fillet

**Summary**

The fillet surface has a constant radius profile and is tangent to the original surfaces. The original surfaces are automatically trimmed to connect the edges of the fillet surface.

**List of Prompts**

The following prompts are displayed.

**First and Second Surface or Region** Specifies the first and second surfaces or regions.

**Radius** Specifies fillet radius. Use the Fillet grip or enter a value to change the radius. You cannot enter a value that is smaller than the gap between the surfaces. If no radius value is entered, the FILLETRAD3D (page 1335) system variable value is used.

**Trim Surface** Trims the original surfaces or regions to the edges of the fillet surface.

**Expression** Enter a formula or equation to specify the fillet radius. See Constrain a Design with Formulas and Equations.

**See also:**

Fillet a Surface
SURFNETWORK

Creates a surface in the space between several curves in the U and V directions (including surface and solid edge subobjects).

Access Methods

Button

Toolbar: Modeling tool set ➤ Surfaces - Create tool group ➤ Surface Network

Menu: Draw ➤ 3D Modeling ➤ Surfaces ➤ Network

Summary

A network surface can be created between a network of curves or between the edges of other 3D surfaces or solids.

The surface will be dependent on the curves or edges from which it was created if the SURFACEASSOCIATIVITY (page 1498) system variable is set to 1.

List of Prompts

The following prompts display:

Select Curves or Surface Edges in the First Direction Select a network of open curves, open surface edges, or region edges (not the surfaces or regions) for the U or V direction.
Select Curves or Surface Edges in the Second Direction

Select a network of open curves, open surface edges, or region edges (not the surfaces or regions) for the \( U \) or \( V \) direction.

Bulge Magnitude

Sets the roundness of the network surface edge where it meets the originating surface. Valid values are between 0 and 1. The default is 0.5. This option displays only if a lofting edge belongs to a 3D solid or surface (not a curve).

See also:

Create Network Surfaces

SURFOFFSET

Creates a parallel surface a specified distance from the original surface.

Access Methods

Button

 직접 도구 패널: Modeling tool set ➤ Surfaces - Create tool group (expanded)
➤ Surface Offset

메뉴: Draw ➤ 3D Modeling ➤ Surfaces ➤ Offset

Summary

Reverse the direction of the offset with the Flip Direction option.
List of Prompts

The following prompts display.

**Specify Offset Distance** Specifies the distance between the offset surface and the original surface.

**Flip Direction** Reverses the offset direction shown by the arrows.

**Both Sides** Offsets the surface in both directions (creates two new surfaces in instead of one).

**Solid** Creates a solid from the offset. This is similar to the **THICKEN** (page 1086) command.

**Connect** Connects multiple offset surfaces, if the original surfaces are connected.
Expression Enter a formula or equation to specify the distance of the surface offset. See Constrain a Design with Formulas and Equations.

See also:
Offset a Surface

SURFPATCH

Creates a new surface by fitting a cap over a surface edge that forms a closed loop.

Access Methods

Button

Toolbar: Modeling tool set ➤ Surfaces - Create tool group ➤ Surface Patch
Menu: Draw ➤ 3D Modeling ➤ Surfaces ➤ Patch

Summary

You can also add an additional curve over the closed loop to constrain and guide the patch surface.
When you create a patch surface, you can specify surface continuity and bulge magnitude. If the `SURFACEASSOCIATIVITY` (page 1498) system variable is set to 1, associativity is maintained between the patch surface and the originating edges or curves.

**List of Prompts**

The following prompts are displayed.

Select **Surface Edges** (page 1057) to patch or [**Chain** (page 1057)/**Curves** (page 1057)] <Curves>: 

**Surface Edges** Selects individual surface edges and adds them to the selection set.

**Chain** Selects contiguous edges of connected but separate surface objects.

**Curves** Selects curves rather than edges.

Select one or more closed surface edges (not the surface itself), a chain of edges, or one or more curves. You cannot choose both edges and curves at the same time.

**List of Options**

Once you have defined the surface edges to patch, the following options are displayed.

Press Enter to accept the patch surface or [**Continuity** (page 1057)/**Bulge Magnitude** (page 1058)/**Guides** (page 1058)]:

**Continuity** Measures how smoothly surfaces flow into each other. The default is G0. See Understand Surface Continuity and Bulge Magnitude. Select a value or use the grip to change the continuity.
**Bulge Magnitude** For best results, enter a value between 0 and 1 to set the roundness of the patch surface edge where it meets the originating surface. The default is 0.5.

**Guides** Uses additional guide curves to shape the patch surface. Guide curves can be curves or points.

See also:
- Patch a Surface

**SURFSCULPT**

Trims and combines surfaces that bound a watertight area to create a solid.

**Access Methods**

![Button]

**Toolbar:** Modeling tool set ➤ Surfaces - Create tool group (expanded) ➤ Surface Sculpt

**Menu:** Modify ➤ Surface Editing ➤ Sculpt

**Summary**

The SURFSCULPT command automatically combines and trims a collection of surfaces that enclose a watertight area to create a solid.

![Image]

**NOTE** The area enclosed by the surfaces must be watertight and the surfaces must have a continuity of G0 or the SURFSCULPT command cannot complete.
The SURFSCULPT command also works with solid and mesh objects. If you are working with meshes, the operation uses the SMOOTHMESHCONVERT (page 1479) setting.

See also:
Create 3D Solids from Objects

SURFTRIM

Trims portions of a surface where it meets another surface or type of geometry.

Access Methods

Button

Toolbar: Modeling tool set ➤ Surfaces - Edit tool group ➤ Surface Trim
Menu: Modify ➤ Surface Editing ➤ Trim

Summary

Trims portions of a surface where it meets or bisects a curve, region, or another surface.

If the SURFACEASSOCIATIVITY (page 1498) system variable is set to 1, the trimmed surface updates whenever the trimming edges are modified.

List of Prompts

The following prompts are displayed.
Select Surfaces or Regions to Trim: Select one or more surfaces or regions to trim.

Select Cutting Curves, Surfaces, or Regions: The curves that can be used as a trimming edge includes lines, arc, circles, ellipses, 2D polylines, 2D spline fit polylines, 2D curve fit polylines, 3D polylines, 3D spline-fit polylines, splines, and helixes. You can also use surfaces and regions as trimming boundaries.

Select Area to Trim: Select one or more regions on a surface to remove.

Extend: Controls whether the cutting surface is trimmed to meet the edge of the trimmed surface.

Projection Direction: The cutting geometry is projected onto the surface. Controls the projection angle as follows:

<table>
<thead>
<tr>
<th>Automatic</th>
<th>When trimming a surface or region in plan, parallel view (for example, the default Top, Front, and Right view), the cutting geometry is projected onto the surface in the view direction.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>When trimming a surface or region with a planar curve in an angled parallel or perspective view, the cutting geometry is projected onto the surface in a direction perpendicular to the curve plane.</td>
</tr>
<tr>
<td></td>
<td>When trimming a surface or region with a 3D curve in an angled, parallel or perspective view (for example, the default perspective view), the cutting geometry is projected onto the surface in a direction parallel to the Z direction of the current UCS.</td>
</tr>
</tbody>
</table>

- View: Projects the geometry based on the current view.
- UCS: Projects the geometry in the +Z and -Z axis of the current UCS.
- None: The surface will only be trimmed if the cutting curve lies on the surface.

See also:

Trim and Untrim Surfaces
SURFUNTRIM

Replaces surface areas removed by the SURFTRIM command.

Access Methods

Button

➤ Toolbar: Modeling tool set ➤ Surfaces - Edit tool group (expanded) ➤ Surface Untrim

➤ Menu: Modify ➤ Surface Editing ➤ Untrim

Summary

If the trimmed edge is dependent on another surface edge that has also been trimmed, you may not be able to fully restore the trimmed area.

NOTE SURFUNTRIM does not restore areas removed by the SURFAUTOTRIM system variable and PROJECTGEOMETRY.

List of Prompts

The following prompts are displayed.

Select Edges on Surfaces to Un-Trim [SURface] Select the edges of trimmed areas to replace or enter SUR to untrim surfaces.

Select Surfaces to Un-Trim Select a surface to replace all trimmed areas.
SWEEP

Creates a 3D solid or surface by sweeping a 2D or 3D object or subobject along a path.

Access Methods

Button

 Toolbar: Modeling tool set ➤ Solids - Create tool group ➤ Solid Creation flyout ➤ Sweep
 Menu: Draw ➤ 3D Modeling ➤ Sweep

Summary

Creates a solid or surface by sweeping an open or closed, planar or non-planar curve (profile) along an open or closed path. Open curves create surfaces and closed curves create solids or surfaces, depending on the specified mode.

You can use the following objects and paths when creating a swept solid or surface:

<table>
<thead>
<tr>
<th>Objects for sweeping</th>
</tr>
</thead>
<tbody>
<tr>
<td>Objects that Can Be Swept</td>
</tr>
<tr>
<td>2D and 3D splines</td>
</tr>
</tbody>
</table>

See also:

Trim and Untrim Surfaces
<table>
<thead>
<tr>
<th>Objects that Can Be Swept</th>
<th>Objects that Can Be Used as a Sweep Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>2D polylnes</td>
<td>2D and 3D polylnes</td>
</tr>
<tr>
<td>2D solids</td>
<td>Solid, surface and mesh edge subobjects</td>
</tr>
<tr>
<td>3D solid face subobjects</td>
<td>Helices</td>
</tr>
<tr>
<td>Arcs</td>
<td>Arcs</td>
</tr>
<tr>
<td>Circles</td>
<td>Circles</td>
</tr>
<tr>
<td>Ellipses</td>
<td>Ellipses</td>
</tr>
<tr>
<td>Elliptical arcs</td>
<td>Elliptical arcs</td>
</tr>
<tr>
<td>Lines</td>
<td>Lines</td>
</tr>
<tr>
<td>Regions</td>
<td></td>
</tr>
<tr>
<td>Solid, surface and mesh edge sub-</td>
<td></td>
</tr>
<tr>
<td>objects</td>
<td></td>
</tr>
<tr>
<td>Trace</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE** Select face and edge subobjects by pressing Ctrl while you select them.

To automatically delete the original geometry used to create the object, use the `DELOBJ` (page 1251) system variable. For **associative surfaces** (page 1498), the DELOBJ system variable is ignored and the originating geometry is not deleted.

**List of Prompts**

The following prompts are displayed.

- **Objects to Sweep** Specifies an object to use as the sweep profile.
- **Sweep Path** Specifies the sweep path based on the object you select.
Mode Controls whether the sweep action creates a solid or a surface. Surfaces are swept as either NURBS surfaces or procedural surfaces, depending on the SURFACEMODELINGMODE (page 1500) system variable.

Alignment Specifies whether the profile is aligned to be normal to the tangent direction of the sweep path.

NOTE If the profile is not perpendicular (normal) to the tangent of the start point of the path, then the profile automatically aligns. Enter No at the alignment prompt to prevent this.

Base Point Specifies a base point for the objects to be swept.

Scale Specifies a scale factor for a sweep operation. The scale factor is uniformly applied to the objects that are swept from the start to the end of the sweep path.

- Reference. Scales the selected objects based on the length you reference by picking points or entering values.

Twist Sets a twist angle for the objects being swept. The twist angle specifies the amount of rotation along the entire length of the sweep path.

- Bank. Specifies whether the curve(s) being swept will naturally bank (rotate) along a 3D sweep path (3D polyline, spline, or helix).

See also:
Create a Solid or Surface by Sweeping

T Commands

TABLE

Creates an empty table object.

Access Methods

Button

Toolbar: Annotation tool set ➤ Tables tool group ➤ Table
Menu: Draw ➤ Table
Summary

A table is a compound object that contains data in rows and columns. It can be created from an empty table or a table style. When you create a table, the number of columns and rows created is determined by the two points picked to define the size of the table.

If you enter `-table` at the Command prompt, options are displayed (page 1070).

List of Prompts

The following prompts are displayed.
Specify first corner:  Specify a point for the first corner of the table
Specify second corner:  Specify the opposite corner of the table

See also:
Create and Modify Tables

Manage Cell Content Dialog Box

Displays the content of the selected cell.
Access Methods

Toolbar: Table Cell visor (expanded) ➤ Manage Cell Contents

List of Options

The following options are displayed.

Cell Content
Lists all text and/or blocks in the selected cell in order of appearance. Text is indicated with the label Table Cell Text. Blocks are indicated with Block preceding the name of the block.

Delete (-)
Removes the selected content from the table cell.

Options
Changes the direction and spacing of the content in the cell.

Layout
Changes the direction in which cell content will appear.

Flow
Places cell content based on the width of the cell.

**Stacked Horizontally**
Places cell content horizontally, regardless of cell width.

**Stacked Vertically**
Places cell content vertically, regardless of cell height.

**Spacing**
Determines the spacing between text and/or blocks within the cell.

**See also:**
Create and Modify Tables

**Table Cell Format Dialog Box**
The options displayed here change based on the selected data type and format you select.

![Table Cell Format Dialog Box](image)

**List of Options**
The following options are displayed.

**Data Type** Displays a list of data types (Angle, Date, Decimal Number, and so on) that you can format for table rows.
Preview Displays a preview of the option you selected in the Format list.

Format Depending on the data type you select, displays a list of relevant format types. For example, if you selected Angle as the data type, options such as Decimal Degrees, Grads, Radians, and so on are displayed.

Precision For Angle, Decimal Number, and Points data types only, sets the precision for applicable formats. For example, if you select Angle as the data type and Radians as the format type, options such as Current Precision, 0.0r, 0.00r, 0.000r, and so on are displayed.

List Separator For a Point data type only, displays a list of options (comma, semicolon, or colon) that you can use to separate list items.

Symbol For Currency data types only, displays a list of currency symbols that you can use.

Append Symbol In Currency data types, places the currency symbol after the number. In the Percentage data types, places the percent symbol after the number.

Negative Numbers For Currency data types only, lists options for displaying negative numbers.

X, Y, and Z Coordinates For a Point data type only, filters X, Y, or Z coordinates.

Additional Format For Angle, Decimal Number, Point, and Whole Number data types only, opens the Additional Format dialog box (page 1068), where you set additional formatting options for table cells.

Examples For the Date data type only, displays a list of date display options for the date option you selected in the Format field. Click a date in the Format field to see an example.

See also:

Work with Table Styles

Additional Format Dialog Box

Provides additional formatting options for fields and table cells.
List of Options

The following options are displayed.

**Value**
Displays the value in base drawing units, and reflects the value as it will appear once the conversion factor and other settings are applied.

**Conversion**
Specifies the conversion factor to use on the current value. The default is 1 for no conversion.

**Additional Text**
Specifies a prefix or a suffix for the value.

**Number Separators**
Specifies a decimal separator and the formatting for numbers over 1000.
**Decimal** Specifies the separator for decimal values. Select a period, a comma, or a space.

**Thousands** Inserts a comma to group thousands in a field value.

**Zero Suppression**
Controls the suppression of leading and trailing zeros, and of feet and inches that have a value of zero.

**Leading** Suppresses leading zeros in all decimal values. For example, 0.5000 becomes .5000.

**Trailing** Suppresses trailing zeros in all decimal values. For example, 12.5000 becomes 12.5, and 30.0000 becomes 30.

**0 Feet** Suppresses the feet portion of a feet-and-inches value when the distance is less than one foot. For example, 0'-6 1/2" becomes 6 1/2".

**0 Inches** Suppresses the inches portion of a feet-and-inches value when the distance is an integral number of feet. For example, 1'-0" becomes 1'.

**See also:**
- Work with Table Styles

---

**-TABLE**

Creates an empty table object.

**List of Prompts**

The following prompts are displayed.

Current table style: "Standard" Cell width: 2.5000 Cell height: 1 line(s)
Enter number of columns (page 1070) or [Auto (page 1071)/from Style (page 1071)] <5>:

**Number of Columns**
Specifies the number of columns.

**Number of Rows**
Specifies the number of rows.

**Insertion Point** Specifies the location of the upper-left corner of the table. If the table style sets the direction of the table to read from the bottom up, the insertion point is the lower-left corner of the table.
**Width** Specifies a width for the table columns.

**Height** Specifies a height for the table rows.

**Style** Specifies a table style for the table. The specified table style must contain a starting table.

**Auto** Specifies a size and a location for the table. When this option is selected, you can set the number of columns or the column width, but not both. The number of rows and the row height depend on the size of the window you specify.

**First Corner** Specifies the location of the upper-left corner of the table. If the table style sets the direction of the table to read from the bottom up, the insertion point is the lower-left corner of the table.

**Height** Specifies a height for the table rows.

**Auto** Specifies a size and a location for the table.

**Number of Rows** Specifies the number of rows.

**From Style** Specifies a table style for creating the table. You can use the pointing device or enter coordinate values at the Command prompt. The specified table style must contain a starting table.

**Insertion Point** Specifies the location of the upper-left corner of the table. If the table style sets the direction of the table to read from the bottom up, the insertion point is the lower-left corner of the table.

**Style** Specifies a table style for the table.

Entering [?] displays a list of table styles available in your drawing.

**Rows** Specifies the number of rows you want to add to the table stored in the specified table style. The rows are added to the rows already in the specified table.

**Columns** Specifies the number of columns you want to add to the table stored in the specified table style. The columns are added to the columns already in the specified table.

**Options**

Specifies special formatting options that can be inserted in the table.

**Label Text** Retains rows with a cell type of Label found in the table style's starting table.
The cell type is set in the Properties Inspector palette. The Header and Title cell styles use the Label cell type by default.

Data Text Retains rows with a cell type of Data found in the table style’s starting table.

The cell type is set in the Properties Inspector palette. The Data cell style uses the Data cell type property by default.

Formulas Retains formulas found in the specified table style’s starting table.

Fields Retains fields found in the specified table style’s starting table. For more information, see Use Fields in Text.

Blocks Retains blocks found in the specified table style’s starting table.

Cell Style Overrides Retains cell style overrides found in the specified table style’s starting table.

See also:
Create and Modify Tables

TABLEEDIT
Edits text in a table cell.

Access Methods

Pointing device: Double-click inside a table cell.
Pick a table cell: Click inside a table cell, and edit or format the text

See also:
Add Text and Blocks to Tables

TABLEEXPORT
Exports data from a table object in CSV file format.
Summary

A standard file selection dialog box (page 723) is displayed. Table data is exported in the comma-separated (CSV) file format. All formatting of the table and its text is lost.

See also:
Create and Modify Tables

TABSURF

Creates a mesh from a line or curve that is swept along a straight path.

Access Methods

Menu: Draw ➤ 3D Modeling ➤ Meshes ➤ Tabulated Mesh

Summary

Select a line, arc, circle, ellipse, or polyline to sweep in a straight path. Then select a line or polyline to determine the first and last points of a vector that indicates the direction and length of the polygon mesh.

The MESHTYPE (page 1408) system variable sets which type of mesh is created. Mesh objects are created by default. Set the variable to 0 to create legacy polyface or polygon mesh.

For polygon meshes, TABSURF constructs a 2 by \( n \) mesh, where \( n \) is determined by the SURFTAB1 (page 1500) system variable. The \( M \) direction of the mesh is always 2 and lies along the direction vector. The \( N \) direction lies along the path curve. If the path curve is a line, arc, circle, ellipse, or spline-fit polyline, tabulation lines are drawn that divide the path curve into intervals of equal
size set by SURFTAB1. If the path curve is a polyline that has not been spline fit, tabulation lines are drawn at the ends of straight segments, and each arc segment is divided into intervals set by SURFTAB1.

**List of Prompts**

The following prompts are displayed.

**Object for path curve** Specifies which object is swept along the path.

The path curve defines the approximated surface of the polygon mesh. It can be a line, arc, circle, ellipse, or 2D or 3D polyline. The mesh is drawn starting at the point on the path curve closest to the selection point.

**Object for direction vector.** Specifies a line or open polyline that defines the direction of the sweep.

Only the first and last points on a polyline are considered, and intermediate vertices are ignored. The direction vector indicates the direction and length of the shape to be extruded. The end selected on the polyline or line determines the direction of the extrusion. The original path curve is drawn with wide lines to help you visualize how the direction vector dictates the construction of a tabulated mesh.
TARGETPOINT

Creates a target point light.

List of Prompts

The following prompts are displayed.

Specify source location <0,0,0>: Enter coordinate values or use the pointing device

Specify target location <0,0,-10>: Enter coordinate values or use the pointing device

If the LIGHTINGUNITS system variable is set to 0, the following prompt is displayed:

Enter an option to change [Name (page 1075)/Intensity (page 1075)/Status (page 1075)/Shadow (page 1076)/Attenuation (page 1077)/Color (page 1077)/eXit (page 1078)] <eXit>:

If the LIGHTINGUNITS system variable is set to 1 or 2, the following prompt is displayed:

Enter an option to change [Name (page 1075)/Intensity factor (page 1075)/Status (page 1075)/Photometry (page 1076)/Attenuation (page 1077)/Shadow (page 1076)/filterColor (page 1077)/eXit (page 1078)] <eXit>:

NOTE When the LIGHTINGUNITS system variable is set to 1 or 2, the Attenuation option has no affect on the creation of the light. It is only maintained for scripting compatibility.

Name
Specifies the name of the light.

Intensity/Intensity Factor
Sets the intensity or brightness of the light.

Status
Turns the light on and off.
Photometry
Photometry is available when the LIGHTINGUNITS system variable is set to 1 or 2. Photometry is the measurement of the luminous intensities of visible light sources.

In photometry, luminous intensity is a measure of the perceived power emitted by a light source in a particular direction. Luminous flux is the perceived power per unit of solid angle. The total luminous flux for a lamp is the perceived power emitted in all directions. Luminance is the total luminous flux incident on a surface, per unit area.

Intensity Enter an intensity value in candelas, the perceived power in a luminous flux value, or illuminance value for the total luminous flux incident on a surface.

- Candela (symbol: cd) is the SI unit of luminous intensity (perceived power emitted by a light source in a particular direction). Cd/Sr
- Lux (symbol: lx) is the SI unit of illuminance. Lm/m^2
- Foot-candle (symbol: fc) is the American unit of illuminance. Lm/ft^2

Enter f to specify the perceived power in a luminous flux value.
If you enter i, you can specify the intensity of the light based on an illuminance value.
The illuminance value can be specified in either lux or foot-candles. Enter d to specify a distance to use to calculate illuminance.

Color Specify the color of the light based on a color name or a Kelvin temperature.
Enter ? to display a list of color names. Enter a text string using wild card characters to display a partial listing of color names, or an asterisk (*) to display all the possible choices.
If you enter k, you can specify the color of the light based on a Kelvin temperature value.

Exit Exits the command.

Shadow Makes the light cast shadows.

Off Turns off the display and calculation of shadows for the light. Turning shadows off increases performance.

Sharp Displays shadows with sharp edges. Use this option to increase performance.

Soft Mapped Displays realistic shadows with soft edges.
Map Size Specifies the amount of memory that should be used to calculate the shadow map.

Softness Specifies the softness to use to calculate the shadow map.

Soft Sampled Displays realistic shadows with softer shadows (penumbra) based on extended light sources.

Shape Specify the shape of the shadow by entering $s$ and then the dimensions of the shape. (For example, the radius of the sphere or the length and width of a rectangle.)

Attenuation
Attenuation Type Controls how light diminishes over distance. The farther away an object is from a point light, the darker the object appears. Attenuation is also known as decay.

- **None.** Sets no attenuation. Objects far from the point light are as bright as objects close to the light.

- **Inverse Linear.** Sets attenuation to be the inverse of the linear distance from the light. For example, at a distance of 2 units, light is half as strong as at the point light; at a distance of 4 units, light is one quarter as strong. The default value for inverse linear is half the maximum intensity.

- **Inverse Squared.** Sets attenuation to be the inverse of the square of the distance from the light. For example, at a distance of 2 units, light is one quarter as strong as at the point light; at a distance of 4 units, light is one sixteenth as strong.

Use Limits Specifies whether to use limits or not.

Attenuation Start Limit Specifies the point where light starts as an offset from the center of the light.

Attenuation End Limit Specifies the point where light ends as an offset from the center of the light. No light is cast beyond this point. Setting an end limit increases performance where the effect of lighting is so minimal that the calculations are wasted processing time.

Color/Filter Color
Controls the color of the light.

True Color Specifies a True Color. Enter in the format R,G,B (red, green, blue).

Index Specifies an ACI (AutoCAD Color Index) color.

HSL Specifies an HSL (hue, saturation, luminance) color.

Color Book Specifies a color from a color book.
Exit
Exits the command.

See also:
Use Point Lights

TEXT
Creates a single-line text object.

Access Methods

Button

Toolbar: Annotation tool set ➤ Text tool group ➤ Multiline Text flyout ➤ Single Line

Menu: Draw ➤ Text ➤ Single Line Text

Summary
You can use single-line text to create one or more lines of text, where each text line is an independent object that you can move, format, or otherwise modify. Right-click in the text box to select options on the shortcut menu.

If TEXT was the last command entered, pressing Enter at the Specify Start Point of Text prompt skips the prompts for paper height and rotation angle. The text that you enter in the text box is placed directly beneath the previous line of text. The point that you specified at the prompt is also stored as the insertion point of the text.

When creating text, you can click anywhere in a drawing to create a new text block. You can also use the keyboard to move among text blocks (for example: for new text created using the TEXT command, you can navigate through text groups by pressing Tab or Shift+Tab, or edit a group of text lines by pressing Alt and clicking each text object.)

NOTE Text that would otherwise be difficult to read (if it is very small, very large, or is rotated) is displayed at a legible size and is oriented horizontally so that you can easily read and edit it.
You can enter special characters and format text by entering Unicode strings (page 1083) and control codes (page 1083).

Use -TEXT to honor the TEXTVAL system variable (page 1085).

**List of Prompts**

The following prompts are displayed.

Current text style: `<current>`

Current text height: `<current>`

Annotative: `<current>`

Specify start point (page 1079) of text or [Justify (page 1079)/Style (page 1082)]: Specify a point or enter an option

**Start Point**

Specifies a start point for the text object. Enter text in the In-Place Text Editor for single-line text.

The SpecifyHeight prompt is displayed only if the current text style is not annotative and does not have a fixed height.

The Specify Paper Text Height prompt is displayed only if the current text style is annotative.

**Justify**

Controls justification of the text.

You can also enter any of these options at the Specify Start Point of Text prompt.

**Align** Specifies both text height and text orientation by designating the endpoints of the baseline.

The size of the characters adjusts in proportion to their height. The longer the text string, the shorter the characters.

1ø12.7 FOR ø8.2
BUSHING—PRESS
FIT—4 REQ.—EQ. SP.
**Fit** Specifies that text fits within an area and at an orientation defined with two points and a height. Available for horizontally oriented text only.

The height is the distance in drawing units that the uppercase letters extend from the baseline. Designated text height is the distance between the start point and a point you specify. The longer the text string, the narrower the characters. The height of the characters remains constant.

**Center** Aligns text from the horizontal center of the baseline, which you specify with a point. The rotation angle specifies the orientation of the text baseline with respect to the center point. You can designate the angle by specifying a point. The text baseline runs from the start point toward the specified point. If you specify a point to the left of the center point, the text is drawn upside down.

**Middle** Aligns text at the horizontal center of the baseline and the vertical center of the height you specify. Middle-aligned text does not rest on the baseline.

The Middle option differs from the MC option in that it uses the midpoint of all text, including descenders. The MC option uses the midpoint of the height of uppercase letters.

**Right** Right-justifies the text at the baseline, which you specify with a point.

**TL (Top Left)** Left-justifies text at a point specified for the top of the text. Available for horizontally oriented text only.
TC (Top Center) Centers text at a point specified for the top of the text. Available for horizontally oriented text only.

TR (Top Right) Right-justifies text at a point specified for the top of the text. Available for horizontally oriented text only.

ML (Middle Left) Left-justifies text at a point specified for the middle of the text. Available for horizontally oriented text only.

MC (Middle Center) Centers the text both horizontally and vertically at the middle of the text. Available for horizontally oriented text only. The MC option differs from the Middle option in that it uses the midpoint of the height of uppercase letters. The Middle option uses the midpoint of all text, including descenders.

MR (Middle Right) Right-justifies text at a point specified for the middle of the text. Available for horizontally oriented text only.

BL (Bottom Left) Left-justifies text at a point specified for the baseline. Available for horizontally oriented text only.

BC (Bottom Center) Centers text at a point specified for the baseline. Available for horizontally oriented text only.
**BR (Bottom Right)** Right-justifies text at a point specified for the baseline. Available for horizontally oriented text only.

**Style**
Specifies the text style, which determines the appearance of the text characters. Text you create uses the current text style.

Entering ? lists the current text styles, associated font files, height, and other parameters.

**See also:**
Create Single-Line Text

**Text Shortcut Menu**

Displays options available for creating and modifying single-line text.

**List of Options**

The following options are displayed.

**Opaque Background** When checked, makes the background of the editor opaque.

**Insert Field** Displays the Insert Field dialog box (page 432), where you can select a field to insert in the text.

**Find and Replace** Displays the Find and Replace dialog box (page 690).

**Select All** Selects all the text in the single-line text object.

**Change Case** Changes the case of selected text.
See also:

Create Single-Line Text

**Special Unicode Characters**

When entering text, you can create special characters, including the degree symbol, plus/minus tolerance symbol, and the diameter symbol, by entering the following Unicode character strings.

**List of Options**

The following options are displayed.

\U+00B0 Degrees symbol (°)

\U+00B1 Tolerance symbol (±)

\U+2205 Diameter symbol (∅)

See “Unicode Font Descriptions” in the *Customization Guide*.

See also:

Create Single-Line Text

**Control Codes and Special Characters**

Unicode characters can be used to enter special characters, overscore and underscore text, or insert a special symbol by including control information in the text string.

**Summary**

Use a pair of percent signs to introduce each control sequence.

You can use this control code with standard AutoCAD text fonts and Adobe PostScript fonts.

**List of Options**

The following options are displayed.

%\%nnn Draws character number nnn.
You can use these control codes with standard AutoCAD text fonts only:

`%%o` Toggles overscoring on and off.

\[36.63\]

`%%u` Toggles underscoring on and off.

\[36.63\]

`%%d` Draws degrees symbol (°).

\[36.63°\]

`%%p` Draws plus/minus tolerance symbol (±).

\[36.63±.1\]

`%%c` Draws circle diameter dimensioning symbol (Ø).

\[Ø\,36.63\]

`%%%` Draws a single percent sign (%). This is valid for the TEXT command only.

\[36.63%\]

Overscoring and underscoring can be in effect at the same time. Both turn off automatically at the end of the text string.

\[36.63\]

You can use the `%%%nnn` control sequence to display special characters using the PostScript fonts.

**See also:**

Create Single-Line Text
**TEXT and the TEXTEVAL System Variable**

**Summary**

Entering `-text` at the Command prompt displays the same prompts as the TEXT command. Unlike the TEXT command, `-TEXT` checks the setting of the TEXTEVAL (page 1507) system variable. When the TEXTEVAL system variable is set to 1, AutoLISP® expressions are evaluated when the `-TEXT` command ends. AutoLISP expressions that are entered using this method must begin with an exclamation point or left parenthesis.

The TEXT command checks the setting of the TEXTEVAL system variable setting only if it is used in a script or AutoLISP expression and all the TEXT command prompts are included within the script or AutoLISP expression.

*See also:*

Create Single-Line Text

**TEXTEDIT**

Edits a selected multiline or single-line text object, or the text in a dimension object.

**Summary**

Displays the in-place text editor, and accepts your changes to the selected multiline text, single-line text, or dimension object.

**List of Prompts**

The following prompt is displayed.

*Select an annotation object: Select a text, mtext, or dimension object*

*See also:*

Change Text
TEXTTOFRONT

Brings text, dimensions, and multileaders in front of all other objects in the drawing.

Access Methods

Button

Toolbar: Drafting tool set ➤ Move/Rotate/Scale tool group (expanded) ➤ Draw Order flyout ➤ Bring Text to Front, Bring Dimensions to Front

Menu: Tools ➤ Draw Order ➤ Bring Annotations to Front

List of Prompts

The following prompts are displayed.

Bring to front [Text/Dimensions/Leaders/All] <All>: Enter an option or press Enter

Text Brings all text in front of all other objects in the drawing.

Dimensions Brings all dimensions in front of all other objects in the drawing.

Leaders Brings all multileaders in front of all other objects in the drawing.

All Brings all text, leader, and dimension objects in front of all other objects in the drawing.

NOTE Text, dimensions, and multileaders that are contained within blocks and xrefs cannot be brought to the front apart from the containing object. Also, text in tables are not supported by the command.

See also:

Control How Overlapping Objects Are Displayed

THICKEN

Converts a surface into a 3D solid with a specified thickness.
Access Methods

Button

_toolbar: Modeling tool set ➤ Solids - Edit (expanded) ➤ Thicken
_menu: Modify ➤ 3D Operations ➤ Thicken

Summary

A useful technique for modeling a complex 3D curved solid is to first create a surface and then convert it to a 3D solid by thickening it.

Initially, the default thickness value is zero. During a drawing session, the default value for the thickness is the previously entered thickness value.

The DELOBJ (page 1251) system variable controls whether the object(s) you select are automatically deleted when the surface is created or whether you are prompted to delete the object(s).

If you select a mesh face to thicken, you can choose to convert the mesh object to a solid or surface before completing the operation.

List of Options

The following prompts are displayed.

Surfaces to thicken Specifies one or more surfaces to thicken into solids.

Thickness Sets the height of the thickened object.

See also:

Create 3D Solids from Objects

TIFOUT

Saves selected objects to a file in TIFF file format.

Summary

The Create Raster File dialog box (a standard file selection dialog box (page 723)) is displayed. Enter the file name in the dialog box.
List of Prompts

The following prompts are displayed.
Select objects or <all objects and viewports>: Press Enter to select all objects and viewports or use an object selection method and press Enter

A TIFF file is created that contains the objects you select. The file reflects what is displayed on the screen.

**NOTE** When the FILEDIA (page 1334) system variable is set to 0 (Off), command prompts are displayed.

See also:

- Export Raster Files

## TIME

Displays the date and time statistics of a drawing.

### Access Methods

- **Menu: Tools ➤ Inquiry ➤ Time**
- **Command entry: 'time** for transparent use

### Summary

The Total Editing Time cannot be reset or stopped. Plotting time is not included in the total editing time, nor is the viewing time if the drawing is not saved.

The Elapsed Timer controls are separate and can be started, stopped, and reset.

### List of Prompts

The following prompts are displayed.

**Current time** (page 1089): Wednesday, December 31, 2003
9:54:51.406 AM

Times for this drawing:

**Created** (page 1089): Friday, December 12, 2003 1:21:36.203 AM

**Last Updated** (page 1089): Wednesday, December 31, 2003
9:49:19.208 AM

**Total Editing Time** (page 1089): 0 days 06:44:10.520

**Elapsed Timer** (page 1089) (on): 0 days 00:07:05.312
Next Automatic Save In (page 1089): 0 days 01:59:15.570
Enter option [Display (page 1089)/On (page 1089)/OFF (page 1089)/Reset (page 1089)]: Enter an option or press Enter

Current Time Displays the current date and time to the nearest millisecond using a 24-hour clock.

Created Displays the date and time that the current drawing was created.

Last Updated Displays the date and time of the latest update of the current drawing. This date and time is initially the drawing creation time. The time is revised whenever the drawing file is saved.

Total Editing Time Displays the time spent editing the current drawing. This timer is updated by the program and cannot be reset or stopped. Plotting time is not included in the total editing time. If you quit the editing session without saving the drawing, the time you spent in the editing session is not added to the accumulated editing time.

Elapsed Timer Runs as another timer while the program is running. You can turn it on and off or reset it whenever you like.

Next Automatic Save In Indicates the time remaining until the next automatic save. You can set the time interval using OPTIONS (page 727) or the SAVETIME (page 1465) system variable.

Display Repeats the display with updated times.

On Starts the user elapsed timer if it was off.

Off Stops the user elapsed timer.

Reset Resets the user elapsed timer to 0 days 00:00:00.000.

See also:
Obtain General Drawing Information

TINSERT

Inserts a block in a table cell.

Access Methods

 Toolbar: With a table and table cell selected, click Insert Block on the Table Cell visor.
Summary
The Insert Block in a Table Cell dialog box (page 1090) is displayed.

See also:
Add Text and Blocks to Tables

Insert Block in Table Cell Dialog Box
Specifies options for inserting a block in a table cell.

List of Options
The following options are displayed.

Name
Specifies the block reference to insert.

Browse
Displays the Select Drawing File dialog box. Select the drawing file to insert as a block reference.

Path
Displays the location of the drawing file selected in the Select Drawing File dialog box.

Scale
Specifies the scale for the block reference. Enter a value or select AutoFit to scale the block to fit in the selected cell.
AutoFit Controls if the block reference should be scaled to fit in the select table cell, or if the height and width of the table cell should be adjusted to fit the block reference being inserted.

Rotation Angle
Specifies a rotation angle for the block.

Overall Cell Alignment
Specifies alignment for the block in the table cell. The block is middle-, top-, or bottom-aligned with respect to the top and bottom borders of the cell. The block is center-, left-, or right-aligned with respect to the left and right borders of the cell.

See also:
Add Text and Blocks to Tables

TOLERANCE
Creates geometric tolerances contained in a feature control frame.

Access Methods

Button

Toolbar: Annotation tool set ➤ Dimensions tool group (expanded) ➤ Tolerance

Menu: Dimension ➤ Tolerance

Summary
The Geometric Tolerance dialog box (page 1092) is displayed.

Geometric tolerances show acceptable deviations of form, profile, orientation, location, and runout. Feature control frames can be created with leader lines using TOLERANCE, LEADER, or QLEADER.
See also:
Overview of Geometric Tolerances

**Geometric Tolerance Dialog Box**

Specifies the symbols and values for a feature control frame.

![Geometric Tolerance Dialog Box](image)

**Summary**

After you select geometric characteristic symbols, the Geometric Tolerance dialog box closes and the following prompt is displayed:

Enter tolerance location: *Specify a location*

The feature control frame is placed at the specified location.

**List of Prompts**

The following prompts are displayed.
Sym
Displays the geometric characteristic symbol, which you select from the Symbol dialog box (page 1095). The dialog box is displayed when you select one of the Sym boxes.

Tolerance 1
Creates the first tolerance value in the feature control frame. The tolerance value indicates the amount by which the geometric characteristic can deviate from a perfect form. You can insert a diameter symbol before the tolerance value and a material condition symbol after it.

First Box
Inserts a diameter symbol in front of the tolerance value. Click the box to insert the diameter symbol.

Second Box
Creates the tolerance value. Enter a value in the box.

Third Box
Displays the Material Condition dialog box (page 1097), in which you select a modifying symbol. These symbols act as modifiers to the geometric characteristic and the tolerance value of features that can vary in size. The symbol is inserted into the MC box for the first tolerance value in the Geometric Tolerance dialog box.

Tolerance 2
Creates the second tolerance value in the feature control frame. Specify the second tolerance value in the same way as the first.

Datum 1
Creates the primary datum reference in the feature control frame. The datum reference can consist of a value and a modifying symbol. A datum is a theoretically exact geometric reference used to establish the tolerance zone for a feature.
First Box
Creates the datum reference value.

Second Box
Displays the Material Condition dialog box (page 1097), in which you select a modifying symbol. These symbols act as modifiers to the datum reference. The symbol is inserted into the MC box for the primary datum reference in the Geometric Tolerance dialog box.

Datum 2
Creates the secondary datum reference in the feature control frame in the same way as the primary datum reference.

Datum 3
Creates the tertiary datum reference in the feature control frame in the same way as the primary datum reference.

Height
Creates a projected tolerance zone value in the feature control frame. A projected tolerance zone controls the variation in height of the extended portion of a fixed perpendicular part and refines the tolerance to that specified by positional tolerances.

Projected Tolerance Zone
Inserts a projected tolerance zone symbol after the projected tolerance zone value.
Datum Identifier

Creates a datum-identifying symbol consisting of a reference letter. A datum is a theoretically exact geometric reference from which you can establish the location and tolerance zones of other features. A point, line, plane, cylinder, or other geometry can serve as a datum.

See also:

Overview of Geometric Tolerances

Symbol Dialog Box

Displays the geometric characteristic symbols for location, orientation, form, profile, and runout.

Summary

The symbol is inserted into the Sym text box in the Geometric Tolerance dialog box (page 1092). The following table describes the symbols.

<table>
<thead>
<tr>
<th>Geometric characteristic symbol</th>
<th>Characteristic</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>Location</td>
<td></td>
</tr>
<tr>
<td>Symbol</td>
<td>Characteristic</td>
<td>Type</td>
</tr>
<tr>
<td>--------</td>
<td>--------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>⊙</td>
<td>Concentricity or coaxiality</td>
<td>Location</td>
</tr>
<tr>
<td></td>
<td>Symmetry</td>
<td>Location</td>
</tr>
<tr>
<td></td>
<td>Parallelism</td>
<td>Orientation</td>
</tr>
<tr>
<td></td>
<td>Perpendicularity</td>
<td>Orientation</td>
</tr>
<tr>
<td></td>
<td>Angularity</td>
<td>Orientation</td>
</tr>
<tr>
<td></td>
<td>Cylindricility</td>
<td>Form</td>
</tr>
<tr>
<td></td>
<td>Flatness</td>
<td>Form</td>
</tr>
<tr>
<td></td>
<td>Circularity or roundness</td>
<td>Form</td>
</tr>
<tr>
<td></td>
<td>Straightness</td>
<td>Form</td>
</tr>
<tr>
<td></td>
<td>Profile of a surface</td>
<td>Profile</td>
</tr>
<tr>
<td></td>
<td>Profile of a line</td>
<td>Profile</td>
</tr>
</tbody>
</table>
Geometric characteristic symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Characteristic</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Symbol]</td>
<td>Circular runout</td>
<td>Runout</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Total runout</td>
<td>Runout</td>
</tr>
</tbody>
</table>

See also:

Overview of Geometric Tolerances

**Material Condition Dialog Box**

Specifies a modifying symbol. These symbols act as modifiers to the geometric characteristic and the tolerance value of features that can vary in size.

![Material Condition]

**Summary**

The symbol is inserted into the MC box for the first or second tolerance value in the Geometric Tolerance dialog box (page 1092).

See also:

Overview of Geometric Tolerances

**TOOLSETS**

Opens the Tool Sets palette.

**Access Methods**

Menu: Tools ➤ Palettes ➤ Tool Sets

Menu: Window ➤ Tool Sets
See also:
The Tool Sets Palette

**TOOLSETSCLOSE**

Closes the Tool Sets palette.

See also:
The Tool Sets Palette

**TORUS**

Creates a donut-shaped 3D solid.

**Access Methods**

- **Button**
  - Toolbar: Modeling tool set ➤ Solids - Create tool group ➤ Solid Primitives flyout ➤ Torus
  - Menu: Draw ➤ 3D Modeling ➤ Torus

**Summary**

You can create a torus by specifying the center, then the radius or diameter of the torus, and then the radius or diameter of the tube that surrounds the torus. You can control the smoothness of curved 3D solids, such as a torus, in a shaded or hidden visual style with the FACETRES system variable.
List of Prompts

The following prompts are displayed.
Specify center point or [3P (page 1099)/2P (page 1099)/TTR (page 1099)]: Specify a point (1) or enter an option

When you specify the center point, the torus is positioned so that its central axis is parallel to the Z axis of the current user coordinate system (UCS). The torus is parallel to and bisected by the XY plane of the current workplane.
Specify radius (page 1099) or [diameter (page 1100)] <default>: Specify a distance or enter d

**3P (Three Points)**
Defines the circumference of the torus with three points that you specify. The three specified points also define the plane of the circumference.

**2P (Two Points)**
Defines the circumference of the torus with two points that you specify. The plane of the circumference is defined by the Z value of the first point.

**TTR (Tangent, Tangent, Radius)**
Defines the torus with a specified radius tangent to two objects. The specified tangency points are projected onto the current UCS.

**Radius**
Defines the radius of the torus: the distance from the center of the torus to the center of the tube. A negative radius creates a solid shaped like an American football.

**Radius** Defines the radius of the tube.
Diameter Defines the diameter of the tube.

Diameter Defines the diameter of the torus.
- Radius (page 1099)
- Diameter (page 1100)

See also:
Create a Solid Torus

TRANSPARENCY

Controls whether background pixels in an image are transparent or opaque.

Access Methods

Menu: Modify ➤ Object ➤ Image ➤ Transparency

List of Prompts

The following prompts are displayed.
Select image(s):
Enter transparency mode [ON/OFF] <current>: Enter an option or press Enter
On Turns transparency on so that objects beneath the image are visible.
Off Turns transparency off so that objects beneath the image are not visible.

See also:
Modify Color and Transparency for Bitonal Raster Images
TREESTAT

Displays information about the drawing's current spatial index.

Access Methods

Command entry: `treestat` for transparent use

Summary

The program indexes objects in a region by recording their positions in space. The result is called a spatial index. The spatial index is tree structured and has branching nodes to which objects are attached. The index has two major branches. The paper space branch is called a quad-tree and treats objects as two-dimensional. The model space branch is called an oct-tree and treats objects as either two- or three-dimensional. The model space branch can also be changed to a quad-tree when you are working on two-dimensional drawings.

TREESTAT displays information about each branch. The most important information is in the first two lines of the report—number of nodes, number of objects, maximum depth of the branch, and average number of objects per node.

If REDRAW (page 881) and object selection are very slow, you can improve their performance. For example, if there are 50 megabytes of memory available and the current drawing has 50,000 objects with only 1,000 nodes in the index tree, increase the TREEDEPTH (page 1519) value to improve performance.

Each node consumes about 80 bytes of memory. The fewer objects per node of the oct-tree, the better the performance.

See also:

Increase Performance with Large Referenced Drawings

TRIM

Trims objects to meet the edges of other objects.
Access Methods

Button

_toolbar: Drafting tool set ➤ Modify tool group ➤ Trim
_menu: Modify ➤ Trim

Summary

To trim objects, select the boundaries. Then press Enter and select the objects that you want to trim. To use all objects as boundaries, press Enter at the first Select Objects prompt.

List of Prompts

The following prompts are displayed.
Current settings: Projection = current, Edge = current
Select cutting edges...
Select objects or <select all>: Select one or more objects and press Enter, or press Enter to select all displayed objects
Select the objects that define the cutting edges to which you want to trim an object, or press Enter to select all displayed objects as potential cutting edges. TRIM projects the cutting edges and the objects to be trimmed onto the XY plane of the current user coordinate system (UCS).

**NOTE** To select cutting edges that include blocks, you can use only the single selection, Crossing, Fence, and Select All options.

Select `object to trim` (page 1103) or `shift-select to extend` (page 1103) or `[Fence (page 1103)/Crossing (page 1103)/Project (page 1104)/Edge (page 1105)/eRase (page 1105)/Undo (page 1105)]`: Select an object to trim, hold down Shift and select an object to extend it instead, or enter an option

Specify an object selection method to select the objects to trim. If more than one trim result is possible, the location of the first selection point determines the result.

**Object to Trim**
Specifies the object to trim.

![Objects to Trim](image)

**Shift-Select to Extend**
Extends the selected objects rather than trimming them. This option provides an easy method to switch between trimming and extending.

**Fence**
Selects all objects that cross the selection fence. The selection fence is a series of temporary line segments that you specify with two or more fence points. The selection fence does not form a closed loop.

**Crossing**
Selects objects within and crossing a rectangular area defined by two points.

**NOTE** Some crossing selections of objects to be trimmed are ambiguous. TRIM resolves the selection by following along the rectangular crossing window in a clockwise direction from the first point to the first object encountered.
**Project**  
Specifies the projection method used when trimming objects.

*None* Specifies no projection. The command trims only objects that intersect with the cutting edge in 3D space.

*UCS* Specifies projection onto the XY plane of the current UCS. The command trims objects that do not intersect with the cutting edge in 3D space.

*View* Specifies projection along the current view direction. The command trims objects that intersect the boundary in the current view.
**Edge**
Determines whether an object is trimmed at another object's extrapolated edge or only to an object that intersects it in 3D space.

![Diagram of Edge](image)

**Extend** Extends the cutting edge along its natural path to intersect an object in 3D space.

![Diagram of Extend](image)

**No Extend** Specifies that the object is trimmed only at a cutting edge that intersects it in 3D space.

**NOTE** When trimming hatches, do not set Edge to Extend. If you do, gaps in the trim boundaries will not be bridged when trimming hatches, even when the gap tolerance is set to a correct value.

![Diagram of No Extend](image)

**Erase**
Deletes selected objects. This option provides a convenient method to erase unneeded objects without leaving the TRIM command.

**Undo**
Reverses the most recent change made by TRIM.

**See also:**
Trim or Extend Objects
U Commands

U

Reverses the most recent operation.

Access Methods

Menu: Edit ➤ Undo
Shortcut menu: With no command active and no objects selected, right-click in the drawing area and click Undo.
Command entry: Cmd-Z

Summary

You can enter u as many times as you wish, backing up one step at a time, until the drawing is as it was when you began the current editing session.

When an operation cannot be undone, the command name is displayed but no action is performed. Operations external to the current drawing, such as plotting or writing to a file, cannot be undone.

If you changed modes or used transparent commands during a command, their effects are undone, along with the effects of the main command.

The U command is equivalent to entering undo 1.

See also:

Correct Mistakes

UCS

Sets the origin and orientation of the current UCS.

Access Methods

Button

Toolbar: Drafting tool set ➤ Coordinates tool group ➤ World UCS

1106 | Chapter 2  Commands
Menu: Tools ➤ New UCS
Shortcut menu: Right-click the UCS icon and click an option.

Summary

The UCS is the active coordinate system that establishes the XY plane (work plane) and Z-axis direction for drawing and modeling. Control the UCS origin and orientation to make drawing more convenient as you specify points, enter coordinates, and work with drawing aids, such as Ortho mode and the grid.

A UCS can be stored with a viewport if the UCSV (page 1529) system variable is set to 1 for that viewport.

List of Prompts

The following prompts are displayed.

Specify Origin of UCS (page 1107) or [Face (page 1108)/Named (page 1108)/Object (page 1109)/Previous (page 1109)/View (page 1109)/World (page 1110)/X/Y/Z (page 1110)/ZAxis (page 1111)] <World>:

Specify Origin of UCS
Defines a new UCS using one, two, or three points:

- If you specify a single point, the origin of the current UCS shifts without changing the orientation of the X, Y, and Z axes.
- If you specify a second point, the UCS rotates to pass the positive X axis through this point.
- If you specify a third point, the UCS rotates around the new X axis to define the positive Y axis.

The three points specify an origin point, a point on the positive X axis, and a point on the positive XY plane.
NOTE If you do not specify a Z coordinate value when entering a coordinate, the current Z value is used.

**TIP** You can also select and drag the UCS icon origin grip directly to a new location, or choose Move Origin Only from the origin grip menu.

**Face**

**TIP** You can also select and drag the UCS icon (or choose Move And Align from the origin grip menu) to dynamically align the UCS with faces.

Dynamically aligns the UCS to a face on a 3D object.

Move the cursor over a face to see a preview of how the UCS will be aligned.

Next Locates the UCS on either the adjacent face or the back face of the selected edge.

Xflip Rotates the UCS 180 degrees around the X axis.

Yflip Rotates the UCS 180 degrees around the Y axis.

Accept Accepts the changes and places the UCS.

**Named**

Saves or restores named UCS definitions.

**TIP**

You can also right-click the UCS icon and click Named UCS to save or restore named UCS definitions.

**Restore**

Restores a saved UCS definition so that it becomes the current UCS.

Name Specifies the name of the UCS definition to restore.

?—List UCS definitions Lists details about the specified UCS definitions.
**Save**
Saves the current UCS to a specified name.

**Name** Specifies the name for the UCS definition.

**Delete**
Removes the specified UCS definition from the list of saved definitions.

If you delete a UCS definition that is currently active, the UCS stays in place but is listed as NO NAME.

?—**List UCS Definitions**
Lists saved UCS definitions showing the origin and X, Y, and Z axes for each saved UCS definition relative to the current UCS. Enter an asterisk to list all UCS definitions. If the current UCS is the same as the WCS (World Coordinate System), it is listed as WORLD. If it is custom, but unnamed, it is listed as NO NAME.

**Object**
Aligns the UCS to a selected 2D or 3D object. The UCS can be aligned with any object type except xlines and 3D polylines.

Move the cursor over an object to see a preview of how the UCS will align, and click to place the UCS. In most cases, the UCS origin will be located at the endpoint that is nearest to the specified point, the X axis will align to an edge or tangent to a curve, and the Z axis will align perpendicular to the object.

**Previous**
Restores the previous UCS.

You can steps back through the last 10 UCS settings in the current session. UCS settings are stored independently for model space and paper space.

**View**
Aligns the XY plane of the UCS to a plane perpendicular to your viewing direction. The origin point remains unchanged, but the X and Y axes become horizontal and vertical.
World
Aligns the UCS with the world coordinate system (WCS).

**TIP** You can also click the UCS icon and choose World from the origin grip menu.

**X, Y, Z**
Rotates the current UCS about a specified axis.

Point your right thumb in the positive direction of the X axis and curl your fingers. Your fingers indicate the positive rotation direction about the axis.

Point your right thumb in the positive direction of the Y axis and curl your fingers. Your fingers indicate the positive rotation direction about the axis.
Point your right thumb in the positive direction of the Z axis and curl your fingers. Your fingers indicate the positive rotation direction about the axis.

You can define any UCS by specifying an origin and one or more rotations around the X, Y, or Z axis.

**Z Axis**
Aligns the UCS to a specified positive Z axis.

The UCS origin is moved to the first point and its positive Z axis passes through the second point.
Object Aligns the Z axis tangent to the endpoint that is nearest to the specified point. The positive Z axis points away from the object.

Apply Applies the current UCS setting to a specified viewport or all active viewports when other viewports have a different UCS saved in the viewport. (UCSVP (page 1529) system variable).

Viewport Applies the current UCS to the specified viewport and ends the UCS command.

All Applies the current UCS to all active viewports.

See also:

Work with the User Coordinate System (UCS)

UCSSELECTMODE (page 1528)

UCSICON

Controls the visibility, placement, appearance, and selectability of the UCS icon.

Access Methods

.Button

Icon Properties

Toolbar: Drafting tool set ➤ Coordinates tool group (expanded) ➤ UCS Icon Properties

Menu: View ➤ Display ➤ UCS Icon ➤ Properties
Summary

The UCS icon indicates the location and orientation of the current UCS. You can manipulate the UCS icon using grips. This is controlled by the UCSSELECT-MODE (page 1528) system variable.

**NOTE** If the location of the UCS origin is not visible in a viewport, the UCS icon is displayed in the lower-left corner of the viewport instead.

Different coordinate system icons are displayed in paper space and model space. In model space, you can choose between 2D and 3D icon display styles (see the Properties (page 1114) option):

- **2D**. The letter W appears in the Y portion of the icon if the UCS is the same as the WCS (world coordinate system). If the UCS is rotated so that the Z axis lies in a plane parallel to the viewing plane—that is, if the XY plane is edge-on to the viewer—the 2D UCS icon is replaced by a broken pencil icon.

- **3D**. A square is displayed in the XY plane at the origin if the current UCS is the same as the WCS, and you are viewing the UCS from above (the positive Z direction). The square is missing if you are viewing the UCS from below. The Z axis is solid when viewed from above the XY plane and dashed when viewed from below the XY plane.

![2D UCS](image)

![3D UCS](image)

List of Prompts

The following prompts are displayed.

Enter an option [ON (page 1114)/OFF (page 1114)/All (page 1114)/Noorigin (page 1114)/ORigin (page 1114)/Selectable (page 1114)/Properties (page 1114)]<current>: Enter an option or press Enter
On Displays the UCS icon.

Off Turns off display of the UCS icon.

All Applies changes to the icon in all active viewports. Otherwise, UCSICON affects only the current viewport.

No Origin Displays the icon at the lower-left corner of the viewport regardless of the location of the UCS origin.

Origin Displays the icon at the origin (0,0,0) of the current UCS. If the origin is out of view, it is displayed at the lower-left corner of the viewport.

Selectable Controls whether the UCS icon is selectable and can be manipulated with grips.

Properties Displays the UCS Icon dialog box (page 1114), in which you can control the style, visibility, and location of the UCS icon.

See also:

Control the Display of the User Coordinate System Icon

**UCS Icon Dialog Box**

Controls the style, visibility, and location of the UCS icon.
List of Options

The following options are displayed.

**Style**

Specifies display of either the 2D or the 3D UCS icon and its appearance.

- **2D**
  
  Displays a 2D icon without a representation of the Z axis.

- **3D**
  
  Displays a 3D icon.

**Line Width**

Controls the line width of the UCS icon if the 3D UCS icon is selected.

**Preview**

Displays a preview of the UCS icon in model space.

**Size**

Controls the size of the UCS icon as a percentage of viewport size. The default value is 50, and the valid range is from 5 to 95. Note that the size of the UCS icon is proportional to the size of the viewport in which it is displayed.
**Color**
Controls the colors of the UCS icon in model space viewports and in layout tabs.

**Model Space Icon Color**
Controls the color of the UCS icon in model space viewports.

**Layout Tab Icon Color**
Controls the UCS icon color in layout tabs.

**Apply Single Color**
Applies the selected Model space icon color to all axes of the 2D UCS icon.

See also:
Control the Display of the User Coordinate System Icon

**UCSMAN**
Manages UCS definitions.

**Access Methods**

<table>
<thead>
<tr>
<th>Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbar: Drafting tool set ➤ Coordinates tool group (expanded) ➤ Named UCS</td>
</tr>
<tr>
<td>Menu: Tools ➤ Named UCS</td>
</tr>
</tbody>
</table>

**Summary**
The UCS dialog box (page 1116) is displayed.

See also:
Work with the User Coordinate System (UCS)

**UCS Dialog Box**
Controls the UCS and UCS icon settings for viewports.
Summary

Lists, renames, and restores user coordinate system (UCS) definitions, and controls UCS and UCS icon settings for viewports.

List of Tabs

The UCS dialog box includes the following tabs:

- **Named** (page 1117)
- **Orthographic** (page 1118)
- **Settings** (page 1119)

Named Tab (UCS Dialog Box)

Lists UCS definitions and sets the current UCS.

Current UCS

Displays the name of the current UCS. If the UCS has not been saved and named, it is listed as UNNAMED.

UCS Names List

Lists the coordinate systems defined in the current drawing. If there are multiple viewports and multiple unnamed UCS settings, the list includes only the unnamed UCS of the current viewport. Unnamed UCS definitions that are locked to other viewports (UCSVP (page 1529) system variable = 1) are not listed in the current viewport. A pointer indicates the current UCS. UNNAMED is always the first entry if the current UCS is unnamed. World is always listed and cannot be renamed or deleted. If you define other coordinate
systems for the active viewport during the current editing session, a Previous entry is next. You can step back through these coordinate systems by selecting Previous and Set Current repeatedly.

To add a UCS name to this list, use the Save option of the UCS (page 1106) command.

**Delete** (-) Deletes a named UCS. You cannot delete the World or Previous UCS.

**Options**
Manages the selected UCS in the dialog box.

**Set Current** Restores the selected coordinate system.

**Rename** Renames a customized UCS. You cannot rename the World UCS.

**Details** Displays the UCS Details dialog box (page 1121), which displays UCS coordinate data.

Changes the UCS to one of the orthographic UCS settings.

![UCS Dialog Box](image)

**Current UCS**
Displays the name of the current UCS. If the UCS has not been saved and named, it is listed as UNNAMED.

**Orthographic UCS Names**
Lists the six orthographic coordinate systems defined in the current drawing. The orthographic coordinate systems are defined relative to the UCS specified in the Relative To list.

- **Name**. Specifies the name of the orthographic coordinate system.
**Depth.** Specifies the distance between the XY plane of the orthographic UCS and a parallel plane that passes through the origin of the coordinate system specified by the UCSBASE (page 1525) system variable. The parallel plane of the UCSBASE coordinate system can be an XY, YZ, or XZ plane.

**NOTE** You can specify the depth or a new origin for the selected orthographic UCS. See Depth option.

**Relative To**
Specifies the base coordinate system for defining the orthographic UCSs. By default, WCS is the base coordinate system.
Whenever you change the Relative To setting, the origin of the selected orthographic UCS is restored to its default position.
If you save an orthographic coordinate system in a drawing as part of a viewport configuration, or if you select a setting in Relative To other than World, the orthographic coordinate system name changes to UNNAMED to distinguish it from the predefined orthographic coordinate system.

**Options**
Manages the selected UCS in the dialog box.

**Set Current** Restores the selected coordinate system.

**Reset** Restores the origin of the selected orthographic coordinate system. The origin is restored to its default location (0,0,0) relative to the specified base coordinate system.

**Depth** Specifies the distance between the XY plane of the orthographic UCS and a parallel plane that passes through the origin of the coordinate system.
In the Orthographic UCS Depth dialog box, enter a value or choose the Select New Origin button to use the pointing device to specify a new depth or a new origin.

**Details** Displays the UCS Details dialog box (page 1121), which displays UCS coordinate data.

**Settings Tab (UCS Dialog Box)**
Displays and modifies UCS icon settings and UCS settings saved with a viewport.
Icon
Specifies the UCS icon display settings for the current viewport.
On
Displays the UCS icon in the current viewport.
Display at UCS Origin Point
Displays the UCS icon at the origin of the current coordinate system in the current viewport. If this option is cleared, or if the origin of the coordinate system is not visible in the viewport, the UCS icon is displayed at the lower-left corner of the viewport.
Apply to All Active Viewports
Applies the UCS icon settings to all active viewports in the current drawing.
Allow Selecting UCS Icon
Controls whether the UCS icon is highlighted when the cursor moves over it and whether you can click to select it and access the UCS icon grips.

UCS
Specifies UCS behavior when the UCS setting is updated.
Save UCS with Viewport
Saves the coordinate system setting with the viewport (UCSVP (page 1529) system variable). If this option is cleared, the viewport reflects the UCS of the viewport that is current.

**Update View to Plan When UCS Is Changed**

Restores Plan view when the coordinate system in the viewport is changed. (UCSFOLLOW (page 1526) system variable)

**See also:**

Work with the User Coordinate System (UCS)

### Orthographic UCS Depth Dialog Box

Specifies the depth for an orthographic UCS.

**Access Methods**

**Shortcut menu:** On the Orthographic tab, click Options ➤ Depth.

**List of Options**

The following options are displayed.

<Name> Depth

Specifies the distance between the XY plane of the orthographic UCS and a parallel plane that passes through the origin of the coordinate system.

**Select New Origin**

Temporarily closes the dialog box so that you can use the pointing device to specify a new depth location in the drawing.

To reset the origin of the selected orthographic UCSs to the default location (0,0,0), click Options ➤ Reset.

**See also:**

Work with the User Coordinate System (UCS)

### UCS Details Dialog Box

Displays information about the origin and axes of the selected UCS.
**Access Methods**

**Shortcut menu:** On the Named or Orthographic tab, click Options ➤ Details.

**Summary**

By default, the origin and the values for the X, Y, and Z axes are calculated relative to the world coordinate system.

**List of Options**

The following options are displayed.

**Name**
Displays the name of the current named UCS.

**Origin**
Displays the UCS origin relative to the UCS selected in Relative To.

**X Axis**
Displays the values for the X axis relative to the UCS selected in Relative To.

**Y Axis**
Displays the values for the Y axis relative to the UCS selected in Relative To.

**Z Axis**
Displays the values for the Z axis relative to the UCS selected in Relative To.

**Relative To**
Sets a base coordinate system for calculating the values for Origin, X Axis, Y Axis, and Z Axis. ([UCSBASE](page 1525) system variable)

See also:

- Work with the User Coordinate System (UCS)

**ULAYERS**

Controls the display of layers in a PDF underlay.
Access Methods

Button

 Toolbar: PDF Underlay visor ➤ Underlay Layers
Shortcut menu: Select an underlay. Right-click in the drawing area and choose View PDF Layers.

Summary

The Underlay Layers dialog box (page 1123) is displayed.

See also:

Control the Display of Layers in a PDF Underlay

Underlay Layers Dialog Box

Controls the display of layers in a PDF underlay.

List of Options

The following options are available in this dialog box.
**Reference Name**  
Select the reference whose layers you want to manage.

**Layer List**  
Visible Displays the current visibility state for each layer in the selected underlay. When a layer is on it is visible and available for plotting. When a layer is off, it is invisible and not plotted.  
Click in this column to toggle the current visibility for the layer listed in the Name column.

Name Displays the names of all the available layers in the selected underlay.

**Search for Layers**  
Filters the layer list by name quickly as you enter characters. This filter is not saved when you close the Underlay Layers dialog box. You can also search using wild cards.

**See also:**  
Control the Display of Layers in a PDF Underlay

**UNDEFINE**

Allows an application-defined command to override an internal command.

**List of Prompts**

The following prompts are displayed.  
Enter command name:

Enter a command name to suppress that command. The suppressed command name can then be reDEFINED to perform some other function.

You can undefine only built-in AutoCAD commands. You cannot undefine commands defined by AutoLISP®. This includes ObjectARX™ application commands registered by acedDefun(). You also cannot undefine external commands and aliases defined in the acad.pgp file.

If an AutoLISP or ObjectARX application has reDEFINED a command with the same name as a built-in AutoCAD command, the application-defined command is active.

You can restore an undefined command with REDEFINE (page 880).

You can always access a built-in AutoCAD command by preceding the command name with a period (.)

1124 | Chapter 2  Commands
ObjectARX application commands that are registered by `acedRegCmd` can be accessed by preceding the command name with a period (.), followed by the command's group name, followed by another period (.). For example, the MTEXT command can be accessed with `acad_mtext.mtext`.

To determine command names and groups of an ObjectARX application, use the ARX (page 111) command, and choose the Commands option to see a listing of all currently loaded ObjectARX commands and their group names.

See also:
- Use Built-in Commands in Macros

**UNDO**

Reverses the effect of commands.

**Summary**

UNDO displays the command or system variable name at the Command prompt to indicate that you have stepped past the point where the command was used.

**NOTE** UNDO has no effect on some commands and system variables, including those that open, close, or save a window or a drawing, display information, change the graphics display, regenerate the drawing, or export the drawing in a different format.

**List of Prompts**

The following prompts are displayed.

Enter the number (page 1125) of operations to undo or [Auto (page 1125)/Control (page 1126)/BEgin/End (page 1126)/Mark/Back (page 1126)]: Enter a positive number, enter an option, or press Enter to undo a single operation

**Number**

Undoes the specified number of preceding operations. The effect is the same as entering `u` multiple times.

**Auto**

Groups the commands in a macro, such as a menu macro, into a single action, making them reversible by a single `U` (page 1106) command.
UNDO Auto is not available if the Control option has turned off or limited the UNDO feature.

**Control**
Limits or turns off UNDO.

**All**
Turns on the full UNDO command.

**None**
Turns off the U and UNDO commands and discards any UNDO command information saved earlier in the editing session. The Undo button on the Standard toolbar is unavailable.

The Auto, Begin, and Mark options are not available when None or One is in effect. If you attempt to use UNDO while it is turned off, the following prompt is displayed:

Enter an UNDO control option [All/None/One/Combine/Layer] <All>:

**One**
Limits UNDO to a single operation.

The Auto, Begin, and Mark options are not available when None or One is in effect. The main prompt for the UNDO command changes to show that only a Control option or a single step of the UNDO command is available when the One option is in effect.

**Combine**
Controls whether multiple, consecutive zoom and pan commands are combined as a single operation for undo and redo operations.

**NOTE** Pan and zoom commands that are started from the menu are not combined, and always remain separate actions.

**Layer**
Controls whether the layer dialog operations are combined as a single undo operation.

**Begin, End**
Groups a sequence of actions into a set. After you enter the Begin option, all subsequent actions become part of this set until you use the End option. Entering `undo begin` while a group is already active ends the current set and begins a new one. UNDO and U treat grouped actions as a single action.

If you enter `undo begin` without `undo end`, using the Number option undoes the specified number of commands but does not back up past the begin point. If you want to go back to before the begin point, you must use the End option, even if the set is empty. The same applies to the U command. A mark placed by the Mark option disappears inside an UNDO group.

**Mark, Back**
Mark places a mark in the undo information. Back undoes all the work done back to this mark. If you undo one operation at a time, you are informed when you reach the mark.
You can place as many marks as necessary. Back moves back one mark at a time, removing the mark. If no mark is found, Back displays the following prompt:

This will undo everything. OK? <Y>: Enter y or n or press Enter

Enter y to undo all commands entered in the current session. Enter n to ignore the Back option.

When you use the Number option to undo multiple actions, UNDO stops if it encounters a mark.

See also:
Correct Mistakes

Undocumented Command or System Variable

This command or system variable is not documented in the Help system for one of several reasons, including

- It is obsolete, but included in the product to maintain legacy script compatibility
- It was included for testing purposes and has limited or no functionality

Use Search to find additional information about the feature in which you are interested, and the documented commands and system variables associated with it.

UNGROUP

Disassociates the objects from a group.

Access Methods

Menu: Tools ➤ Ungroup

Summary

UNGROUP removes all objects from the current group.

The following prompts are displayed.

Select group or [Name]:

U Commands | 1127
If a group contains sub-groups, you are prompted to Accept to ungroup the current selection or choose Next to cycle through the groups in the selection set.

See also:
   Edit Groups

**UNION**

Combines selected 3D solids, surfaces, or 2D regions by addition.

**Access Methods**

- **Button**
- **Ribbon:**
  - Modeling tool set ➤ Solids - Edit tool group ➤ Booleans flyout ➤ Union

**Summary**

You can combine two or more 3D solids, surfaces, or 2D regions into a single, composite 3D solid, surface, or region. You must select the same type of objects to combine.
Using the Union Command with Surfaces

Although you can use the UNION command with surfaces, it will cause the surface to lose associativity. Instead, it is recommended that you use the surface editing commands:

- **SURFBLEND** (page 1047)
- **SURFFILLET** (page 1051)
- **SURFPATCH** (page 1056)

Using the Union Command with Solids and Regions

The selection set can contain objects that lie in any number of arbitrary planes. For mixed object types, selection sets are divided into subsets that are joined separately. Solids are grouped in the first subset. The first selected region and all subsequent coplanar regions are grouped in the second set, and so on.

The resulting composite solid includes the volume enclosed by all of the selected solids. Each of the resulting composite regions encloses the area of all regions in a subset.

You cannot use UNION with mesh objects. However, if you select a mesh object, you will be prompted to convert it to a 3D solid or surface.

List of Prompts

The following prompt is displayed.
Select objects Select the 3D solids, surfaces, or regions to be combined.

See also:
Create Composite Objects

UNISOLATEOBJECTS

Displays previously hidden objects.

Access Methods

Menu: Tools ➤ Isolate ➤ End Object Isolation
Shortcut menu: Right-click in the drawing area and click Isolate ➤ End Object Isolation.

Summary
Displays objects previously hidden with the ISOLATEOBJECTS (page 534) or HIDEOBJECTS (page 509) command.

See also:
Control the Display of Objects

UNITS

Controls coordinate and angle display formats and precision.

Access Methods

Menu: Format ➤ Units
Command entry: 'units for transparent use

Summary
The format, precision, and other conventions to be used in displaying coordinates, distances, and angles are set and saved in drawing template files. These settings can also be changed in the current drawing file.
The Drawing Units dialog box (page 1131) is displayed.
If you enter `-units` at the Command prompt, options are displayed (page 1134).

See also:

Determine the Units of Measurement

**Drawing Units Dialog Box**

Controls the displayed precision and format for coordinates and angles.

![Drawing Units Dialog Box](image)

**List of Options**

The following options are displayed.

**Length**

Specifies the current unit of measurement and the precision for the current units.

**Type**

Sets the current format for units of measure. The values include Architectural, Decimal, Engineering, Fractional, and Scientific. The Engineering and
Architectural formats produce feet-and-inches displays and assume that each
drawing unit represents one inch. The other formats can represent any
real-world unit.

**Precision**
Sets the number of decimal places or fractional size displayed for linear
measurements.

**Angle**
Specifies the current angle format and the precision for the current angle
display.

**Type**
Sets the current angle format.

**Precision**
Sets the precision for the current angle display.

The following conventions are used for the various angle measures: decimal
degrees appear as decimal numbers, grads appear with a lowercase g suffix,
and radians appear with a lowercase r suffix. The degrees/minutes/seconds
format uses d for degrees, ' for minutes, and " for seconds; for example:
123d45'56.7"

Surveyor's units show angles as bearings, using N or S for north or south,
degrees/minutes/seconds for how far east or west the angle is from direct north
or south, and E or W for east or west; for example:
N 45d00'0" E

The angle is always less than 90 degrees and is displayed in the
degrees/minutes/seconds format. If the angle is precisely north, south, east,
or west, only the single letter representing the compass point is displayed.

**Clockwise**
Calculates positive angles in the clockwise direction. The default direction for
positive angles is counterclockwise.

When prompted for an angle, you can point in the desired direction or enter
an angle regardless of the setting specified for Clockwise.

**Preview**
Displays an example of the current settings for units and angles.

**Lighting**
Controls the unit of measurement for the intensity of photometric lights in
the current drawing.
NOTE In order to create and use photometric lights, a unit other than Generic must be specified from the list of options. If Insertion Scale is set to Unitless, a warning message is displayed informing you that the rendered output might not be as expected.

**Insertion Scale**

Controls the unit of measurement for blocks and drawings that are inserted into the current drawing. A block or a drawing that is created with units that are different from the units specified with this option is scaled when inserted. The insertion scale is the ratio of the units used in the source block or drawing and the units used in the target drawing. Select Unitless to insert the block without scaling it to match the specified units.

NOTE

In the Application Preferences dialog box, Units & Guides tab, the Source Content Units and Target Drawing Units settings are used when, either in the source block or the target drawing, Insertion Scale is set to Unitless.

**Base Angle Directions**

Sets the direction of the zero angle. The following options affect the entry of angles, the display format, and the entry of polar, cylindrical, and spherical coordinates.

- **East** Specifies the compass direction east (the default).
- **North** Specifies the compass direction north.
- **West** Specifies the compass direction west.
- **South** Specifies the compass direction south.
- **Other** Specifies a direction different from the points of the compass.
- **Angle** Specifies a value for the zero angle when Other is selected.

**Pick an Angle Button** Defines the zero angle in the graphics area based on the angle of an imaginary line that connects any two points you specify with the pointing device.

See also:

- Determine the Units of Measurement
-UNITS

Controls coordinate and angle display formats and precision.

List of Prompts

The following prompts are displayed.
Report formats: (Examples)
1. Scientific 1.55E+01
2. Decimal 15.50
3. Engineering 1'-3.50"
4. Architectural 1'-3 1/2"
5. Fractional 15 1/2
Enter choice, 1 to 5 <current>: Enter a value (1-5) or press Enter

The following prompt for decimal precision is displayed if you specify the scientific, decimal, or engineering format:
Enter number of digits to right of decimal point (0 to 8) <current>: Enter a value (0-8) or press Enter

The following prompt for the denominator of the smallest fraction is displayed if you specify the architectural or fractional format.
Enter denominator of smallest fraction to display (1, 2, 4, 8, 16, 32, 64, 128, or 256) <current>: Enter a value (1, 2, 4, 8, 16, 32, 64, 128, or 256) or press Enter

The next prompt is for angle formats and precision:
Systems of angle measure: (Examples)
1. Decimal degrees 45.0000
2. Degrees/minutes/seconds 45d0'0"
3. Grads 50.0000g
4. Radians 0.7854r
5. Surveyor's units N 45d0'0" E
Enter choice, 1 to 5 <current>: Enter a value (1–5) or press Enter
Enter number of fractional places for display of angles (0 to 8) <current>: Enter a value (0–8) or press Enter

The next prompt is for the direction for angle 0:
Direction for angle 0:
East 3 o'clock = 0
North 12 o'clock = 90
West 9 o'clock = 180
South 6 o'clock = 270
Enter direction for angle 0 <current>: Enter a value or press Enter
The default direction for 0 degrees is to the east quadrant, or 3 o’clock. The default direction for positive angular measurement is counterclockwise.

Measure angles clockwise? [Yes/No] <current>: Enter y or n or press Enter

See also:
Determine the Units of Measurement

**UPDATEFIELD**

Manually updates fields in selected objects in the drawing.

**Access Methods**

Button

 Toolbar: Annotation tool set ➤ Fields tool group ➤ Update Fields

Menu: Tools ➤ Update Field

Shortcut menu: With any text command active and a field selected, right-click and click Update Field.

**Summary**

You can update a field manually when you want to see the latest value. With Date fields, you must update them manually, they never update automatically.

See also:
Update Fields

**UPDATETHUMBSNOW**

Manually updates thumbnail previews for named views, drawings, and layouts.
Summary

The **UPDATE THUMBNAIL** (page 1533) system variable controls how the thumbnail previews are updated. The **UPDATE THUMBSNOW** command updates the following:

- Layout and model space view thumbnails in the Project Manager
- Quick View images

See also:

Switch Between Open Drawings

**UPLOADTOWS**

Uploads the current drawing file to AutoCAD WS.

Access Methods

Menu: File ➤ Upload Drawing Online

Summary

If you are not logged into AutoCAD WS, the **Login to AutoCAD WS dialog box** (page 1137) is displayed prior to the drawing file being uploaded.

The Upload Complete dialog box is displayed when the drawing file is successfully uploaded.

**NOTE** Prior to uploading a drawing file, you need to log into AutoCAD WS. If you do not have an account, click the First Time User? Create an Account link and follow the on screen instructions.

For additional information and tutorials on how to use AutoCAD WS, see [www.autocadws.com](http://www.autocadws.com).

See also:

Use AutoCAD WS for Drawing File Collaboration
Login to AutoCAD WS Dialog Box

Allows you to log in to AutoCAD WS and upload the current drawing file.

List of Options

The following options are displayed.

**Email**
Enter the e-mail address associated with your AutoCAD WS account.

**First Time User? Create an Account**
Launches your default Web browser and displays the Create an AutoCAD WS Account page on [www.autocadws.com](http://www.autocadws.com).

**Password**
Enter the password for your account.

**Forgot Your Password?**
Launches your default Web browser and displays the AutoCAD WS Home page where you can request the password for your account.

**Keep Me Logged In**
The account information you enter is retained for the next time you go to upload a drawing to AutoCAD WS.

**Login**
Logs you into AutoCAD WS and begins the upload process for the drawing.
See also:

Use AutoCAD WS for Drawing File Collaboration

Upload Complete Dialog Box

Displays the current status of the drawing being uploaded to AutoCAD WS.

List of Options

The following options are displayed.

**User Name**
Displays the user name of the account currently logged in.

**Logout**
Logs the current user out and displays the Login to AutoCAD WS dialog box (page 1137).

**Upload Status**
Displays the current status of the drawing being uploaded: Upload Successful, Upload Failed, or Uploading.

**View Online**
Launches your default Web browser and displays the AutoCAD WS website ([www.autocadws.com](http://www.autocadws.com)).

See also:

Use AutoCAD WS for Drawing File Collaboration
**V Commands**

**VIEW**

Saves and restores named model space views, layout views, and preset views.

**Summary**

The options are displayed at the Command prompt, options are displayed (page 1139). If you enter `-view` at the Command prompt, the options are displayed at the Command prompt as well.

**NOTE** The VIEW command cannot be used transparently.

**See also:**
Save and Restore Views

**-VIEW**

**List of Prompts**

The following prompts are displayed.

Enter an option `?` (page 1139)/Delete (page 1139)/Orthographic (page 1139)/Restore (page 1140)/Save (page 1140)/Settings (page 1140)/Window (page 1141):

`?`—List Views The list includes the name of each specified view and the space in which it was defined. M designates model space, and P designates paper space.

Delete Deletes one or more named views.

Orthographic Restores the predefined orthographic view you specify to the current viewport.
The view orientation of the specified orthographic view is based on the **UCSBASE** (page 1525) system variable, which is set to the world coordinate system by default. When one of the orthographic views is restored, the program zooms to the extents in the current viewport.

**Restore** Restores the view you specify to the current viewport. If a UCS setting was saved with the view, it is also restored.

The center point and magnification of the saved view are also restored. If you restore a model space view while working in paper space, you are prompted to select a viewport in which to restore that view.

Select the viewport by clicking its border. The viewport you select must be on and active. The program switches to model space and restores the view in the selected viewport.

If you restore a paper space view while working in model space in a layout tab, the program switches to paper space and restores the view. You can't restore a paper space view if you are working in the Model tab.

**Save** Saves the display in the current viewport using the name you supply.

The current value of the **UCSVIEW** (page 1529) system variable is displayed when you save a view. To change the setting and turn this option on or off, use the UCS option of VIEW.

**Settings** Specifies various settings for the VIEW command.

**Background** Specifies background the for view. Backgrounds are visible in a 3D visual style only.

**Categorize** Specifies a category for the named view.

**Layer Snapshot** Saves the current layer visibility settings with the new named view.

**Live Section** For model views only, specifies the live section applied when the view is restored.
UCS Determines whether the current UCS and elevation settings are saved when a view is saved. ([UCSVIEW](page 1529) system variable)

**Visual Style** Sets or updates a visual style for a view.

**Window** Saves a portion of the current display as a view. Restoring such a view may display objects outside the window you specified because the shape of the window may differ from that of the viewport in which you are restoring the view. However, plotting the view plots only the objects inside the window, not the entire viewport display.

See also:
- Save and Restore Views

**VIEWPLOTDETAILS**

Displays information about completed print and publish jobs.

**Summary**

The Print Details dialog box (page 1141) is displayed.

You can view detailed information about all completed print jobs, or just the errors that have occurred. You can also copy the information displayed in the dialog box to the Clipboard.

See also:
- Overview of Plotting

**Print Details Dialog Box**

Displays information about plotting and publishing jobs that have been completed in the current session.
List of Options

The following options are displayed.

**View**
Specifies what is displayed. You can also right-click in the details area and click View Errors Only or View All to change this setting.

**All** Displays information about all completed print and publish jobs and sheets within those jobs.

**Errors** Lists errors that have occurred as jobs were printed or published.

**Copy to Clipboard**
Copies all highlighted text to the Clipboard.

**Details Area**
Lists details of completed print and publish jobs.
**VIEWRES**

Sets the resolution for objects in the current viewport.

**Summary**

The model is regenerated.

VIEWRES controls the appearance of circles, arcs, splines, and arced polylines using short vectors. The greater the number of vectors, the smoother the appearance of the circle or arc. For example, if you create a very small circle and then zoom in, it might appear to be a polygon. Using VIEWRES to increase the zoom percentage and regenerate the drawing updates and smooths the circle’s appearance.

![VIEWRES at 500](image)

**NOTE** Increasing the zoom percentage in VIEWRES may increase the time it takes to regenerate the drawing.

When a named (paper space) layout is made current for the first time and a default viewport is created in the layout, the viewing resolution for this initial viewport is the same as the viewing resolution for the Model layout viewport.

The VIEWRES setting is saved in the drawing. To change the default for new drawings, consider specifying the VIEWRES setting in the template files on which you base your new drawings.

**See also:**

Change Views
**VISUALSTYLES (-VISUALSTYLES)**

Creates and modifies visual styles from the command line.

**List of Prompts**

The following prompts are displayed.

Enter an option [set Current (page 1144)/Saveas (page 1144)/Rename (page 1144)/Delete (page 1144)/? (page 1144)]:

**Set Current**

These options are the same as the options in **VSCURRENT** (page 1158).

**Save As**

Saves the visual style with the name you specify.

**NOTE**

You must be in model space to save a visual style. If you enter a name that is already in use for a visual style, you can either replace the existing visual style or enter a different name.

**Rename**

Renames a visual style.

**Delete**

Deletes a visual style.

?—List Visual Styles

Lists the visual styles in the drawing.

**See also:**

Use a Visual Style to Display Your Model

**VPCLIP**

Clips layout viewport objects and reshapes the viewport border.

**Access Methods**

* Menu: Modify ➤ Clip ➤ Viewport

**Shortcut menu:** Select the viewport to clip. Right-click in the drawing area and choose Viewport Clip.
Summary

You can either select an existing object to designate as the new boundary, or specify the points of a new boundary. The new boundary does not clip the old boundary, it redefines it.

**TIP** Use the CLIP (page 201) command to clip any type of referenced file: images, external references, viewports, and PDF underlays.

List of Prompts

The following prompts are displayed.

**Clipping Object** Specifies an object to act as a clipping boundary. Objects that are valid as clipping boundaries include closed poly-lines, circles, ellipses, closed splines, and regions.

**Polygonal** Draws a clipping boundary. You can draw line segments or arc segments by specifying points. The following prompt is displayed:

The descriptions of the Next Point, Arc, Close, Length, and Undo options match the descriptions of the corresponding options in the PLINE (page 796) command.

**Delete** Deletes the clipping boundary of a selected viewport. This option is available only if the selected viewport has already been clipped. If you clip a viewport that has been previously clipped, the original clipping boundary is deleted, and the new clipping boundary is applied.

See also:

Create and Modify Layout Viewports

**VPLAYER**

Sets layer visibility within viewports.

List of Prompts

The following prompts are displayed.

Enter an option [? (page 1146)/Color (page 1146)/Ltype (page 1146)/LWeight (page 1146)/PStyle (page 1147)/Transparency (page 1147)/Freeze (page 1147)/Thaw (page 1147)/Reset (page 1147)/Newfrz (page 1148)/Vpvisdflt (page 1148)]:

V Commands | 1145
In the Model layout, the VPLAYER command has two options. Enter an option [Newfrz (page 1148)/Vpvisdflt (page 1148)]:

?-List Frozen Layers
Displays the names of frozen layers in a selected viewport.

**Color**
Changes the color associated with a layer.

*True Color* Specifies a true color to use for the selected object.

*Color Book* Specifies a color from a loaded color book to use for the selected object.

**All** Applies the changes in all viewports.

**Select** Applies the changes in selected viewports.

**Current** Applies the changes in the current viewport only.

**Except Current** Applies the changes to all viewports across all layouts except the current viewport.

**Ltype**
Changes the linetype associated with a layer.

- **All** (page 1146)
- **Select** (page 1146)
- **Current** (page 1146)
- **Except Current** (page 1146)

**Lweight**
Changes the lineweight associated with a layer.

If you enter a lineweight that is not valid, the current lineweight is set to the nearest fixed lineweight value.

If you want to print an object with a custom width not found in the list of fixed lineweight values, you can use the Plot Style Table Editor to customize plotted lineweights.

- **All** (page 1146)
- **Select** (page 1146)
- **Current** (page 1146)
- **Except Current** (page 1146)
**Pstyle**
Sets the plot style assigned to a layer. This option is not available if you are using color-dependent plot styles in the current drawing (the PSTYLEPOLICY (page 1451) system variable is set to 1). See Use Plot Styles to Control Plotted Objects in the User’s Guide.

- All (page 1146)
- Select (page 1146)
- Current (page 1146)
- Except Current (page 1146)

**Transparency**
Changes the transparency level associated with a layer.

- All (page 1146)
- Select (page 1146)
- Current (page 1146)
- Except Current (page 1146)

**Freeze**
Freezes a layer or set of layers in one or more viewports. Objects on frozen layers are not displayed, regenerated, or plotted.

- All (page 1146)
- Select (page 1146)
- Current (page 1146)
- Except Current (page 1146)

**Thaw**
Thaws layers in specific viewports.

- All (page 1146)
- Select (page 1146)
- Current (page 1146)
- Except Current (page 1146)

**Reset**
Sets the visibility of layers in specified viewports to their current default setting.

- All (page 1146)
Select (page 1146)
Current (page 1146)
Except Current (page 1146)

Newfrz (New Freeze)
Creates new layers that are frozen in all viewports.

Vpvisdflt (Viewport Visibility Default)
Thaws or freezes the specified layers in subsequently created viewports.

See also:
Freeze Specified Layers in a Layout Viewport

VPMAX

Expands the current layout viewport for editing.

Access Methods

_TOOLBAR: Status bar ➤ Maximize Viewport
_Pointing device: Viewport Control menu (+) ➤ Maximize Viewport
_Shortcut menu: Select a named layout viewport to maximize. Right-click and click Maximize Viewport.
_Pointing device: Double-click a named layout viewport.

Summary

The viewport is expanded to fill the screen and switched to model space for editing.

See also:
Access Model Space from a Layout Viewport

VPMIN

Restores the current layout viewport.
**Access Methods**

- **Toolbar**: Status bar ➤ Minimize Viewport
- **Pointing device**: Viewport Control menu (+) ➤ Restore Layout
- **Shortcut menu**: Select a named layout viewport to maximize. Right-click and click Minimize Viewport.
- **Pointing device**: Double-click outside of the maximized viewport.

**Summary**

The center point and magnification are returned to the settings that were in effect before the viewport was maximized.

**See also:**
- Access Model Space from a Layout Viewport

**VPOINT**

Sets the viewing direction for a 3D visualization of the drawing.

**Access Methods**

- **Menu**: View ➤ 3D Views ➤ Viewpoint

**List of Prompts**

The following prompts are displayed.

Specify a view point (page 1149) or [Rotate (page 1150)] <display compass and tripod (page 1150)>: Specify a point, enter r, or press Enter to display a compass and axis tripod

**View Point** Creates a vector that defines a direction from which the drawing can be viewed. The view defined is as if the viewer is looking from the point back at the origin (0,0,0).
Rotate Specifies a new viewing direction using two angles.

- **Enter angle in XY plane from X axis.**

  The first angle is specified with respect to the X axis, in the XY plane.

- **Enter angle from XY plane.**

  The second angle is specified up or down from the XY plane.

**Compass and Axis Tripod** Displays a compass and axis tripod, which you use to define a viewing direction in the viewport.

The compass is a two-dimensional representation of a globe. The center point is the north pole (0,0,n), the inner ring is the equator (n,n,0), and the entire outer ring is the south pole (0,0,-n).
As you move the crosshairs, the axis tripod rotates to conform to the viewing direction indicated on the compass. To select a viewing direction, move your pointing device to a location on the globe and click.

See also:
Define a 3D View with Coordinate Values or Angles

VPORTS

Creates multiple viewports in model space or paper space.

Access Methods

Menu: View ➤ Viewports ➤ New Viewports, Named Viewports
Shortcut menu: Right-click the drawing area when a named layout is current and click Viewports ➤ Named Viewports, New Viewports

Summary

The Viewports dialog box (page 1151) is displayed.

If you enter -vports at the Command prompt, options are displayed (page 1154).

See also:
Set Model Space Viewports

Viewports Dialog Box

Creates new viewport configurations, or names and saves a model space viewport configuration.

Summary

The options available depend on whether you are configuring model space viewports (on the Model layout) or layout viewports (on a named (paper space) layout).
List of Options

The following options are displayed.

**New Viewports Tab—Model Space (Viewports Dialog Box)**

- **New Name**
  Specifies a name for the new model space viewport configuration. If you do not enter a name, the viewport configuration is applied but not saved. If a viewport configuration is not saved, it cannot be used in a layout.

- **Standard Viewports**
  Lists and sets the standard viewport configurations, including CURRENT, which is the current configuration.

- **Preview**
  Displays a preview of the viewport configuration you select and the default views assigned to each individual viewport in the configuration.

- **Apply To**
  Applies the model space viewport configuration to the entire display or to the current viewport.
  - **Display:** Applies the viewport configuration to the entire Model tab display.
- **Current Viewport**: Applies the viewport configuration to the current viewport only.

**Setup**
Specifies either a 2D or a 3D setup. When you select 2D, the new viewport configuration is initially created with the current view in all of the viewports. When you select 3D, a set of standard orthogonal 3D views is applied to the viewports in the configuration.

**Change View To**
Replaces the view in the selected viewport with the view you select from the list. You can choose a named view, or if you have selected 3D setup, you can select from the list of standard views. Use the Preview area to see the choices.

**Visual Style**
Applies a visual style to the viewport. All available visual styles are displayed.

**Named Viewports Tab—Model Space (Viewports Dialog Box)**
Lists all saved model viewport configurations in the drawing.

![Named Viewports Tab](image)

**Current Name**
Displays the name of the current viewport configuration.
**New Viewports Tab—Layouts (Viewports Dialog Box)**

- **Standard Viewports** Displays a list of standard viewport configurations and configures layout viewports.
- **Preview** Displays a preview of the viewport configuration you select and the default views assigned to each individual viewport in the configuration.
- **Viewport Spacing**
  Specifies the spacing you want to apply between the layout viewports you are configuring.
- **Setup** Specifies either a 2D or a 3D setup. When you select 2D, the new viewport configuration is initially created with the current view in all of the viewports. When you select 3D, a set of standard orthogonal 3D views is applied to the viewports in the configuration.
- **Change View To** Replaces the view in the selected viewport with the view you select from the list. You can choose a named view, or if you have selected 3D setup, you can select from the list of standard views.

**Named Viewports Tab—Layouts (Viewports Dialog Box)**

Displays any saved and named model space viewport configurations for you to use in the current layout. You cannot save and name a layout viewport configuration.

**See also:**

- Set Model Space Viewports

---

**-VPOR**

Creates multiple viewports in model space or paper space.

**Summary**

The command prompts available depend on whether you are configuring model viewports (page 1155) (on the Model tab) or layout viewports (page 1156) (on a layout).

**See also:**

- Set Model Space Viewports
-VPORTS - Model Space Viewports

Creates multiple viewports in model space.

Summary

The number and layout of active viewports and their associated settings are called viewport configurations.

List of Prompts

The following prompts are displayed.
Enter an option [Save (page 1155)/Restore (page 1155)/Delete (page 1155)/Join (page 1155)/Single (page 1155)/? (page 1156)/2 (page 1156)/3 (page 1156)/4 (page 1156)] <3>: Enter an option

Save Saves the current viewport configuration using a specified name.

Restore Restores a previously saved viewport configuration.

Delete Deletes a named viewport configuration.

Join Combines two adjacent model viewports into one larger viewport.

The two model viewports must share a common edge of the same length. The resulting viewport inherits the view of the dominant viewport.

Save restores the current viewport configuration using a specified name.

Restore restores a previously saved viewport configuration.

Delete deletes a named viewport configuration.

Join combines two adjacent model viewports into one larger viewport.

The two model viewports must share a common edge of the same length. The resulting viewport inherits the view of the dominant viewport.

Single returns the drawing to a single viewport view, using the view from the current viewport.
List Viewport Configurations Displays the identification numbers and screen positions of the active viewports.

The lower-left and upper-right corners of the viewport define its location. For these corners, values between 0.0,0.0 (for the lower-left corner of the drawing area) and 1.0,1.0 (for the upper-right corner) are used. The current viewport is listed first.

2 Divides the current viewport in half.

3 Divides the current viewport into three viewports.
The Horizontal and Vertical options split the area into thirds. The Above, Below, Left, and Right options specify where the larger viewport is placed.

4 Divides the current viewport into four viewports of equal size.

See also:
Set Model Space Viewports

-VPORTS - Layout Viewports

Creates multiple viewports in named (paper space) layouts.

Access Methods

Shortcut menu: Right-click in drawing area when a named layout is current and click Viewports ➤ 1 Viewport, 2 Viewports, 3 Viewports, 4 Viewports, Polygonal Viewport, Object, Join

Summary

The number and layout of active viewports and their associated settings are called viewport configurations.
List of Prompts

The following prompts are displayed.
Specify corner of viewport or [ON (page 1157)/OFF (page 1157)/Fit (page 1157)/Shadeplot (page 1157)/Lock (page 1157)/Object (page 1157)/Polygonal (page 1157)/Restore (page 1157)/Layer (page 1157)/2 (page 1157)/3 (page 1158)/4 (page 1158)] <Fit>: Specify a point or enter an option

On Turns on a viewport, making it active and making its objects visible.

Off Turns off a viewport. When a viewport is off, its objects are not displayed, and you cannot make that viewport current.

Fit Creates one viewport that fills the available display area. The actual size of the viewport depends on the dimensions of the paper space view.

Shadeplot Specifies how viewports in layouts are plotted.
  ■ As Displayed: Plots the same way it is displayed
  ■ Wireframe: Plots wireframe regardless of display
  ■ Hidden: Plots with hidden lines removed regardless of display
  ■ Visual Styles: Plots using the specified visual style; all visual styles in the drawing are listed as options whether in use or not
  ■ Render Presets: Plots using the specified render preset; all render presets are listed as options

Lock Locks the current viewport. This is similar to layer locking.

Object Creates a non-rectangular layout viewport from a closed polyline, ellipse, spline, region, or circle. The polyline you specify must be closed and contain at least three vertices. It can be self-intersecting, and it can contain arcs as well as line segments.

Polygonal Creates a non-rectangular layout viewport defined by a series of line and arc segments.
The descriptions of the Next Point, Arc, Close, Length, and Undo options match the descriptions of the corresponding options in the PLINE (page 796) command.

Restore Restores a previously saved viewport configuration.

Layer Resets layer property overrides for the selected viewport to their global layer properties.

2 Divides the current viewport in half.
3 Divides the current viewport into three viewports.
Horizontal and Vertical split the area into thirds. The other options create one large viewport in half the available area and two smaller ones in the other half. Above, Below, Left, and Right specify where the larger viewport is placed.

4 Divides the current viewport into four viewports of equal size.

See also:
Create and Modify Layout Viewports

VSCURRENT

Sets the visual style in the current viewport.

List of Prompts

The following prompts are displayed.
Enter an option [2dwireframe (page 1159)/Wireframe (page 1159)/Hidden (page 1159)/Realistic (page 1159)/Conceptual (page
NOTE To display lighting from point lights, distant lights, spotlights, or the sun, set the visual style to Realistic, Conceptual, or a custom visual style with shaded objects.

2D Wireframe Displays the objects using lines and curves to represent the boundaries. Raster images, linetypes, and lineweights are visible. Even if the value for the COMPASS system variable is set to 1, it does not appear in the 2D Wireframe view.

Wireframe Displays the objects using lines and curves to represent the boundaries. Displays a shaded 3D UCS icon. You can set the COMPASS system variable to 1 to view the compass.

Hidden Displays the objects using 3D wireframe representation and hides lines representing back faces.

Realistic Shades the objects and smooths the edges between polygon faces. Materials that you have attached to the objects are displayed.

Conceptual Shades the objects and smooths the edges between polygon faces. Shading uses a transition between cool and warm colors. The effect is less realistic, but it can make the details of the model easier to see.

Shaded Produces a smooth shaded model.

Shaded with Edges Produces a smooth shaded model with visible edges.

Shades of Gray Produces a gray color effect by using the monochrome face color mode.

Sketchy Produces a hand-sketched effect by using the overhang and jitter.

X-ray Changes the opacity of faces to make the whole scene partially transparent.

Other Displays the following prompt:
Enter a visual style name [?]: Enter the name of a visual style in the current drawing, or enter ? to display a list of names and repeat the prompt

See also:
   Use a Visual Style to Display Your Model
VSSAVE

Saves a visual style.

List of Prompts

The following prompts are displayed.

Save current visual style as or [?] 

Enter a name or enter ? to list all the visual styles in the drawing.

NOTE You must be in model space to save a visual style. If you enter a name that is already in use for a visual style, you can either replace the existing visual style or enter a different name.

See also:

Use a Visual Style to Display Your Model

W Commands

WBLOCK

Saves selected objects or converts a block to a specified drawing file.

Access Methods

Button

Toolbar: Drafting tool set ➤ Block tool group (expanded) ➤ Write Block

Summary

The Write Block dialog box (page 1161) is displayed.

Entering -wblock at the Command prompt displays a standard file selection dialog box in which to specify a name for the new drawing file, followed by command prompts (page 1163). If FILEDIA (page 1334) is set to 0, the standard file selection dialog box is suppressed.
See also:
Create Drawing Files for Use as Blocks

Write Block Dialog Box

Saves objects or converts a block to a file.

Summary

The Write Block dialog box displays different default settings depending on whether nothing is selected, a single block is selected, or objects other than blocks are selected.
List of Options

The following options are displayed.

Save Location

Specifies the new name and location of the file and the units of measurement to be used when the block is inserted.

File Name and Path

Specifies a file name and path where the block or objects will be saved.

Browse

Displays a standard file selection dialog box (page 723).

Preview

Displays a preview of the objects selected to be written to a drawing file.

Creation

Specifies blocks and objects, saves them as a file, and specifies insertion points.

Selected Objects

Selects objects to save as a file. Specify a base point and select objects below.

Entire Drawing

Selects current drawing to save as another file.

Block

Specifies an existing block to save as a file. Select a name from the list.

Source Objects

Sets the effect of block creation on objects used to create a block.

Select Objects Button

Temporarily closes the dialog box so that you can select one or more objects to save to the file.

Convert to Block

Converts the selected object or objects to a block in the current drawing after saving them as a file.

Retain objects

Retains the selected objects in the current drawing after saving them as a file.

Delete objects
Deletes the selected objects from the current drawing after saving them as a file.

**Base Point**

Specifies a base point for the block. The default value is 0,0,0.

**Pick Point**

Temporarily closes the dialog box so that you can specify an insertion base point in the current drawing.

**X**

Specifies the X coordinate value for the base point.

**Y**

Specifies the Y coordinate value for the base point.

**Z**

Specifies the Z coordinate value for the base point.

**Extended Options**

**Blocks Unit**

Specifies the unit value to be used for automatic scaling when the new file is inserted as a block in a drawing that uses different units. Select Unitless if you do not want to automatically scale the drawing when you insert it. See `IN-SUNITS` (page 1373).

See also:

- Create Drawing Files for Use as Blocks

**-WBLOCK**

Saves selected objects or converts a block to a specified drawing file.

**Summary**

If `FILEDIA` (page 1334) is set to 1, entering `-wbloc\ck` at the Command prompt displays a standard file selection dialog box in which to specify a name for the new drawing file. If `FILEDIA` is set to 0, entering `-wblock` at the Command prompt displays a prompt. The new drawing is saved in the file format that is specified in Save As on the Open and Save tab in the Options dialog box.
After the file is created, the selected objects are deleted from the drawing. You can use OOPS (page 722) to restore the objects.

In the new drawing, the world coordinate system (WCS) is set parallel to the user coordinate system (UCS).

**List of Prompts**

The following prompts are displayed.

Enter name of output file:
Enter name of existing block or 
[= (block=output file)/* (whole drawing)] <define new drawing>:

**Existing Block** Writes that block to a file. You cannot enter the name of an external reference (xref) or one of its dependent blocks.

= Specifies that the existing block and the output file have the same name.

* Writes the entire drawing to the new output file, except for unreferenced symbols. Model space objects are written to model space, and paper space objects are written to paper space.

See also:

Create Drawing Files for Use as Blocks

**WEBLIGHT**

Creates a web light.

**Access Methods**

Button
List of Prompts

The following prompts are displayed.
Specify source location <0,0,0>: Enter coordinate values or use the pointing device
Specify target location <1,1,1>: Enter coordinate values or use the pointing device
Enter an option to change [Name (page 1165)/Intensity factor (page 1165)/Status (page 1165)/Photometry (page 1165)/web (page 1166)/shadow (page 1166)/filterColor (page 1167)/eXit (page 1167)]<eXit>:

NOTE The LIGHTINGUNITS system variable must be set to a value other than 0 to create and use weblights.

Name
Specifies the name of the light.

Intensity Factor
Sets the intensity or brightness of the light.

Status
Turns the light on and off. If lighting is not enabled in the drawing, this setting has no effect.

Photometry
Photometry is available when the LIGHTINGUNITS system variable is set to 1 or 2. Photometry is the measurement of the luminous intensities of visible light sources.

In photometry, luminous intensity is a measure of the perceived power emitted by a light source in a particular direction. Luminous flux is the perceived power in per unit of solid angle. The total luminous flux for a lamp is the perceived power emitted in all directions. Luminance is the total luminous flux incident on a surface, per unit area.

Intensity Enter an intensity value in candelas, the perceived power in a luminous flux value, or illuminance value for the total luminous flux incident on a surface.

- Candela (symbol: cd) is the SI unit of luminous intensity (perceived power emitted by a light source in a particular direction). Cd/Sr
- Lux (symbol: lx) is the SI unit of illuminance. Lm/m^2
Foot-candle (symbol: fc) is the American unit of illuminance. Lm/ft^2

Enter f to specify the perceived power in a luminous flux value.
If you enter i, you can specify the intensity of the light based on an illuminance value.
The illuminance value can be specified in either lux or foot-candles. Enter d to specify a distance to use to calculate illuminance.

Color Specify the color of the light based on a color name or a Kelvin temperature. Enter ? to display a list of color names.
Enter a text string using wild card characters to display a partial listing of color names, or an asterisk (*) to display all the possible choices.
If you enter k, you can specify the color of the light based on a Kelvin temperature value.

Exit Exits the command.

Web
Specifies the intensity for a light at points on a spherical grid.

File Specifies which web file to use to define the properties of the web. Web files have the file extension .ies.

X Specifies the X rotation for the web.

Y Specifies the Y rotation for the web.

Z Specifies the Z rotation for the web.

Shadow
Makes the light cast shadows.

Off Turns off the display and calculation of shadows for the light. Use this option to increase performance.

Sharp Displays shadows with sharp edges. Use this option to increase performance.

Soft Mapped Displays realistic shadows with soft edges.

Map Size Specifies the amount of memory to use to calculate the shadow map.

Softness Specifies the softness to use to calculate the shadow map.

Soft Sampled Displays realistic shadows with softer shadows (penumbra) based on extended light sources.
Specify the shape of the shadow by entering s and then the dimensions of the shape. (For example, the radius of the sphere or the length and width of a rectangle.)

Specify the sample size by entering a.

Specify the visibility of the shape by for the shadow by entering v.

**Filter Color**
Controls the color of the light.

*True Color* Specifies a True Color. Enter in the format R,G,B (red, green, blue).

*Index* Specifies an ACI (AutoCAD Color Index) color.

*HSL* Specifies an HSL (hue, saturation, luminance) color.

*Color Book* Specifies a color from a color book.

**Exit**
Exits the command.

**See also:**
Overview of Weblights

**WEDGE**
Creates a 3D solid wedge.

**Access Methods**

**Button**

**Toolbar:** Modeling tool set ➤ Solids - Create tool group ➤ Solid Primitive flyout ➤ Weblight

**Menu:** Draw ➤ 3D Modeling ➤ Wedge

**Summary**
The direction of the taper is always in the positive X-axis direction of the UCS.
List of Prompts

The following prompts are displayed.
Specify first corner or [Center (page 1168)]: Specify a point or enter c for center
Specify other corner or [Cube (page 1169)/Length (page 1169)]: Specify the other corner of the wedge or enter an option
If the other corner of the wedge is specified with a Z value that differs from the first corner, then no height prompt is displayed.
Specify height or [2Point (page 1169)] <default>: Specify the height or enter 2P for the 2 Point option
Entering a positive value draws the height along the positive Z axis of the current UCS. Entering a negative value draws the height along the negative Z axis.

**Center**
Creates the wedge by using a specified center point.

**Cube** Creates a wedge with sides of equal length.
**Length** Creates a wedge with length, width, and height values you specify. The length corresponds to the X axis, the width to the Y axis, and the height to the Z axis. If you pick a point to specify the length, you also specify the rotation in the XY plane.

**Cube**
Creates a wedge with sides of equal length.

**Length**
Creates a wedge with length, width, and height values you specify. The length corresponds to the X axis, the width to the Y axis, and the height to the Z axis.

**2Point**
Specifies that the height of the wedge is the distance between the two specified points.
See also:
   Create a Solid Wedge

WHOHAS

Displays ownership information for opened drawing files.

Summary

You can use WHOHAS to track which users have certain drawing files open. After you select a file, the ownership information is displayed at the Command prompt. The information includes the current user's computer name, login ID, and full name (if available) and the date and time the drawing file was opened.

NOTE Similar information is displayed automatically when you try to open a drawing file that another user has already opened.

The information displayed by WHOHAS is stored in a temporary DWL (drawing lock) file. A DWL file is deleted when the file is closed.

See also:
   Open a Drawing

WIPEOUT

Creates a wipeout object, and controls whether wipeout frames are displayed in the drawing.

Access Methods

Button

 Toolbar: Drafting tool set ➤ Closed Shapes tool group (expanded) ➤ Wipeout
 Menu: Draw ➤ Wipeout
Summary

Creates a polygonal area that masks underlying objects with the current background color. The wipeout area is bounded by a frame that you can turn on for editing and turn off for plotting.

List of Prompts

The following prompts are displayed.

Specify first point (page 1171) or [Frames (page 1171)/Polyline (page 1171)] <Polyline>.

First Point Determines the polygonal boundary of the wipeout object from a series of points.

Frames Determines whether the edges of all wipeout objects are displayed or hidden.

Polyline Determines the polygonal boundary of the wipeout objects from a selected polyline.

Erase Polyline Enter y to erase the polyline that was used to create the wipeout object. Enter n to retain the polyline.

See also:

Create a Blank Area to Cover Objects
X Commands

**XATTACH**

Inserts DWG files as an external reference (xref).

**Access Methods**

Menu: Insert ➤ DWG Reference

**Summary**

When you attach a drawing file as an xref, you link that referenced drawing to the current drawing. Any changes to the referenced drawing are displayed in the current drawing when it is opened or reloaded.

The Select Reference File dialog box (a standard file selection dialog box (page 723)) is displayed. After you select the DWG files, the Attach External Reference dialog box (page 1172) is displayed.

After the files are attached, you can adjust and clip the xref through the External Reference visor (page 1175).

See also:

Attach Drawing References (Xrefs)

**Attach External Reference Dialog Box**

Attaches drawings as an external reference (xref).
Summary

If you attach a drawing that contains an attached xref, the attached xref appears in the current drawing. You can select multiple DWG files to attach. Like blocks, attached xrefs can be nested. If another person is currently editing the xref, the attached drawing is based on the most recently saved version.

List of Options

The following options are displayed.

Name
Identifies the DWG you have selected to attach.

Browse
Displays the Select Reference File dialog box (a standard file selection dialog box (page 723)), in which you can select a new external reference for the current drawing.

Reference Type
Specifies whether the external reference is an attachment or an overlay. Unlike an xref that is an attachment, an overlay is ignored when the drawing to which it is attached is then attached as an xref to another drawing.

See Attach Drawing References (Xrefs) and Nest and Overlay Referenced Drawings.

Preview
Displays the DWG you have selected to attach.
**Insertion Point**
*Specify On-Screen* Allows you to input at the Command prompt or the pointing device.

X Sets the X coordinate value.
Y Sets the Y coordinate value.
Z Sets the Z coordinate value.

**Scale**
*Specify On-screen* Allows you to input at the Command prompt or the pointing device.

X Sets the X scale factor.
Y Sets the Y scale factor.
Z Sets the Z scale factor.

*Uniform Scale* Sets the Y and X scale factors as the same as Z.

**Rotation**
*Specify on-screen* If Specify On-Screen is selected, you may wait until you exit the dialog box to rotate the object with your pointing device or at the Command prompt.

*Angle* If Specify On-Screen is cleared, enter the rotation angle value in the dialog box.

**Path Type**
Select the full (absolute) path, the relative path to the external reference file, or No Path, the name of the external reference (the file must be located in the same folder as the current drawing file).

**Details**
Displays block and path information about the external reference being attached.

*Block* Displays information about the block in the drawing.

- **Unit.** Displays the specified INSUNITS (page 1373) value for the inserted block.
- **Factor.** Displays the unit scale factor, which is calculated based on the INSUNITS (page 1373) value of the block and the drawing units.

*Path* Displays the external reference file paths.

- **Found In.** Displays the path where the external reference file is located.
Saved Path. Displays the path that is saved with the drawing when the external reference is attached. The path is dependent upon the Path Type setting.

See also:
Attach Drawing References (Xrefs)

External Reference Visor

Displays options for attaching external references.

Summary

The External Reference visor is displayed when you select an external reference.

List of Options

The following options are displayed.

Edit Reference in Place
Edits the selected xref directly within the current drawing window. (REFEDIT (page 883) command)

Open Reference in New Window
Opens the selected drawing reference (xref) in a new window. (XOPEN (page 1184) command)

Create Clipping Boundary
Crops the display of the selected external reference to a specified boundary. (XCLIP (page 1178) command)

Delete the Clipping Boundary
Removes the clipping boundary from the selected external reference. (XCLIP (page 1178) command)

Show/Hide Reference Manager
Opens or closes the Reference Manager palette. (EXTERNALREFERENCES (page 418) command)
XBIND

Binds one or more definitions of named objects in an xref to the current drawing.

**Access Methods**

Menu: Modify ➤ Object ➤ External Reference ➤ Bind

**Summary**

The Bind External Definitions dialog box (page 1176) is displayed.
If you enter -xbind at the Command prompt, options are displayed (page 1178).

**NOTE** The Bind option of XREF binds the xref file. Use XBIND for individual dependent definitions.

**See also:**

Archive Drawings That Contain Referenced Drawings (Bind)

**Bind External Definitions Dialog Box**

Adds xref-dependent named objects (such as blocks, dimension styles, layers, linetypes, and text styles) to your drawing.
List of Options

The following options are displayed.

**Xrefs**

Lists the xrefs currently attached to the drawing. Selecting an xref (double-clicking) displays the named object definitions in the attached xref.

**Definitions to Bind**

Lists the xref-dependent named object definitions to bind to the host drawing.

**Add**

Moves the named object definitions selected in the Xrefs list into the Definitions to Bind list.

**Remove**

Moves the xref-dependent named object definition selected in the Definitions to Bind list back to its xref-dependent definition table.

**See also:**

Archive Drawings That Contain Referenced Drawings (Bind)
-XBIND

Binds one or more definitions of named objects in an xref to the current drawing.

List of Prompts

The following prompts are displayed.

Enter symbol type to bind [Block/Dimstyle/Layer/LType/Style]:

Enter an option

Depending on the option, you are prompted for a xref-dependent named object (symbol) such as a block, dimension style, layer, linetype, or text style.

Enter dependent Symbol name(s): Enter a name list or * to bind all xref-dependent named objects (symbols) from that definition table

The name you specify must be the full name, including the vertical bar character (|).

The xref-dependent named objects you specify are added to your drawing. You can manipulate them as you would any other named object. The vertical bar character (|) from each xref-dependent named object is replaced with a number (usually 0) between two dollar signs ($).

If you specify a layer whose associated linetype is not CONTINUOUS, XBIND also binds the referenced linetype. If you apply XBIND to a block, any block, dimension style, layer, linetype, or text style that's referenced by objects in the block is also bound. If the block contains an xref, XBIND binds that xref and all its dependent named objects.

See also:

- Archive Drawings That Contain Referenced Drawings (Bind)

XCLIP

Crops the display of a selected external reference or block reference to a specified boundary.

Access Methods

Menu: Modify ➤ Clip ➤ Xref
Shortcut menu: Select an xref. Right-click in the drawing area and click Clip Xref.

Summary

The clipping boundary determines the portion of an xref or block instance that is hidden, either outside or inside the boundary. The visibility of the clipping boundary is controlled by the XCLIPFRAME (page 1572) system variable.

TIP Use the CLIP (page 201) command to clip any type of referenced file: images, external references, viewports, and PDF underlays.

List of Options

The following options are displayed.

On
Displays the clipped portion of the external reference or block in the current drawing.

Off
Displays all of the geometry of the external reference or block in the current drawing, ignoring the clipping boundary.

Clipdepth
Sets the front and back clipping planes on an xref or block. Objects outside the volume defined by the boundary and the specified depth are not displayed. Regardless of the current UCS, the clip depth is applied parallel to the clipping boundary.

Front Clip Point Creates a clipping plane passing through and perpendicular to the clipping boundary.

Distance Creates a clipping plane the specified distance from and parallel to the clipping boundary.

Remove Removes both the front and back clipping planes.

Delete
Removes a clipping boundary for the selected xref or block. To temporarily turn off a clipping boundary, use the Off option. Delete erases the clipping boundary and the clipdepth. The ERASE (page 410) command cannot be used to delete clipping boundaries.

Generate Polyline
Automatically draws a polyline coincident with the clipping boundary. The polyline assumes the current layer, linetype, lineweight, and color settings.
Use this option when you want to modify the current clipping boundary using `PEDIT` (page 779) and then redefine the clipping boundary with the new polyline. To see the entire xref while reddefining the boundary, use the Off option.

**New Boundary**
Defines a rectangular or polygonal clipping boundary, or generates a polygonal clipping boundary from a polyline.

**Select Polyline** Defines the boundary with the selected polyline. The polyline can be open but must consist of straight line segments and cannot intersect itself.

**Polygonal** Defines a polygonal clipping boundary with three or more points that you specify for the vertices of a polygon.

**Rectangular** Defines a rectangular boundary with the points that you specify for opposite corners.

**Invert Clip** Inverts the mode of the clipping boundary: objects are clipped either outside the boundary or inside the boundary.

**NOTE** You can only create a new clipping boundary for a selected XREF underlay when the old boundary is deleted.

See also:
Clip External References and Blocks

**XEDGES**

Creates wireframe geometry from the edges of a 3D solid, surface, mesh, region, or subobject.

**Access Methods**

**Button**

- **Toolbar**: Modeling tool set ➤ Solids - Edit tool group (expanded) ➤ Extract Edges
- **Menu**: Modify ➤ 3D Operations ➤ Extract Edges
Summary

With the XEDGES command, you can create wireframe geometry by extracting all the edges from the following objects:

- 3D solids
- 3D solid history subobjects
- Meshes
- Regions
- Surfaces
- Subobjects (edges and faces)

Press and hold Ctrl to select faces, edges and component objects, repeating if necessary. Objects such as lines, arcs, splines, or 3D polylines are created along the edges of the selected objects or subobjects.

See also:

Create Wireframe Models

XLINE

Creates a line of infinite length.

Access Methods

1. Button
Toolbar: Drafting tool set ➤ Open Shapes tool group (expanded) ➤ Construction Line

Menu: Draw ➤ Construction Line

Summary

Lines that extend to infinity, such as xlines, can be used to create construction and reference lines, and for trimming boundaries.

List of Prompts

The following prompts are displayed.
Specify a point (page 1182) or [Hor (page 1182)/Ver (page 1183)/Ang (page 1183)/Bisect (page 1183)/Offset (page 1184).

Point
Specifies the location of the infinite line using two points through which it passes.

The xline is created through the specified point.

Hor
Creates a horizontal xline passing through a specified point.
The xline is created parallel to the X axis.
**Ver**
Creates a vertical xline passing through a specified point.
The xline is created parallel to the $Y$ axis.

**Ang**
Creates an xline at a specified angle.

**Angle of Xline** Specifies the angle at which to place the line.

**Reference** Specifies the angle from a selected reference line. The angle is measured counterclockwise from the reference line.

**Bisect**
Creates an xline that passes through the selected angle vertex and bisects the angle between the first and second line.
The xline lies in the plane determined by the three points.
**Offset**
Creates an xline parallel to another object.

**Offset Distance** Specifies the distance the xline is offset from the selected object.

**Through** Creates an xline offset from a line and passing through a specified point.

*See also:*
  - Draw Construction Lines (and Rays)

**XOPEN**
Opens a selected drawing reference (xref) in a new window.

**Summary**
Opens a selected drawing reference in a separate window for editing.

*See also:*
  - Edit a Referenced Drawing in a Separate Window

**XPLODE**
Breaks a compound object into its component objects.

**Summary**
Reports how many objects were selected and, of those, how many objects cannot be exploded.

**List of Prompts**
The following prompts are displayed.
Enter an option [Individually (page 1185)/Globally (page 1185)].
Individually
Applies changes to the selected objects one at a time. The following prompt is displayed for each object.

All Sets the color, linetype, lineweight, and layer of the component objects after you explode them. The prompts associated with the Color, Linetype, Lineweight, and Layer options are displayed.

Color Sets the color of the objects after you explode them.
- Enter bylayer to inherit the color of the exploded object's layer.
- Enter byblock to inherit the color of the exploded object.
- Enter t for a true color to be used for the selected object.
- Enter co for a color from a loaded color book to be used for the selected object.

Layer Sets the layer of the component objects after you explode them. The default option is to inherit the current layer rather than the layer of the exploded object.

LType Sets the linetype of the component objects after you explode them.
Enter bylayer to inherit the linetype of the exploded object's layer.
Enter byblock to inherit the linetype of the exploded object.

LWeight Sets the lineweight of the component objects after you explode them.

Inherit from Parent Block Sets the color, linetype, lineweight, and layer of the component objects to that of the exploded object if the component objects' color, linetype, and lineweight are BYBLOCK and the objects are drawn on layer 0.

Explode Breaks a compound object into its component objects exactly as the EXPLODE (page 411) command does.

Globally
Applies changes to all the selected objects.
See also:
Disassemble a Block Reference (Explode)

**XREF**

Starts the EXTERNALREFERENCES command.

**Summary**

The Reference Manager palette (page 418) is displayed.

If you enter `-xref` at the Command prompt, options are displayed (page 1186).

See also:
Attach and Detach Referenced Drawings
ERHIGHLIGHT (page 1322)

**-XREF**

Attach and manage external referenced drawings (xrefs).

**List of Prompts**

The following prompts are displayed.

**Enter an Option**

?—List Xrefs  Lists the DWG reference name, path, and type and the number of DWG references currently attached to your drawing.

Bind  Converts a specified DWG reference into a block, making it a permanent part of the drawing.

The xref-dependent named objects, such as layer names, of the former xref are added to your drawing. In each xref-dependent named object, the vertical bar (|) is replaced with three new characters: a number (usually 0) between two dollar signs ($). The number is increased if the same name already exists in the current drawing.

Detach  Detaches one or more DWG references from your drawing, erasing all instances of a specified xref and marking the xref definition for deletion from the definition table. Only the xrefs attached or overlaid directly to the current drawing can be detached; nested xrefs cannot be detached.
Path Displays and edits the path name associated with a particular DWG reference. This option is useful if you change the location of or rename the drawing file associated with the xref.

Unload Unloads the selected DWG references.
A marker is left in place of the xref so that it can be reloaded later.

Reload Reloads one or more DWG references. This option reloads and displays the most recently saved version of that drawing.
If the program encounters an error while reloading, it ends XREF and undoes the entire reloading sequence.

Overlay Displays the Enter Name of File to Overlay dialog box (a standard file selection dialog box). If you reference a drawing that contains an overlaid xref, the overlaid xref does not appear in the current drawing.
Unlike blocks and attached xrefs, overlaid xrefs cannot be nested. If another person is currently editing the xref file, the program overlays the most recently saved version.
If the xref you specify is not already overlaid, a new xref is created, using the name of the referenced file.
If FILEDIA is set to 0, the following prompt is displayed:
Enter Name of File to Overlay.
You can enter a tilde (~) to display a dialog box.

Attach Displays the Select Reference File dialog box. See XATTACH (page 1172).
If you reference a drawing that contains an attached xref, the attached xref appears in the current drawing. Like blocks, attached xrefs can be nested. If another person is currently editing the xref file, the most recently saved version is attached.

Specify Insertion Point
Specify a point or enter an option

Scale Sets the scale factor. All X and Y dimensions of the xref are multiplied by the X and Y scale factors. The xref is rotated by the specified angle, using the insertion point as the center of rotation.

X, Y, and Z Sets X, Y, and Z scale factors.
- **X Scale Factor.** Defines X, Y, and Z scale factors for the xref.
- **Corner.** Defines the X and Y scales at the same time, using the insertion point and another point as the corners of a box, and then defines the Z scale.

Rotate Sets the angle of insertion for the xref.
**PScale** Sets the scale factor for the X, Y, and Z axes to control the display of the xref as it is dragged into position.

**PX, PY, and PZ** Sets the X, Y, and Z axes to control the display of the xref as it is dragged into position.

**PRotate** Sets the rotation angle of the xref as it is dragged into position.

See also:
Attach and Detach Referenced Drawings

### Z Commands

**ZOOM**

Increases or decreases the magnification of the view in the current viewport.

**Access Methods**

- **Menu:** View ➤ Zoom ➤ Realtime
- **Toolbar:** Status bar ➤ Zoom
- **Shortcut menu:** With no objects selected, right-click in the drawing area and choose Zoom to zoom in real time.

**Summary**

You can change the magnification of a view by zooming in and out, which is similar to zooming in and out with a camera. Using ZOOM does not change the absolute size of objects in the drawing. It changes only the magnification of the view.

In a perspective view, ZOOM displays the 3DZOOM (page 54) prompts.

**NOTE** You cannot use ZOOM transparently during VPOINT (page 1149) or DVIEW (page 389) or while ZOOM, PAN (page 767), or VIEW (page 1139) is in progress.

**List of Prompts**

The following prompts are displayed.
Specify corner of window, enter a scale factor (nX or nXP), or

[All (page 1189)/Center (page 1189)/Dynamic (page 1189)/Extents (page 1190)/Previous (page 1190)/Scale (page 1190)/Window (page 1191)/Object (page 1191)] <real time (page 1191)>

**All** Zooms to display all visible objects and visual aids.

Adjusts the magnification of the drawing area to accommodate the extents of all visible objects in the drawing, or visual aids such as the grid limits (the LIMITS (page 575) command), whichever is larger.

In the illustration on the right, the grid limits are set to a larger area than the extents of the drawing.

Because it always regenerates the drawing, you cannot use ZOOM All transparently.

**Center** Zooms to display a view defined by a center point and a magnification value or a height. A smaller value for the height increases the magnification. A larger value decreases the magnification. Not available in perspective projection.

**Dynamic** Pans and zooms using a rectangular view box. The view box represents your view, which you can shrink or enlarge and move around the drawing. Positioning and sizing the view box pans or zooms to fill the viewport with the view inside the view box. Not available in perspective projection.
■ To change the size of the view box, click, resize it, and click again to accept the new size of the view box.

■ To pan with the view box, drag it to the location you want and press Enter.

**Extents** Zoons to display the maximum extents of all objects.

The extents of each object in the model are calculated and used to determine how the model should fill the window.

**Previous** Zoons to display the previous view. You can restore up to 10 previous views.

---

**NOTE** If you change the visual style, the view is changed. If you enter ZOOM Previous, it restores the previous view, which is shaded differently but not zoomed differently.

**Scale** Zoons to change the magnification of a view using a scale factor.

■ Enter a value followed by \( x \) to specify the scale relative to the current view.

■ Enter a value followed by \( x p \) to specify the scale relative to paper space units.
For example, entering .5x causes each object to be displayed at half its current size on the screen.

Entering .5xp displays model space at half the scale of paper space units. You can create a layout with each viewport displaying objects at a different scale. Enter a value to specify the scale relative to the grid limits of the drawing. (This option is rarely used.) For example, entering 2 displays objects at twice the size they would appear if you were zoomed to the limits of the drawing.

**Window** Zooms to display an area specified by a rectangular window. With the cursor, you can define an area of the model to fill the entire window.

**Object** Zooms to display one or more selected objects as large as possible and in the center of the view. You can select objects before or after you start the ZOOM command.

**Real Time** Zooms interactively to change the magnification of the view. The cursor changes to a magnifying glass with plus (+) and minus (-) signs. See **Zoom Shortcut Menu** (page 1192) for a description of the options that are available while zooming in real time.
Holding down the pick button at the midpoint of the window and moving vertically to the top of the window zooms in to 100%. Conversely, holding the pick button down at the midpoint of the window and moving vertically to the bottom of the window zooms out by 100%.

When you reach the zoom-in limit, the plus sign in the cursor disappears, indicating that you can no longer zoom in. When you reach the zoom-out limit, the minus sign in the cursor disappears, indicating that you can no longer zoom out.

When you release the pick button, zooming stops. You can release the pick button, move the cursor to another location in the drawing, and then press the pick button again and continue to zoom the display from that location.

To exit zooming, press Enter or Esc.

**See also:**

Pan or Zoom a View

### Zoom Shortcut Menu

Shortcut menu allows you to switch between pan and different zoom options.

**Summary**

When the ZOOM command is active, you can exit ZOOM or switch to **PAN** (page 767) or **3DORBIT** (page 40) using the options on the Zoom shortcut menu. To access the Zoom shortcut menu, right-click in the drawing area while ZOOM is active.

**List of Options**

The following options are displayed.

**Exit** Cancels ZOOM or PAN.

**Pan** Switches to PAN.

**Zoom** Switches to ZOOM in real time.

**3D Orbit** Switches to 3DORBIT.

**Zoom Window** Zooms to display an area specified by a rectangular window.
**Zoom Object** Zooms to display one or more selected objects as large as possible and in the center of the drawing area.

**Zoom Original** Restores the original view.

**Zoom Extents** Zooms to display the drawing extents.

**See also:**

Pan or Zoom a View
Overview of Command Modifiers

You can use command modifiers to help you locate points or select objects while a command is in progress. Use the Coordinate Filter, Direct Distance Entry, From, MTP, and Tracking command modifiers at any prompt that requires point specification. Use the Selection Mode command modifiers at any prompt that requires object selection.

Coordinate Filters (Command Modifier)

Combines X, Y, and Z values from different points to specify a single point

**Command entry:** Enter .x, .y, .xy, .xz, or .yz

At any prompt for locating a point, you can enter point filters to specify a single coordinate by extracting the X, Y, and Z values of several points. In the following example, the start point for the line has a coordinate constructed from the X value of the midpoint of the first object you select, with the Y and Z values of the midpoint of the second object you select.

Command: `line`
Specify first point: `.x`
of `mid`
of `Select an object`
of (need YZ) `mid`
of `Select another object`
To point: `Specify a point`
Direct Distance Entry (Command Modifier)

Locates the next point at a specified distance in the direction of your cursor

**Command entry:** At a prompt to locate a point, enter a numeric value

With direct distance entry, you can quickly specify a point relative to the last point you entered. At any prompt for a point location, you move the cursor first to specify the direction, and then enter a numeric distance.

In the following example, the second point for the line will be located 5 units toward the direction of the cursor. The direct distance that you enter is measured along the path from the last point to the current location of the cursor. This feature is usually used with Ortho or Snap mode turned on.

Command: `line`

Specify first point: Specify a point

Specify next point: Move the cursor in the desired direction and enter 5

**NOTE** The direct distance entry method is not available while you are using temporary override keys for Ortho, object snap tracking, or polar tracking.

See also:

Enter Direct Distances

FROM (Command Modifier)

Locates a point offset from a reference point within a command.

**Toolbar:** Object Snap

**Command entry:** At a prompt to locate a point, enter from

Base Point: Specify a point to use as a base point of <offset>: Enter a relative offset

At a prompt for locating a point, enter from, and then enter a temporary reference or base point from which you can specify an offset to locate the next point. Enter the offset location from this base point as a relative coordinate, or use direct distance entry (page 1196).
NOTE You cannot use this method during dragging in commands such as MOVE and COPY. Specifying an absolute coordinate, either by keyboard entry or with a pointing device, cancels the FROM command.

See also:
Offset from Temporary Reference Points

MTP (Command Modifier)
Locates the midpoint between two points.

Command entry: At a prompt to locate a point, enter `mtp`
The midpoint between two points (MTP) command modifier can be used with running object snaps or object snap overrides. (OSNAP (page 747) command)
At any Command prompt to locate a point, enter `mtp` or `m2p`.
First point of mid: Specify a point
Second point of mid: Specify a second point

TRACKING (Command Modifier)
Locates a point from a series of temporary points.

Command entry: At a prompt to locate a point, enter `tracking`
Tracking turns on Ortho mode and can be used with Snap mode.
At any prompt to locate a point, enter `tracking`, `track`, or `tk`.
First tracking point: Specify a location or distance
Next point (Press ENTER to end tracking): Specify a second location or distance
Tracking specifies a series of temporary points, each offset from the previous one. Thus, you specify a new point location from a series of directions and distances. To determine the location of each temporary point, you can use direct distance entry (page 1196). First move the cursor to specify the direction, and then enter a numeric distance.
Alternatively, tracking can establish a new point by combining the X and Y values of two specified points. You can specify these two points in any order, depending on the cursor direction after the first point. Direct distance entry...
specifies a distance in the direction of the current location of your cursor. Coordinate filters (page 1195) combine X, Y, and Z values from different points into a single point. Relative coordinate entry locates a point relative to the last point entered.

You can also access tracking by holding down SHIFT and right-clicking to display the object snap shortcut menu.

**See also:**
Track to Offset Point Locations (Tracking)

## Object Snaps (Command Modifier)

Specifies a precise point at a location on an object.

**Command entry:** Within a command, at a prompt to locate a point, specify an object snap

When you specify an object snap, the cursor snaps to the specified point on an object closest to the center of the cursor. By default, a marker and a tooltip are displayed when you move the cursor over the object snap location on an object.

### Specify a Single Object Snap

If you specify a single object snap, it stays in effect only for the next point you specify.

You can specify an object snap with any of the following methods:

- Enter a object snap by typing its name. To see a list of valid object snaps, refer to the OSNAP (page 747) command or the Drafting Settings Dialog Box (page 369).

- Click an object snap from the Object Snap toolbar.

- Click an object snap from the Object Snap shortcut menu. You can display this shortcut menu by pressing SHIFT while you right-click.
**Use Running Object Snaps**

Using the [OSNAP](page 747) or [DSETTINGS](page 368) commands, you can specify a set of *running object snaps*. Running object snaps are one or more object snaps that remain in effect as you work.

- To turn running object snaps on and off, click the OSNAP button on the status bar or press F3.
- Press TAB to cycle through the object snap possibilities before you specify the point.
- To turn off running object snaps for the next point only, specify the None object snap.

**Selection Modes (Command Modifiers)**

Controls how you create selection sets

- **Command entry**: At a prompt to select objects, enter one of the valid selection modes described in the SELECT command

The selection mode you enter remains active only for the current Select Objects prompt.

**See also:**

Select Objects
System Variables

Overview of System Variables

AutoCAD® stores the values for its operating environment and some of its commands in system variables. You can examine any system variable and change any writable system variable directly at the command prompt by entering the system variable name or by using the SETVAR command or the AutoLISP® getvar and setvar functions. Many system variables are also accessible through dialog box options.

3D System Variables

3DOSMODE

Controls the settings for the 3D object snaps.

Type: Integer  
Saved in: Registry  
Initial value: 11

Controls which 3D object snaps are enabled. The setting is stored as a bitcode using the sum of the following values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
<th>Shortcut Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Enables all 3D object snaps</td>
<td></td>
</tr>
<tr>
<td>Value</td>
<td>Description</td>
<td>Code</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
<td>------</td>
</tr>
<tr>
<td>1</td>
<td>Disables all 3D object snaps</td>
<td>ZNON</td>
</tr>
<tr>
<td>2</td>
<td>Snaps to a vertex or a control vertex</td>
<td>ZVER</td>
</tr>
<tr>
<td>4</td>
<td>Snaps to the midpoint on a face edge</td>
<td>ZMID</td>
</tr>
<tr>
<td>8</td>
<td>Snaps to the center of a face</td>
<td>ZCEN</td>
</tr>
<tr>
<td>16</td>
<td>Snaps to a spline or surface knot</td>
<td>ZKNO</td>
</tr>
<tr>
<td>32</td>
<td>Snaps to a perpendicular face (planar faces only)</td>
<td>ZPER</td>
</tr>
<tr>
<td>64</td>
<td>Snaps to an object nearest to a face</td>
<td>ZNEA</td>
</tr>
<tr>
<td>126</td>
<td>Turns on all 3D object snaps</td>
<td></td>
</tr>
</tbody>
</table>

To specify more than one object snap, enter the sum of their values. For example, entering 6 specifies the vertex (2) and midpoint (4) object snaps. Entering 126 turns on all 3D object snaps.

**See also:**
Use Object Snaps

### 3DSELECTIONMODE

Controls the selection precedence of both visually and physically overlapping objects when using 3D visual styles.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Use legacy 3D selection precedence.</td>
</tr>
</tbody>
</table>
Use line-of-sight 3D selection precedence for selecting 3D solids and surfaces. Also, a defining object associated with a surface is given selection precedence with this setting.

3DSELECTIONMODE has no effect when selecting 3D solids if they are displayed as 2D or 3D wireframes.

See also:
Select Objects Individually

A System Variables

ACADLSPASDOC

Controls whether the acad.lsp file is loaded into every drawing or just the first drawing opened in a session.

| Type:       | Integer |
| Saved in:   | Registry |
| Initial value: | 0 |

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Loads acad.lsp into just the first drawing opened in a session</td>
</tr>
<tr>
<td>1</td>
<td>Loads acad.lsp into every drawing opened</td>
</tr>
</tbody>
</table>

See also:
AutoLISP

ACADPREFIX

Stores the directory path, if any, specified by the ACAD environment variable, with path separators appended if necessary.

(Read-only)

| Type:       | String |
| Saved in:   | Not-saved |
| Initial value: | Varies |
See also:
Set Up the Drawing Area

ACADVER

Stores the AutoCAD version number.
(Read-only)
Type: String
Saved in: Not-saved
Initial value: Varies

This variable differs from the DXF file $ACADVER header variable, which contains the drawing database level number.

See also:
Customize the Drawing Environment

ACISOUTVER

Obsolete

This system variable has been removed. The ACIS output version is controlled by the product when exporting a drawing to a SAT file with ACISOUT or EXPORT.

See also:
Export ACIS SAT Files

AFLAGS

Sets options for attributes.

Type: Integer
Saved in: Not-saved
Initial value: 16
The value is the sum of the following:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No attribute mode selected</td>
</tr>
<tr>
<td>1</td>
<td>Invisible</td>
</tr>
<tr>
<td>2</td>
<td>Constant</td>
</tr>
<tr>
<td>4</td>
<td>Verify</td>
</tr>
<tr>
<td>8</td>
<td>Preset</td>
</tr>
<tr>
<td>16</td>
<td>Lock position in block</td>
</tr>
<tr>
<td>32</td>
<td>Multiple lines</td>
</tr>
</tbody>
</table>

See also:

Define Block Attributes

**ANGBASE**

Sets the base angle to 0 with respect to the current UCS.

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** 0.0000

See also:

Create Angular Dimensions

**ANGDIR**

Sets the direction of positive angles.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0
Angle values are measured from angle 0 relative to the orientation of the current UCS.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Counterclockwise</td>
</tr>
<tr>
<td>1</td>
<td>Clockwise</td>
</tr>
</tbody>
</table>

See also:
Create Angular Dimensions

**ANNOALLVISIBLE**

Hides or displays annotative objects that do not support the current annotation scale.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 1

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Only annotative objects that support the current annotation scale are displayed</td>
</tr>
<tr>
<td>1</td>
<td>All annotative objects are displayed</td>
</tr>
</tbody>
</table>

The ANNOALLVISIBLE setting is saved individually for model space and each layout.

**NOTE** When ANNOALLVISIBLE is set to 1, annotative objects that support more than one scale will only display one scale representation.

See also:
Display Annotative Objects

**ANNOAUTOSCALE**

Updates annotative objects to support the annotation scale when the annotation scale is changed.
Type: Integer
Saved in: Registry
Initial value: -4

When the value is negative, the autoscale functionality is turned off, but the settings are maintained:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Newly set annotation scale is not added to annotative objects.</td>
</tr>
<tr>
<td>1</td>
<td>Adds the newly set annotation scale to annotative objects that support the current scale except for those on layers that are turned off, frozen, or that are set to Viewport &gt; Freeze.</td>
</tr>
<tr>
<td>2</td>
<td>Adds the newly set annotation scale to annotative objects that support the current scale except for those on layers that are turned off, frozen, or that are set to Viewport &gt; Freeze.</td>
</tr>
<tr>
<td>3</td>
<td>Adds the newly set annotation scale to annotative objects that support the current scale except for those on layers that are locked.</td>
</tr>
<tr>
<td>4</td>
<td>Adds the newly set annotation scale to all annotative objects that support the current scale.</td>
</tr>
</tbody>
</table>

See also:
Set Annotation Scale

**ANNO MONITOR**

Turns the annotation monitor on or off. When the annotation monitor is on, it flags all non-associative annotations by placing a badge on them.

Type: Integer
Saved in: Registry
Initial value: -1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Annotation monitor is on.</td>
</tr>
<tr>
<td>1</td>
<td>Annotation monitor on.</td>
</tr>
</tbody>
</table>
Annotation monitor off. However, automatically turns on (sets AN-NOMONITOR to 2), when a model documentation edit or update event occurs.

See also:
- Associative Dimensions
- Overview of Leader Objects

**ANNOTATEDWG**

Specifies whether or not the drawing will behave as an annotative block when inserted into another drawing.

- **Type:** Integer
- **Saved in:** Drawing
- **Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Nonannotative</td>
</tr>
<tr>
<td>1</td>
<td>Annotative</td>
</tr>
</tbody>
</table>

**NOTE** The ANNOTATEDWG system variable becomes read-only if the drawing contains annotative objects.

See also:
- Create Annotative Blocks and Attributes

**APBOX**

Turns the display of the AutoSnap aperture box on or off.

- **Type:** Integer
- **Saved in:** Registry
**Initial value:**

0

The aperture box is displayed in the center of the crosshairs when you snap to an object.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off</td>
</tr>
<tr>
<td>1</td>
<td>On</td>
</tr>
</tbody>
</table>

See also:

Set Visual Aids for Object Snaps (AutoSnap)

**APERTURE**

Sets the display size for the object snap target box, in pixels.

**Type:** Integer

**Saved in:** Registry

**Initial value:** 10

This system variable has the same name as a command. Use the SETVAR command to access this system variable.

Enter a value (1-50). The higher the number, the larger the target box.

You can also change this setting on the Application Preferences dialog box, Cursor & Selection tab (page 730).

APERTURE controls the object snap target box, not the pickbox displayed at the Select Objects prompt. The object selection pickbox is controlled by the PICKBOX (page 1433) system variable.

See also:

Use Object Snaps

**APPAUTOLOAD**

Controls when plug-in applications are loaded.

**Type:** Bitcode

**Saved in:** User-settings
Initial value: 14

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Do not load plug-in applications at any time</td>
</tr>
<tr>
<td>1</td>
<td>Display all messages when loading plug-in applications</td>
</tr>
<tr>
<td>2</td>
<td>Load plug-in applications at startup</td>
</tr>
<tr>
<td>4</td>
<td>Load plug-in applications when a new drawing is opened</td>
</tr>
<tr>
<td>8</td>
<td>Load plug-in applications when they appear in the plug-ins folder</td>
</tr>
</tbody>
</table>

See also:
Install and Uninstall Plug-In Applications

AREA

Stores the last area computed by the AREA command.
(Read-only)
Type: Real
Saved in: Not-saved
Initial value: 0.0000

This system variable has the same name as a command.
Use the SETVAR command to access this system variable.

See also:
Obtain Area and Mass Properties Information

ARRAYASSOCIATIVITY

Sets the default behavior of new arrays to be associative or non-associative.
Type: Integer
Saved in: Registry
Initial value: 1
Associative arrays are treated as a single array object, which is helpful when you want to modify spacing, angles, or replace or modify the source object. If an array is non-associative, each copied item is treated as a separate object. Editing one item does not affect the other items.

<table>
<thead>
<tr>
<th></th>
<th>Non-associative</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Associative</td>
</tr>
</tbody>
</table>

See also:
Array Objects

**ARRAYEDITSTATE**

Indicates whether the drawing is in the array editing state, which is activated while editing an associative array's source objects.

(Read-only)

| Type: Integer |  |
| Saved in: Not-saved |  |
| Initial value: Off |  |

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off</td>
</tr>
<tr>
<td>1</td>
<td>On</td>
</tr>
</tbody>
</table>

See also:
Edit Associative Arrays

**ARRAYTYPE**

Specifies the default array type.

| Type: Integer |  |
| Saved in: Registry |  |
**Initial value:** 0

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Rectangular array</td>
</tr>
<tr>
<td>1</td>
<td>Path array</td>
</tr>
<tr>
<td>2</td>
<td>Polar array</td>
</tr>
</tbody>
</table>

See also:
Array Objects

**ATTDIA**

Controls whether the INSERT command uses a dialog box for attribute value entry.

Type: Integer  
Saved in: Registry  
Initial value: 0

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Issues Command prompts</td>
</tr>
<tr>
<td>1</td>
<td>Uses a dialog box</td>
</tr>
</tbody>
</table>

See also:
Insert Blocks

**ATTIPE**

Controls if all formatting options are available with the in-place editor for modifying multiline attributes.

Type: Integer  
Saved in: Registry  
Initial value: 0

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Limited formatting options with the in-place editor</td>
</tr>
</tbody>
</table>
Use the limited formatting options with the in-place editor when modifying multiline attributes for best compatibility with releases prior to AutoCAD 2008.

See also:
  Define Block Attributes

### ATTMODE

Controls display of attributes.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off: Makes all attributes invisible</td>
</tr>
<tr>
<td>1</td>
<td>Normal: Retains current visibility of each attribute; visible attributes are displayed; invisible attributes are not</td>
</tr>
<tr>
<td>2</td>
<td>On: Makes all attributes visible</td>
</tr>
</tbody>
</table>

See also:
  Define Block Attributes

### ATTMULTI

Controls whether multiline attributes can be created.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Turns off all access methods for creating multiline attributes. They can still be viewed and edited.</td>
</tr>
</tbody>
</table>
### ATTREQ

Controls whether INSERT uses default attribute settings during insertion of blocks.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Assumes the defaults for the values of all attributes</td>
</tr>
<tr>
<td>1</td>
<td>Turns on prompts or a dialog box for attribute values, as specified by ATTDIA (page 1212)</td>
</tr>
</tbody>
</table>

**See also:**  
Insert Blocks

### AUDITCTL

Controls whether AUDIT creates an audit report (ADT) file.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Prevents writing of ADT files</td>
</tr>
<tr>
<td>1</td>
<td>Writes ADT files</td>
</tr>
</tbody>
</table>

**See also:**  
Repair a Damaged Drawing File
**AUNITS**

Sets units for angles.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Decimal degrees</td>
</tr>
<tr>
<td>1</td>
<td>Degrees/minutes/seconds</td>
</tr>
<tr>
<td>2</td>
<td>Gradians</td>
</tr>
<tr>
<td>3</td>
<td>Radians</td>
</tr>
<tr>
<td>4</td>
<td>Surveyor's units</td>
</tr>
</tbody>
</table>

**See also:**  
Set the Unit Format Conventions

**AUPREC**

Sets the display precision for angular units and coordinates.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0

However, the internal precision of angular values and coordinates is always maintained, regardless of the display precision. AUPREC does not affect the display precision of dimension text (see DIMSTYLE (page 319)).

Valid values are integers from 0 to 8.

**See also:**  
Set the Unit Format Conventions
AUTOCOMPLETDELAY

Controls the amount of time that elapses before automated keyboard features display at the Command prompt.

Type: Integer
Saved in: Drawing
Initial value: 0.3

The time delay setting in the AUTOCOMPLETEMODE (page 1216) system variable must be turned on for AUTOCOMPLETDELAY to have an effect.

Valid values are real numbers from 0 to 10, which represent seconds.

See also:

The Command Line
Enter Commands on the Command Line

AUTOCOMPLETEMODE

Controls what types of automated keyboard features are available at the Command prompt.

Type: Integer
Saved in: Drawing
Initial value: 15

The setting is stored as a bitcode using the sum of the following values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Turns off all automated keyboard features when typing at the Command prompt</td>
</tr>
<tr>
<td>1</td>
<td>Turns on any automated keyboard features when typing at the Command prompt</td>
</tr>
<tr>
<td>2</td>
<td>Automatically appends suggestions as each keystroke is entered after the third keystroke</td>
</tr>
<tr>
<td>4</td>
<td>Displays a list of suggestions as keystrokes are entered</td>
</tr>
<tr>
<td>8</td>
<td>Displays the icon of the command or system variable, if available</td>
</tr>
<tr>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>0</td>
<td>Turns off the AutoSnap marker, tooltips, and magnet. Also turns off polar tracking, object snap tracking, and tooltips for polar tracking, object snap tracking, and Ortho mode.</td>
</tr>
<tr>
<td>1</td>
<td>Turns on the AutoSnap marker</td>
</tr>
<tr>
<td>2</td>
<td>Turns on the AutoSnap tooltips</td>
</tr>
<tr>
<td>4</td>
<td>Turns on the AutoSnap magnet</td>
</tr>
<tr>
<td>8</td>
<td>Turns on polar tracking</td>
</tr>
<tr>
<td>16</td>
<td>Turns on object snap tracking</td>
</tr>
<tr>
<td>32</td>
<td>Turns on tooltips for polar tracking, object snap tracking, and Ortho mode</td>
</tr>
</tbody>
</table>

**AUTOSNAP**

Controls the display of the AutoSnap marker, tooltip, and magnet.

- **Type:** Integer
- **Saved in:** Registry
- **Initial value:** 63

Also turns on polar and object snap tracking, and controls the display of polar tracking, object snap tracking, and Ortho mode tooltips. The setting is stored as a bitcode using the sum of the following values:

See also:

- Set Visual Aids for Object Snaps (AutoSnap)
B System Variables

BACKZ

Stores the back clipping plane offset from the target plane for the current viewport, in drawing units.

(Read-only)

Type: Real
Saved in: Drawing
Initial value: 0.0000

Meaningful only if clipping is specified in DVIEW (page 389). If there are several cameras, the value is the last back clipping plane that you set current. The distance of the back clipping plane from the camera point can be found by subtracting BACKZ from the camera-to-target distance.

See also:

Create a 3D Dynamic View (DVIEW)

BINDTYPE

Controls how xref names are handled when binding xrefs or editing xrefs in place.

Type: Integer
Saved in: Not-saved
Initial value: 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Traditional binding behavior (&quot;xref1</td>
</tr>
<tr>
<td>1</td>
<td>Insert-like behavior (&quot;xref1</td>
</tr>
</tbody>
</table>

See also:

Archive Drawings That Contain Referenced Drawings (Bind)
BLIPMODE

Controls whether marker blips are visible.

**Type:** Integer

**Saved in:** Registry

**Initial value:** 0

Obsolete

Marker blips have been removed from the product.

This system variable has the same name as the BLIPMODE command. Use the SETVAR (page 955) command to access this system variable.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Turns off marker blips</td>
</tr>
<tr>
<td>1</td>
<td>Turns on marker blips</td>
</tr>
</tbody>
</table>

See also:
Erase Objects

BLOCKEDITLOCK

Disallows opening of the Block Editor and editing of block definitions.

**Type:** Integer

**Saved in:** Registry

**Initial value:** 0

When BLOCKEDITLOCK is set to 1, double-clicking a block in a drawing opens the Properties Inspector. If the block contains attributes, double-clicking the block opens the Enhanced Attribute Editor.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Specifies that the Block Editor can be opened</td>
</tr>
<tr>
<td>1</td>
<td>Specifies that the Block Editor cannot be opened</td>
</tr>
</tbody>
</table>

See also:
Create and Modify Blocks
**BLOCKEDITOR**

Indicates whether or not the Block Editor is open.

(Read-only)

**Type:** Integer  
**Saved in:** Not-saved  
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Indicates that the Block Editor is not open</td>
</tr>
<tr>
<td>1</td>
<td>Indicates that the Block Editor is open</td>
</tr>
</tbody>
</table>

**See also:**
- Create and Modify Blocks

**BTMARKDISPLAY**

Controls whether or not value set markers are displayed for dynamic block references.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Specifies that value set markers are not displayed</td>
</tr>
<tr>
<td>1</td>
<td>Specifies that value set markers are displayed</td>
</tr>
</tbody>
</table>
See also:

C System Variables

CACHEMAXFILES

Sets the maximum number of graphics cache files saved in the GraphicsCache folder for the product.

Type: Integer  
Saved in: Registry  
Initial value: 256

The valid range is from 0 to 65535 files.

When the number of graphics cache files reaches the maximum, the oldest files in the cache are automatically deleted. Setting this variable to 0 disables caching entirely and deletes any existing files in the GraphicsCache folder that are not in use by an open drawing file.

See also:

Memory Tuning

CACHEMAXTOTALSIZE

Sets the maximum total size of all graphics cache files saved in the GraphicsCache folder for the product.

Type: Integer  
Saved in: Registry  
Initial value: 1024

The valid range is from 0 to 65535 megabytes.

When the total size of the graphics cache files reaches the maximum, the oldest files in the cache are automatically deleted. Setting this variable to 0 disables caching entirely and deletes any existing files in the GraphicsCache folder that are not in use by an open drawing file.

See also:

Memory Tuning
CAMERADISPLAY

Turns the display of camera objects on or off.

**Type:** Integer

**Saved in:** Drawing

**Initial value:** 0

Camera objects can only be created with the Windows releases of AutoCAD.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Camera glyphs are not displayed</td>
</tr>
<tr>
<td>1</td>
<td>Camera glyphs are displayed</td>
</tr>
</tbody>
</table>

**See also:**

Specify 3D Views

CANNOSCALE

Sets the name of the current annotation scale for the current space.

**Type:** String

**Saved in:** Drawing

**Initial value:** 1:1

You can only enter a named scale that exists in the drawing’s named scale list.

**See also:**

Set Annotation Scale

CANNOSCALEVALUE

Returns the value of the current annotation scale.

(Read-only)

**Type:** Real

**Saved in:** Drawing

**Initial value:** 1.0000
See also:
Set Annotation Scale

**CCONSTRAINTFORM**

Controls whether annotational or dynamic constraints are applied to objects.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Dynamic</td>
</tr>
<tr>
<td>1</td>
<td>Annotational</td>
</tr>
</tbody>
</table>

When this system variable is set to 0, dynamic constraints are created, by default, when you use the DIMCONSTRAINT (page 289) command.

See also:
Apply Dimensional Constraints

**CDATE**

Stores the current date and time in decimal format.

(Read-only)  
**Type:** Real  
**Saved in:** Not-saved  
**Initial value:** Varies

The date and time displays in a decimal format starting with the year. After the decimal point, CDATE displays the time using a 24-hour clock. For example, the ninth day of February in the year 2006 at 3:05 pm displays as 20060209.150500.

See also:
Obtain General Drawing Information
CECOLOR

Sets the color of new objects.

**Type:** String  
**Saved in:** Drawing  
**Initial value:** BYLAYER

Valid values include the following:
- BYLAYER or BYBLOCK
- AutoCAD Color Index (ACI): integer values from 1 to 255, or a color name from the first seven colors
- True Colors: RGB or HSL values from 000 to 255 in the form "RGB:130,200,240"
- Color Books: Text from standard PANTONE or custom color books, the DIC color guide, or RAL color sets, for example "DIC COLOR GUIDE(R)$DIC 43"

**See also:**
- Change the Color of an Object

CELTSCALE

Sets the current object linetype scaling factor.

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** 1.0000

Sets the linetype scaling for new objects relative to the LTSCALE (page 596) command setting. A line created with CELTSCALE = 2 in a drawing with LTSCALE set to 0.5 would appear the same as a line created with CELTSCALE = 1 in a drawing with LTSCALE = 1.

**See also:**
- Control Linetype Scale
**CELTYPE**

Sets the linetype of new objects.

**Type:** String  
**Saved in:** Drawing  
**Initial value:** BYLAYER

**See also:**  
Set the Current Linetype

**CELWEIGHT**

Sets the lineweight of new objects.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** -1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-1</td>
<td>Sets the lineweight to &quot;BYLAYER.&quot;</td>
</tr>
<tr>
<td>-2</td>
<td>Sets the lineweight to &quot;BYBLOCK.&quot;</td>
</tr>
<tr>
<td>-3</td>
<td>Sets the lineweight to &quot;DEFAULT.&quot; &quot;DEFAULT&quot; is controlled by the LWDEFAULT (page 1404) system variable.</td>
</tr>
</tbody>
</table>

Other valid values entered in hundredths of millimeters include 0, 5, 9, 13, 15, 18, 20, 25, 30, 35, 40, 50, 53, 60, 70, 80, 90, 100, 106, 120, 140, 158, 200, and 211.

All values must be entered in hundredths of millimeters. (Multiply a value by 2540 to convert values from inches to hundredths of millimeters.)

**See also:**  
Set the Current Lineweight

**CENTERMT**

Controls how grips stretch multiline text that is centered horizontally.
**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 0

CENTERMT does not apply to stretching multiline text by using the ruler in the In-Place Text Editor.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>When you move a corner grip in centered multiline text, the center grip moves in the same direction, and the grip on the opposite side remains in place.</td>
</tr>
<tr>
<td>1</td>
<td>When you move a corner grip in centered multiline text, the center grip stays in place, and both sets of side grips move in the direction of the stretch.</td>
</tr>
</tbody>
</table>

See also:  
Change Multiline Text

---

**CETRANSAPRENCY**

Sets the transparency level for new objects.

**Type:** String  
**Saved in:** Drawing  
**Initial value:** ByLayer

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ByLayer</td>
<td>Transparency value determined by layer</td>
</tr>
<tr>
<td>ByBlock</td>
<td>Transparency value determined by block</td>
</tr>
<tr>
<td>0</td>
<td>Fully opaque (not transparent)</td>
</tr>
<tr>
<td>1-90</td>
<td>Transparency value defined as a percentage</td>
</tr>
</tbody>
</table>

To change the transparency of existing objects, use the Properties Inspector or Layers palette.

**NOTE** Transparency is limited to 90 percent to avoid confusion with layers that are turned off or frozen.
The transparency level for new hatch objects is controlled by the HPTRANSPARENCY system variable.

See also:
Display and Change the Properties of Objects

CHAMFERA

Sets the first chamfer distance when CHAMMODE is set to 0.

Type: Real
Saved in: Drawing
Initial value: 0.0000

See also:
Create Chamfers

CHAMFERB

Sets the second chamfer distance when CHAMMODE is set to 0.

Type: Real
Saved in: Drawing
Initial value: 0.0000

See also:
Create Chamfers

CHAMFERC

Sets the chamfer length when CHAMMODE is set to 1.

Type: Real
Saved in: Drawing
Initial value: 0.0000

See also:
Create Chamfers
**CHAMFERD**

Sets the chamfer angle when CHAMMODE is set to 1.

*Type:* Real  
*Saved in:* Drawing  
*Initial value:* 0.0000

*See also:*
Create Chamfers

**CHAMMODE**

Sets the input method for CHAMFER.

*Type:* Integer  
*Saved in:* Not-saved  
*Initial value:* 0

<table>
<thead>
<tr>
<th>0</th>
<th>Requires two chamfer distances</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Requires a chamfer length and an angle</td>
</tr>
</tbody>
</table>

*See also:*
Create Chamfers

**CIRCLERAD**

Sets the default circle radius.

*Type:* Real  
*Saved in:* Not-saved  
*Initial value:* 0.0000

A zero indicates no default.

*See also:*
Draw Circles
CLASSICKEYS

Sets the behavior of the AutoCAD shortcut keys.

**Type:** Switch  
**Saved in:** Registry  
**Initial value:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>To copy, press Cmd-C</td>
</tr>
<tr>
<td>1</td>
<td>To cancel, press Cmd-C</td>
</tr>
</tbody>
</table>

See also:
- Set Interface Options

CLAYER

Sets the current layer.

**Type:** String  
**Saved in:** Drawing  
**Initial value:**

See also:
- Change Layer Settings and Layer Properties

CLEANSCREENSTATE

Indicates whether the clean screen state is on or off.  
(Read-only)

**Type:** Integer  
**Saved in:** Not-saved  
**Initial value:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off</td>
</tr>
<tr>
<td>1</td>
<td>On</td>
</tr>
</tbody>
</table>
See also:

**CLISTATE**

Indicates whether the Command Line is open or closed.

(Read-only)

**Type:** Integer  
**Saved in:** Not-saved  
**Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Closed</td>
</tr>
<tr>
<td>1</td>
<td>Open</td>
</tr>
</tbody>
</table>

See also:

**CMATERIAL**

Sets the material of new objects.

**Type:** String  
**Saved in:** Drawing  
**Initial value:** BYLAYER

Valid values are BYLAYER, BYBLOCK, and the name of a material in the drawing.

See also:  
Browse Material Library

**CMDACTIVE**

Indicates whether an ordinary command, transparent command, script, or dialog box is active.

(Read-only)

**Type:** Integer  
**Saved in:** Not-saved
Initial value: Varies

The setting is stored as a bitcode using the sum of the following values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No active command</td>
</tr>
<tr>
<td>1</td>
<td>Ordinary command is active</td>
</tr>
<tr>
<td>2</td>
<td>Transparent command is active</td>
</tr>
<tr>
<td>4</td>
<td>Script is active</td>
</tr>
<tr>
<td>8</td>
<td>Dialog box is active</td>
</tr>
<tr>
<td>16</td>
<td>Not used</td>
</tr>
<tr>
<td>32</td>
<td>AutoLISP is active (only visible to an ObjectARX-defined command)</td>
</tr>
<tr>
<td>64</td>
<td>ObjectARX command is active</td>
</tr>
</tbody>
</table>

See also:

Enter Commands on the Command Line

CMDDIA

Controls the display of the In-Place Text Editor for the LEADER and QLEADER commands.

Type: Integer
Saved in: Registry
Initial value:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off</td>
</tr>
<tr>
<td>1</td>
<td>On</td>
</tr>
</tbody>
</table>
See also:
Create and Modify Leaders

CMDECHO

Controls whether prompts and input are echoed during the AutoLISP command function.

Type: Integer
Saved in: Not-saved
Initial value: 1

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Turns off echoing</td>
</tr>
<tr>
<td>1</td>
<td>Turns on echoing</td>
</tr>
</tbody>
</table>

See also:
AutoLISP

CMDINPUTHISTORYMAX

Sets the maximum number of previous input values that are stored for a prompt in a command.

Type: Integer
Saved in: Registry
Initial value: 20

Display of the history of user input is controlled by the INPATHISTORYMODE (page 1372) system variable.

See also:

CMDNAMES

Displays the names of the active and transparent commands.

(Read-only)
Type: String
\textbf{Saved in:} Not-saved
\textbf{Initial value:}"

For example, LINE’ZOOM indicates that the ZOOM command is being used transparently during the LINE command.

This variable is designed for use with programming interfaces such as AutoLISP and DIESEL.

The following is an example that demonstrates how to use DIESEL to determine the current state of a system variable from a menu macro.

```
$M=$(if,$(and,$(getvar,CleanScreenState),1),^C^C_CleanScreenOFF,^C^C_CleanScreenON)
```

For additional information, see “Introduction to Programming Interfaces” in the \textit{Customization Guide}.

\textbf{See also:}

Enter Commands on the Command Line

\section*{CMLEADERSTYLE}

Sets the name of the current multileader style.

\textbf{Type:} String
\textbf{Saved in:} Drawing
\textbf{Initial value:} Standard

\textbf{See also:}

Work with Leader Styles

\section*{CMLJUST}

Specifies multiline justification.

\textbf{Type:} Integer
\textbf{Saved in:} Drawing
\textbf{Initial value:} 0

\begin{tabular}{|l|l|}
\hline
0 & Top \\
\hline
1 & Zero (Middle) \\
\hline
\end{tabular}
CMLSCALE

Controls the overall width of a multiline.

Type: Real
Saved in: Drawing
Initial value: 1.0000 (imperial) or 20.0000 (metric)

A scale factor of 2.0 produces a multiline twice as wide as the style definition. A zero scale factor collapses the multiline into a single line. A negative scale factor flips the order of the offset lines (that is, the smallest or most negative is placed on top when the multiline is drawn from left to right).

See also:

Modify Multilines

CMLSTYLE

Sets the multiline style that governs the appearance of the multiline.

Type: String
Saved in: Drawing
Initial value: Standard

See also:

Modify Multilines

COLORSCHEME

Stores the current color scheme used by the program.

Type: Integer
Saved in: Registry
**Initial value:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Dark</td>
</tr>
<tr>
<td>1</td>
<td>Light</td>
</tr>
</tbody>
</table>

**See also:**

Interface Themes and Background Color

**COMPASS**

Controls whether the 3D compass is on or off in the current viewport.

**Type:** Integer  

**Saved in:** Not-saved  

**Initial value:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Turns off the 3D compass</td>
</tr>
<tr>
<td>1</td>
<td>Turns on the 3D compass</td>
</tr>
</tbody>
</table>

**See also:**

Use 3D Navigation Tools

**CONSTRAINTBARDISPLAY**

Controls the display of constraint bars after you apply constraints and when you select geometrically constrained drawings.

**Type:** Bitcode  

**Saved in:** Registry  

**Initial value:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Does not display constraint bars for selected objects after applying geometric constraints</td>
</tr>
</tbody>
</table>
**NOTE** Constraint bars will always be displayed when CONSTRAINTBAR = Showall, even if you set the value of the CONSTRAINTBARDISPLAY system variable to 0.

<table>
<thead>
<tr>
<th>Bit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Displays constraint bars for selected objects after applying constraints</td>
</tr>
<tr>
<td>2</td>
<td>Temporarily displays constraint bars for the selected geometrically constrained objects</td>
</tr>
<tr>
<td>3</td>
<td>Bits 1 and 2 are both turned on</td>
</tr>
</tbody>
</table>

See also:
- Apply or Remove Geometric Constraints

**CONSTRAINTBARMODE**

Controls the display of geometrical constraints on constraint bars.

<table>
<thead>
<tr>
<th>Type</th>
<th>Saved in</th>
<th>Initial value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bitcode</td>
<td>Registry</td>
<td>4095</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Bit</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>4096</td>
<td>Horizontal</td>
</tr>
<tr>
<td>2</td>
<td>4097</td>
<td>Vertical</td>
</tr>
<tr>
<td>4</td>
<td>4098</td>
<td>Perpendicular</td>
</tr>
<tr>
<td>8</td>
<td>4099</td>
<td>Parallel</td>
</tr>
<tr>
<td>16</td>
<td>4100</td>
<td>Tangent</td>
</tr>
<tr>
<td>32</td>
<td>4101</td>
<td>Smooth</td>
</tr>
<tr>
<td>64</td>
<td>4102</td>
<td>Coincident</td>
</tr>
</tbody>
</table>
For example, set CONSTRAINTBARMODE to 12 (8+4) to display parallel and perpendicular constraints on the constraint bars.
Set CONSTRAINTBARMODE to 4095 to display constraint bars for all constraint types.

See also:

Apply or Remove Geometric Constraints

CONSTRAINTINFER

Controls whether the geometric constraints are inferred while drawing and editing geometry.

Type: Bitcode
Saved in: Registry
Initial value: 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Geometric constraints are not inferred</td>
</tr>
<tr>
<td>1</td>
<td>Geometric constraints are inferred</td>
</tr>
</tbody>
</table>

See also:

Infer Geometric Constraints
**CONSTRAINTNAMEFORMAT**

Controls the text format for dimensional constraints.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 2

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Name (for example, Width)</td>
</tr>
<tr>
<td>1</td>
<td>Value (for example, 4.0000)</td>
</tr>
<tr>
<td>2</td>
<td>Expression (for example, width = 4.0000)</td>
</tr>
</tbody>
</table>

**NOTE** The CONSTRAINTNAMEFORMAT system variable is also applicable to the block constraint parameters in the Block Editor.

See also:  
Apply Dimensional Constraints

**CONSTRAINTRELAX**

Indicates whether constraints are enforced or relaxed when editing an object.  
(Read-only)

**Type:** Integer  
**Saved in:** Not-saved  
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Maintains constraints</td>
</tr>
<tr>
<td>1</td>
<td>Relaxes constraints</td>
</tr>
</tbody>
</table>

See also:  
Modify Objects with Geometric Constraints Applied
**CONSTRAINTSOLVEMODE**

Controls constraint behavior when applying or editing constraints.

- **Type:** Bitcode
- **Saved in:** Registry
- **Initial value:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Does not retain the size of the geometry when a constraint is applied or modified</td>
</tr>
<tr>
<td>1</td>
<td>Retains the size of the geometry when a constraint is applied or modified</td>
</tr>
</tbody>
</table>

When the CONSTRAINTSOLVEMODE is set to 0, resizing a constrained line may result in unpredictable behavior.

See also:
- Modify Objects with Geometric Constraints Applied

**CONTENTSTATE**

Indicates whether the Content palette is open or closed.

(Read-only)

- **Type:** Integer
- **Saved in:** Not-saved
- **Initial value:** Varies

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Closed</td>
</tr>
<tr>
<td>1</td>
<td>Open</td>
</tr>
</tbody>
</table>

See also:
- The Content Palette
COPYMODE

Controls whether the COPY command repeats automatically.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Sets the COPY command to repeat automatically</td>
</tr>
<tr>
<td>1</td>
<td>Sets the COPY command to create a single copy</td>
</tr>
</tbody>
</table>

See also:  
Copy Objects

CLOTSTYLE

Controls the current plot style for new objects.

**Type:** String  
**Saved in:** Drawing  
**Initial value:** ByColor

If the current drawing you are working in is in color-dependent mode, CPLOTSTYLE is read-only and has a value of BYCOLOR. If the current drawing is in named plot styles mode, CPLOTSTYLE can be set to the following values (BYLAYER is the default):

"BYLAYER"  
"BYBLOCK"  
"NORMAL"  
"USER DEFINED"

See also:  
Overview of Plot Styles
**CPROFILE**

Displays the name of the current profile.

(Read-only)

**Type:** String  
**Saved in:** Registry  
**Initial value:** <<Unnamed Profile>>

**See also:**  
Set Interface Options

**CROSSINGAREACOLOR**

Controls the color of the selection area during crossing selection.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 100

The valid range is 1 to 255. The SELECTIONAREA (page 1466) system variable must be on.

**See also:**  
Customize Object Selection

**CSHADOW**

Sets the shadow display property for a 3D object.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0

To be visible, shadows must be turned on in the visual style that is applied to the viewport.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Casts and receives shadows</td>
</tr>
<tr>
<td>1</td>
<td>Casts shadows</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>2</td>
<td>Receives shadows</td>
</tr>
<tr>
<td>3</td>
<td>Ignores shadows</td>
</tr>
</tbody>
</table>

See also:
Display Backgrounds and Shadows

**CTAB**

Returns the name of the current layout in the drawing.

**Type:** String  
**Saved in:** Drawing  
**Initial value:** Model

Provides a means for the user to determine which layout is active.

See also:  
Set Model Space Viewports

**CTABLESTYLE**

Sets the name of the current table style.

**Type:** String  
**Saved in:** Drawing  
**Initial value:** Standard

See also:  
Work with Table Styles

**CULLINGOBJ**

Controls whether 3D subobjects that are hidden from view can be highlighted or selected.

**Type:** Integer
### Saved in:
Registry

### Initial value:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
</table>
| 0     | No subobject culling  
  - Rolling over 3D objects highlights all 3D subobjects, including hidden subobjects.  
  - Selecting 3D objects by dragging selects all 3D subobjects, including hidden subobjects. |
| 1     | Apply subobject culling  
  - Rolling over 3D objects highlights only the subobjects that are normal in the current view.  
  - Selecting 3D objects by dragging selects only the subobjects that are normal in the current view. |

See also:
Cycle Through and Filter Subobjects

### CULLINGOBJSELECTION

Controls whether 3D objects that are hidden from view can be highlighted or selected.

**Type:** Integer

**Saved in:** Registry

**Initial value:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
</table>
| 0     | No object culling  
  - Rolling over 3D objects highlights all 3D objects, including hidden objects.  
  - Selecting 3D objects by dragging selects all 3D objects, including hidden objects. |
| 1     | Apply object culling  
  - Rolling over 3D objects highlights only the objects that are normal in the current view. |
Selecting 3D objects by dragging selects only the objects that are normal in the current view.

See also:

Cycle Through and Filter Subobjects

CURSORTSIZE

Determines the size of the crosshairs as a percentage of the screen size.

Type: Integer
Saved in: Registry
Initial value: 5

Valid settings range from 1 to 100 percent. When set to 100, the crosshairs are full-screen and the ends of the crosshairs are never visible. When less than 100, the ends of the crosshairs may be visible when the cursor is moved to one edge of the screen.

See also:

Set Up the Drawing Area

CVPORT

Displays the identification number of the current viewport.

Type: Integer
Saved in: Drawing
Initial value: 2

You can change this value, which changes the current viewport, if the following conditions are met:

- The identification number you specify is that of an active viewport.
- A command in progress has not locked cursor movement to that viewport.
- Tablet mode is off.

See also:

Select and Use the Current Viewport
D System Variables

DATE

Stores the current date and time in Modified Julian Date format.

(Read-only)

**Type:** Real

**Saved in:** Not-saved

**Initial value:** Varies

This value is represented as a Modified Julian Date (MJD), which is the Julian day number and decimal fraction of a day in the format:

\(<\text{Julian day number}.<\text{Decimal fraction of a day}>\>

The Modified Julian Date, conventionally called UT1, is a worldwide scientific standard that assigns day numbers beginning at an essentially arbitrary date and time of 12:00 a.m. on 1 January 4713 B.C. (B.C.E.). With this system, 4 July 1997 at 2:29:58 p.m. corresponds to 2450634.60387736, and 1 January 1998 at 12:00 noon corresponds to 2450815.50000000.

You can compute differences in date and time by subtracting the numbers returned by DATE. To extract the seconds since midnight from the value returned by DATE, use AutoLISP expressions:

```
(setq s (getvar "DATE"))
(setq seconds (* 86400.0 (- s (fix s))))
```

Because your computer clock provides the date and time, the DATE system variable returns a true Julian date only if the system clock is set to UTC/Zulu (Greenwich Mean Time). **TDCREATE** (page 1504) and **TDUPDATE** (page 1505) have the same format as DATE, but their values represent the creation time and last update time of the current drawing.

**See also:**

Obtain General Drawing Information

DBLCLKEDIT

Controls the double click editing behavior in the drawing area.
**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 1

The system variable can accept the values of On and Off in place of 1 and 0.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Disabled</td>
</tr>
<tr>
<td>1</td>
<td>Enabled</td>
</tr>
</tbody>
</table>

**See also:**  
Modify Objects

---

**DBMOD**

Indicates the drawing modification status.  
(Read-only)  
**Type:** Integer  
**Saved in:** Not-saved  
**Initial value:** 0

The setting is stored as a bitcode using the sum of the following values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Object database modified</td>
</tr>
<tr>
<td>4</td>
<td>Database variable modified</td>
</tr>
<tr>
<td>8</td>
<td>Window modified</td>
</tr>
<tr>
<td>16</td>
<td>View modified</td>
</tr>
<tr>
<td>32</td>
<td>Field modified</td>
</tr>
</tbody>
</table>

The DBMOD value is reset to 0 when you save the drawing.

**See also:**  
Save a Drawing
DEFAULTGIZMO

Sets the 3D Move, 3D Rotate, or 3D Scale gizmo as the default during subobject selection.

**Type:** Integer

**Saved in:** Not-saved

**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>The 3D Move gizmo is displayed by default when an object is selected in a 3D visual style.</td>
</tr>
<tr>
<td>1</td>
<td>The 3D Rotate gizmo is displayed by default when an object is selected in a 3D visual style.</td>
</tr>
<tr>
<td>2</td>
<td>The 3D Scale gizmo is displayed by default when an object is selected in a 3D visual style.</td>
</tr>
<tr>
<td>3</td>
<td>No gizmo is displayed by default when an object is selected in a 3D visual style.</td>
</tr>
</tbody>
</table>

Set this variable to display the gizmo you use most often by default.

With the 3D Move gizmo, you can restrict the movement of selected objects along an X, Y, or Z axis, or within a specified plane. To specify the movement limitations, hover the cursor over the gizmo until the axis or plane is highlighted.

With the 3D Rotate gizmo, you can restrict the rotation of selected objects about an X, Y, or Z axis. To specify the rotation axis, hover the cursor over the gizmo until the axis line is displayed in red and the revolution path is highlighted in yellow.
With the 3D Scale gizmo, you can resize selected objects uniformly, resize them along an X, Y, or Z axis, or resize them along a specified plane. To specify the scale limitations, hover the cursor over the gizmo. Highlight the solid area between the axes for uniform resizing. Highlight the double lines between the axes to specify resizing along a plane. Highlight an axis to specify resizing along an axis.

No gizmo is displayed by default when an object is selected in a 3D visual style.
Use the Gizmos

DEFAULTLIGHTING

Turns on and off default lighting in place of other lighting.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 1

Default lighting is provided by a set of distant lights that follow the view direction. When default lighting is on, the sun and other lights do not cast light, even if they are turned on. The setting of this system variable is viewport-specific.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Default lighting is automatically turned off when point lights, spotlight, distant lights, or the sun are on</td>
</tr>
<tr>
<td>1</td>
<td>Default lighting only is turned on</td>
</tr>
</tbody>
</table>

See also:  
Overview of Lighting

DEFAULTLIGHTINGTYPE

Specifies the type of default lighting, old or new.
**DEFPLSTYLE**

Specifies the default plot style for all layers in a drawing when opening a drawing that was created in a release prior to AutoCAD 2000, or for Layer 0 when creating a new drawing from scratch without using a drawing template.

**Type:** String

**Saved in:** Registry

**Initial value:** ByColor

When the drawing is opened and `PSTYLEPOLICY` (page 1451) is set to 1 (color-dependent plot style mode), `DEFPLSTYLE` is read-only and has a value of “BYCOLOR.” If `PSTYLEPOLICY` is set to 0 (named plot style mode) when the drawing is opened, `DEFPLSTYLE` is writable and has a default value of “NORMAL.”

**See also:**

Overview of Plot Styles

---

**DEFPLSTYLE**

Specifies the default plot style for new objects in a drawing when opening a drawing that was created in a release prior to AutoCAD 2000, or when creating a new drawing from scratch without using a drawing template.
**String**
**Saved in:** Registry
**Initial value:** ByColor

When the drawing is opened and PSTYLEPOLICY (page 1451) is set to 1 (color-dependent plot style mode), DEFPLSTYLE is read-only and has a value of “BYCOLOR.” If PSTYLEPOLICY is set to 0 (named plot style mode), DEFPLSTYLE is writable and has a default value of “BYLAYER.”

**See also:**
Overview of Plot Styles

---

**DELOBJ**

Controls whether geometry used to create other objects is retained or deleted.

**Type:** Integer
**Saved in:** Registry
**Initial value:** 3

If you use a product that supports creation of 3D models based on existing geometry, use this system variable to control whether the original geometry is retained or removed.

If the SURFACEASSOCIATIVITY (page 1498) system variable is set to 1, the DELOBJ setting is ignored.

<table>
<thead>
<tr>
<th></th>
<th>All defining geometry is retained.</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Deletes profile curves, including those used with the EXTRUDE (page 427), SWEEP (page 1062), REVOLVE (page 913), and LOFT (page 585) commands. Removes all defining geometry for CONVTOSOLID (page 229), CONVTSURFACE (page 232), CONVTONURBS (page 229), and CONVTOMESH (page 227) commands. Cross sections used with the LOFT command are also deleted.</td>
</tr>
<tr>
<td>2</td>
<td>Deletes all defining geometry, including paths and guide curves used with the SWEEP and LOFT commands.</td>
</tr>
<tr>
<td>3</td>
<td>Deletes all defining geometry, including paths and guide curves used with the SWEEP and LOFT commands if the action results in a solid object. Removes all defining geometry for CONVTOSOLID,</td>
</tr>
</tbody>
</table>
CONVTOSURFACE, CONVTONURBS, and CONVTOMESH commands.
This setting also applies to options in commands such as REGION, SPLINE, and ARRAY. The range of non-zero values is present to maintain AutoCAD compatibility.

-1 Displays prompts to delete profile curves, including those used with the EXTRUDE, SWEEP, REVOLVE, and LOFT commands. Prompts to remove cross sections used with the LOFT command. The original geometry for CONVTOSOLID, CONVTOSURFACE, and CONVTOMESH commands is removed without prompting.

-2 Displays prompts to delete all defining geometry, including paths and guide curves used with the SWEEP and LOFT commands. The original geometry for CONVTOSOLID, CONVTOSURFACE, and CONVTOMESH commands is removed without prompting.

-3 Displays prompts to delete all defining geometry if the resulting entities are a surface of any type. Deletes all original geometry resulting in a solid entity, original geometry for CONVTOSOLID, CONVTOSURFACE, CONVTONURBS, and CONVTOMESH commands is removed without prompting.

See also:
Create and Combine Areas (Regions)
Create Solids and Surfaces from Lines and Curves

**DEMANDLOAD**

Specifies if and when to demand-load certain applications.

- **Type:** Integer
- **Saved in:** Registry
- **Initial value:** 3

If you set this system variable to 0, third-party applications and some AutoCAD commands cannot function.

0 | Turns off demand-loading.
Demand-loads the source application when you open a drawing that contains custom objects. This setting does not demand-load the application when you invoke one of the application's commands.

Demand-loads the source application when you invoke one of the application's commands. This setting does not demand-load the application when you open a drawing that contains custom objects.

Demand-loads the source application when you open a drawing that contains custom objects or when you invoke one of the application's commands.

See also:
Overview of Demand Loading

**DIASTAT**

Stores the exit method of the most recently used dialog box.

(Read-only)

**Type:** Integer  
**Saved in:** Not-saved  
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Cancel</td>
</tr>
<tr>
<td>1</td>
<td>OK</td>
</tr>
</tbody>
</table>

**NOTE** The DIASTAT system variable does not apply to standard file selection dialog boxes, such as the Select File and the Save Drawing As dialog boxes.

See also:
Switch Between Dialog Boxes and the Command Line
**DIMADEC**

Controls the number of precision places displayed in angular dimensions.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0

- **-1**  
  Angular dimensions display the number of decimal places specified by DIMDEC (page 1267).

- **0-8**  
  Specifies the number of decimal places displayed in angular dimensions (independent of DIMDEC)

**See also:**  
Create Angular Dimensions

**DIMALT**

Controls the display of alternate units in dimensions.

**Type:** Switch  
**Saved in:** Drawing  
**Initial value:** Off

See also DIMALT (page 1254), DIMALTF (page 1255), DIMALTLD (page 1256), DIMALTTZ (page 1256), DIMALTZ (page 1257), and DIMAPOST (page 1259).

- **Off**  
  Disables alternate units

- **On**  
  Enables alternate units

**See also:**  
Control the Display of Dimension Units

**DIMALTD**

Controls the number of decimal places in alternate units.
**DIMALT**

Controls the multiplier for alternate units.

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** 25.4000 (imperial) or 0.0394 (metric)

If DIMALT is turned on, DIMALTF multiplies linear dimensions by a factor to produce a value in an alternate system of measurement. The initial value represents the number of millimeters in an inch.

**See also:**  
Control the Display of Dimension Units

**DIMALTRND**

Rounds off the alternate dimension units.

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** 0.0000

**See also:**  
Control the Display of Dimension Units
**DIMALTTD**

Sets the number of decimal places for the tolerance values in the alternate units of a dimension.

*Type:* Integer  
*Saved in:* Drawing  
*Initial value:* 2 (imperial) or 3 (metric)

*See also:*

Control the Display of Dimension Units

**DIMALTTZ**

Controls suppression of zeros in tolerance values.

*Type:* Integer  
*Saved in:* Drawing  
*Initial value:* 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Suppresses zero feet and precisely zero inches</td>
</tr>
<tr>
<td>1</td>
<td>Includes zero feet and precisely zero inches</td>
</tr>
<tr>
<td>2</td>
<td>Includes zero feet and suppresses zero inches</td>
</tr>
<tr>
<td>3</td>
<td>Includes zero inches and suppresses zero feet</td>
</tr>
</tbody>
</table>

To suppress leading or trailing zeros, add the following values to one of the preceding values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Suppresses leading zeros</td>
</tr>
<tr>
<td>8</td>
<td>Suppresses trailing zeros</td>
</tr>
</tbody>
</table>

*See also:*

Control the Display of Dimension Units
**DIMALTU**

Sets the units format for alternate units of all dimension substyles except Angular.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 2

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Scientific</td>
</tr>
<tr>
<td>2</td>
<td>Decimal</td>
</tr>
<tr>
<td>3</td>
<td>Engineering</td>
</tr>
<tr>
<td>4</td>
<td>Architectural (stacked)</td>
</tr>
<tr>
<td>5</td>
<td>Fractional (stacked)</td>
</tr>
<tr>
<td>6</td>
<td>Architectural</td>
</tr>
<tr>
<td>7</td>
<td>Fractional</td>
</tr>
<tr>
<td>8</td>
<td>System Format</td>
</tr>
</tbody>
</table>

**See also:**  
Control the Display of Dimension Units

**DIMALTZ**

Controls the suppression of zeros for alternate unit dimension values.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0
DIMALTZ values 0-3 affect feet-and-inch dimensions only.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Suppresses zero feet and precisely zero inches</td>
</tr>
<tr>
<td>1</td>
<td>Includes zero feet and precisely zero inches</td>
</tr>
<tr>
<td>2</td>
<td>Includes zero feet and suppresses zero inches</td>
</tr>
<tr>
<td>3</td>
<td>Includes zero inches and suppresses zero feet</td>
</tr>
<tr>
<td>4</td>
<td>Suppresses leading zeros in decimal dimensions (for example, 0.5000 becomes .5000)</td>
</tr>
<tr>
<td>8</td>
<td>Suppresses trailing zeros in decimal dimensions (for example, 12.5000 becomes 12.5)</td>
</tr>
<tr>
<td>12</td>
<td>Suppresses both leading and trailing zeros (for example, 0.5000 becomes .5)</td>
</tr>
</tbody>
</table>

See also:
Control the Display of Dimension Units

**DIMANNO**

Indicates whether or not the current dimension style is annotative.

(Read-only)

**Type:** Integer

**Saved in:** Drawing

**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Nonannotative</td>
</tr>
<tr>
<td>1</td>
<td>Annotative</td>
</tr>
</tbody>
</table>

See also:
Create Annotative Dimensions and Tolerances
**DIMAPPOST**

Specifies a text prefix or suffix (or both) to the alternate dimension measurement for all types of dimensions except angular.

**Type:** String  
**Saved in:** Drawing  
**Initial value:**"

For instance, if the current units are Architectural, `DIMALT` (page 1254) is on, `DIMALTF` (page 1255) is 25.4 (the number of millimeters per inch), `DIMALTD` (page 1254) is 2, and `DIMAPPOST` is set to "mm", a distance of 10 units would be displayed as 10"[254.00mm].

To turn off an established prefix or suffix (or both), set it to a single period (.).

See also:  
Control the Display of Dimension Units

**DIMARCSYM**

Controls display of the arc symbol in an arc length dimension.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:**0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Places arc length symbols before the dimension text</td>
</tr>
<tr>
<td>1</td>
<td>Places arc length symbols above the dimension text</td>
</tr>
<tr>
<td>2</td>
<td>Suppresses the display of arc length symbols</td>
</tr>
</tbody>
</table>

See also:  
Create Arc Length Dimensions
DIMASSOC

Controls the associativity of dimension objects and whether dimensions are exploded.

**Type:** Integer
**Saved in:** Drawing
**Initial value:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Creates exploded dimensions. There is no association between the various elements of the dimension. The lines, arcs, arrowheads, and text of a dimension are drawn as separate objects.</td>
</tr>
<tr>
<td>1</td>
<td>Creates non-associative dimension objects. The elements of the dimension are formed into a single object. If one of the definition points of the dimension moves, the dimension is updated.</td>
</tr>
<tr>
<td>2</td>
<td>Creates associative dimension objects. The elements of the dimension are formed into a single object, and one or more definition points of the dimension are coupled with association points on geometric objects. If the association point on the geometric object moves, the dimension location, orientation, and value are updated.</td>
</tr>
</tbody>
</table>

DIMASSOC is not stored in a dimension style.

Drawings saved in a format previous to AutoCAD 2002 retain the setting of the DIMASSOC system variable. When the drawing is reopened in AutoCAD 2002 or later, the dimension associativity setting is restored.

**See also:**

Associative Dimensions

DIMASZ

Controls the size of dimension line and leader line arrowheads. Also controls the size of hook lines.

**Type:** Real
**Saved in:** Drawing
**Initial value:** 0.1800 (imperial) or 2.5000 (metric)
Multiples of the arrowhead size determine whether dimension lines and text should fit between the extension lines. DIMASZ is also used to scale arrowhead blocks if set by DIMBLK (page 1263). DIMASZ has no effect when DIMTSZ (page 1288) is other than zero.

See also:
Customize Arrowheads

**DIMATFIT**

Determines how dimension text and arrows are arranged when space is not sufficient to place both within the extension lines.

**Type:** Integer

**Saved in:** Drawing

**Initial value:** 3

<table>
<thead>
<tr>
<th></th>
<th>Places both text and arrows outside extension lines</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Moves arrows first, then text</td>
</tr>
<tr>
<td>2</td>
<td>Moves text first, then arrows</td>
</tr>
<tr>
<td>3</td>
<td>Moves either text or arrows, whichever fits best</td>
</tr>
</tbody>
</table>

A leader is added to moved dimension text when DIMTMOVE (page 1285) is set to 1.

See also:
Fit Dimension Text Within Extension Lines

**DIMAUNIT**

Sets the units format for angular dimensions.

**Type:** Integer

**Saved in:** Drawing
**Initial value:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Decimal degrees</td>
</tr>
<tr>
<td>1</td>
<td>Degrees/minutes/seconds</td>
</tr>
<tr>
<td>2</td>
<td>Gradians</td>
</tr>
<tr>
<td>3</td>
<td>Radians</td>
</tr>
</tbody>
</table>

**See also:**
- Create Angular Dimensions

**DIMAZIN**

Suppresses zeros for angular dimensions.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Displays all leading and trailing zeros</td>
</tr>
<tr>
<td>1</td>
<td>Suppresses leading zeros in decimal dimensions (for example, 0.5000 becomes .5000)</td>
</tr>
<tr>
<td>2</td>
<td>Suppresses trailing zeros in decimal dimensions (for example, 12.5000 becomes 12.5)</td>
</tr>
<tr>
<td>3</td>
<td>Suppresses leading and trailing zeros (for example, 0.5000 becomes .5)</td>
</tr>
</tbody>
</table>

**See also:**
- Suppress Zeros in Dimensions
DIMBLK

Sets the arrowhead block displayed at the ends of dimension lines.

**Type:** String  
**Saved in:** Drawing  
**Initial value:** ""

To return to the default, closed-filled arrowhead display, enter a single period (.) Arrowhead block entries and the names used to select them in the New, Modify, and Override Dimension Style dialog boxes are shown below. You can also enter the names of user-defined arrowhead blocks.

**NOTE** Annotative blocks cannot be used as custom arrowheads for dimensions or leaders.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;=&quot;</td>
<td>closed filled</td>
</tr>
<tr>
<td>&quot;_DOT&quot;</td>
<td>dot</td>
</tr>
<tr>
<td>&quot;_DOTSMALL&quot;</td>
<td>dot small</td>
</tr>
<tr>
<td>&quot;_DOTBLANK&quot;</td>
<td>dot blank</td>
</tr>
<tr>
<td>&quot;_ORIGIN&quot;</td>
<td>origin indicator</td>
</tr>
<tr>
<td>&quot;_ORIGIN2&quot;</td>
<td>origin indicator 2</td>
</tr>
<tr>
<td>&quot;_OPEN&quot;</td>
<td>open</td>
</tr>
<tr>
<td>&quot;_OPEN90&quot;</td>
<td>right angle</td>
</tr>
<tr>
<td>&quot;_OPEN30&quot;</td>
<td>open 30</td>
</tr>
<tr>
<td>&quot;_CLOSED&quot;</td>
<td>closed</td>
</tr>
<tr>
<td>&quot;_SMALL&quot;</td>
<td>dot small blank</td>
</tr>
<tr>
<td>&quot;_NONE&quot;</td>
<td>none</td>
</tr>
<tr>
<td>String</td>
<td>Meaning</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>&quot;_OBLIQUE&quot;</td>
<td>oblique</td>
</tr>
<tr>
<td>&quot;_BOXFILLED&quot;</td>
<td>box filled</td>
</tr>
<tr>
<td>&quot;_BOXBLANK&quot;</td>
<td>box</td>
</tr>
<tr>
<td>&quot;_CLOSEDBLANK&quot;</td>
<td>closed blank</td>
</tr>
<tr>
<td>&quot;_DATUMFILLED&quot;</td>
<td>datum triangle filled</td>
</tr>
<tr>
<td>&quot;_DATUMBLANK&quot;</td>
<td>datum triangle</td>
</tr>
<tr>
<td>&quot;_INTEGRAL&quot;</td>
<td>integral</td>
</tr>
<tr>
<td>&quot;_ARCHTICK&quot;</td>
<td>architectural tick</td>
</tr>
</tbody>
</table>

See also:

Customize Arrowheads

**DIMBLK1**

Sets the arrowhead for the first end of the dimension line when DIMSAH is on.

**Type:** String

**Saved in:** Drawing

**Initial value:** ""

To return to the default, closed-filled arrowhead display, enter a single period (.). For a list of arrowheads, see DIMBLK.

**NOTE** Annotative blocks cannot be used as custom arrowheads for dimensions or leaders.

See also:

Customize Arrowheads
**DIMBLK2**

Sets the arrowhead for the second end of the dimension line when DIMSAH is on.

*Type:* String  
*Saved in:* Drawing  
*Initial value:*

To return to the default, closed-filled arrowhead display, enter a single period (.). For a list of arrowhead entries, see DIMBLK.

**NOTE** Annotative blocks cannot be used as custom arrowheads for dimensions or leaders.

**See also:**

Customize Arrowheads

**DIMCEN**

Controls drawing of circle or arc center marks and centerlines by the DIMCENTER, DIMDIAMETER, and DIMRADIUS commands.

*Type:* Real  
*Saved in:* Drawing  
*Initial value:*

For DIMDIAMETER and DIMRADIUS, the center mark is drawn only if you place the dimension line outside the circle or arc.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No center marks or lines are drawn</td>
</tr>
<tr>
<td>&lt;0</td>
<td>Centerlines are drawn</td>
</tr>
<tr>
<td>&gt;0</td>
<td>Center marks are drawn</td>
</tr>
</tbody>
</table>

The absolute value specifies the size of the center mark or centerline.  
The size of the centerline is the length of the centerline segment that extends outside the circle or arc.  It is also the size of the gap between the center mark and the start of the centerline.
The size of the center mark is the distance from the center of the circle or arc to the end of the center mark.

See also:
Create Radial Dimensions

**DIMCLRD**

Assigns colors to dimension lines, arrowheads, and dimension leader lines.

**Type:** Integer

**Saved in:** Drawing

**Initial value:** 0

Also controls the color of leader lines created with the LEADER command. Color numbers are displayed in the Color Palette dialog box. For BYBLOCK, enter 0. For BYLAYER, enter 256.

See also:
Control Dimension Lines

**DIMCLRE**

Assigns colors to extension lines, center marks, and centerlines.

**Type:** Integer

**Saved in:** Drawing

**Initial value:** 0

Color numbers are displayed in the Color Palette dialog box. For BYBLOCK, enter 0. For BYLAYER, enter 256.

See also:
Override a Dimension Style

**DIMCLRT**

Assigns colors to dimension text.
**DIMCONSTRAINTICON**

Displays the lock icon next to the text for dimensional constraints.

**Type:** Bitcode  
**Saved in:** Registry  
**Initial value:** 3

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Does not display the lock icon next to the text for dimensional constraints</td>
</tr>
<tr>
<td>1</td>
<td>Displays the icon for dynamic constraints</td>
</tr>
<tr>
<td>2</td>
<td>Displays the icon for annotational constraints</td>
</tr>
<tr>
<td>3</td>
<td>Displays the icon for dynamic and annotational constraints</td>
</tr>
</tbody>
</table>

**See also:**

Apply Dimensional Constraints

**DIMDEC**

Sets the number of decimal places displayed for the primary units of a dimension.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 4 (imperial) or 2 (metric)
The precision is based on the units or angle format you have selected. Specified value is applied to angular dimensions when DIMADEC (page 1254) is set to -1.

See also:
Control the Display of Dimension Units

**DIMDLE**

Sets the distance the dimension line extends beyond the extension line when oblique strokes are drawn instead of arrowheads.

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** 0.0000

See also:
Control Dimension Lines

**DIMDLI**

Controls the spacing of the dimension lines in baseline dimensions.

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** 0.3800 (imperial) or 3.7500 (metric)

Each dimension line is offset from the previous one by this amount, if necessary, to avoid drawing over it. Changes made with DIMDLI are not applied to existing dimensions.

See also:
Control Dimension Lines

**DIMDSEP**

Specifies a single-character decimal separator to use when creating dimensions whose unit format is decimal.

**Type:** Single-character
Saved in: Drawing
Initial value: (imperial) or , (metric)

When prompted, enter a single character at the Command prompt. If dimension units is set to Decimal, the DIMDSEP character is used instead of the default decimal point. If DIMDSEP is set to NULL (default value, reset by entering a period), the decimal point is used as the dimension separator.

See also:
Control the Display of Dimension Units

DIMEXE

Specifies how far to extend the extension line beyond the dimension line.

Type: Real
Saved in: Drawing
Initial value: 0.1800 (imperial) or 1.2500 (metric)

See also:
Control Extension Lines

DIMEXO

Specifies how far extension lines are offset from origin points.

Type: Real
Saved in: Drawing
Initial value: 0.0625 (imperial) or 0.6250 (metric)

With fixed-length extension lines, this value determines the minimum offset.

See also:
Control Extension Lines

DIMFRAC

Sets the fraction format when DIMLUNIT is set to 4 (Architectural) or 5 (Fractional).
**Type:** Integer
**Saved in:** Drawing
**Initial value:** 0

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Horizontal stacking</td>
</tr>
<tr>
<td>1</td>
<td>Diagonal stacking</td>
</tr>
<tr>
<td>2</td>
<td>Not stacked (for example, 1/2)</td>
</tr>
</tbody>
</table>

**See also:**
Control the Display of Fractions

**DIMFXL**

Sets the total length of the extension lines starting from the dimension line toward the dimension origin.

**Type:** Real
**Saved in:** Drawing
**Initial value:** 1.0000

**See also:**
Control Extension Lines

**DIMFXLON**

Controls whether extension lines are set to a fixed length.

**Type:** Switch
**Saved in:** Drawing
**Initial value:** Off

When DIMFXLON is on, extension lines are set to the length specified by DIMFXL.

**See also:**
Control Extension Lines
**DIMGAP**

Sets the distance around the dimension text when the dimension line breaks to accommodate dimension text.

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** 0.0900 (imperial) or 0.6250 (metric)

Also sets the gap between annotation and a hook line created with the LEADER command. If you enter a negative value, DIMGAP places a box around the dimension text.

DIMGAP is also used as the minimum length for pieces of the dimension line. When the default position for the dimension text is calculated, text is positioned inside the extension lines only if doing so breaks the dimension lines into two segments at least as long as DIMGAP. Text placed above or below the dimension line is moved inside only if there is room for the arrowheads, dimension text, and a margin between them at least as large as DIMGAP: 2 * (DIMASZ (page 1260) + DIMGAP).

**See also:**  
Control the Location of Dimension Text

**DIMJOGANG**

Determines the angle of the transverse segment of the dimension line in a jogged radius dimension.

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** 45

Jogged radius dimensions are often created when the center point is located off the page. Valid settings range is 5 to 90.

**See also:**  
Create Radial Dimensions
**DIMJUST**

Controls the horizontal positioning of dimension text.

**Type:** Integer

**Saved in:** Drawing

**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Positions the text above the dimension line and center-justifies it between the extension lines</td>
</tr>
<tr>
<td>1</td>
<td>Positions the text next to the first extension line</td>
</tr>
<tr>
<td>2</td>
<td>Positions the text next to the second extension line</td>
</tr>
<tr>
<td>3</td>
<td>Positions the text above and aligned with the first extension line</td>
</tr>
<tr>
<td>4</td>
<td>Positions the text above and aligned with the second extension line</td>
</tr>
</tbody>
</table>

**See also:**

Control the Location of Dimension Text

**DIMLDRBLK**

Specifies the arrow type for leaders.

**Type:** String

**Saved in:** Drawing

**Initial value:** ""

To return to the default, closed-filled arrowhead display, enter a single period (.). For a list of arrowhead entries, see **DIMBLK** (page 1263).

**NOTE** Annotative blocks cannot be used as custom arrowheads for dimensions or leaders.

**See also:**

Overview of Leader Objects
**DIMLFAC**

Sets a scale factor for linear dimension measurements.

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** 1.0000

All linear dimension distances, including radii, diameters, and coordinates, are multiplied by DIMLFAC before being converted to dimension text. Positive values of DIMLFAC are applied to dimensions in both model space and paper space; negative values are applied to paper space only.

DIMLFAC applies primarily to nonassociative dimensions (DIMASSOC set 0 or 1). For nonassociative dimensions in paper space, DIMLFAC must be set individually for each layout viewport to accommodate viewport scaling.

DIMLFAC has no effect on angular dimensions, and is not applied to the values held in DIMRND (page 1277), DIMTM (page 1284), or DIMTP (page 1287).

**See also:**  
Set the Scale for Dimensions

**DIMLIM**

Generates dimension limits as the default text.

**Type:** Switch  
**Saved in:** Drawing  
**Initial value:** Off

Setting DIMLIM to On turns DIMTOL off.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Dimension limits are not generated as default text</td>
</tr>
<tr>
<td>On</td>
<td>Dimension limits are generated as default text</td>
</tr>
</tbody>
</table>

**See also:**  
Display Lateral Tolerances
**DIMLTEX1**

Sets the linetype of the first extension line.

*Type:* String  
*Saved in:* Drawing  
*Initial value:*"

The value is BYLAYER, BYBLOCK, or the name of a linetype.

**See also:**  
Control Extension Lines

---

**DIMLTEX2**

Sets the linetype of the second extension line.

*Type:* String  
*Saved in:* Drawing  
*Initial value:*"

The value is BYLAYER, BYBLOCK, or the name of a linetype.

**See also:**  
Control Extension Lines

---

**DIMLTYPE**

Sets the linetype of the dimension line.

*Type:* String  
*Saved in:* Drawing  
*Initial value:*"

The value is BYLAYER, BYBLOCK, or the name of a linetype.

**See also:**  
Control Dimension Lines
**DIMLUNIT**

Sets units for all dimension types except Angular.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 2

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Scientific</td>
</tr>
<tr>
<td>2</td>
<td>Decimal</td>
</tr>
<tr>
<td>3</td>
<td>Engineering</td>
</tr>
<tr>
<td>4</td>
<td>Architectural (always displayed stacked)</td>
</tr>
<tr>
<td>5</td>
<td>Fractional (always displayed stacked)</td>
</tr>
<tr>
<td>6</td>
<td>System Format</td>
</tr>
</tbody>
</table>

**See also:**  
Control the Display of Dimension Units

**DIMLWD**

Assigns lineweight to dimension lines.

**Type:** Enum  
**Saved in:** Drawing  
**Initial value:** 2

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-3</td>
<td>Default (the LWDEFAULT (page 1404) value)</td>
</tr>
<tr>
<td>-2</td>
<td>BYBLOCK</td>
</tr>
<tr>
<td>-1</td>
<td>BYLAYER</td>
</tr>
</tbody>
</table>

The integer represents 1/100th of a mm.
See also:
  Control Dimension Lines

**DIMLWE**

Assigns lineweight to extension lines.

**Type:** Enum  
**Saved in:** Drawing  
**Initial value:** -2

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-3</td>
<td>Default (the LWDEFAULT (page 1404) value)</td>
</tr>
<tr>
<td>-2</td>
<td>BYBLOCK</td>
</tr>
<tr>
<td>-1</td>
<td>BYLAYER</td>
</tr>
</tbody>
</table>

The integer represents 1/100th of a mm.

See also:  
  Control Extension Lines

**DIMPOST**

Specifies a text prefix or suffix (or both) to the dimension measurement.

**Type:** String  
**Saved in:** Drawing  
**Initial value:** None

For example, to establish a suffix for millimeters, set DIMPOST to mm; a distance of 19.2 units would be displayed as 19.2 mm.

If tolerances are turned on, the suffix is applied to the tolerances as well as to the main dimension.

Use <> to indicate placement of the text in relation to the dimension value. For example, enter <>mm to display a 5.0 millimeter radial dimension as "5.0mm". If you entered mm <>, the dimension would be displayed as "mm 5.0". Use the <> mechanism for angular dimensions.
See also:

Control the Display of Dimension Units

**DIMRND**

Rounds all dimensioning distances to the specified value.

*Type:* Real  
*Saved in:* Drawing  
*Initial value:* 0.0000

For instance, if DIMRND is set to 0.25, all distances round to the nearest 0.25 unit. If you set DIMRND to 1.0, all distances round to the nearest integer. Note that the number of digits edited after the decimal point depends on the precision set by DIMDEC. DIMRND does not apply to angular dimensions.

See also:

Round Off Dimension Values

**DIMSAH**

Controls the display of dimension line arrowhead blocks.

*Type:* Switch  
*Saved in:* Drawing  
*Initial value:* Off

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Use arrowhead blocks set by DIMBLK (page 1263)</td>
</tr>
<tr>
<td>On</td>
<td>Use arrowhead blocks set by DIMBLK1 (page 1264) and DIMBLK2 (page 1265)</td>
</tr>
</tbody>
</table>

See also:

Customize Arrowheads
**DIMSCALE**

Sets the overall scale factor applied to dimensioning variables that specify sizes, distances, or offsets.

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** 1.0000

Also affects the leader objects with the LEADER command.

Use MLEADERSCALE (page 1410) to scale multileader objects created with the MLEADER (page 654) command.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
<td>A reasonable default value is computed based on the scaling between the current model space viewport and paper space. If you are in paper space or model space and not using the paper space feature, the scale factor is 1.0.</td>
</tr>
<tr>
<td>&gt;0</td>
<td>A scale factor is computed that leads text sizes, arrowhead sizes, and other scaled distances to plot at their face values.</td>
</tr>
</tbody>
</table>

DIMSCALE does not affect measured lengths, coordinates, or angles.

Use DIMSCALE to control the overall scale of dimensions. However, if the current dimension style is annotative, DIMSCALE is automatically set to zero and the dimension scale is controlled by the CANNOSCALE (page 1222) system variable. DIMSCALE cannot be set to a non-zero value when using annotative dimensions.

**See also:**

Set the Scale for Dimensions

**DIMSD1**

Controls suppression of the first dimension line and arrowhead.

**Type:** Switch  
**Saved in:** Drawing  
**Initial value:** Off
When turned on, suppresses the display of the dimension line and arrowhead between the first extension line and the text.

<table>
<thead>
<tr>
<th></th>
<th>First dimension line is not suppressed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>On</td>
<td>First dimension line is suppressed</td>
</tr>
</tbody>
</table>

**See also:**
Control Dimension Lines

**DIMSD2**

Controls suppression of the second dimension line and arrowhead.

**Type:** Switch  
**Saved in:** Drawing  
**Initial value:** Off

When turned on, suppresses the display of the dimension line and arrowhead between the second extension line and the text.

<table>
<thead>
<tr>
<th></th>
<th>Second dimension line is not suppressed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>On</td>
<td>Second dimension line is suppressed</td>
</tr>
</tbody>
</table>

**See also:**
Control Dimension Lines

**DIMSE1**

Suppresses display of the first extension line.

**Type:** Switch  
**Saved in:** Drawing  
**Initial value:** Off

<table>
<thead>
<tr>
<th></th>
<th>Extension line is not suppressed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td></td>
</tr>
</tbody>
</table>
### DIMSE2

Suppresses display of the second extension line.

**Type:** Switch  
**Saved in:** Drawing  
**Initial value:** Off

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Extension line is not suppressed</td>
</tr>
<tr>
<td>On</td>
<td>Extension line is suppressed</td>
</tr>
</tbody>
</table>

**See also:**  
Control Extension Lines

### DIMSOXD

Suppresses arrowheads if not enough space is available inside the extension lines.

**Type:** Switch  
**Saved in:** Drawing  
**Initial value:** Off

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Arrowheads are not suppressed</td>
</tr>
<tr>
<td>On</td>
<td>Arrowheads are suppressed</td>
</tr>
</tbody>
</table>

If not enough space is available inside the extension lines and DIMTIX (page 1284) is on, setting DIMSOXD to On suppresses the arrowheads. If DIMTIX is off, DIMSOXD has no effect.
See also:
Control Dimension Lines

**DIMSTYLE**

Stores the name of the current dimension style.

*(Read-only)*

**Type:** String  
**Saved in:** Drawing  
**Initial value:** Standard (imperial) or ISO-25 (metric)

This system variable has the same name as a command. Use the SETVAR command to access this system variable. The DIMSTYLE system variable is read-only; to change the current dimension style, use the DIMSTYLE command.

See also:
Apply a New Dimension Style to Existing Dimensions

**DIMTAD**

Controls the vertical position of text in relation to the dimension line.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0 (imperial) or 1 (metric)

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Centers the dimension text between the extension lines.</td>
</tr>
<tr>
<td>1</td>
<td>Places the dimension text above the dimension line except when the dimension line is not horizontal and text inside the extension lines is forced horizontal (<em>DIMTIH</em> (page 1283) = 1). The distance from the dimension line to the baseline of the lowest line of text is the current <em>DIMGAP</em> (page 1271) value.</td>
</tr>
<tr>
<td>2</td>
<td>Places the dimension text on the side of the dimension line farthest away from the defining points.</td>
</tr>
<tr>
<td>3</td>
<td>Places the dimension text to conform to Japanese Industrial Standards (JIS).</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>4</td>
<td>Places the dimension text below the dimension line.</td>
</tr>
</tbody>
</table>

**See also:**

Control the Location of Dimension Text

**DIMTDEC**

Sets the number of decimal places to display in tolerance values for the primary units in a dimension.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 4 (imperial) or 2 (metric)

This system variable has no effect unless DIMTOL is set to On. The default for DIMTOL is Off.

**See also:**  
Display Lateral Tolerances

**DIMTFAC**

Specifies a scale factor for the text height of fractions and tolerance values relative to the dimension text height, as set by DIMTXT.

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** 1.0000

For example, if DIMTFAC is set to 1.0, the text height of fractions and tolerances is the same height as the dimension text. If DIMTFAC is set to 0.7500, the text height of fractions and tolerances is three-quarters the size of dimension text.

**See also:**  
Set the Scale for Dimensions
**DIMTFILL**

Controls the background of dimension text.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No background</td>
</tr>
<tr>
<td>1</td>
<td>The background color of the drawing</td>
</tr>
<tr>
<td>2</td>
<td>The background specified by DIMTFILLCLR (page 1283)</td>
</tr>
</tbody>
</table>

**See also:**  
Control the Appearance of Dimension Text

**DIMTFILLCLR**

Sets the color for the text background in dimensions.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0

Color numbers are displayed in the Color Palette dialog box. For BYBLOCK, enter 0. For BYLAYER, enter 256.

**See also:**  
Control the Appearance of Dimension Text

**DIMTIH**

Controls the position of dimension text inside the extension lines for all dimension types except Ordinate.

**Type:** Switch  
**Saved in:** Drawing
**Initial value:** On (imperial) or Off (metric)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Aligns text with the dimension line</td>
</tr>
<tr>
<td>On</td>
<td>Draws text horizontally</td>
</tr>
</tbody>
</table>

**See also:**

Control the Location of Dimension Text

**DIMTIX**

Draws text between extension lines.

**Type:** Switch  
**Saved in:** Drawing  
**Initial value:** Off

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>For linear and angular dimensions, dimension text is placed inside the extension lines if there is sufficient room.</td>
</tr>
<tr>
<td>On</td>
<td>Draws dimension text between the extension lines even if it would ordinarily be placed outside those lines. For radius and diameter dimensions, DIMTIX on always forces the dimension text outside the circle or arc.</td>
</tr>
</tbody>
</table>

**See also:**

Fit Dimension Text Within Extension Lines

**DIMTM**

Sets the minimum (or lower) tolerance limit for dimension text when DIMTOL or DIMLIM is on.

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** 0.0000
DIMTM accepts signed values. If DIMTOL is on and DIMTP and DIMTM are set to the same value, a tolerance value is drawn.

If DIMTM and DIMTP values differ, the upper tolerance is drawn above the lower, and a plus sign is added to the DIMTP value if it is positive.

For DIMTM, the program uses the negative of the value you enter (adding a minus sign if you specify a positive number and a plus sign if you specify a negative number).

See also:
  Display Lateral Tolerances

**DIMTMOVE**

Sets dimension text movement rules.

- **Type:** Integer
- **Saved in:** Drawing
- **Initial value:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Moves the dimension line with dimension text</td>
</tr>
<tr>
<td>1</td>
<td>Adds a leader when dimension text is moved</td>
</tr>
<tr>
<td>2</td>
<td>Allows text to be moved freely without a leader</td>
</tr>
</tbody>
</table>

See also:
  Modify Dimension Text

**DIMTOFL**

Controls whether a dimension line is drawn between the extension lines even when the text is placed outside.

- **Type:** Switch
- **Saved in:** Drawing
- **Initial value:** Off (imperial) or On (metric)
For radius and diameter dimensions, a dimension line is drawn inside the circle or arc when the text, arrowheads, and leader are placed outside.

<table>
<thead>
<tr>
<th></th>
<th>Does not draw dimension lines between the measured points when arrowheads are placed outside the measured points</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>On</td>
<td>Draws dimension lines between the measured points even when arrowheads are placed outside the measured points</td>
</tr>
</tbody>
</table>

See also:

Fit Dimension Text Within Extension Lines

**DIMTOH**

Controls the position of dimension text outside the extension lines.

**Type:** Switch  
**Saved in:** Drawing  
**Initial value:** On (imperial) or Off (metric)

<table>
<thead>
<tr>
<th></th>
<th>Aligns text with the dimension line</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>On</td>
<td>Draws text horizontally</td>
</tr>
</tbody>
</table>

See also:

Fit Dimension Text Within Extension Lines

**DIMTOL**

Appends tolerances to dimension text.

**Type:** Switch  
**Saved in:** Drawing  
**Initial value:** Off

Setting DIMTOL to on turns DIMLIM off.
See also:
Display Lateral Tolerances

**DIMTOLJ**

Sets the vertical justification for tolerance values relative to the nominal dimension text.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 1 (imperial) or 0 (metric)

This system variable has no effect unless DIMTOL is set to On. The default for DIMTOL is Off.

<table>
<thead>
<tr>
<th>Value</th>
<th>Justification</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Bottom</td>
</tr>
<tr>
<td>1</td>
<td>Middle</td>
</tr>
<tr>
<td>2</td>
<td>Top</td>
</tr>
</tbody>
</table>

See also:
Display Lateral Tolerances

**DIMTP**

Sets the maximum (or upper) tolerance limit for dimension text when DIMTOL or DIMLM is on.

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** 0.0000

DIMTP accepts signed values. If DIMTOL is on and DIMTP and DIMTM are set to the same value, a tolerance value is drawn.

If DIMTM and DIMTP values differ, the upper tolerance is drawn above the lower and a plus sign is added to the DIMTP value if it is positive.
DIMTSZ

Specifies the size of oblique strokes drawn instead of arrowheads for linear, radius, and diameter dimensioning.

<table>
<thead>
<tr>
<th>Type</th>
<th>Real</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in</td>
<td>Drawing</td>
</tr>
<tr>
<td>Initial value</td>
<td>0.0000</td>
</tr>
</tbody>
</table>

- 0 Draws arrowheads.
- >0 Draws oblique strokes instead of arrowheads. The size of the oblique strokes is determined by this value multiplied by the DIMSCALE (page 1278) value.

See also:

Customize Arrowheads

DIMTVP

Controls the vertical position of dimension text above or below the dimension line.

<table>
<thead>
<tr>
<th>Type</th>
<th>Real</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in</td>
<td>Drawing</td>
</tr>
<tr>
<td>Initial value</td>
<td>0.0000</td>
</tr>
</tbody>
</table>

The DIMTVP value is used when DIMTAD is off. The magnitude of the vertical offset of text is the product of the text height and DIMTVP. Setting DIMTVP to 1.0 is equivalent to setting DIMTAD to on. The dimension line splits to accommodate the text only if the absolute value of DIMTVP is less than 0.7.

See also:

Control the Location of Dimension Text
**DIMTXSTY**

Specifies the text style of the dimension.

**Type:** String  
**Saved in:** Drawing  
**Initial value:** Standard

See also:  
Control the Appearance of Dimension Text

**DIMTXT**

Specifies the height of dimension text, unless the current text style has a fixed height.

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** 0.1800 (imperial) or 2.5000 (metric)

See also:  
Control the Appearance of Dimension Text

**DIMTXTDIRECTION**

Specifies the reading direction of the dimension text.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0

<table>
<thead>
<tr>
<th>0</th>
<th>Displays dimension text in a Left-to-Right reading style</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Displays dimension text in a Right-to-Left reading style</td>
</tr>
</tbody>
</table>

See also:  
Control the Appearance of Dimension Text
**DIMTZIN**

Controls the suppression of zeros in tolerance values.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0 (imperial) or 8 (metric)

Values 0-3 affect feet-and-inch dimensions only.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Suppresses zero feet and precisely zero inches</td>
</tr>
<tr>
<td>1</td>
<td>Includes zero feet and precisely zero inches</td>
</tr>
<tr>
<td>2</td>
<td>Includes zero feet and suppresses zero inches</td>
</tr>
<tr>
<td>3</td>
<td>Includes zero inches and suppresses zero feet</td>
</tr>
<tr>
<td>4</td>
<td>Suppresses leading zeros in decimal dimensions (for example, 0.5000 becomes .5000)</td>
</tr>
<tr>
<td>8</td>
<td>Suppresses trailing zeros in decimal dimensions (for example, 12.5000 becomes 12.5)</td>
</tr>
<tr>
<td>12</td>
<td>Suppresses both leading and trailing zeros (for example, 0.5000 becomes .5)</td>
</tr>
</tbody>
</table>

See also:  
Display Lateral Tolerances

**DIMUPT**

Controls options for user-positioned text.

**Type:** Switch  
**Saved in:** Drawing  
**Initial value:** Off

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Cursor controls only the dimension line location</td>
</tr>
</tbody>
</table>

1290 | Chapter 4   System Variables
Cursor controls both the text position and the dimension line location.

See also:
Control the Location of Dimension Text

DIMZIN

Controls the suppression of zeros in the primary unit value.

**Type:** Integer

**Saved in:** Drawing

**Initial value:** 0 (imperial) or 8 (metric)

Values 0-3 affect feet-and-inch dimensions only:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Suppresses zero feet and precisely zero inches</td>
</tr>
<tr>
<td>1</td>
<td>Includes zero feet and precisely zero inches</td>
</tr>
<tr>
<td>2</td>
<td>Includes zero feet and suppresses zero inches</td>
</tr>
<tr>
<td>3</td>
<td>Includes zero inches and suppresses zero feet</td>
</tr>
<tr>
<td>4</td>
<td>Suppresses leading zeros in decimal dimensions</td>
</tr>
<tr>
<td></td>
<td>(for example, 0.5000 becomes .5000)</td>
</tr>
<tr>
<td>8</td>
<td>Suppresses trailing zeros in decimal dimensions</td>
</tr>
<tr>
<td></td>
<td>(for example, 12.5000 becomes 12.5)</td>
</tr>
<tr>
<td>12</td>
<td>Suppresses both leading and trailing zeros</td>
</tr>
<tr>
<td></td>
<td>(for example, 0.5000 becomes .5)</td>
</tr>
</tbody>
</table>

DIMZIN also affects real-to-string conversions performed by the AutoLISP `rtos` and `angtos` functions.

See also:
Suppress Zeros in Dimensions
**DISPLAYVIEWCUBEIN2D**

Controls the display of the ViewCube tool when the 2D Wireframe visual style is applied to a viewport.

<table>
<thead>
<tr>
<th>Type:</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>Registry</td>
</tr>
<tr>
<td>Initial value:</td>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off. Do not display the ViewCube tool when the 2D Wireframe visual style is applied</td>
</tr>
<tr>
<td>1</td>
<td>On. Display the ViewCube tool when the 2D Wireframe visual style is applied</td>
</tr>
</tbody>
</table>

See also:

Use ViewCube Tool

**DISPLAYVIEWCUBEIN3D**

Controls the display of the ViewCube tool when a 3D visual style is applied to a viewport.

<table>
<thead>
<tr>
<th>Type:</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>Registry</td>
</tr>
<tr>
<td>Initial value:</td>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off. Do not display the ViewCube tool when a 3D visual style is applied</td>
</tr>
<tr>
<td>1</td>
<td>On. Display the ViewCube tool when a 3D visual style is applied</td>
</tr>
</tbody>
</table>

See also:

Use ViewCube Tool
**DISPSILH**

Controls display of silhouette edges of 3D solid objects in a 2D Wireframe or 3D Wireframe visual style.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off. Do not display silhouette edges</td>
</tr>
<tr>
<td>1</td>
<td>On. Display silhouette edges</td>
</tr>
</tbody>
</table>

When turned on, DISPSILH also suppresses the mesh displayed when using the HIDE command in the 2D Wireframe visual style.

Use the REGEN command to display the results.

**See also:**  
Control the Display of Edges

**DISTANCE**

Stores the distance computed by the DIST command.

(Read-only)  
**Type:** Real  
**Saved in:** Not-saved  
**Initial value:** 0.0000

**See also:**  
Obtain Distances, Angles, and Point Locations

**DIVMESHBOXHEIGHT**

Sets the number of subdivisions for the height of a mesh box along the Z axis.

**Type:** Integer  
**Saved in:** User-settings  
**Initial value:** 3
This setting affects new mesh boxes that are created with the `MESH` (page 620) command.

**See also:**
Create a Mesh Box

**DIVMESHBOXLENGTH**

Sets the number of subdivisions for the length of a mesh box along the X axis.

- **Type:** Integer
- **Saved in:** User-settings
- **Initial value:** 3

This setting affects new mesh boxes that are created with the `MESH` (page 620) command.
See also:

Create a Mesh Box

DIVMESHBOXWIDTH

Sets the number of subdivisions for the width of a mesh box along the \( Y \) axis.

- **Type:** Integer
- **Saved in:** User-settings
- **Initial value:** 3

This setting affects new mesh boxes that are created with the **MESH** (page 620) command.

See also:

Create a Mesh Box

DIVMESHCONEAXIS

Sets the number of subdivisions around the perimeter of the mesh cone base.

- **Type:** Integer
- **Saved in:** User-settings
- **Initial value:** 8
This setting affects new mesh cones that are created with the MESH (page 620) command.

See also:
   Create a Mesh Cone

**DIVMESHCONEBASE**

Sets the number of subdivisions between the perimeter and the center point of the mesh cone base.

- **Type:** Integer
- **Saved in:** User-settings
- **Initial value:** 3
This setting affects new mesh cones that are created with the MESH command.

See also:
Create a Mesh Cone

DIVMESHCONEHIGHT

Sets the number of subdivisions between the base and the point or top of the mesh cone.

**Type:** Integer  
**Saved in:** User-settings  
**Initial value:** 3
This setting affects new mesh cones that are created with the MESH (page 620) command.

See also:
Create a Mesh Cone

DIVMESHCYLAXIS

Sets the number of subdivisions around the perimeter of the mesh cylinder base.

Type: Integer
Saved in: User-settings
Initial value: 8
This setting affects new mesh cylinders that are created with the `MESH` (page 620) command.

**See also:**
Create a Mesh Cylinder

**DIVMESHCYLBASE**

Sets the number of radial subdivisions from the center of the mesh cylinder base to its perimeter.

**Type:** Integer  
**Saved in:** User-settings  
**Initial value:** 3
This setting affects new mesh cylinders that are created with the MESH (page 620) command.

See also:
Create a Mesh Cylinder

**DIVMESHCYLHEIGHT**

Sets the number of subdivisions between the base and the top of the mesh cylinder.

- **Type:** Integer
- **Saved in:** User-settings
- **Initial value:** 3

This setting affects new mesh cylinders that are created with the MESH (page 620) command.

See also:
Create a Mesh Cylinder

**DIVMESHPYRBASE**

Sets the number of radial subdivisions between the center of the mesh pyramid base and its perimeter.

- **Type:** Integer
**DIVMESHPYRHEIGHT**

Sets the number of subdivisions between the base and the top of the mesh pyramid.

*Type:* Integer  
*Saved in:* User-settings  
*Initial value:* 3

This setting affects new mesh pyramids that are created with the MESH (page 620) command.

**See also:**  
Create a Mesh Pyramid
This setting affects new mesh pyramids that are created with the MESH (page 620) command.

See also:
Create a Mesh Pyramid

DIVMESHPYRLENGTH

Sets the number of subdivisions along each dimension of a mesh pyramid base.

Type: Integer
Saved in: User-settings
Initial value: 3

This setting affects new mesh pyramids that are created with the MESH (page 620) command.

See also:
Create a Mesh Pyramid

DIVMESHSPHEREAXIS

Sets the number of radial subdivisions around the axis endpoint of the mesh sphere.

Type: Integer
Saved in: User-settings
**Initial value:** 12

This setting affects new mesh spheres that are created with the MESH (page 620) command.

**See also:**
Create a Mesh Sphere

**DIVMESHSPHEREHEIGHT**

Sets the number of subdivisions between the two axis endpoints of the mesh sphere.

**Type:** Integer  
**Saved in:** User-settings  
**Initial value:** 6

This setting affects new mesh spheres that are created with the MESH (page 620) command.
See also:

Create a Mesh Sphere

**DIVMESHTORUSPATH**

Sets the number of subdivisions in the path that is swept by the profile of a mesh torus.

**Type:** Integer  
**Saved in:** User-settings  
**Initial value:** 8

This setting affects new mesh tori that are created with the MESH (page 620) command.

See also:  
Create a Mesh Torus

**DIVMESHTORUSSECTION**

Sets the number of subdivisions in the profile that sweeps the path of a mesh torus.

**Type:** Integer  
**Saved in:** User-settings  
**Initial value:** 8
This setting affects new mesh tori that are created with the MESH (page 620) command.

See also:
Create a Mesh Torus

DIVMESHWEDGEBASE

Sets the number of subdivisions between the midpoint of the perimeter of triangular dimension of the mesh wedge.

Type: Integer
Saved in: User-settings
Initial value: 3

This setting affects new mesh wedges that are created with the MESH (page 620) command.
See also:

Create a Mesh Wedge

DIVMESHWEDGEHEIGHT

Sets the number of subdivisions for the height of the mesh wedge along the Z axis.

Type: Integer
Saved in: User-settings
Initial value: 3

This setting affects new mesh wedges that are created with the MESH (page 620) command.

See also:

Create a Mesh Wedge

DIVMESHWEDGELENGTH

Sets the number of subdivisions for the length of a mesh wedge along the X axis.

Type: Integer
Saved in: User-settings
Initial value: 4
This setting affects new mesh wedges that are created with the MESH (page 620) command.

See also:

Create a Mesh Wedge

DIVMESHWEDGESLOPE

Sets the number of subdivisions in the slope that extends from the apex of the wedge to the edge of the base.

Type: Integer
Saved in: User-settings
Initial value: 3
This setting affects new mesh wedges that are created with the MESH (page 620) command.

**See also:**
Create a Mesh Wedge

**DIVMESHWEDGEWIDTH**

Sets the number of subdivisions for the width of the mesh wedge along the Y axis.

**Type:** Integer  
**Saved in:** User-settings  
**Initial value:** 3

This setting affects new mesh wedges that are created with the MESH (page 620) command.

**See also:**
Create a Mesh Wedge

**DONUTID**

Sets the default for the inside diameter of a donut.

**Type:** Real  
**Saved in:** Not-saved
**Initial value:** 0.5000

**See also:**
- Draw Donuts

**DONUTOD**

Sets the default for the outside diameter of a donut.

**Type:** Real  
**Saved in:** Not-saved  
**Initial value:** 1.0000

The value must be nonzero. If DONUTID is larger than DONUTOD, the two values are swapped by the next command.

**See also:**
- Draw Donuts

**DRAGMODE**

Controls the display of objects being dragged.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 2

This system variable has the same name as a command. Use the SETVAR command to access this system variable.

When it is on, the image of an object is displayed as you drag it to another location. With some computer configurations, dragging can be time-consuming. Use DRAGMODE to suppress dragging.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Does not display an outline of the object as you drag it</td>
</tr>
<tr>
<td>1</td>
<td>Displays the outline of the object as you drag it only if you enter <code>drag</code> at the Command prompt after selecting the object to drag</td>
</tr>
<tr>
<td>2</td>
<td>Auto; always displays an outline of the object as you drag it</td>
</tr>
</tbody>
</table>
DRAGP1

When hardware acceleration is used, controls how many vectors the system draws when you drag objects within a 2D viewport before it checks for a new input sample from the mouse.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 5000

A larger number results in more graphical vectors being displayed as objects are dragged. For best performance, it is recommended that you use hardware acceleration rather than software acceleration. DRAGP1 has no effect when dragging objects in a 3D viewport.

**See also:**  
Set Up the Drawing Area

DRAGP2

When software acceleration is used, controls how many vectors the system draws when you drag objects within a 2D viewport before it checks for a new input sample from the mouse.

(Read-only)  
**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 10

Not supported on Mac OS and is provided for scripting compatibility with the Windows releases of AutoCAD.

**See also:**  
Set Up the Drawing Area


**DRAGVS**

Sets the visual style that is displayed while creating 3D solid and mesh primitives and extruded solids, surfaces, and meshes.

**Type:** String  
**Saved in:** Drawing  
**Initial value:**"

You can enter a period (.) to specify the current visual style. DRAGVS can only be set to a visual style that is saved in the drawing.

DRAGVS has no effect when the current viewport's visual style is set to 2D Wireframe.

The visual style specified for DRAGVS cannot be removed with the PURGE (page 861) command.

**See also:**
- Create a Solid Box

**DRAWORDERCTL**

Controls the default display behavior of overlapping objects when they are created or edited.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 3

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Turns off the default draw order of overlapping objects: after objects are edited, regardless of their draw order, the objects are displayed on top until a drawing is regenerated (REGEN) or reopened. This setting also turns off draw order inheritance: new objects that are created from another object using the commands listed below are not assigned the draw order of the original object. Use this setting to improve the speed of editing operations in large drawings. The commands that are affected by inheritance are BREAK, FILLET, HATCH, HATCHEDIT, EXPLODE, TRIM, JOIN, PEDIT, and OFFSET.</td>
</tr>
<tr>
<td>1</td>
<td>Turns on the default draw order of objects: after objects are edited, they are automatically displayed according to the correct draw order.</td>
</tr>
<tr>
<td></td>
<td>Description</td>
</tr>
<tr>
<td>---</td>
<td>-------------</td>
</tr>
<tr>
<td>2</td>
<td>Turns on draw order inheritance: new objects created from another object using the commands listed above are assigned the draw order of the original object.</td>
</tr>
<tr>
<td>3</td>
<td>Provides full draw order display. Turns on the correct draw order of objects, and turns on draw order inheritance.</td>
</tr>
</tbody>
</table>

**NOTE** Full draw order display may slow some editing operations.

See also:
- Control How Overlapping Objects Are Displayed

### DRSTATE

Indicates whether the Files Recovered dialog box is open or closed.

(Read-only)

**Type:** Integer  
**Saved in:** Not-saved  
**Initial value:** Varies

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Closed</td>
</tr>
<tr>
<td>1</td>
<td>Open</td>
</tr>
</tbody>
</table>

See also:
- Recover from a System Failure

### DTEXTED

Specifies the user interface displayed for editing single-line text.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 2

Obsolete command. Replaced by the TEXTED (page 1506) system variable.
See also:
Create Single-Line Text

**DWGCHECK**

Checks drawings for potential problems when opening them.

**Type:** Integer

**Saved in:** Registry

**Initial value:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>If a drawing that you try to open has a potential problem, you are warned before the drawing is opened.</td>
</tr>
<tr>
<td>1</td>
<td>If a drawing that you try to open has a potential problem, or if it was saved by an application other than one released by Autodesk or based on RealDWG, you are warned before the drawing is opened.</td>
</tr>
<tr>
<td>2</td>
<td>If a drawing that you try to open has a potential problem, you are notified at the Command prompt.</td>
</tr>
<tr>
<td>3</td>
<td>If a drawing that you try to open has a potential problem, you are notified at the Command prompt. If the drawing has a potential problem and the drawing was saved by an application other than one released by Autodesk or based on RealDWG, you are warned before the drawing is opened.</td>
</tr>
</tbody>
</table>

See also:
Open a Drawing

**DWGCODEPAGE**

Stores the same value as SYSCODEPAGE (for compatibility reasons).

(Read-only)

**Type:** String

**Saved in:** Not-saved

**Initial value:** Varies
See also:

Use Text Fonts for International Work

**DWGNAME**

Stores the name of the current drawing.

(Read-only)

**Type:** String  
**Saved in:** Not-saved  
**Initial value:** Drawing1.dwg

If a new drawing has not been saved yet, DWGNAME defaults to `Drawing1.dwg`. Additional new drawings are named `Drawing2.dwg`, `Drawing3.dwg`, and so on.

The location of the saved drawing file is stored in **DWGPREFIX** (page 1314).

See also:

Save a Drawing

**DWGPREFIX**

Stores the drive and folder prefix for the drawing.

(Read-only)

**Type:** String  
**Saved in:** Not-saved  
**Initial value:** Varies

See also:

Save a Drawing

**DWGTITLED**

Indicates whether the current drawing has been named.

(Read-only)

**Type:** Integer  
**Saved in:** Not-saved
Initial value:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Drawing has not been named</td>
</tr>
<tr>
<td>1</td>
<td>Drawing has been named</td>
</tr>
</tbody>
</table>

See also:

Save a Drawing

**DYNCONSTRAINTMODE**

Displays hidden dimensional constraints when constrained objects are selected.

**Type:** Integer

**Saved in:** Registry

**Initial value:** 1

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Keeps constraints hidden when an object is selected</td>
</tr>
<tr>
<td>1</td>
<td>Displays hidden constraints when dimensionally constrained objects are selected</td>
</tr>
</tbody>
</table>

**NOTE** This system variable takes effect when dynamic constraints are hidden (see DCDISPLAY (page 263)).

See also:

Control the Display of Dimensional Constraints

**DYNDIGRIP**

Controls which dynamic dimensions are displayed during grip stretch editing.

**Type:** Bitcode

**Saved in:** Registry

**Initial value:** 31
The DYNDIVIS system variable must be set to 2, which displays all dynamic dimensions. The setting is stored as a bitcode using the sum of the following values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Bitcode</th>
<th>Dimension</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Resulting dimension</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Length change dimension</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Absolute angle dimension</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Angle change dimension</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Arc radius dimension</td>
<td></td>
</tr>
</tbody>
</table>

The DYNMODE (page 1317) system variable turns Dynamic Input features on and off.

See also:
Use Dynamic Input

**DYNDIVIS**

Controls how many dynamic dimensions are displayed during grip stretch editing.

*Type:* Integer  
*Saved in:* Registry  
*Initial value:* 1

DYNDIGRIP controls which dynamic dimensions are displayed during grip stretch editing.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Only the first dynamic dimension in the cycle order</td>
</tr>
<tr>
<td>1</td>
<td>Only the first two dynamic dimensions in the cycle order</td>
</tr>
</tbody>
</table>
2 All dynamic dimensions, as controlled by the `DYNDIGRIP` (page 1315) system variable

The `DYNMODE` (page 1317) system variable turns Dynamic Input features on and off.

See also:

Use Dynamic Input

**DYNINFOTIPS**

Controls whether tips are displayed for using Shift and Ctrl when editing with grips.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 1

When dynamic input is turned on and you select a grip, a tip at the cursor lists the available grip options that you can cycle through using Shift or Ctrl.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Hide the Shift and Ctrl tips</td>
</tr>
<tr>
<td>1</td>
<td>Display the Shift and Ctrl tips</td>
</tr>
</tbody>
</table>

This setting is on the Dynamic Input tab in the drafting settings dialog box (page 369).

See also:

Use Object Grips

**DYNMODE**

Turns Dynamic Input features on and off.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 3
When all features are on, the context governs what is displayed.

When DYNMODE is set to a negative value, the Dynamic Input features are not turned on, but the setting is stored. Press the Dynamic Input button in the status bar to set DYNMODE to the corresponding positive value.

<table>
<thead>
<tr>
<th></th>
<th>All Dynamic Input features, including dynamic prompts, off</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Pointer input on</td>
</tr>
<tr>
<td>1</td>
<td>Dimensional input on</td>
</tr>
<tr>
<td>2</td>
<td>Both pointer input and dimensional input on</td>
</tr>
</tbody>
</table>

If dynamic prompts are on (DYNPROMPT (page 1320) is set to 1), they are displayed when DYNMODE is set to 1, 2, or 3.

When dimensional input is turned on (DYNMODE = 2 or 3), the program switches to pointer input when you enter a comma or an angle bracket (<), or when you select multiple grip points.

When DYNMODE is set to 1, 2, or 3, you can turn off all features temporarily by holding down the temporary override key, Fn-F12.

Settings are on the Dynamic Input tab in the Drafting Settings dialog box (page 369).

See also:
- Use Dynamic Input

**DYNPICOORDS**

Controls whether pointer input uses relative or absolute format for coordinates.

<table>
<thead>
<tr>
<th>Type:</th>
<th>Switch</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>Registry</td>
</tr>
<tr>
<td>Initial value:</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Relative</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Absolute</td>
</tr>
</tbody>
</table>

1318 | Chapter 4 · System Variables
The **DYNMODE** (page 1317) system variable turns Dynamic Input features on and off.

**See also:**
Use Dynamic Input

### DYNPIFORMAT

Controls whether pointer input uses polar or Cartesian format for coordinates.

**Type:** Switch  
**Saved in:** Registry  
**Initial value:** 0

This setting applies only to a second or next point.

<table>
<thead>
<tr>
<th>0</th>
<th>Polar</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Cartesian</td>
</tr>
</tbody>
</table>

The **DYNMODE** (page 1317) system variable turns Dynamic Input features on and off.

**See also:**
Use Dynamic Input

### DYNPIVIS

Controls when pointer input is displayed.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 1

<table>
<thead>
<tr>
<th>0</th>
<th>Only when you type at a prompt for a point</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Automatically at a prompt for a point</td>
</tr>
<tr>
<td>2</td>
<td>Always</td>
</tr>
</tbody>
</table>
The DYNMODE (page 1317) system variable turns Dynamic Input features on and off.

See also:
Use Dynamic Input

DYNPROMPT

Controls display of prompts in Dynamic Input tooltips.

Type: Integer
Saved in: Registry
Initial value: 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off</td>
</tr>
<tr>
<td>1</td>
<td>On</td>
</tr>
</tbody>
</table>

The DYNMODE (page 1317) system variable turns Dynamic Input features on and off. When DYNMODE is set to 0 (off), prompts are not displayed regardless of the DYNPROMPT setting.

See also:
Use Dynamic Input

DYNTOOTIPS

Controls which tooltips are affected by tooltip appearance settings.

Type: Switch
Saved in: Registry
Initial value: 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Only Dynamic Input value fields</td>
</tr>
<tr>
<td>1</td>
<td>All drafting tooltips</td>
</tr>
</tbody>
</table>

The DYNMODE (page 1317) system variable turns Dynamic Input features on and off. When DYNMODE is set to 0 (off), prompts are not displayed regardless of the DYNPROMPT setting.

See also:
Use Dynamic Input
See also:
Use Dynamic Input

E System Variables

EDGEMODE

Controls how the TRIM and EXTEND commands determine cutting and boundary edges.

| Type:     | Integer          |
| Saved in: | Registry         |
| Initial value: | 0          |

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Uses the selected edge without any extensions</td>
</tr>
<tr>
<td>1</td>
<td>Extends or trims the selected object to an imaginary extension of the cutting or boundary edge</td>
</tr>
</tbody>
</table>

Lines, arcs, elliptical arcs, rays, and polylines are objects eligible for natural extension. The natural extension of a line or ray is an unbounded line (xline), an arc is a circle, and an elliptical arc is an ellipse. A polyline is broken down into its line and arc components, which are extended to their natural boundaries.

See also:
Trim or Extend Objects

ELEVATION

Stores the current elevation of new objects relative to the current UCS.

| Type: | Real |
| Saved in: | Drawing |
| Initial value: | 0.0000 |

E System Variables | 1321
ERHIGHLIGHT

Controls whether reference names or reference objects are highlighted when their counterparts are selected in the Reference Manager palette or in the drawing window.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Referenced objects are not highlighted.</td>
</tr>
<tr>
<td>1</td>
<td>Referenced objects are highlighted.</td>
</tr>
</tbody>
</table>

**See also:**  
Attach Drawing References (Xrefs)

ERRNO

Displays the number of the appropriate error code when an AutoLISP function call causes an error that AutoCAD detects.

(Read-only)

**Type:** Integer  
**Saved in:** Not-saved  
**Initial value:** 0

AutoLISP applications can inspect the current value of ERRNO with (getvar "errno").

The ERRNO system variable is not always cleared to zero. Unless it is inspected immediately after an AutoLISP function has reported an error, the error that its value indicates may be misleading. This variable is always cleared when starting or opening a drawing.

See the *AutoLISP Developer's Guide* for more information.
See also:
Overview of AutoLISP

ERSTATE

Indicates whether the Reference Manager palette is open or closed.
(Read-only)

<table>
<thead>
<tr>
<th>Type:</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>Not-saved</td>
</tr>
<tr>
<td>Initial value:</td>
<td>Varies</td>
</tr>
<tr>
<td>0</td>
<td>Closed</td>
</tr>
<tr>
<td>1</td>
<td>Open</td>
</tr>
</tbody>
</table>

See also:
Attach Drawing References (Xrefs)

EXPERT

Controls whether certain prompts are issued.

<table>
<thead>
<tr>
<th>Type:</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>Not-saved</td>
</tr>
<tr>
<td>Initial value:</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>0</th>
<th>Issues all prompts normally.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Suppresses “About to regen, proceed?” and “Really want to turn the current layer off?” (-LAYER (page 539))</td>
</tr>
<tr>
<td>2</td>
<td>Suppresses the preceding prompts and “Block already defined. Redefine it?” (-BLOCK (page 148)) and “A drawing with this name already exists. Overwrite it?” (SAVE (page 926) or WBLOCK (page 1160)).</td>
</tr>
</tbody>
</table>
3 Suppresses the preceding prompts and those issued by the \texttt{LINETYPE} (page 578) Command prompt (-LINETYPE) if you try to load a linetype that's already loaded or create a new linetype in a file that already defines that linetype.

4 Suppresses the preceding prompts and those issued by \texttt{UCS} (page 1106) Save and \texttt{VPORTS} (page 1151) Save if the name you supply already exists.

5 Suppresses the prompt, “That name is already in Use, redefine it?” issued by the \texttt{-DIMSTYLE} (page 319) Save option when you supply the name of an existing dimension style.
Suppresses the same prompt issued by the \texttt{-SCALELISTEDIT} (page 930) Add option.

When a prompt is suppressed by EXPERT, the operation in question is performed as though you entered \texttt{y} at the prompt. Setting EXPERT can affect scripts, menu macros, AutoLISP, and the command functions.

\textbf{See also:}

Switch Between Dialog Boxes and the Command Line

\section*{EXPLMODE}

Controls whether the \texttt{EXPLODE} command supports nonuniformly scaled (NUS) blocks.

\begin{itemize}
  \item \textbf{Type:} Integer
  \item \textbf{Saved in:} Not-saved
  \item \textbf{Initial value:} 1
\end{itemize}

\begin{tabular}{|c|l|}
  \hline
  0 & Does not explode NUS blocks \\
  \hline
  1 & Explodes NUS blocks \\
  \hline
\end{tabular}

\textbf{See also:}

Disassemble a Block Reference (Explode)
**EXTMAX**

Stores the upper-right point of the drawing extents.

(Read-only)

**Type:** 3D-point  
**Saved in:** Drawing  
**Initial value:**Varies

Expands outward as new objects are drawn; shrinks only with ZOOM All or ZOOM Extents. Reported in world coordinates for the current space.

**See also:**  
Pan or Zoom a View

**EXTMIN**

Stores the lower-left point of the drawing extents.

(Read-only)

**Type:** 3D-point  
**Saved in:** Drawing  
**Initial value:**Varies

Expands outward as new objects are drawn; shrinks only with ZOOM All or ZOOM Extents. Reported in world coordinates for the current space.

**See also:**  
Pan or Zoom a View

**EXTNAMES**

Sets the parameters for named object names (such as linetypes and layers) stored in definition tables.

**Type:** Integer  
**Saved in:** Drawing
Initial value: 1

<table>
<thead>
<tr>
<th>0</th>
<th>Uses AutoCAD R14 parameters, which limit names to 31 characters in length. Names can include the letters A to Z, the numerals 0 to 9, and the special characters dollar sign ($), underscore (_), and hyphen (-).</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Uses AutoCAD 2000 (and later releases) parameters. Names can be up to 255 characters in length, and can include the letters A to Z, the numerals 0 to 9, spaces, and any special characters not used by the operating system and AutoCAD for other purposes.</td>
</tr>
</tbody>
</table>

See also:
Resolve Name Conflicts in External References

F System Variables

FACETERDEVNORMAL

Sets the maximum angle between the surface normal and contiguous mesh faces.

**Type:** Real  
**Saved in:** User-settings  
**Initial value:** 40

This setting affects mesh that is converted from another object using the MESHSMOOTH (page 640) command. (For a complete list of objects that can be converted to mesh, see Objects That Can Be Converted to Mesh (page 641).)

Use this setting to retain visual consistency between mesh objects that have the same shape but different sizes. You can enter any non-negative number between 0 (zero) and 180. Lowering the value increases the density in areas of high curvature and decreases density in flatter areas.

Lowering the value might increase the drawing file size, and should be saved for larger objects with high FACETERDEVSURFACE (page 1327) settings. Avoid lowering this value for objects with small details such as holes or fillets.
The value of this system variable reflects the value for objects with no smoothness.

See also:
Create Meshes by Conversion

**FACETERDEVSURFACE**

Sets how closely the converted mesh object adheres to the original shape of the solid or surface.

<table>
<thead>
<tr>
<th>Type:</th>
<th>Real</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>User-settings</td>
</tr>
<tr>
<td>Initial value:</td>
<td>0.001</td>
</tr>
</tbody>
</table>

This setting affects mesh that is converted from another object using the MESHSMOOTH (page 640) command. (For a complete list of objects that can be converted to mesh, see Objects That Can Be Converted to Mesh (page 641).)

You can enter any non-negative number, including 0 (zero). Smaller values result in a higher number of faces, more accurate meshes with less deviation from the object surface, and slower performance. Set the value to 0 to turn off the option.

The value of this system variable reflects the value for objects with no smoothness.

See also:
Create Meshes by Conversion

**FACETERGRIDRATIO**

Sets the maximum aspect ratio for the mesh subdivisions that are created for solids and surfaces converted to mesh.

<table>
<thead>
<tr>
<th>Type:</th>
<th>Real</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>User-settings</td>
</tr>
<tr>
<td>Initial value:</td>
<td>0.0000</td>
</tr>
</tbody>
</table>

F System Variables | 1327
This setting affects mesh that is converted from another object using the PATHSMOOTH (page 640) command. (For a complete list of objects that can be converted to mesh, see Objects That Can Be Converted to Mesh (page 641).)

Permissible values range from 0 to 100, and set the height/width ratio of the face. Use this variable to prevent long, thin faces that can result from cylindrical object conversions. Smaller values result in more, better-formed faces, but can affect performance. Set this value to 0 to turn it off.

If the value you enter is less than 1, the ratio calculation is based on $1/n$. For example, if you enter 0.2, the variable value is $1/0.2 = 5$.

**NOTE** The value of this system variable reflects the value for objects with no smoothness.

See also:

Create Meshes by Conversion

### FACETERMAXEDGELENGTH

Sets the maximum length of edges for mesh objects that are created by conversion from solids and surfaces.

**Type:** Real

**Saved in:** User-settings

**Initial value:** 0.0000

You can use any non-negative number, including 0 (zero). A value of 0 (zero) does not restrict the length an edge can be when a surface or solid is converted to a mesh.

This setting affects mesh that is converted from another object using the PATHSMOOTH (page 640) command. (For a complete list of objects that can be converted to mesh, see Objects That Can Be Converted to Mesh (page 641).)

**NOTE** The value of this system variable reflects the value for objects with no smoothness.

See also:

Create Meshes by Conversion
FACETERMAXGRID

Sets the maximum number of U and V grid lines for solids and surfaces converted to mesh.

**Type:** Integer  
**Saved in:** User-settings  
**Initial value:** 4096

This setting affects mesh that is converted from another object using the MESHSMOOTH (page 640) command. (For a complete list of objects that can be converted to mesh, see Objects That Can Be Converted to Mesh (page 641).) Permissible values range from 0 to 4096.

**NOTE** The value of this system variable reflects the value for objects with no smoothness.

See also:  
Create Meshes by Conversion

FACETERMESHTYPE

Sets the type of mesh to be created.

**Type:** Integer  
**Saved in:** User-settings  
**Initial value:** 0

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Objects are converted to an optimized mesh object type with fewer faces</td>
</tr>
<tr>
<td>1</td>
<td>Faces are mostly quadrilateral</td>
</tr>
<tr>
<td>2</td>
<td>Faces are mostly triangular</td>
</tr>
</tbody>
</table>

This setting affects mesh that is converted from another object using the MESHSMOOTH (page 640) command. (For a complete list of objects that can be converted to mesh, see Objects That Can Be Converted to Mesh (page 641).)
SEE ALSO:
Create Meshes by Conversion

FACETERMINUGRID

Sets the minimum number of U grid lines for solids and surfaces that are
converted to mesh.

Type: Integer
Saved in: User-settings
Initial value: 0

This setting affects mesh that is converted from another object using the
MESHSMOOTH (page 640) command. (For a complete list of objects that can
be converted to mesh, see Objects That Can Be Converted to Mesh (page 641).)

Permissible values range from 0 to 1023. Setting 0 (zero) turns off the setting.
The value of this system variable cannot exceed the value of FACETERMAX-
GRID (page 1329)/FACETERMINVGRID (page 1330).

NOTE The value of this system variable reflects the value for objects with no
smoothness.

SEE ALSO:
Create Meshes by Conversion

FACETERMINVGRID

Sets the minimum number of V grid lines for solids and surfaces that are
converted to mesh.

Type: Integer
Saved in: User-settings
Initial value: 0

This setting affects mesh that is converted from a 3D solid or surface object
using the MESHSMOOTH (page 640) command. (For a complete list of objects
that can be converted to mesh, see Objects That Can Be Converted to Mesh
(page 641).)
Permissible values range from 0 to 1023. Setting 0 (zero) turns off the setting. The value of this system variable cannot exceed the value of FACETERMAXGRID (page 1329)/FACETERMINUGRID (page 1330).

**NOTE** The value of this system variable reflects the value for objects with no smoothness.

See also:

Create Meshes by Conversion

**FACETERPRIMITIVEMODE**

Specifies whether the smoothness settings for objects that are converted to a mesh.

<table>
<thead>
<tr>
<th>Type:</th>
<th>Bitcode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>User-settings</td>
</tr>
<tr>
<td>Initial value:</td>
<td>1</td>
</tr>
</tbody>
</table>

- 0 : Applies settings from the FACETERSMOOTHLEV system variable to the converted object.
- 1 : Applies settings from the DIVMESH* system variables to the converted object.

This setting affects a mesh that is converted from a primitive 3D solid object (such as box or cone) using the MESHSMOOTH (page 640) command. (For a complete list of objects that can be converted to mesh, see Objects That Can Be Converted to Mesh (page 641).)

See also:

Create Meshes by Conversion

**FACETERSMOOTHLEV**

Sets the default level of smoothness for objects that are converted to mesh.

<table>
<thead>
<tr>
<th>Type:</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>User-settings</td>
</tr>
</tbody>
</table>

F System Variables | 1331
**Initial value:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-1 or any negative number</td>
<td>Does not smooth the object after conversion</td>
</tr>
<tr>
<td>0</td>
<td>Does not smooth the object after conversion</td>
</tr>
<tr>
<td>1</td>
<td>Applies smoothness level 1 after conversion</td>
</tr>
<tr>
<td>2</td>
<td>Applies smoothness level 2 after conversion</td>
</tr>
<tr>
<td>3</td>
<td>Applies smoothness level 3 after conversion</td>
</tr>
</tbody>
</table>

This variable sets the default level of smoothness that is applied to mesh that is created as a result of conversion from another object with the MESHSMOOTH (page 640) command.

The value cannot be greater than the value of SMOOTHMESHMAXLEV (page 1481).

Mesh objects that are created under the following circumstances are always created without smoothness, and are not affected by this system variable:

- Mesh created using REVSURF (page 917), TABSURF (page 1073), RULESURF (page 924), or EDGESURF (page 403)
- Mesh created using MESHSMOOTH when the type of mesh is set to be quadrilateral or triangular (FACETERMESHTYPE (page 1329))

For a complete list of objects that can be converted to mesh, see Objects That Can Be Converted to Mesh (page 641).

**See also:**

Create Meshes by Conversion

**FACETRATIO**

Controls the aspect ratio of faceting for cylindrical and conic solids.

**Type:** Integer  
**Saved in:** Not-saved
**Initial value:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Creates an $N$ by 1 mesh for cylindrical and conic solids</td>
</tr>
<tr>
<td>1</td>
<td>Creates an $N$ by $M$ mesh for cylindrical and conic solids</td>
</tr>
</tbody>
</table>

A setting of 1 increases the density of the mesh to improve the quality of rendered and shaded models. The faceting is visible only in the 2D Wireframe visual style.

**See also:**
- Create 3D Solid Primitives

**FACETRES**

Adjusts the smoothness of shaded and rendered objects and objects with hidden lines removed.

**Type:** Real

**Saved in:** Drawing

**Initial value:** 0.5000

Valid values are from 0.01 to 10.0.

**See also:**
- Balance Mesh Density for Smooth Geometry

**FIELDDISPLAY**

Controls whether fields are displayed with a gray background.

**Type:** Integer

**Saved in:** Registry

**Initial value:** 1

The background is not plotted.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Fields are displayed with no background</td>
</tr>
</tbody>
</table>
Fields are displayed with a gray background

See also:
Update Fields

**FIELDVAL**

Controls how fields are updated.

**Type:** Integer

**Saved in:** Drawing

**Initial value:** 31

The setting is stored as a bitcode using the sum of the following values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Not updated</td>
</tr>
<tr>
<td>1</td>
<td>Updated on open</td>
</tr>
<tr>
<td>2</td>
<td>Updated on save</td>
</tr>
<tr>
<td>4</td>
<td>Updated on plot</td>
</tr>
<tr>
<td>8</td>
<td>Not used</td>
</tr>
<tr>
<td>16</td>
<td>Updated on regeneration</td>
</tr>
</tbody>
</table>

**NOTE** The Date field is updated by `UPDATEFIELD` (page 1135), but it is not updated automatically based on the setting of the FIELDEVAL system variable.

See also:
Update Fields

**FILEDIA**

Suppresses display of file navigation dialog boxes.
Integer
Type: Registry
Saved in: Initial value:

<table>
<thead>
<tr>
<th>0</th>
<th>Does not display dialog boxes. You can still request a file dialog box to appear by entering a tilde (~) in response to the command's prompt. The same is true for AutoLISP and ObjectARX.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Displays dialog boxes. However, if a script or AutoLISP/ObjectARX™ program is active, an ordinary prompt is displayed.</td>
</tr>
</tbody>
</table>

See also:

Switch Between Dialog Boxes and the Command Line

**FILLETRAD**

Stores the current fillet radius for 2D objects.

**Type:** Real

**Saved in:** Drawing

**Initial value:** 0.0000

If you use the FILLET (page 436) command to change the radius of a 2D fillet, the value of this system variable changes to match.

See also:

Create Fillets

**FILLETRAD3D**

Stores the current fillet radius for 3D objects.

**Type:** Real

**Saved in:** Drawing

**Initial value:** 1.0000

Stores the default radius for 3D solid and surface fillets created with the FILLETEDGE (page 440) and SURFFILLET (page 1051) commands. If you change the radius while using the FILLETEDGE or SURFFILLET commands, the FILLETTRAD system variable does **not** update to this new value.
See also:
Fillet a Surface
Modify Edges on 3D Objects

FILLMODE

Specifies whether hatches and fills, 2D solids, and wide polylines are filled in.

Type: Integer
Saved in: Drawing
Initial value: 1

0 | Objects are not filled

1 | Objects are filled

See also:
Control the Display of Polylines, Hatches, Gradient Fills, Lineweights, and Text

FONTALT

Specifies the alternate font to be used when the specified font file cannot be located.

Type: String
Saved in: Registry
Initial value: simplex.shx

When a drawing file with a defined text style is opened and an alternate font is not specified, the Alternate Font dialog box is displayed.

See also:
Substitute Fonts
**FONTMAP**

Specifies the font mapping file to be used.

**Type:** String  
**Saved in:** Registry  
**Initial value:** acad.fmp

A font mapping file contains one font mapping per line; the original font used in the drawing and the font to be substituted for it are separated by a semicolon (;). For example, to substitute the Times TrueType font for the Roman font, the line in the mapping file would read as follows:

```
romanc.shx;times.ttf
```

If FONTMAP does not point to a font mapping file, if the FMP file is not found, or if the font file name specified in the FMP file is not found, the font defined in the style is used. If the font in the style is not found, a font is substituted according to the substitution rules.

FONTMAP affects the creation, editing, and display of all text objects.

**See also:**  
Substitute Fonts

**FRAME**

Controls the display of frames for all images, PDF underlays, clipped xrefs, and wipeout objects.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 3

The FRAME setting overrides the individual IMAGEFRAME (page 1369), PDF- FRAME (page 1427), XCLIPFRAME (page 1572), and WIPEOUTFRAME (page 1570) settings.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>The frame is not visible and it is not plotted. The frame temporarily reappears during selection preview or object selection.</td>
</tr>
</tbody>
</table>

F System Variables | 1337
<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Displays and plots the frame.</td>
</tr>
<tr>
<td>2</td>
<td>Displays but does not plot the frame.</td>
</tr>
<tr>
<td>3</td>
<td>The individual setting varies for all external references in the current</td>
</tr>
<tr>
<td></td>
<td>drawing (raster images, underlays, clipped xrefs, and wipeout objects all</td>
</tr>
<tr>
<td></td>
<td>have different frame settings).</td>
</tr>
</tbody>
</table>

**See also:**
- Hide and Show PDF Underlay Frames
- Show and Hide Raster Image Boundaries
- Update Referenced Drawing Attachments
- Create a Blank Area to Cover Objects

**FRAMESELECTION**

Controls whether the frame of an image, PDF underlay, clipped xref, or wipeout objects can be selected.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Hidden frames cannot be selected.</td>
</tr>
<tr>
<td>1</td>
<td>Hidden frames can be selected.</td>
</tr>
</tbody>
</table>

**NOTE** The PREVIEWFILTER (page 1444) system variable may prevent the frame from redisplaying during selection preview, but the frame can still be selected.

**See also:**
- Clip External References and Blocks
- Hide and Show PDF Underlay Frames
- Show and Hide Raster Image Boundaries
- Create a Blank Area to Cover Objects
FRONTZ

Stores the front clipping plane offset from the target plane for the current viewport, in drawing units.

(Read-only)

**Type:** Real

**Saved in:** Drawing

**Initial value:** 0.0000

The front clipping and front clip not at eye bitcodes in `VIEWMODE` (page 1535) are on. The FRONTZ value is the last front clipping plane value set current with the `DVIEW` command. The distance of the front clipping plane from the camera point is found by subtracting FRONTZ from the camera-to-target distance.

**See also:**

Create a 3D Dynamic View (`DVIEW`)

FULLPLOTPATH

Controls whether the full path of the drawing file is sent to the plot spooler.

**Type:** Integer

**Saved in:** Registry

**Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Sends the drawing file name only</td>
</tr>
<tr>
<td>1</td>
<td>Sends the full path of the drawing file</td>
</tr>
</tbody>
</table>

**See also:**

Print or Plot Drawings
G System Variables

GEOMARKERVISIBILITY

Controls the visibility of geographic markers.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Geographic marker is not visible</td>
</tr>
<tr>
<td>1</td>
<td>Geographic marker is visible</td>
</tr>
</tbody>
</table>

GFANG

Specifies the angle of a gradient fill.

**Type:** Real  
**Saved in:** Not-saved  
**Initial value:** 0

Valid values range from 0 to less than 360 (degrees). Negative values and values equal to or greater than 360 are accepted, but they are converted to the equivalent value between 0 and 360.

See also:  
Choose a Hatch Pattern or Fill

GFCLR1

Specifies the color for a one-color gradient fill or the first color for a two-color gradient fill.

**Type:** String  
**Saved in:** Not-saved  
**Initial value:** "Blue"
Valid values include the following:

- AutoCAD Color Index (ACI): integer values from 1 to 255, or a color name from the first seven colors
- True Colors: RGB or HSL values from 000 to 255 in the form "RGB:130,200,240"
- Color Books: Text from standard color books, guides, or sets, for example "DIC COLOR GUIDE(R)$DIC 43"

See also:
Choose a Hatch Pattern or Fill

**GFCLR2**

Specifies the second color for a two-color gradient fill.

**Type:** String  
**Saved in:** Not-saved  
**Initial value:** "Yellow"

Valid values include the following:

- AutoCAD Color Index (ACI): integer values from 1 to 255, or a color name from the first seven colors
- True Colors: RGB or HSL values from 000 to 255 in the form "RGB:130,200,240"
- Color Books: Text from standard color books, guides, or sets, for example "DIC COLOR GUIDE(R)$DIC 43"

See also:
Choose a Hatch Pattern or Fill

**GFCLRLUM**

Controls the tint or shade level in a one-color gradient fill.

**Type:** Real  
**Saved in:** Not-saved  
**Initial value:** 1.0000
A tint gradient transitions toward white and a shade gradient transitions toward black. Valid values range from 0.0 (darkest) to 1.0 (lightest).

See also:

Choose a Hatch Pattern or Fill

**GFCLRSTATE**

Specifies whether a gradient fill uses one color or two colors.

<table>
<thead>
<tr>
<th>Type:</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>Not-saved</td>
</tr>
<tr>
<td>Initial value:</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Two-color gradient fill</td>
</tr>
<tr>
<td>1</td>
<td>One-color gradient fill</td>
</tr>
</tbody>
</table>

See also:

Choose a Hatch Pattern or Fill

**GFNAME**

Specifies the pattern of a gradient fill.

<table>
<thead>
<tr>
<th>Type:</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>Not-saved</td>
</tr>
<tr>
<td>Initial value:</td>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Linear</td>
</tr>
<tr>
<td>2</td>
<td>Cylindrical</td>
</tr>
<tr>
<td>3</td>
<td>Inverted cylindrical</td>
</tr>
<tr>
<td>4</td>
<td>Spherical</td>
</tr>
</tbody>
</table>
Hemispherical
Curved
Inverted spherical
Inverted hemispherical
Inverted curved

See also:
Choose a Hatch Pattern or Fill

**GFSHIFT**

Specifies whether the pattern in a gradient fill is centered or is shifted up and to the left.

**Type:** Integer  
**Saved in:** Not-saved  
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Centered</td>
</tr>
<tr>
<td>1</td>
<td>Shifted up and to the left</td>
</tr>
</tbody>
</table>

See also:
Choose a Hatch Pattern or Fill

**GRIDDISPLAY**

Controls the display behavior and display limits of the grid.

**Type:** Bitcode  
**Saved in:** Drawing  
**Initial value:** 3

G System Variables | 1343
The setting is stored as a bitcode using the sum of the following values:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Restricts the grid to the area specified by the LIMITS command</td>
</tr>
<tr>
<td>1</td>
<td>Does not restrict the grid to the area specified by the LIMITS command</td>
</tr>
<tr>
<td>2</td>
<td>Turns on adaptive grid display, which limits the density of the grid when zoomed out</td>
</tr>
<tr>
<td>4</td>
<td>If the grid is set to adaptive display and when zoomed in, generates additional, more closely spaced grid lines in the same proportion as the intervals of the major grid lines</td>
</tr>
<tr>
<td>8</td>
<td>Changes the grid plane to follow the XY plane of the dynamic UCS.</td>
</tr>
</tbody>
</table>

**NOTE** Setting 4 is ignored unless setting 2 is specified.

**See also:**
Adjust Grid and Grid Snap

**GRIDMAJOR**

Controls the frequency of major grid lines compared to minor grid lines.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 5

Valid values range from 1 to 100.  
Grid lines are displayed in any visual style.

**See also:**
Adjust Grid and Grid Snap
GRIDMODE

Specifies whether the grid is turned on or off.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Turns the grid off</td>
</tr>
<tr>
<td>1</td>
<td>Turns the grid on</td>
</tr>
</tbody>
</table>

See also:  
Adjust Grid and Grid Snap

GRIDSTYLE

Controls the style of grid displayed for 2D model space, Block Editor, 3D parallel projection, 3D perspective projection, and Sheet and Layout tabs.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:**

The setting is stored as an integer using the sum of the following values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Displays lined grid for 2D model space, Block Editor, 3D parallel projection, 3D perspective projection, and Sheet and Layout.</td>
</tr>
<tr>
<td>1</td>
<td>Displays dotted grid for 2D model space.</td>
</tr>
<tr>
<td>2</td>
<td>Displays dotted grid for Block Editor.</td>
</tr>
<tr>
<td>4</td>
<td>Displays dotted grid for Sheet and Layout.</td>
</tr>
</tbody>
</table>

See also:  
Adjust Grid and Grid Snap
GRIDUNIT

Specifies the grid spacing (X and Y) for the current viewport.

Type: 2D-point  
Saved in: Drawing  
Initial value: 0.5000, 0.5000 (imperial) or 10,10 (metric)

To make the grid spacing default to the snap spacing, set GRIDUNIT to 0,0. Changes to GRIDUNIT are not displayed in the grid until the view is regenerated.

See also:

Adjust Grid and Grid Snap

GRIPBLOCK

Controls the display of grips in blocks.

Type: Integer  
Saved in: Registry  
Initial value: 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Assigns a grip only to the insertion point of the block</td>
</tr>
<tr>
<td>1</td>
<td>Assigns grips to objects within the block</td>
</tr>
</tbody>
</table>

See also:

Control Grips in Blocks

GRIPCOLOR

Controls the color of unselected grips.

Type: Integer  
Saved in: Registry  
Initial value: 150

The valid range is 1 to 255.
See also:
   Use Object Grips

**GRIPCONTOUR**

Controls the color of the grip contour.

- **Type:** Integer
- **Saved in:** Registry
- **Initial value:** 251

The valid range is 1 to 255.

See also:
   Use Object Grips

**GRIPDYNCOLOR**

Controls the color of custom grips for dynamic blocks.

- **Type:** Integer
- **Saved in:** Registry
- **Initial value:** 140

The valid range is 1 to 255.

See also:
   Work with Dynamic Blocks in Drawings

**GRIPHOT**

Controls the color of selected grips.

- **Type:** Integer
- **Saved in:** Registry
- **Initial value:** 12

The valid range is 1 to 255.
See also:
Use Object Grips

**GRIPHOVER**

Controls the fill color of an unselected grip when the cursor pauses over it.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 11

The valid range is 1 to 255.

See also:
Use Object Grips

**GRIPMULTIFUNCTIONAL**

Specifies the access methods for multi-functional grip options.

**Type:** Bitcode  
**Saved in:** Registry  
**Initial value:** 3

<table>
<thead>
<tr>
<th>Value</th>
<th>Access Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Access to multi-functional grips is disabled</td>
</tr>
<tr>
<td>1</td>
<td>Access multi-functional grips with Ctrl-cycling and the Hot Grip shortcut menu</td>
</tr>
<tr>
<td>2</td>
<td>Access multi-functional grips with the dynamic menu and the Hot Grip shortcut menu</td>
</tr>
<tr>
<td>3</td>
<td>Access multi-functional grips with Ctrl-cycling, the dynamic menu, and the Hot Grip shortcut menu</td>
</tr>
</tbody>
</table>

See also:
Choose a Method to Modify Objects  
Use Object Grips
**GRIPOBJLIMIT**

Suppresses the display of grips when the selection set includes more than the specified number of objects.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 100

The valid range is 0 to 32,767. For example, when set to 1, grips are suppressed when more than one object is selected. When set to 0, grips are always displayed.

**See also:**  
Use Object Grips

---

**GRIPS**

Controls the display of grips on selected objects.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 2

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Hides grips</td>
</tr>
<tr>
<td>1</td>
<td>Displays grips</td>
</tr>
<tr>
<td>2</td>
<td>Displays additional midpoint grips on polyline segments</td>
</tr>
</tbody>
</table>

To adjust the size of the grips and the effective selection area used by the cursor when you snap to a grip, use **GRIPSIZE** (page 1349).

**See also:**  
Use Object Grips

---

**GRIPSIZE**

Sets the size of the grip box in pixels.
**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 5

The valid range is 1 to 255.

See also:  
Use Object Grips

---

**GRIPSUBOBJMODE**

Controls whether grips are automatically selected (made “hot”) when subobjects are selected.

**Type:** Bitcode  
**Saved in:** Registry  
**Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Does not turn grips hot when subobjects are selected.</td>
</tr>
<tr>
<td>1</td>
<td>Turns the face, edge, or vertex grips hot when subobjects of 3D objects (solid, surface, or mesh) are selected.</td>
</tr>
<tr>
<td>2</td>
<td>Turns the grips hot when subobjects of 2D polyline objects (line or arc segments) are selected.</td>
</tr>
</tbody>
</table>
| 3     | Turns the grips hot when subobjects of  
|       | - 3D objects (faces, edges, or vertices) are selected  
|       | - 2D polyline objects (line or arc segments) are selected |

Setting this system variable to 1 is especially helpful for quickly modifying groups of faces, edges, and vertices on mesh objects.

See also:  
Use Grips to Edit 3D Solids and Surfaces  
Choose a Method to Modify Objects
**GRIPTIPS**

Controls the display of grip tips when the cursor hovers over grips on dynamic blocks and custom objects that support grip tips.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Turns off the display of grip tips.</td>
</tr>
<tr>
<td>1</td>
<td>Turns on the display of grip tips.</td>
</tr>
</tbody>
</table>

**See also:**
- Use Object Grips
- Choose a Method to Modify Objects

**GROUPDISPLAYMODE**

Controls the display and grips on groups, when group selection is on.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 2

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Displays grips on all objects in the selected group</td>
</tr>
<tr>
<td>1</td>
<td>Displays a single grip at the center of the grouped objects</td>
</tr>
<tr>
<td>2</td>
<td>Displays the group bounding box with a single grip at the center</td>
</tr>
</tbody>
</table>

Group selection is enabled by setting the `PICKSTYLE` (page 1435) system variable to 1 or 3.

**See also:**
- Select Objects in Groups
GROUPLAYERDELETABLE

Controls what happens to the layers referenced by a layer group when the group is deleted.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Layers referenced by a layer group are not removed from the drawing when the group is deleted.</td>
</tr>
<tr>
<td>1</td>
<td>You are prompted on how to handle the deletion of layers referenced by the layer group being deleted. When deleting the referenced layers, you will be prompted on how to handle layers that contain objects on them.</td>
</tr>
</tbody>
</table>

See also:

The Layers Palette

GROUPSONTOP

Controls how layer groups are sorted in the Layers palette.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Layers and layer groups are sorted together and alphanumerically by name</td>
</tr>
<tr>
<td>1</td>
<td>Layers and layer groups are sorted separately, layer groups appear at the top of the Layers list</td>
</tr>
</tbody>
</table>
Layers and layer groups are sorted separately, layer groups appear at the bottom of the Layers list.

See also:
The Layers Palette

**GTAUTO**

Controls whether 3D gizmos are automatically displayed when you select objects before you start a command in a viewport with a 3D visual style.

- **Type:** Integer
- **Saved in:** Registry
- **Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Gizmos are not displayed automatically when you select objects before starting a command.</td>
</tr>
<tr>
<td>1</td>
<td>Gizmos are displayed automatically after you create a selection set.</td>
</tr>
</tbody>
</table>

This system variable affects the display of the 3D Move, 3D Rotate, and 3D Scale gizmos. Gizmos were previously known as “grip tools.”

See also:
Use the Gizmos

**GTDEFAULT**

Controls whether the 3D Move, 3D Rotate, or 3D Scale operation starts automatically when you start the MOVE, ROTATE, or SCALE command in a viewport with a 3D visual style.

- **Type:** Integer
- **Saved in:** Registry
**Initial value:** 0

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Does not automatically start the 3DMOVE (page 36), 3DROTATE (page 47), or 3DSCALE (page 50) commands when the MOVE (page 674), ROTATE (page 919), or SCALE (page 928) commands are started in a 3D view.</td>
</tr>
<tr>
<td>1</td>
<td>Automatically starts the 3DMOVE, 3DROTATE, or 3DScale commands when the MOVE, ROTATE, or SCALE commands are started in a 3D view.</td>
</tr>
</tbody>
</table>

**See also:**

Use the Gizmos

---

**GTLOCATION**

Controls the initial location of the 3D Move, 3D Rotate, or 3D Scale gizmo when you select objects before you start a command in a viewport with a 3D visual style.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 1

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Places the 3D Move, 3D Rotate, or 3D Scale gizmo at the same location as the UCS icon. The gizmo orientation is aligned with the current UCS.</td>
</tr>
<tr>
<td>1</td>
<td>Places the 3D Move, 3D Rotate, or 3D Scale gizmo at the geometric center of the selection set.</td>
</tr>
</tbody>
</table>

This system variable affects the display of the 3D Move, 3D Rotate, and 3D Scale gizmos. Gizmos were previously known as “grip tools.”

**See also:**

Use the Gizmos
H System Variables

HALOGAP

Specifies a gap to be displayed where an object is hidden by another object.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0

The value is specified as a percent of one unit and is independent of the zoom level.

HALOGAP is available only in 2D views. In 3D views, the VSHALOGAP (page 1553) system variable is used.

See also:

- Use a Visual Style to Display Your Model

HANDLES

Reports whether object handles can be accessed by applications.

(Read-only)  
**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** On

Because handles can no longer be turned off, has no effect except to preserve the integrity of scripts.

See also:

- Overview of Command Scripts

HELPPREFIX

Sets the file path for the Help system.

**Type:** String  
**Saved in:** Registry
Initial value: Varies

See also:
Set Up the Drawing Area
Application Tab (Application Preferences Dialog Box)  (page 738)

HIDEPRECISION

Controls the accuracy of hides and shades.

Type: Integer
Saved in: Not-saved
Initial value: 0

Hides can be calculated in double precision or single precision. Setting HIDEPRECISION to 1 produces more accurate hides by using double precision, but this setting also uses more memory and can affect performance, especially when hiding solids.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Single precision; uses less memory</td>
</tr>
<tr>
<td>1</td>
<td>Double precision; uses more memory</td>
</tr>
</tbody>
</table>

See also:
Shade a Model and Use Edge Effects

HIDETEXT

Specifies whether text objects created by the TEXT or MTEXT command are processed during a HIDE command.

Type: Switch
Saved in: Drawing
Initial value: On

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Text is not hidden and does not hide other objects</td>
</tr>
<tr>
<td>On</td>
<td>Text is hidden but does not hide other objects</td>
</tr>
</tbody>
</table>
See also:
  Shade a Model and Use Edge Effects

**HIGHLIGHT**

Controls object highlighting; does not affect objects selected with grips.

Type: Integer
Saved in: Not-saved
Initial value: 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Turns off object selection highlighting</td>
</tr>
<tr>
<td>1</td>
<td>Turns on object selection highlighting</td>
</tr>
</tbody>
</table>

See also:
  Customize Object Selection

**HPANG**

Sets the angle for new hatch patterns.

Type: Real
Saved in: Not-saved
Initial value: 0.0000

See also:
  Overview of Hatch Patterns and Fills

**HPANNOTATIVE**

Controls whether a new hatch pattern is annotative.

Type: Integer
Saved in: Drawing
**Initial value:** 0

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Nonannotative</td>
</tr>
<tr>
<td>1</td>
<td>Annotative</td>
</tr>
</tbody>
</table>

See also:
Overview of Scaling Annotations

**HPASSOC**

Controls whether hatches and fills are associative.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 1

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Hatches and fills are not associated with their defining boundary objects</td>
</tr>
<tr>
<td>1</td>
<td>Hatches and fills are associated with their defining boundary objects and are updated when the boundary objects change</td>
</tr>
</tbody>
</table>

See also:
Specify Hatch and Fill Areas

**HPBACKGROUND COLOR**

Controls the background color for hatch patterns.

**Type:** String  
**Saved in:** Drawing  
**Initial value:** None

Valid values include the following:
- “None” or “.” for no background color
- AutoCAD Color Index (ACI): integer values from 1 to 255, or a color name from the first seven colors
True Colors: RGB or HSL values from 000 to 255 in the form "RGB:130,200,240"
Color Books: Text from standard color books, guides, or sets, for example "DIC COLOR GUIDE(R)DIC 43"

See also:
Set Property Overrides for Hatches and Fills

**HPBOUND**

Controls the object type created by HATCH and BOUNDARY.

**Type:** Integer  
**Saved in:** Not-saved  
**Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Creates a region</td>
</tr>
<tr>
<td>1</td>
<td>Creates a polyline</td>
</tr>
</tbody>
</table>

A polyline or region object is created only if the HPBOUNDRETAIN system variable is turned on.

See also:
Specify Hatch and Fill Areas

**HPBOUNDRETAIN**

Controls whether boundary objects are created for new hatches and fills.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Does not create boundary objects</td>
</tr>
<tr>
<td>1</td>
<td>Creates boundary objects according to the HPBOUND system variable</td>
</tr>
</tbody>
</table>
See also:
    Specify Hatch and Fill Areas

**HPCOLOR**

Sets a default color for new hatches.

**Type:** String  
Saved in: Drawing  
Initial value: use current

Valid values include the following:
- “.” to use the current color set in the CECOLOR system variable
- ByLayer or ByBlock
- AutoCAD Color Index (ACI): integer values from 1 to 255, or a color name from the first seven colors
- True Colors: RGB or HSL values from 000 to 255 in the form "RGB:130,200,240"
- Color Books: Text from standard color books, guides, or sets, for example "DIC COLOR GUIDE(R)$DIC 43"

Values other than the “.” (use current) value override the current color (CECOLOR).

See also:
    Set Property Overrides for Hatches and Fills

**HPDLGMODE**

Controls the display of the Hatch and Gradient dialog box and the Hatch Edit dialog box.

**Type:** Integer  
Saved in: User-settings  
Initial value: 2

0 or 2  | Hatch and Gradient dialog box is not displayed for HATCH and GRADIENT unless Settings is entered at the Command prompt.
Hatch and Gradient dialog box is displayed for HATCH and GRADIENT.

See also:
Overview of Hatch Patterns and Fills

HPDOUBLE

Specifies hatch pattern doubling for user-defined patterns.

Type: Integer
Saved in: Not-saved
Initial value: 0

Doubling specifies a second set of lines drawn at 90 degrees to the original lines.

- 0: Turns off hatch pattern doubling
- 1: Turns on hatch pattern doubling

See also:
Choose a Hatch Pattern or Fill

HPDRAWORDER

Controls the draw order of hatches and fills.

Type: Integer
Saved in: Not-saved
Initial value: 3

Controls whether hatch and fill objects are displayed in front or behind all other objects, or in front or behind their associated boundaries.

- 0: None. The hatch or fill is not assigned a draw order.
- 1: Send to back. The hatch or fill is sent to the back of all other objects.
2 Bring to front. The hatch or fill is brought to the front of all other objects.

3 Send behind boundary. The hatch or fill is sent behind the hatch’s boundary objects.

4 Bring in front of boundary. The hatch or fill is brought in front of the hatch’s boundary objects.

See also:
Set Property Overrides for Hatches and Fills

HPGAPTOL
Treats a set of objects that almost enclose an area as a closed hatch boundary.

Type: Real
Saved in: Registry
Initial value: 0.0000

The default value, 0, specifies that the objects enclose the area, with no gaps. Enter a value, in drawing units, from 0 to 5000 to set the maximum size of gaps that can be ignored when the objects serve as a hatch boundary.

See also:
Specify Hatch and Fill Areas

HPINHERIT
Controls whether to inherit the hatch origin when using the Inherit Properties option in HATCH and HATCHEDIT.

Type: Integer
Saved in: Drawing
Initial value: 0

0 The hatch origin is taken from HPORIGIN
The hatch origin is taken from the source hatch object.

See also:
Modify Hatch Alignment, Scale, and Rotation

**HPISLANDDETECTION**

Controls how islands within the hatch boundary are treated.

<table>
<thead>
<tr>
<th>Type: Integer</th>
<th>Saved in: Drawing</th>
<th>Initial value: 1</th>
</tr>
</thead>
</table>
| 0 Normal. Hatches islands within islands.
| 1 Outer. Hatches only areas outside of islands.
| 2 Ignore. Hatches everything within the boundaries.

An island is an enclosed area within the area to be hatched.

See also:
Specify Hatch and Fill Areas

**HPISLANDDETECTIONMODE**

Controls whether internal closed boundaries, called islands, are detected.

<table>
<thead>
<tr>
<th>Type: Integer</th>
<th>Saved in: Drawing</th>
<th>Initial value: 1</th>
</tr>
</thead>
</table>
| 0 Off
| 1 On (recommended). Hatches or ignores islands according to HPISLANDDETECTION. |
See also:
  Specify Hatch and Fill Areas

**HPLAYER**

Specifies a default layer for new hatches and fills.

*Type:* String  
*Saved in:* Drawing  
*Initial value:* use current

Values other than the “.” (use current) value override the current layer (CELAYER).

See also:
  Set Property Overrides for Hatches and Fills

**HPMAXAREAS**

Sets the maximum number of enclosed areas that a single hatch object can have and still automatically switch between solid and pattern hatches during zoom operations.

*Type:* Real  
*Saved in:* Registry  
*Initial value:* 100

Valid values are from 0 to 10,000,000.

See also:
  Control the Scale of Hatch Patterns

**HPMAXLINES**

Sets the maximum number of hatch lines that are generated in a hatch operation.

*Type:* Real  
*Saved in:* Registry  
*Initial value:* 1000000
Valid values are from 100 to 10,000,000.

See also:

Control the Scale of Hatch Patterns

**HPNAME**

Sets the default hatch pattern name.

**Type:** String  
**Saved in:** Not-saved  
**Initial value:** ANSI31 (imperial) or ANGLE (metric)

Valid names can contain up to 34 characters without spaces. The value "" indicates that there is no default. Enter a period (.) to reset HPNAME to the default value.

See also:

Choose a Hatch Pattern or Fill

**HPOBJWARNING**

Sets the number of hatch boundary objects that can be selected before displaying a warning message.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 10000

The maximum value can vary, but is significantly larger than 100000000 (one hundred million).

See also:

Control the Scale of Hatch Patterns

**HPORIGIN**

Sets the hatch origin point for new hatch patterns relative to the current user coordinate system.
Type: 2D-point
Saved in: Drawing
Initial value: 0.0000, 0.0000

See also:
Control the Hatch Origin Point

**HPORIGINMODE**

Controls how the default hatch origin point is determined.

Type: Integer
Saved in: Registry
Initial value: 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Uses HPORIGIN</td>
</tr>
<tr>
<td>1</td>
<td>Uses the bottom-left corner of the rectangular extents of the hatch boundaries</td>
</tr>
<tr>
<td>2</td>
<td>Uses the bottom-right corner of the rectangular extents of the hatch boundaries</td>
</tr>
<tr>
<td>3</td>
<td>Uses the top-right corner of the rectangular extents of the hatch boundaries</td>
</tr>
<tr>
<td>4</td>
<td>Uses the top-left corner of the rectangular extents of the hatch boundaries</td>
</tr>
<tr>
<td>5</td>
<td>Uses the center of the rectangular extents of the hatch boundaries</td>
</tr>
</tbody>
</table>

See also:
Control the Hatch Origin Point

**HPQUICKPREVIEW**

Controls whether a hatch preview is displayed when specifying a hatch area.
**Type:** Switch  
**Saved in:** User-settings  
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 or OFF</td>
<td>No preview</td>
</tr>
<tr>
<td>1 or ON</td>
<td>Quick preview</td>
</tr>
</tbody>
</table>

**See also:**  
Specify Hatch and Fill Areas

---

**HPQUICKPREVTIMEOUT**

Sets the maximum time for a hatch preview to generate before the preview is automatically cancelled.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 2

If the specified duration is reached, and the preview is not complete, the preview is cancelled, but the command remains active.

The duration is measured in seconds. Valid values range from 1 to 300.

**NOTE** The `HPQUICKPREVIEW` (page 1366) system variable controls whether a preview is generated when using the `HATCH` (page 473) command.

**See also:**  
Specify Hatch and Fill Areas

---

**HPSCALE**

Sets the hatch pattern scale factor.

**Type:** Real  
**Saved in:** Not-saved  
**Initial value:** 1.0000
See also:
  Control the Scale of Hatch Patterns

**HPSEPARATE**

Controls whether a single hatch object or separate hatch objects are created when operating on several closed boundaries.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>A single hatch object is created</td>
</tr>
<tr>
<td>1</td>
<td>Separate hatch objects are created</td>
</tr>
</tbody>
</table>

See also:
  Specify Hatch and Fill Areas

**HPSPACE**

Sets the hatch pattern line spacing for user-defined patterns.

**Type:** Real  
**Saved in:** Not-saved  
**Initial value:** 1.0000

See also:
  Control the Scale of Hatch Patterns

**HPTRANSPARENCY**

Sets the default transparency for new hatches and fills.

**Type:** String  
**Saved in:** Drawing  
**Initial value:** use current
Valid values include “use current” (or “.”), ByLayer, ByBlock, and integer values from 0 to 90. The higher the value, the more transparent the hatch.

Values other than “use current” or “.” override the current transparency (CETRANSPARENCY (page 1226)).

Changing this value does not affect existing hatch objects.

See also:
Set Property Overrides for Hatches and Fills

I System Variables

ICONSIZE

Controls the size of the icons displayed on the Tool Sets palette and status bar.

Type: Integer
Saved in: Registry
Initial value: 16

Valid values are from 16 to 32.

See also:
The Tool Sets Palette
The Status Bar

IMAGEFRAME

Controls whether image frames are displayed and plotted.

Type: Integer
Saved in: Drawing
Initial value: 1
The FRAME (page 1337) system variable overrides the IMAGEFRAME setting. Use the IMAGEFRAME system variable after the FRAME system variable to reset the image frame settings.

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>The image frame is not displayed or plotted. The frame temporarily reappears during selection preview or object selection.</td>
</tr>
<tr>
<td>1</td>
<td>Displays and plots the image frame.</td>
</tr>
<tr>
<td>2</td>
<td>Displays but does not plot the image frame.</td>
</tr>
</tbody>
</table>

**See also:**
Show and Hide Raster Image Boundaries

**IMAGEHLT**
Controls whether the entire raster image or only the raster image frame is highlighted.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 0

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Highlights only the raster image frame</td>
</tr>
<tr>
<td>1</td>
<td>Highlights the entire raster image</td>
</tr>
</tbody>
</table>

**See also:**
Improve the Display Speed of Raster Images

**IMPLIEDFACE**
Controls the detection of implied faces.

**Type:** Integer  
**Saved in:** Registry
**Initial value:**

<table>
<thead>
<tr>
<th></th>
<th>Implied faces cannot be detected.</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Implied faces can be detected.</td>
</tr>
</tbody>
</table>

An *implied face* is a closed area that creates a boundary by intersecting or overlapping a face on a 3D solid object.

This variable affects the ability to use implied faces when you press Ctrl-Shift-E and drag the area inside the boundary to create an extrusion dynamically.

This variable must be set to 1 if you want to select and modify implied faces.

**See also:**

Pressing or Pulling Areas, Faces, and Edges

**INDEXCTL**

Controls whether layer and spatial indexes are created and saved in drawing files.

**Type:** Integer

**Saved in:** Drawing

**Initial value:** 0

To receive the maximum benefit of demand loading, it is recommended that you save any drawings that are used as xrefs with layer and spatial indexes.

<table>
<thead>
<tr>
<th></th>
<th>No indexes are created</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Layer index is created</td>
</tr>
<tr>
<td>2</td>
<td>Spatial index is created</td>
</tr>
<tr>
<td>3</td>
<td>Layer and spatial indexes are created</td>
</tr>
</tbody>
</table>

**See also:**

Work with Layer and Spatial Indexes
INETLOCATION

Stores the Internet location used by the BROWSER command.

**Type:** String  
**Saved in:** Registry  
**Initial value:** http://www.autodesk.com

**See also:**  
Get Started with Internet Access

INPUTHISTORYMODE

Controls the content and location of the user input history.

**Type:** Bitcode  
**Saved in:** Registry  
**Initial value:** 15

The setting is stored as a bitcode using the sum of the following values:

<table>
<thead>
<tr>
<th>Bit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No history of recent input is displayed.</td>
</tr>
<tr>
<td>1</td>
<td>History of recent input is displayed at the command line or in a dynamic prompt tooltip. Access with the Up Arrow and Down Arrow keys at the Command prompt, or at an input prompt.</td>
</tr>
<tr>
<td>2</td>
<td>History of recent input for the current command is displayed in the shortcut menu under Recent Input.</td>
</tr>
<tr>
<td>4</td>
<td>History of recent input for all commands in the current session is displayed in the shortcut menu under Recent Input.</td>
</tr>
<tr>
<td>8</td>
<td>Markers for recent input of point locations are displayed. Use the arrow keys at the Command prompt for specifying a point location.</td>
</tr>
</tbody>
</table>

**See also:**  
The Command Line  
Work with Shortcut Menus
INSBASE

Stores the insertion base point set by BASE, which gets expressed as a UCS coordinate for the current space.

Type: 3D-point
Saved in: Drawing
Initial value: 0.0000, 0.0000, 0.0000

See also:
Insert Blocks

INSNAME

Sets a default block name for the INSERT command.

Type: String
Saved in: Not-saved
Initial value: ""

The name must conform to symbol naming conventions. Returns ** if no default is set. Enter a period (.) to set no default.

See also:
Insert Blocks

INSUNITS

Specifies a drawing-units value for automatic scaling of blocks, images, or xrefs when inserted or attached to a drawing.

Type: Integer
Saved in: Drawing
Initial value: 1 (imperial) or 4 (metric)

NOTE The INSUNITS setting is ignored when inserting annotative blocks into a drawing.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Unspecified (No units)</td>
</tr>
<tr>
<td></td>
<td>Units</td>
</tr>
<tr>
<td>---</td>
<td>------------------</td>
</tr>
<tr>
<td>1</td>
<td>Inches</td>
</tr>
<tr>
<td>2</td>
<td>Feet</td>
</tr>
<tr>
<td>3</td>
<td>Miles</td>
</tr>
<tr>
<td>4</td>
<td>Millimeters</td>
</tr>
<tr>
<td>5</td>
<td>Centimeters</td>
</tr>
<tr>
<td>6</td>
<td>Meters</td>
</tr>
<tr>
<td>7</td>
<td>Kilometers</td>
</tr>
<tr>
<td>8</td>
<td>Microinches</td>
</tr>
<tr>
<td>9</td>
<td>Mils</td>
</tr>
<tr>
<td>10</td>
<td>Yards</td>
</tr>
<tr>
<td>11</td>
<td>Angstroms</td>
</tr>
<tr>
<td>12</td>
<td>Nanometers</td>
</tr>
<tr>
<td>13</td>
<td>Microns</td>
</tr>
<tr>
<td>14</td>
<td>Decimeters</td>
</tr>
<tr>
<td>15</td>
<td>Dekameters</td>
</tr>
<tr>
<td>16</td>
<td>Hectometers</td>
</tr>
<tr>
<td>17</td>
<td>Gigameters</td>
</tr>
<tr>
<td>18</td>
<td>Astronomical Units</td>
</tr>
</tbody>
</table>
## Light Years

<table>
<thead>
<tr>
<th>19</th>
<th>Light Years</th>
</tr>
</thead>
</table>

## Parsecs

<table>
<thead>
<tr>
<th>20</th>
<th>Parsecs</th>
</tr>
</thead>
</table>

### See also:

Insert Blocks

## INSUNITSDFSOURCE

Sets source content units value when INSUNITS is set to 0.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 1  

Valid range is 0 to 20.

<table>
<thead>
<tr>
<th>0</th>
<th>Unspecified (No units)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Inches</td>
</tr>
<tr>
<td>2</td>
<td>Feet</td>
</tr>
<tr>
<td>3</td>
<td>Miles</td>
</tr>
<tr>
<td>4</td>
<td>Millimeters</td>
</tr>
<tr>
<td>5</td>
<td>Centimeters</td>
</tr>
<tr>
<td>6</td>
<td>Meters</td>
</tr>
<tr>
<td>7</td>
<td>Kilometers</td>
</tr>
<tr>
<td>8</td>
<td>Microinches</td>
</tr>
<tr>
<td>9</td>
<td>Mils</td>
</tr>
</tbody>
</table>

1 System Variables | 1375
<table>
<thead>
<tr>
<th>Number</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Yards</td>
</tr>
<tr>
<td>11</td>
<td>Angstroms</td>
</tr>
<tr>
<td>12</td>
<td>Nanometers</td>
</tr>
<tr>
<td>13</td>
<td>Microns</td>
</tr>
<tr>
<td>14</td>
<td>Decimeters</td>
</tr>
<tr>
<td>15</td>
<td>Dekameters</td>
</tr>
<tr>
<td>16</td>
<td>Hectometers</td>
</tr>
<tr>
<td>17</td>
<td>Gigameters</td>
</tr>
<tr>
<td>18</td>
<td>Astronomical Units</td>
</tr>
<tr>
<td>19</td>
<td>Light Years</td>
</tr>
<tr>
<td>20</td>
<td>Parsecs</td>
</tr>
</tbody>
</table>

See also:
Insert Blocks

**INSUNITSDEFAULT**

Sets target drawing units value when INSUNITS is set to 0.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 1

Valid range is 0 to 20.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Unspecified (No units)</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>-------------------</td>
</tr>
<tr>
<td>1</td>
<td>Inches</td>
</tr>
<tr>
<td>2</td>
<td>Feet</td>
</tr>
<tr>
<td>3</td>
<td>Miles</td>
</tr>
<tr>
<td>4</td>
<td>Millimeters</td>
</tr>
<tr>
<td>5</td>
<td>Centimeters</td>
</tr>
<tr>
<td>6</td>
<td>Meters</td>
</tr>
<tr>
<td>7</td>
<td>Kilometers</td>
</tr>
<tr>
<td>8</td>
<td>Microinches</td>
</tr>
<tr>
<td>9</td>
<td>Mils</td>
</tr>
<tr>
<td>10</td>
<td>Yards</td>
</tr>
<tr>
<td>11</td>
<td>Angstroms</td>
</tr>
<tr>
<td>12</td>
<td>Nanometers</td>
</tr>
<tr>
<td>13</td>
<td>Microns</td>
</tr>
<tr>
<td>14</td>
<td>Decimeters</td>
</tr>
<tr>
<td>15</td>
<td>Dekameters</td>
</tr>
<tr>
<td>16</td>
<td>Hectometers</td>
</tr>
<tr>
<td>17</td>
<td>Gigameters</td>
</tr>
<tr>
<td>18</td>
<td>Astronomical Units</td>
</tr>
</tbody>
</table>
**INTELLIGENTUPDATE**

Controls the graphics refresh rate.

- **Type:** Integer
- **Saved in:** Registry
- **Initial value:** 20 frames per second.

The default value is 20 frames per second. If you encounter problems related to graphics generation or timing, turn off the variable by setting it to 0. INTELLIGENTUPDATE works by suppressing the graphics update until the timer expires. Subsequent updates reset the timer.

The performance improvement significantly affects updates for scripts and AutoLISP graphics. Those using regular AutoCAD commands will not see a noticeable difference in performance.

- **See also:** Set Interface Options

**INTERFERECOLOR**

Sets the color for interference objects.

- **Type:** String
- **Saved in:** Drawing
- **Initial value:**

Valid values include BYLAYER, BYBLOCK, a color name, and integers from 0 to 255.

Valid values for True Colors are a string of integers each from 0 to 255 separated by commas and preceded by RGB. The True Color setting is entered as follows:
If you have a color book installed, you can specify any colors that are defined in the book.

**See also:**
- Check 3D Models for Interferences

**INTERFEREOBJVS**

Sets the visual style for interference objects.

**Type:** String  
**Saved in:** Drawing  
**Initial value:** Realistic

INTERFEREOBJVS can only be set to a visual style that is saved in the drawing.

The visual style specified for INTERFEREOBJVS cannot be removed with the PURGE (page 861) command.

**See also:**
- Check 3D Models for Interferences

**INTERFEREVPVS**

Specifies the visual style for the viewport during interference checking.

**Type:** String  
**Saved in:** Drawing  
**Initial value:** Wireframe

INTERFEREVPVS can only be set to a visual style that is saved in the drawing.

The visual style specified for INTERFEREVPVS cannot be removed with the PURGE (page 861) command.

**See also:**
- Check 3D Models for Interferences
**INTERSECTIONCOLOR**

Controls the color of polylines at the intersection of 3D surfaces when the visual style is set to 2D Wireframe.

Value 0 designates ByBlock, value 256 designates ByLayer, and value 257 designates ByEntity. Values 1-255 designate an AutoCAD Color Index (ACI) color. True Colors and Color Book colors are also available.

The INTERSECTIONCOLOR setting is visible only if **INTERSECTIONDISPLAY** (page 1380) is turned on and if the **HIDE** (page 507) command is used.

See also:

- Control the Display of Edges

**INTERSECTIONDISPLAY**

Controls the display of polylines at the intersection of 3D surfaces when the visual style is set to 2D Wireframe.

**Type:** Switch  
**Saved in:** Drawing  
**Initial value:** Off

<table>
<thead>
<tr>
<th>Off</th>
<th>Turns off the display of intersection polylines</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Turns on the display of intersection polylines</td>
</tr>
</tbody>
</table>

See also:

- Control the Display of Edges

**ISAVEBAK**

Improves the speed of incremental saves, especially for large drawings.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 1
ISAVEBAK controls the creation of a backup file (BAK). In the operating system, copying the file data to create a BAK file for large drawings takes a major portion of the incremental save time.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No BAK file is created (even for a full save)</td>
</tr>
<tr>
<td>1</td>
<td>A BAK file is created</td>
</tr>
</tbody>
</table>

**WARNING** In some cases (such as a power failure in the middle of a save), it’s possible that drawing data can be lost.

See also:
Set Interface Options

**ISAVEPERCENT**

Determines the amount of wasted space tolerated in a drawing file.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 50

The value of ISAVEPERCENT is an integer between 0 and 100. The default value of 50 means that the estimate of wasted space within the file does not exceed 50 percent of the total file size. Wasted space is eliminated by periodic full saves. When the estimate exceeds 50 percent, the next save will be a full save. This resets the wasted space estimate to 0. If ISAVEPERCENT is set to 0, every save is a full save.

See also:
Set Up the Drawing Area

**ISOLINES**

Specifies the number of contour lines displayed on the curved surfaces of 3D solids.

**Type:** Integer  
**Saved in:** Drawing
Initial value: 4
Valid settings range from 0 to 2047.

See also:
Create Solids

L System Variables

LARGEOBJECTSUPPORT

Controls large object size limit support when you open and save drawings.

Type: Integer
Saved in: Registry
Initial value: 0

0 Use legacy object size limits from AutoCAD 2009 and prior
1 Use AutoCAD 2010 object size limits

See also:
Save a Drawing

LASTANGLE

Stores the end angle of the last arc entered relative to the XY plane of the current UCS for the current space.

(Read-only)
Type: Real
Saved in: Not-saved
Initial value: 0.0000

See also:
Draw Arcs
LASTPOINT

Stores the last point specified, expressed as UCS coordinates for the current space.

**Type:** 3D-point

**Saved in:** Not-saved

**Initial value:** 0.0000,0.0000,0.0000

You can reference the last point specified by entering the @ symbol at a point prompt. This is equivalent to entering @0,0,0.

**See also:**
- Overview of Coordinate Entry

LASTPROMPT

Stores the last string echoed to the Command prompt.

(Read-only)

**Type:** String

**Saved in:** Not-saved

**Initial value:**"

This string is identical to the last line seen at the Command prompt and includes any user input.

**See also:**
- Enter Commands on the Command Line

LATITUDE

Specifies the latitude of the drawing model in decimal format.

**Type:** Real

**Saved in:** Drawing

**Initial value:** 37.7950

The default is the latitude of San Francisco, California. The valid range is -90 to +90. Positive values represent north latitudes.

This value is affected by the settings of the LUPREC system variable.
This value is not affected by the settings of the AUNITS and AUPREC system variables.

See also:

Specify Units and Unit Formats

**LAYEREVAL**

Specifies whether the layer list is evaluated for new layers when added to the drawing or to attached xrefs.

<table>
<thead>
<tr>
<th>Type:</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>Drawing</td>
</tr>
<tr>
<td>Initial value:</td>
<td>0</td>
</tr>
</tbody>
</table>

The setting is stored in an integer using one of the following values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off</td>
</tr>
<tr>
<td>1</td>
<td>Detects when new xref layers have been added in the drawing</td>
</tr>
<tr>
<td>2</td>
<td>Detects when new layers have been added in the drawing and xrefs</td>
</tr>
</tbody>
</table>

**NOTE** LAYEREVALCTL (page 1384) overrides the LAYEREVAL and LAYERNOTIFY (page 1386) setvars when LAYEREVALCTL = 0. It acts like a global off (but not a global on). There is no effect even if LAYEREVALCTL is turned on if LAYERNOTIFY = 0 or LAYEREVAL = 0. LAYEREVALCTL must be set to 1 for LAYERNOTIFY and LAYEREVAL to function correctly.

See also:

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAYEREVALCTL</td>
<td>1384</td>
</tr>
<tr>
<td>LAYERNOTIFY</td>
<td>1386</td>
</tr>
</tbody>
</table>

**LAYEREVALCTL**

Controls the overall Unreconciled New Layer filter list in Layers palette which is evaluated for new layers.

<table>
<thead>
<tr>
<th>Type:</th>
<th>Integer</th>
</tr>
</thead>
</table>
**Saved in:** User-settings  
**Initial value:** 1

This system variable also affects whether the new layer notification is displayed or not.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Disables the evaluation and notification of new layers</td>
</tr>
<tr>
<td>1</td>
<td>Enables the evaluation of new layers on LAYEREVAL settings in DWG file</td>
</tr>
</tbody>
</table>

**NOTE** LAYEREVALCTL overrides the LAYEREVAL (page 1384) and LAYERNOTIFY (page 1386) setvars when LAYEREVALCTL = 0. It acts like a global off (but not a global on). There is no effect even if LAYEREVALCTL is turned on if LAYERNOTIFY = 0 or LAYEREVAL = 0. LAYEREVALCTL must be set to 1 for LAYERNOTIFY and LAYEREVAL to function correctly.

See also:  
- LAYEREVAL (page 1384)  
- LAYERNOTIFY (page 1386)

---

**LAYERFILTERALERT**

Deletes excessive dynamic layer group filters to improve performance.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 2

When a drawing has 100 or more dynamic layer group filters, and the number of filters exceeds the number of layers, LAYERFILTERALERT provides a method for deleting filters to improve performance.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off</td>
</tr>
<tr>
<td>1</td>
<td>When the Layers palette is opened, deletes all dynamic layer group filters; no message is displayed</td>
</tr>
<tr>
<td>2</td>
<td>When the Layers palette is opened, displays a message that states the problem, recommends deleting all dynamic layer group filters,</td>
</tr>
</tbody>
</table>
and offers a choice: “Do you want to delete all dynamic layer group filters now?”

When the drawing is opened, displays a message that states the problem and offers to display a dialog box where you can choose which dynamic layer group filters to delete.

See also:
Filter and Sort the List of Layers

### LAYERMANAGERSTATE

Indicates whether the Layers palette is open or closed.

(Read-only)

<table>
<thead>
<tr>
<th>Type:</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>Not-saved</td>
</tr>
<tr>
<td>Initial value:</td>
<td>Varies</td>
</tr>
</tbody>
</table>

- **0**: Closed
- **1**: Open and collapsed
- **2**: Open and expanded

See also:
Change Layer Settings and Layer Properties

### LAYERNOTIFY

Specifies when an alert displays when unreconciled new layers are found.

<table>
<thead>
<tr>
<th>Type:</th>
<th>Bitcode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>Drawing</td>
</tr>
<tr>
<td>Initial value:</td>
<td>0</td>
</tr>
</tbody>
</table>

- **0**: Off
NOTE LAYEREVALCTL (page 1384) overrides the LAYEREVAL (page 1384) and LAYERNOTIFY setvars when LAYEREVALCTL = 0. It acts like a global off (but not a global on). There is no effect even if LAYEREVALCTL is turned on if LAYERNOTIFY = 0 or LAYEREVAL = 0. LAYEREVALCTL must be set to 1 for LAYERNOTIFY and LAYEREVAL to function correctly.

See also:
- LAYEREVAL (page 1384)
- LAYEREVALCTL (page 1384)

LAYLOCKFADECTL

Controls the amount of fading for objects on locked layers.

**Type:** Integer

**Saved in:** Registry

**Initial value:** 50

Fades the objects on locked layers to contrast them with objects on unlocked layers and reduces the visual complexity of a drawing. Objects on locked layers are still visible for reference and for object snapping.
The range for controlling the fading for objects on locked layers is from -90 to 90.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Locked layers are not faded</td>
</tr>
<tr>
<td>&gt;0</td>
<td>When the value is positive, controls the percent of fading up to 90 percent</td>
</tr>
<tr>
<td>&lt;0</td>
<td>When the value is negative, locked layers are not faded, but the value is saved for switching to that value by changing the sign</td>
</tr>
</tbody>
</table>

**NOTE** The fading value is limited to 90 percent to avoid confusion with layers that are turned off or frozen.

See also:

Use Layers to Manage Complexity

**LAYOUTCREATEVIEWPORT**

Controls whether a viewport is created automatically on each new layout added to a drawing.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Newly created layouts do not include any viewports.</td>
</tr>
<tr>
<td>1</td>
<td>A single layout viewport is created with each new layout.</td>
</tr>
</tbody>
</table>
See also:
  Work on a Named Layout

**LAYOUTREGENCTL**

Specifies how the display list is updated in the Model layout and named layouts.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 2

For each layout, the display list is updated either by regenerating the drawing when you switch to that layout or by saving the display list to memory and regenerating only the modified objects when you switch to that layout. Changing the LAYOUTREGENCTL setting can improve performance.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>The drawing is regenerated each time you switch tabs.</td>
</tr>
<tr>
<td>1</td>
<td>For the Model layout and the last named layout made current, the display list is saved to memory and regenerations are suppressed when you switch between layouts. For all other layouts, regenerations still occur when you switch to that layout.</td>
</tr>
<tr>
<td>2</td>
<td>The drawing is regenerated the first time you switch to each layout. For the remainder of the drawing session, the display list is saved to memory and regenerations are suppressed when you switch to those layouts</td>
</tr>
</tbody>
</table>

The performance gain achieved by changing the LAYOUTREGENCTL setting is dependent on several factors, including the drawing size and type, the objects contained in the drawing, the amount of available memory, and the effect of other open drawings or applications. When LAYOUTREGENCTL is set to 1 or 2, the amount of additional memory used is the size of the Model layout's display list multiplied by the number of viewports in each layout for which the display list is saved.

If LAYOUTREGENCTL is set to 1 or 2 and performance seems slow in general or when you switch between layouts for which the display list is saved, consider changing to a setting of 0 or 1 to find the optimal balance for your work environment.
Regardless of the LAYOUTREGENCTL setting, if you redefine a block or undo a layout switch, the drawing is regenerated the first time you switch to any layout that contains saved viewports.

See also:
- Work on a Named Layout

**LEGACYCTRLPICK**

Specifies the keys for selection cycling and the behavior for Ctrl-click.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 2

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Ctrl-click is used to select subobjects (faces, edges, and vertices) on 3D solids, surfaces, and meshes.</td>
</tr>
<tr>
<td>1</td>
<td>Ctrl-click is used to cycle through overlapping objects. Disallows using Ctrl-click to select subobjects on 3D solids, surfaces, and meshes.</td>
</tr>
<tr>
<td>2</td>
<td>Ctrl-click is used to select subobjects (faces, edges, and vertices) on 3D solids, surfaces, and meshes when SUBOBJSELECTIONMODE (page 1494) is set to 0. If SUBOBJSELECTIONMODE is set to 1, 2, 3, or 4, it is not necessary to hold down the Ctrl key to select subobjects. If you hold down the Ctrl key when SUBOBJSELECTIONMODE is set to 1, 2, 3, or 4, the subobject filter is turned off until the Ctrl key is released.</td>
</tr>
</tbody>
</table>

See also:
- Select Objects Individually
  - SUBOBJSELECTIONMODE (page 1494)
- Cycle Through and Filter Subobjects

**LENSLENGTH**

Stores the length of the lens (in millimeters) used in perspective viewing.
Type: Real
Saved in: Drawing
Initial value: 50.0000

See also:
Define a Perspective Projection (DVIEW)

LIGHTGLYPHDISPLAY

Turns on and off the display of light glyphs.

Type: Integer
Saved in: Drawing
Initial value: 1

When this system variable is set to Off, the glyphs that represent lights in the drawing are not displayed.

A light glyph is a symbolic representation of a point lights and spotlights.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off</td>
</tr>
<tr>
<td>1</td>
<td>On</td>
</tr>
</tbody>
</table>

See also:
Control the Display of Lights

LIGHTINGUNITS

Controls whether generic or photometric lights are used, and specifies the lighting units for the drawing.

Type: Integer
Saved in: Drawing
Initial value: 2

When this system variable is set to 1 or 2, photometric lighting is enabled; otherwise standard (generic) lighting is used.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No lighting units are used and standard (generic) lighting is enabled.</td>
</tr>
</tbody>
</table>
American lighting units (foot-candles) are used and photometric lighting is enabled.

International lighting units (lux) are used and photometric lighting is enabled.

See also:
Standard and Photometric Lighting Workflow

**LIGHTSINBLOCKS**

Controls whether lights contained in blocks are used when rendering.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 1

By default, this system variable is turned on. When this system variable is off, lights in blocks do not affect 3D objects in the current viewport when rendering. Some previous versions of AutoCAD did not support rendering lights in blocks.

| 0 (Off) | Lights in blocks are disabled |
| 1 (On)  | Lights in blocks are enabled  |

See also:  
Incorporate Luminaire Objects

**LIMCHECK**

Controls the creation of objects outside the grid limits.

**Type:** Integer  
**Saved in:** Drawing
**Initial value:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Objects can be created outside the limits</td>
</tr>
<tr>
<td>1</td>
<td>Objects cannot be created outside the limits</td>
</tr>
</tbody>
</table>

**See also:**

Adjust Grid and Grid Snap

**LIMMAX**

Stores the upper-right grid limits for the current space, expressed as world coordinates.

**Type:** 2D-point

**Saved in:** Drawing

**Initial value:**

12.0000,9.0000 (imperial) or 420.0000,297.0000 (metric)

LIMMAX is read-only when paper space is active and the paper background or printable area is displayed.

**See also:**

Adjust Grid and Grid Snap

**LIMMIN**

Stores the lower-left grid limits for the current space, expressed as a world coordinate.

**Type:** 2D-point

**Saved in:** Drawing

**Initial value:**

0.0000,0.0000

LIMMIN is read-only when paper space is active and the paper background or printable area is displayed.

**See also:**

Adjust Grid and Grid Snap
**LINEARBRIGHTNESS**

Controls the brightness level of the viewport when using default lighting or generic lights.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0

Controls the brightness level of the viewport when standard lighting is enabled (LIGHTINGUNITS system variable is set to 0). Valid settings are integers from -10 to 10. The brightness level in photometric lighting can be controlled by the LOGEXPBRIGHTNESS system variable.

**See also:**  
Standard and Photometric Lighting Workflow

**LINEARCONTRAST**

Controls the contrast level of the viewport when using default lighting or generic lights.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0

Controls the contrast level of the viewport when standard lighting is enabled (LIGHTINGUNITS system variable is set to 0). Valid settings are integers from -10 to 10. The contrast level in photometric lighting can be controlled by LOGEXPCONTRAST.

**See also:**  
Standard and Photometric Lighting Workflow

**LOCALE**

Displays a code that indicates the current locale.

(Read-only)  
**Type:** String  
**Saved in:** Not-saved
**Initial value:** Varies by country/region

This code appears as a three-letter abbreviation returned by the operating system.

**See also:**
- Specify Search Paths and File Locations
- Organize Program and Support Files

**LOCALROOTPREFIX**

Stores the full path to the root folder where local customizable files were installed.

*(Read-only)*

**Type:** String

**Saved in:** Registry

**Initial value:** Varies

The *Template* and *Textures* folders are in this location, and you can add any customizable files that you do not want to roam on the network. See **ROAM-ABLEROOTPREFIX** (page 1462) for the location of the roamable files.

**See also:**
- Overview of File Organization

**LOFTANG1**

Sets the draft angle through the first cross section in a loft operation.

**Type:** Real

**Saved in:** Drawing

**Initial value:** 90

The 0 direction is measured outward from the curve on the plane of the curve. The positive direction is measured toward the next cross section. Valid values include 0 to less than 360.

**See also:**
- Create a Solid or Surface by Lofting
LOFTANG2

Sets the draft angle through the last cross section in a loft operation.

Type:  Real
Saved in:  Drawing
Initial value:  90

The 0 direction is measured outward from the curve on the plane of the curve. The positive direction is measured toward the previous cross section. Valid values include 0 to less than 360.

See also:
Create a Solid or Surface by Lofting

LOFTMAG1

Sets the magnitude of the draft angle through the first cross section in a loft operation.

Type:  Real
Saved in:  Drawing
Initial value:  0.0000

Controls how soon the surface starts bending back toward the next cross section.

See also:
Create a Solid or Surface by Lofting

LOFTMAG2

Sets the magnitude of the draft angle through the last cross section in a loft operation.

Type:  Real
Saved in:  Drawing
Initial value:  0.0000

Controls how soon the surface starts bending back toward the next cross section.
See also:
Create a Solid or Surface by Lofting

LOFTNORMALS

Controls the normals of a lofted object where it passes through cross sections.

Type: Integer
Saved in: Drawing
Initial value: 1

This setting is ignored when specifying a path or guide curves.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Ruled</td>
</tr>
<tr>
<td>1</td>
<td>Smooth Fit</td>
</tr>
<tr>
<td>2</td>
<td>Start cross section</td>
</tr>
<tr>
<td>3</td>
<td>End cross section</td>
</tr>
<tr>
<td>4</td>
<td>Start and End cross sections</td>
</tr>
<tr>
<td>5</td>
<td>All cross sections</td>
</tr>
<tr>
<td>6</td>
<td>Use draft angle and magnitude</td>
</tr>
</tbody>
</table>

See also:
Create a Solid or Surface by Lofting

LOFTPARAM

Controls the shape of lofted solids and surfaces.

Type: Bitcode
Saved in: Drawing
Initial value: 7
The setting is stored as a bitcode using the sum of the following values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>No twist (minimizes the twist between cross sections)</td>
</tr>
<tr>
<td>2</td>
<td>Align direction (aligns the start to end direction of each cross section curve)</td>
</tr>
<tr>
<td>4</td>
<td>Simplify (produces simple solids and surfaces, such as a cylinder or plane, instead of spline solids and surfaces)</td>
</tr>
<tr>
<td>8</td>
<td>Close (closes the surface or solid between the first and the last cross sections)</td>
</tr>
</tbody>
</table>

See also:
Create a Solid or Surface by Lofting

**LOGEXPBRIGHTNESS**

Controls the brightness level of the viewport when using photometric lighting.

*Type:* Real  
*Saved in:* Drawing  
*Initial value:* 65.0

Controls the brightness level of the viewport when photometric lighting is enabled (*LIGHTINGUNITS* (page 1391) system variable is set to 1 or 2). Valid range is from 0.0 to 200.0. The brightness level in standard lighting can be controlled by the *LINEARBRIGHTNESS* (page 1394) systems variable.

See also:
Standard and Photometric Lighting Workflow

**LOGEXPCONTRAST**

Controls the contrast level of the viewport when using photometric lighting.

*Type:* Real  
*Saved in:* Drawing  
*Initial value:* 50.0
Controls the contrast level of the viewport when photometric lighting is enabled (LIGHTINGUNITS (page 1391) system variable is set to 1 or 2). Valid range is from 0.0 to 100.0. The contrast level in standard lighting can be controlled by the LINEARCHRCONTRAST (page 1394) systems variable.

See also:
Standard and Photometric Lighting Workflow

**LOGEXPDAYLIGHT**

Controls if the exterior daylight flag is enabled when using photometric lighting.

**Type:** Integer

**Saved in:** Drawing

**Initial value:** 2

When this system variable is off, exterior daylight is turned off when photometric lighting is enabled (LIGHTINGUNITS (page 1391) system variable is set to 1 or 2). When on, the exposure control algorithm in the rendering acts as if there is an extremely bright light source in the scene. Therefore, the default setting of “Auto” is tied directly to the sun setting. Under special circumstances, it may be desirable to manually set this variable due to extremely bright artificial light sources or, conversely, due to a sun-lit scene that it is illuminated only by a small amount of directly visible sunlight.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off</td>
</tr>
<tr>
<td>1</td>
<td>On</td>
</tr>
<tr>
<td>2</td>
<td>Auto, current sun status is used</td>
</tr>
</tbody>
</table>

See also:
Standard and Photometric Lighting Workflow

**LOGEXPMIDTONES**

Controls the mid tones level of the viewport when using photometric lighting.
Real
Type:
Saved in: Drawing
Initial value: 1.0
Controls the mid tones level of the viewport when photometric lighting is enabled (LIGHTINGUNITS (page 1391) system variable is set to 1 or 2). Valid range from 0.01 to 20.0.

See also:
Standard and Photometric Lighting Workflow

LOGEXPPHYSICALSCALE

Controls the relative brightness of self-illuminated materials in a photometric environment.

Real
Type:
Saved in: Drawing
Initial value: 1500.0000

This global scale factor is used to adjust the relative brightness of self-illuminated materials in a photometric environment. Valid values range from 0.001 to 200000.

See also:
Standard and Photometric Lighting Workflow

LOGFILEMODE

Specifies whether the contents of the command history are written to a log file.

<table>
<thead>
<tr>
<th>Type: Integer</th>
<th>Saved in: Registry</th>
<th>Initial value: 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Log file is not maintained</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Log file is maintained</td>
<td></td>
</tr>
</tbody>
</table>
See also:

Set Interface Options

LOGFILENAME

Specifies the path and name of the command history log file for the current drawing.

(Read-only)

**Type:** String

**Saved in:** Drawing

**Initial value:** Varies

The initial value varies depending on the name of the current drawing and the installation folder.

See also:

Set Interface Options

LOGFILEPATH

Specifies the path for the command history log files for all drawings in a session.

**Type:** String

**Saved in:** Registry

**Initial value:** Varies

You can also specify the path by using the OPTIONS command. The initial value is based on the installation folder.

See also:

Set Interface Options

LOGINNAME

Displays the current user’s login name and is saved with the file properties statistics of DWG and related files.

(Read-only)
**Type:** String  
**Saved in:** Not-saved  
**Initial value:** Varies

**See also:**  
Open a Drawing

### LONGITUDE

Specifies the longitude of the drawing model in decimal format.

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** -122.3940

The default is the longitude of San Francisco, California. The valid range is -180 to +180. Positive values represent east longitudes.

This value is affected by the settings of the LUPREC system variable.

This value is not affected by the settings of the AUNITS and AUPREC system variables.

**See also:**  
Specify Units and Unit Formats

### LTSCALE

Sets the global linetype scale factor.

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** 1.0000

The linetype scale factor cannot equal zero. This system variable has the same name as a command. Use the SETVAR command to access this system variable.

**See also:**  
Control Linetype Scale
LUNITS

Sets linear units.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 2

<table>
<thead>
<tr>
<th>1</th>
<th>Scientific</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Decimal</td>
</tr>
<tr>
<td>3</td>
<td>Engineering</td>
</tr>
<tr>
<td>4</td>
<td>Architectural</td>
</tr>
<tr>
<td>5</td>
<td>Fractional</td>
</tr>
</tbody>
</table>

**See also:**
- Set the Unit Format Conventions

LUPREC

Sets the display precision for linear units and coordinates.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 4

However, the internal precision of distance, area, and volume values, and linear coordinates is always maintained, regardless of the display precision. LUPREC does not affect the display precision of dimension text (see DIMSTYLE (page 319)).

Valid values are integers from 0 to 8.

**See also:**
- Set the Unit Format Conventions
**LWDEFAULT**

Sets the value for the default lineweight.

**Type:** Enum  
**Saved in:** Registry  
**Initial value:** 25

The default lineweight can be set to any valid lineweight value in hundredths of millimeters, including: 0, 5, 9, 13, 15, 18, 20, 25, 30, 35, 40, 50, 53, 60, 70, 80, 90, 100, 106, 120, 140, 158, 200, and 211.

All values must be entered in hundredths of millimeters. (Multiply a value by 2540 to convert values from inches to hundredths of millimeters.)

**See also:**
- Overview of Lineweights

**LWDISPLAY**

Controls whether the lineweights of objects are displayed.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** OFF

This setting is controlled separately for model space and for all paper space layouts.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OFF</td>
<td>Lineweights are not displayed</td>
</tr>
<tr>
<td>ON</td>
<td>Lineweights are displayed</td>
</tr>
</tbody>
</table>

**See also:**
- Display Lineweights

**LWUNITS**

Controls whether lineweight units are displayed in inches or millimeters.
Type: Integer
Saved in: Registry
Initial value: 1

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Inches</td>
</tr>
<tr>
<td>1</td>
<td>Millimeters</td>
</tr>
</tbody>
</table>

See also:
Display Lineweights

M System Variables

MATBROWSERSTATE

Indicates whether the Materials Browser is open or closed.
(Read-only)
Type: Switch
Saved in: User-settings
Initial value: 0

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Materials Browser is closed.</td>
</tr>
<tr>
<td>1</td>
<td>Materials Browser is open.</td>
</tr>
</tbody>
</table>

See also:
Browse Material Library

MAXACTVP

Sets the maximum number of viewports that can be active at one time in a layout.
Type: Integer
Saved in: Drawing
**Initial value:** 64

MAXACTVP has no effect on the number of viewports that are plotted.

**See also:**
  - Turn Layout Viewports On or Off

**MAXSORT**

Sets the maximum number of symbol names or block names sorted by listing commands.

- **Type:** Integer
- **Saved in:** Registry
- **Initial value:** 1000

If the total number of items exceeds this value, no items are sorted.

The value of MAXSORT is an integer between 0 and 32767.

**See also:**
  - Work with Blocks

**MBUTTONPAN**

Controls the behavior of the middle button or wheel on the pointing device.

- **Type:** Integer
- **Saved in:** Registry
- **Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Supports the action defined in the customization file</td>
</tr>
<tr>
<td>1</td>
<td>Supports panning when you hold and drag the button or wheel</td>
</tr>
</tbody>
</table>

**See also:**
  - Set Up the Drawing Area
MEASUREINIT

Controls whether a drawing you start from scratch uses imperial or metric default settings.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** Varies by country/region

Specifically, MEASUREINIT controls which hatch pattern and linetype files are used. The \textit{Drawing1.dwg} that opens when you start the program is a drawing that is started from scratch.

| 0 | Imperial; uses the hatch pattern file and linetype file designated by the ANSIHatch and ANSILinetype registry settings |
| 1 | Metric; uses the hatch pattern file and linetype file designated by the ISOHatch and ISOLinetype registry settings |

See also:  
Overview of Starting a New Drawing

MEASUREMENT

Controls whether the current drawing uses imperial or metric hatch pattern and linetype files.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0 (imperial) or 1 (metric)

| 0 | Imperial; uses the hatch pattern file and linetype file designated by the ANSIHatch and ANSILinetype registry settings |
| 1 | Metric; uses the hatch pattern file and linetype file designated by the ISOHatch and ISOLinetype registry settings |

See also:  
Overview of Starting a New Drawing
MENUECHO

Sets menu echo and prompt control bits.

**Type:** Integer  
**Saved in:** Not-saved  
**Initial value:** 0

The value is the sum of the following:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Suppresses echo of menu items (^P in a menu item toggles echoing)</td>
</tr>
<tr>
<td>2</td>
<td>Suppresses display of system prompts during menu</td>
</tr>
<tr>
<td>4</td>
<td>Disables ^P toggle of menu echoing</td>
</tr>
<tr>
<td>8</td>
<td>Displays input/output strings; debugging aid for DIESEL macros</td>
</tr>
</tbody>
</table>

See also:  
Create Macros

MENUNAME

Stores the customization file name, including the path for the file name.

(Read-only)  
**Type:** String  
**Saved in:** Registry  
**Initial value:** customization_file_name

See also:  
User Interface Customization

MESHTYPE

Controls the type of mesh that is created by REVSURF, TABSURF, RULESURF and EDGESURF.

**Type:** Bitcode
### MIRRHATCH

Controls how MIRROR reflects hatch patterns.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0  

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Retains hatch pattern direction</td>
</tr>
<tr>
<td>1</td>
<td>Mirrors the hatch pattern direction</td>
</tr>
</tbody>
</table>

**See also:**  
Mirror Objects

### MIRRTEXT

Controls how MIRROR reflects text.

**Type:** Integer  
**Saved in:** Drawing
Initial value: 0

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Retains text direction</td>
</tr>
<tr>
<td>1</td>
<td>Mirrors the text</td>
</tr>
</tbody>
</table>

See also:
Mirror Objects

MLEADERSCALE

Sets the overall scale factor applied to multileader objects.

Type: Real
Saved in: Drawing
Initial value: 1.0000

Use DIMSCALE (page 1278) to scale leader objects created with the LEADER (page 570) command.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
<td>A reasonable default value is computed based on the scaling between the current model space viewport and paper space. If you are in paper space or model space and not using the paper space feature, the scale factor is 1.0.</td>
</tr>
<tr>
<td>&gt;0</td>
<td>A scale factor is computed that leads text sizes, arrowhead sizes, and other scaled distances to plot at their face values.</td>
</tr>
</tbody>
</table>

MLEADERSCALE does not affect measured lengths, coordinates, or angles.

When MLEADERSCALE is set to 0, and the current multileader style is not annotative, the overall multileader scale of multileader objects created in paper space viewports is determined by the viewport scale. When the current multileader style is annotative, the MLEADERSCALE value is set to 0. Changes to the MLEADERSCALE value are ignored and the value is reset to 0.

See also:
Create and Modify Leaders
**MSLTSCALE**

Scales linetypes displayed on the model tab by the annotation scale.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Linetypes displayed on the Model tab are not scaled by the annotation scale</td>
</tr>
<tr>
<td>1</td>
<td>Linetypes displayed on the Model tab are scaled by the annotation scale</td>
</tr>
</tbody>
</table>

**NOTE** MSLTSCALE is set to 0 when you open drawings created in AutoCAD 2007 and earlier.

See also:  
Display Annotative Objects

**MTEXTCOLUMN**

Sets the default column setting for an mtext object.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 2

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No column.</td>
</tr>
<tr>
<td>1</td>
<td>Dynamic columns with auto height.</td>
</tr>
<tr>
<td>2</td>
<td>Dynamic column with manual height.</td>
</tr>
</tbody>
</table>

See also:  
Create and Edit Columns in Multiline Text
**MTEXTFIXED**

Sets the display size and orientation of multiline text in the In-Place Text Editor.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 2

Changes to this system variable affect the Always Display as WYSIWYG setting of the In-Place Text Editor.

- **0 or 1**  
  Zooms the drawing to the extents of the multiline text object’s bounding box when the text in the In-Place Text Editor is difficult to read (very small or large, or is rotated). The displayed text does not represent the text object’s final size and position. If the text object is rotated, the drawing view is temporarily rotated to match the orientation of the text object while it is being edited. Smooth view transitions are used when the drawing view is zoomed or rotated.

- **2**  
  The text within the In-Place Text Editor is displayed at its actual size and position. The display of the drawing is not zoomed or rotated, which might make it difficult to edit very small or large text objects. If the text object is rotated, the text object and not the drawing view is temporarily rotated while it is being edited.

See also:  
Overview of Multiline Text

**MTJIGSTRING**

Sets the content of the sample text displayed at the cursor location when the MTEXT command is started.

**Type:** String  
**Saved in:** Registry  
**Initial value:** “abc”
The text string is displayed in the current text size and font. You can enter any string of up to ten letters or numbers or enter a period (.) to display no sample text.

See also:
Overview of Multiline Text

**MYDOCUMENTSPREFIX**

Stores the full path to the Documents folder for the user currently logged on.

(Read-only)

**Type:** String  
**Saved in:** Registry  
**Initial value:** Varies

See also:
Specify Search Paths and File Locations

**N System Variables**

**NAVVCUBEDISPLAY**

Controls the display of the ViewCube tool in the current visual style and the current viewport.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 3

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>ViewCube is not displayed in 2D and 3D visual styles</td>
</tr>
<tr>
<td>1</td>
<td>ViewCube is displayed in 3D visual styles, but not in 2D visual styles</td>
</tr>
<tr>
<td>2</td>
<td>ViewCube is displayed in 2D visual styles, but not in 3D visual styles</td>
</tr>
<tr>
<td>3</td>
<td>ViewCube is displayed in both 2D and 3D visual styles</td>
</tr>
</tbody>
</table>
See also:
Use ViewCube Tool

**NAVVCUBELOCATION**

Identifies the corner in a viewport where the ViewCube tool is displayed.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Upper-right</td>
</tr>
<tr>
<td>1</td>
<td>Upper-left</td>
</tr>
<tr>
<td>2</td>
<td>Lower-left</td>
</tr>
<tr>
<td>3</td>
<td>Lower-right</td>
</tr>
</tbody>
</table>

See also:  
Use ViewCube Tool

**NAVVCUBEOPACITY**

Controls the opacity of the ViewCube tool when inactive.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 50

Valid values are from 0 to 100 percent. When set to 100, the ViewCube tool appears fully opaque against the drawing window and obscures all objects under it in the viewport. When set to less than 100, the ViewCube tool fades into the drawing window, which results in the objects under it to appear less obscured. If set to 0, the ViewCube tool is not displayed in the viewport unless the cursor is positioned over top of the ViewCube tool location.
See also:
   Use ViewCube Tool

**NAVVCUBEORIENT**

Controls whether the ViewCube tool reflects the current UCS or WCS.

*Type:* Integer  
*Saved in:* Registry  
*Initial value:* 1  

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>ViewCube tool is oriented to reflect WCS</td>
</tr>
<tr>
<td>1</td>
<td>ViewCube tool is oriented to reflect the current UCS</td>
</tr>
</tbody>
</table>

See also:  
   Use ViewCube Tool

**NAVVCUBESIZE**

Specifies the size of the ViewCube tool.

*Type:* Integer  
*Saved in:* Registry  
*Initial value:* 4  

<table>
<thead>
<tr>
<th>Value</th>
<th>Size</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Small</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Large</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Tiny</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Automatic</td>
<td>The size of the ViewCube tool is scaled up or down based on the size of the active viewport, zoom factor of the active layout, or drawing window</td>
</tr>
</tbody>
</table>
See also:

Use ViewCube Tool

NOMUTT

Suppresses the message display (muttering) when it wouldn't normally be suppressed.

Type: Short
Saved in: Not-saved
Initial value: 0

Displaying messages is the normal mode, but message display is suppressed during scripts, AutoLISP routines, and so on.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Resumes normal muttering behavior</td>
</tr>
<tr>
<td>1</td>
<td>Suppresses muttering indefinitely</td>
</tr>
</tbody>
</table>

See also:

Set Interface Options

NORTHDIRECTION

Specifies the angle of the sun from north.

Type: Real
Saved in: Drawing
Initial value: 0.0000

This value is affected by the settings of the AUNITS and AUPREC system variables.

NOTE The angle is interpreted in the context of the world coordinate system (WCS). This value is completely separate from surveyor angular units, which are always set relative to the current UCS.

See also:

Sun and Sky Simulation
**O System Variables**

**OBJECTISOLATIONMODE**

Controls whether hidden objects remain hidden between drawing sessions.

**Type:** Integer  
**Saved in:** User-settings  
**Initial value:** 0

OBJECTISOLATIONMODE controls whether objects that are hidden using the ISOLATEOBJECTS (page 534) or HIDEOBJECTS (page 509) command remain hidden after saving and reopening the drawing.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Isolated/hidden objects are temporary for current drawing session</td>
</tr>
<tr>
<td>1</td>
<td>Isolated/hidden objects persist between drawing sessions</td>
</tr>
</tbody>
</table>

See also:
- Control the Display of Objects

**OBSCUREDCOLOR**

Specifies the color of obscured lines.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 257

Value 0 designates ByBlock, value 256 designates ByLayer, and value 257 designates ByEntity. Values 1-255 designate an AutoCAD Color Index (ACI).

An obscured line is a hidden line made visible by changing its color and linetype. OBSCUREDCOLOR is available only in 2D views. In 3D views, the VSOBSCUREDCOLOR (page 1559) system variable is used.

The OBSCUREDCOLOR setting is visible only if the OBSCUREDTYPE (page 1418) system variable is turned on by setting it to a value other than 0.
See also:

Control the Display of Edges

**OBSCUREDTYPE**

Specifies the linetype of obscured lines.

**Type:** Integer

**Saved in:** Drawing

**Initial value:** 0

An obscured line is a hidden line made visible by changing its color and linetype. OBSCUREDTYPE is available only in 2D views. In 3D views, the VSOBSCUREDTYPE (page 1560) system variable is used.

Obscured linetypes are independent of zoom level, unlike regular linetypes. The linetype values are defined as follows:

<table>
<thead>
<tr>
<th>Value</th>
<th>Linetype</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off</td>
</tr>
<tr>
<td>1</td>
<td>Solid</td>
</tr>
<tr>
<td>2</td>
<td>Dashed</td>
</tr>
<tr>
<td>3</td>
<td>Dotted</td>
</tr>
<tr>
<td>4</td>
<td>Short Dash</td>
</tr>
<tr>
<td>5</td>
<td>Medium Dash</td>
</tr>
<tr>
<td>6</td>
<td>Long Dash</td>
</tr>
</tbody>
</table>

Off: No line is drawn.

Solid: A line is drawn.

Dashed: A dashed line is drawn, with dashes separated by spaces.

Dotted: A dotted line is drawn.

Short Dash: A line is drawn with short dashes.

Medium Dash: A line is drawn with medium dashes.

Long Dash: A line is drawn with long dashes.
<table>
<thead>
<tr>
<th>7</th>
<th>Double Short Dash</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Double Medium Dash</td>
</tr>
<tr>
<td>9</td>
<td>Double Long Dash</td>
</tr>
<tr>
<td>10</td>
<td>Medium Long Dash</td>
</tr>
<tr>
<td>11</td>
<td>Sparse Dot</td>
</tr>
</tbody>
</table>

See also:
Control the Display of Edges

**OFFSETDIST**

Sets the default offset distance.

**Type:** Real
**Saved in:** Not-saved
**Initial value:** -1.0000

<table>
<thead>
<tr>
<th>&lt;0</th>
<th>Offsets an object through a specified point</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Sets the default offset distance</td>
</tr>
</tbody>
</table>

See also:
Offset an Object
OFFSETGAPTYPE

Controls how potential gaps between segments are treated when polylines are offset.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Extends line segments to their projected intersections.</td>
</tr>
<tr>
<td>1</td>
<td>Fillets line segments at their projected intersections. The radius of each arc segment is equal to the offset distance.</td>
</tr>
<tr>
<td>2</td>
<td>Chamfers line segments at their projected intersections. The perpendicular distance from each chamfer to its corresponding vertex on the original object is equal to the offset distance.</td>
</tr>
</tbody>
</table>

**See also:**  
Offset an Object

OPMSTATE

Indicates whether the Properties Inspector palette is open or closed.  
(Read-only)

**Type:** Integer  
**Saved in:** Not-saved  
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Closed</td>
</tr>
<tr>
<td>1</td>
<td>Open</td>
</tr>
</tbody>
</table>

**See also:**  
Display and Change the Properties of Objects
**ORTHOMODE**

Constrains cursor movement to the perpendicular.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0

When ORTHOMODE is turned on, the cursor can move only horizontally or vertically relative to the UCS and the current grid rotation angle:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Turns off Ortho mode</td>
</tr>
<tr>
<td>1</td>
<td>Turns on Ortho mode</td>
</tr>
</tbody>
</table>

**See also:**

Use Orthogonal Locking (Ortho Mode)

**OSMODE**

Sets running object snaps

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 4133

The setting is stored as a bitcode using the sum of the following values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>NONe</td>
</tr>
<tr>
<td>1</td>
<td>ENDpoint</td>
</tr>
<tr>
<td>2</td>
<td>MIDpoint</td>
</tr>
<tr>
<td>4</td>
<td>CENter</td>
</tr>
<tr>
<td>8</td>
<td>NODe</td>
</tr>
<tr>
<td>16</td>
<td>QUAdrant</td>
</tr>
<tr>
<td>32</td>
<td>INTersection</td>
</tr>
<tr>
<td>-----</td>
<td>-----------------------</td>
</tr>
<tr>
<td>64</td>
<td>INSertion</td>
</tr>
<tr>
<td>128</td>
<td>PERpendicular</td>
</tr>
<tr>
<td>256</td>
<td>TANGent</td>
</tr>
<tr>
<td>512</td>
<td>NEArest</td>
</tr>
<tr>
<td>1024</td>
<td>Clears all object snaps</td>
</tr>
<tr>
<td>2048</td>
<td>APParent Intersection</td>
</tr>
<tr>
<td>4096</td>
<td>EXTension</td>
</tr>
<tr>
<td>8192</td>
<td>PARallel</td>
</tr>
</tbody>
</table>

To specify more than one object snap, enter the sum of their values. For example, entering 3 specifies the Endpoint (bitcode 1) and Midpoint (bitcode 2) object snaps. Entering 16383 specifies all object snaps.

When object snaps are switched off using the Osnap button on the status bar, a bitcode of 16384 (0x4000) is returned, in addition to the normal value of OSMODE. With this additional value, developers can distinguish this mode from Object Snap modes that have been turned off from within the Drafting Settings dialog box. Setting this bit toggles running object snaps off. Setting OSMODE to a value with this bit off toggles running object snaps on.

**See also:**

Use Object Snaps

**OSNAPCOORD**

Controls whether coordinates entered on the command line will override running object snaps.

**Type:** Integer
Saved in: Registry
Initial value: 2

<table>
<thead>
<tr>
<th></th>
<th>Running object snap settings override keyboard coordinate entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Keyboard entry overrides object snap settings except in scripts</td>
</tr>
</tbody>
</table>

See also:
Set Visual Aids for Object Snaps (AutoSnap)

**OSNAPNODELEGACY**

Controls whether the Node object snap can be used to snap to multiline text objects.

Type: Integer
Saved in: Registry
Initial value: 0

The number and location of nodes on a multiline text object snap depends on the vertical and horizontal justification of the multiline text object.

<table>
<thead>
<tr>
<th></th>
<th>Node object snap can be used with multiline text objects</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Node object snap ignores multiline text objects</td>
</tr>
</tbody>
</table>

See also:
Change Multiline Text

**OSNAPZ**

Controls whether object snaps are automatically projected onto a plane parallel to the XY plane of the current UCS at the current elevation.

Type: Integer
Saved in: Not-saved
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Osnap uses the Z-value of the specified point</td>
</tr>
<tr>
<td>1</td>
<td>Osnap substitutes the Z-value of the specified point with the elevation (ELEV (page 405)) set for the current UCS</td>
</tr>
</tbody>
</table>

**See also:**

Use Object Snaps

**OSOPTIONS**

Automatically suppresses object snaps on hatch objects and geometry with negative Z values when using a dynamic UCS.

**Type:** Bitcode  
**Saved in:** Registry  
**Initial value:** 3

The setting is stored as a bitcode using the sum of the following values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Object snaps operate on hatch objects, and on geometry with negative Z values when using a dynamic UCS</td>
</tr>
<tr>
<td>1</td>
<td>Object snaps ignore hatch objects</td>
</tr>
<tr>
<td>2</td>
<td>Object snaps ignore geometry with negative Z values during use of a dynamic UCS</td>
</tr>
</tbody>
</table>

**See also:**

Use Object Snaps
PALETTEICONSTATE

Indicates whether palettes are in icon state.

(Read-only)

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Palettes are expanded, not as icons</td>
</tr>
<tr>
<td>1</td>
<td>Palettes are collapsed as icons and displayed along the left side of the screen</td>
</tr>
<tr>
<td>2</td>
<td>Palettes are collapsed as icons and displayed along the right side of the screen</td>
</tr>
</tbody>
</table>

See also:

Specify the Behavior of Palettes

PAPERSPACEVISOR

Controls the display of the Layout visor when switching to a named layout.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Hidden</td>
</tr>
<tr>
<td>1</td>
<td>Displayed</td>
</tr>
</tbody>
</table>

See also:

Work on a Named Layout
PAPERUPDATE

Controls the display of a warning dialog box when attempting to print a layout with a paper size different from the paper size specified by the default for the plotter configuration file.

Type: Integer
Saved in: Registry
Initial value: 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Displays a warning dialog box if the paper size specified in the layout is not supported by the plotter</td>
</tr>
<tr>
<td>1</td>
<td>Sets paper size to the configured paper size of the plotter configuration file</td>
</tr>
</tbody>
</table>

See also:
Set Paper Size

PARAMETERCOPYMODE

Controls how constraints and referenced user parameters are handled when constrained objects are copied between drawings, Model space and layouts, and block definitions.

Type: Integer
Saved in: Registry
Initial value: 1

Parameters and their values apply to the current space only. Model space, individual paper space layouts, and various block definitions in the block editor cannot access each other's parameters. Several commands, including PASTECLIP (page 770) and EXPLODE (page 411), can introduce dimensional constraints and constraint parameters into an environment where referenced user parameters are no longer accessible or are in conflict.
The PARAMETERCOPYMODE system variable provides several options for handling these situations.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Do not copy any dimensional constraints or constraint parameters. Constraints are removed from copied objects.</td>
</tr>
<tr>
<td>1</td>
<td>Copy dimensional constraints and constraint parameters. Always replace expressions with numerical constants. Rename dimensional parameters if there is a naming conflict.</td>
</tr>
<tr>
<td>2</td>
<td>Copy dimensional constraints, constraint parameters, and user parameters. Reference existing user parameters when available, otherwise replace expressions with numerical constants.</td>
</tr>
<tr>
<td>3</td>
<td>Copy dimensional constraints, constraint parameters, and user parameters. Reference existing user parameters when available, otherwise create any missing user parameters. Change missing referenced dimensional constraints into user parameters.</td>
</tr>
<tr>
<td>4</td>
<td>Copy all dimensional constraints, constraint parameters, and expressions. Rename the parameters of copied objects if conflicts in value occurs for copied parameters.</td>
</tr>
</tbody>
</table>

See also:

Apply Dimensional Constraints

**PDFFRAME**

Determines whether the PDF underlay frame is visible.

**Type:** Integer  
**Saved in:** Drawing
Initial value: 1

The FRAME (page 1337) system variable overrides the PDFFRAME setting. Use the PDFFRAME system variable after the FRAME system variable to reset the PDF frame settings.

0  The PDF underlay frame is not displayed or plotted. The frame temporarily reappears during selection preview or object selection.

1  Displays and plots the PDF underlay frame.

2  Displays but does not plot the PDF underlay frame.

See also:

Hide and Show PDF Underlay Frames

PDFOSNAP

Determines whether object snapping is active for geometry in PDF underlays that are attached to the drawing.

Type:  Integer
Saved in:  Registry
Initial value: 1

The UOSNAP (page 1532) system variable overrides the PDFOSNAP setting.

0  Object snapping is disabled for geometry in all PDF underlay attachments in the drawing

1  Object snapping is enabled for geometry in all PDF underlay attachments in the drawing

See also:

Use Object Snaps with PDF Underlays
PDMODE

Controls how point objects are displayed.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0

For information about values to enter, see the POINT (page 826) command.

See also:
- Divide an Object into Equal Segments

PDSIZE

Sets the display size for point objects.

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** 0.0000

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Creates a point at 5 percent of the drawing area height</td>
</tr>
<tr>
<td>&gt;0</td>
<td>Specifies an absolute size</td>
</tr>
<tr>
<td>&lt;0</td>
<td>Specifies a percentage of the viewport size</td>
</tr>
</tbody>
</table>

See also:
- Divide an Object into Equal Segments

PEDITACCEPT

Suppresses display of the Object Selected Is Not a Polyline prompt in PEDIT.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 0
The prompt is followed by “Do you want it to turn into one?” Entering y converts the selected object to a polyline. When the prompt is suppressed, the selected object is automatically converted to a polyline.

<table>
<thead>
<tr>
<th>0</th>
<th>The prompt is displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The prompt is suppressed</td>
</tr>
</tbody>
</table>

See also:
- Modify Polylines

**PELLIPSE**

Controls the ellipse type created with ELLIPSE.

- **Type:** Integer
- **Saved in:** Drawing
- **Initial value:** 0

<table>
<thead>
<tr>
<th>0</th>
<th>Creates a true ellipse object.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Creates a polyline representation of an ellipse</td>
</tr>
</tbody>
</table>

See also:
- Draw Ellipses

**PERIMETER**

Stores the last perimeter value computed by the AREA or LIST command.

(Read-only)

- **Type:** Real
- **Saved in:** Not-saved
- **Initial value:** 0.0000

Also stores perimeter values computed by DBLIST (page 257).
See also:

Obtain Area and Mass Properties Information

**PERSPECTIVE**

Specifies whether the current viewport displays a perspective view.

<table>
<thead>
<tr>
<th>Type:</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>Drawing</td>
</tr>
<tr>
<td>Initial value:</td>
<td>Varies</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Perspective view turned off</td>
</tr>
<tr>
<td>1</td>
<td>Perspective view turned on</td>
</tr>
</tbody>
</table>

Perspective views are available only in model space, and only with 3D visual styles.

**NOTE** PERSPECTIVE is set to 0 when the drawing file or DXF file is saved to a file format earlier than AutoCAD 2007.

See also:

Define a Perspective Projection (DVIEW)

**PERSPECTIVECLIP**

Determines the location of eyepoint clipping.

<table>
<thead>
<tr>
<th>Type:</th>
<th>Real</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>Registry</td>
</tr>
<tr>
<td>Initial value:</td>
<td>5.0000</td>
</tr>
</tbody>
</table>

The value determines where the eye point clipping occurs as a percentage. Values can range between 0.01 and 10.0. If you select a small value, the z-values of objects will be compressed at the target view and beyond. If you select a value such as 0.5%, the clipping will appear very close to the eyepoint of the view. In some extreme cases it might be appropriate to use 0.1%, but it is recommended to change the setting to a higher value such as 5%.
See also:
  Define a Perspective Projection (DVIEW)

PFACEVMAX

Sets the maximum number of vertices per face.
(Read-only)
**Type:** Integer
**Saved in:** Not-saved
**Initial value:** 4

This system variable affects only legacy polyface meshes such as those created by PFACE (page 792).

See also:
  Create Custom Mesh (Legacy)

PICKADD

Controls whether subsequent selections replace the current selection set or add to it.

<table>
<thead>
<tr>
<th><strong>Type:</strong></th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Saved in:</strong></td>
<td>User-settings</td>
</tr>
<tr>
<td><strong>Initial value:</strong></td>
<td>2</td>
</tr>
</tbody>
</table>

| 0 | Turns off PICKADD. The objects and subobjects most recently selected become the selection set. Previously selected objects and subobjects are removed from the selection set. Add more objects or subobjects to the selection set by pressing SHIFT while selecting. |
| 1 | Turns on PICKADD. Each object and subobject selected, either individually or by windowing, is added to the current selection set. To remove objects or subobjects from the selection set, press SHIFT while selecting. |
| 2 | Turns on PICKADD. Each object and subobject selected, either individually or by windowing, is added to the current selection set. To |
remove objects or subobjects from the set, press SHIFT while selecting. Keeps objects selected after the SELECT (page 949) command ends.

See also:
Select Multiple Objects

### PICKAUTO

Controls automatic windowing for object selection.

<table>
<thead>
<tr>
<th>Type:</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>Registry</td>
</tr>
<tr>
<td>Initial value:</td>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Window selection is disabled.</td>
</tr>
<tr>
<td>1</td>
<td>Selects a clicked object or begins a selection window (for either a window or crossing selection) when the cursor is not on an object.</td>
</tr>
<tr>
<td>2</td>
<td>Selects a clicked object or begins a selection window whether the cursor is on an object or not.</td>
</tr>
</tbody>
</table>

For PICKAUTO settings 0 and 1, object selection occurs when the mouse button is pressed. For PICKAUTO setting 2, object selection occurs when the mouse button is released.

See also:
Select Multiple Objects

### PICKBOX

Sets the object selection target height, in pixels.

<table>
<thead>
<tr>
<th>Type:</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>Registry</td>
</tr>
<tr>
<td>Initial value:</td>
<td>3</td>
</tr>
</tbody>
</table>
NOTE When PICKBOX is set to 0, selection previewing of objects is not available.

See also:
Select Objects Individually

PICKDRAG

Controls the method of drawing a selection window.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 2

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Create a selection window using two points. Click once to begin a selection window, click again to complete the selection.</td>
</tr>
<tr>
<td>1</td>
<td>Create a selection window clicking and dragging. Release the mouse button to complete the selection.</td>
</tr>
<tr>
<td>2</td>
<td>Create a selection window using either of the methods above.</td>
</tr>
</tbody>
</table>

See also:
Select Multiple Objects

PICKFIRST

Controls whether you select objects before (noun-verb selection) or after you issue a command.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Turns off PICKFIRST; you select objects after you issue a command</td>
</tr>
<tr>
<td>1</td>
<td>Turns on PICKFIRST; you select objects before you issue a command</td>
</tr>
</tbody>
</table>
See also:

Customize Object Selection

**PICKSTYLE**

Controls the use of group selection and associative hatch selection.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No group selection or associative hatch selection</td>
</tr>
<tr>
<td>1</td>
<td>Group selection</td>
</tr>
<tr>
<td>2</td>
<td>Associative hatch selection</td>
</tr>
<tr>
<td>3</td>
<td>Group selection and associative hatch selection</td>
</tr>
</tbody>
</table>

See also:

Select Objects in Groups

**PLATFORM**

Indicates which platform is in use.

(Read-only)

**Type:** String  
**Saved in:** Not-saved  
**Initial value:** Varies

See also:

Set Interface Options
PLINECONVERTMODE

Specifies the fit method used in converting splines to polylines.

Type: Integer
Saved in: Registry
Initial value: 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Polylines are created with linear segments</td>
</tr>
<tr>
<td>1</td>
<td>Polylines are created with arc segments</td>
</tr>
</tbody>
</table>

See also:

Modify Splines

PLINEGEN

Sets how linetype patterns generate around the vertices of a 2D polyline.

Type: Integer
Saved in: Drawing
Initial value: 0

Does not apply to polylines with tapered segments.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Generates polylines to start and end with a dash at each vertex</td>
</tr>
<tr>
<td>1</td>
<td>Generates the linetype in a continuous pattern around the vertices of the polyline</td>
</tr>
</tbody>
</table>

See also:

Display Linetypes on Short Segments and Polylines

PLINEREVERSEWIDTHS

Controls the appearance of a polyline when reversed.

Type: Integer
Saved in: Registry
Initial value: 0

0  Direction of polyline is reversed; order of polyline segment widths is not reversed

1  Order and direction of polyline segments are reversed

Polylines are reversed with the REVERSE command.

See also:
Modify Polylines

PLINETYPE

Specifies whether optimized 2D polylines are used.

Type: Integer
Saved in: Registry
Initial value: 2

PLINETYPE controls both the creation of new polylines with the PLINE command and the conversion of existing polylines in drawings from previous releases.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Polylines in older drawings are not converted when opened; PLINE creates old-format polylines</td>
</tr>
<tr>
<td>1</td>
<td>Polylines in older drawings are not converted when opened; PLINE creates optimized polylines</td>
</tr>
<tr>
<td>2</td>
<td>Polylines in AutoCAD Release 14 or older drawings are converted when opened; PLINE creates optimized polylines</td>
</tr>
</tbody>
</table>

For more information on the two formats, see the CONVERT (page 226) command.

PLINETYPE also controls the polyline type created with the following commands: BOUNDARY (page 154) (when object type is set to Polyline),
DONUT (page 363), PEDIT (page 779) (when selecting a line or arc), POLYGON (page 832), and SKETCH (page 980) (when SKPOLY (page 1478) is set to 1).

**See also:**
- Draw Polylines

### PLINEWID

Stores the default polyline width.

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** 0.0000

**See also:**
- Draw Polylines

### PLOTOFFSET

Controls whether the plot offset is relative to the printable area or to the edge of the paper.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Sets the plot offset relative to the printable area.</td>
</tr>
<tr>
<td>1</td>
<td>Sets the plot offset relative to the edge of the paper</td>
</tr>
</tbody>
</table>

**See also:**
- Adjust the Plot Offset of a Layout

### PLOTROTMODE

Controls the orientation of plots.
**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 2

<table>
<thead>
<tr>
<th>0</th>
<th>Rotates the effective plotting area so the corner with the Rotation icon aligns with the paper at the lower left for 0, top left for 90, top right for 180, and lower right for 270. X and Y origin offsets are calculated relative to the lower-left corner.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Aligns the lower-left corner of the effective plotting area with the lower-left corner of the paper.</td>
</tr>
<tr>
<td>2</td>
<td>Works the same as 0 value except that the X and Y origin offsets are calculated relative to the rotated origin position.</td>
</tr>
</tbody>
</table>

See also:

Select a Printer or Plotter

**PLOTTRANSPARENCYOVERRIDE**

Controls whether object transparency is plotted.

**Type:** Integer  
**Saved in:** User-settings  
**Initial value:** 1

<table>
<thead>
<tr>
<th>0</th>
<th>Does not plot object transparency</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Uses the setting specified in the Page Setup or the Plot dialog boxes</td>
</tr>
<tr>
<td>2</td>
<td>Plots object transparency</td>
</tr>
</tbody>
</table>

Setting the PLOTTRANSPARENCYOVERRIDE system variable to 0 or 2 overrides the Print Transparency option in the Page Setup dialog box.

**WARNING** Because this system variable can affect global plot performance, it is strongly advised that you leave the value set to 1 and manage plot transparency when plotting.
See also:

Work with Object Properties

**PLQUIET**

Controls the display of optional plot-related dialog boxes and nonfatal errors for scripts.

<table>
<thead>
<tr>
<th>Type:</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>Registry</td>
</tr>
<tr>
<td>Initial value:</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>0</th>
<th>Displays plot dialog boxes and nonfatal errors</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Logs nonfatal errors and does not display plot-related dialog boxes</td>
</tr>
</tbody>
</table>

See also:

Switch Between Dialog Boxes and the Command Line

**POLARADDANG**

Stores additional angles for polar tracking and polar snap.

<table>
<thead>
<tr>
<th>Type:</th>
<th>String</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>Registry</td>
</tr>
<tr>
<td>Initial value:</td>
<td>&quot;&quot;</td>
</tr>
</tbody>
</table>

You can add up to 10 angles. Each angle can be separated with semicolons (;). The AUNITS system variable sets the format for display of angles. Unlike POLARANG, POLARADDANG angles do not result in multiples of their values. The bit value for the POLARMODE system variable must have 4 turned on for POLARADDANG to have an effect.

When using fractions of an angle, set the AUPREC system variable (angular precision) to a higher value. Otherwise, the POLARADDANG value will be rounded off.

See also:

Use Polar Tracking and PolarSnap
POLARANG

Sets the polar angle increment.

**Type:** Real  
**Saved in:** Registry  
**Initial value:** 90

Values are 90, 45, 30, 22.5, 18, 15, 10, and 5.

See also:

Use Polar Tracking and PolarSnap

POLARDIST

Sets the snap increment when the SNAPTYPE is set to 1 (PolarSnap).

**Type:** Real  
**Saved in:** Registry  
**Initial value:** 0.0000

See also:

Use Polar Tracking and PolarSnap

POLARMODE

Controls settings for polar and object snap tracking.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 0

The setting is stored as a bitcode using the sum of the following values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Measure polar angles based on current UCS (absolute)</td>
</tr>
<tr>
<td>1</td>
<td>Measure polar angles from selected objects (relative)</td>
</tr>
</tbody>
</table>
Object snap tracking

<table>
<thead>
<tr>
<th>0</th>
<th>Track orthogonally only</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Use polar tracking settings in object snap tracking</td>
</tr>
</tbody>
</table>

Use additional polar tracking angles

<table>
<thead>
<tr>
<th>0</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Acquire object snap tracking points

<table>
<thead>
<tr>
<th>0</th>
<th>Acquire automatically</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Press SHIFT to acquire</td>
</tr>
</tbody>
</table>

**NOTE** In a 3D view, a tracking vector parallel to the Z axis of the UCS is also displayed, and the tooltip displays +Z and -Z for the angle depending on the direction along the Z axis.

See also:

Use Polar Tracking and PolarSnap

**POLYSIDES**

Sets the default number of sides for the POLYGON command.

**Type:** Integer

**Saved in:** Not-saved

**Initial value:** 4

The range is 3 to 1024.

See also:

Draw Rectangles and Polygons
POPUPS

Displays the status of the currently configured display driver.

(Read-only)

**Type:** Integer

**Saved in:** Not-saved

**Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Does not support dialog boxes and the menu bar</td>
</tr>
<tr>
<td>1</td>
<td>Supports these features</td>
</tr>
</tbody>
</table>

**See also:**

Set Interface Options

PREVIEWCREATIONTRANSPARENCY

Controls the transparency of the preview generated while using SURFBLEND, SURFPATCH, SURFFILLET, FILLETEDGE, CHAMFEREDGE, and LOFT.

**Type:** Integer

**Saved in:** Registry

**Initial value:** 60

Valid values range from 0 to 90, where 0 is the lowest transparency value (opaque) and 90 is the highest transparency value.

**See also:**

Create Surfaces from Other Surfaces

PREVIEWEFFECT

Specifies the visual effect used for previewing selection of objects.

**Type:** Integer

**Saved in:** Registry
Initial value: 2

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Dashed lines (the default display for selected objects)</td>
</tr>
<tr>
<td>1</td>
<td>Thickened lines</td>
</tr>
<tr>
<td>2</td>
<td>Dashed and thickened lines</td>
</tr>
</tbody>
</table>

See also:
Customize Object Selection

**PREVIEWFACEEFFECT**

Specifies the visual effect used for previewing selection of face subobjects.

Type: Integer
Saved in: Registry
Initial value: 1

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No highlight effect for face</td>
</tr>
<tr>
<td>1</td>
<td>Highlight face with texture fill</td>
</tr>
</tbody>
</table>

See also:
Customize Object Selection

**PREVIEWFILTER**

Excludes specified object types from selection previewing.

Type: Bitcode
Saved in: Registry
Initial value: 7

The setting is stored as a bitcode using the sum of the following values:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Excludes nothing</td>
</tr>
<tr>
<td>1</td>
<td>Excludes objects on locked layers</td>
</tr>
<tr>
<td>2</td>
<td>Excludes objects in xrefs</td>
</tr>
<tr>
<td>4</td>
<td>Excludes tables</td>
</tr>
<tr>
<td>8</td>
<td>Excludes multiline text objects</td>
</tr>
<tr>
<td>16</td>
<td>Excludes hatch objects</td>
</tr>
<tr>
<td>32</td>
<td>Excludes objects in groups</td>
</tr>
</tbody>
</table>

See also:
Customize Object Selection

**PREVIEWTYPE**

Controls the view to use for the drawing thumbnail.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0

| 0  | Use last saved view                        |
| 1  | Use Home view                              |

See also:
Save a Drawing

**PRODUCT**

Returns the product name.  
(Read-only)  
**Type:** String
**PROGRAM**

Returns the program name.

(Read-only)

**Type:** String  
**Saved in:** Not-saved  
**Initial value:** "acad"

**See also:**  
Set Interface Options

**PROJECTNAME**

Assigns a project name to the current drawing.

**Type:** String  
**Saved in:** Drawing  
**Initial value:** ""

Used when an xref, image, or PDF underlay file is not found in its original path. The project name points to a section in the registry that can contain one or more search paths for each project name defined. Project names and their search directories are created from the Application tab of the Application Preferences dialog box.

Project names make it easier for users to manage xrefs, images, and underlays when drawings are exchanged between customers, or if users have different drive mappings to the same location on a server.

If the xref, image, or underlay file is not found at the original path, the project paths associated with the project name are searched. If the xref, image, or underlay file is not found there, the folders defined under Support File Search Path in the Application Preferences dialog box are searched.
See also:
Set Paths to Referenced Drawings

PROJMODE
Sets the current Projection mode for trimming or extending.

**Type:** Integer

**Saved in:** Registry

**Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>True 3D mode (no projection)</td>
</tr>
<tr>
<td>1</td>
<td>Project to the XY plane of the current UCS</td>
</tr>
<tr>
<td>2</td>
<td>Project to the current view plane</td>
</tr>
</tbody>
</table>

See also:
Trim or Extend Objects

PROPOBJLIMIT
Limits the number of objects that can be changed at one time with the Properties Inspector.

**Type:** Integer

**Saved in:** User-settings

**Initial value:** 25000

The valid range is 0 - 32767. If the limit is exceeded, changes to the property fields do not affect the selected objects.

See also:
Display and Change the Properties of Objects
**PROXYGRAPHICS**

Specifies whether images of proxy objects are saved in the drawing.

- **Type:** Integer
- **Saved in:** Drawing
- **Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Does not save image with the drawing; a bounding box is displayed instead</td>
</tr>
<tr>
<td>1</td>
<td>Saves image with the drawing</td>
</tr>
</tbody>
</table>

**See also:**

Work with Custom and Proxy Objects

---

**PROXYNOTICE**

Displays a notice when a proxy is created.

- **Type:** Integer
- **Saved in:** Registry
- **Initial value:** 1

A proxy is created when you open a drawing containing custom objects created by an application that is not present. A proxy is also created when you issue a command that unloads a custom object’s parent application.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No proxy warning is displayed</td>
</tr>
<tr>
<td>1</td>
<td>Proxy warning is displayed</td>
</tr>
</tbody>
</table>

**See also:**

Work with Custom and Proxy Objects

---

**PROXYSHOW**

Controls the display of proxy objects in a drawing.
**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 1  

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Proxy objects are not displayed</td>
</tr>
<tr>
<td>1</td>
<td>Graphic images are displayed for all proxy objects</td>
</tr>
<tr>
<td>2</td>
<td>Only the bounding box is displayed for all proxy objects</td>
</tr>
</tbody>
</table>

**See also:**  
Work with Custom and Proxy Objects

**PROXYWEBSEARCH**

Specifies how the program checks for object enablers.

| Type: | Integer  
|-------|---------|
| Saved in: | Registry  
| Initial value: | 0  

Object enablers allow you to display and use custom objects in drawings even when the ObjectARX application that created them is unavailable.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Prevents checking for object enablers</td>
</tr>
<tr>
<td>1</td>
<td>Checks for object enablers only if a live Internet connection is present</td>
</tr>
</tbody>
</table>

**See also:**  
Work with Custom and Proxy Objects

**PSLTSCALE**

Controls the linetype scaling of objects displayed in paper space viewports.

| Type: | Integer  
|-------|---------|
| Saved in: | Drawing  

P System Variables | 1449
Initial value: \textit{1}

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No special linetype scaling. Linetype dash lengths are based on the drawing units of the space (model or paper) in which the objects were created. Scaled by the global \texttt{LTSCALE} (page 596) factor.</td>
</tr>
<tr>
<td>1</td>
<td>Viewport scaling governs linetype scaling. If \texttt{TILEMODE} (page 1511) is set to 0, dash lengths are based on paper space drawing units, even for objects in model space. In this mode, viewports can have varying magnifications, yet display linetypes identically. For a specific linetype, the dash lengths of a line in a viewport are the same as the dash lengths of a line in paper space. You can still control the dash lengths with \texttt{LTSCALE}.</td>
</tr>
</tbody>
</table>

When you change \texttt{PSLTSCALE} or use a command such as \texttt{ZOOM} (page 1188) with \texttt{PSLTSCALE} set to 1, objects in viewports are not automatically regenerated with the new linetype scale. Use the \texttt{REGEN} (page 889) or \texttt{REGENALL} (page 889) command to update the linetype scales in each viewport.

See also:

Scale Linetypes in Layout Viewports

**PSOLHEIGHT**

Controls the default height for a swept solid object created with the \texttt{POLYSOLID} command.

\begin{itemize}
  \item \textbf{Type:} Real
  \item \textbf{Saved in:} Drawing
  \item \textbf{Initial value:} 4.0000 (imperial) or 80.0000 (metric)
\end{itemize}

The value reflects the last entered height value when using the \texttt{POLYSOLID} (page 834) command. You cannot enter 0 as the value.

See also:

Create a Polysolid
**PSOLWIDTH**

Controls the default width for a swept solid object created with the POLYSOLID command.

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** 0.2500 (imperial) or 5.0000 (metric)

The value reflects the last entered height value when using the POLYSOLID (page 834) command. You cannot enter 0 as the value.

**See also:**  
Create a Polysolid

**PSTYLEMODE**

Indicates whether the current drawing is in a Color-Dependent or Named Plot Style mode.

(Read-only)  
**Type:** Integer  
**Saved in:** Drawing  
**Initial value:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Uses named plot style tables in the current drawing</td>
</tr>
<tr>
<td>1</td>
<td>Uses color-dependent plot style tables in the current drawing</td>
</tr>
</tbody>
</table>

**See also:**  
Overview of Plot Styles

**PSTYLEPOLICY**

Controls the plot style mode, Color-Dependent or Named, that is used when opening a drawing that was created in a release prior to AutoCAD 2000 or when creating a new drawing from scratch without using a drawing template.

**Type:** Integer
Saved in: Registry
Initial value: 1

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Drawing is set to use named plot styles. The plot style for new objects is set to the default defined in DEFPLSTYLE (page 1250). The plot style for new layers is set to the default defined in DEFLPLSTYLE (page 1250).</td>
</tr>
<tr>
<td>1</td>
<td>Drawing is set to use color-dependent plot styles. The plot style for an object is based on the object’s color.</td>
</tr>
</tbody>
</table>

See also:
Overview of Plot Styles

PSVPSCALE

Sets the view scale factor for all newly created viewports.

Type: Real
Saved in: Drawing
Initial value: 0.0000

The view scale factor is defined by comparing the ratio of units in paper space to the units in newly created model space viewports. The view scale factor you set is used with the VPORTS command. A value of 0 means the scale factor is Scaled to Fit. A scale must be a positive real value.

See also:
Scale Views in Layout Viewports

PUCSBASE

Stores the name of the UCS that defines the origin and orientation of orthographic UCS settings in paper space only.

Type: String
Saved in: Drawing
Initial value: ""
See also:

Overview of the User Coordinate System (UCS)

Q System Variables

QTEXTMODE

Controls how text is displayed.

<table>
<thead>
<tr>
<th>Type:</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>Drawing</td>
</tr>
<tr>
<td>Initial value:</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Turns off Quick Text mode; displays characters</td>
</tr>
<tr>
<td>1</td>
<td>Turns on Quick Text mode; displays a box in place of text</td>
</tr>
</tbody>
</table>

See also:

Control the Display of Polylines, Hatches, Gradient Fills, Lineweights, and Text

R System Variables

RASTERDPI

Controls paper size and plot scaling when changing from dimensional to dimensionless output devices, or vice versa.

<table>
<thead>
<tr>
<th>Type:</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>Registry</td>
</tr>
<tr>
<td>Initial value:</td>
<td>300</td>
</tr>
</tbody>
</table>

Converts millimeters or inches to pixels, or vice versa. Accepts an integer between 100 and 32,767 as a valid value.
See also:
Plot Files to Other Formats

RASTERPERCENT

Sets the maximum percentage of available virtual memory that is allowed for plotting a raster image.

Type: Integer
Saved in: Registry
Initial value: 20

See also:
Plot Files to Other Formats

RASTERPREVIEW

Controls whether thumbnail preview images are created and saved with the drawing.

Type: Integer
Saved in: Registry
Initial value: 1

Obsolete. This system variable has been placed with THUMBSAVE.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No preview image is saved in the drawing</td>
</tr>
<tr>
<td>1</td>
<td>A preview image is created and saved in the drawing</td>
</tr>
</tbody>
</table>

See also:
Open a Drawing
Save a Drawing
Preview Open Drawings and Layouts
RASTERTHRESHOLD

Specifies a raster threshold in megabytes.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 20

If the plotted raster image exceeds this threshold, the availability of system memory is checked. The plot is aborted if the image is too big for the available memory.

**See also:**  
Plot Files to Other Formats

REBUILD2DCV

Sets the number of control vertices when rebuilding a spline.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 6

Valid values are from 2 to 32767.

**See also:**  
CVREBUILD (page 249)  
Rebuild NURBS Surfaces and Curves

REBUILD2DDEGREE

Sets the global degree when rebuilding a spline.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 3

Valid values are 1 to 11.
A curve with a degree of 1 is a straight line and a curve with a degree of 2 has one bend. A Bezier curve has a degree of 3. Higher degrees create more complex curves, but require computations.

See also:

CVREBUILD (page 249)
Rebuild NURBS Surfaces and Curves

REBUILD2DOPTION

Controls whether to delete the original curve when rebuilding a spline.

Type: Switch
Saved in: Registry
Initial value: 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Retains original curve</td>
</tr>
<tr>
<td>1</td>
<td>Deletes original curve</td>
</tr>
</tbody>
</table>

See also:

CVREBUILD (page 249)
Rebuild NURBS Surfaces and Curves

REBUILDDEGREEU

Sets the degree in the U direction when rebuilding a NURBS surface.
**REBUILDDEGREEV**

Sets the degree in the V direction when rebuilding a NURBS surface.

- **Type:** Integer
- **Saved in:** Registry
- **Initial value:** 3
- Valid values are 2 to 11.

**See also:**

CVREBUILD (page 249)
Rebuild NURBS Surfaces and Curves

**REBUILDOPTIONS**

Controls deletion and trimming options when rebuilding a NURBS surface.

- **Type:** Integer
- **Saved in:** Registry
- **Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>When you use CVREBUILD:</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>The original surface is not deleted and trimmed areas are not applied to the rebuilt object.</td>
</tr>
<tr>
<td>1</td>
<td>The original surface is deleted and trimmed areas are not applied to the rebuilt object.</td>
</tr>
</tbody>
</table>
The original surface is not deleted and trimmed areas are applied to the rebuilt object.

The original surface is deleted and trimmed areas are applied to the rebuilt object.

See also:

CVREBUILD (page 249)
Rebuild NURBS Surfaces and Curves

REBUILDU

Sets the number of grid lines in the U direction when rebuilding a NURBS surface.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 6

Valid values are 2 to 32767 to increase or decrease the number of grid lines in the U direction used to rebuild the NURBS surface.

See also:

CVREBUILD (page 249)
Rebuild NURBS Surfaces and Curves

REBUILDV

Sets the number of grid lines in the V direction when rebuilding a NURBS surface.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 6

Valid values are 2 to 32767 to increase or decrease the number of grid lines in the V direction used to rebuild the NURBS surface.
See also:

CVREBUILD  (page 249)
Rebuild NURBS Surfaces and Curves

RECOVERAUTO

Controls the display of recovery notifications before or after opening a damaged drawing file.

Type: Bitcode
Saved in: Registry
Initial value: 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Displays a task dialog to recover damaged files while opening a drawing that needs recovery. The task dialog interrupts any running scripts.</td>
</tr>
<tr>
<td>1</td>
<td>Automatically recovers the damaged files, opens the drawing, and displays a task dialog with the information of the recovered files. If a script is running, the task dialog is suppressed.</td>
</tr>
<tr>
<td>2</td>
<td>Automatically recovers the damaged files and opens the drawing without displaying any task dialog. The information of the recovered files is displayed at the command prompt.</td>
</tr>
</tbody>
</table>

See also:

Repair a Damaged Drawing File

REFEDITNAME

Displays the name of the reference being edited.

(Read-only)

Type: String
Saved in: Not-saved
Initial value: “”
See also:

Edit Selected Objects in Referenced Drawings and Blocks

**REGENMODE**

Controls automatic regeneration of the drawing.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Turns off the REGENAUTO (page 890) command</td>
</tr>
<tr>
<td>1</td>
<td>Turns on the REGENAUTO (page 890) command</td>
</tr>
</tbody>
</table>

See also:

Control the Display of Polylines, Hatches, Gradient Fills, Lineweights, and Text

**RE-INIT**

Reinitializes the acad.pgp file.

**Type:** Integer  
**Saved in:** Not-saved  
**Initial value:** 0

The setting is stored as a bitcode using the sum of the following values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Not used</td>
</tr>
<tr>
<td>2</td>
<td>Not used</td>
</tr>
<tr>
<td>4</td>
<td>Not used</td>
</tr>
<tr>
<td>8</td>
<td>Not used</td>
</tr>
<tr>
<td>16</td>
<td>PGP file reinitialization (reload)</td>
</tr>
</tbody>
</table>
REMEMBERFOLDERS

Controls the default path displayed in standard file selection dialog boxes.

**Type:** Integer

**Saved in:** Registry

**Initial value:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Restores the behavior of AutoCAD 2000 and previous releases. When you start the program by double-clicking a shortcut icon, if a Start In path is specified in the icon properties, that path is used as the default for all standard file selection dialog boxes.</td>
</tr>
<tr>
<td>1</td>
<td>The default path in each standard file selection dialog box is the last path used in that dialog box. The Start In folder specified for the AutoCAD shortcut icon is not used.</td>
</tr>
</tbody>
</table>

See also:
Open a Drawing

RENDERUSERLIGHTS

Controls whether to override the setting for viewport lighting during rendering.

**Type:** Integer

**Saved in:** Registry

**Initial value:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>The current lights in the viewport are used in the rendered scene, either default lights or user lights, as specified by the DEFAULTLIGHTING system variable.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

See also:

Create Command Aliases
Overrides the setting for the DEFAULTLIGHTING system variable. Only user lights are rendered.

**REPORTERROR**

Controls whether an error report can be sent to Autodesk if the program closes unexpectedly.

<table>
<thead>
<tr>
<th>Type:</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>Registry</td>
</tr>
<tr>
<td>Initial value:</td>
<td>1</td>
</tr>
</tbody>
</table>

Error reports help Autodesk diagnose problems with the software.

<table>
<thead>
<tr>
<th>0</th>
<th>The Error Report message is not displayed, and no report can be sent to Autodesk.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The Error Report message is displayed, and an error report can be sent to Autodesk.</td>
</tr>
</tbody>
</table>

An error report can be sent through the operating system if REPORTERROR is set to 0 and the operating system supports error reporting.

**See also:**

Recover from a System Failure

**ROAMABLEROOTPREFIX**

Stores the full path to the root folder where roamable customizable files were installed.

(Read-only)

<table>
<thead>
<tr>
<th>Type:</th>
<th>String</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>Registry</td>
</tr>
<tr>
<td>Initial value:</td>
<td>Varies</td>
</tr>
</tbody>
</table>

If you are working on a network that supports roaming, when you customize files that are in your roaming profile they are available to you regardless of which machine you are currently using.
See also:
Overview of File Organization

RTDISPLAY

Controls the display of raster images during Realtime ZOOM or PAN.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Displays raster image content</td>
</tr>
<tr>
<td>1</td>
<td>Displays outline only</td>
</tr>
</tbody>
</table>

See also:
Pan or Zoom a View

S System Variables

SAVEFIDELITY

Controls whether the drawing is saved with visual fidelity.

**Type:** Bitcode  
**Saved in:** Registry  
**Initial value:** 1

The setting is stored as a bitcode using the sum of the following values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Saved without visual fidelity.</td>
</tr>
<tr>
<td>1</td>
<td>Annotation objects assigned annotative scales are saved to separate layers for each scale used. Only affects drawings when saving to AutoCAD 2007 or earlier file formats.</td>
</tr>
</tbody>
</table>
See also:

- Save a Drawing
- Save with Visual Fidelity for Annotative Objects

**SAVEFILE**

Stores the current automatic save file name.

(Read-only)

**Type:** String

**Saved in:** Registry

**Initial value:** Varies

See also:

- Set Up the Drawing Area

**SAVEFILEPATH**

Specifies the path to the directory for all automatic save files for the current session.

**Type:** String

**Saved in:** Registry

**Initial value:** Varies

You can also change the path in the Application Preferences dialog box.

See also:

- Set Up the Drawing Area

**SAVENAME**

Displays the file name and directory path of the most recently saved drawing.

(Read-only)

**Type:** String

**Saved in:** Not-saved

**Initial value:** ""
See also:

Obtain General Drawing Information

SAVETIME

Sets the automatic save interval, in minutes.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 10

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Turns off automatic saving.</td>
</tr>
<tr>
<td>&gt;0</td>
<td>Saves the drawing at intervals specified by the nonzero integer automatically</td>
</tr>
</tbody>
</table>

The value of SAVETIME is an integer between 0 and 600.

The SAVETIME timer starts as soon as you make a change to a drawing. It is reset and restarted by a manual QSAVE (page 872), SAVE (page 926), or SAVEAS (page 926). The current drawing is saved to the path specified by the SAVEFILE-PATH (page 1464) system variable. The file name is stored in the SAVEFILE (page 1464) system variable.

See also:

Set Up the Drawing Area

SCREENSEIZE

Stores current viewport size in pixels (X and Y).

(Read-only)

**Type:** 2D-point  
**Saved in:** Not-saved  
**Initial value:** Varies

See also:

Switch Between Layouts in the Current Drawing
**SELECTIONANNODISPLAY**

Controls whether alternate scale representations are temporarily displayed in a dimmed state when an annotative object is selected.

| Type:    | Integer |
| Saved in: | Registry |
| Initial value: | 1 |

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off</td>
</tr>
<tr>
<td>1</td>
<td>On</td>
</tr>
</tbody>
</table>

The dimming intensity is controlled by the XFADECTL (page 1574) system variable.

See also:

Display Annotative Objects

---

**SELECTIONAREA**

Controls the display of effects for selection areas.

| Type:    | Integer |
| Saved in: | Registry |
| Initial value: | 1 |

Selection areas are created by the Window, Crossing, WPolygon, and CPolygon options of SELECT (page 949).

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off</td>
</tr>
<tr>
<td>1</td>
<td>On</td>
</tr>
</tbody>
</table>

See also:

Customize Object Selection
**SELECTIONAREAOPACITY**

Controls the transparency of the selection area during window and crossing selection.

*Type:* Integer  
*Saved in:* Registry  
*Initial value:* 25

The valid range is 0 to 100. The lower the setting, the more transparent the area. A value of 100 makes the area opaque. The `SELECTIONAREA` (page 1466) system variable must be on.

**See also:**  
Customize Object Selection

**SELECTIONCYCLING**

Turns selection cycling on and off.

*Type:* Integer  
*Saved in:* Registry  
*Initial value:* 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off</td>
</tr>
<tr>
<td>1</td>
<td>On</td>
</tr>
</tbody>
</table>

**See also:**  
Select Objects Individually  
Use 3D Subobject Grips  
Modify 3D Subobjects

**SELECTIONPREVIEW**

Controls the display of selection previewing.

*Type:* Bitcode  
*Saved in:* Registry
**Initial value:** 3

Objects are highlighted when the pickbox cursor rolls over them. This selection previewing indicates that the object would be selected if you clicked. The setting is stored as a bitcode using the sum of the following values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off</td>
</tr>
<tr>
<td>1</td>
<td>On when no commands are active</td>
</tr>
<tr>
<td>2</td>
<td>On when a command prompts for object selection</td>
</tr>
</tbody>
</table>

**See also:**
- Customize Object Selection

**SELECTIONPREVIEWLIMIT**

Limits the number of objects that can display preview highlighting during a window or crossing selection.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 2000

When you select a large number of objects using a windowing or crossing method, preview highlighting can sometimes affect program performance. You might want to decrease this number when working with large, complex drawings. Whenever the selection set exceeds the number in this setting, all preview highlighting is discontinued.

This setting has no effect unless SELECTIONPREVIEW is on.

**See also:**
- Customize Object Selection

**SELECTSIMILARMODE**

Controls which properties must match for an object of the same type to be selected with SELECTSIMILAR.
**Type:** Bitcode  
**Saved in:** User-settings  
**Initial value:** 130

The default value is 130. Objects of the same type are considered similar if they are on the same layer, and, for referenced objects, have the same name.

The setting is stored as a bitcode using the sum of the following values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Object type</td>
</tr>
<tr>
<td>1</td>
<td>Color</td>
</tr>
<tr>
<td>2</td>
<td>Layer</td>
</tr>
<tr>
<td>4</td>
<td>Linetype</td>
</tr>
<tr>
<td>8</td>
<td>Linetype scale</td>
</tr>
<tr>
<td>16</td>
<td>Lineweight</td>
</tr>
<tr>
<td>32</td>
<td>Plot style</td>
</tr>
<tr>
<td>64</td>
<td>Object style (such as text styles, dimension styles, and table styles)</td>
</tr>
<tr>
<td>128</td>
<td>Name (for referenced objects, such as blocks, xrefs, and images)</td>
</tr>
</tbody>
</table>

**See also:**
Select Objects by Properties

### SHADEDGE

Controls the shading of edges.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 3

0  | Faces shaded, edges not highlighted
1 | Faces shaded, edges drawn in background color
2 | Faces not filled, edges in object color
3 | Faces in object color, edges in background color

See also:
Use a Visual Style to Display Your Model

SHADEDIFF

Sets the ratio of diffuse reflective light to ambient light.

**Type:** Integer  
**Saved in:** Drawing  
**Initial Value:** 70

The ratio is a percentage of diffuse reflective light when SHADEDGE (page 1469) is set to 0 or 1.

See also:
Use a Visual Style to Display Your Model

SHADOWPLANELOCATION

Controls the location of an invisible ground plane used to display shadows.

**Type:** Real  
**Saved in:** Drawing  
**Initial Value:** 0.0000

The value is a location on the current Z axis. The ground plane is invisible, but it casts and receives shadows. Objects that are located below the ground plane are shadowed by it. The ground plane is used when the VSSHADOWS (page 1565) system variable is set to display either full shadows or ground shadows.

See also:
Display Backgrounds and Shadows
SHORTCUTMENU

Controls whether Default, Edit, and Command mode shortcut menus are available in the drawing area.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 11

The setting is stored as a bitcode using the sum of the following values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Disables all Default, Edit, and Command mode shortcut menus, restoring AutoCAD Release 14 behavior.</td>
</tr>
<tr>
<td>1</td>
<td>Enables Default mode shortcut menus.</td>
</tr>
<tr>
<td>2</td>
<td>Enables Edit mode shortcut menus.</td>
</tr>
<tr>
<td>4</td>
<td>Enables Command mode shortcut menus whenever a command is active.</td>
</tr>
<tr>
<td>8</td>
<td>Enables Command mode shortcut menus only when command options are currently available at the Command prompt.</td>
</tr>
<tr>
<td>16</td>
<td>Enables the display of a shortcut menu when the right button on the pointing device is held down long enough.</td>
</tr>
</tbody>
</table>

**NOTE** When this system variable is set to a value greater than 15, the SHORTCUTMENUDURATION (page 1471) system variable determines the length of time that the right button on the pointing device must be held down to display a shortcut menu.

See also:  
Set Up the Drawing Area

SHORTCUTMENUDURATION

Specifies how long the right button on a pointing device must be pressed to display a shortcut menu in the drawing area.
Type: Integer
Saved in: Registry
Initial value: 250

The value is expressed in milliseconds, and the valid range is 100 to 10,000.

If the right button is held down for the same or longer duration than the value of this system variable, a shortcut menu is displayed.

If the right button is held down for a shorter duration, the result is the same as if you press the Enter or Return key.

**NOTE** The SHORTCUTMENU (page 1471) system variable must be set to a value greater than 15 for this system variable to take effect.

See also:
Control the Drawing Area Interface

---

**SHOWALLUSEDLAYERSGROUP**

Controls the visibility of the dynamic All Used Layers layer group in the Layers palette.

Type: Integer
Saved in: Registry
Initial value: 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Not displayed</td>
</tr>
<tr>
<td>1</td>
<td>Displayed</td>
</tr>
</tbody>
</table>

See also:
The Layers Palette

---

**SHOWEMPTYGROUPS**

Controls the visibility of empty dynamic layer groups in the Layers palette.

Type: Integer
Saved in: Registry
**SHOWGROUPS**

Controls the visibility of layer groups in the Layers list of the Layers palette.

- **Type:** Integer
- **Saved in:** Registry
- **Initial value:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Not displayed</td>
</tr>
<tr>
<td>1</td>
<td>Displayed</td>
</tr>
</tbody>
</table>

**See also:**

The Layers Palette

**SHOWHIST**

Controls the Show History property for solids in a drawing.

- **Type:** Integer
- **Saved in:** Drawing
- **Initial value:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Sets the Show History property to No (read-only) for all solids. Oversides the individual Show History property settings for solids. You cannot view the original objects that were used to create the solid.</td>
</tr>
<tr>
<td>1</td>
<td>Displayed</td>
</tr>
</tbody>
</table>
1. Does not override the individual Show History property settings for solids.

2. Displays the history of all solids by overriding the individual Show History property settings for solids. You can view the original objects that were used to create the solid.

See also:
Display Original Forms of Composite Solids

SHOWPAGESETUPFORNEWLAYOUTS

Specifies whether the Page Setup Manager is displayed when a new layout is created.

Type: Integer
Saved in: Registry
Initial value: 0

0 | Do not display the Page Setup Manager when a new layout is created
1 | Display the Page setup Manager when a new layout is created

See also:
Use a Page Setup to Specify Plot Settings

SHOWPALETTESTATE

Indicates whether palettes were hidden by the HIDEPALETTES command or restored by the SHOWPALETTES command.

(Read-only)
Type: Integer
Saved in: Registry
Initial value:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Indicates that there are palettes hidden by the HIDEPALETTES command</td>
</tr>
<tr>
<td>1</td>
<td>Indicates that all palettes hidden by the HIDEPALETTES command were restored by the SHOWPALETTES command</td>
</tr>
</tbody>
</table>

See also:

Control the Drawing Area Interface

SHOWUNRECONCILEDLAYERSGROUP

Controls the visibility of the dynamic Unreconciled Layers layer group in the Layers palette.

Type: Integer
Saved in: Registry
Initial value: 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Not displayed</td>
</tr>
<tr>
<td>1</td>
<td>Displayed</td>
</tr>
</tbody>
</table>

See also:

The Layers Palette

SHOWVPOVERRIDESGROUP

Controls the visibility of the dynamic Viewport Overrides layer group in the Layers palette when focus is in a viewport on a layout.

Type: Integer
Saved in: Registry
Initial value: 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Not displayed</td>
</tr>
</tbody>
</table>
SHOWXREFGROUPS

Controls the visibility of layer groups that are saved in an attached external reference (xref) in the Layers palette.

Type: Integer
Saved in: Registry
Initial value: 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Not displayed</td>
</tr>
<tr>
<td>1</td>
<td>Displayed</td>
</tr>
</tbody>
</table>

See also:
The Layers Palette

SHOWXREFLAYERS

Controls the visibility of layers saved in an attached external reference (xref) in the Layers palette.

Type: Integer
Saved in: Registry
Initial value: 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Not displayed</td>
</tr>
<tr>
<td>1</td>
<td>Displayed</td>
</tr>
</tbody>
</table>

See also:
The Layers Palette
SHPNAME

Sets a default shape name that must conform to symbol-naming conventions.

**Type:** String  
**Saved in:** Not-saved  
**Initial value:**"

If no default is set, it returns "". Enter a period (.) to set no default.

See also:  
Shape Descriptions

SIGWARN

Controls whether a warning is presented when a file with an attached digital signature is opened.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:**

If the system variable is on and you open a file with a valid signature, the digital signature status is displayed. If the variable is off and you open a file, the digital signature status is displayed only if a signature is invalid.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Warning is not presented if a file has a valid signature</td>
</tr>
<tr>
<td>1</td>
<td>Warning is presented</td>
</tr>
</tbody>
</table>

SKETCHINC

Sets the record increment for the SKETCH command.

**Type:** Real  
**Saved in:** Drawing  
**Initial value:**0.1000 (imperial) or 1.0000 (metric)

See also:  
Draw Freehand Sketches
**SKPOLY**

Determines whether the SKETCH command generates lines, polylines, or splines.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Generates lines</td>
</tr>
<tr>
<td>1</td>
<td>Generates polylines</td>
</tr>
<tr>
<td>2</td>
<td>Generates splines</td>
</tr>
</tbody>
</table>

**See also:**  
Draw Freehand Sketches

**SKTOLERANCE**

Determines how closely the spline fits to the freehand sketch.

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** 0.5

Valid values are between 0 and 1.

**See also:**  
Draw Freehand Sketches

**SKYSTATUS**

Determines if the sky illumination is computed at render time.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0
This has no impact on the viewport illumination or the background. It only makes the sky available as a gathered light source for rendering.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Sky off</td>
</tr>
<tr>
<td>1</td>
<td>Sky background</td>
</tr>
<tr>
<td>2</td>
<td>Sky background and illumination</td>
</tr>
</tbody>
</table>

See also:
Sun and Sky Simulation

SMOOTHMESHCONVERT

Sets whether mesh objects that you convert to 3D solids or surfaces are smoothed or faceted, and whether their faces are merged.

**Type:** Bitcode  
**Saved in:** User-settings  
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Creates a smooth model. Coplanar faces are optimized, or merged.</td>
</tr>
<tr>
<td>1</td>
<td>Creates a smooth model. Original mesh faces are retained in the converted object.</td>
</tr>
<tr>
<td>2</td>
<td>Creates a model with flattened faces. Coplanar faces are optimized, or merged.</td>
</tr>
<tr>
<td>3</td>
<td>Creates a model with flattened faces. Original mesh faces are retained in the converted object.</td>
</tr>
</tbody>
</table>

This system variable sets the default value for operations that use CONVTSOLID (page 229) and CONVTOSURFACE (page 232) commands.

See also:
Create 3D Solids from Objects
**SMOOTHMESHGRID**

Sets the maximum level of smoothness at which the underlying mesh facet grid is displayed on 3D mesh objects.

**Type:** Integer  
**Saved in:** User-settings  
**Initial value:** 3

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Never displays the underlying mesh facet grid</td>
</tr>
<tr>
<td>1</td>
<td>Displays the facet grid for smoothing levels 0 and 1</td>
</tr>
<tr>
<td>2</td>
<td>Displays the facet grid for smoothing levels 2 and lower</td>
</tr>
<tr>
<td>3</td>
<td>Displays the facet grid for smoothing levels 3 and lower</td>
</tr>
<tr>
<td>4</td>
<td>Displays the facet grid for smoothing levels 4 and lower</td>
</tr>
</tbody>
</table>

Use this variable to help visualize smooth surfaces. By setting limits, you can simplify the display of the underlying facet grid when you work with extremely dense mesh objects.

You can enter any number, depending on the number of smoothing levels you expect. This variable does not affect the smoothing level of the mesh. Its value cannot exceed the value of SMOOTHMESHMAXLEV.

If the **VSLIGHTINGQUALITY** (page 1556) system variable is 0, this system variable is ignored and all smoothness levels are displayed as faceted.

**See also:**

- Change Mesh Smoothness Levels

**SMOOTHMESHMAXFACE**

Sets the maximum number of faces permitted for mesh objects.

**Type:** Integer  
**Saved in:** User-settings  
**Initial value:** 1000000
The initial value of this system variable is adjusted for best performance based on your system configuration. Permissible values are from 108 to 16,000,000. Use this limit to prevent creating extremely dense meshes that might affect program performance.

See also:

Change Mesh Smoothness Levels

SMOOTHMESHMAXLEV

Sets the maximum smoothness level for mesh objects.

Type: Integer
Saved in: User-settings
Initial value: 4

Permissible values are from 1 to 255. The recommended range is 1-5. Use this limit to prevent creating extremely dense meshes that might affect program performance.

See also:

Change Mesh Smoothness Levels

SNAPANG

Sets the snap and grid rotation angle for the current viewport relative to the current UCS.

Type: Real
Saved in: Drawing
Initial value: 0.0000

When SNAPANG is set to a value other than 0, the lined grid will not display.

See also:

Adjust Grid and Grid Snap
**SNAPBASE**

Sets the snap and grid origin point for the current viewport relative to the current UCS.

**Type:** 2D-point  
**Saved in:** Drawing  
**Initial value:** 0.0000, 0.0000

See also:  
Adjust Grid and Grid Snap

**SNAPGRIDLEGACY**

Controls whether the cursor snaps to the snap grid only when an operation is in progress.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0

<table>
<thead>
<tr>
<th>0</th>
<th>Makes the cursor snap to the snap grid only when SNAP is turned on, and an operation is in progress</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Makes the cursor snap to the snap grid at all times when SNAP is turned on (legacy behavior)</td>
</tr>
</tbody>
</table>

See also:  
Adjust Grid and Grid Snap

**SNAPISOPAIR**

Controls the isometric plane for the current viewport.

**Type:** Integer  
**Saved in:** Drawing
**SNAPMODE**

Turns the Snap mode on and off.

- **Type:** Integer
- **Saved in:** Drawing
- **Initial value:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Snap off</td>
</tr>
<tr>
<td>1</td>
<td>Snap on for the current viewport</td>
</tr>
</tbody>
</table>

**See also:**
- Adjust Grid and Grid Snap

**SNAPSTYL**

Sets the snap style for the current viewport.

- **Type:** Integer
- **Saved in:** Drawing
- **Initial value:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Standard (rectangular snap)</td>
</tr>
<tr>
<td>1</td>
<td>Isometric snap</td>
</tr>
</tbody>
</table>
### SNAPTYPE

Sets the type of snap for the current viewport.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Grid, or standard snap.</td>
</tr>
<tr>
<td>1</td>
<td>PolarSnap. Snaps along polar angle increments. Use PolarSnap with polar and object snap tracking.</td>
</tr>
</tbody>
</table>

**See also:** Adjust Grid and Grid Snap

### SNAPUNIT

Sets the snap spacing for the current viewport.

**Type:** 2D-point  
**Saved in:** Drawing  
**Initial value:** 0.5000,0.5000 (imperial) or 10.0000,10.0000 (metric)

If SNAPSTYL is set to 1, the X value of SNAPUNIT is adjusted automatically to accommodate the isometric snap.

Changes to this system variable are not reflected in the grid until the display is refreshed.

**See also:** Adjust Grid and Grid Snap
**SOLIDCHECK**

Turns 3D solid validation on and off for the current session.

**Type:** Integer  
**Saved in:** Not-saved  
**Initial value:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off</td>
</tr>
<tr>
<td>1</td>
<td>On</td>
</tr>
</tbody>
</table>

See also:  
Clean and Check 3D Solids

**SOLIDHIST**

Controls whether new composite solids retain a history of their original components.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Sets the History property to None for new solids. No history is retained.</td>
</tr>
<tr>
<td>1</td>
<td>Sets the History property to Record for new solids. Solids retain a history of their original objects.</td>
</tr>
</tbody>
</table>

See also:  
Display Original Forms of Composite Solids
SORTENTS

Controls object sorting in support of draw order for several operations.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 127

The setting is stored as a bitcode using the sum of the following values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Turns off all object sorting</td>
</tr>
<tr>
<td>1</td>
<td>Sorts for object selection</td>
</tr>
<tr>
<td>2</td>
<td>Sorts for object snaps</td>
</tr>
<tr>
<td>4</td>
<td>Obsolete, has no effect</td>
</tr>
<tr>
<td>8</td>
<td>Obsolete, has no effect</td>
</tr>
<tr>
<td>16</td>
<td>Sorts for REGEN commands</td>
</tr>
<tr>
<td>32</td>
<td>Sorts for plotting</td>
</tr>
<tr>
<td>64</td>
<td>Obsolete, has no effect</td>
</tr>
</tbody>
</table>

**See also:**  
Control How Overlapping Objects Are Displayed

SPACEPAN

Controls whether pressing and holding the Spacebar starts the PAN command transparently.

**Type:** Integer  
**Saved in:** Registry
**Initial value:**

0  PAN command does not start transparently when the Spacebar is held.

1  PAN command starts transparently after the Spacebar is held for the duration specified in the SPACEPANTIMEOUT system variable.

See also:
- Pan or Zoom a View

**SPACEPANTIMEOUT**

Sets the duration that the Spacebar must be held down before the PAN command is started transparently.

*Type:* Integer  
*Saved in:* Registry  
*Initial value:*250

Duration is measured in milliseconds. Valid range is 100 to 1000.

See also:
- Pan or Zoom a View

**SPLDEGREE**

Stores the last-used degree setting for splines and sets the default degree setting for the SPLINE command when specifying control vertices.

(Read-only)  
*Type:* Integer  
*Saved in:* Not-saved  
*Initial value:*3

Enter a value from 1 to 5.

---

**NOTE** SPLDEGREE defaults to 3 when AutoCAD starts.
See also:
    Modify Polylines

**SPLFRAME**

Controls the display of helixes and smoothed mesh objects.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Display Options</th>
</tr>
</thead>
</table>
| 0     | - Does not display the control polygon for helixes.  
        - Displays smoothed mesh objects if they have been smoothed.  
        - Does not display the invisible edges of 3D faces or polyface meshes. |
| 1     | - Displays the control polygon for helixes.  
        - Displays unsmoothed mesh objects, even if they have been smoothed.  
        - Displays the edges of 3D faces and polyface meshes. |

**NOTE** To control the display for splines, use the `CVSHOW` (page 253) and the `CVHIDE` (page 248) commands.

See also:
    Overview of Creating Meshes

**SPLINESEGS**

Sets the number of line segments to be generated for each spline-fit polyline generated by the Spline option of the `PEDIT` command.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 8

Enter a non-zero integer between -32768 to 32767. If you set `SPLINESEGS` to a negative value, segments are generated using the absolute value of the setting.
and then a fit-type curve is applied to those segments. Fit-type curves use arcs as the approximating segments. Using arcs yields a smoother generated curve when few segments are specified, but the curve can take longer to generate.

See also:
Modify Polylines

**SPLINETYPE**

Sets the type of curve generated by the Spline option of the PEDIT command.

<table>
<thead>
<tr>
<th>Type</th>
<th>Saved in</th>
<th>Initial value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integer</td>
<td>Drawing</td>
<td>6</td>
</tr>
</tbody>
</table>

- **5** Quadratic B-spline
- **6** Cubic B-spline

See also:
Modify Polylines

**SPLKNOTS**

Stores the default knot option for the SPLINE command when specifying fit points.

<table>
<thead>
<tr>
<th>Type</th>
<th>Saved in</th>
<th>Initial value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integer</td>
<td>Not-saved</td>
<td>0</td>
</tr>
</tbody>
</table>

- **0** Chord distance
- **1** Square root of chord distance
- **2** Uniform distance
NOTE SPLKNOTS always defaults to 0 when AutoCAD starts.

See also:
Modify Splines

SPLMETHOD
Stores whether the default method used for the SPLINE command is fit points or control vertices.

Type: Integer
Saved in: Not-saved
Initial value: 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Create splines using fit points</td>
</tr>
<tr>
<td>1</td>
<td>Create splines using control vertices</td>
</tr>
</tbody>
</table>

NOTE SPLMETHOD always defaults to 0 when AutoCAD starts.

See also:
Draw Splines

SPLPERIODIC
Controls whether closed splines and NURBS surfaces are generated with periodic properties to maintain the smoothest continuity at the closure point or seam.

Type: Integer
Saved in: User-settings
Initial value: 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Creates closed splines and NURBS surfaces with the method used in AutoCAD 2011 and earlier releases.</td>
</tr>
<tr>
<td>1</td>
<td>Creates periodic closed splines and closed NURBS surfaces, for the smoothest (C2) continuity. (Recommended)</td>
</tr>
</tbody>
</table>
See also:

* Draw Splines

**SSFOUND**

Displays the path and file name if a search for a project file is successful.

(Read-only)

**Type:** String

**Saved in:** Not-saved

**Initial value:** ""

SSLOCATE must be set to 1 and the drawing file must be open for a successful search.

See also:

* Publish a Project

**SSLOCATE**

Controls whether the project associated with a drawing is located and opened when the drawing is opened.

**Type:** Integer

**Saved in:** User-settings

**Initial value:** 1

<table>
<thead>
<tr>
<th></th>
<th>Does not open a drawing's project with the drawing</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Opens a drawing's project with the drawing</td>
</tr>
</tbody>
</table>

**SSMAUTOOPEN** (page 1492) and SSLOCATE must both be set to 1 to open a project automatically in the Project Manager.

See also:

* Create and Modify Layouts in a Project
SSMAUTOOPEN

Controls the display behavior of the Project Manager when a drawing associated with a layout is opened.

**Type:** Integer  
**Saved in:** User-settings  
**Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Does not open the Project Manager automatically</td>
</tr>
<tr>
<td>1</td>
<td>Opens the Project Manager automatically</td>
</tr>
</tbody>
</table>

SSMAUTOOPEN and **SSLOCATE** (page 1491) must both be set to 1 to open a project automatically in the Project Manager.

**See also:**  
Create and Modify Layouts in a Project

SSMPOLLTIME

Controls the time interval between automatic refreshes of the status data in a project.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 60

The SSMPOLLTIME timer sets the time in seconds between automatic refreshes of the status data of layouts in a project. Valid values are 20-600. The **SSMSHEETSTATUS** (page 1492) system variable must be set to 2 for the timer to operate.

**See also:**  
Create and Modify Layouts in a Project

SSMSHEETSTATUS

Controls how the status data in a project is refreshed.
**Type:** Integer

**Saved in:** Registry

**Initial value:** 2

The status data for layouts in the current project includes whether a layout is locked and whether a layout is missing (or found in an unexpected location). This status data can be updated automatically for all layouts.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Do not automatically refresh the status data in a project</td>
</tr>
<tr>
<td>1</td>
<td>Refresh the status data when the project is loaded or updated</td>
</tr>
<tr>
<td>2</td>
<td>Refresh the status data when the project is loaded or updated, or at a time interval set by SSMPOLLTIME (page 1492)</td>
</tr>
</tbody>
</table>

**See also:**

Create and Modify Layouts in a Project

---

**SSMSTATE**

Indicates whether the Project Manager window is open or closed.

(Read-only)

**Type:** Integer

**Saved in:** Not-saved

**Initial value:** Varies

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Closed</td>
</tr>
<tr>
<td>1</td>
<td>Open</td>
</tr>
</tbody>
</table>

**See also:**

Create a Project

---

**STATUSBAR**

Controls the display of the status bar.
**Integer**

**Saved in:** Registry

**Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Hides the status bar</td>
</tr>
<tr>
<td>1</td>
<td>Shows the status bar</td>
</tr>
</tbody>
</table>

**See also:**

The Status Bar

**SUBOBJSELECTIONMODE**

Filters whether faces, edges, vertices or solid history subobjects are highlighted when you roll over them.

**Type:** Integer

**Saved in:** Not-saved

**Initial value:** 0

In busy 3D environments with many objects, it can be helpful to filter certain subobjects out of the selection highlighting.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>When subobject filtering is off, press Ctrl+click to select a face, edge, vertex or a history subobject. (Shift-F1)</td>
</tr>
<tr>
<td>1</td>
<td>Only vertices are available for selection (Shift-F2)</td>
</tr>
<tr>
<td>2</td>
<td>Only edges are available for selection. (Shift-F3)</td>
</tr>
<tr>
<td>3</td>
<td>Only faces are available for selection. (Shift-F4)</td>
</tr>
<tr>
<td>4</td>
<td>Only history subobjects of compound objects are available for selection. (Shift-F5)</td>
</tr>
</tbody>
</table>

Turn off subobject filtering if you want to select the entire object. You can also press Ctrl-click to select faces, edges, and vertices.
When filtering is set for vertices, you cannot select faces, edges, or history subobjects.

When filtering is set for edges, you cannot select faces, vertices, or history subobjects.

When filtering is set for faces, you cannot select edges, vertices, or history subobjects.
When filtering is set for history subobjects, you can only select the wireframe representations of portions of objects removed during a union, subtract, or intersect operation.

**Subobject Selection Filter Cursors**

When a subobject selection filter is set, the following images are displayed next to the cursor:

<table>
<thead>
<tr>
<th>Image</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Vertex filtering" /></td>
<td>Vertex filtering is on</td>
</tr>
<tr>
<td><img src="image" alt="Edge filtering" /></td>
<td>Edge filtering is on</td>
</tr>
<tr>
<td><img src="image" alt="Face filtering" /></td>
<td>Face filtering is on</td>
</tr>
<tr>
<td><img src="image" alt="History subobject filtering" /></td>
<td>History subobject filtering is on</td>
</tr>
</tbody>
</table>
SUNSTATUS

Turns on and off the lighting effects of the sun in the current viewport.

Type: Integer
Saved in: Drawing
Initial value: 0

Only the lights from sources other than the sun affect the view in the current viewport.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off</td>
</tr>
<tr>
<td>1</td>
<td>On</td>
</tr>
</tbody>
</table>

See also:
Sun and Sky Simulation

SUPPRESSALERTS

Controls alerts about potential data loss when opening and saving newer drawings in older versions of the product.

Type: Integer
Saved in: Not-saved
Initial value: 0
By default, an alert displays when a drawing is opened from a more recent version of the product that contains data that might be lost if the drawing is edited and saved.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>The alert is displayed</td>
</tr>
<tr>
<td>1</td>
<td>The alert is suppressed, which might be desirable when running scripts</td>
</tr>
</tbody>
</table>

See also:
- Work with Drawings in Earlier Releases
- Open a Drawing
- Save a Drawing

**SURFACEASSOCIATIVITY**

Controls whether surfaces maintain a relationship with the objects from which they were created.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 1

When associativity is on, surfaces automatically adjust to modifications made to other, related surfaces.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Surfaces are created with no associativity to other surfaces</td>
</tr>
<tr>
<td>1</td>
<td>Surfaces are created with associativity to other surfaces</td>
</tr>
</tbody>
</table>

When set to 1, the DELOBJ (page 1251) system variable is ignored. Defining geometry are not deleted when an associative surface is created.

See also:
- Create Associative Surfaces
SURFACEASSOCIATIVITYDRAG

Sets the dragging preview behavior of associative surfaces.

**Type:** Switch

**Saved in:** Registry

**Initial value:** 1

Controls the preview behavior of surfaces and any associated surfaces when a selected surface is dragged. Disabling the preview can increase performance.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Displays no preview. The display refreshes after dragging is complete.</td>
</tr>
<tr>
<td>1</td>
<td>Previews only the movement of the first associated surface. All other</td>
</tr>
<tr>
<td></td>
<td>associated surfaces do not move until after dragging is complete.</td>
</tr>
<tr>
<td>2</td>
<td>Previews the movement of all associated surfaces.</td>
</tr>
</tbody>
</table>

**See also:**
Create Associative Surfaces

SURFACEAUTOTRIM

Controls whether surfaces are automatically trimmed when you project geometry onto them.

**Type:** Integer

**Saved in:** Registry

**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Surfaces are not trimmed when you project geometry onto them.</td>
</tr>
<tr>
<td>1</td>
<td>Surfaces are automatically trimmed to geometry that is projected using PROJECTGEOMETRY (page 841).</td>
</tr>
</tbody>
</table>

**See also:**
Trim and Untrim Surfaces
SURFACEMODELINGMODE

Controls whether surfaces are created as procedural surfaces or NURBS surfaces.

**Type:** Switch  
**Saved in:** Not-saved  
**Initial value:** 0

<table>
<thead>
<tr>
<th>0</th>
<th>Creates a <em>procedural surface</em> when creating surfaces.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Creates a <em>NURBS surface</em> when creating surfaces.</td>
</tr>
</tbody>
</table>

See also:
- Create Solids and Surfaces from Lines and Curves
- Create Surfaces

SURFTAB1

Sets the number of tabulations to be generated for the RULESURF and TABSURF commands.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 6

Also sets the mesh density in the M direction for the REVSURF and EDGESURF commands.

See also:
- Construct Meshes from Other Objects

SURFTAB2

Sets the mesh density in the N direction for the REVSURF and EDGESURF commands.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 6
See also:

Construct Meshes from Other Objects

**SURFTYPE**

Controls the type of surface-fitting to be performed by the Smooth option of the PEDIT command.

*Type:* Integer

*Saved in:* Drawing

*Initial value:* 6

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Quadratic B-spline surface</td>
</tr>
<tr>
<td>6</td>
<td>Cubic B-spline surface</td>
</tr>
<tr>
<td>8</td>
<td>Bezier surface</td>
</tr>
</tbody>
</table>

See also:

Modify Polylines

**SURFU**

Sets the surface density for PEDIT Smooth in the M direction and the U isolines density on surface objects.

*Type:* Integer

*Saved in:* Drawing

*Initial value:* 6

Valid values are 0 through 200. Meshes are always created with a minimum surface density of 2.

See also:

Modify Polylines
**SURFV**

Sets the surface density for PEDIT Smooth in the N direction and the V isolines density on surface objects.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 6

Valid values are 0 through 200. Meshes are always created with a minimum surface density of 2.

**See also:**  
Modify Polylines

**SYSCODEPAGE**

Indicates the system code page, which is determined by the operating system.

(Read-only)  
**Type:** String  
**Saved in:** Not-saved  
**Initial value:**Varies

To change the code page, see Help for your operating system.

**See also:**  
Use Text Fonts for International Work

**T System Variables**

**TABLEINDICATOR**

Controls the display of row numbers and column letters when the In-Place Text Editor is open for editing a table cell.

**Type:** Integer  
**Saved in:** Registry
**TARGET**

Stores the location (as a UCS coordinate) of the target point for the current viewport.

(Read-only)

**Type:** 3D-point  
**Saved in:** Drawing  
**Initial value:** 0.0000, 0.0000, 0.0000

**See also:**  
- Overview of Parallel and Perspective Views

**TBSHOWSHORTCUTS**

Specifies if shortcut keys are displayed in tooltips.

**Type:** String  
**Saved in:** Registry  
**Initial value:** yes

<table>
<thead>
<tr>
<th>no</th>
<th>Display shortcut keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>yes</td>
<td>Do not display shortcut keys</td>
</tr>
</tbody>
</table>
**TDCREATE**

Stores the local time and date the drawing was created.

(Read-only)

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** Varies

**See also:**
- Add Identifying Information to Drawings

**TDINWDG**

Stores the total editing time, which is the total elapsed time between saves of the current drawing.

(Read-only)

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** Varies

The format is:

<number of days>.<decimal fraction of a day>

To compute the number of seconds, multiply the decimal fraction in TDINWDG by 86400 seconds.

**See also:**
- Add Identifying Information to Drawings

**TDUCREATE**

Stores the universal time and date that the drawing was created.

(Read-only)

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** Varies
See also:

Add Identifying Information to Drawings

**TDUPDATE**

Stores the local time and date of the last update/save.

(Read-only)

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** Varies

See also:

Add Identifying Information to Drawings

**TDUSRTIMER**

Stores the user-elapsed timer.

(Read-only)

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** Varies

See also:

Add Identifying Information to Drawings

**TDUUPDATE**

Stores the universal time and date of the last update or save.

(Read-only)

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** Varies

See also:

Add Identifying Information to Drawings
TEMPOVERRIDES

Turns temporary override keys on and off.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 1

A temporary override key is a key that you can hold down to temporarily turn on or turn off one of the drawing aids that are set in the Drafting Settings dialog box; for example, Ortho mode, object snaps, or Polar mode.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off</td>
</tr>
<tr>
<td>1</td>
<td>On</td>
</tr>
</tbody>
</table>

**See also:**  
Override Object Snap Settings

TEMPPREFIX

Contains the directory name (if any) configured for placement of temporary files, with a path separator appended.

(Read-only)

**Type:** String  
**Saved in:** Not-saved  
**Initial value:** Varies

You can modify the location from the Application Preferences dialog box, Application tab, Files section, under Temporary Drawing File Location.

**See also:**  
Specify Search Paths and File Locations

TEXTED

Specifies the user interface displayed for editing single-line text.

**Type:** Integer
**Saved in:** Registry  
**Initial value:** 2

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Displays the In-Place Text Editor when creating or editing single-line text.</td>
</tr>
<tr>
<td>1</td>
<td>Displays the Edit Text dialog box when editing single-line text.</td>
</tr>
<tr>
<td>2</td>
<td>Displays the In-Place Text Editor when creating or editing single-line text. Repeats the command automatically.</td>
</tr>
</tbody>
</table>

**See also:**  
Change Single-Line Text

---

**TEXTEVAL**

Controls how text strings entered with TEXT (using scripts or AutoLISP) or with -TEXT are evaluated.  

**Type:** Integer  
**Saved in:** Not-saved  
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>All responses to prompts for text strings and attribute values are taken literally.</td>
</tr>
<tr>
<td>1</td>
<td>All text starting from an opening parenthesis [()] or an exclamation mark [!] is evaluated as an AutoLISP expression, as for nontextual input.</td>
</tr>
</tbody>
</table>

The TEXT (page 1078) command takes all input literally regardless of the setting of TEXTEVAL unless it is executed completely with a script or AutoLISP expression. The -TEXT command honors the setting of TEXTEVAL.

**See also:**  
Create Single-Line Text
**TEXTFILL**

Controls the filling of TrueType fonts while printing.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Displays text as outlines</td>
</tr>
<tr>
<td>1</td>
<td>Displays text as filled images</td>
</tr>
</tbody>
</table>

See also:
- Use TrueType Fonts

**TEXTOUTPUTFILEFORMAT**

Provides Unicode options for log files.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>ANSI format</td>
</tr>
<tr>
<td>1</td>
<td>UTF-8 (Unicode)</td>
</tr>
<tr>
<td>2</td>
<td>UTF-16LE (Unicode)</td>
</tr>
<tr>
<td>3</td>
<td>UTF-16BE (Unicode)</td>
</tr>
</tbody>
</table>

See also:
- Share Drawing Files Internationally
TEXTQLTY

Sets the resolution tessellation fineness of text outlines.

**Type:** Integer

**Saved in:** Not-saved

**Initial value:** 50

Sets the resolution tessellation fineness of text outlines for TrueType fonts while plotting and rendering. 0 represents no effort to refine the smoothness of the text; 100 represents a maximum effort to smooth text characters. Lower values decrease resolution and increase plotting speed. Higher values increase resolution and decrease plotting speed.

Sets the resolution of TrueType fonts while plotting. Use integer values from 0 to 100. Lower values decrease resolution and increase plotting speed. Higher values increase resolution and decrease plotting speed.

**See also:**
- Use TrueType Fonts

TEXTSIZE

Sets the default height for new text objects drawn with the current text style.

**Type:** Real

**Saved in:** Drawing

**Initial value:** 0.2000 (imperial) or 2.5000 (metric)

TEXTSIZE has no effect if the current text style has a fixed height.

**See also:**
- Set Text Height

TEXTSTYLE

Sets the name of the current text style.

**Type:** String

**Saved in:** Drawing

**Initial value:** Standard
See also:
  Overview of Text Styles

THICKNESS

Sets the current 3D thickness.

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** 0.0000

See also:
  Add 3D Thickness to Objects

THUMBSAVE

Controls whether thumbnail preview images are created and saved with the drawing.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No preview image is saved in the drawing</td>
</tr>
<tr>
<td>1</td>
<td>A preview image is created and saved in the drawing</td>
</tr>
</tbody>
</table>

See also:
  Open a Drawing  
  Save a Drawing  
  Preview Open Drawings and Layouts

THUMBSIZE

Specifies the display resolution in pixels for all thumbnail preview images.

**Type:** Integer
Saved in: Registry
Initial value: 3

Whether preview images are saved in drawings is controlled by the THUMB SAVE system variable.

<table>
<thead>
<tr>
<th>Value</th>
<th>Preview Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>64 x 64</td>
</tr>
<tr>
<td>1</td>
<td>128 x 128</td>
</tr>
<tr>
<td>2</td>
<td>256 x 256</td>
</tr>
<tr>
<td>3</td>
<td>512 x 512</td>
</tr>
<tr>
<td>4</td>
<td>1024 x 1024</td>
</tr>
<tr>
<td>5</td>
<td>1440 x 1440</td>
</tr>
<tr>
<td>6</td>
<td>1600 x 1600</td>
</tr>
<tr>
<td>7</td>
<td>1920 x 1920</td>
</tr>
<tr>
<td>8</td>
<td>2560 x 2560</td>
</tr>
</tbody>
</table>

See also:
- Open a Drawing
- Save a Drawing
- Preview Open Drawings and Layouts

**TILEMODE**

Makes the Model tab or the last layout tab current.

**Type:** Integer

**Saved in:** Drawing

**Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Makes the last active layout tab (paper space) active</td>
</tr>
</tbody>
</table>
Makes the Model tab active

See also:
Set Model Space Viewports

TIMEZONE

Sets the time zone for the sun in the drawing.

**Type:** Enum  
**Saved in:** Drawing

**Initial value:** -8000

The values in the table are expressed as hours and minutes away from Greenwich Mean Time. The geographic location you set also sets the time zone.

<table>
<thead>
<tr>
<th>Value</th>
<th>Time Zone</th>
</tr>
</thead>
<tbody>
<tr>
<td>-12000</td>
<td>International Date Line West</td>
</tr>
<tr>
<td>-11000</td>
<td>Midway Island, Samoa</td>
</tr>
<tr>
<td>-10000</td>
<td>Hawaii</td>
</tr>
<tr>
<td>-9000</td>
<td>Alaska</td>
</tr>
<tr>
<td>-8000</td>
<td>Pacific Time (US &amp; Canada), Tijuana</td>
</tr>
<tr>
<td>-7000</td>
<td>Arizona</td>
</tr>
<tr>
<td>-7000</td>
<td>Chihuahua, La Paz, Mazatlan</td>
</tr>
<tr>
<td>-7000</td>
<td>Mountain Time (US &amp; Canada)</td>
</tr>
<tr>
<td>-7001</td>
<td>Arizona</td>
</tr>
<tr>
<td>-7002</td>
<td>Mazatlan</td>
</tr>
<tr>
<td>Time Zone</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>-6000</td>
<td>Central America</td>
</tr>
<tr>
<td>-6001</td>
<td>Central Time (US &amp; Canada)</td>
</tr>
<tr>
<td>-6002</td>
<td>Guadalajara, Mexico City, Monterrey</td>
</tr>
<tr>
<td>-6003</td>
<td>Saskatchewan</td>
</tr>
<tr>
<td>-5000</td>
<td>Eastern Time (US &amp; Canada)</td>
</tr>
<tr>
<td>-5001</td>
<td>Indiana (East)</td>
</tr>
<tr>
<td>-5002</td>
<td>Bogota, Lima, Quito</td>
</tr>
<tr>
<td>-4000</td>
<td>Atlantic Time (Canada)</td>
</tr>
<tr>
<td>-4001</td>
<td>Caracas, La Paz</td>
</tr>
<tr>
<td>-4002</td>
<td>Santiago</td>
</tr>
<tr>
<td>-3300</td>
<td>Newfoundland</td>
</tr>
<tr>
<td>-3000</td>
<td>Brasilia</td>
</tr>
<tr>
<td>-3001</td>
<td>Buenos Aires, Georgetown</td>
</tr>
<tr>
<td>-3002</td>
<td>Greenland</td>
</tr>
<tr>
<td>-2000</td>
<td>Mid-Atlantic</td>
</tr>
<tr>
<td>-1000</td>
<td>Azores</td>
</tr>
<tr>
<td>-1001</td>
<td>Cape Verde Is.</td>
</tr>
<tr>
<td>0</td>
<td>Universal Coordinated Time</td>
</tr>
<tr>
<td>Time Zone</td>
<td>Cities</td>
</tr>
<tr>
<td>----------</td>
<td>--------</td>
</tr>
<tr>
<td>+1000</td>
<td>Amsterdam, Berlin, Bern, Rome, Stockholm</td>
</tr>
<tr>
<td>+1001</td>
<td>Brussels, Madrid, Copenhagen, Paris</td>
</tr>
<tr>
<td>+1002</td>
<td>Belgrade, Bratislava, Budapest, Ljubljana, Prague</td>
</tr>
<tr>
<td>+1003</td>
<td>Sarajevo, Skopje, Warsaw, Zagreb</td>
</tr>
<tr>
<td>+1004</td>
<td>West Central Africa</td>
</tr>
<tr>
<td>+2000</td>
<td>Athens, Beirut, Istanbul, Minsk</td>
</tr>
<tr>
<td>+2001</td>
<td>Bucharest</td>
</tr>
<tr>
<td>+2002</td>
<td>Cairo</td>
</tr>
<tr>
<td>+2003</td>
<td>Harare, Pretoria</td>
</tr>
<tr>
<td>+2004</td>
<td>Helsinki, Kyiv, Sofia, Talinn, Vilnius</td>
</tr>
<tr>
<td>+2005</td>
<td>Jerusalem</td>
</tr>
<tr>
<td>+3000</td>
<td>Moscow, St. Petersburg, Volograd</td>
</tr>
<tr>
<td>+3001</td>
<td>Kuwait, Riyadh</td>
</tr>
<tr>
<td>+3002</td>
<td>Baghdad</td>
</tr>
<tr>
<td>+3003</td>
<td>Nairobi</td>
</tr>
<tr>
<td>+3300</td>
<td>Tehran</td>
</tr>
<tr>
<td>Code</td>
<td>City</td>
</tr>
<tr>
<td>-------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>+4000</td>
<td>Abu Dhabi, Muscat</td>
</tr>
<tr>
<td>+4001</td>
<td>Baku, Tbilisi, Yerevan</td>
</tr>
<tr>
<td>+4300</td>
<td>Kabul</td>
</tr>
<tr>
<td>+5000</td>
<td>Ekaterinburg</td>
</tr>
<tr>
<td>+5001</td>
<td>Islamabad, Karachi, Tashkent</td>
</tr>
<tr>
<td>+5300</td>
<td>Chennai, Kolkata, Mumbai, New Delhi</td>
</tr>
<tr>
<td>+5450</td>
<td>Kathmandu</td>
</tr>
<tr>
<td>+6000</td>
<td>Almaty, Novosibirsk</td>
</tr>
<tr>
<td>+6001</td>
<td>Astana, Dhaka</td>
</tr>
<tr>
<td>+6002</td>
<td>Sri Jayawardenepura</td>
</tr>
<tr>
<td>+6300</td>
<td>Rangoon</td>
</tr>
<tr>
<td>+7000</td>
<td>Bangkok, Hanoi, Jakarta</td>
</tr>
<tr>
<td>+7001</td>
<td>Krasnoyarsk</td>
</tr>
<tr>
<td>+8000</td>
<td>Beijing, Chongqing, Hong Kong, Urumqi</td>
</tr>
<tr>
<td>+8001</td>
<td>Kuala Lumpur, Singapore</td>
</tr>
<tr>
<td>+8002</td>
<td>Taipei</td>
</tr>
<tr>
<td>+8003</td>
<td>Irkutsk, Ulaan Batar</td>
</tr>
<tr>
<td>+8004</td>
<td>Perth</td>
</tr>
</tbody>
</table>
See also:
   Specify Units and Unit Formats

**TOOLSETSSTATE**

Indicates whether the Tool Sets palette is open or closed.
(Read-only)
**TOOLTIPMERGE**

Combines drafting tooltips into a single tooltip.

- **Type:** Switch
- **Saved in:** Registry
- **Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off</td>
</tr>
<tr>
<td>1</td>
<td>On</td>
</tr>
</tbody>
</table>

**See also:**
Set Interface Options

**TOOLTIPSIZE**

Sets the display size for drafting tooltips, and for automatic completion text at the Command prompt.

- **Type:** Integer
- **Saved in:** Registry
- **Initial value:** 0

Valid range is -3 to 6. Greater values result in larger drafting tooltips, and larger automatic completion text at the Command prompt. Negative values represent smaller sizes than the default.
See also:

Use Dynamic Input

**TOOLTIPTRANSPARENCY**

Sets the transparency for drafting tooltips.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 0

Valid range is 0 to 100. When a value of 0 is used, the drafting tooltip is fully opaque. The greater the value entered, the more transparent the drafting tooltip will appear.

See also:

Parts of the User Interface

**TRACKPATH**

Controls the display of polar and object snap tracking alignment paths.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Displays full-screen polar and object snap tracking paths</td>
</tr>
<tr>
<td>1</td>
<td>Displays full-screen polar tracking path; displays object snap tracking path only between the alignment point and the From point to the cursor location</td>
</tr>
<tr>
<td>2</td>
<td>Displays full-screen object snap tracking path; does not display polar tracking path</td>
</tr>
<tr>
<td>3</td>
<td>Does not display polar tracking path; displays object snap tracking path only between the alignment point and the From point to the cursor location</td>
</tr>
</tbody>
</table>
See also:
Use Polar Tracking and PolarSnap

**TRANSPARENCYDISPLAY**

Controls whether the object transparency is displayed.

| Type: Integer |
| Saved in: Registry |
| **Initial value:** 1 |

| 0 | Object transparency is not displayed |
| 1 | Object transparency is displayed |

See also:
Control the Display Properties of Certain Objects

**TREEDEPTH**

Specifies the maximum depth, that is, the number of times the tree-structured spatial index can divide into branches.

| Type: Integer |
| Saved in: Drawing |
| **Initial value:** 3020 |

| 0 | Suppresses the spatial index entirely, eliminating the performance improvements it provides in working with large drawings. This setting assures that objects are always processed in database order. |
| >0 | Turns on spatial indexing. An integer of up to five digits is valid. The first three digits refer to model space, and the remaining two digits refer to paper space. |
| <0 | Treats model space objects as 2D (Z coordinates are ignored), as is always the case with paper space objects. Such a setting is appropri- |
ate for 2D drawings and makes more efficient use of memory without loss of performance

**NOTE** You cannot use TREEDEPTH transparently.

**See also:**

- Work with Layer and Spatial Indexes

---

**TREEMAX**

Limits memory consumption during drawing regeneration by limiting the number of nodes in the spatial index (oct-tree).

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 10000000

By imposing a fixed limit with TREEMAX, you can load drawings created on systems with more memory than your system and with a larger TREEDEPTH (page 1519) than your system can handle. These drawings, if left unchecked, have an oct-tree large enough to eventually consume more memory than is available to your computer. TREEMAX also provides a safeguard against experimentation with inappropriately high TREEDEPTH (page 1519) values.

The initial default for TREEMAX is 10000000 (10 million), a value high enough to effectively disable TREEMAX as a control for TREEDEPTH (page 1519). The value to which you should set TREEMAX depends on your system's available RAM. You get about 15,000 oct-tree nodes per megabyte of RAM.

If you want an oct-tree to use up to, but no more than, 2 megabytes of RAM, set TREEMAX to 30000 (2 x 15,000). If the program runs out of memory allocating oct-tree nodes, restart, set TREEMAX to a smaller number, and try loading the drawing again.

The program might occasionally run into the limit you set with TREEMAX. Follow the resulting prompt instructions. Your ability to increase TREEMAX depends on your computer's available memory.

**See also:**

- Work with Layer and Spatial Indexes
TRIMMODE

Controls whether selected edges for chamfers and fillets are trimmed.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Leaves selected edges intact</td>
</tr>
<tr>
<td>1</td>
<td>Trims selected edges to the endpoints of chamfer lines and fillet arcs</td>
</tr>
</tbody>
</table>

See also:
Create Chamfers

TSPACEFAC

Controls the multiline text line-spacing distance measured as a factor of text height.

**Type:** Real  
**Saved in:** Not-saved  
**Initial value:** 1.0000

Valid values are 0.25 to 4.0.

See also:
Specify the Line Spacing Within Multiline Text

TSPACETYPE

Controls the type of line spacing used in multiline text.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 1
At Least adjusts line spacing based on the tallest characters in a line. Exactly uses the specified line spacing, regardless of individual character sizes.

1  At Least
2  Exactly

See also:
Specify the Line Spacing Within Multiline Text

TSTACKALIGN

Controls the vertical alignment of stacked text.

Type: Integer
Saved in: Drawing
Initial value: 1

<table>
<thead>
<tr>
<th>Integer</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Bottom aligned</td>
</tr>
<tr>
<td>1</td>
<td>Center aligned</td>
</tr>
<tr>
<td>2</td>
<td>Top aligned</td>
</tr>
</tbody>
</table>

See also:
Create Stacked Characters Within Multiline Text

TSTACKSIZE

Controls the percentage of stacked text fraction height relative to selected text's current height.

Type: Integer
Saved in: Drawing
Initial value: 70

Valid values are from 25 to 125.
U System Variables

**UCS2DDISPLAYSETTING**

Displays the UCS icon when the 2D Wireframe visual style is current.

<table>
<thead>
<tr>
<th>Type:</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>Registry</td>
</tr>
<tr>
<td>Initial value:</td>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off. The UCS icon is not displayed when the 2D Wireframe visual style is current.</td>
</tr>
<tr>
<td>1</td>
<td>On. The UCS icon is displayed when the 2D Wireframe visual style is current.</td>
</tr>
</tbody>
</table>

**NOTE** The `UCSICON` (page 1112) command must also be set to ON to display the UCS icon.

See also:

- The UCS Icon
- Control the Display of the User Coordinate System Icon

**UCS3DPARADISPLAYSETTING**

Displays the UCS icon when perspective view is off and a 3D visual style is current.

<table>
<thead>
<tr>
<th>Type:</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>Registry</td>
</tr>
<tr>
<td>Initial value:</td>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off. The UCS icon is not displayed when perspective is turned off and a 3D visual style is current.</td>
</tr>
</tbody>
</table>
On. The UCS icon is displayed when perspective is turned off and a 3D visual style is current.

NOTE The UCSICON (page 1112) command must also be set to ON to display the UCS icon.

See also:
- The UCS Icon
- Control the Display of the User Coordinate System Icon

**UCS3DPERPDISPLAYSETTING**

Displays the UCS icon when perspective view is on and a 3D visual style is current.

<table>
<thead>
<tr>
<th>Type: Integer</th>
<th>Saved in: Registry</th>
<th>Initial value: 1</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>0</th>
<th>Off. The UCS icon is not displayed when perspective is turned on and a 3D visual style is current.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>On. The UCS icon is displayed when perspective is turned on and a 3D visual style is current.</td>
</tr>
</tbody>
</table>

NOTE The UCSICON (page 1112) command must also be set to ON to display the UCS icon.

See also:
- The UCS Icon
- Control the Display of the User Coordinate System Icon

**UCSAXISANG**

Stores the default angle when rotating the UCS around one of its axes using the X, Y, or Z option of the UCS command.
Type: Integer  
Saved in: Registry  
Initial value: 90

Its value must be entered as an angle in degrees (valid values are: 5, 10, 15, 18, 22.5, 30, 45, 90, 180).

See also:
   Work with the User Coordinate System (UCS)

UCSBASE

Stores the name of the UCS that defines the origin and orientation of orthographic UCS settings.

Type: String  
Saved in: Drawing  
Initial value:"

Valid values include any named UCS.

See also:
   Overview of the User Coordinate System (UCS)

UCSDetect

Controls whether dynamic UCS acquisition is active or not.

Type: Integer  
Saved in: Registry  
Initial value: 1

<table>
<thead>
<tr>
<th>0</th>
<th>Not active</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Active</td>
</tr>
</tbody>
</table>

See also:
   Use the Dynamic UCS with Solid Models
**UCSFOLLOW**

Generates a plan view whenever you change from one UCS to another.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0

The UCSFOLLOW setting is saved separately for each viewport. If UCSFOLLOW is on for a particular viewport, a plan view is generated in that viewport whenever you change coordinate systems.

Once the new UCS has been established, you can use **DVIEW** (page 389), **PLAN** (page 794), **VIEW** (page 1139), or **VPOINT** (page 1149) to change the view of the drawing. It will change to a plan view again the next time you change coordinate systems.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>UCS does not affect the view</td>
</tr>
<tr>
<td>1</td>
<td>Any UCS change causes a change to the plan view of the new UCS in the current viewport</td>
</tr>
</tbody>
</table>

The setting of UCSFOLLOW is maintained separately for paper space and model space and can be accessed in either, but the setting is ignored while in paper space (it is always treated as if set to 0). Although you can define a non-world UCS in paper space, the view remains in plan view to the world coordinate system.

**See also:**
- Overview of the User Coordinate System (UCS)

**UCSICON**

Displays the UCS icon for the current viewport or layout.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 3

This system variable has the same name as a command. Use the SETVAR command to access this system variable.
The setting is stored as a bitcode using the sum of the following values:

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No icon is displayed</td>
</tr>
<tr>
<td>1</td>
<td>On; the icon is displayed in the lower-left corner of the current viewport or layout</td>
</tr>
<tr>
<td>2</td>
<td>Origin; if the icon is on, the icon is displayed at the UCS origin, if possible</td>
</tr>
</tbody>
</table>

The setting of this system variable is viewport and layout specific.

See also:

Control the Display of the User Coordinate System Icon

**UCSNAME**

Stores the name of the current coordinate system for the current viewport in the current space.

(Read-only)

**Type:** String

**Saved in:** Drawing

Returns a null string if the current UCS is unnamed.

See also:

Overview of the User Coordinate System (UCS)

**UCSORG**

Stores the origin point of the current coordinate system for the current viewport in the current space.

(Read-only)

**Type:** 3D-point

**Saved in:** Drawing

**Initial value:** 0.0000, 0.0000, 0.0000

This value is always stored as a world coordinate.
See also:
Overview of the User Coordinate System (UCS)
Assign UCS Definitions to Viewports

**UCSORTHO**

Determines whether the related orthographic UCS setting is restored automatically when an orthographic view is restored.

<table>
<thead>
<tr>
<th>Type:</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>Registry</td>
</tr>
<tr>
<td>Initial value:</td>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>0</th>
<th>Specifies that the UCS setting remains unchanged when an orthographic view is restored</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Specifies that the related orthographic UCS setting is restored automatically when an orthographic view is restored</td>
</tr>
</tbody>
</table>

See also:
Overview of the User Coordinate System (UCS)

**UCSSELECTMODE**

Controls whether the UCS icon can be selected and manipulated with grips.

<table>
<thead>
<tr>
<th>Type:</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>Registry</td>
</tr>
<tr>
<td>Initial value:</td>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>0</th>
<th>The UCS icon is not selectable.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The UCS icon is selectable.</td>
</tr>
</tbody>
</table>

See also:
Overview of the User Coordinate System (UCS)
**UCSVIEW**

Determines whether the current UCS is saved with a named view.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:**

<table>
<thead>
<tr>
<th>0</th>
<th>Does not save current UCS with a named view</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Saves current UCS whenever a named view is created</td>
</tr>
</tbody>
</table>

**See also:**  
Save and Restore Views

---

**UCSVP**

Determines whether the UCS in viewports remains fixed or changes to reflect the UCS of the current viewport.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:**

<table>
<thead>
<tr>
<th>0</th>
<th>Unlocked; UCS reflects the UCS of the current viewport</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Locked; UCS stored in viewport, and is independent of the UCS of the current viewport</td>
</tr>
</tbody>
</table>

**See also:**  
Assign UCS Definitions to Viewports

---

**UCSXDIF**

Stores the X direction of the current UCS for the current viewport in the current space.
(Read-only)

**Type:** 3D-point

**Saved in:** Drawing

**Initial value:** 1.0000, 0.0000, 0.0000

The setting of this system variable is viewport specific.

**See also:**

Overview of the User Coordinate System (UCS)

---

**UCSYDIR**

Stores the Y direction of the current UCS for the current viewport in the current space.

(Read-only)

**Type:** 3D-point

**Saved in:** Drawing

**Initial value:** 0.0000, 1.0000, 0.0000

The setting of this system variable is viewport specific.

**See also:**

Overview of the User Coordinate System (UCS)

---

**UNDOCTL**

Indicates the state of the Auto, Control, and Group options of the UNDO command.

(Read-only)

**Type:** Integer

**Saved in:** Not-saved

**Initial value:** 53

The setting is stored as a bitcode using the sum of the following values:

<table>
<thead>
<tr>
<th></th>
<th>UNDO is turned off</th>
<th>UNDO is turned on</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Value</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Only one command can be undone</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Auto is turned on</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>A group is currently active</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Zoom and pan operations are grouped as a single action</td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>Layer property operations are grouped as a single action</td>
<td></td>
</tr>
</tbody>
</table>

See also:
Correct Mistakes

**UNDOMARKS**

Stores the number of marks placed in the UNDO control stream by the Mark option.

(Read-only)

**Type:** Integer  
**Saved in:** Not-saved  
**Initial value:** 0

The Mark and Back options are not available if a group is currently active.

See also:
Correct Mistakes

**UNITMODE**

Controls the display format for units.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0
By default, the format for displaying measured values differs slightly from the format used for entering them. (You cannot include spaces when entering measured values.)

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Displays fractional, feet-and-inches, and surveyor's angles in “report” format using spaces as delimiters</td>
</tr>
<tr>
<td>1</td>
<td>Displays fractional, feet-and-inches, and surveyor's angles in “input” format without including spaces and, in some cases, substituting dashes for spaces</td>
</tr>
</tbody>
</table>

See also:
- Specify Units and Unit Formats

## UOSNAP

Determines whether object snapping is active for geometry in PDF underlays that are attached to the drawing.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 1

UOSNAP overrides the PDFOSNAP (page 1428) setting. Conversely, you can override the UOSNAP setting for PDF underlays with the PDFOSNAP system variable.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Object snapping is disabled for geometry in all underlay attachments in the drawing.</td>
</tr>
<tr>
<td>1</td>
<td>Object snapping is enabled for geometry in all underlay attachments in the drawing.</td>
</tr>
<tr>
<td>2</td>
<td>Object snapping is determined by the individual object snap underlay settings.</td>
</tr>
</tbody>
</table>

See also:  
- Use Object Snaps with PDF Underlays

1532 | Chapter 4  System Variables
**UPDATETHUMBNAIL**

Controls updating of the thumbnail previews for views and layouts.

**Type:** Bitcode  
**Saved in:** Drawing  
**Initial value:** 15

The setting is stored as a bitcode using the sum of the following values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Does not update previews</td>
</tr>
<tr>
<td>1</td>
<td>Updates previews for model space views</td>
</tr>
<tr>
<td>2</td>
<td>Updates previews for layout views</td>
</tr>
<tr>
<td>4</td>
<td>Updates previews for layouts</td>
</tr>
<tr>
<td>8</td>
<td>Updates previews when layouts or views are created, modified, or restored</td>
</tr>
<tr>
<td>16</td>
<td>Updates previews when the drawing is saved</td>
</tr>
</tbody>
</table>

**See also:**  
Set Interface Options

**USERI1-5**

Provides storage and retrieval of integer values.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0

There are five system variables: USERI1, USERI2, USERI3, USERI4, and USERI5.

**See also:**  
DIESEL Expressions in Macros
**USERR1-5**

Provides storage and retrieval of real numbers.

*Type:* Real  
*Saved in:* Drawing  
*Initial value:* 0.0000

There are five system variables: USERR1, USERR2, USERR3, USERR4, and USERR5.

See also:  
DIESEL Expressions in Macros

**USERS1-5**

Provides storage and retrieval of text string data.

*Type:* String  
*Saved in:* Not-saved  
*Initial value:*"

There are five system variables: USERS1, USERS2, USERS3, USERS4, and USERS5.

See also:  
DIESEL Expressions in Macros

**V System Variables**

**VIEWCTR**

Stores the center of view in the current viewport.  
(Read-only)  
*Type:* 3D-point  
*Saved in:* Drawing  
*Initial value:*Varies  

Expressed as a UCS coordinate.
See also:

Pan or Zoom a View

**VIEWDIR**

Stores the viewing direction in the current viewport, expressed in UCS coordinates.

(Read-only)

**Type:** 3D-vector  
**Saved in:** Drawing  
**Initial value:** 0.0000, 0.0000, 1.0000

This describes the camera point as a 3D offset from the target point.

See also:

Change to a View of the XY Plane

**VIEWMODE**

Stores the View mode for the current viewport.

(Read-only)

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0

The setting is stored as a bitcode using the sum of the following values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Turned off.</td>
</tr>
<tr>
<td>1</td>
<td>Perspective view active.</td>
</tr>
<tr>
<td>2</td>
<td>Front clipping on</td>
</tr>
<tr>
<td>4</td>
<td>Back clipping on.</td>
</tr>
<tr>
<td>8</td>
<td>UCS Follow mode on.</td>
</tr>
</tbody>
</table>
Front clip not at eye. If on, the front clip distance (FRONTZ (page 1339)) determines the front clipping plane. If off, FRONTZ is ignored, and the front clipping plane is set to pass through the camera point (vectors behind the camera are not displayed). This flag is ignored if the front-clipping bit (2) is off.

See also:
Save and Restore Views

VIEWSIZE
Stores the height of the view displayed in the current viewport, measured in drawing units.
(Read-only)
Type: Real
Saved in: Drawing
Initial value: Varies

See also:
Save and Restore Views

VIEWTWIST
Stores the view rotation angle for the current viewport measured relative to the WCS.
(Read-only)
Type: Real
Saved in: Drawing
Initial value: 0.0000

See also:
Rotate Views in Layout Viewports
**VISRETAIN**

Controls the properties of xref-dependent layers.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 1

Controls visibility, color, linetype, lineweight, and plot styles.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>The layer table, as stored in the reference drawing (xref), takes precedence. Changes made to xref-dependent layers in the current drawing are valid in the current session only and are not saved with the drawing. When the current drawing is reopened, the layer table is reloaded from the reference drawing, and the current drawing reflects all of those layer property settings.</td>
</tr>
<tr>
<td>1</td>
<td>Xref-dependent layer changes made in the current drawing take precedence. Layer settings are saved with the current drawing’s layer table and persist from session to session.</td>
</tr>
</tbody>
</table>

**See also:**  
Attach Drawing References (Xrefs)

**VPCONTROL**

Controls whether the menus for viewport tools, views, and visual styles that are located in the upper-left corner of every viewport are displayed.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** ON (or 1)

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OFF (or 0)</td>
<td>Hides viewport controls.</td>
</tr>
<tr>
<td>ON (or 1)</td>
<td>Displays viewport controls.</td>
</tr>
</tbody>
</table>

**See also:**  
Viewport Label Menus
VPCoordDisplay

Controls whether the current coordinates value of the crosshair cursor are displayed in the lower-right corner of the active viewport.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 1

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off</td>
</tr>
<tr>
<td>1</td>
<td>On</td>
</tr>
</tbody>
</table>

**See also:**  
Parts of the User Interface

VPlayerOverRides

Indicates if there are any layers with viewport (VP) property overrides for the current layout viewport.

(Read-only)  
**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Current viewport does not have any associated layer property overrides</td>
</tr>
<tr>
<td>1</td>
<td>Current viewport has associated layer property overrides</td>
</tr>
</tbody>
</table>

**See also:**  
Override Layer Properties in Viewports
**VPLAYEROVERRIDESMODE**

Controls whether layer property overrides for layout viewports are displayed and plotted.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Layer property overrides are not displayed in layout viewports or plotted</td>
</tr>
<tr>
<td>1</td>
<td>Layer property overrides are displayed in layout viewports and plotted</td>
</tr>
</tbody>
</table>

See also:  
Override Layer Properties in Viewports

**VPMAXIMIZEDSTATE**

Indicates whether the viewport is maximized or not.

(Read-only)  
**Type:** Integer  
**Saved in:** Not-saved  
**Initial value:** 0

The maximized viewport state is canceled if you start the PLOT command.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Not maximized</td>
</tr>
<tr>
<td>1</td>
<td>Maximized</td>
</tr>
</tbody>
</table>

See also:  
Access Model Space from a Layout Viewport
**VPROTATEASSOC**

Controls whether the view within a viewport is rotated with the viewport when the viewport is rotated.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>When a viewport is rotated, the view inside is not rotated.</td>
</tr>
<tr>
<td>1</td>
<td>When a viewport is rotated, the view inside is rotated to match the rotation of the viewport.</td>
</tr>
</tbody>
</table>

**NOTE** After rotating a viewport, VPROTATEASSOC is set to 0 for a new viewport created in the same layout.

See also:

Rotate Views in Layout Viewports

**VSACURVATUREHIGH**

Sets the value at which a surface displays as green during curvature analysis (ANALYSISCURVATURE (page 61)).

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** 1

The default value for this system variable is 1.

See also:

ANALYSISOPTIONS (page 63)  
ANALYSISOPTIONS - Curvature Tab (page 65)
VSACURVATURELOW

Sets the value at which a surface displays as blue during curvature analysis (ANALYSISCURVATURE (page 61)).

Type: Real
Saved in: Drawing
Initial value: -1

The default value for this system variable is -1.

See also:
  ANALYSISOPTIONS (page 63)
  ANALYSISOPTIONS - Curvature Tab (page 65)

VSACURVATURETYPE

Controls which type of curvature analysis is used with the (ANALYSISCURVATURE (page 61)).

Type: Integer
Saved in: Drawing
Initial value: 0

<table>
<thead>
<tr>
<th></th>
<th>Gaussian curvature (evaluates areas of high and low curvature)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Mean curvature (evaluates the mean curvature of the U and V surface curvature values)</td>
</tr>
<tr>
<td>1</td>
<td>Maximum curvature (evaluates the maximum curvature of the U and V surface curvature values)</td>
</tr>
<tr>
<td>2</td>
<td>Minimum curvature (evaluates the minimum curvature of the U and V surface curvature values)</td>
</tr>
</tbody>
</table>

See also:
  ANALYSISOPTIONS (page 63)
  ANALYSISOPTIONS - Curvature Tab (page 65)
VSADRAFTANGLEHIGH

Sets the value at which a model displays as green during draft analysis (ANALYSISDRAFT (page 62)).

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** 3

Draft angle is the angle in degrees between the surface normal and the UCS plane. High value is set by this system variable.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-90</td>
<td>Surface is parallel to the UCS with surface normal facing the opposite direction as the construction plane</td>
</tr>
<tr>
<td>0</td>
<td>Surface is perpendicular to the construction plane</td>
</tr>
<tr>
<td>90</td>
<td>Surface is parallel to the construction plane with surface normal facing the same direction as the UCS</td>
</tr>
</tbody>
</table>

See also:
- ANALYSISOPTIONS (page 63)  
- ANALYSISOPTIONS - Draft Angle Tab (page 66)

VSADRAFTANGLELOW

Sets the value at which a model displays as blue during draft analysis (ANALYSISDRAFT (page 62)).

**Type:** Real  
**Saved in:** Drawing  
**Initial value:** -3

Draft angle is the angle in degrees between the surface normal and the UCS plane. Low value set by this system variable.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-90</td>
<td>Surface is parallel to the UCS with surface normal facing the opposite direction as the construction plane</td>
</tr>
<tr>
<td>0</td>
<td>Surface is perpendicular to the construction plane</td>
</tr>
</tbody>
</table>
Surface is parallel to the construction plane with surface normal facing the same direction as the UCS.

See also:

ANALYSISOPTIONS  (page 63)
ANALYSISOPTIONS - Draft Angle Tab  (page 66)

VSAZEBRACOLOR1

Sets the first color of the zebra stripes displayed during zebra analysis (ANALYSISZEBRA).

**Type:** String  
**Saved in:** Drawing  
**Initial value:** RGB: 255, 255, 255

Values 1-255 designate an AutoCAD Color Index (ACI) color.  
Values for RGB True Color are represented as a comma-separated string of integers 000 to 255. The default value is RGB:255,255,255.

**NOTE** When a color book is installed, any colors defined in the book can be used.

See also:

ANALYSISOPTIONS  (page 63)  
ANALYSISOPTIONS - Zebra Tab  (page 64)

VSAZEBRACOLOR2

Sets the second (contrasting) color of the zebra stripes displayed during zebra analysis (ANALYSISZEBRA).

**Type:** String  
**Saved in:** Drawing  
**Initial value:** RGB: 0, 0, 0

Values 1-255 designate an AutoCAD Color Index (ACI) color.  
Values for RGB True Color are represented as a comma-separated string of integers 000 to 255. The default value is RGB:0,0,0.
NOTE When a color book is installed, any colors defined in the book can be used.

See also:

  ANALYSISOPTIONS (page 63)
  ANALYSISOPTIONS - Zebra Tab (page 64)

VSAZEBRADIRECTION

Controls whether zebra stripes display horizontally, vertically, or at an angle during zebra analysis (ANALYSISRBA).

| Type: Integer |
| Saved in: Drawing |
| Initial value: 90 |

<table>
<thead>
<tr>
<th>Value</th>
<th>Direction</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Horizontal</td>
</tr>
<tr>
<td>90</td>
<td>Vertical</td>
</tr>
</tbody>
</table>

NOTE Enter a value between 0 and 90 degrees to set Zebra stripes at an angle.

See also:

  ANALYSISOPTIONS (page 63)
  ANALYSISOPTIONS - Zebra Tab (page 64)

VSAZEBRASIZE

Controls the width of the zebra stripes displayed during zebra analysis (ANALYSISRBA).

| Type: Integer |
| Saved in: Drawing |
| Initial value: 45 |

Valid values are from 1 to 100.

See also:

  ANALYSISOPTIONS (page 63)
VSZEBRATYPE

Sets the type of zebra display when using zebra analysis (ANALYSISZEBRA).

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Chrome Ball</td>
</tr>
<tr>
<td>1</td>
<td>Cylinder</td>
</tr>
</tbody>
</table>

See also:
- ANALYSISOPTIONS (page 63)
- ANALYSISOPTIONS - Zebra Tab (page 64)

VSBACKGROUNDs

Controls whether backgrounds are displayed in the visual style applied to the current viewport.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off</td>
</tr>
<tr>
<td>1</td>
<td>On</td>
</tr>
</tbody>
</table>

**NOTE** Existing visual styles are not changed when you enter a new value for this system variable. Any new value entered for this system variable temporarily creates an unsaved new visual style.

See also:
- Display Backgrounds and Shadows
**VSEDGECOLOR**

Sets the color of edges in the visual style in the current viewport.

- **Type:** String
- **Saved in:** Drawing
- **Initial value:** BYENTITY

Value 0 designates ByBlock, value 256 designates ByLayer, and value 257 designates ByEntity. Values 1-255 designate an AutoCAD Color Index (ACI) color. True Colors and Color Book colors are also available.

Valid values for True Colors are a string of integers each from 0 to 255 separated by commas and preceded by RGB. The True Color setting is entered as follows:

```
RGB:000,000,000
```

If you have a color book installed, you can specify any colors that are defined in the book.

---

**NOTE** Existing visual styles are not changed when you enter a new value for this system variable. Any new value entered for this system variable temporarily creates an unsaved new visual style.

---

**See also:**

- Control the Display of Edges

---

**VSEDGEJITTER**

Makes edges on 3D objects appear wavy, as though they were sketched with a pencil.

- **Type:** Integer
- **Saved in:** Drawing
- **Initial value:** -2

The amount of jitter can be set to low, medium, or high. Negative numbers store the value but turn off the effect. Plot styles are not available for objects with the Jitter edge modifier applied.
NOTE Negative numbers store the value but turn off the effect. Plot styles are not available for objects with the Jitter edge modifier applied.

NOTE Existing visual styles are not changed when you enter a new value for this system variable. Any new value entered for this system variable temporarily creates an unsaved new visual style.

See also:

Control the Display of Edges

**VSEDGELEX**

Makes edges on 3D objects extend beyond their intersection for a hand-drawn effect.

- **Type:** Integer
- **Saved in:** Drawing
- **Initial value:** 6

The range is 1 to 100 pixels. Turn off the line extensions effect by preceding the setting with a minus sign (-).
NOTE Existing visual styles are not changed when you enter a new value for this system variable. Any new value entered for this system variable temporarily creates an unsaved new visual style.

See also:

Control the Display of Edges

VSEDGEOVERHANG

Makes edges on 3D objects extend beyond their intersection for a hand-drawn effect.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** -6

The amount of overhang can be set between 1 and 100 pixels. Negative numbers store the value but turn off the effect.

NOTE Existing visual styles are not changed when you enter a new value for this system variable. Any new value entered for this system variable temporarily creates an unsaved new visual style.

See also:

Control the Display of Edges

VSEDGES

Controls the types of edges that are displayed in the viewport.
**Type:** Integer  
**Saved in:** Drawing  
**Initial value:**

```
<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No edges are displayed</td>
</tr>
<tr>
<td>1</td>
<td>Isolines are displayed</td>
</tr>
<tr>
<td>2</td>
<td>Facet edges are displayed</td>
</tr>
</tbody>
</table>
```

**NOTE** Existing visual styles are not changed when you enter a new value for this system variable. Any new value entered for this system variable temporarily creates an unsaved new visual style.

**See also:**  
Control the Display of Edges
**VSEDGESMOOTH**

Specifies the angle at which crease edges are displayed.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 1  

The range is 0 to 180.

**NOTE** Existing visual styles are not changed when you enter a new value for this system variable. Any new value entered for this system variable temporarily creates an unsaved new visual style.

**See also:**  
Control the Display of Edges

**VSFACECOLORMODE**

Controls how the color of faces is calculated.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Normal: Does not apply a face color modifier</td>
</tr>
<tr>
<td>1</td>
<td>Monochrome: Displays all faces in the color that is specified in the <strong>VSMONOCOLOR</strong> (page 1558) system variable</td>
</tr>
<tr>
<td>2</td>
<td>Tint: Uses the color that is specified in the <strong>VSMONOCOLOR</strong> (page 1558) system variable to shade all faces by changing the hue and saturation values of the color</td>
</tr>
<tr>
<td>3</td>
<td>Desaturate: Softens the color by reducing its saturation component by 30 percent</td>
</tr>
</tbody>
</table>

**NOTE** Existing visual styles are not changed when you enter a new value for this system variable. Any new value entered for this system variable temporarily creates an unsaved new visual style.
See also:
Shade and Color Faces

**VSFACEHIGHLIGHT**

Controls the display of specular highlights on faces without materials in the current viewport.

**Type:** Integer

**Saved in:** Drawing

**Initial value:** -30

The range is -100 to 100. The higher the number, the larger the highlight. Objects with materials attached ignore the setting of VSFACEHIGHLIGHT when VSMATERIALMODE (page 1557) is on.

**NOTE** Existing visual styles are not changed when you enter a new value for this system variable. Any new value entered for this system variable temporarily creates an unsaved new visual style.

See also:
Shade and Color Faces

**VSFACEOPACITY**

Turns on and off a preset level of transparency for 3D objects.

**Type:** Integer

**Saved in:** Drawing

**Initial value:** 60

The level of transparency for 3D solids and surfaces can be set between 100 percent opaque and 0 percent opaque. Negative numbers store the value but turn off the effect.
NOTE Existing visual styles are not changed when you enter a new value for this system variable. Any new value entered for this system variable temporarily creates an unsaved new visual style.

See also:
- Shade and Color Faces

VSFAESTYLE

Controls how faces are displayed in the current viewport.

Type: Integer
Saved in: Drawing
Initial value: 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No style applied</td>
</tr>
<tr>
<td>1</td>
<td>Real: as close as possible to how the face would appear in the real world</td>
</tr>
<tr>
<td>2</td>
<td>Gooch: uses cool and warm colors instead of dark and light to enhance the display of faces that might be shadowed and difficult to see in a realistic display</td>
</tr>
</tbody>
</table>

NOTE Existing visual styles are not changed when you enter a new value for this system variable. Any new value entered for this system variable temporarily creates an unsaved new visual style.
See also:
Shade and Color Faces

**VSHALOGAP**

Sets the halo gap in the visual style applied to the current viewport.

- **Type:** Integer
- **Saved in:** Drawing
- **Initial value:** 0

The range is 0 to 100.

**NOTE** Existing visual styles are not changed when you enter a new value for this system variable. Any new value entered for this system variable temporarily creates an unsaved new visual style.

See also:
Use a Visual Style to Display Your Model

**VSHIDEPRECISION**

Controls the accuracy of hides and shades in the visual style applied to the current viewport.

- **Type:** Integer
- **Saved in:** Not-saved
- **Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Single precision; uses less memory</td>
</tr>
<tr>
<td>1</td>
<td>Double precision; uses more memory</td>
</tr>
</tbody>
</table>

**NOTE** Existing visual styles are not changed when you enter a new value for this system variable. Any new value entered for this system variable temporarily creates an unsaved new visual style.

See also:
Shade and Color Faces
VSINTERSECTIONCOLOR

Specifies the color of intersection polylines in the visual style applied to the current viewport.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 7

The initial value is 7, which is a special value that inverts the color (black or white) based on the background color.

Value 0 designates ByBlock, value 256 designates ByLayer, and value 257 designates ByEntity. Values 1-255 designate an AutoCAD Color Index (ACI) color. True Colors and Color Book colors are also available.

**NOTE**  
INTERSECTIONCOLOR (page 1380) controls the color of intersection polylines when the visual style is set to 2D Wireframe.

**NOTE**  
Existing visual styles are not changed when you enter a new value for this system variable. Any new value entered for this system variable temporarily creates an unsaved new visual style.

**See also:**  
Control the Display of Edges

VSINTERSECTIONEDGES

Controls the display of intersection edges in the visual style applied to the current viewport.

**Type:** Switch  
**Saved in:** Drawing  
**Initial value:** 0

**NOTE**  
INTERSECTIONDISPLAY (page 1380) controls the color of intersection polylines when the visual style is set to 2D Wireframe.
NOTE Existing visual styles are not changed when you enter a new value for this system variable. Any new value entered for this system variable temporarily creates an unsaved new visual style.

See also:

Control the Display of Edges

**VSINTERSECTIONLTYPE**

Sets the linetype for intersection lines in the visual style applied to the current viewport.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 1

The range is 1 to 11.

<table>
<thead>
<tr>
<th>Value</th>
<th>Linetype</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Solid</td>
</tr>
<tr>
<td>2</td>
<td>Dashed</td>
</tr>
<tr>
<td>3</td>
<td>Dotted</td>
</tr>
<tr>
<td>4</td>
<td>Short Dash</td>
</tr>
<tr>
<td>5</td>
<td>Medium Dash</td>
</tr>
<tr>
<td>6</td>
<td>Long Dash</td>
</tr>
<tr>
<td>7</td>
<td>Double Short Dash</td>
</tr>
<tr>
<td>8</td>
<td>Double Medium Dash</td>
</tr>
<tr>
<td>9</td>
<td>Double Long Dash</td>
</tr>
<tr>
<td>10</td>
<td>Medium Long Dash</td>
</tr>
</tbody>
</table>
Existing visual styles are not changed when you enter a new value for this system variable. Any new value entered for this system variable temporarily creates an unsaved new visual style.

See also:

Control the Display of Edges

**VSISOONTOP**

Displays isolines on top of shaded objects in the visual style applied to the current viewport.

**Type:** Integer

**Saved in:** Drawing

**Initial value:** 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off</td>
</tr>
<tr>
<td>1</td>
<td>On</td>
</tr>
</tbody>
</table>

Existing visual styles are not changed when you enter a new value for this system variable. Any new value entered for this system variable temporarily creates an unsaved new visual style.

See also:

Control the Display of Edges

**VSLIGHTINGQUALITY**

Sets the lighting quality in the current viewport.

**Type:** Integer

**Saved in:** Drawing
**Initial value:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Faceted. A single color is computed for each face of a surface or 3D solid.</td>
</tr>
<tr>
<td>1</td>
<td>Smooth. The colors are computed as a gradient between the vertices of the faces.</td>
</tr>
<tr>
<td>2</td>
<td>Smoothest. If the Per-Pixel Lighting setting is turned on in the Manual Performance Tuning dialog box, then the colors are computed for individual pixels. If not, the Smooth setting is used instead.</td>
</tr>
</tbody>
</table>

**NOTE** Existing visual styles are not changed when you enter a new value for this system variable. Any new value entered for this system variable temporarily creates an unsaved new visual style.

**See also:**

Use a Visual Style to Display Your Model

**VSMATERIALMODE**

Controls the display of materials in the current viewport.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 0

- Turn off the display of materials and textures to maximize performance during unrelated operations.
- Turn off the display of textures to modify materials, or to increase performance during unrelated operations.
- After turning them off, you can restore the display of materials and textures.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No materials are displayed</td>
</tr>
<tr>
<td>1</td>
<td>Materials are displayed, textures are not displayed</td>
</tr>
<tr>
<td>2</td>
<td>Materials and textures are displayed</td>
</tr>
</tbody>
</table>
NOTE Existing visual styles are not changed when you enter a new value for this system variable. Any new value entered for this system variable temporarily creates an unsaved new visual style.

See also:

Use a Visual Style to Display Your Model

**VS MAX**

Stores the upper-right corner of the current viewport's virtual screen.

(Read-only)

**Type:** 3D-point  
**Saved in:** Drawing  
**Initial value:** Varies

Expressed as a UCS coordinate.

See also:

Save and Restore Model Layout Viewport Arrangements

**VS MIN**

Stores the lower-left corner of the current viewport's virtual screen.

(Read-only)

**Type:** 3D-point  
**Saved in:** Drawing  
**Initial value:** Varies

Expressed as a UCS coordinate.

See also:

Save and Restore Model Layout Viewport Arrangements

**VS MONOCOLOR**

Sets the color for monochrome and tint display of faces in the visual style applied to the current viewport.
**VSOBSCUREDCOLOR**

Specifies the color of obscured (hidden) lines in the visual style applied to the current viewport.

- **Type:** String
- **Saved in:** Drawing
- **Initial value:** 255,255,255

Valid values include ByLayer (256), ByBlock (0), ByEntity (257), and any AutoCAD Color Index (ACI) color (an integer from 1 to 255).

You can also specify a true color or a color book color. Valid values for true colors are a string of integers each from 1 to 255 separated by commas and preceded by RGB. The True Color setting is entered as follows:

RGB:000,000,000

- **NOTE** Existing visual styles are not changed when you enter a new value for this system variable. Any new value entered for this system variable temporarily creates an unsaved new visual style.

- **See also:** Control the Display of Edges

**VSOBSCUREDEDDGES**

Controls whether obscured (hidden) edges are displayed.
Type: Integer  
Saved in: Drawing  
Initial value: 1

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off</td>
</tr>
<tr>
<td>1</td>
<td>On</td>
</tr>
</tbody>
</table>

**NOTE** Existing visual styles are not changed when you enter a new value for this system variable. Any new value entered for this system variable temporarily creates an unsaved new visual style.

See also:  
Control the Display of Edges

**VSOBSCUREDTYPE**

Specifies the linetype of obscured (hidden) lines in the visual style applied to the current viewport.

Type: Integer  
Saved in: Drawing  
Initial value: 1

The range is 1 to 11.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Solid</td>
</tr>
<tr>
<td>2</td>
<td>Dashed</td>
</tr>
<tr>
<td>3</td>
<td>Dotted</td>
</tr>
<tr>
<td>4</td>
<td>Short Dash</td>
</tr>
</tbody>
</table>

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1560 | Chapter 4  System Variables
<table>
<thead>
<tr>
<th>5</th>
<th>Medium Dash</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>— — — — — — — —</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>6</th>
<th>Long Dash</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>— — — — — — — —</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>7</th>
<th>Double Short Dash</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>— — — —</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>8</th>
<th>Double Medium Dash</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>— — — — — — — —</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>9</th>
<th>Double Long Dash</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>— — — — — — — —</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>10</th>
<th>Medium Long Dash</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>— — — — — — —</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>11</th>
<th>Sparse Dot</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>· · · · · · · ·</td>
</tr>
</tbody>
</table>

The initial value of VSOBSCUREDLTYPE varies on the current visual style.

<table>
<thead>
<tr>
<th>Visual Style (VSCURRENT)</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>2D Wireframe</td>
<td>1</td>
</tr>
<tr>
<td>Conceptual</td>
<td>1</td>
</tr>
<tr>
<td>Hidden</td>
<td>2</td>
</tr>
<tr>
<td>Shaded</td>
<td>1</td>
</tr>
<tr>
<td>Shaded with Edges</td>
<td>2</td>
</tr>
<tr>
<td>Shades of Gray</td>
<td>1</td>
</tr>
</tbody>
</table>
Visual Style (VSCURRENT) | Initial Value
--- | ---
Sketchy | 1
Wireframe | 1
X-ray | 1
Realistic | 1

**NOTE** Existing visual styles are not changed when you enter a new value for this system variable. Any new value entered for this system variable temporarily creates an unsaved new visual style.

See also:
Control the Display of Edges

**VSOCCLUDEDCOLOR**

Specifies the color of occluded (hidden) lines in the visual style applied to the current viewport.

**Type:** String  
**Saved in:** Drawing  
**Initial value:** ByEntity

Valid values include ByLayer (256), ByBlock (0), ByEntity (257), and any AutoCAD Color Index (ACI) color (an integer from 1 to 255).

You can also specify a true color or a color book color. Valid values for true colors are a string of integers each from 1 to 255 separated by commas and preceded by RGB. The True Color setting is entered as follows:

```
RGB:000,000,000
```

**NOTE** Existing visual styles are not changed when you enter a new value for this system variable. Any new value entered for this system variable temporarily creates an unsaved new visual style.
See also:

Control the Display of Edges

**VSOCLAUDEDGEDGES**

Controls whether occluded (hidden) edges are displayed.

**Type:** Integer

**Saved in:** Drawing

**Initial value:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off</td>
</tr>
<tr>
<td>1</td>
<td>On</td>
</tr>
</tbody>
</table>

**NOTE** Existing visual styles are not changed when you enter a new value for this system variable. Any new value entered for this system variable temporarily creates an unsaved new visual style.

See also:

Control the Display of Edges

**VSOCLAUDEDLTYPE**

Specifies the linetype of occluded (hidden) lines in the visual style applied to the current viewport.

**Type:** Integer

**Saved in:** Drawing

**Initial value:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Solid</td>
</tr>
<tr>
<td>2</td>
<td>Dashed</td>
</tr>
</tbody>
</table>

The range is 1 to 11.
<table>
<thead>
<tr>
<th>VSOCCLUDEDLTYPE</th>
<th>Visual Style (VSCURRENT)</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dotted</td>
<td>2D Wireframe</td>
<td>1</td>
</tr>
<tr>
<td>Short Dash</td>
<td>Conceptual</td>
<td>1</td>
</tr>
<tr>
<td>Medium Dash</td>
<td>Hidden</td>
<td>2</td>
</tr>
<tr>
<td>Long Dash</td>
<td>Sparse Dot</td>
<td></td>
</tr>
</tbody>
</table>

The initial value of VSOCCLUDEDLTYPE varies on the current visual style.
NOTE Existing visual styles are not changed when you enter a new value for this system variable. Any new value entered for this system variable temporarily creates an unsaved new visual style.

See also:

Control the Display of Edges

VSSHADOWS

Controls whether a visual style displays shadows.

Type: Integer
Saved in: Drawing
Initial value: 0

<table>
<thead>
<tr>
<th>0</th>
<th>No shadows are displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ground shadows only are displayed</td>
</tr>
<tr>
<td>2</td>
<td>Full shadows are displayed</td>
</tr>
</tbody>
</table>
NOTE Existing visual styles are not changed when you enter a new value for this system variable. Any new value entered for this system variable temporarily creates an unsaved new visual style.

See also:
Display Backgrounds and Shadows

VSSILHEDGES

Controls display of silhouette edges of solid objects in the visual style applied to the current viewport.

Type: Integer
Saved in: Drawing
Initial value: 0

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off</td>
</tr>
<tr>
<td>1</td>
<td>On</td>
</tr>
</tbody>
</table>

The initial value of VSSILHEDGES depends on the current visual style.

<table>
<thead>
<tr>
<th>Visual Style (VSCURRENT)</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>2D Wireframe</td>
<td>0</td>
</tr>
<tr>
<td>Conceptual</td>
<td>1</td>
</tr>
<tr>
<td>Hidden</td>
<td>1</td>
</tr>
<tr>
<td>Visual Style (VSCURRENT)</td>
<td>Initial Value</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Shaded</td>
<td>0</td>
</tr>
<tr>
<td>Shaded with Edges</td>
<td>1</td>
</tr>
<tr>
<td>Shades of Gray</td>
<td>1</td>
</tr>
<tr>
<td>Sketchy</td>
<td>1</td>
</tr>
<tr>
<td>Wireframe</td>
<td>0</td>
</tr>
<tr>
<td>X-ray</td>
<td>0</td>
</tr>
<tr>
<td>Realistic</td>
<td>0</td>
</tr>
</tbody>
</table>

**NOTE** Existing visual styles are not changed when you enter a new value for this system variable. Any new value entered for this system variable temporarily creates an unsaved new visual style.

See also:

Control the Display of Edges

**VSSILHWIDTH**

Specifies the width in pixels of silhouette edges in the current viewport.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 5  

The range is 1 to 25.

**NOTE** Existing visual styles are not changed when you enter a new value for this system variable. Any new value entered for this system variable temporarily creates an unsaved new visual style.
See also:
  Control the Display of Edges

**VTDURATION**

Sets the duration of a smooth view transition, in milliseconds.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 750

The valid range is 0 to 5000.

See also:
  Pan or Zoom a View

**VTENABLE**

Controls when smooth view transitions are used.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 3

Smooth view transitions can be on or off for panning and zooming, for changes of view angle, or for scripts. The valid range is 0 to 7.

<table>
<thead>
<tr>
<th>Setting</th>
<th>For pan/zoom</th>
<th>For rotation</th>
<th>For scripts</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>1</td>
<td>On</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>2</td>
<td>Off</td>
<td>On</td>
<td>Off</td>
</tr>
<tr>
<td>3</td>
<td>On</td>
<td>On</td>
<td>Off</td>
</tr>
<tr>
<td>4</td>
<td>Off</td>
<td>Off</td>
<td>On</td>
</tr>
</tbody>
</table>
### VTFPS

Sets the minimum speed of a smooth view transition, in frames per second.

**Type:** Integer  
**Saved in:** Registry  
**Initial Value:** 7

When a smooth view transition cannot maintain this speed, an instant transition is used. The valid range is 1 to 30.

See also:

Pan or Zoom a View

---

### W System Variables

#### WHIPARC

Controls whether the display of circles and arcs is smooth.

**Type:** Integer  
**Saved in:** Registry  
**Initial Value:** 0

<table>
<thead>
<tr>
<th>Setting</th>
<th>For pan/zoom</th>
<th>For rotation</th>
<th>For scripts</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>On</td>
<td>Off</td>
<td>On</td>
</tr>
<tr>
<td>6</td>
<td>Off</td>
<td>On</td>
<td>On</td>
</tr>
<tr>
<td>7</td>
<td>On</td>
<td>On</td>
<td>On</td>
</tr>
</tbody>
</table>

0 | Circles and arcs are not smooth, but rather are displayed as a series of vectors
Circles and arcs are smooth, displayed as true circles and arcs.

See also:
- Draw Curved Objects

**WINDOWAREACOLOR**

Controls the color of the transparent selection area during window selection.

- **Type:** Integer
- **Saved in:** Registry
- **Initial value:** 150

The valid range is 1 to 255. **SELECTIONAREA** (page 1466) must be on.

See also:
- Customize Object Selection

**WIPEOUTFRAME**

Controls the display of frames for wipeout objects.

- **Type:** Integer
- **Saved in:** Drawing
- **Initial value:** 1

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Frames are not displayed or plotted. Frames are temporarily displayed for object selection and selection preview.</td>
</tr>
<tr>
<td>1</td>
<td>Frames are displayed and plotted.</td>
</tr>
<tr>
<td>2</td>
<td>Frames are displayed, but not plotted.</td>
</tr>
</tbody>
</table>

**NOTE** The **FRAME** (page 1337) system variable overrides the **WIPEOUTFRAME** setting.
See also:
Create a Blank Area to Cover Objects

WORLDUCS

Indicates whether the UCS is the same as the WCS.
(Read-only)

<table>
<thead>
<tr>
<th>Type:</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>Not-saved</td>
</tr>
<tr>
<td>Initial value:</td>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>UCS differs from the WCS</td>
</tr>
<tr>
<td>1</td>
<td>UCS matches the WCS</td>
</tr>
</tbody>
</table>

See also:
Overview of the User Coordinate System (UCS)

WORLDVIEW

Determines whether input to the DVIEW and VPOINT commands is relative to the WCS (default) or the current UCS.

<table>
<thead>
<tr>
<th>Type:</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved in:</td>
<td>Drawing</td>
</tr>
<tr>
<td>Initial value:</td>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>UCS remains unchanged</td>
</tr>
<tr>
<td>1</td>
<td>UCS changes to the WCS for the duration of the command; the command input is relative to the current UCS</td>
</tr>
</tbody>
</table>

See also:
Define a 3D View with Coordinate Values or Angles
WRITESTAT

Indicates whether a drawing file is read-only or can be revised.

(Read-only)

**Type:** Integer  
**Saved in:** Not-saved  
**Initial value:** 1

For developers who need to determine write status through AutoLISP.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Cannot write to the drawing</td>
</tr>
<tr>
<td>1</td>
<td>Can write to the drawing</td>
</tr>
</tbody>
</table>

See also:

Overview of AutoLISP

X System Variables

XCLIPFRAME

Determines whether xref clipping boundaries are visible or plotted in the current drawing.

**Type:** Integer  
**Saved in:** Drawing  
**Initial value:** 2

The FRAME (page 1337) system variable overrides the XCLIPFRAME setting. Use the XCLIPFRAME system variable after the FRAME system variable to reset the clipped xref frame settings.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>The frame is not visible and it is not plotted. The frame temporarily reappears during selection preview or object selection.</td>
</tr>
<tr>
<td>1</td>
<td>The clipped xref frame is displayed and plotted</td>
</tr>
</tbody>
</table>
The clipped xref frame is displayed but not plotted

**See also:**

Update Referenced Drawing Attachments

**XDWGFADECTL**

Controls the dimming for all DWG xref objects.

**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 70

The valid XDWGFADECTL system variable value is between -90 and 90. When XDWGFADECTL is set to a negative value, the Xref Fading feature is not turned on, but the setting is stored.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>DWG xref objects are not faded.</td>
</tr>
<tr>
<td>&gt;0</td>
<td>When the value is positive, controls the percent of fading up to 90 percent.</td>
</tr>
<tr>
<td>&lt;0</td>
<td>When the value is negative, xref objects are not faded, but the value is saved for switching to that value by changing the sign.</td>
</tr>
</tbody>
</table>

**See also:**

Attach Drawing References (Xrefs)

**XEDIT**

Controls whether the current drawing can be edited in-place when being referenced by another drawing.

**Type:** Integer  
**Saved in:** Drawing
Initial value: 1

- 0: Cannot use in-place reference editing
- 1: Can use in-place reference editing

See also:
Update Referenced Drawing Attachments

**XFADECTL**

Controls the amount of fading within a reference being edited in place. This setting affects only the objects that are not being edited in the reference.

<table>
<thead>
<tr>
<th>Type: Integer</th>
<th>Saved in: Registry</th>
<th>Initial value: 50</th>
</tr>
</thead>
</table>

Valid values are from 0 to 90.

Also controls the fading intensity percentage of alternate object representations that display in a dimmed state, such as alternate scale representations of annotative objects.

**SELECTIONANNODISPLAY** (page 1466) controls whether or not alternate scale representations of annotative objects are displayed.

See also:
Attach Drawing References (Xrefs)

**XLOADCTL**

Turns xref demand-loading on and off, and controls whether it opens the referenced drawing or a copy.

<table>
<thead>
<tr>
<th>Type: Integer</th>
<th>Saved in: Registry</th>
<th>Initial value: 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>0:</td>
<td></td>
<td>Turns off demand-loading; the entire drawing is loaded.</td>
</tr>
</tbody>
</table>

1574 | Chapter 4  System Variables
<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Turns on demand-loading. Referenced drawings are kept open and locked.</td>
</tr>
<tr>
<td>2</td>
<td>Turns on demand-loading. Copies of referenced drawings are opened and locked; referenced drawings are not locked.</td>
</tr>
</tbody>
</table>

When XLOADCTL is set to 2, a copy of each referenced drawing file is stored in the folder specified by the XLOADPATH system variable or the temporary files folder (set in the Application Preferences dialog box).

Additionally, xrefs load faster when you work across a network: the performance enhancement is most pronounced when you open drawings with many xrefs.

See also:

Work with Demand Loading in Large Drawings

**XLOADPATH**

Creates a path for storing temporary copies of demand-loaded xref files.

*Type:* String  
*Saved in:* Registry  
*Initial value:* Varies

For more information, see [XLOADCTL](page 1574).

See also:

Set Paths for Temporary Xref File Copies

**XREFCTL**

Controls whether external reference log (XLG) files are created.

*Type:* Integer  
*Saved in:* Registry  
*Initial value:* 0

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Does not write log files</td>
</tr>
</tbody>
</table>
1 | Writes log files

See also:
Track External Reference Operations (Log File)

**XREFNOTIFY**

Controls the notification for updated or missing xrefs.

**Type:** Integer

**Saved in:** Registry

**Initial value:** 2

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 or 1</td>
<td>Disables xref notification</td>
</tr>
<tr>
<td>2</td>
<td>Enables xref notification and balloon messages.</td>
</tr>
</tbody>
</table>

See also:
Update Referenced Drawing Attachments

**XREFSTATE**

Indicates whether the Reference Manager palette is open or closed, and can be used to toggle the display state of the Reference Manager palette.

**Type:** Integer

**Saved in:** Registry

**Initial value:** Varies

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Closed</td>
</tr>
<tr>
<td>1</td>
<td>Open</td>
</tr>
</tbody>
</table>

See also:
Attach Drawing References (Xrefs)
**XREFTYPE**

Controls the default reference type when attaching or overlaying an external reference.

<table>
<thead>
<tr>
<th>Type: Integer</th>
<th>Saved in: Registry</th>
<th>Initial value: 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Attachment is the default</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Overlay is the default</td>
<td></td>
</tr>
</tbody>
</table>

See also:

Nest and Overlay Referenced Drawings

**Z System Variables**

**ZOOMFACTOR**

Controls how much the magnification changes when the mouse wheel moves forward or backward.

<table>
<thead>
<tr>
<th>Type: Integer</th>
<th>Saved in: Registry</th>
<th>Initial value: 60</th>
</tr>
</thead>
</table>

Accepts an integer between 3 and 100 as a valid value. The higher the number, the more the change.

See also:

Pan or Zoom a View

**ZOOMWHEEL**

Toggles the direction of transparent zoom operations when you scroll the middle mouse wheel.
**Type:** Integer  
**Saved in:** Registry  
**Initial value:** 0

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Moves wheel forward zooms in; moving wheel backwards zooms out.</td>
</tr>
<tr>
<td>1</td>
<td>Move wheel forward zooms out; moving wheel backwards zooms in.</td>
</tr>
</tbody>
</table>

**See also:**  
Pan or Zoom a View
Index

3D command 7
3D Edit Bar shortcut menu 30
3D Free Orbit cursor icons 34
3D Move Gizmo shortcut menu 39
3D Object Snap tab (Drafting Settings dialog box) 379
3D Rotate Gizmo shortcut menu 50
3D Scale Gizmo shortcut menu 52
3DALIGN command 19
3DARRAY command 20
3DCONFIG command 22
3DDISTANCE command 25
3DEDITBAR command 25
3DFACE command 31
3DFORBIT command 33
3DMESH command 35
3DMOVE command 36
3DORBIT command 40
3DORBIT shortcut menu 41
3DORBITCTR command 43
3DOSMODE system variable 1202
3DOSNAP command 44
3DPAN command 45
3DPOLY command 46
3DROTATE command 48
3DSCALE command 50
3DSELECTIONMODE system variable 1203
3DSWIVEL command 54
3DZOOM command 54
Add Scales to Object dialog box 717
Additional Format dialog box 1069
ADDSELECTED command 57
AFLAGS system variable 1205
ALIGN command 58
Alternate Font dialog box 744
Alternate Units tab (New Dimension Style dialog box) 344
AMECONVERT command 60
Analysis Options dialog box 64
ANALYSISCURVATURE command 61
ANALYSISDRAFT command 62
ANALYSISOPTIONS command 63
ANALYSISZEBRA command 67
ANGBASE system variable 1205
ANGDIR system variable 1206
ANNOALLVISIBLE system variable 1206
ANNOAUTOSCALE system variable 1207
ANNORESET command 68
Annotation tab (Leader Settings dialog box) 868
Annotative Object Scale dialog box 716
ANNOTATIVE DWG system variable 1208
APPLOAD command about 70
Load/Unload Applications dialog box 71
Startup Suite dialog box 73
arc
ARC command 74
AREA command 79
AREA system variable 1210
ARRAY command 82
Array dialog box 87
BROWSER command 163
BSAVE command 163
BSAVEAS command 164
BTMARKDISPLAY system variable 1221

C

CACHEMAXFILES system variable
CAL command 165
Callout Blocks dialog box 976
CAMERADisplay system variable 1222
CANNOSCALE system variable 1222
CANNOSCALEVALUE system variable 1223
CCONRAINFORM system variable 1223
CDATE system variable 1223
CECOLOR system variable 1224
Cell Border Properties dialog box 847
CELSCALE system variable 1224
CELTYPE system variable 1225
CELWEIGHT system variable 1225
CENTERMT system variable 1226
 CETRANSPARENCY system variable 1227
CHAMFER command 187
CHAMFERA system variable 1227
CHAMFERB system variable 1227
CHAMFERC system variable 1227
CHAMFERD system variable 1228
CHAMMODE system variable 1228
CHANGE command 192
Change to Layer dialog box 562
Check Spelling dialog box 1016
Check Spelling Settings dialog box 1019
CHPROP command 194
circle
CIRCLE command 196
CIRCLERAD system variable 1228
CLASSICKEYS system variable 1229
CLAYER system variable 1229
CLEANSCREENOFF command 201
CLEANSCREENON command 200
CLEANSERENSTATE system variable 1230

CLIP command 201
CLISTATE system variable 1230
CLOSE command 204
CLOSEALL command 204
CMATERIAL system variable 1230
CMDACTIVE system variable 1231
CMDDIA system variable 1232
CMDECHO system variable 1232
CMDINPUTHISTORYMAX system variable 1232
CMDNAMES system variable 1233
CMLEADERSTYLE system variable 1233
CMLJUST system variable 1234
CMLSSCALE system variable 1234
CMLSTYLE system variable 1234
Color Books tab (Select Color dialog box) 211
COLOR command 205
COLORSCHEME system variable 1235
Column Label shortcut menu 544
Column Settings dialog box 688
Columns menu 687
command line
   entering data on 4
   selecting options 4
COMMANDLINE command 213
COMMANDLINEHIDE command 214
commands
   executing 2
   recently-used list 5
   repeating 5
   starting 2
   transparent 3
Commands tab (Customize dialog box) 240
Compare Dimension Styles dialog box 352
COMPASS system variable 1235
COMPILE command 214
CONE command 215
Constraint Settings dialog box 220
CONSTRAINTBAR command
CONSTRAINTBARDISPLAY system variable 1236
CONSTRAINTBARMODE system variable 1237
CONSTRAINTINFERENCE system variable 1237
CONSTRAINTNAMEFORMAT system variable 1238
CONSTRAINTRELAX system variable 1238
CONSTRAINTSETTINGS command 219
CONSTRAINTSOLVEMODE system variable 1239
Content palette 223
Content tab (Modify Multileader Style dialog box) 667
CONTENTCLOSE command 226
CONTENTSTATE system variable 1239
CONVERT command 226
CONVTOBOMESH command 227
CONVTONURBS command 229
CONVTSOLID command 230
CONVTSURFACE command 232
Coordinate Filters command modifier 1195
COPY command 235
COPYBASE command 237
COPYCLIP command 238
COPYHIST command 238
COPYMODE system variable 1240
CPLOTSTYLE system variable 1240
CTAB system variable 1242
CTABLESTYLE system variable 1242
Create New Dimension Style dialog box 322
Create New Multileader Style dialog box 669
Create STL File dialog box 1038
CROSSINGAREACOLOR system variable 1241
CROSSHADOW system variable 1242
CTAB system variable 1242
CTABLESTYLE system variable 1242
CUI command about 239
Customize dialog box 239
Specify Tool Set Image dialog box 245
CULLINGOBJ system variable 1243
CULLINGOBJSELECTION system variable 1244
Cursor & Selection tab (Application Preferences dialog box) 731
CURSORSIZE system variable 1244
Curvature tab (Analysis Options dialog box) 65
curves
Customize dialog box
CUI command 239
CUTCLIP command 244
CVADD command 247
CVHIDE command 248
CVPORT system variable 1244
CVREBUILD command about 249
Rebuild Curve dialog box 251
Rebuild Surface dialog box 250
CVREMOVE command 252
CVSHOW command 254
CYLINDER command 255

D
DATE system variable 1245
DBLCLKEDIT system variable 1246
DBLIST command 257
DBMOD system variable 1246
DCALIGNED command 257
DCANGULAR command 259
DCCONVERT command 261
DCDIAMETER command 262
DCDISPLAY command 263
DCFORM command 263
DCDISPLAY command 263
DCFORM command 263
DCFUNCTION command 264
DCLINEAR command 266
DCDIAMETER command 267
DCDIAMETER command 267
DCVERTICAL command 268
DDEEDIT command about 269
Edit Attribut Definition dialog box 270
DDPTYPE command 269
Default Scale List dialog box 271
DEFAULTGIZMO system variable 1249
DESCRIPTIONGIZMO system variable 1249
DEFOULTLIGHTING system variable 1249
DEFAULTLIGHTINGTYPE system variable 1250
DEFLPLSTYLE system variable 1250
DEFLSTYLE system variable 1251
DELAY command 273
DECLCONRAINT command 273
Delete Duplicate Objects dialog box 749
DELOBJ system variable 1252
DEMANDLOAD system variable 1253
dialog boxes
suppressing display 3
DIASTAT system variable 1253
DIM and DIM1 commands 274
DIMADEC system variable 1254
DIMALIGNED command 277
DIMALT system variable 1254
DIMALTD system variable 1255
DIMALTF system variable 1255
DIMALTRND system variable 1255
DIMALTTD system variable 1256
DIMALTTZ system variable 1256
DIMALTU system variable 1257
DIMALTZ system variable 1258
DIMANGULAR command 280
DIMANNO system variable 1258
DIMAPPOST system variable 1259
DIMARC command 283
DIMARCSYM system variable 1259
DIMASSOC system variable 1260
DIMAZIN system variable 1262
DIMBASELINE command 285
DIMBLK system variable 1264
DIMBREAK command 287
DIMCEN system variable 1266
DIMCENTER command 288
DIMCLRD system variable 1266
DIMCLRE system variable 1266
DIMCLRT system variable 1267
DIMCONSTRAINT command 289
DIMCONTAINTICON system variable 1267
DIMCONTINUE command 291
DIMDEC system variable 1268
DIMDIAMETER command 293
DIMDISASSOCIATE command 295
DIMDL system variable 1268
DIMDLI system variable 1268
DIMSEP system variable 1269
DIMEDIT command 295
Dimension Input Settings dialog box 387
Dimension Style Manager about 320
Dimensional tab (Constraint Settings dialog box) 220
DIMEXE system variable 1269
DIMEXO system variable 1269
DIMFRAC system variable 1270
DIMFXL system variable 1270
DIMFXLON system variable 1270
DIMGAP system variable 1271
DIMINSPECT command 298
DIMJOGANG system variable 1271
DIMJOGED command 301
DIMJOGLINE command 303
DIMJUST system variable 1272
DIMLD system variable 1272
DIMLLAC system variable 1273
DIMLIN system variable 1273
DIMLINEAR command 304
DIMLDD1 system variable 1274
DIMLTL system variable 1274
DIMLUNIT system variable 1275
DIMLD system variable 1276
DIMLWE system variable 1276
DIMLW system variable 1276
DIMORDERATE command 309
DIMOVERRIDE command 311
DIMPOST system variable 1277
DIMRADIUS command 312
DIMREASSOCIATE command 313
DIMREGEN command 315
DIMREND system variable 1277
DIMROTATED command 316
DIMSAH system variable 1277
DIMSCALE system variable 1278
DIMSCI system variable 1279

Index | 1583
DIMSD2 system variable 1279
DIMSE1 system variable 1280
DIMSE2 system variable 1280
DIMSOXD system variable 1281
DIMSPACE command 318
DIMSTYLE command
about 319
Compare Dimension Styles dialog box 312
Create New Dimension Style dialog box 322
Dimension Style Manager 320
Modify Dimension Style dialog box 323
New Dimension Style dialog box 323
Override Dimension Style dialog box 323
DIMSTYLE system variable 1281
DIMTAD system variable 1282
DIMTDEC system variable 1282
DIMTEDIT command 355
DIMTFAC system variable 1282
DIMTFILL system variable 1283
DIMTFILLCLR system variable 1283
DIMTH system variable 1284
DIMTIX system variable 1284
DIMTM system variable 1285
DIMTMOVE system variable 1285
DIMTOFL system variable 1286
DIMTOH system variable 1286
DIMTOL system variable 1287
DIMTOLJ system variable 1287
DIMTP system variable 1288
DIMTSZ system variable 1288
DIMTVP system variable 1288
DIMTXSTY system variable 1289
DIMTXT system variable 1289
DIMTXTDIRECTION system variable 1289
DIMTZIN system variable 1290
DIMUPT system variable 1291
DIMZIN system variable 1291
Direct Distance command modifier 1196 displaying dialog boxes 3
DISPLAYVIEWCUBEIN2D system variable 1292
DISPLAYVIEWCUBEIN3D system variable 1292
DISPSILH system variable 1293
DIST command 358
DISTANCE system variable 1293
DISTANTLIGHT command 359
DIVIDE command 361
DIVEMSHBOXHEIGHT system variable 1294
DIVEMSHBOXLENGTH system variable 1295
DIVEMSHBOXWIDTH system variable 1295
DIVEMESHCONEXAXIS system variable 1296
DIVEMESHCONEBASE system variable 1297
DIVEMESHCONEXHEIGHT system variable 1298
DIVEMESHCYLAXIS system variable 1299
DIVEMESHCYLBASE system variable 1300
DIVEMESHYLHEIGHT system variable 1300
DIVEMESHPYRBASE system variable 1301
DIVEMESHPYRHEIGHT system variable 1302
DIVEMESHPYRLENGTH system variable 1302
DIVEMESHSPHEREAXIS system variable 1303
DIVEMESHSPHEREHEIGHT system variable 1304
DIVEMESHTORUSPATH system variable 1304
DIVEMESHTORUSSCCTION system variable 1305
DIVEMESHEDGEBASE system variable 1306
DIVEMESHEDGEHEIGHT system variable 1306
DIVEMESHEDGELENGTH system variable 1307
DIVEMESHEDGESLOPE system variable 1308
FACETERGRIDRATIO system variable 1328
FACETERMAXEDGELENGTH system variable 1329
FACETERMAXGRID system variable 1329
FACETERMESHTYPE system variable 1329
FACETERMINUGRID system variable 1330
FACETERMINVGRID system variable 1331
FACETERPRIMITIVEMODE system variable 1331
FACETERSMOOTHLEV system variable 1332
FACETRATIO system variable 1333
FACETRES system variable 1333
FIELD command 432
Field dialog box 433
FIELDDISPLAY system variable 1334
FIELDEVAL system variable 1334
FIELDIA system variable 1335
Files Recovered dialog box 366
FILL command 435
FILLET command 436
FILLETEDGE command 440
FILLETRAD system variable 1335
FILLETRAD3D system variable 1336
FILLMODE system variable 1336
Find and Replace dialog box (mtext) 690
Find and Replace dialog box (text) 442
FIND command 442
Fit tab (New Dimension Style dialog box) 336
FLATSHOT command 445
Flatshot dialog box 446
FONTALT system variable 1336
FONTMAP system variable 1337
FRAME system variable 1338
frames
FRAMESELECTION system variable 1338
FREESPOT command 448
FREEWEB command 451
FROM command modifier 1196
FRONAZ system variable 1339
FULLPLOTPATH system variable 1339

G
GCCOINCIDENT command 454
GCCOLLINEAR command 456
GCCONCENTRIC command 457
GCEQUAL command 458
GCFIX command 459
GCHORIZONTAL command 460
GCPARALLEL command 461
GCPERPENDICULAR command 462
GCSMOOTH command 462
GCSYMMETRIC command 464
GCTANGENT command 465
GCVERTICAL command 466
General tab (Application Preferences dialog box) 729
Generate Section / Elevation dialog box 947
GEOMARKERVISIBILITY system variable 1340
GEOMCONSTRAINT command 467
Geometric tab (Constraint Settings dialog box) 220
Geometric Tolerance dialog box 1092
GFANG system variable 1340
GFCLR1 system variable 1341
GFCLR2 system variable 1341
GFCLRLUM system variable 1342
GFCLRLSTATE system variable 1342
GNAME system variable 1343
GSHIFT system variable 1343
Gradient tab (Hatch and Gradient dialog box) 482
GRID command 470
GRIDDISPLAY system variable 1344
GRIDMAJOR system variable 1344
GRIDMODE system variable 1345
GRIDSTYLE system variable 1345
GRIDUNIT system variable 1346
GRIPTBLOCK system variable 1346
GRCOLOR system variable 1347
GROCOUPLE system variable 1347
GRIPCOLOR system variable 1347
GRIPHOT system variable 1348
GRIPOBJLIMIT system variable 1349
GRIPS system variable 1349
GRIPS system variable 1349
GRIPSIZE system variable 1350
GRIPSOBJMODE system variable 1350
GRIP TIPS system variable 1351
GROUP command 199, 471
GROUPDISPLAYMODE system variable 1351
GROUPEDIT command about 473
GROUPPLAYERDELETE system variable 1352
GROUPSONTOP system variable 1353
GTAUTO system variable 1353
GTDEFAULT system variable 1354
GTLOCATION system variable 1354
HALOGAP system variable 1355
HANDLES system variable 1355
Hatch and Gradient dialog box 475
HATCH command about 474
Hatch and Gradient dialog box 475
Hatch Library dialog box 490
Hatch Library palette 490
Hatch visor 486
Hatch Edit dialog box 498
Hatch Library dialog box 490
Hatch Library palette 490
Hatch tab (Hatch and Gradient dialog box) 479
Hatch visor 486
HATCHEDIT command 498
HATCHGENERATEBOUNDARY command 502
HATCHSETBOUNDARY command 502
HATCHSETORIGIN command 503
HATCHTOBACK command 504
HELIX command 504
HELPPREFIX system variable 1356
HIDE command 507
HIDEOBJECTS command 509
HIDEPALLETTES command 510
HIDEPRECISION system variable 1356
HIDETEXT system variable 1357
hiding dialog boxes 3
HIGHLIGHT system variable 1357
HPANG system variable 1357
HPANNOTATIVE system variable 1358
HPASSOC system variable 1358
HPBACKGROUND system variable 1359
HPBOUND system variable 1359
HPBOUNDRETAIN system variable 1360
HPCOLOR system variable 1360
HPDLGMODE system variable 1361
HPDOUBLE system variable 1361
HPDRAWORDER system variable 1362
HPGAPTO system variable 1362
HPINHERIT system variable 1363
HPISLANDDETECTION system variable 1363
HPISLANDDETECTIONMODE system variable 1364
HPPLAYER system variable 1364
HPMAXAREAS system variable 1364
HPMAXLINES system variable 1365
HPNAME system variable 1365
HPOBJWARNING system variable 1365
HPOORIGIN system variable 1366
HPOORIGINMODE system variable 1366
HPQUICKPREVIEW system variable 1367
HPQUICKPREVTIMEOUT system variable 1367
HPScale system variable 1368
HPSEPARATE system variable 1368
HPSPACE system variable 1368
HPTRANSPARENCY system variable 1369

ICONSIZE system variable 1369
ID command 510
IMAGE command 511
IMAGEADJUST command 513
IMAGEATTACH command about 514
   Attach Image dialog box 515
IMAGECLIP command 518
IMAGEFRAME system variable 1370
IMAGEHLT system variable 1370
IMAGEQUALITY command 519
IMPLIEDFACE system variable 1371
IMPORT command 520
Import Page Setups dialog box 764
IMPRINT command 521
In-Place Text Editor about 678
Index Color tab (Select Color dialog box) 206
INDEXCTL system variable 1371
INETLOCATION system variable 1372
INPUTHISTORYMODE system variable 1372
INSBASE system variable 1373
Insert Block in Table Cell dialog box 1090
INSERT command 522
Insert dialog box 523
INSNAME system variable 1373
Inspection Dimension dialog box 299
INSUNITS system variable 1375
INSUNITSDEFSOURCE system variable 1376
INSUNITSDEFTARGET system variable 1378
INTELLIGENTUPDATE system variable 1378
INTERFERE command about 528
   Interference Checking dialog box 531
   Interference Settings dialog box 530
INTERFERECOLOR system variable 1379
Interference Checking dialog box 531
Interference Settings dialog box 530
INTERFEREOBJVS system variable 1379
INTERFEREVPVS system variable 1379
INTERSECT command 533
INTERSECTIONCOLOR system variable 1380
INTERSECTIONDISPLAY system variable 1380
ISAVEBAK system variable 1381
ISAVEPERCENT system variable 1381
ISOLATEOBJECTS command 534
isoline
ISOLINES system variable 1382
ISOPLANE command 535

J

JOGSECTION command (SECTIONPLANE(JOG)) 938
JOIN command 536
JPEG Image Options dialog box 901
JPGOUT command 539

L

Label Block for Views dialog box 977
LARGEOBJECTSUPPORT system variable 1382
LASTANGLE system variable 1382
LASTPOINT system variable 1383
LASTPROMPT system variable 1383
LATITUDE system variable 1384
LAYER command about 539
   Layers palette 541
      New Dynamic Group dialog box 549
   Select Linetype dialog box 553
LAYERCLOSE command 557
LAYERCLOSE command 557
LAYEREVAL system variable 1384
LAYEREVALCTL system variable 1385
LAYERFILTERALERT system variable 1386
LAYERMANAGERSTATE system variable 1386
LAYERNOTIFY system variable 1387
LAYERP command 557
LAYERPMODE command 558
Layers palette about 541
LAYFRZ command 558, 559
LAYISO command 560
LAYLCCK command 561
LAYLOCKFADECTL system
  variable 1388
LAYMCUR command 563
LAYOFF command 564
LAYON command 565
LAYOUT command 566
  Layout visor 567
Layout visor 567
LAYOUTCREATEVIEWPORT system
  variable 1389
LAYOUTREGENCTL system
  variable 1390
LAYTHW command 568
LAYULK command 569
LAYUNISO command 569
LEADER command 570
Leader Format tab (Modify Multileader
  Style dialog box) 665
Leader Line & Arrow tab (Leader Settings
dialog box) 870
Leader Settings dialog box 867
Leader Structure tab (Modify Multileader
  Style dialog box) 666
LEGACYCTRLPICK system variable 1390
LENGTHEN command 572
LENSLENGTH system variable 1391
LIGHT command 575
LIGHTGLYPHDISPLAY system
  variable 1391
Lighting Properties dialog box 849
LIGHTINGUNITS system variable 1392
LIGHTSINBLOCKS system variable 1392
LIMCHECK system variable 1393
LIMITS command 575
LIMMAX system variable 1393
LIMMIN system variable 1393
LINE command 576
LINEARBRIGHNESS system
  variable 1394
LINEARCORNTAST system variable 1394
Lines and Arrows tab (New Dimension
  Style dialog box) 324
LINETYPE command
  about 578
  Linetype Manager 579
  Load or Reload Linetypes dialog
    box 581
  Linetype Manager
    about 579
Lineweight Settings dialog box 598
LIST command 583
List View shortcut menu 544
LIVESECTION command 584
LOAD command 585
Load or Reload Linetypes dialog box 581
Load/Unload Applications dialog box 71
LOCALE system variable 1395
LOCALROOTPREFIX system
  variable 1395
LOFT command 586
Loft Handle 593
Loft Settings dialog box 591
LOFTANG1 system variable 1395
LOFTANG2 system variable 1396
LOFTMAG1 system variable 1396
LOFTMAG2 system variable 1397
LOFTNORMALS system variable 1397
LOFTPSTRING variable 1398
LOGEXPBRIGHNESS system
  variable 1398
LOGEXPWCONTRAST system
  variable 1399
LOGEXPWDAYLIGHT system
  variable 1399
LOGEXPWMIDTONES system
  variable 1400
LOGEXPPHYSICALSCALE system
  variable 1400
LOGFILEMODE system variable 1401
LOGFILENAM system variable 1401
LOGFILEOFF command 595
LOGFILEON command 596
LOGFILEPATH system variable 1401
Login to AutoCAD WS dialog box 1137
LOGINNAME system variable 1402
LONGITUDE system variable 1402
Look & Feel tab (Application Preferences
dialog box) 736
LTSCALE command 596  
LTSCALE system variable 1402  
LUNITS system variable 1403  
LUPREC system variable 1403  
LWDEFAULT system variable 1404  
LWDISPLAY system variable 1404  
LWEIGHT command 597  
LWUNITS system variable 1405

M

Magnitude Handle 593  
Manage Cell Content dialog box 1066  
Manage Content Libraries dialog box 225  
MASSPROP command 600  
MATBROWSERCLOSE command 604  
MATBROWSEROPEN command 605  
MATBROWSERSTATE system variable 1405  
MATCHCELL command 608  
MATCHPROP command 609  
Material Condition dialog box 1097  
MATERIALASSIGN command 612  
Materials Browser about 606  
MATERIALS command about 613  
MATERIALSCLOSE command 613  
MAXACTVP system variable 1406  
MAXSORT system variable 1406  
MBUTTONPAN system variable 1406  
MEASURE command 614  
MEASUREGEOM command 616  
MEASUREINIT system variable 1407  
MEASUREMENT system variable 1407  
MENUCHO command 1408  
MENUNAME system variable 1408  
Menus tab (Customize dialog box) 242  
MESH command 620  
MESHCAP command 633  
MESHCOLLAPSE command 634  
MESHCREASE command 634  
MESHEXTRUDE command 636  
MESHMERGE command 638  
MESHREFINE command 639  
MESHSMOOTH command 640  
MESHSMOOTHLESS command 641  
MESHSMOOTHMORE command 642  
MESHPIN command 643  
MESHSPLIT command 644  
MESHTYPE system variable 1409  
MESHUNCREASE command 646  
MINsert command 647  
MIRRHATCH system variable 1409  
MIRROR command 651  
MIRROR3D command 652  
MIRTEXT system variable 1410  
MLEADER command 655  
MLEADERALIGN command 657  
MLEADERCOLLECT command 659  
MLEADEREDIT command 660  
MLEADERSCALE system variable 1410  
MLEADERSTYLE command about 661  
Multileader Style Manager 662  
MLINE command 671  
MODEL command 674  
Modify Dimension Style dialog box 323  
Modify Multileader Style dialog box 664  
More Options tab (Hatch and Gradient dialog box) 483  
MOVE command 674  
MREDO command 675  
MSLTSCALE system variable 1411  
MSPACE command 676  
MTEDIT command 677  
MTEXT command about 677  
AutoStack Properties dialog box 694  
Background Mask dialog box 689  
Column Settings dialog box 688  
Columns menu 687  
Find and Replace dialog box 690  
In-Place Text Editor 678  
Paragraph dialog box 685  
Stack Properties dialog box 692  

1590 | Index
Text Editor visor 682
MTEXTCOLUMN system variable 1411
MTEXTFIXED system variable 1412
MTJIGSTRING system variable 1413
MTP command modifier 1197
Multileader Style Manager 662
MULTIPLE command 702
MVVIEW command 703
MVSETUP command 706
MYDOCUMENTSPREFIX system variable 1413

N
Named UCSs tab (UCS dialog box) 1117
Named Viewports tab (Viewports dialog box) 1153
NAVVCUBE command 711
NAVVCUBEDISPLAY system variable 1414
NAVVCUBELOCATION system variable 1414
NAVVCUBEOPACITY system variable 1415
NAVVCUBEORIENT system variable 1415
NAVVCUBESIZE system variable 1416
NEW command about 714
New Dimension Style dialog box 323
New Dynamic Group dialog box 549
New Layer Name dialog box 945
New Page Setup dialog box 757
New Project dialog box 973
New Project Layout dialog box 974
New Viewports tab (Viewports dialog box)
NEWSHEETSET command 714
NOMUTT system variable 1416
NORTHDIRECTION system variable 1416
Object Snaps command modifier 1198
OBJECTISOLATIONMODE system variable 1417
OBJECTSCALE command about 715
Add Scales to Object dialog box 717
Annotative Object Scale dialog box 716
OBSERCEDCOLOR system variable 1418
OBSERCEDTYPE system variable 1419
OFFSET command 719
OFFSETDIST system variable 1419
OFFSETEDGE command 721
OFFSETGAPTYPE system variable 1420
OOPS command 722
OPEN command about 723
Standard File Selection dialog boxes 724
OPENSHEETSET command 727
OPMSTATE system variable 1420
OPTIONS command about 727
Alternate Font dialog box 744
Default Scale List dialog box 745
ORTHO command 746
Orthographic UCS Depth dialog box 1121
Orthographic UCSs tab (UCS dialog box) 1118
ORTHOMODE system variable 1421
OSMODE system variable 1422
OSNAP command 747
OSNAPCOORD system variable 1423
OSNAPNODELEGACY system variable 1423
OSNAPZ system variable 1424
OSOPTIONS system variable 1424
Output Size dialog box (RENDEROUTPUTSIZE) 907
OVERKILL command 749
Override Dimension Style dialog box 323

O
Object Snap tab (Drafting Settings dialog box) 375
Page Setup dialog box 758
Page Setup Manager about 754
Page Setup dialog box 758
PAGESETUP command about 753
Import Page Setups dialog box 764
New Page Setup dialog box 757
Page Setup dialog box 758
Page Setup Manager 754
PAGESETUPEDIT command 765
PALETTEICONOFF command 766
PALETTEICONON command 766
PALETTEICONSTATE system variable 1425
PAN command 767
Pan shortcut menu 768
PAPERSPACEVISOR system variable 1425
PAPERUPDATE system variable 1426
Paragraph dialog box 685
PARAMETERCOPYMODE system variable 1427
PARAMETERS command 770
PASTECLIP command 771
Path Array visor 96
PCX Image Options dialog box 899
PDFADJUST command
PDFATTACH command about
PDFATTACH command Attach PDF Underlay dialog box
PDFCLIP command
PDFFRAME system variable 1428
PDFLAYERS command
PDFSNAP system variable 1428
PDMODE system variable 1429
PDSIZE system variable 1429
PEDIT command 779
PEDITACCEPT system variable 1430
PELLIPSE system variable 1430
performance improvements
PERIMETER system variable 1431
PERSPECTIVE system variable 1431
PERSPECTIVECLIP system variable 1432
PFACE command 793
PFACEVMAX system variable 1432
PICKADD system variable 1433
PICKAUTO system variable 1433
PICKBOX system variable 1434
PICKDRAG system variable 1434
PICKFIRST system variable 1435
PICKSTYLE system variable 1435
PLAN command 794
PLANESURF command 795
PLATFORM system variable 1435
pline
PLINE command 797
PLINECONVERTMODE system variable 1436
PLINEGEN system variable 1436
LINEREVERSEWIDTHS
LINETYPE system variable 1438
LINEWID system variable 1438
Plot and Publish Details dialog box 1142
PLOT command about 803
Print dialog box 804
Plot Stamp dialog box 812
Plot Style Table Editor 821
PLOTOFFSET system variable 1438
PLOTMODE system variable 1439
PLOTSTAMP command about 811
Plot Stamp dialog box 812
User Defined Fields dialog box 816
PLOTSTYLE command about 819
Edit Plot Style Table dialog box 819
Plot Style Table Editor 821
plotting
PLOTTRANSPARENCYOVERRIDE system variable 1440
PLQUIET system variable 1440
PNG Image Options dialog box 902
PNGOUT command 825
POINT command 826
Point Style dialog box 272
Pointer Input Settings dialog box 386
POINTERLIGHT command 828
Polar Array visor 97
Polar Tracking tab (Drafting Settings dialog box) 373
POLARADDDANG system variable 1440
POLARANG system variable 1441
POLARDIST system variable 1441
POLARMODE system variable 1442
POLYGON command 832
POLYSIDES system variable 1442
POLYSOLID command 834
POPUPS system variable 1443
PRESSPULL command 838
PREVIEW command 840
PREVIEWCREATIONTRANSPARENCY system variable 1443
PREVIEWEFFECT system variable 1444
PREVIEWFACEEFFECT system variable 1444
PREVIEWFILTER system variable 1445
PREVIEWTYPE system variable 1445
Primary Units tab (New Dimension Style dialog box) 341
Print dialog box 804
PRODUCT system variable 1446
PROGRAM system variable 1446
Project Manager
about 958
  group properties 970
  layout properties 968
  project properties 965
  view properties 972
PROJECTGEOMETRY command 841
PROJECTNAME system variable 1447
PROJMODE system variable 1447
prompts
responding to 3
PROPERTIES command
about 843
  Cell Border Properties dialog box 847
  Lighting Properties dialog box 849
  Properties palette 844
Properties Inspector palette
about 845
  general properties 846
Properties palette
about 844
Properties tab (Attribute Editor dialog box) 138
Properties tab (Enhanced Attribute Editor) 401
PROPERTIESCLOSE command 855
Property Settings dialog box 610
PROPOBJLIMIT system variable
PROXYGRAPHICS system variable 1448
PROXYNOTICE system variable 1448
PROXYSHOW system variable 1449
PROXYWEBSEARCH system variable 1449
PSETUPIN command 855
PSLTSCALE system variable 1450
PSOLHEIGHT system variable 1450
PSOLWIDTH system variable 1451
PSPACE command 856
PSTYLEMODE system variable 1452
PSTYLEPOLICY system variable 1452
PSVPSCALE system variable 1452
PUBLISH command
  Batch Publish dialog box 858
  PUCSBASE system variable 1453
PYRAMID command 863
Q
QDIM command 865
QLEADER command
about 866
  Leader Settings dialog box 867
QNEW command 872
QSAVE command 872
QTTEXT command 873
QTTEXTMODE system variable 1453
QUICKVIEW command 873
QuickView dialog box 874
QUIT command 876
R
RASTERDPI system variable 1454
RASTERPERCENT system variable 1454
RASTERPREVIEW system variable 1454
RASTERTHRESHOLD system variable 1455
Index | 1593
RAY command 877
RE-INIT system variable] 1461
Rebuild Curve dialog box 251
Rebuild Surface dialog box 250
REBUILD2DCV system variable 1455
REBUILD2DEGREE system variable 1456
REBUILD2DOPTION system variable 1456
REBUILDDEGREEU system variable 1457
REBUILDDEGREEV system variable 1457
REBUILD2DOPTIONS system variable 1458
REBUILDU system variable 1458
REBUILDV system variable 1459
RECOVER command 878
RECOVERAUTO system variable 1459
RECTANG command 878
Rectangular Array visor 98
REDEFINE command 880
REDO command 880
REDRAW command 881
REDRAWALL command 881
REFCLOSE command 882
REFEDIT command
about 883
Reference Edit dialog box 884
Reference Editor visor 884
REFEDITNAME system variable 1460
Reference Edit dialog box 884
Reference Editor visor 884
Reference Manager palette
about 419
REFSET command 888
REGEN command 889
REGENALL command 890
REGENAUTO command 890
REGENMODE system variable 1460
REGION command 891
Reload Linetypes dialog box 581
REMEMBERFOLDERS system variable 1461
RENAME command 892
Rename dialog box 893
RENDER command
about 895
BMP Image Options dialog box 898
JPEG Image Options dialog box 901
PCX Image Options dialog box 899
PNG Image Options dialog box 902
Render Output File dialog box 897
Targa Image Options dialog box 899
TIFF Image Options dialog box 900
Render Environment dialog box 906
Render Output File dialog box 897
RENDERENVIRONMENT command 905
RENDEROUTPUTSIZE command 907
RENDERUSERLIGHTS system variable 1462
RENDERWIN command 909
Repair Broken Layouts dialog box 978
repeating commands 5
REPORTERROR system variable 1462
RESETBLOCK command 909
RESETPALETTES command 910
RESUME command 910
REV CLOUD command 911
REVERSE command 912
REVOLVE command 913
REV SURF command 917
ROAMABLEROOTPREFIX system variable 1463
ROTATE command 920
ROTATE3D command 921
RSCRIPT command 923
RTDISPLAY system variable 1463
RULESURF command 924

S
Save Block As dialog box 164
SAVE command 926
SAVEAS command
about 926
Template Options display 927
SAVEFIDELITY system variable 1464
SAVE FILE system variable 1464
SAVE FILE PATH system variable 1464
SAVE IMG command 928
SAVENAME system variable 1465
SAVETIME system variable 1465
SCALE command 928
SCALELISTEDIT command  
about  930
  Edit Drawing Scales dialog box  931
SCREENSIZE system variable  1465
SCRIPT command  932
SECTION command  933
Section Settings dialog box  940
SECTIONPLANE command  936
SECTIONPLANEJOG command  938
SECTIONPLANESETTINGS command  
about  939
  New Layer Name dialog box  945
  Section Settings dialog box  940
SECTIONPLANETOBLOCK command  
about  946
  Generate Section / Elevation dialog box  947
Select Color dialog box  
about  205
  Color Books tab  211
  Index Color tab  206
  True Color tab  208
SELECT command  949
Select Linetype dialog box  553
Select Similar Settings dialog box  954
selection highlighting limits
Selection Modes command  
modifier  1199
SELECTIONANNODISPLAY system variable  1466
SELECTIONAREA system variable  1466
SELECTIONAREAOACITY system variable  1467
SELECTIONCYCLING system variable  1467
SELECTIONPREVIEW system variable  1468
SELECTSIMILAR command  953
SELECTSIMILARMODE system variable  1469
Settings tab (UCS dialog box)  1119
SETVAR command  955
SHADEEDGE system variable  1470
SHADEDIF system variable  1470
SHADEMODE command  955
SHADOWPLANELOCATION system variable  1470
SHAPE command  956
SHEETSET command  
  Add Custom Property dialog box  975
  Callout Blocks dialog box  976
  group properties  970
  Label Block for Views dialog box  977
  layout properties  968
  New Project dialog box  973
  New Project Layout dialog box  974
  Project Manager  958
  project properties  965
  Repair Broken Layouts dialog box  978
  view properties  972
SHEETSETHIDE command  979
SHORTCUTMENU system variable  1471
SHORTCUTMENUDURATION system variable  1472
SHOWALLUSEDLAYERSGROUP system variable  1472
SHOWEMPTYGROUPS system variable  1473
SHOWGROUPS system variable  1473
SHOWHIST system variable  1474
SHOWPAGESETUPFORNEWLAYOUTS system variable  1474
SHOWPALETTESTATE system variable  1475
SHOWUNRECONCILEDLAYERSGROUP system variable  1475
SHOWVPOVERRIDESGROUP system variable  1476
SHOWXREFGROUPS system variable  1476
SHOWXREFLAYERS system variable  1476
SHPNAME system variable  1477
SIGWARN system variable  1477
SKETCH command  980
SKETCHINC system variable  1477
SKETCHINC system variable  1477
SKPOLY system variable  1478
SKTOLERANCE system variable 1478
SKYSTATUS system variable 1479
SLICE command 981
SMOOTHMESHCONVERT system variable 1479
SMOOTHMESHGRID system variable 1480
SMOOTHMESHMAXFACE system variable 1481
SMOOTHMESHMAXLEV system variable 1481
Snap and Grid tab (Drafting Settings dialog box) 369
SNAP command 987
SNAPANG system variable 1481
SNAPBASE system variable 1482
SNAPGRIDLEGACY system variable
SNAPISOPAIR system variable 1483
SNAPMODE system variable 1483
SNAPSTYL system variable 1484
SNAPTYPE system variable 1484
SNAPUNIT system variable 1484
SOLDRAW command 989
SOLID command
SOLIDCHECK system variable 1485
SOLIDEDIT command 991
SOLIDHIST system variable 1485
SOLPROF command 1007
SOLVIEW command 1009
SORTENTS system variable 1486
SPACEPAN system variable 1487
SPACEPANTIMEOUT system variable 1487
Specify Tool Set Image dialog box 246
SPELL command
about 1015
Check Spelling dialog box 1016
SPHERE command 1020
SPLDEGREE system variable 1488
SPLFRAME system variable 1488
spline
SPLINE command 1022
SPLINEDIT command 1027
SPLINESEGS system variable 1489
SPLINETYPE system variable 1489
SPLKNOTS system variable 1490
SPLMETHOD system variable 1490
SPLPERIODIC system variable 1491
SPOTLIGHT command 1032
SSFIND system variable 1491
SSLLOCATE system variable 1491
SSMAUTOOPEN system variable 1492
SSMPOOLLTIME system variable 1492
SSMSHEETSTATUS system variable 1493
SSMSTATE system variable 1493
Stack Properties dialog box 692
Startup Suite dialog box 73
STATUS command 1035
STATUSBAR system variable 1494
STLOUT command 1037
Create STL File dialog box 1038
STRETCH command 1039
STYLE command 1040
STYLES MANAGER command
about 1045
SUBOBJECTSELECTIONMODE system variable 1497
SUBTRACT command 1046
Sun & Sky Properties display 853
SUNSTATUS system variable 1497
SUPPRESSALERTS system variable
SURFACEASSOCIATIVITY system variable 1498
SURFACEASSOCIATIVITYDRAG system variable 1499
SURFACEAUTOTRIM system variable 1499
SURFACEMODELINGMODE system variable 1500
SURFBLEND command 1048
SURFEXTEND command 1049
SURFFILLET command 1052
SURFN E T R N E T C O M M A N D 1 0 5 3
SURF OFFSET command 1054
SURFPATCH command 1056
SURFSCULPT command 1058
SURFTAB1 system variable 1500
SURFTAB2 system variable 1501
SURFTRIM command 1059
SURFTYPE system variable 1501
SURFU system variable 1501
SURFUNTRIM command 1061
SURFV system variable 1502
SWEEP command 1062
Symbol dialog box 1095
Symbols and Arrows tab (New Dimension Style dialog box) 328
SYSCODEPAGE system variable 1502

T

Table Cell Format dialog box 1067
TABLE command
about 1065
Manage Cell Content dialog box 1066
TABLEDIT command 1072
TABLEEDIT command 1072
TABLEEXPORT command 1073
TABLEINDICATOR system variable 1503
TABLESTYLE command
Table Cell Format dialog box 1067
TABSURF command 1073
Targa Image Options dialog box 899
TARGET system variable 1503
TARGETPOINT command 1075
TBSHOWSHORTCUTS system variable 1504
TDCREATE system variable 1504
TDINDWG system variable 1504
TDUCREATE system variable 1505
TDUPDATE system variable 1505
TDUSRTIMER system variable 1505
TDUUPDATE system variable 1505
Template Options display 927
TEMPOVERRIDES system variable 1506
TEMPPREFIX system variable 1506
TEXT command 1078
Text Editor shortcut menu 678
Text Editor visor 682
Text Options tab (Attribute Editor dialog box) 137
Text Options tab (Enhanced Attribute Editor) 399
Text shortcut menu 1082
Text Style dialog box 1041
Text tab (New Dimension Style dialog box) 332
TEXTED system variable 1507
TEXTEDIT command 1085
TEXTEVAL system variable 1507
TEXTFILL system variable 1508
TEXTOUTPUTFILEFORMAT system variable 1508
TEXTQLTY system variable 1509
TEXTSIZE system variable 1509
TEXTSTYLE system variable 1510
TEXTTOFRONT command 1086
THICKEN command 1087
THICKNESS system variable 1510
THUMBSAVE system variable 1510
THUMBSIZE system variable 1511
TIFF Image Options dialog box 900
TIFOUT command 1087
TILEMODE system variable 1512
TIME command 1088
TIMEZONE system variable 1516
TINSERT command 1090
TOLERANCE command
about 1091
Geometric Tolerance dialog box 1092
Material Condition dialog box 1097
Symbol dialog box 1095
Tolerances tab (New Dimension Style dialog box) 347
Tool Sets tab (Customize dialog box) 244
TOOLSETSCLOSE command 1098
TOOLSETSCLOSE command 1098
TOOLSETSTSTATE system variable 1517
Tooltip Appearance dialog box 388
TOOLTIPMERGE system variable 1517
TOOLTIPSIZE system variable 1518
TOOLTIPTRANSPARENCY system variable 1518
TORUS command 1098
Tracking command modifier 1197
TRACKPATH system variable 1519
TRANSPARENCY command 1100
TRANSPARENCYDISPLAY system variable 1519
transparent commands 3
TREEDEPTH system variable 1520
TREEMAX system variable 1520

Index | 1597
TREESTAT command 1101
TRIM command 1102
TRIMMODE system variable 1521
True Color tab (Select Color dialog box) 208
TSPACEFAC system variable 1521
TSPACETYPE system variable 1522
TSTACKALIGN system variable 1522
TSTACKSIZE system variable 1523

U
u
U command 1106
UCS command 1107
UCS Details dialog box 1122
UCS dialog box 1117
UCS Icon dialog box 1115
UCS2DDISPLAYSETTING system variable 1523
UCS3DPARADISPLAYSETTING system variable 1524
UCS3DPERPDISPLAYSETTING system variable 1524
UCSAXISANG system variable 1525
UCSBASE system variable 1525
UCSDetect system variable 1525
UCSFOLOW system variable 1526
UCSICON command 1113
UCSICON system variable 1527
UCSMAN command
about 1116
Orthographic UCS Depth dialog box 1121
UCS Details dialog box 1122
UCS dialog box 1117
UCSNAME system variable 1527
UCSORG system variable 1528
UCSORTH0 system variable 1528
UCSSELECTMODE system variable 1528
UCSVIEW system variable 1529
UCSVVP system variable 1529
UCSXDIR system variable 1530
UCSYDIR system variable 1530
ULAYERS command
UNDEFINE command 1124
Underlay Layers dialog box
UNDO command 1125
UNDOCTL system variable 1531
UNDOMARKS system variable 1531
UNGROUP command 1127
UNION command 1128
UNISOLATEOBJECTS command 1130
UNITMODE system variable 1532
Units & Guides tab (Application Preferences dialog box) 734
UNITS command
about 1130
Drawing Units dialog box 1131
UOSNAP system variable 1532
UPDATEFIELD command 1135
UPDATETHUMBNAIl system variable 1533
UPDATETHUMBNSNOW command 1136
Upload Complete dialog box 1138
UPLOADTOWS command 1136
User Defined Fields dialog box 816
USERI-5 system variable 1533
USERI-5 system variable 1534
USERI-5 system variable 1534

V
v
VIEW command
about 1139
VIEWCTR system variable 1535
ViewCube Settings dialog box 712
VIEWDIR system variable 1535
VIEWMODE system variable 1536
VIEWPLOTDETAILS command
about 1141
Plot and Publish Details dialog box 1142
Viewports dialog box 1151
VIEWRES command 1143
VIEWSIZE system variable 1536
VIEWSIZE system variable 1536
VIEWTWIST system variable 1536
VISRETAIN system variable 1537
VISUALSTYLES command 1144
VPCLIP command 1145
VPCONTROL system variable 1537

1598 | Index
VPCOORDDISPLAY system variable 1538
VPLAYER command 1145
VPLAYEROVERRIDES system variable 1538
VPLAYEROVERRIDESMODE system variable 1539
VPMAX command 1148
VPMAXIMIZEDSTATE system variable 1539
VPMIN command 1149
VPOINT command 1149
VPORTS command 1151
VPROTATEASSOC system variable 1540
VSACURVATUREHIGH system variable 1540
VSACURVATURELOW system variable 1541
VSACURVATURETYPE system variable 1541
VSAZEBRACOLOR1 system variable 1543
VSAZEBRACOLOR2 system variable 1544
VSAZEBRADIRECTION system variable 1544
VSAZEBRASIZE system variable 1544
VSAZEBRATYPE system variable 1545
VSBACKGROUNDS system variable 1545
VSCURRENT command 1158
VSEDGECOLOR system variable 1546
VSEDGEJITTER system variable 1547
VSEDGELEX system variable 1548
VSEDGEOVERHANG system variable 1548
VSEDGES system variable 1549
VSEDGESMOOTH system variable 1550
VSFACECOLORMODE system variable 1551
VSFACEHIGHLIGHT system variable 1551
VSFACEOPACITY system variable 1552
VSFACESTYLE system variable 1553
VSHALOGAP system variable 1553
VSHIDEPRECISION system variable 1553
VSINTERSECTIONCOLOR system variable 1554
VSINTERSECTIONCOLORS system variable 1555
VSINTERSECTIONTYPE system variable 1555
VSISOONTOP system variable 1556
VSLIGHTINGQUALITY system variable 1557
VSMATERIALMODE system variable 1558
VSMAX system variable 1558
VSMIN system variable 1558
VSMONOCOLOR system variable 1559
VSOBSERVEDCOLOR system variable 1559
VSOBSERVEDCOLORS system variable 1560
VSOBSERVEDTYPE system variable 1562
VSOCCCLUDEDCOLOR system variable 1563
VSOCCCLUDEDCOLORS system variable 1563
VSOCCCLUDEDTYPE system variable 1565
VSAVE command 1160
VSSHADOWS system variable 1566
VSSILHEDGES system variable 1567
VSSILHWIDTH system variable 1568
VTDURATION system variable 1568
VTFPS system variable 1569
W
WBLOCK command 1160
WEBLIGHT command 1165
WEDGE command 1167
WHIPARC system variable 1570
WHOHAS command 1170
wildcard characters
command line prompts 5

Index | 1599
WINDOWAREACOLOR system variable 1570
wipeout
WIPEOUT command 1171
WIPEOUTFRAME system variable
WORLDUCS system variable 1571
WORLDVIEW system variable 1571
Write Block dialog box 1161
WRITESTAT system variable 1572

X

XATTACH command
about 1172
Attach External Reference dialog box 1173
External Reference visor 1175
XBIND command 1176
Xbind dialog box 1177
XCLIP command 1179
XCLIPFRAME system variable 1573
XDWGFADECTL system variable 1573
XEDGES command 1181
XEDIT system variable 1574
XFADECTL system variable 1574
XLINE command 1182
XLOADCTL system variable 1575
XLOADPATH system variable 1575
XOPEN command 1184
XPLODE command 1184
XREF command 1186
XREFCTL system variable 1576
XREFNOTIFY system variable 1576
XREFSSTATE system variable 1576
XREFTYPE system variable 1577

Z

Zebra Analysis tab (Analysis Options dialog box) 64
ZOOM command 1188
Zoom shortcut menu 1192
ZOOMFACTOR system variable 1577
ZOOMWHEEL system variable 1578